This work is part of the Dynamic Networks project at the center for Computational Analysis of Social and Organizational Systems (CASOS) of the School of Computer Science (SCS) at Carnegie Mellon University (CMU) and the on-going collaboration on network analytics with Netanomics. The original ORA was done under private funding. Recent work on ORA-LITE was supported in part by private funding. Additional support for select features has been provided by Office of Naval Research – Group Polarization in Social Media (N00014182106); Office of Naval Research – BotHunter (N000141812108); Office of Naval Research MURI – Near Real Time Assessment of Emergent Complex Systems of Confederates (N000141712675); Office of Naval Research Minerva – Dynamic Statistical Network Informatics for work on the socio-cultural cognitive map (N000141512797); the Office of Naval Research Minerva – Multi-Source Assessment of State Stability (N000141310835/N000141612324); the Office of Naval Research – MURI: A Structural Approach to the Incorporation of Cultural Knowledge in Adaptive Adversary Models (N000140811186); Additional support was provided by CASOS – the Center for Computational Analysis of Social and Organizational Systems at Carnegie Mellon University, ORA-PRO and all the visualization, dynamic, and geo-spatial features were supported by DARPA/GenNet (W31P4Q13C0048); the Office of Naval Research for Estimation of Info Op Strategies in Social Media (N0001418P7006); and by Netanomics. The views and conclusions contained in this document are those of the authors and should not be interpreted as representing the official policies, either expressed or implied, of the Office of Naval Research, Netanomics or the U.S. government. ORA-PRO is supported and maintained by Netanomics. ORA-LITE is supported and maintained jointly by Netanomics and CMU CASOS.
Keywords: DNA, ORA, Dynamic Network Analysis, Meta-network, Network Science, Network Visualization, Social Network Analysis
Abstract

ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design structure. The design structure of an organization is the relationship among its personnel, knowledge, resources, and tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are also organized by input requirements and by output. ORA generates formatted reports viewable on screen or in log files, and reads and writes networks in multiple data formats to be interoperable with existing network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ computational back end.

The most current edition of ORA software, Version 3, is available in two versions. ORA-LITE is available on the CASOS website: http://casos.cs.cmu.edu/projects/ora/. It contains hundreds of social network, dynamic network metrics, trail metrics, procedures for grouping nodes, identifying local patterns, comparing and contrasting networks, groups, and individuals from a dynamic meta-network perspective. ORA-LITE is itself limited to a maximum of 2,000 nodes per entity class. Thus a Meta-Matrix can have 2000 agents, 2000 organizations, and so on. The professional version of ORA, ORA-PRO, which has no limit on the number of nodes and a number of advanced functions is available from Netanomics: www.netanomics.com.
# Table of Contents

## Getting Started

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is ORA?</td>
<td>3</td>
</tr>
<tr>
<td>Overview</td>
<td>4</td>
</tr>
<tr>
<td>Social Network Analysis (SNA)</td>
<td>5</td>
</tr>
<tr>
<td>Dynamic Network Analysis (DNA)</td>
<td>7</td>
</tr>
<tr>
<td>Tool Chains</td>
<td>8</td>
</tr>
<tr>
<td>System Requirements</td>
<td>9</td>
</tr>
<tr>
<td>File Formats</td>
<td>11</td>
</tr>
<tr>
<td>Network Drives</td>
<td>12</td>
</tr>
<tr>
<td>DyNetML Networks</td>
<td>16</td>
</tr>
<tr>
<td>Fast Fourier Transform</td>
<td>19</td>
</tr>
</tbody>
</table>

## ORA QuickStart

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickStart Main Interface</td>
<td>20</td>
</tr>
<tr>
<td>QuickStart Visualizer</td>
<td>22</td>
</tr>
<tr>
<td>QuickStart Reports</td>
<td>56</td>
</tr>
<tr>
<td>QuickStart Measures</td>
<td>61</td>
</tr>
</tbody>
</table>

## General Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2 or n Mode Data</td>
<td>69</td>
</tr>
<tr>
<td>Actions vs Tasks vs Events</td>
<td>71</td>
</tr>
<tr>
<td>Aggregation</td>
<td>79</td>
</tr>
<tr>
<td>Beliefs</td>
<td>80</td>
</tr>
<tr>
<td>Change Format</td>
<td>84</td>
</tr>
<tr>
<td>Correlation</td>
<td>85</td>
</tr>
<tr>
<td>Cube Analysis</td>
<td>89</td>
</tr>
<tr>
<td>Delimited Files</td>
<td>91</td>
</tr>
<tr>
<td>Dynamic Networks</td>
<td>98</td>
</tr>
<tr>
<td>Deltas and Keyframes</td>
<td>103</td>
</tr>
<tr>
<td>Create Dynamic Network</td>
<td>110</td>
</tr>
<tr>
<td>Meta-Network Time Notation</td>
<td>114</td>
</tr>
<tr>
<td>Exponential Random Graph Models (ERGM)</td>
<td>123</td>
</tr>
<tr>
<td>Fast Fourier Transform</td>
<td>135</td>
</tr>
<tr>
<td>Folding Math</td>
<td>137</td>
</tr>
<tr>
<td>Gower's Method</td>
<td>139</td>
</tr>
<tr>
<td>Hamming Distance</td>
<td>141</td>
</tr>
<tr>
<td>Inferences Matrices</td>
<td>143</td>
</tr>
<tr>
<td>Large Meta-Networks</td>
<td>145</td>
</tr>
<tr>
<td>MetaOntology</td>
<td>147</td>
</tr>
<tr>
<td>Monte Carlo Methods</td>
<td>148</td>
</tr>
<tr>
<td>Moran-I and Geary-C</td>
<td>151</td>
</tr>
<tr>
<td>Multiple Links in Imported Data</td>
<td>152</td>
</tr>
<tr>
<td>Network Basics</td>
<td>154</td>
</tr>
<tr>
<td>Ontology</td>
<td>155</td>
</tr>
<tr>
<td>Inferences Matrices</td>
<td>159</td>
</tr>
</tbody>
</table>
Parts of Speech........................................................................................................161
Reduced Form Networks..........................................................................................162
Regression..................................................................................................................167
Semantic Network.....................................................................................................173
Simulated Annealing................................................................................................174
Synchronization.........................................................................................................175
WGS84 Maps.............................................................................................................176

ORA's Main Interface..............................................................................................177

Main Interface Tasks...............................................................................................180
  Aggregate KeyFrames............................................................................................182
  Attributes................................................................................................................184
  Attribute Buttons....................................................................................................187
  Clean Button............................................................................................................190
  Context Menus-Meta-Networks..............................................................................196
  Context Menus-Multi Files...................................................................................202
  Context Menus-Networks.......................................................................................206
  Context Menus-Dynamic Meta-Networks...............................................................211
  Create a New Meta-Network..................................................................................214
  Create Meta-Network from Excel File....................................................................216
  Create New Node...................................................................................................219
  Dating Meta-Networks............................................................................................221
  Delimited Files........................................................................................................222
  Document/URI Attributes......................................................................................227
  Duplicate Items........................................................................................................229
  Editor Tab-Networks................................................................................................230
  Editor Toolbar..........................................................................................................237
  Filters........................................................................................................................238
  Fold Network...........................................................................................................243
  Hovering Tooltips...................................................................................................245
  ID Names..................................................................................................................246
  Info Tab-Nodesets...................................................................................................247
  Info Tab-Networks...................................................................................................249
  Info Tab-Network-Statistics....................................................................................253
  Link Attributes.........................................................................................................255
  Measure Charts........................................................................................................258
  Meta-Node Analysis...............................................................................................260
  Network Editor........................................................................................................268
  Node Buttons...........................................................................................................273
  Search.......................................................................................................................274
  Visualize Buttons....................................................................................................279

File Menu...............................................................................................................281
  Opening Files in ORA.............................................................................................283
  Large Scale Table Importer.....................................................................................288
  Data Import Wizard...............................................................................................302

vi
Design a Meta-Network .......................................................... 305
Import Excel or Text Delimited Files .................................. 309
  Rectangle of Link Values (Matrix) ....................................... 310
Import Table of Network Links ........................................... 317
Import Table of Node Attributes ....................................... 323
Import Advanced Table .................................................... 329
Trail Importer ..................................................................... 346
Import from Other Network Analysis Tools ......................... 368
  Import from UCINET ....................................................... 370
  Import from Pajek .......................................................... 376
  Import from Analyst’s Notebook ...................................... 378
  Import from Pen-Link ..................................................... 382
  Import from Pathfinder .................................................. 384
  Import from ThingFinder ............................................... 386
  Import from PersonalBrain ............................................. 388
  Import from CmapTools ................................................ 390
  Import Palantir Data ...................................................... 392
  Import from C3TRACE ................................................... 394
    Import C3TRACE Model Data ...................................... 395
    Import C3TRACE Communication Details Report Data .... 397
  Import from Pythia ......................................................... 399
  Import from CAESAR III ................................................. 401
Import XML Network Data ................................................ 403
  Import DyNetML Data ................................................... 404
  Import GraphML Data .................................................. 406
  Import Palantir Data ..................................................... 408
Import Other Data Formats ............................................... 410
  Import JSON Data ........................................................ 411
  Import Twitter Data ....................................................... 415
  Import Blogtrackers Data .............................................. 428
  Import GitHub Data ...................................................... 434
  Import YouTube Data .................................................... 440
  Import Talkwalker Data ................................................ 444
  Import Pulse Data ........................................................ 448
  Import NexalIntelligence Data ...................................... 451
  Import VK Data ............................................................ 454
  Import Survey Monkey Data ....................................... 457
  Import Shapefile Data ................................................... 461
  Import Bibliography & Citations Data .............................. 464
  Import TAVI Data ........................................................ 471
  Import THINK Data ....................................................... 473
Import Email ...................................................................... 476
  Import Arbitrary Database ............................................. 480
Data Export ....................................................................... 485
Simulations
Analysis Menu
Generate Networks
Data Management
Preferences Menu
Preferences Panes
Edit Menu
Find Entities
File Operations
Matrix Algebra
Meta-Network Transform
Meta-Network Union
Meta-Network Derived Data
Meta-Network Anonymize
Attribute Value Tool
Randomize Links
Generate Networks
Influence Network Generator
Extracting a Task Network for the Influence Network Generator
Pythia
Command and Control Structure Generator
Extracting a Task Network for the Command and Control
CAESAR III
New Meta-Network in Visualizer
Create Stylized Networks
Cellular Network
Core Periphery Network
Erdos-Reyni Network
Lattice Network
Scale Free Network
Small World Network
Fixed Degree-Distribution Network
Create Expected Interaction Networks
Analysis Menu
Generate Reports
Measures Manager
Categories of Reports
Reports In Which Category
Correspondence Analysis
Correspondence Analysis Example
Socio-cultural Cognitive Mapping (SCM)
Moran-I and Geary-C
Simulations
Near Term Analysis
Near Term Analysis Menu
Katz Centrality ................................................................. 1251
Knowledge Actual Workload ............................................. 1253
Knowledge Based Access Index ........................................ 1254
Knowledge Based Task Completion ................................. 1256
Knowledge Negotiation .................................................... 1258
Knowledge Omega ........................................................... 1260
Knowledge Potential Workload ........................................ 1261
Knowledge Under Supply ............................................... 1262
Lateral Link Count .......................................................... 1263
Link Betweenness Centrality ............................................. 1264
Link Count ................................................................. 1265
Local Efficiency .............................................................. 1267
Location Relevance ......................................................... 1268
Minimum Speed ............................................................ 1269
Network Assortativity ..................................................... 1271
Node Count ................................................................. 1273
Nodeset Size ................................................................. 1274
Organization Agent Knowledge Needs Congruence ............... 1275
Organization Agent Knowledge Waste Congruence .............. 1277
Organization Agent Resource Needs Congruence ................. 1279
Organization Agent Resource Waste Congruence ................. 1281
Organization Task Knowledge Needs Congruence ................. 1283
Organization Task Knowledge Waste Congruence ................. 1285
Organization Task Resource Needs Congruence ................. 1287
Organization Task Resource Waste Congruence ................. 1289
Organizational Availability ............................................. 1291
Out-Degree Average Neighbor ........................................ 1292
Out-Degree Centrality ................................................... 1293
Out-Degree Network Centralization .................................. 1295
Overall Role Based Availability ...................................... 1296
Overall Task Completion .............................................. 1297
PN Centrality ............................................................... 1299
PageRank Centrality ....................................................... 1300
Pearson Correlation ....................................................... 1302
Performance As Accuracy ............................................. 1303
Personnel Cost ............................................................. 1305
Political Independence Index ......................................... 1306
Pooled Link Count ......................................................... 1307
Potential Boundary Spanner ........................................... 1308
Potential Workload ....................................................... 1310
Public Health Complexity .............................................. 1311
Radiality Centrality ....................................................... 1312
Radials ................................................................. 1313
Reachable Diameter ..................................................... 1314
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geospatial Assessment</td>
<td>1543</td>
</tr>
<tr>
<td>Group Talk</td>
<td>1548</td>
</tr>
<tr>
<td>Hot Topics (Content Analysis)</td>
<td>1552</td>
</tr>
<tr>
<td>Immediate Impact</td>
<td>1560</td>
</tr>
<tr>
<td>Influence Net</td>
<td>1573</td>
</tr>
<tr>
<td>K-Centrality</td>
<td>1579</td>
</tr>
<tr>
<td>Key Entities Ranking</td>
<td>1584</td>
</tr>
<tr>
<td>Locate Groups</td>
<td>1593</td>
</tr>
<tr>
<td>Management</td>
<td>1633</td>
</tr>
<tr>
<td>Missing Links</td>
<td>1638</td>
</tr>
<tr>
<td>Network Comparison</td>
<td>1644</td>
</tr>
<tr>
<td>Node of Interest Characterization</td>
<td>1650</td>
</tr>
<tr>
<td>Optimizer</td>
<td>1657</td>
</tr>
<tr>
<td>Part of Speech</td>
<td>1665</td>
</tr>
<tr>
<td>Potential Errors</td>
<td>1671</td>
</tr>
<tr>
<td>QAP/MRQAP Analysis</td>
<td>1675</td>
</tr>
<tr>
<td>Semantic Network</td>
<td>1685</td>
</tr>
<tr>
<td>Shortest Path</td>
<td>1694</td>
</tr>
<tr>
<td>Simmelian Ties Analysis</td>
<td>1699</td>
</tr>
<tr>
<td>Socio-cultural Cognitive Mapping</td>
<td>1704</td>
</tr>
<tr>
<td>Statistical Change Detection</td>
<td>1711</td>
</tr>
<tr>
<td>Statistical Distribution</td>
<td>1718</td>
</tr>
<tr>
<td>Tactical Insight</td>
<td>1723</td>
</tr>
<tr>
<td>Topic Analysis</td>
<td>1727</td>
</tr>
<tr>
<td>Trails</td>
<td>1734</td>
</tr>
<tr>
<td>Triad Census</td>
<td>1747</td>
</tr>
<tr>
<td>Twitter</td>
<td>1752</td>
</tr>
<tr>
<td>YouTube</td>
<td>1758</td>
</tr>
<tr>
<td>Running ORA in Batch Mode</td>
<td>1762</td>
</tr>
<tr>
<td>Bibliography</td>
<td>1774</td>
</tr>
<tr>
<td>Java Libraries</td>
<td>1781</td>
</tr>
<tr>
<td>Glossary</td>
<td>1795</td>
</tr>
</tbody>
</table>
Latest Version
ORA 3 (2019)

Contact Information
Carnegie Mellon University
School of Computer Science
Institute for Software Research (ISR)
Center for Computational Analysis of Social and Organizational Systems (CASOS)
5000 Forbes Avenue
4212 Wean Hall
Pittsburgh, PA, 15213-3890

Questions, Bugs, and Comments
Please contact: Dr. Kathleen M. Carley (kathleen.carley@cmu.edu)

Copyright Notification
COPYRIGHT (c) 2001-2019 Kathleen M. Carley
Center for Computational Analysis of Social and Organizational Systems (CASOS)
Institute for Software Research (ISR), School of Computer Science
Getting Started

Welcome to ORA's help system! ORA Help and the examples contained herein are often written with a specific data sets in mind, mostly designed specifically for a particular section.

How to use ORA help

If you are not familiar with Social Network Analysis we encourage you to read through the beginning sections of the help set. The ORA help set is broken up into seven primary parts, which are designed for varying levels of user expertise.

Getting Started : Provides an overview of Social Networks and how they pertain to ORA.

Quick Start : Describes the key interface components and data elements that make up the ORA system.

General Content : Information applicable across many parts of ORA in different ways.

Main Interface : Details working with the data within the meta-networks. This includes loading, saving, merging, performing various math functions on the meta-networks, generating a variety of networks, and running reports.

Visualizer : Takes meta-networks and turns them into graphical representations. There are tools for creating / deleting nodes and links, displaying information in different formats, and helping to analyze the data.

Measures : Explains the various measures used in ORA. Entries contain a short explanation of the measure and describes the type, input, and output.

Reports : Each report entry contains a description of the technique and what it will tell you about your data with procedural notes. Report usage and common procedures are described in separately.

Student Version

NOTE : The student version is for academic use only. The student version is limited to 2000 nodes, certain reports are not available, and some advanced features have been removed.
What is ORA?

An Overview

ORA is a statistical analysis package for analyzing complex systems as Dynamic Social Networks.

Many complex systems such as organizations, intra-state alliances, food webs, etc. can be represented as an ecology of interlinked networks. Within ORA any complex system is represented as a network. What follows is a general description of ORA’s primary capabilities. Specific instruction is provided under the correlating folders in this help system.

See the Glossary for additional definitions relating to social networks.

The ORA Visualizer

The ORA Visualizer renders conceptual images of social networks. Nodes represent real-world entities like the president of a company, driving to the airport, or how to wash your clothes. Nodes which share the same attributes can be further grouped together creating nodesets. Links connect nodes that share a direct relationship. Such relationships are derived from the network. ORA’s single unit of data input, and are referred to as graphs. The ORA visualizer is interactive. You can zoom, rotate, isolate, add and remove nodes, and much more.

Reports

ORA include many reports which can be applied to network data. For general analysis the Key Entities Ranking, Locate Groups, and Node of Interest Characterization reports are often employed along with many additional reports. Multiple organizations can be compared against each other, network structure can be optimized, subgroups within a network can be identified, and scenarios involving the removal of nodes or links can be examined. Reports for specific data categories include the Twitter, Blogs, Trails and others. Reporting capabilities are constantly being refined and updated.

Charts

Multiple chart types are available: Bar Chart, Scatter Plot, Histogram, and Regression. Each one in turn presents a different statistical profile of a selected nodeset. Examples of these reports and how to access them can be found in the help under Main Interface > Measure Charts.
Overview

Contact Information
Kathleen M. Carley
CASOS, Carnegie Mellon University
kathleen.carley@cs.cmu.edu
tel: 412 268 6016

ORA
ORA is an analysis tool designed to help the user evaluate one or more networks. It can be used to assess the nature of, features of, change in, and determinants of complex networks. A large variety of networks can be assessed including, but not limited to, social networks, activity networks, task networks, knowledge networks, supply chains, and communication networks. Using ORA questions such as the following can be addressed: what is critical, are there groups of interest, are there patterns of interest, how might interventions impact the network, who is critical, are there emerging groups, how is the network changing.

What is a network? In any data there are relations among things such as two people are cousins, or a set of people are all members of the same club. These networks might be psychological or cultural as when two people share the same belief. They might be physical as in two resources being in the same location or two computers being connected by a line, or they might be social as in people being related. There are many reasons why networks exist. Networks are ubiquitous. Everyone and everything is constrained and enabled by the networks in which they are embedded. Everyone and everything is embedded in multiple networks; e.g. you are connected to some people due to work, others due to school, others due to your kids, and so on. ORA lets you visualize, assess, and reason about these networks.

What Kinds of Networks?
ORA can assess any type of network. Anything that can be represented as a set of nodes and relations can be assessed. Typical networks are: social networks (who interacts with whom), financial networks (who lends money to whom); gant charts (what task needs to be done before what), supply chains (what resources are needed to build what other resources), semantic networks (what ideas are linked to what ideas), proximity networks (what states border on what states), and so on. ORA can
assess any data that can be represented as nodes and relations regardless of what the nodes are or what the relations are.

**What If There Are Many Networks?**

ORA can be used to assess the interlocks among networks. For example, imagine that the following networks exist: who works with whom; who has what skills, what skills are needed for what tasks, who is doing what tasks then ORA can assess whether in fact the right people have been assigned to those tasks or where there are problems because there is insufficient skills available for the task. ORA can assess "multi-mode multi-link" data.

**What If the Networks Change?**

ORA can be used to assess change in networks over time. Over time, the shape or topology of a network might change; e.g., start up companies move from a collaborative to a hierarchical structure, terrorists change what weapons they use to attack sites, scholars cite different papers, and so on. Consequently, over time, who or what is critical in a network might change. ORA can assess change in networks, and forecast possible ways in which the network might change in the future.

**What If Information Is Incomplete?**

ORA can assess networks even when information is incomplete. ORA has been built to gracefully degrade so that it calculates all and only those metrics for which there is information.

**Illustrative Applications**

ORA has been applied in numerous settings. Examples include the following. Assessment of team-x leadership structure at NASA. Comparison of terror networks. Identification of vulnerabilities in insurgency and terror networks. Assessing change in political elite structures in Korea and early identification of emergent leaders. Designing teams for wargames. Assessing the impact of turnover and retirement on public health organizations in Duchess County, NY. Identifying reports with AIS data. Organizations where ORA has been used include: AFIT, SOCOM, USMA, CIA, many universities.

**Tool Evolution**

There are still many challenges in the area of dynamic network analysis. Key challenges include handling streaming data, locating confidence intervals for metrics, uncertainty assessment, and so on. As these challenges are met, new algorithms are implemented, tested and added to ORA thus further meeting the user's needs.
Social Network Analysis (SNA)

Social Network Analysis is a scientific area focused on the study of relations, often defined as social networks.

In its basic form, a social network is a network where the people (entities) and the relations (links) are a form of connection such as friendship. Social Network Analysis takes graph theoretic ideas and applies them to the social world.

The term social network was first coined by J. A. Barnes (1954). Social network analysis is also called network analysis, structural analysis, and the study of human relations. SNA is often referred to as the science of connecting the dots.

Today, the term Social Network Analysis (or SNA) is used to refer to the analysis of any network such that all the entities are of one mode (e.g. all people, or all roles, or all organizations), or at most two mode (e.g. people and the groups they belong to). The metrics and tools in this area, since they are based on the mathematics of graph theory, are applicable regardless of the type of nodes in the network or the reason for the connections.

For most researchers, the entities are actors. As such, a network can be a cell of terrorists, employees of global company or simply a group of friends. However, entities are not limited to actors. A series of computers that interact with each other or a group of interconnected libraries can comprise a network also.

Where to Learn More:


Dynamic Network Analysis (DNA) is an emergent scientific field that brings together traditional social network analysis (SNA), link analysis, and multi-agent systems. There are two aspects of this field. The first is the statistical analysis of DNA data. The second is the utilization of simulations to address issues of network dynamics. DNA networks vary from traditional social networks in that they are larger, multi-mode, multi-plex networks, and may contain varying levels of uncertainty.

DNA statistical tools are generally optimized for large-scale networks and admit the analysis of multiple networks simultaneously in which there are multiple types of nodes (multi-node) and multiple types of links (multi-plex). In contrast, SNA statistical tools focus on one or at most two mode data and facilitate the analysis of only one type of link at a time.

DNA statistical tools tend to provide more measures to the user because they have measures that use data drawn from multiple networks simultaneously. From a computer simulation perspective, nodes in DNA are like atoms in quantum theory in that they can be, though need not be, treated as probabilistic.

Whereas nodes in a traditional SNA model are static, nodes in a DNA model have the ability to learn. Properties change over time; entities can adapt: A company's employees can learn new skills and increase their value to the network; or, kill one terrorist and three more are forced to improvise. Change propagates from one entity to the next and so on. DNA adds the critical element of a network's evolution and considers the circumstances under which change is likely to occur.

Where to Learn More:


Tool Chains

In general, you may want to use ORA in conjunction with other computational tools to advance DNA theory. The CMU CASOS tools that work with ORA to form tool chains are AutoMap (extracts networks from texts) and various DNA simulators including both Construct and DyNet. These tools are often used in a number of real world applications, including the following areas:

- Designing adaptive teams for Command and Control Networks
- Estimating the impact of organizational downsizing
- Estimating the effectiveness of new structures
- Evaluating risk in organizational designs
- Examine impact of IT effectiveness
- Impact analysis of actions in asymmetric warfare simulation
- Impact analysis of weaponized biological attacks on cities

ORA is inter-operable with a number of other SNA and link-analysis tools: UCINET, KeyPlayer, and Analyst's Notebook. Additional information is listed under data import and export.

Where to Learn More About CASOS Tools and This Tool Chain


System Requirements

ORA performs best on machines that meet or exceed the following specifications:

<table>
<thead>
<tr>
<th>Spec</th>
<th>ORA-LITE</th>
<th>ORA-PRO</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>XP/VISTA/7/8/10</td>
<td>OSX 10.4.x</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB of RAM</td>
<td>1GB</td>
</tr>
<tr>
<td>Processor</td>
<td>32 or 64-bit Intel Pentium/Celeron family, or AMD K6/Athlon/Duron family, or compatible processor recommended</td>
<td>Intel Core 2 Duo</td>
</tr>
<tr>
<td>Speed</td>
<td>500 megahertz or higher (3 Ghz is recommended for large datasets)</td>
<td>2.0 GHz</td>
</tr>
<tr>
<td>Multi-core support</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Disk Space</td>
<td>500 MB</td>
<td></td>
</tr>
<tr>
<td>Java</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Notes</td>
<td>*Requires Windows virtual machine/emulator.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**: When working with extremely large data sets, increasing processing speed and RAM is highly recommended.
File Formats

ORA can import data in a variety of file formats. Below is a list, with examples, of those formats.

**DyNetML (.xml)**

DyNetML (file extension .xml) is an XML interchange language for relational data including nodes, links, and the attributes of these nodes and link. DyNetML is a universal data interchange format to enable exchange of rich social network data and improve compatibility of analysis and visualization tools.

```xml
<nodes>
  <node id="col_jack_o'neill">
    <properties>
      <property name="ally" type="string" value="yes"/>
      <property name="gender" type="string" value="male"/>
    </properties>
  </node>
</nodes>

<network source="Agent" target="Agent" id="agent x agent" isDirected="true">
  <link source="A01" target="A11" value="1"/>
  <link source="A02" target="A01" value="1.45"/>
</network>
```

**DL - Data Language (.dl)**

DL (for "data language", file extension .dl) is a very powerful and (fairly) simple language that allows the creation of quite complex and large UCINET data sets with
minimal data entry. DL language files are plain ASCII text files that can be created with any editor (be sure to store the results as plain text).

dl n=9, format=edgelist1

labels:
   A,B,C,D,E,F,G,H,I

data:
   
   1 1 1
   1 2 1
   1 6 1
   .
   .
   .
   8 7 1
   9 9 1

---

**UCINET**

UCINET datasets (paired file extensions .##h and ##d) are stored in a special (Pascal) format, but can be created and manipulated using both UCINET’s and other software tools (text editors and spreadsheets). Each UCINET dataset consists of two separate files that contain header information (e.g. myfile.##h) and the data lines (e.g. myfile.##d). Because of this somewhat unusual way of storing data, it is best to create data sets with the internal spreadsheet editor or DL language tools, or to import text or spreadsheet files and save the results as UCINET files.

---

**CSV - Comma Separated Values**

The CSV ("Comma Separated Value") file format (file extension .csv) is often used to exchange data between disparate applications. The file format, as it is used in Microsoft Excel, has become a pseudo standard throughout the industry, even among non-Microsoft platforms. File most commonly created from an Excel spreadsheet using the Save As option
• Each record is one line but — A record separator may consist of a line feed (ASCII/LF=0x0A), or a carriage return and line feed pair (ASCII/CRLF=0x0D 0x0A) but — fields may contain embedded line-breaks (see below) so a record may span more than one line.
• Fields are separated with commas.
• Leading and trailing space-characters adjacent to comma field separators are ignored.
• Fields with embedded commas must be delimited with double-quote characters.
• Fields that contain double quote characters must be surrounded by double-quotes, and the embedded double-quotes must each be represented by a pair of consecutive double quotes.
• A field that contains embedded line-breaks must be surrounded by double-quotes.
• Fields with leading or trailing spaces must be delimited with double-quote characters.
• Fields may always be delimited with double quotes.
• The first record in a CSV file may be a header record containing column (field) names

,A01,A02,A03,A04
A01,0,0,0,0
A02,1,0,0,0
A03,1,0,0,0
A04,1,0,0,0

Text Files
Text files (file extension .txt) sometimes referred to ASCII files which contain no predefined formatting. The in addition to the single-byte ASCII representation, the UTF-8 character set can be used for text to cover a broader range of languages and symbols (note however that UTF-8 without BOM should be employed for Java compatibility).
**Pajek**

The Pajek file format (file extension .net) provides information on the vertices, arcs (directed edges), and undirected edges. A short example showing the file format is given below:

*Vertices 3
1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown
2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown
3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown

*Arcs
1 2 3 c Green
2 3 5 c Black

*Edges
1 3 4 c Green

---

**GraphML**

GraphML (file extension .graphml) is a comprehensive and easy-to-use file format for graphs. It consists of a language core to describe the structural properties of a graph and a flexible extension mechanism to add application-specific data. Unlike many other file formats for graphs, GraphML does not use a custom syntax. Instead, it is based on XML and hence ideally suited as a common denominator for all kinds of services generating, archiving, or processing graphs.

<x:s:annotation>
  <xs:documentation
    source="http://graphml.graphdrawing.org/"
    xml:lang="en">
    Simple type definitions for the new graph attributes.
  </xs:documentation>
</xs:annotation>
Network Drives

If you are running on a network drive then the help system needs a drive letter in order to work correctly. There are two possible solutions to this:

1. Copy the ORA folder to each local machine.
2. If at all possible Map a Network Drive. Right click on the shared folder and select Map Network drive.

Mapping a Network Drive

In an Explorer window select My Network Places. Find the name of the network which contains ORA.

Go back to My Document.

From the menu select Tools > Map Network Drive. This brings up the dialog box below.

Select the [ Browse ] button in order to select the network drive.
Select the correct network drive and press [ OK ].

Select [ Finish ].
Your computer now has the network drive with ORA mapped on the desktop.
DyNetML Networks

DyNetML is an XML (Extensible Markup Language) based interchange language for relational data including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal data interchange format to enable exchange of rich social network data and improve compatibility of analysis and visualization tools.

Network types supported by DyNetML include:

- **Meta-networks** - a collection of nodes, attributes, nodesets and networks, including:
  - One mode (uni-modal) networks
  - Two mode (bi-modal) networks
  - *N mode networks* - represented as a meta-network of appropriately structured two mode networks.

- **Dynamic Meta-networks** - a container for meta-networks permitting representation of network change (e.g. evolution of a network through time, with meta-networks as intervals).

ORA stores networks in DyNetML format as a default. ORA provides tools for creating, manipulating and analyzing DyNetML networks. However, ORA users seldom manipulate DyNetML files directly since ORA provides a more human-friendly means to work with network data.

While ORA defaults to the use of DyNetML for storing and interchanging network data, other network data formats are supported and ORA can handle a range of other data sources that can be used to create and store network data. See File Formats.
ORA QuickStart

GENERAL

1 WHAT IS ORA
ORA is a network analysis package that lets you create, import, analyze, visualize, and forecast changes in networks using network and statistical based techniques.

The ORA user interface consists of two major parts: The Editor, which allows you to create, manipulate and analyze meta-networks and the Visualizer, which allows you to see a graphic depiction of meta-network.

2 ORA VERSIONS
ORA-NetScenes is a joint product of Netanomics and Carnegie Mellon University's CASOS center and is currently available in several versions.

ORA-LITE is a special student version available at no cost that runs under Microsoft Windows. This version is restricted to use at educational institutions. ORA-LITE is limited to a maximum of 2,000 nodes per entity class, so you can have 2000 agents, 2000 organizations, and so on. Certain specialized reports and techniques are not available in ORA-LITE. Qualified users may download ORA_LITE from the CASOS web site (see below).

ORA-PRO is a full-featured, unlimited version available for purchase from Netanomics (http://netanomics.com/). ORA-PRO is available for Windows, Mac or Linux operating systems.

Batch Mode Enabled ORA is a full-featured version of ORA enhanced to support non-interactive operation (batch mode) available for purchase from Netanomics (http://netanomics.com/). Batch mode is useful for processing large data sets and executing repetitive analyses.

3 INSTALLING THE ORA-LITE (STUDENT) VERSION OF ORA
To install ORA on your Windows computer:

Go to http://casos.cs.cmu.edu/projects/ora/software.php

Click the Download the latest version link.

After reading the Copyright Notification and Disclaimer, select the [ Yes ] check box to agree to these terms and click the [ Continue ] button to continue.
Complete the Registration Information form and click [ Continue ]. (Note that a valid email address is required to complete the installation.)

Choose your platform.

Click the appropriate link for your system type [ 32-bit ] or [ 64-bit ]. Save the installer file on the target system.

An email with key information will be sent to the email address entered previously. This information is required to complete the installation.

After the program is downloaded and the key information email received, double click the file icon to install. Follow installation instructions provided by the installer (one of which will be entering the serial number from the email).

**NOTE:** ORA-LITE can be run on an Apple Mac system by using a Windows emulator. See the ORA software page for further information.
QuickStart Main Interface

1. EDITOR GUI

The ORA interface is organized into two sections which are placed in resizable and dockable panes. Each pane will have one or more individual parts. On each tab are two buttons: undock and close. In the upper right corner of each pane are three buttons: undock, maximize, and close. This will allow you to arrange the interface to suit your needs.

In the image above some key elements of the ORA Editor are displayed (the default layout, with no open meta-networks, is shown).

1) Menu : Commands for performing the majority of tasks. The menu items are separated into categories each containing commands and sub-categories.

2) Toolbar : Buttons for frequently used functions to work with meta-networks, nodesets and networks.
3) Meta-Network Manager: This pane displays all currently open meta-networks. Selecting meta-networks or their constituent components displays information in the editor (4).

4) Editor: This pane displays information on the selected nodesets and networks in multiple tabs.

5) Generate Reports: This button opens a Generate Reports pane for the currently selected meta-network.

6) Visualize: This button/pulldown menu activates a visualizer for the currently selected network (by default a 2-D visualizer; the pulldown provides additional visualizer choices).

7) Measure Charts: This button opens chart interface to create charts of measures computed from the currently selected meta-network.

NOTE: A View Trails… button will also appear when dynamic meta-networks are selected, to support over-time analysis supported by this meta-network type.

2. WHAT'S IN A META-NETWORK

A Meta-Network is a container for nodesets and networks. It may contain zero to many nodesets and networks.

Currently opened networks are displayed in the Meta-Network Manager panel. A meta-network is identified by the icon: **Expanding the display (clicking the [+] button to the left) will show the constituent components. Selecting a meta-network or component will display the contents in the Editor panel.**

A meta-network contains the following components:

Nodeset: A collection of nodes and their attributes. All nodes are assigned to a nodeset and nodes within a nodeset are considered to be of the same kind. A nodeset is always assigned a nodeset class.

Node: An individual "thing", either material or immaterial, such as a real-world item (person, place, tool), a concept or belief (process, procedure, system) or any other unit of interest (a word, event, geological era).

Attribute: Additional information about a node. Attributes are defined at the nodeset level while attribute data is held at the node level (e.g. the attribute age is defined for an agent nodeset and each node will hold a numeric value recording that agent's age).
**Nodeset Class**: Classification of a nodeset according to a predefined set of classes. Nodesets (and hence the contained nodes) can be classified as "Agent", "Organization", "Knowledge", "Resource", "Belief", "Event", "Task", "Location", "Role", "Action" or "Unknown". Multiple nodesets in a meta-network can be assigned to the same nodeset class. Many predefined ORA analyses use the nodeset class to determine inputs. See [MetaOntology](#) for further information (NOTE: hyperlinks are highlighted in blue; use the back button to return to this page from the linked page).

**Network**: A representation of the links between the nodes of nodeset(s). A network may record links between a single nodeset or two different nodesets. For example an agent x agent network might code kinship links and an agent x organization network might indicate group affiliation.

**Link**: A connection or relation between any two nodes. Any given node may have zero to many links. A link may be marked present/absent (binary) or the strength of the connection may be indicated by a link value.

Meta-network components include key information fields. Some important ones are:

<table>
<thead>
<tr>
<th>Component</th>
<th>Element</th>
<th>Key Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meta-Network</td>
<td>Name</td>
<td>Required</td>
<td>Meta network name. The name does not have to be unique and may be changed by the user in the Editor Pane.</td>
<td></td>
</tr>
<tr>
<td>Meta-Network</td>
<td>Time</td>
<td>Optional</td>
<td>A time stamp for the network. The actual value may be a fixed time (Date) or an string (Period) which indicates the relative ordering of meta-networks using lexical ordering (e.g. &quot;A&quot;, &quot;B&quot;, &quot;C&quot;).</td>
<td></td>
</tr>
<tr>
<td>Meta-Network</td>
<td>Filename</td>
<td>Optional</td>
<td>Indicates the current file holding a meta-network copy (updated when a network copy is read or saved).</td>
<td></td>
</tr>
<tr>
<td>Nodeset</td>
<td>Name</td>
<td>Required</td>
<td>Name for a nodeset. Automatically generated by ORA but may be changed by the user; the name must be unique within meta-network.</td>
<td></td>
</tr>
<tr>
<td>Nodeset</td>
<td>Class</td>
<td>Required</td>
<td>Set to one of a predefined set of classes - &quot;Agent&quot;, &quot;Organization&quot;, &quot;Knowledge&quot;, &quot;Resource&quot;, &quot;Belief&quot;, &quot;Event&quot;, &quot;Task&quot;,</td>
<td></td>
</tr>
</tbody>
</table>
"Location", "Role", "Action" or "Unknown". (Multiple nodesets in a meta-network can be assigned to the same nodeset class.)

Name for a node, which must be unique within a nodeset. ORA will automatically generate node names when creating a blank nodeset or they can be read from user provided data files. Node names may be changed using the Editor Pane.

Text used throughout ORA (e.g. in the editor and visualizer) to identify a node. By default the same as the node name. Node titles do not have to be unique and are sometimes shortened versions of the node name to improve clarity in visualizations and reports. The node title may be changed using the Editor Pane.

Automatically generated for nodesets created in ORA.

Name for an attribute, which must be unique within a nodeset. The attribute name may be changed using the Editor Pane.

Certain attribute names have special meanings to certain ORA components: "Alias", "Longitude", "Latitude", "Node Image", "Node Type" and "Title". For instance, if Latitude and Longitude attributes are present, then the GeoSpatial visualizer will assume they contain decimal latitude and longitude values and use them to place nodes on maps.

Set to one of a predefined set of types - "Text", "Text Category", "Text Multi-Select".
"URI", "Number Category", "Number", "Date". The attribute type identifies the field contents for certain ORA tools.

Text and text fields contain any desired text. The category designation is intended to establish groups (e.g. node color could be a text category). A URI attribute holds a Uniform Resource Identifier, typically a Uniform Resource Locator (URL) (i.e. a web address). Number and Number Category hold numeric values (integer or real), with the category form establishing groups. A date type identifies an attribute holding time values.

<table>
<thead>
<tr>
<th>Name</th>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Name</td>
<td>Required</td>
<td>Name for a network. Automatically generated by ORA but may be changed by the user; the name must be unique within meta-network.</td>
</tr>
<tr>
<td>Source Nodeset</td>
<td>Required</td>
<td>Name of source nodeset (the rows in the default network editor view). Nodeset may not be changed after network creation but the field is updated if the nodeset name is changed.</td>
</tr>
<tr>
<td>Target Nodeset</td>
<td>Required</td>
<td>Name of target nodeset (the columns in the default network editor view). Nodeset may not be changed after network creation but the field is updated if the nodeset name is changed.</td>
</tr>
<tr>
<td>Network Link Value</td>
<td>Required</td>
<td>A numeric value indicating the presence or absence connection between nodes. A value of 0 indicates no connection while any integer or real number (positive or negative) indicates a connection.</td>
</tr>
</tbody>
</table>
3. WHAT IS A DYNAMIC-META-NETWORK

A dynamic meta-network is a container for meta-networks. A dynamic meta-network may contain zero to many meta-networks. Constituent meta-networks are often timestamped to indicate ordering (although this is optional and some, none or all constituent meta-networks can be timestamped). Dynamic meta-networks facilitate dynamic network analysis, the study of network change, particularly network change over time. Certain ORA analytical tools are designed to take dynamic meta-networks as input. ORA provides assistance in creating dynamic meta-networks both manually and by reading in appropriately structured data files.

NOTE: In the ORA Editor's Meta-Network Manager, a dynamic meta-network is distinguished by a special icon. Expanding the display (clicking the [+ ] button to the left) will show the constituent meta-networks.

4. CREATING AND REMOVING META-NETWORKS, NETWORKS AND NODESETS

The Editor contains shortcut buttons to add or remove meta-networks, nodesets, or networks. Buttons with a plus (+) sign add and a minus (-) sign remove.

To add a meta-network, nodeset, or network click the appropriate button. The new item will appear in the Meta-Network Manager. ORA will create empty entries but will prompt for required values (e.g. number of nodes, node class, nodesets and so on as appropriate) for the target object.

To remove a meta-network, nodeset, or network highlight the target item and click the corresponding delete button.

NOTE: In the Editor Pane, only applicable buttons will be active. For example, when no meta-network is highlighted only the add network button will be active (displayed in color). All the other buttons will be greyed out.
In addition to shortcut buttons, create and remove options are available under the Data Management entry in the Menu and by right clicking on meta-networks/networks/nodeset entries in the Meta-Network Manager to display a popup menu with appropriate options.

5. CREATING A NETWORK AND NODESET FILE

A nodeset or network can be created either within ORA (see, for instance, 4. CREATING AND REMOVING META-NETWORKS, NETWORKS AND NODESETS above) then adding data using the editor (see 9. EDITING NODES AND ATTRIBUTES and 10. EDITING NETWORKS AND LINKS below) or by creating a file containing network representation with an external program such as a text editor (e.g. NotePad or NotePad++) or a spreadsheet program (e.g. Microsoft Excel) and reading (importing) the information. The latter process, reading a network representation from a file, is covered in the this and following sections, beginning with creating a network with links.

By importing external files, ORA can create a variety of meta-networks and dynamic meta-networks, from a simple network to complex representations with date and attribute information. This example will create a file containing a simple square network, with links between nodes. ORA can automatically create the requisite nodeset in while importing the network.

5.1 Using a Text Editor to Create a CSV Network and Nodeset File

In the sample textual network representation, all information is separated by commas. The information between commas are cells in the input network, which contain node identifiers (node names, which will be combined into a nodeset) and links (connections between nodes). The left hand column consists of the node names for the from nodes and the top row consists of the node names for the to nodes. A "0" at an intersection means there is no link (connection) while a non-zero number means there is a link.

Using a text editor, enter the following lines:

```
, A01, A02, A03, A04, A05
A01, 0, 0, 0, 0, 1
A02, 1, 0, 0, 0, 0
A03, 1, 0, 0, 0, 1
A04, 1, 0, 0, 0, 1
A05, 0, 0, 0, 0, 0
```

Text rendering of the SG-1 network data

28
NOTE: In the text file above notice the empty value in the top row just to the left of the first comma. This creates an empty cell and corresponds to the empty cell in the Excel spreadsheet in Column A Row 1 seen below.

To indicate the file contains comma separated values (CSV format) save the file with a .csv extension to the file name. Alternatively, save the network as a text file (.txt extension) then change the file extension to .csv.

5.2 Using Excel to Create a Network and Nodeset File

In an Excel Spreadsheet, the network is represented with separate rows (from nodes) and columns (to nodes), each labeled with the node names (which will be combined into a nodeset). The links are coded in the intersecting cells.

Create a blank spreadsheet in Excel and enter the following data (the information is identical with the text example above):

Excel with the SG-1 network data

In this example, an Agent x Agent network has been coded. Links will run from the nodes named in Column A to the nodes named in Row 1. For example there is a link from A02 to A01 (cell B3) but there is no link from A01 to A02 (cell C2).

Again note that the cell A1 is blank. This is common in all network files created in this manner.

Save the Excel file in native format.
Note to experienced ORA users: ORA now supports reading Excel native format files; conversion to comma-separated format is no longer required.

NOTE: The illustration shows multiple worksheets. ORA supports reading spreadsheets with multiple worksheets and will ask which worksheet to read and process.

6. IMPORT FILES INTO ORA TO CREATE NODESET AND NETWORK

With nodesets and networks created it is time to import them into ORA. For this we use the Data Import Wizard. To open the Data Import Wizard from the Menu, select File > Data Import Wizard. Alternatively you can use the Editor keyboard shortcut Ctrl+w or click on the Data Import Wizard button which appears by default in the shortcut button bar:

NOTE: The Data Import Wizard retains previously entered parameter values throughout an ORA session; the images and instructions shown below assume that this is the initial use of the wizard for a session but you may see different values when working with ORA. (Retaining prior parameters simplifies error correction and repetitive processing during data imports.)

Perform the following steps to import one of the nodeset and network files created above:

6.1 Data Import Wizard Dialog 1 - What Would You Like to Do?
Data Import Wizard Matrix Dialog 1

In the left pane (labeled What would you like to do?) select Import Excel or text delimited files > Rectangle of link values (a network). (In this tree (hierarchical) view, use the [+ ] button to the left or double click to open to branches until you reach the final node (leaf). The leaf is then clicked to select it.)

Note that description and sample information is presented in the right hand panel for the selected branch.

Click [ Next > ].

6.2 Data Import Wizard Dialog 2 - Select a Data Destination

Data Import Wizard Matrix Dialog 2

Select Create a new meta-network with ID: by clicking the radio button to the left.

Enter a meta-network name for your new Meta-network (e.g. "SG-1") in the text field replacing the current value (by default ORA enters the name "Meta Network").

Click [ Next > ]
6.3 Data Import Wizard Dialog 3 - Input File Format

Data Import Wizard Matrix Dialog 3

For Import file: click [Browse] and locate the csv (or Excel) file containing your network. Select your file and click [Open].

If your input file is an Excel spreadsheet with multiple worksheets, a dialog box labeled Select Excel Worksheet will appear. Select the appropriate worksheet from the pulldown list and click [OK].

ORA will scan the file and generate a file description. Select the following options (ORA will preselect and generate certain values):

Check File has source headers.

For Source type select "Agent" from the pulldown list.

ORA will generate the Name: "Agent" (this default value need not be changed).

Check File has target headers.

For Target type select "Agent" from the pulldown list.

ORA will generate the Name: "Agent" (this default value need not be changed).

ORA will generate the Network Name: "Agent x Agent" (this default value need not be changed).
Click [Finish].

The new meta-network data should be appear and be automatically selected in the Meta Network-Manager pane. Expand the meta-network (click the [+] button to the left of the meta-network name) then select the network "Agent x Agent". In the Editor Pane, click on the Editor tab (top of pane). You should see the following (note that the image shows the "Binary link values" view; the editor presentation is selected using the Display Options menu item at the top of the pane).

![The ORA Editor with the SG-1 network loaded](image)

The ORA Editor with the SG-1 network loaded

NOTE: Multiple input files can be imported to build a network using the Data Import Wizard's Rectangle of link values (a network) process:

- To input multiple files at the same time, clicking the [Click to import from another file] button in the third dialog allows you to select and describe additional files.
- To add additional files into the meta-network after it had been created, open the Data Import Wizard and in the second dialog click the checkbox for Add to the existing meta-network instead of Create a new Meta-Network with ID:. Then select the meta-network to augment from the pulldown list.

These steps may be combined (e.g. multiple files may be added to an existing meta-network at the same time).

7. CREATING AN ATTRIBUTE FILE

Attributes contain additional information about a node. In this example, a separate attribute file will be created to augment the SG-1 network created in Sections 5 and 6. Files can be created using external program such as a text editor (e.g. NotePad or NotePad++) or a spreadsheet program (e.g. Microsoft Excel).

The file contains three columns, an "Id" column containing the identifiers (node names) used in the Agent nodeset and information for two attributes "Character" and "Actor" with information for each node on a separate line. The top row contains the names of the fields that will be imported. To add attribute data previously created
nodes, the node names must match the node names of existing nodes (optionally, new nodes can also be created).

7.1 Using a Text Editor to Create a CSV Attribute File

In the textual attribute file, all information is separated by commas. The first row contains column headers; ORA will use these header values to name the attributes it adds to the nodeset. In the following lines fields between commas contain node identifiers (node names) and attribute values.

Using a text editor, enter the following lines:

```
Id,Character,Actor
A01,Col. Jack O'Neill,Richard Dean Anderson
A02,Maj. Samantha Carter,Amanda Tapping
A03,Daniel Jackson,Michael Shanks
A04,Teal'c,Christopher Judge
A05,Gen. Hammond,Don S. Davis
```

*Text rendering of the SG-1 attribute data*

To indicate the file contains comma separated values (CSV format) save the file with a .csv extension to the file name. Alternatively, save the network as a text file (.txt extension) then change the file extension to .csv.

7.2 Using Excel to Create an Attribute File

In an Excel Spreadsheet place each node name or attribute into a separate row with each piece of information in a separate cell.

Create a blank spreadsheet in Excel and enter the following data (the information is identical with the text example above):
Excel with the SG-1 attribute data

Save the Excel file in native format.

*Note to experienced ORA users:* ORA now supports reading Excel native format files; conversion to comma-separated format is no longer required.

**NOTE:** The illustration shows multiple worksheets. ORA supports reading spreadsheets with multiple worksheets and will ask which worksheet to read and process.

### 8. IMPORT ATTRIBUTES INTO ORA

After creating the attribute file, use the Data Import Wizard to add the attribute data to the SG-1 network in ORA. To open the Data Import Wizard from the Menu, select File > Data Import Wizard. Alternatively you can use the Editor keyboard shortcut Ctrl+w or click on the Data Import Wizard button which appears by default in the shortcut button bar:

![Data Import Wizard button](image)

**NOTE:** The Data Import Wizard retains previously entered parameter values throughout an ORA session; the images and instructions shown below assume that
this is the initial use of the wizard for a session but you may see different values when working with ORA. (Retaining prior parameters simplifies error correction and repetitive processing during data imports.)

Perform the following steps to import one of the attribute files created above:

8.1 Data Import Wizard Dialog 1 - What Would You Like to Do?

In the left pane (labeled What would you like to do?) select Import Excel or text delimited files > Table of node attributes. (In this tree (hierarchical) view, use the [+] button to the left or double click to open to branches until you reach the final node (leaf). The leaf is then clicked to select it.)

Note that description and sample information is presented in the right hand panel for the selected branch.

Click [ Next > ].
8.2 Data Import Wizard Dialog 2 - Select Meta-Networks to Modify

In the list labeled Select one or more meta-networks to modify, find and check the target meta-network which will receive attributes from the input file. Uncheck any other networks with check marks. (By default ORA will check all meta-networks currently selected in the Meta-network Manager.)

Click [ Next > ]
8.3 Data Import Wizard Dialog 3 - Select a Data Destination

Data Import Wizard Attribute Table Dialog 3

Select Import into existing nodesets: by clicking the radio button to the left.

Listed below are the nodeset(s) contained in the meta-networks selected in Dialog 2. Select Agent (which should be the only nodeset listed).

Click [ Next > ]
8.4 Data Import Wizard Dialog 4 - Input File Format

For Step 1: Select an attributes file: Click [Browse] and locate the csv (or Excel) file containing your network. Select your file and click [Open].

If your input file is an Excel spreadsheet with multiple worksheets, a dialog box labeled Select Excel Worksheet will appear. Select the appropriate worksheet from the pulldown list and click [OK].

ORA will scan the file and generate a file description for use in the next two steps.

In Step 2: Select how to identify the node(s) to get attribute values from a line of the file: Select the column containing the node name for match purposes:

Select Match node name with the file column by clicking the radio button to the left.

From the pulldown menu to the right, select Id.

In Step 3: Select the columns of the file to import as attribute values: Select the following options (ORA will preselect certain values):

Check Character (ORA should select this by default).

For Type select "Text" from the pulldown list.
Check Actor (ORA should select this by default).

For Type select "Text" from the pulldown list.

In the additional controls below select:

Uncheck Create nodes for new names if checked. This prevents new nodes being added to the meta-network.

Check Keep first value to ensure that only one attribute value is entered (if more than one value is found in the input file).

Click [ Finish ].

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Actor</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>Richard Dean Anderson</td>
<td>Col. Jack O'Neil</td>
</tr>
<tr>
<td>A02</td>
<td>Amanda Tapping</td>
<td>Maj. Samantha Carter</td>
</tr>
<tr>
<td>A03</td>
<td>Michael Shanks</td>
<td>Daniel Jackson</td>
</tr>
<tr>
<td>A04</td>
<td>Christopher Judge</td>
<td>Teal'c</td>
</tr>
<tr>
<td>A05</td>
<td>Don S. Davis</td>
<td>Gen. Hammond</td>
</tr>
</tbody>
</table>

**The ORA Editor with the SG-1 attributes loaded**

After adding attribute data to the input file, you can examine the new attributes by selecting the SG-1 network Agent nodeset in the Meta-network Manager and viewing the Editor tab. Next, select the SG-1 meta-network and click the [ Visualize ] button in the Editor pane's Info tab. A 2-D visualizer panel will open, showing the network. Click the magnifying glass button to center the view. Nodes should be labeled with the Node Name (e.g. "A01"). Return to the ORA Editor and select the SG-1 Agent nodeset and then select the Info tab in the Editor pane. Go to the Display nodes by entry and change the pulldown value to "Actor" and then "Character". The visualizer will change the node labels to the attribute values.

**Display nodes by "Node Name"**

**Display nodes by "Actor"**

**Display nodes by "Character"**

**The ORA 2-D Visualizer with the SG-1 network loaded**
9. EDITING NODES AND ATTRIBUTES

Nodes and attributes can be added, changed or removed to any nodeset through the Editor pane. To edit a nodeset, select the nodeset in the Meta-network Manager pane. Then click the Editor tab.

WARNING: ORA does not provide undo/redo functionality during editing. Be sure to make a copy of any important meta-networks before editing (see 11. SAVE A META-NETWORK, below).

9.1 Changing Attribute Values

To change an attribute value, click on the target cell containing the value to select that cell for editing (selecting the cell will highlight it). Then edit the cell contents using the keyboard. Certain attributes (notably, the Node Name attribute) are auto-validated to prevent duplicate values when the editing is complete (user hits return or selects another item). If the changed value would create a duplicate entry the altered value is rejected and the cell contents returns to the original value.

9.2 Searching, Sorting, Filtering and Selecting Nodes

The Editor pane supports several techniques for searching and filtering nodesets. More than one search/filter (collectively referred to as "filters") can be active at the same time. Searching and filtering reduces the list of nodes displayed to simplify measure selection and supports management of large nodesets. The nodeset is not otherwise altered. Selection marks nodes for further processing by other edit commands.

Searching

Search Bar - Enables string matching of nodeset attributes (including the Node Name). Nodes which match the search are displayed while non-matching nodes are hidden.

The search bar includes the following elements (from left to right):

Text Entry Field - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the list of measures. Use quotation marks to search for a phrase (spaces are treated as part of the search). All fields are searched.
[Contains ▼ ] / [Equals ▼ ] - This button controls the text match policy. Contains matches all measures lines which include the string in any position. Equals matches only complete words.

**Options** - Additional options for searching are revealed when the ▼ button is clicked (use ^ to close).

[Clear filters ] : Clear all filters, including search strings. Displays the entire nodeset.

Match all : Show only node names that match all filters (equivalent to a logical and). (Match all is selected on start up.)

Match at least one : Show node names that match any filter (equivalent to a logical or).

**Sorting** - The displayed list of nodes can be sorted by clicking on an attribute column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is alphabetical (i.e. A-Z). A second click sorts the list in reverse alphabetical order (i.e. Z-A). Clicking a different column header will re-sort the list based on that column's content.

**Filtering** - Individual attribute columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu.

The filter menu supports two types of filtering:

**Standard** - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.

**Custom** - Checking the Define a custom filter: option allows a user specified search. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The type of search depends on the type of data contained in the column (text or numeric).

**Text Filtering** - To create a text filter, enter match string in the text field. Then select the string match type is selected from the pulldown list:

- Contains
- Not contain
- Equals
- Not equal
**Numeric Filtering** - To create a numeric filter, build a conditional statement using the following steps:

Select a relational operator from the pulldown menu:

Greater or equals  
Greater than  
Less or equals  
Less than  
Equals  
Not equals

Enter a number value for the comparison by typing in the text box.

Optionally, check a boolean operator if a second condition will be defined.  
And  
Or

Select an additional relational operator from the pulldown menu:

Greater or equals  
Greater than  
Less or equals  
Less than  
Equals  
Not equals

Enter a number value for the comparison by typing in the text box.

[ Apply ] Click to apply the current filter.

[ Cancel ] To close the filter menu. (NOTE: To remove the filter, click the [ Clear Filter ] button.)

**Selecting** - Selected nodes are marked by a check in the left-hand check box. Selection indicates which nodes are to be acted on by other editing commands. For instance, using the Nodes command in the edit menu selected nodes can be deleted or merged.

**Individual Selection** - To select individual nodes, place a check mark next to the node.

**Multiple Selection** - To select multiple nodes, use the controls at the bottom of the Editor pane:
Select/Clear All: Checking this box selects all nodes (whether the measure is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all nodes.

Select/Clear Visible: Checking this box selects visible nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all nodes found by a search. Unchecking the box deselects just the displayed nodes.

9.3 Node Operations

Individual nodes can be manipulated (added, deleted, merged). As nodes in the nodeset are added, deleted or altered, the networks in the meta-network are updated automatically.

Nodes: These Editor menu commands manipulate nodes.

Create new nodes: Insert new node(s) into the nodeset.

Select nodes: Select nodes by matching node names listed in a file.

Move selected nodes: Move node(s) from one nodeset to another.

Delete selected nodes: Remove node(s) from nodeset.

Merge selected nodes: Combine two or more nodes into one. (Nodes can also be merged by attribute values, see 9.4 Attribute Operations.)

Clean Nodeset: Special operations to modify the nodeset. [Advanced option]

Find duplicates: Search for nodes with similar names or ties and merge.

Export blank change list: Create a file listing the nodes in change list format.

9.4 Attribute Operations

Attributes can be manipulated (added, deleted, exported) as a unit.

Attributes: These Editor menu command manipulate attributes.

Create new attribute: Add a new (blank) attribute. ORA will prompt for a Name and Type (see 2. WHAT'S IN A META-NETWORK under the key fields entries for Attribute Name and Attribute Type for further information on these items).
Create new attribute measure: Create a new attribute containing measure values computed on a network or the entire meta-network. User can select the desired measure from a dialog. [Advanced option]

Import attributes: Import attributes from an external file (equivalent to the process described in 8. IMPORT ATTRIBUTES INTO ORA, above, which used the Data Import Wizard).

Export attributes: Save a copy of the current attributes.

Export to a file: Save a copy of the attributes as a file. User can control the attributes and attribute contents saved.

Export to a network: Create a new network from an attribute. Each distinct attribute value becomes a node. [Advanced option]

Delete attributes: Remove attributes by selecting attributes from a popup dialog.

Combine nodes by attribute value: Use an attribute to merge nodes (each distinct attribute value becomes a node). Note that all nodes are renamed using the attribute values (old names are stored in a new "Alias" attribute). [Advanced option]

9.5 Meta-Network Operations
These commands allow the user to define new networks based on nodes selected in the editor.

Meta-Network: These Editor menu commands create networks. [Advanced option]

Create new network: Create a new network based on the visible and/or selected nodes in the Editor pane.

Create new meta-network: Create a new network based on the visible and/or selected nodes in the Editor pane.

10. EDITING NETWORKS AND LINKS
ORA provides numerous ways to modify networks through the Editor pane. This section will describe a few common procedures to modify networks and links. Note that to change the nodes in a network, the nodeset must be modified (see 9. EDITING NODES AND ATTRIBUTES above).
WARNING: ORA does not provide undo/redo functionality during editing. Be sure to make a copy of any important meta-networks before editing (see 11. SAVE A META-NETWORK, below).

10.1 Presenting Networks: Matrix Versus List Views

The Editor pane can present a network several ways. The selected view will be used for all networks shown in the Editor pane until changed. The current view is selected using the Display Options command in the Editor menu.

- **Matrix Views** Display network as a matrix labeled with the node names for the source node (or from node) in the leftmost column and target node (or to node) in the top row. A "0" at an intersection means there is no link (connection) while a non-zero number means there is a link.
  - Numeric link values - Show links as decimal values. Use this option where links can be different (e.g. strong or weak) not just present or absent.
  - Binary link values - Show links as binary (0/1) values. Use this option for binary (present/absent) links where all links are assumed to be the same.
- **List View** - Show only linked nodes in a list form, of the form Source Node (from node name), Target Node (to node name) and Value. This view is useful when checking for the existence of individual links.

**Note:** These views are simply different ways to view the underlying matrix. All links are capable of having link weights and using the binary view will not change existing link weights (adding or deleting the link will, of course alter the link value).

![Matrix View - Numeric Link Values](image1)

![Matrix View - Binary Link Values](image2)

![List View](image3)

ORA Editor views

10.2 Add/Remove/Change Individual Links

In either of the matrix views, you can create, delete and alter individual links.

Choose a meta-network for practice purposes. Do not use a meta-network which contains useful data; instead make a copy of the meta-network and work on the copy (see 11.2 Make a Meta-Network Copy in ORA below).

Select a matrix in the meta-matrix and select the Editor tab in the Editor pane.
If the Editor is not showing a matrix view, click Display Options in the menu. Click on the Change to matrix view option. (If you are already in matrix view, you will see Change to list view instead.)

When in matrix view, you can use the Display Options command to change the matrix view type:

Select Numeric link values to display data as numbers.

Select Binary link values to display data as check marks.

Select Numeric link values initially.

Edit links:

Place the mouse pointer in a cell and select with the left mouse button. The cell will be highlighted.

Enter a link with a weight of "-6.7".

Hit the Enter key; the value will appear in the cell and the cursor will advance to the next cell. (ORA will advance to the next cell down in the column, wrap to the top of the next column as required and will wrap from the last (lower right) cell to the first cell in the matrix (upper left) when necessary.

Navigate to an existing link. You can use the keyboard arrow keys to move to adjacent cells as well was the mouse. Enter a "0" value. This will remove the existing link.

Enter additional positive and negative links values including decimal numbers as desired.

Switch the matrix view to Binary link values using the Display Options category of the Editor menu.

Note that display now shows check boxes in the matrix, with check marks where links exist.

Edit links:

Select an unchecked cell and double-click the check box. A link is created.
Navigate to an existing link and uncheck it by double-clicking. (As with the numeric matrix view, you can use the arrow keys to move to adjacent cells as well as the mouse.)

Return the matrix view to Numeric link values using the Display Options category of the Editor menu. The links created in the binary view contain the numeric link value "1".

Note: In addition to the mouse, the following keyboard keys can be used to navigate:

- **Keyboard Arrow Keys** - The arrow keys move the selection to the adjacent vertical and horizontal cells.

- **Keyboard Page Keys** - Move to the table edge using the Page keys.

  - Page Up: Move to the top of the column.
  - Page Down: Move to the bottom of the column.
  - Ctrl+Page Up: Move to the start of the row.
  - Ctrl+Page Down: Move to the end of the row.

### 10.3 Sorting, Searching and Selecting

When working with larger networks, it can be difficult to locate nodes for link creation and modification. The matrix view provides several methods to organize and search the nodes.

- **Sorting** - Using sort commands in the matrix view temporarily reorders the presentation of rows and columns in the Editor pane (selecting a different nodeset or network returns the presentation to the default view). Note that "sum" indicates arithmetic summation of link weights, both positive and negative (i.e. negative and positive weighted links can cancel each other: $2 + (-1) + (-1) = 0$). Row and column sums can be displayed in the editor using the Display Options command. Sort commands in the editor menu include:

  - Sort Rows: Reorder the row presentation.
  - High to Low by row sum: Reorder the rows by descending sum value.
  - Low to High by row sum: Reorder the rows by ascending sum value.
  - A to Z by node name: Reorder the rows in lexical order.
  - Z to A by node name: Reorder the rows in reverse lexical order.
Sort Columns : Reorder the column presentation.

High to Low by row sum : Reorder the columns by descending sum value.
Low to High by row sum : Reorder the columns by ascending sum value.
A to Z by node name : Reorder the columns in lexical order.
Z to A by node name : Reorder the columns in reverse lexical order.

**Searching** - The Editor pane supports searching row and column labels (link values are not searched). Rows and columns are searched independently and simultaneously. Note that the row and column labels used in the matrix view can be altered to use a different attribute for the label by changing the key field value Display nodes by for the constituent nodeset(s) under the nodeset Info tab.

The search bar includes the following elements (from left to right):

- **Row Text Entry Field** - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the matrix display. Use quotation marks to search for a phrase (spaces are treated as part of the search). Only the row label is searched.

- **Row [ And ▼ ] / [ Or ▼ ]** - This button controls the row text match policy. And matches rows which include all specified strings. Or matches rows which have any one of the specified strings.

- **Column Text Entry Field** - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the matrix display. Use quotation marks to search for a phrase (spaces are treated as part of the search). Only the column label is searched.

- **Column [ And ▼ ] / [ Or ▼ ]** - This button controls the column text match policy. And matches columns which include all specified strings. Or matches columns which have any one of the specified strings.

**Match** - Pulldown list to determine how search results are presented:

- **Show Matches** : Display only rows and columns which satisfy their respective search conditions.

- **Highlight Matches** : Display the entire matrix and highlight rows and columns which independently match their search conditions.
Hide Matches: Show rows and columns which do not satisfy their respective search conditions.

**Selecting** - To operate on links, they must first be selected. Selected links are indicated by a blue background fill.

**Single Selection** - A single cell is selected by placing the mouse pointer in a cell and selecting it with the left mouse button.

**Multiple Selection** - Multiple cells can be selected and operated on group as a group. Multiple selection always starts with a selected cell (per Single Selection above). The selected cell will be the corner of a rectangle of multiple selected cells. Additional cells can be selected by:

**Keyboard Arrow Keys** - Holding the keyboard Shift key down, expand the selected area using using the arrow keys. The initially selected cell will be treated as a corner cell of the selected area.

**Keyboard Page Keys** - Holding the keyboard Shift key down, expand the selected area to the matrix edge using the Page keys.

Shift+Page Up: Extend the selected area up to the top edge. (Unselects selected cells below the initially selected cell.)

Shift+Page Down: Extend the selected area down to the bottom edge. (Unselects selected cells above the initially selected cell.)

Ctrl+Shift+Page Up: Extend the selected area to the left edge. (Unselects selected cells to the right of the initially selected cell.)

Ctrl+Shift+Page Down: Extend the selected area to the right edge. (Unselects selected cells to the left of the initially selected cell.)

**Mouse Click** - Holding the keyboard Shift key down, point at the unselected corner cell of the area, then click the left mouse button. This will select the rectangle defined by the two corner cells. (Moving the cursor and clicking again shifts the selection area with the original selection held constant.)

**NOTE**: The matrix view of the Editor pane supports selection of cells by the user as described here (selected cells are filled with a blue background) and highlighting which are cells marked by the editor (cells are highlighted in yellow). Commands which manipulate highlighted cells will not use selected cells (e.g. searching
highlights cells as does the Highlight command; the Hide command will then operate
on the highlighted cells).

NOTE: Multiple selection is also supported when editing nodesets.

10.4 Operations on Multiply Selected Links

Multiply selected links can be used as a unit for certain editing operations (basic
operations on singly selected links are covered in section 10.2 Add/Remove/Change
Individual Links above.)

**Block Copy and Paste** - The Editor pane allows supports copy and paste of blocks
of links to and from the clipboard.

**Copy** - Use the keyboard shortcut Ctrl+c to copy selected area to the clipboard.

**Paste** - Use the keyboard shortcut Ctrl+v to paste the clipboard contents, using the
upper left corner of the currently selected area as the start point (the size of the
selected area need not match the size of the pasted data). ORA will validate the input
data and warn if the pasted block will exceed the matrix bounds.

Data can be copied and pasted between different tools, not just within ORA. For
instance, a block of links can be copied from ORA, pasted into an Excel spreadsheet,
modified using Excel and then copy/pasted back into ORA.

10.5 Operations on All Links

When editing networks using the matrix view, ORA provides commands to
manipulate multiple links simultaneously. Applicable commands include:

**Convert Links**: Apply a transformation to all link values. Numerous options,
including:

- **Binarize**: Change all link values to 1 (non-links remain 0).
- **Negate**: Reverse the sign of all link values.
- **Scale**: Scale the link values by the specified scale factor.
  and others...

**Remove Links**: Remove all or selected links.

**Remove All Links**: Set all links values to "0" (no connection).

**Remove links by value**: Remove selected links (set the link value to "0", no
connection) based on a numeric comparison of the link value. Supported comparison
types include:
11. SAVE A META-NETWORK

It is important to save your work from time to time, particularly before making editing changes.

11.1 Save a Meta-Network Copy to Disk

You may make save a copy of your meta-networks to disk at any time during an ORA session. Making periodic copies to disk is useful since if something happens to your computer all work done since your last save will be lost. When ORA is shut down, the program will warn you about unsaved meta-networks and offer an opportunity to save them.

There are two file save options, both available from the File menu:

Save Meta-Network: Saves your work to the file that was originally opened when the meta-network was read from disk.

Save Meta-Network As...: Saves your work to a new file. Enter a new file name in the file dialog. This option can be useful if you are experimenting with different ideas and do not want to affect your original data.

11.2 Make a Meta-Network Copy in ORA

Making a meta-network copy within ORA is an alternative to saving to disk. Since ORA does not have undo/redo functionality when editing this is an useful precaution when performing editing changes. To make a copy of a meta-network:

Select a meta-network in the Meta-Network Manager.

Make a copy of the selected meta-network to the clipboard with the keyboard shortcut Ctrl+c.

Paste the meta-network copy into the Meta-Network Manager with the keyboard shortcut Ctrl+v. The meta-network copy will be inserted at the end of the list using the same name as the original.
[Optional] Change the meta-network name after creating the meta-network to avoid confusion with the original.

The new meta-matrix copy will be selected after the copy.

Go to the Editor pane and in the Meta-Network Name entry, change the name by typing a new name in the text field.

12. **SAVING AN ENTIRE ORA SESSION (WORKSPACE)**

ORA will save a list of all files open during a session (a "workspace" in ORA terms). To create a workspace, on the File menu select:

Save Workspace : Creates a listing of the current workspace. The command will prompt you to:

Save any unsaved meta-networks.

Save the change list if present.

Request a filename for the workspace file (list of open meta-networks).

To load a workspace during an ORA session, on the File menu select:

Open Workspace… : Replace the current workspace with stored workspace by reading a workspace file. The command will prompt you to:

Save any unsaved meta-networks.

Save the change list if present.

Select the replacement workspace file.

When exiting ORA by the File > Exit command, ORA will offer a chance to save unsaved files and the option to reload the existing workspace when ORA is restarted.
ORA Exit dialog with prompts to save data and option to restore workspace on restart

13. PREFERENCES

The appearance and content of the ORA interface can be modified using preference options. There are many parameters that can be set. Preferences can be modified using:

Preferences : The preferences command provides numerous options. These include:

Restore Default Layout : Reset the interface panel layout to default settings.

All preferences… : Dialog with multiple tabs for all preference options.

General : Preferences for the look and feel of ORA, whether tooltips are shown when hovering over items, the size of the toolbar icons, etc.

Additional advanced options, not discussed here.

Configure Toolbar Dialog : Controls the items shown in the toolbar. The toolbar permits quick access to commonly used commands (see 4. CREATING AND REMOVING META-NETWORKS, NETWORKS AND NODESETS above for a brief introduction to the default commands). Use the ▼ icon in the toolbar to access the dialog.
Select the toolbar items: Check or uncheck items on the list to alter to toolbar contents.

Restore Default: Click button to return toolbar to the default appearance.
QuickStart Visualizer

ORA provides multiple visualizers. The 2-D visualizer is described here, additional visualizers include:

- 3-D Visualizer
- GeoSpatial Visualizer
- Node Cloud Visualizer
- Trails Visualizer

Supplemental data may be required to use certain visualizers (e.g. location data to allow geospatial visualizations).

1. USER INTERFACE

Provides a visual representation of your meta-network.

The ORA 2-D Visualizer Interface

1) Menu : Display area for visualizations.

2) Legend : Lists the network components available for visualization and controls their display.
3) Menu: Commands for performing the majority of visualizer tasks. The menu items are separated into categories each containing commands and sub-categories.

4) Toolbars: Holds buttons and controls for frequently used performed visualizer tasks.

5) Customize Buttons: Opens a dialog that allows you to add or remove buttons to and from the toolbar.

6) Zoom/Hyperbolic selector: Select the radio button for selecting zooming the network image or applying a fish-eye (center magnified) view.

7) Zoom/Hyperbolic slider: Sets the magnitude of the selected view.

2. DISPLAYING META-NETWORK IN EDITOR

Meta-networks can be visualized in many ways.

Highlight a meta-network. Note we are back in the main ORA interface, not the Visualizer.

Click the Visualizer button.

Or from the Editor Menu select Visualizations > View Networks > 2D Visualization.

NOTE: The Visualizations menu also contains other display functions for your meta-networks. Many of which are advanced functions.

3. ADD/REMOVE NODES WITH THE VISUALIZER MENUS

Actions > Add Node(s): Allows you to add nodes to existing or new nodesets.

Tools > Node Status: Displays all the information about the selected node.

Tools > Node Locator: Selecting a node from the dialog box will reveal the location of the node in Visualizer.

Display > Node Shaper: Use this tool to change the size and shape of the selected node.
4. ADD NODE IN VISUALIZER WITH NODE CREATOR

- The Node Creator button is in the left toolbar (item [4] on the ORA Visualizer interface image above).

In the drop down menu select a nodeset.

Place a check mark in the box. ORA will ask for a name for each new node

Click in the Visualizer to create a new node.

5. ADD LINKS IN VISUALIZER WITH LINK CREATOR

- The Link Creator button in the left toolbar (item [4] on the ORA Visualizer interface image above).

Select the network from the dropdown menu to add a link.

Select the weight for new links created.

Click and hold on the source node.

Drag the mouse to the target node

Release the mouse to create a new link.

6. REMOVE NODES OR LINKS IN VISUALIZER WITH LINK ERASER

- Click Node/Link Eraser is in the left toolbar (item [4] on the ORA Visualizer interface image above).

Removes node(s) and link(s) from the Visualizer display. Click on a node or a link to remove it from the display and meta-network.

If the Permanently Delete check box is empty ORA will remove the node(s) or link(s) from the display only. The node(s) or links(s) will be retained in the meta-network.
If the Permanently Delete check box contains a check mark the node(s) or links(s) will be permanently deleted from the meta-network as well.

7. SHOW/HIDE VISUALIZER LABELS, LINKS, & ARROWS

In the display various items can be shown or hidden (item [4] on the ORA Visualizer interface image above).

Toggle the display to show/hide the node labels.

Toggle the display to show/hide the links.

Toggle the display to show/hide the node arrows.

8. CHANGE Nodeset COLOR:

You can change the color of an entire nodeset in the Visualizer.

If the Legend is not visible, open it by selecting Tools > Legend.

Click on the color node for a nodeset.

In the color selector dialog box select a new color.

Click [ OK ].

9. DATA REDUCTION STRATEGIES

At times the Visualizer display can be difficult to read. There are multiple ways to reduce unneeded information temporarily from the display.

9.1 Hide Isolates

You can remove isolates from the display without permanently removing them from the meta-network.

From the Visualizer menu select Actions > Isolates > Hide Isolate Nodes.

9.2 Remove Isolates

You can permanently remove isolates from a meta-network in two ways:
From the Visualizer menu select Actions > Delete Isolates > Delete Currently Visible Isolates. This will remove from the meta-network only those nodes that are visible.

From the Visualizer menu select Actions > Delete Isolates > Delete Underlying Isolates. This will remove all isolates from the meta-network.

9.3 Hide Pendants

You can remove Pendants from the display without permanently removing them from the meta-network.

From the Visualizer menu select Actions > Hide Pendant Nodes.

10. ADD ICONS OR PICTURES

Nodes can be replaced by icons or pictures (50 x 50 pixel max) for easier identification.

10.1 Icons

Right-Click a node and select Appearance Submenu > Set Picture.

From the drop down menu select a category then click and highlight your icon.

Click [ OK ] when finished, The node will then display the icon

11. CHANGE SIZE/COLOR NODES BY METRIC

Node Appearance > Size Node by Attribute or Measure.

This will scale the size of all nodes by using the attribute or measure selected.

Numbers for each node value are user adjustable.

Node Appearance > Node Color > Color Node by Attribute or Measure

This will color all nodes by using the attribute or measure selected.

Colors for each node value is adjustable.

To reset color and size select Node Appearance > Reset Node Color and Size.
QuickStart Reports

Reports give you information about your meta-networks. These are the four most important reports:

Key Entities Ranking: Identifies key entities and groups who, by virtue of their position in the network, are critical to its operation. More...

Locate Groups: Identifies the groups present in the network using various grouping algorithms. Algorithms work on unimodal or bimodal parts of the meta-network. More...

Node of Interest Characterization: For each node specified, finds some important measures and facts about the node in relation to their network. More...

Twitter: Identifies key tweeters and tweets in a meta-network derived from twitter data. Characterizes tweets and tweeters. More...

These reports can be initiated using the ORA graphical user interface:

Using the Meta-Network Manager Manager pane:

Select one or more meta networks in the Meta-Network Manager Manager (to select the first meta-network, left-click on the meta-network name; to add additional meta-networks ctrl-left-click on additional meta-networks).

In the editor pane, click the [ Generate Reports… ] then select the desired report using the Generate Reports dialog.

In the menu bar:
Select Analysis > Generate Report > [ category ] > [ report name ] with categories and names as follows:

- **Key Entities Ranking**: Locate Key Entities > Key Entities Ranking
- **Locate Groups**: Characterize Groups and Networks > Locate Groups
- **Node of Interest Characterization**: Locate Key Entities > Node of Interest Characterization
- **Twitter**: Social Media > Twitter

Either method will open the Generate Reports dialog, which will, by default, use with the most recently selected report and meta-networks. You may adjust the input meta-network(s) and report type by selecting the Select Report option in the dialog.
To change the report, several methods are available under Reports: select a report to run from the list or by category:

1. Select the report name from the pull-down list of reports (in the text area, click the down-pointing triangle (▼) then select the desired report from the list). (Note: If you have already selected a report by typing the name into the text box as described below, you will need to clear the text to restore the full report list.)
2. Directly type the report name into the text box. The list of available reports will be dynamically trimmed to reports that contain the typed characters.
3. Click on the [Categories ▼] button, then select the appropriate category and report.

To change the input meta-network(s) use the list under Meta-Networks: select one or more to analyze in the report

1. To select/unselect individual meta-networks, click the box next to the meta-network name. A check mark indicates that a meta-network is selected for analysis.
2. To select/unselect all meta-networks, use the Select All box. Clicking the box will select all meta-networks if there are any currently unselected meta-networks and will unselect all meta-networks otherwise.

Detailed help is available for each of the individual reports listed above.
1. Focus on Actor

One item you need to discover is who is important in a meta-network. To obtain this information you can run the Key Entities Ranking report. Go to Analysis > Generate Reports > Locate Key Entities > Key Entities Ranking.

The report will ask you for the number of nodes to display and if you want to use a particular attribute in the calculation. But the most important selection is the Who, How, What, and Where. When focusing on actors place a check mark in the Who only. By default the report lists the top 10. This can be changed when running the report.

To find out how a particular person is connected run the Analysis > Generate Reports > Locate Key Entities > Node of Interest Characterization report.
Begin with placing a check mark next to one or more a meta-networks from the list. Then click [ Next > ].

In the second window place a check mark next to the Nodeset(s) to analyze. In this case choose Agent.

All networks which contain any of the nodesets selected appear in the bottom pane. Having only chosen Agent only the Agent x Agent network appears. Place a check mark next to Agent x Agent. Then click [ Next > ].
Next place a check mark next to the agent(s) to track. Then click [ Next > ].

Finally place a check mark next to all the nodes to visualize. Then click [ Next > ].
The final screen allows you to choose where to sent the results. The two most common choices are: Text will display it in the Report Tab in ORA. HTML will open a file in your browser. The browser version is usually best for presentations as it contains more visual elements.

**2. Focus on Region**

In addition to finding out who the important agents are in a meta-network the Key Entities Ranking report can also show you the important locations.

As with Focus on Actor above the check mark should be placed in the Where box only.

Once the key locations are discovered agents connected to that location can be analyzed. In time marked data it will also show When those agents were in those locations.

**3. Focus on Time**

In the Editor the Measures Over Time allows you to see how a network measures changes over multiple time periods.
This requires your data to have time data. Highlight a meta-network and in the Editor pane to Date:. If the area is blank your meta-network does not have time data and the function will not run. You can click the [ Click to create? ] button to assign a data to each time slice.

Below is an example of the type of display viewing two measures over nine time periods.

Any networks included in a meta-network can be displayed in the fashion.

In the Visualizer the View Networks Over Time allow you to see how networks change over the specified time periods.

Each meta-network included should contain nodes and networks named the same. This is necessary in order for ORA to assess how individual items have changed for each time period. If a node has a slightly different name then ORA will assume they are not the same node.

The animated sequence will display the selected networks for each meta-network.

This display is the normal Visualizer display.

Refer to the User Guide for more information.
QuickStart Measures

A measure is a function that takes as input a meta-network and outputs a single value or a vector of values. For more information on the measures see the User Guide.
General Content

These are pages for information on ORA-NetScenes which is general in nature and does not pertain to any particular ORA section.

1, 2, or n Mode Data - Creating networks with one, two or multiple nodeset classes.

Actions vs Tasks vs Event - Discriminating between the two node classes in ORA that represent acting or doing.

Aggregation - Issues in combining network entities.

Beliefs - Belief diffusion.

Change Format - Format and purpose of change lists.

Correlation - Computing correlations.

Cube Analysis - Cube analysis of communicative power.

Delimited Files - Delimiters in flat data files.

Dynamic Network - Dynamic network concepts.

Exponential Random Graph Models-ERGM - Statistical models that help analyze the structure and properties of social and other networks.

Fast Fourier Transform - Fourier analysis.

Folding Math - Network folding.

Hamming Distance - Computing Hamming distance of networks.

Inference Matrix - Questions and answers about inference matrices.

Large Meta-Networks - Maximum allowable network sizes.

MetaOntology - Standard nodeset classes.

Monte Carlo - Technique employing repeated random sampling.

Moran-I and Geary-C Analysis - Techniques for the measurement of spatial autocorrelation

Multiple Links in Imported Data - What to do when there is the possibility of multiple links between the same nodes in a file.

Network Basics - Basic terms for networks.
**Ontology** - A brief introduction to ontology.

**Parts of Speech** - Parts of speech tagging conventions for text.

**Reduced Form Networks** - Definition, utility and limitations on reduced form networks.

**Regression** - Performing regression analysis on networks.

**Semantic Network** - Semantic networks in ORA.

**Simulated Annealing** - An optimization heuristic.

**Synchronization** - Dynamic visualization of editing changes.

**WGS84 Maps** - Using the WGS84 notation.
1, 2 or n Mode Data

Ora can handle 1, 2 or n mode data. A mode is a set of nodes, i.e., a nodeset. Typical social network analysis handles one mode data (e.g. a people to people network). In this case, the metrics identify which node in the network are critical. The grouping algorithms cluster the nodes, (e.g., the people, into groups). Sometimes you have two mode data such as people by events, (e.g. Davis, Gardner and Gardner's (1941) classic Southern Women Study). In this case, you can ask questions like who was at the most events or what events were attended by most people to create two different one mode networks people to people and events to events. With these one mode networks you can again calculate all the standard metrics.

In ORA, however, there are additional special metrics such as redundancy, that can be calculated on two mode data.

With N mode data, you can do all the above, and in ORA there are additional special metrics such as cognitive demand that calculate a nodes position based on multiple matrices.

In ORA, nodesets can be cross indexed as being related to agents, organizations, locations, tasks, events, resources, knowledge, beliefs, roles. If you do this there are some additional metrics that rely on knowing what nodesets you have that you can take advantage of (e.g., with locations you can run the locations reports).

In general, all metrics that run on agents also run on organizations and roles. For tasks and events - there are other special temporal metrics. All metrics that run on resources also run on knowledge and beliefs. The standard social network measures run on any square one mode network - however in ORA - some guidance is provided on how to interpret this based on the type of nodes.

One-Mode

A One Mode dataset uses the same nodeset as source and target such as an Agent x Agent network.
Two-Mode

A Two Mode dataset uses two different nodesets as source and target such as Agent x Knowledge.

<table>
<thead>
<tr>
<th></th>
<th>K1</th>
<th>K2</th>
<th>K3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Multi-Mode

An N Mode dataset uses multiple nodesets set in multiple networks and is represented as a DyNetML file. The example below consists of three nodesets: Agent, Knowledge, Resource, etc. with subsequent networks for each. The blanks are where the opposite network would exist if needed (i.e. the knowledge x agent). These are usually omitted as the information already exists in the first network. But they can be included if there is a need.
# Measures and Their Modes

<table>
<thead>
<tr>
<th>Measure</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Actual Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Agent Knowledge Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Agent Knowledge Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Agent Resource Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Agent Resource Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Agent Socio Economic Power</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Assignment Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Authority Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Average Communication Speed</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Betweenness Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Betweenness Centrality Spatial</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Betweenness Network Centralization</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Measure</td>
<td>Mode</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Biological Diversity Index</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Bonacich Power Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Burt Constraint</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Burt Effective Network Size</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Capacity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Characteristic Path Length</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Clique Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Closeness Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Closeness Centrality Spatial</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Closeness Network Centralization</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Clustering Coefficient</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Cognitive Demand</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Cognitive Distinctiveness</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Cognitive Resemblance</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Cognitive Similarity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Column Breadth</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Column Count</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Column Degree Centrality</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Column Degree Network Centralization</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Column Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Communication</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Communication Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Communicative Need</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Complexity</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Connectedness</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Correlation Expertise</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Correlation Distinctiveness</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Correlation Resemblance</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Correlation Similarity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Degree Centrality Spatial</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Density</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Density Classic SNA</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Diameter</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Diffusion</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Edge Betweenness Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Metric</td>
<td>Mode</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Efficiency</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Eigenvector Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Eigenvector Centrality Spatial</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Exclusivity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Exclusivity Complete</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Fragmentation</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Geodesic Distance</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Global Efficiency</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Hub Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>In-Degree Centrality</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>In-Degree Network Centralization</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Information Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Interdependence</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Interlockers</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Inverse Closeness Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Isolate Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Knowledge Actual Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Knowledge Based Access Index</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Knowledge Task Completion</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Knowledge Diversity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Knowledge Exclusivity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Knowledge Load</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Knowledge Negotiation</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Knowledge Omega</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Knowledge Potential Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Knowledge Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Knowledge Under Supply</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Lateral Link Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Link Count</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Local Efficiency</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Location Relevance</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Minimum Speed</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Network Levels</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Node Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Node Levels</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Metric</td>
<td>Mode</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Organization Agent Knowledge Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Agent Knowledge Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Agent Resource Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Agent Resource Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Task Knowledge Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Task Knowledge Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Task Resource Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organization Task Resource Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Organizational Availability</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Out-Degree Centrality</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Out-Degree Network Centralization</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Overall Role Based Availability</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Overall Task Completion</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Performance as Accuracy</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Personnel Cost</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Pooled Link Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Potential Boundary Spanner</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Potential Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Radials</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Reciprocal Link Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Relative Cognitive Distinctiveness</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Relative Cognitive Expertise</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Relative Cognitive Resemblance</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Relative Cognitive Similarity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Relative Expertise</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Relative Similarity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Resource Actual Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Resource Based Access Index</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Resource Based Task Completion</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Resource Diversity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Resource Exclusivity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Resource Load</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Resource Negotiation</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Resource Omega</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Resource Potential Workload</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Resource Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Metric</td>
<td>Mode</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Resource Under Supply</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Role Based Knowledge Availability</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Role Based Resource Availability</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Role Based Knowledge</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Role Resource Availability</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Row Breadth</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Row Count</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Row Degree Centrality</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Row Degree Network Centralization</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Row Redundancy</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Sequential Link Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Shared Situation Awareness</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Simmelian Ties</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Skip Link Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Social Technical Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Span of Control</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Strict Knowledge Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Strict Resource Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Strong Component Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Task Exclusivity</td>
<td>Two-Mode</td>
</tr>
<tr>
<td>Task Knowledge Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Task Knowledge Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Task Resource Needs Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Task Resource Waste Congruence</td>
<td>Multi-Mode</td>
</tr>
<tr>
<td>Total Degree Centrality</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Total Degree Network Centralization</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Triad Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Transivity</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Upper Boundedness</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Weak Boundary Spanner</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Weak Component Count</td>
<td>One-Mode</td>
</tr>
<tr>
<td>Weak Component Members</td>
<td>One-Mode</td>
</tr>
</tbody>
</table>

References

Actions vs Tasks vs Events

There are three node classes in ORA that represent acting or doing: Action, Task and Event. The definitions below show when you would use each one.

Action: The process of doing something. An action could include driving to a store, submitting a request or activating a machine.

Task: Designed or repeated activities, e.g. it is part of the job description of the employee to make coffee.

Event: One time happening, e.g. the employer made coffee on December 12th, 2011.
Aggregation

Space is continuous and distances can be arbitrarily large or small. Networks can contain relations between discrete entities or vast neighborhoods. Space, like time, can be discretized to produce networks, but you can't forget about it.

Consider a scientific collaboration network. It could be aggregated by the researchers in each city. But there no way to distinguish between the researchers at individual universities in Pittsburgh. You could have collaborations of Pitt-CMU, Pitt-Pitt, and CMU-CMU. Then there are collaboration between Pittsburgh researchers and Boston researchers. Again, which university might it be.

NOTE : You need to remember that in aggregation, order doesn't matter. All events happen more or less at the same time.

Aggregation Issues

You need to disconnect between space and networks. Locations are continuous. Networks are defined between discrete entities. Are two locations ten meters apart the same location?
Aggregation Can Lose Information

Original Dataset

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

Some Information Loss

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
<td>5.0</td>
<td>5.5</td>
<td>1.5</td>
</tr>
</tbody>
</table>
What To Do?

You can explore many different aggregations or quantify the risk of false conclusions. But how much information is not being shown? Is there information entropy from Information Theory. The example below contains links occurring in three separate time periods [top image].

Below shows these links in a network over time.

Aggregated, all three people appear to have links to each other simultaneously.
Before aggregation, the sequence of actions is clear, but not the overall connections. After aggregation, the total network is clear, but it's unclear when these things happen.

NOTE: Aggregation works well with information that is not time sensitive. Total links rather than the sequence of events.
Belief Diffusion is the change in beliefs of actors in a social group over time. Beliefs cannot be evaluated for truth. Knowledge can contribute to or deny a belief.

**Example 1**
Belief : Cats are better house-pets for a family than dogs.

Supporting Evidence : Cats tend to live longer than most breeds of dog.

Contrary Evidence : Most cats must have explicit socialization training early if they are going to be as affectionate as most breeds of dogs.

**Example 2**
Fact 1 : Cats damage furniture.

Fact 2 : Cats are passive aggressive.

Fact 3 : Cats leave trophies.

=> I don't want a cat!
**Change Format**

**Description**

NOTE: The first thing to remember is the Change List is for modifying nodes, not links.

The Change Format is used when you want to:

Delete: Remove a node entirely from the nodeset.

Split: Split a concept into two or more new concepts. (e.g. laptop_computer could be split into two concepts: laptop and computer). The original concept would remain unaffected.

Add: Create a new node in a nodeset.

Merge: Take the information from two separate nodes and combine it into one node. Used to clean up nodes with similar, but not exact, names.

Move: Move a node from one nodeset to another.

**The Columns**

Action: Dictates the action to take on the row. Includes delete remove a node from a nodeset, split create multiple entries from one node, add create a new node in a nodeset, and merge combine node names into a single entity.

Total Degree:

Frequency: Number of occurrences of a concept.

TF-IDF: Reflects how important a word is to a document in a collection or corpus.

Current Node Name: Contains the text as it appears in the original node.

New Node Name: Contains the text you want to use as a replacement for the text in the Current Node Name column. If the New Node Name is blank that means that it remains the same as the Old Node Name.

Current Node Class: Contains the class as it appears in the original node.
New Node Class: Contains the class you want to use as a replacement.

Current Nodeset Name: Contains the Nodeset Name as it appears in the original node.

New Nodeset Name: Contains the Nodeset Name you want to use as a replacement.

Current Node Type: Used to denote whether the concept is specific item (e.g. President Obama) or a generic item (e.g. American) or leave blank.

New Node Type: Allows the user to change the Node Type of a node.

NOTE: ONLY agent, organization, location, event can have a type.

**Generic and Specific Type**

The generic and specific are the two allowed Node Type values. They provide the users with some additional information on whether this is a universal or general concept or a specific concept. The difference between Specific and Generic can be simply put as the difference between a and the.

Specific: Concepts which reference a specific agent, location or organization. For example: John Doe is a specific agent, CASOS is a specific organization, and USA is a specific location.

Generic: Concepts which are universal and do not point to a specific agent, location or an organization. For example: man is a generic agent, health fund organization is a generic organization, and my room is a generic location.

**Where to Use This File**

This file is used in the Data Management > Meta-Network Clean... function.

**New Change List Support**

Integration of ORA and AutoMap formats are improved by use of the Change Format. Deleting, Merging, and Moving nodes is greatly simplified. ORA and AutoMap both use this format.

**How Is It Used?**

When nodes are deleted, merged, and moved within the Node Editor in ORA, these operations are recorded internally in a Change List that can then be exported. Also, existing change lists can be loaded and applied to the Node Class within the editor.
There is one change list per meta-ontology. For example, editing the Agent : Friends Node Class will modify the change list for the Meta-Ontology Agent. If you move to another meta-network and edit its Agent : Enemy Node Class, then it will also modify the Agent change list. You need to manually clear the change list, as otherwise the changes are just accumulated.

Here is the support in the GUI:

Select a meta-network, expand it in the Meta-Network pane, select a nodeset, and click on the Clean dropdown arrow:

![GUI screenshot](image)

These are the different options:

Deduplication : Opens a dialog that has existed for a while and that lets one find nodes that are duplicates based on the similarity of their IDs or Titles. The nodes can then be easily merged.

Apply change list : Prompts for a change list file and applies it to the Node Class.

View changes : View the record of the node Merge, Move, Delete operations performed to the current meta-ontology. From within this dialog, one can clear the list.

Save changes : Exports the current changes to the Change List format, and this can then be used in AutoMap or applied later in ORA.
Entire Meta-Network: Opens up the Text Analysis Cleaner and allows you to work on the whole meta-network.

NOTE: The Delete, Merge, and Move buttons have been made simple buttons. These otherwise have not been changed.

You can think of the Change List as simply a log of the operations performed on the Node Class during the ORA session.
Correlation can be found in the QAP/MRQAP Analysis report.

Below are two networks which contain the same nodes but different links. Correlation shows what needs to be changed to go from one network to the other. Then the mean and the standard deviation will be presented.

**Network 1**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
Network 2

Both networks are converted into strings. The table shows the differences between the two strings.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**String**

Both networks are converted into strings. The table shows the differences between the two strings.

0111010000100010001111110

0001010000100010010011100

**Calculation**

The report will give the results for their differences.

<table>
<thead>
<tr>
<th>Mean</th>
<th>Std. Dev.</th>
<th>Correlation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.44</td>
<td>0.51</td>
<td>0.60</td>
</tr>
<tr>
<td>0.32</td>
<td>0.48</td>
<td></td>
</tr>
</tbody>
</table>
Cube Analysis

Cube Analysis of communicative power: Concept Embedding

Communication depends on asking questions about how different people use words. It is a way of locating Common Ground.

- Do people use same words
- Do people use same words in same way
- Do people evoke the same concepts
- Do people link the same concepts in the same way
- Are the same disciplines employed
- Are the same journals, trade magazines, etc. read

Three key communicative dimensions.

Intensity/consensus: Weighted degree or number of graphs of individual's mental models or number of reports the tie is present in.

Conductivity: in-degree*out-degree or betweenness

Density: degree

Most words will be low on all three dimensions. Words that stand out on any one dimension will have extra communicative power. Messages containing such words will be more persuasive.
The Cube

Frequency

Betweenness

Total Degree

The Cube
General: Ordinary Word

- sense of frustration
  - maddeningly
  - expansion
  - contradictory evidence

Factoid

- Nov. 22, 1963
  - 4 Density
  - 3 Conductivity
  - 4 Consensus
Kennedy Assassination

Vietnam

Assassinations of RFK & King

Watergate

Iran-Contra

right-wing conspiracy

11 Density
49 Conductivity
2 Consensus

4 Density
16 Conductivity
1 Consensus
Standard Symbol

President

15 Total Degree
120 Betweenness
8 Frequency

Allusion

Grassy Knoll

15 Total Degree
0 Betweenness
8 Frequency
Illustrative Concept

Summary of Cube Analysis

- Texts can be coded as networks
- Networks represent the mental model
- Coding texts as mental models focuses on meaning
- Concepts have position in texts
- Examining positions focuses on communicative power
Delimited Files

Excel, when reading in a flat file (i.e. txt or .csv), is sensitive to the kind of delimiter used. In the American version of excel, it assumes that a comma or tab is used to separate columns. In other versions, it often assumes that a semicolon or tab is used to separate columns. This is because in many other languages the comma is used as a period in showing the price of items.

AutoMap and ORA export data as comma separated and can import comma separated data. This means if you are reading into or reading from a non-American version of excel you may have problems.

Reading in the .csv file into Excel that uses something other than commas will cause the data to appear as a set of text in column A. There are two ways to fix this.

NOTE : And if your data contains commas change to another character before changing the delimiting characters to commas.

First read the file into a text editor and globally change all the delimiting characters to commas.

Second read the file into excel and use the Text to Columns function and use a different delimiter.

Excel Example

Let's start with a simple three line file using semicolons as delimiters.

NOTE : Remember, data can be separated with a variety of characters. This procedure allows you to import data with any of them.

100;apple;red
101;lime;green
102;lemon;yellow

Opening this file in Excel will place each line of text into a single cell. You need to separate this into individual columns.
Select the cells you want to convert then click the Data tab. Click the Text to Columns function.

This brings up the Convert Text to Columns Wizard. Make sure the Delimited radio button is selected. Then click [ Next > ].
Under the Delimiters header make sure the Semicolon box contains a check mark. In the Data preview area it will show you what your data will look like after the conversion. Click [ Next > ].
Lastly you can do some final tweaks to how your data will be converted if you want such as your data format or a different destination. In this example we want the data to be inserted back into the original starting cell. Click [ Finish ].
Each piece of data now resides in a separate cell.

The new file can now be imported into ORA through the Data Import Wizard.
Dynamic Networks

In ORA the primary data object is the meta-network, which is a multi-mode, multi-link, multi-level network. This page describes a container class for grouping meta-networks, the dynamic meta-network. A dynamic meta-network is a structured collection of meta-networks.

Networks are representations of the connections between entities, where entities can represent any real or abstract "thing". The meta-network in ORA structures network data to facilitate dynamic network analysis (DNA) a scientific field that brings together many forms of traditional network analysis:

- DNA looks at multiple networks simultaneously, thus the "meta-network" is the unit of analysis.
- Agent-based modeling and other forms of simulations are often used to explore how networks evolve and adapt as well as the impact of induced changes (interventions) on those networks.
- The connections (links) in the network are not binary; in fact, in many cases they represent the probability that there is a link.

Dynamic meta-networks provide a way of grouping meta-networks together to record network evolution or change.

Dynamic Meta-Network Components

The hierarchy of components that make up a dynamic meta-network, are described below in order from low to high:

Node

A node represents an individual "thing", either material or immaterial, such as a real-world item (person, place, tool), a concept or belief (process, procedure, system) or any other unit of interest (a word, event, geological era). Nodes can have additional information appended as attributes, for example a node representing a person might have an attribute called "Age".

Nodeset

A nodeset is a group of similar nodes (e.g. people, places, knowledge) which can optionally be labeled by a set of common categories (the nodeset class). Multiple nodesets can be assigned to the same nodeset class. For example a representation of a soccer league might use one nodeset per team, with each team nodeset labeled as nodeset class "Agent". All nodes in an ORA meta-network are assigned to nodesets.
and the nodeset class is often used to identify nodesets for specialized analysis techniques.

**Network**

A network shows how the nodes contained in nodesets connect to each other. A link shows a connection or relation between one or two nodesets.

**Meta-Network**

A meta-network incorporates both nodesets and networks into a unit. Intrinsically, the contents of a meta-network are considered to be related although the nature of a relationship is defined by the user. Meta-networks are the foundation for dynamic network analysis (DNA).

A meta-network may be given an optional timestamp, the **meta-network time**.

**Dynamic Meta-Network**

A dynamic meta-network is a container for meta-networks. Constituent meta-networks in a dynamic meta-network generally use the meta-network time value to indicate ordering (although this is not strictly required and some, none or all constituent meta-networks can be timestamped). Dynamic meta-networks facilitate dynamic network analysis, particularly analysis of network change over time.

Certain ORA analytical tools are designed to take dynamic meta-networks directly as input and dynamic meta-networks are often a convenient way of organizing meta-networks. ORA permits users to group meta-networks into dynamic meta-networks and to extract meta-networks from dynamic meta-networks at will.

The conceptual diagram below shows a simple dynamic meta-network changing over time:
In the example above, the six constituent meta-networks represent successive time periods (S1…S6). Each meta-network contains two nodesets: agent and location and two networks: agent x agent and agent x location. The use of meta-networks with a common structure is characteristic of dynamic meta-networks but is not required. During each time interval, the network links change, tracking the connections between agents and locations.

An ORA implementation of the example dynamic meta-network, might look as follows:
Dynamic meta-network shown in the Meta-Network Manager pane.

In the above instantiation of the example dynamic meta-network, the dynamic meta-network is marked with an icon of a clock overlaying a network (△) while the constituent meta-networks are marked with the meta-network icon (□). Each time period is represented by a separate meta-network, named and timestamped as S1, S2, …S6. Each meta-network contains the nodesets Agent and Location which are used to define two networks, Agent x Agent, which shows links between agents and Agent x Location, which shows Agent location. Agents have only one location per period in this example.

Note that the nodeset and network sizes are variable in the instantiation; this is allowed as is a fixed size representation. In the illustration above, during period S1 there are two agents and one location and by period S3, the number has increased to three for each nodeset. The 2D visualizer allows the user to visual the constituent meta-networks in succession.
Useful Dynamic Meta-Network Concepts and Procedures

Meta-Network Time Types

Meta-networks can be timestamped and dynamic meta-networks are routinely constructed from timestamped meta-networks (although this is not an absolute requirement; constituent meta-networks may have no time value assigned). The meta-network time supports two types of time values:

- **Date** – Time values are recorded using the notation of the Gregorian calendar for dates and Coordinated Universal Time (UTC) for time.
- **Period** – Time values are arbitrary strings (e.g. "early", "middle", "late"). Note that ORA organizes time period strings in lexicographical order (also known as dictionary order, a generalization of alphabetical order) so the above example would be ordered as "early", "late", "middle" in the dynamic meta-network.

The duration covered by a meta-network is not encoded (a meta-network might cover observations over the period of a minute or decades, depending on the input data and how the user constructed the meta-network).

See Meta-Network Time Notation for further information.

Aggregation

When creating dynamic meta-networks from timestamped data, ORA will create a meta-network for each distinct time value. Aggregation allows creation of a meta-networks (and dynamic meta-networks) where a range of time are merged into a single meta-network. For instance, it may be desirable to aggregate email messages by day or disease mortality by year.

See Aggregation for further information.

Keyframes and Deltas

A dynamic meta-network contains a series of meta-networks, which are used to represent change. ORA uses two methods to store meta-networks in a dynamic meta-network:

- A Keyframe acts as a starting point, or a snapshot of what the meta-network looks like at any given time. It doesn't care what came before or will occur after. A keyframe is marked with the meta-network icon (●●●) in the meta-network manager.
• A Delta is a set of instructions on how to change the meta-network. It reviews what came before it, applies a set of changes, and displays the revised meta-network. A delta is marked with the delta icon () in the meta-network manager.

A dynamic meta-network may contain keyframe, deltas or a combination of the two. The biggest advantage of deltas is that they require less information (and space) than keyframes. Keyframes contain every node and network for each time slice. Deltas, on the other hand, only store information about individual changes between time slices.

See Deltas and Keyframes for further information.

Creating Dynamic Meta-Networks

Dynamic meta-networks can be created in multiple ways using ORA. There are two general methods.

• Merging Meta-Networks – Meta-networks present in the Meta-Network Manager are merged into a dynamic meta-network. The meta-network time is used to order the meta-networks and aggregation can be performed at dynamic meta-network creation time.

• Direct From Data – Network data is read from files or data sources directly into a dynamic meta-network using the Data Import Wizard, with individual meta-networks created based on time values from the data source. Aggregation can occur as the input data is scanned.

See Create Dynamic Network for further information.

Saving Dynamic Meta-Networks

Dynamic meta-networks can be saved in DyNetML format, which will preserve the complete structure in a single XML format file. Dynamic meta-networks can also be exported in other data formats, such as character delimited files (e.g. CSV) for potential use in other tools but the exported copy will not fully preserve the internal structure of the dynamic meta-network and may produce multiple output files.

Viewing and Changing Meta-Networks

The 2D visualizer allows the user to visual each time period in succession, with manual or automatic progression between the periods.

The ORA editor allows the user to modify dynamic meta-components in the same manner as meta-networks. In addition, meta-networks can be decombined from a dynamic meta-network by simple copy and paste operations.
If you want to copy individual meta-networks (keyframes or deltas) to use as regular meta-networks then:

In the Meta-Network Manager pane:

1) Select meta-networks in the dynamic meta-network.

2) Press Ctrl+c to copy those meta-networks.

3) Select outside the source dynamic meta-network (or close the dynamic meta-network).

4) Press Ctrl+v to copy them into the Meta-Network Manager pane.

NOTE: Deltas will automatically be converted to regular meta-networks (i.e. keyframes) when pasted.
Deltas and Keyframes

A dynamic meta-network contains a series of meta-networks, which are used to represent change. ORA uses two methods to store meta-networks in a dynamic meta-network, keyframes and deltas.

The Difference Between Deltas and KeyFrames

A Keyframe acts as a starting point, or a snapshot of what the meta-network looks like at any given time. It doesn't care what came before or will occur after.

A Delta is a set of instructions on how to change the meta-network. It reviews what came before it, applies a set of changes, and displays the revised meta-network.

For example:

<table>
<thead>
<tr>
<th>Keyframe Representation</th>
<th>Delta Representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial State : Nothing</td>
<td>Initial State : Nothing</td>
</tr>
<tr>
<td>KeyFrame : 3 nodes, 3 links</td>
<td>Delta : +3 nodes, +3 links</td>
</tr>
<tr>
<td>KeyFrame : 6 nodes, 9 links</td>
<td>Delta : +3 nodes, +6 links</td>
</tr>
<tr>
<td>KeyFrame : 6 nodes, 6 links</td>
<td>Delta : -3 links</td>
</tr>
</tbody>
</table>
The biggest advantage of deltas is that they require less information (and space) than keyframes. Keyframes contain every node and network for each time slice. Deltas, on the other hand, only store information about individual changes between time slices.

NOTE: Change in the first keyframe do not affect the following keyframes. But with deltas changes in the initial keyframe are taken into account by following delta.

**The Info Tab**

When you highlight either a meta-network or a delta you will see different information in the Info Tab. A meta-network will display the exact count of nodes, links, and other network information.
The delta, on the other hand, will display only the changes that occurred between itself and the previous meta-network/delta. Displayed are the number of items Added, Modified, and Removed.
Specifying Delta or Keyframe Representation

The representation used for constituent meta-networks in dynamic meta-networks is established when the dynamic meta-network is created.

- **Merging Meta-Networks** – Users can choose between delta and keyframe representation for individual meta-networks.
- **Direct From Data** – The entire dynamic meta-network is represented with either deltas or keyframes based on a user-set parameter. All constituent meta-networks use the same representation.

See [Create Dynamic Network](#) for examples.
Create Dynamic Network

A dynamic meta-network is made up of multiple meta-networks. Dynamic meta-networks can be created in multiple ways using ORA. There are two general methods.

- **Merging Meta-Networks** – Meta-networks present in the Meta-Network Manager are merged into a dynamic meta-network. The network time is used to order the meta-networks and aggregation can be performed at dynamic meta-network creation time.

- **Direct From Data** – Network data is read from files or data sources directly into a dynamic meta-network using the Data Import Wizard, with individual meta-networks created based on time values from the data source. Aggregation can occur as the input data is scanned. Some of the Data Import Wizard methods supporting direct dynamic meta-network creation are:
  - Table of network links
  - Advanced Table
  - Ego network transition table
  - Twitter data – A dynamic meta-network is automatically created, with optional aggregation.
  - VK data – A dynamic meta-network is automatically created, with optional aggregation.
  - JSON data
  - Email – A dynamic meta-network is automatically created, with optional aggregation.

Examples of each import type are shown below:

**Merging Meta-Networks: Raiders of the Lost Ark**

In this example, a set of previously created meta-networks are combined into a dynamic meta-network using the ORA GUI.
I split up The Raiders of the Lost Ark into 27 parts and created a meta-network for each. These contain nodesets for agent, locations, resources, knowledge, and tasks. The Nodeset Names contained in each meta-network are identical but only appear in meta-networks where they have active links.

Example: Belloq, the evil archaeologist, appears in Raiders, peru but is absent until eight meta-networks later in Raiders, cairo-bar.

To create a dynamic meta-network highlight all the meta-networks you want to include. Right-Click on any of them and select Create Dynamic Meta-Network.
In the Dynamic Meta-Network Importer it lists each meta-network, the date, and whether you want it to be a meta-network [check mark] or a delta [no check mark].

Duplicate dates are not allowed and will cause the import to fail. The dynamic meta-network organize the dynamic meta-networks in date/period order.

The far right column is used if you find the need to remove a meta-network before you move on to the creation process. Click the [X] to delete a meta-network before importing.

<table>
<thead>
<tr>
<th>Meta-Network Name</th>
<th>Meta Date</th>
<th>Import as keyframe?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raiders, part 01-Peru</td>
<td>2013-11-01T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 02-New England</td>
<td>2013-11-02T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 03-san Francisco</td>
<td>2013-11-03T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 04-nepal-ravens_salon-1</td>
<td>2013-11-04T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 05-nepal-ravens_salon-2</td>
<td>2013-11-05T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 06-nepal-ravens_salon-3</td>
<td>2013-11-06T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 07-caro-satulls_house</td>
<td>2013-11-07T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 08-caro-streets</td>
<td>2013-11-08T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 09-caro-bar</td>
<td>2013-11-09T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 10-caro-streets</td>
<td>2013-11-10T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 11-caro-salts_house</td>
<td>2013-11-11T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 12-caro-love</td>
<td>2013-11-12T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 13-caro-marions_farm</td>
<td>2013-11-13T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 14-caro-marions_farm</td>
<td>2013-11-14T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 15-caro-marions_farm</td>
<td>2013-11-15T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 16-caro-marions_farm</td>
<td>2013-11-16T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 17-caro-marions_farm</td>
<td>2013-11-17T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 18-caro-marions_farm</td>
<td>2013-11-18T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 19-caro-marions_farm</td>
<td>2013-11-19T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 20-caro-marions_farm</td>
<td>2013-11-20T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 21-caro-marions_farm</td>
<td>2013-11-21T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 22-caro-marions_farm</td>
<td>2013-11-22T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 23-caro-marions_farm</td>
<td>2013-11-23T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 24-caro-marions_farm</td>
<td>2013-11-24T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 25-caro-marions_farm</td>
<td>2013-11-25T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 26-caro-marions_farm</td>
<td>2013-11-26T12:00:00-05</td>
<td>✓</td>
</tr>
<tr>
<td>Raiders, part 27-caro-marions_farm</td>
<td>2013-11-27T12:00:00-05</td>
<td>✓</td>
</tr>
</tbody>
</table>
When finished you will see an new meta-network in the Meta-Network Manager pane. This icon has the clock overlay signifying it is a dynamic meta-network.

The Keyframe meta-networks carry the standard meta-network icon (>Create) created from the items check marked in the Importer window. In the main editor page the statistics will be displayed: Source count, Nodeset count, Node count, Link count, Network count, and Total density.

The Deltas carry the green and orange circle icons (Create). When selected, the main editor page the Operation Statistics will be displayed on the main editor page. This consists of additions, modifications, and deletions of nodesets, nodes, links, and networks.

Direct from Data: Welsh Canals

Using the ORA Advanced Table format, a single input file is used to create a dynamic meta-network of the Welsh canal network as it evolves over time (the data reflects the descriptions present in Wikipedia in 2016). The input file is used to create:

- A dynamic meta-network "Welsh Canals" containing:
  - One meta-network per decade with:
    - "Location" nodeset of places with the attributes:
      - Canal (may contain multiple values since more than one canal may serve a location)
      - Latitude
- Longitude
- "Route" matrix (Location x Location) coding canal connections

For a detailed description of the input file and import process, see the [Advanced Table](#) description.

The data file contains records indicating canal links between places, along with the time(s) the link existed.

<table>
<thead>
<tr>
<th>Columns in the Welsh Canals Dynamic Meta-Network Input File</th>
<th>Used for</th>
<th>Content and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canal</td>
<td>Attribute</td>
<td>Name of canal.</td>
</tr>
<tr>
<td>Canal Nodeset</td>
<td></td>
<td>Set to &quot;Organization&quot;. Not used in this example. Available to create a canal to place network.</td>
</tr>
<tr>
<td>Canal Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Canal&quot;.</td>
</tr>
<tr>
<td>Canal Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Text&quot;.</td>
</tr>
<tr>
<td>Place 1 Attribute Name</td>
<td>Attribute</td>
<td>Name of a location on a canal. Case sensitive and must match all other instances in the Place 1 and Place 2 columns. Creates nodeset entries.</td>
</tr>
<tr>
<td>Place 1 Nodeset</td>
<td>Attribute, Network</td>
<td>Set to &quot;Location&quot;.</td>
</tr>
<tr>
<td>Place 1 Latitude Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Latitude&quot;. (Default name for geographic visualizer.)</td>
</tr>
<tr>
<td>Place 1 Latitude Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Number&quot;.</td>
</tr>
<tr>
<td>Place 1 Latitude Value</td>
<td>Attribute</td>
<td>Decimal latitude value for Place 1.</td>
</tr>
<tr>
<td>Place 1 Longitude Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Longitude&quot;. (Default name for geographic visualizer.)</td>
</tr>
<tr>
<td>Place 1 Longitude Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Number&quot;.</td>
</tr>
<tr>
<td>Place 1 Longitude Value</td>
<td>Attribute</td>
<td>Decimal longitude value for Place 1.</td>
</tr>
<tr>
<td>Place 2 Attribute, Network</td>
<td>Name of a location on a canal. Case sensitive and must match all other instances in the Place 1 and Place 2 columns.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Nodeset Attribute, Network</td>
<td>Set to &quot;Location&quot;. Redundant to Place 1 Nodeset, included for clarity.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Attribute Name Attribute</td>
<td>Set to &quot;Latitude&quot;. (Default name for geographic visualizer.) Redundant to Place 1 Latitude Attribute Name, included for clarity.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Attribute Type Attribute</td>
<td>Set to &quot;Number&quot;. Redundant to Place 1 Latitude Attribute Type, included for clarity.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Value Attribute</td>
<td>Decimal latitude value for Place 2. (Not redundant; Place 2 may or may not be duplicated in the Place 1 column.)</td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Attribute Name Attribute</td>
<td>Set to &quot;Longitude&quot;. (Default name for geographic visualizer.) Redundant to Place 1 Longitude Attribute Name, included for clarity.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Attribute Type Attribute</td>
<td>Set to &quot;Number&quot;. Redundant to Place 1 Longitude Attribute Type, included for clarity.</td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Value Attribute</td>
<td>Decimal longitude value for Place 2. (Not redundant; Place 2 may or may not be duplicated in the Place 1 column.)</td>
<td></td>
</tr>
<tr>
<td>Network Network</td>
<td>Name of network, &quot;Route&quot; in this example (which contains a single network).</td>
<td></td>
</tr>
<tr>
<td>Link Weight Network</td>
<td>Link value for segment, set to 1.</td>
<td></td>
</tr>
<tr>
<td>Dates Dynamic Network</td>
<td>Dates for existence of given a canal segment, by decade. Uses first and last year and the first year of each intervening decade. For example &quot;1790;1800;1810;1818&quot;. Note that gaps in service of less than one decade will not be visible. Since the Advanced Table importer can</td>
<td></td>
</tr>
</tbody>
</table>
aggregate dates, the date values could be at lower level of granularity (e.g. year).

| Notes | Miscellaneous information, not used here but could be added as an attribute. |

To input the file, use the Data Import Wizard's Advanced Table option to define the networks and attributes contained in the input file. Nodesets and matrices will automatically be created as necessary. In the example case, a dynamic network containing three attributes (appended to one nodeset) and one network per time period will be created.

In the first step, the input files is identified, the networks to create are defined, the location of and format of dates is specified (dates values are years) and the aggregation period is set (decades). In addition, the type of meta-network built is specified as keyframe (default) (in the image below, Create deltas is unchecked).

![Image of Import Data into ORA-NetScenes dialog box]

Next, any attributes required defined. In this instance, since the canal network has a physical manifestation, location data is added as attributes to the places that form nodes on the networks.
After the input data has been described and the structure of the desired dynamic meta-network specified, the Data Import Wizard will then process the data in the input file, inserting it into an existing or new dynamic meta-network as nodes, attributes and networks. Notice that not all the fields in the data file are used. ORA will simply ignore unneeded data.

The 1830 Location nodeset in the Welsh Canals dynamic meta-network example after import, with attributes:
The 1830 Route matrix in the Welsh Canals example (using the ORA editor's list view, with source and target place names):

Visualization of a portion of the Welsh Canals example: 1830 in southern Wales near Pembrey and Swansea.
Meta-Network Time Notation

Meta-networks can be timestamped and dynamic meta-networks are routinely constructed from timestamped meta-networks (although this is not an absolute requirement; constituent meta-networks may have no time value assigned in some instances). The meta-network time supports two types of time values:

- **Date** – Time values are recorded using the notation of the Gregorian calendar for dates and Coordinated Universal Time (UTC) for time.
- **Period** – Time values are arbitrary strings (e.g. "early", "middle", "late"). Note that ORA organizes time period strings in lexicographical order (also known as dictionary order, a generalization of alphabetical order) so the above example would be ordered as "early", "late", "middle" in the dynamic meta-network.

The duration covered by a meta-network is not encoded (a meta-network might cover observations over the period of a minute or decades, depending on the input data and how the user constructed the meta-network).

**Manipulating Meta-Network Times Using the ORA GUI**

The meta-network time can be accessed in the ORA editor by selecting the meta-network in the Meta-Network Manager. The editor pane will display the currently set time value in the Meta-Network Time field.

**Setting a Date or Period Value**

While the procedure to access and change the meta-network time varies depends on whether the meta-network is currently part of a dynamic meta-network, setting the date or period value is always done in the same manner:

**Setting a Date**

A date value is set by using the controls provided to set the year, month, day and time values.
Date controls highlighted in the Change Keyframe Date dialog.

**Year** – Use the up/down arrows to change the year value by one or type the year directly into the field. All years are assumed to be in the Common Era (CE) (also known as the Current Era).

**Month** – Select a month from the pulldown menu or type the month name which will search for the month letter by letter (e.g. typing 'j' will bring up "January", 'ju' will show "June" and 'jul' will select "July"). Repeating the initial letter will cycle through the months starting with that letter (e.g. typing 'jjj' with cycle through "January", "June" and "July").

After the month is set, ORA will check the current day value and will set the day to ‘1’ if the value is too large for the selected month (e.g. if the date is currently January 31, selecting the month September will change the day value to 1; selecting July will not change the day). The allowable value for February varies depending on the year to account for leap years.

**Day** – Enter the time value using 24 hour notation. The time value can be set by typing a value in the time field or by using the up/down arrows. For direct entry, set the hour values from 00 to 23 followed by minutes and seconds, separated by colon (':') characters. The up/down arrows will change the currently active field value by one (for example, if the cursor is currently in the minutes field, the minute value will be incremented). If no field is selected, the hours value is incremented.

Hour, minute and second values may be any integer value. ORA will automatically adjust values to the correct range, increasing higher values as needed. For instance if the value 121 is entered in the seconds field, ORA will increase the minutes field by two and set the seconds value to 1; the hour value will be incremented if the minutes value rolls over (however, the hours field will roll over at midnight without affecting the day of month value).

**NOTE:** When entering a time value by typing values in the editor pane into an input field, the cursor must leave the field, either by use of the enter key or selecting another field to record the change. Selecting another item in the Meta-Network Manager pane before this is done will silently restore the original value.
Setting a Period

The period value is a single field containing a string and is straightforward to set or change.

<table>
<thead>
<tr>
<th>Meta-Network Name</th>
<th>Raiders, part 01-Peru</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meta-Network Time</td>
<td>Part 01 - Raiders - Peru</td>
</tr>
<tr>
<td>Filename</td>
<td></td>
</tr>
</tbody>
</table>

*Period field highlighted in the ORA editor pane.*

Type a string value in the text field. Note that ORA organizes time period strings in lexicographical order (also known as dictionary order, a generalization of alphabetical order) so the above example would follow "Part 00…" and proceed "Part 02…" in the dynamic meta-network.

Manipulating Meta-Network Time Values

The procedure to change the meta-network time depends on whether the meta-network is currently part of a dynamic meta-network.

For a meta-network which is not currently part of a dynamic meta-network, the meta-network time information can be directly manipulated:

**Time Operations for a Standalone Meta-Network**

To set the Meta-Network Time to a Date value when no time value is set.

1. Select Date if not already selected.
2. Click the [Click to create… ] button to display the time controls.
3. Use the controls provided to set year, month, day and time (see Setting a Date or Period Value above).

To set the Meta-Network Time to a Period value when no time value is set.

1. Select Period if not already selected.
2. Type a string value in the text field (see Setting a Date or Period Value above).

To change an existing Meta-Network Time.

- For Date values:
  1. Use the controls provided to set year, month, day and time (see Setting a Date or Period Value above).
- For Period values:
1. Type a string value in the text field (see Setting a Date or Period Value above).

To clear the Meta-Network Time.

• For Date values:
  1. Click the X icon to the right of the time controls.

• For Period values:
  1. Change the time type to Date by selecting the Date checkbox to the right of the time controls.
  2. Click the X icon to the right of the time controls.

To change the time type and value.

• To change Date values to Period:
  1. Select the Period checkbox to the right of the time controls.
  2. Type a string value in the text field (see Setting a Date or Period Value above).

• To change Period values to Date:
  1. Select the Date checkbox to the right of the time controls.
  2. Use the controls provided to set year, month, day and time (see Setting a Date or Period Value above).

Dynamic meta-networks require that constituent meta-networks use a single time type, either Date or Period. However, time values can be altered:

NOTE: Meta-Networks can be copied outside a dynamic meta-network, at which point the full range of time options are available. Such extracted meta-networks can then be assembled or inserted into dynamic meta-network provided that the time values match the meta-network.

**Time Operations for Meta-Networks in a Dynamic Meta-Network**

To set the Meta-Network Time value when no time value is set.
Follow the procedure for changing an existing meta-network time, below. The time type will be automatically set to match the rest of the meta-networks.

To set the Meta-Network Time to a Period value when no time value is set.

1. Select Period if not already selected.
2. Type a string value in the text field (see Setting a Date or Period Value above).

To change an existing Meta-Network Time.

• For Date values:
  1. Select the target meta-network in the Meta-Network Manager pane.
  2. Click the [ Change ] button. A dialog will open with the controls to
adjust the appropriate time type.
3. Use the controls provided to set year, month, day and time (see Setting a Date or Period Value above).

• For Period values:
  1. Select the target meta-network in the Meta-Network Manager pane.
  2. Click the [ Change ] button. A dialog will open with the controls to adjust the appropriate time type.
  3. Type a string value in the text field (see Setting a Date or Period Value above).

To clear the Meta-Network Time.
Not allowed.
To change the time type and value.
Not allowed.

Meta-Network Times from Outside ORA
ORA can read time data from a variety of time sources. For data sources with predefined formats such as Twitter data, the input time formats are predetermined by ORA. For user provided data, the user must identify the location of the time information and provide a date and time pattern. A data file must use a single time format. Generally ORA provides a number of predefined date formats for user convenience. Users can customize date formats in some instances.

In the Data Import Wizard's provides the following predefined time formats:

<table>
<thead>
<tr>
<th>Time Format</th>
<th>Time Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>yyyy-MM-dd'T'HH:mm:ssX</td>
<td>Date</td>
<td>2001-07-04T12:08:56-0700</td>
</tr>
<tr>
<td>yyyy-MM-dd HH:mm:ssX</td>
<td>Date</td>
<td>2001-07-04 12:08:56-0700</td>
</tr>
<tr>
<td>yyyy-MM-dd HH:mm:ss</td>
<td>Date</td>
<td>2001-07-04 12:08:56</td>
</tr>
<tr>
<td>yyyy-MM-dd</td>
<td>Date</td>
<td>2001-07-04</td>
</tr>
<tr>
<td>yyyy-MM</td>
<td>Date</td>
<td>2001-07</td>
</tr>
<tr>
<td>MM/dd/yyyy</td>
<td>Date</td>
<td>07/04/2001</td>
</tr>
<tr>
<td>EEE MMM dd HH:mm:ss ZZZZ yyyy</td>
<td>Date</td>
<td>Sat Jul 04 12:08:56 -0700 2001</td>
</tr>
<tr>
<td>Time period string</td>
<td>Period</td>
<td>Mesozoic</td>
</tr>
</tbody>
</table>

For the Date time type the time formats consist of letters ('A' to 'Z' and 'a' to 'z') which are interpreted as pattern letters representing elements of a date. All other characters are not interpreted; instead they are used to match the input string. Text can be quoted with single quotes to avoid interpretation (two single quotes "'" represent a single quote in the input).
The following table summarizes the format elements used for dates (Time period string values are treated as uninterpreted text in all instances):

<table>
<thead>
<tr>
<th>Character</th>
<th>Date or Time Element</th>
<th>Format</th>
<th>Examples</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Date Separator</td>
<td>Literal</td>
<td>/</td>
<td>Not interpreted, must appear in input.</td>
</tr>
<tr>
<td>'</td>
<td>Text</td>
<td>Quoted Text</td>
<td>'T'</td>
<td>Not interpreted, input must contain a quoted text (e.g. T in this example). Paired single quotes (') prevents interpretation of enclosed text. &quot;' &quot; represents a single quote in input.</td>
</tr>
<tr>
<td>y</td>
<td>Year</td>
<td>Year</td>
<td>1996; 96</td>
<td>If the number of pattern letters is more than two, the year is interpreted literally, regardless of the number of digits. For two or fewer letters, dates are adjusted to be within 80 years before and 20 years after the time the data import is started if the input is a two digit number and literally otherwise.</td>
</tr>
<tr>
<td>M</td>
<td>Month in year</td>
<td>Month</td>
<td>July; Jul; 07</td>
<td>If the number of pattern letters is three or more, the month is interpreted as text; otherwise, it is interpreted as a number.</td>
</tr>
<tr>
<td>d</td>
<td>Day in month</td>
<td>Number</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Day name in week</td>
<td>Text</td>
<td>Tuesday; Tue</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Hour in day (0-23)</td>
<td>Number</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>m</td>
<td>Minute in hour</td>
<td>Number</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>s</td>
<td>Second in minute</td>
<td>Number</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Time zone</td>
<td>RFC 822 time zone</td>
<td>-0800</td>
<td>See: <a href="https://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html#rfc822timezone">https://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html#rfc822timezone</a></td>
</tr>
</tbody>
</table>
Format String Customization

Date format strings are customizable by editing after selection, which may permit input of files containing date formats not otherwise listed by removing or reordering elements.

In this example, "yyyy-MM" was selected, then edited to "yyyy" to match the input file.

After selection the Date format: field is set to the predefined "yyyy-MM" value.

After manual editing to remove "-MM" the format string indicates only a year value is present. See Import Advanced Table for the full example.

ORA’s date and time patterns are derived from those defined for the Java programming language's SimpleDateFormat class. In addition to the simple modifications described above, the user can enter legal date and time pattern using the conventions described for the Java SimpleDateFormat class, see https://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html. The pattern can be typed or pasted into the appropriate field, replacing a predefined pattern.

Multiple Time Values in a Single Observation

ORA permits multiple time values for a single observation in input files. ORA processes such records as if a separate records exist for each date. This notation is more compact and can simplify creating and updating information. The semi-colon character (;) is used as a date separator.

As an example, the Welsh Canals input contains multiple dates indicating the time a given canal segment was in operation on the decade level (each date indicates the first year a canal segment was open during the decade or the year the segment closed).
Dates may be continuous or discontinuous. For instance, in the Welsh Canal example, the Neath and Tennant Canal segment between Briton Ferry basin and Giants Grave wharf opened in 1795, closed in 1934 and reopened in 1990, which is represented as:

The image above wraps the date field for presentation purposes. In practice the dates would be on the same line in an input file.

**Aggregation**

When creating dynamic meta-networks from timestamped data, ORA will create a meta-network for each distinct time value. Aggregation allows creation of a meta-networks (and dynamic meta-networks) where a range of time are merged into a single meta-network. For instance, it may be desirable to aggregate email messages by day or disease mortality by year.

ORA aggregates by multiples of standard time units:

- **Year**
- **Month**
- **Week - Sunday Start**
- **Week - Monday Start**
- **Day**
- **Hour**
- **Minute**
- **Second**
WARNING: Aggregation cannot be reversed. Do not remove input meta-networks until the dynamic meta-network contents have been verified.

Aggregation can be performed when a dynamic meta-network is created by the Data Import Wizard or on an existing dynamic meta-network.

**Aggregating Existing Dynamic Meta-Networks**

Aggregation creates a new dynamic meta-network by aggregating keyframes/deltas from an existing dynamic meta-network (the source dynamic meta-network is not changed).

First select a single dynamic meta-network on the Meta-Network Manager pane and right-click to bring up the context menu:

Select the Aggregate… option on the context menu to bring up the Aggregate dialog:
The following options are available:

None - When checked no aggregation occurs.

By period - Check to perform aggregation using the specified arguments.

**Time value** - Enter a numeric value for the number of time unit in an interval. (Set to "1" by default.)

**Time unit** - Select the time unit for aggregation from the pulldown list.

- Year
- Month
- Week (starting Monday)
- Week (starting Sunday)
- Day
- Hours
- Second

Enter interval with:

- Empty meta-network
- Begin date meta-network

Combine meta-networks by: Select method to combine meta-networks into aggregated meta-networks.

- Union - Include all nodes and links that appear in **any** of the aggregated meta-networks.
Intersection - Include only nodes and links that appear in all aggregated meta-networks.

Include empty aggregated meta-networks - Check to retain empty meta-networks, uncheck to eliminate meta-networks with no content.

Click the [ OK ] button to perform aggregation. (Alternatively use the [ Cancel ] button to cancel aggregation and close the dialog.)

**Aggregation During Data Import**

In for many types of data, the Data Import Wizard can perform aggregation while reading data from files or other sources. By default, aggregation is not performed. For example, the Advanced Table importer allows aggregation as an option during file reading:

**Advanced Table aggregation controls**

Aggregate by… Select to define a time interval to group together entries (e.g. group messages time-stamped down to the minute into a network for each day). A meta-network is created for each time interval. (Selected for this example.)

**Enter time value** – enter a numeric value. (Set to "10" for the example.)

**Enter time unit** – select one of the following time units (Year(s) was selected for the example.):

- Year(s)
- Month(s)
- Week(s) - Sunday Start
- Week(s) - Monday Start
- Day(s)
- Hours(s)
- Minutes(s)

After data import, the resulting dynamic meta-network has a keyframe meta-network for each decade:
See [Import Advanced Table](#) for the full import example

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1770-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1780-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1790-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1800-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1810-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1820-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1830-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1840-01-01</td>
<td>00:00:00</td>
</tr>
<tr>
<td>1850-01-01</td>
<td>00:00:00</td>
</tr>
</tbody>
</table>
Exponential Random Graph Models (ERGM)

Exponential Random Graph Models (ERGM), also known as p* models, are a family of statistical models that help analyze the structure and properties of social and other networks. There are other well known techniques to describe the structural properties of a network such as centrality, density etc. As opposed to these techniques which describe only the network for which they are measured, ERGM's try to describe all possible networks with the same statistical properties as the current one. The other alternative networks may or may not have the same structure, but the underlying statistical model that generates them is the same as the observed network.

The networks that are being studied today are substantially larger in structure for example, the World Wide Web, Internet, communication networks, food web networks, etc which have millions and even billions of nodes. It is very hard to visualize the shape and structure of such networks, even with modern advances in computing technology. In absence of reliable visualization techniques, statistical modeling techniques can provide an answer by quantifying large networks. Networks with similar properties will have similar statistical models. This change in scale also makes traditional questions like, which node's removal will affect the connectivity in the network the most, largely irrelevant. For large scale networks a question which makes more sense is what percentage of nodes when removed would significantly affect network connectivity? (Newman, 2003). Statistical modeling of networks will allow us to answer this question.

ERGMs were initially introduced to study social networks but since then have found their application to networks generated from several different domains such as epidemiology, telecommunications, political science etc. One point to remember while using ERGM models is that a network is modeled as a single multivariate observation which limits them from being used for modeling networks over time. In addition the modeling by ERGM is limited to networks with binary edges only. Hence networks with non binary edges should be converted to binary valued edges before using ERGM. The coding rule for the conversion may not always be obvious. The other major limitations of ERGM models are that they are very sensitive to missing data and suffer from degeneracy problems. Degeneracy occurs when the derived model is highly unlikely to have generated the network hence the ERGM cannot be computed. In many cases degeneracy can be circumvented by carefully specifying the components of the model to be estimated as opposed to using ERGM with the default set of controls.

Exponential random graph models have the following form:
Where $X$ is a random graph consisting of $n$ nodes and $x$ is the observed graph. The assumption of this model is that the structure of the observed graph $x$ can be derived from a known vector of graph statistics, $s(x)$ and the associated vector of model parameters $\theta$. The parameter $c(\theta)$, is a normalizing constant where

$$c(\theta) = \sum_{\text{all possible graphs } x} \exp\{\theta^t s(x)\}$$

All exponential random graph models are of the form in equation (1), which describes a general probability distribution of graphs with $n$ nodes. The particular probability for observing the graph $x$ is dependent on its statistics $s(x)$ and on $\theta^t$ for all configurations in the model. Configurations include ties, triads and are these dependence assumptions are important because they pick different configurations as relevant to the model and also because they constrain the possible configurations possible in the model (Robins, Pattison, Kalish, & Lusher, 2007). The simplest dependence assumption is the Bernoulli random graph distributions where the edges are assumed to be independent whereas more complex ERGMs incorporate node level effects in the configurations. This flexibility in dependence assumptions allows for greater variability in the statistical modeling depending on the requirements and needs of the end user using the ERGM technique.

References


Fast Fourier Transform

What does the Fourier Transform do? Given a color swatch, it finds the base colors.

How? Run the color swatch through filters to extract each base color.

Why? A list of colors are easier to analyze, compare, and modify than the swatch itself.

How do we get the swatch back? Blend the base colors.

In essence The Fourier Transform extracts each "cycle ingredient" from a time-based signal (the cycle strength, delay & speed), resulting in a final "cycle recipe". It changes it from one large amount of a mixture to a list of individual ingredients.

Filters

This is a change of perspective. You change from the notion of a single quantity to the amount of something in something else. It changes from What are you looking at? to How was it made?

In other words, What are the component Parts?

And why do it this way? Because it is easier to categorize, compare, modify, and replicate than the original object in question.

Let's take a look at a color swatch. You can't tell what colors go into making this particular swatch. You could guess, but it probably wouldn't be accurate. You'd have to guess about the amounts of Red, Green and Blue in the swatch.

But if you had a way of filtering out each of the colors used to make that swatch, then you could determine exactly what colors went into creating it in the first place. Then you could run the original color first through the red filter [to reveal the amount of units of red are used], then the green, then the blue.
<table>
<thead>
<tr>
<th>Filters</th>
<th>Red Filter</th>
<th>54 units of red</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Filter</td>
<td>220 units of green</td>
<td></td>
</tr>
<tr>
<td>Blue Filter</td>
<td>136 units of blue</td>
<td></td>
</tr>
</tbody>
</table>

Now that you have the breakdown of the three colors used, you could successfully recreate that swatch color.

**Things To Remember**

Even though this sounds simple enough, there are a few things that you need to keep in mind.

Filters must be independent: The red filter will only find the red parts. Adding more green or blue will not affect the amount of red it finds. That would only change the starting color.

Filters must be complete: You need a filter for each part. If the blue filter was left out, the resultant colors from the red and green filters would combine to create a different color.

The individual parts must be combinable: Once separated, the colors can be re-combined to create that color again with no issues. But a cookie run through a set of filters to determine its ingredients could not be readily recombined to make a cookie as there are other processes that are needed to make the cookie.
Folding Math

Folding a Network means multiplying the network by its transpose. And that when one folds a two-mode network (e.g., agent x organization) the diagonal gives the number of organizations each agent has. The off-diagonal contains the organizations which the agents have in common.

NOTE: A network can be folded by highlighting the network in the Meta-Manager pane. Right-Click on the network and select Fold Network.

Here is a simple two-mode network agent x organization I have the following values:

<table>
<thead>
<tr>
<th></th>
<th>Club A</th>
<th>Club B</th>
<th>Club C</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Izy</strong></td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td><strong>Jane</strong></td>
<td>5</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td><strong>Karl</strong></td>
<td>4</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

**Original Network**

<table>
<thead>
<tr>
<th></th>
<th>Izy</th>
<th>Jane</th>
<th>Karl</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Izy</strong></td>
<td>104</td>
<td>30</td>
<td>12</td>
</tr>
<tr>
<td><strong>Jane</strong></td>
<td>30</td>
<td>34</td>
<td>20</td>
</tr>
<tr>
<td><strong>Karl</strong></td>
<td>12</td>
<td>206</td>
<td>52</td>
</tr>
</tbody>
</table>

The question people will have is, "How can Izy have a self loop of 104, Jane Self Loop of 34, and Karl Self Loop of 52?"

**Transpose of Original Network**

First you need the transpose of your original network.

<table>
<thead>
<tr>
<th></th>
<th>Izy</th>
<th>Jane</th>
<th>Karl</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Club A</strong></td>
<td>0</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td><strong>Club B</strong></td>
<td>2</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td><strong>Club C</strong></td>
<td>10</td>
<td>3</td>
<td>0</td>
</tr>
</tbody>
</table>

And finally, the math.
Linear Algebra

It's part of a the linear algebra operation called the inner-dot product of the first row and column vector.

For Izy at row 1 col 1, the value after folding is \([0 \ 2 \ 10] \ast \ [0 \ 2 \ 10]'\), or \(0 \ast 0 + 2 \ast 2 + 10 \ast 10 = 0 + 4 + 100 = 104\).

Now let's take a look at the value from Izy to Jane (30), which is the dot product of the 1st row times the 2nd col, or \([0 \ 2 \ 10] \ast \ [5 \ 0 \ 3]' = 0 \ast 5 + 2 \ast 0 + 10 \ast 3 = 0 + 0 + 30 = 30\).

This process continues for all cells.

The short of this is, The self-loop is the sum of the squares of all their ties.
Gower's Method

Gower's method (Gower, 1971), also known as Gower's coefficient, Gower's formula, Gower's general similarity coefficient or Gower's distance measure is a frequently used measure of proximity for mixed data types. In ORA, Gower's method provides a way to compare objects where each object is characterized by features/attributes/values, etc. regardless of the data type.

Description

If comparison features are all continuous numeric values, such salary, then we could compare objects just by computing the correlation between two object's feature values.

But what if the feature values are categorical? For instance, what if the feature of interest is Education_Level = {HighSchool, College, Masters, PhD}. I could assign numeric values and then run a correlation, such as HighSchool=1, College=2, Masters=3, PhD=4, and then correlate. But I might instead want to say, "If two people have the exact same value in Education_Level, then increase their similarity by 1, otherwise by 0". This is an example of a categorical numerical variable.

This distinction becomes more clear when categorical values are text based with no obvious ordering which would map to numerical values, such as Home_Town={Boston, Portland, SanFrancisco}. In this case I just want to increase similarity by 1 for an exact match between objects, or 0 if they are not.

Gower's method allows the user to choose one or more nodeset attributes in ORA regardless of data type to measure the similarity (or dissimilarity) between nodes (most typically of nodeset type agent or organization) by handling mixtures of numeric and categorical (either numeric or text) variables.

When to Use Gower's Method

Users need to decide when to use Gower's versus the traditional shared counts option. In general you should use Gower's if your node data is all continuous variables or a mix of categorical and continuous variables. If you your node values are all categorical, or continuous values that can be meaningfully binned into categories, you should use the traditional shared counts.

References

Hamming Distance

The Hamming Distance of two networks (of the same dimension) is the number of times a link exists in one network but not in another. This count can then be normalized by dividing by the number of possible links. Link values are ignored; only the existence or non-existence of links is used.

Hamming Distance can be found in the Key Entities Ranking report.

Example: consider the two networks below which are both defined on the nodes A, B, C, D, and E. For each network there is a visualization and adjacency matrix representation of the links.

Network 1

![Network 1 Diagram]

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
Network 2

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

**Binary String**

We will compute the hamming distance by comparing each cell of the adjacency networks. We could compare each of the corresponding cells in the two matrices, or for convenience, we have concatenated the rows of the matrices into vectors which we can easily compare:

0111010000100010000111110

0001010000100010010011100

**Calculation**

There are five (5) differences in the binary string: the unnormalized hamming distance is 5.

There are a total possible 20 links (assume that diagonal links are not possible, and that links are directed): the normalized hamming distance is 5/20 = .20 or 20%.
Inferences Matrices

Questions and Answers about Inference Matrices

Question: You have a matrix defined as \[ AK \times AK^T \] and end up with an Agent matrix but with inferences based on the knowledge matrix. What information can you get from this? For example, what if \( a(ij) = 1 \). Does that means that agent \( i \) and agent \( j \) are connected by a common knowledge? Are there any other uses for the inference matrices? Any deeper information we can gather from them? Are there metrics that are applicable to them?

Answer: These often go under two mode metrics. See also Command and Control for more information.

Question: If, in the above example, the AK matrix is not a boolean, but rather has values from \( 0 \to n \), showing the strength of the tie between that agent \( i \) and knowledge \( j \). When we look at the inference matrix, some of the values in the matrix are bound to be \( > 1 \). Does this imply that the tie between agent \( i \) and agent \( j \) is greater if there is a value \( > 1 \), or should the inference matrix be thought of as a boolean \( 0, 1 \) no matter what the value in the matrix after the matrix multiplication?

Answer: It is OK to have cell values greater than 1. It is also OK to binarize it. It just depends on what you want to look at.

Question: Are there any affects that need to be watched for when multiplying a directed and undirected meta matrix?

Answer: If you multiply a direct and an undirected it becomes directed.

Question: Do we lose properties, gain them? Is the resultant network directed or undirected (which property is dominant)?

Answer: If you don't want direction to matter you can always symmetrize and tell ora to treat it as undirected.
Question: Directed mean it matters which node is the source and which is the target. Symmetric means that for any network $H$, $H_{ij}=H_{ji}$. Asymmetric means $H_{ij}$ does not necessarily equal $H_{ji}$.

Answer: An undirected network is symmetric. A symmetric network is not necessarily undirected. A symmetric but directed network that contains $H_{ij}$ and $H_{ji}$ are treated as two different ties just of the same value. If it is symmetric and undirected $H_{ij}=H_{ji}$ and this is treated as a single tie.
Large Meta-Networks

Description

There's always a question as to the maximum size for a meta-network in ORA. That depends on a number of items.

First it depends on your machine. Extremely large networks (networks containing $10^6$ nodes) have been run successfully on 64-bit multi-core machines.

It is also about the amount of memory in the machine. The more you have the better it is. It helps make very big networks are doable.

Also, if it is taking forever to run simple reports, you may want to go to Analysis > Measures Manager... and opt out some of the slow metrics, such as information centrality, if you are not particularly interested in those.
An ontology is defined as the group of classes in which almost every concept and phrase can be classified depending on the context in which the concept/phrase is used in a particular sentence or a paragraph. For example: "USA" can be classified as a location or an organization, depending on the context where the word occurs.

ORA-NetScenes defines a standard MetaOntology of classes which are used to classify the nodesets used in meta-matrices. Many ORA features depend on this MetaOntology to discriminate and identify nodes for analytical and visualization purposes.

**Standard Nodeset Classes**

The eleven nodeset classes can be defined as follows:

1. **Agent** identifies individual decision makers. The most common type of decision makers is people. However, this category could also be used for other types of actors such as robots or monkeys. A single Agent represents any person: a family member, a Roman soldier, Soothsayer, Calpurnia, Cicero, any historical figure, a terrorist, or a teacher.

2. **Resource** identifies products, materials, or goods that are necessary to perform Tasks, Events, and Actions. A Resource could literally be a dagger, a cloak, a crown, a short sword, a computer, money, bombs, tools, or books.

3. **Knowledge** describes cognitive capabilities and skills. Knowledge could be Trigonometry, History, English, Economics, the science of DNA, or the knowledge about how to perform a surgery or to build bombs.

4. **Task** describes well defined procedures or goals. A Task could be any process in a company, e.g., product development or administration, but also the plan to kill Caesar.

5. **Organization** identifies collectives of people that try to reach a common goal. An Organization could be a specific company, the United Nations, or the government of a country.

6. **Location** includes geographical positions at any aggregation level that describe places or areas. A Location could be 1600 Pennsylvania Avenue in Washington, London, Florida, The Middle East, Earth, or Mars.
7. **Event** identifies occurrences or phenomena that happen. An Event could be the JFK Assassination, the 2014 FIFA World Cup, a wedding, a funeral, or an inauguration. Specific events are one time occurrences with a specific date, such as the 9-11 terrorist attacks on the United States.

9. **Belief** identifies any form of religious or other conviction. A Belief could be faith that there is a god, or that there are many gods, or that that Earth is flat. Some beliefs are signaled by sentiment such as "war is bad."

10. **Action** identifies the process of doing something. An action could include driving to a store, submitting a request or activating a machine.

11. **Unknown** is used when a node is not yet classified into one of the above classes.

Groups, also referred to as meta-nodes, are any categorization of nodes into a cluster. Groups are defined by one or more of the grouping algorithms.

**Example**

Consider a software company with employees, skills, and tasks. The employees would be contained in an Agent nodeset, the skills in a Knowledge nodeset, and the tasks in a Task nodeset.

**Standard Node Types**

Nodes in some classes can have an additional called **node type** that has the value either **generic** or **specific**. This indicates whether the node models a general entity, or a specific or one-time entity. Only these nodeset classes can have node type: agent, organization, event, and location.

The following are examples of generic and specific nodes for each nodeset class:

- **Agent-Generic**: a general subject; e.g. American, girl, child, nurse, president.
- **Agent-Specific**: a specific or unique subject; e.g. George Washington, Red Deer 0001012.
- **Organization-Generic**: e.g. a political party
- **Organization-Specific**: e.g. The Republican Party
- **Event-Generic**: general happenings, e.g. poker night, dinner with friends
- **Event-Specific**: one-time happenings or special events; e.g. the assassination of John F. Kennedy or the 2004 Pacific Tsunami
Location-Generic: e.g. a city, a church

Location-Specific: e.g. Grand Canyon, St. Peters Basilica
Monte Carlo Methods

Description

Monte Carlo methods (or Monte Carlo experiments) are a class of computational algorithms that rely on repeated random sampling to compute their results. Monte Carlo methods are often used in computer simulations of physical and mathematical systems. These methods are most suited to calculation by a computer and tend to be used when it is infeasible to compute an exact result with a deterministic algorithm. This method is also used to complement the theoretical derivations.

In general, Monte Carlo methods are used in mathematics to solve various problems by generating suitable random numbers and observing that fraction of the numbers which obeys some property or properties. The method is useful for obtaining numerical solutions to problems which are too complicated to solve analytically. The most common application of the Monte Carlo method is Monte Carlo integration.
Moran-I and Geary-C

Moran's-I : The measure of spatial autocorrelation to study stochastic phenomena which are distributed in space in two or more dimensions. The values of Moran's I range from +1 meaning strong positive spatial autocorrelation, to 0 meaning a random pattern to -1 indicating strong negative spatial autocorrelation.

This particular statistic is designed for the measurement of global spatial autocorrelation of ordinal, interval or ratio data.

Geary's-C : Based upon a paired comparison of juxtaposed map values and ranges between 0 and 2. Positive spatial autocorrelation is found with values ranging from 0 to 1 and negative spatial autocorrelation is found between 1 and 2. However, values can be found greater than 2 on occasion (Griffith, 1987). As similar values are in juxtaposition the numerator which measures the absolute difference squared between juxtaposed values will tend toward zero. Whereas, as non-similar values become juxtaposed the statistic will tend toward larger values in the numerator and thus toward its maximum value of two.

This particular statistic is designed for the measurement of local spatial autocorrelation of ordinal, interval or ratio data.

Example

<table>
<thead>
<tr>
<th></th>
<th>Moran's-I</th>
<th>Geary's C</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0.9</td>
<td>0.04</td>
</tr>
<tr>
<td>B</td>
<td>0.2</td>
<td>0.9</td>
</tr>
<tr>
<td>C</td>
<td>-0.8</td>
<td>1.8</td>
</tr>
</tbody>
</table>

A has positive global spatial autocorrelation and local spatial autocorelation.

B is random with respect to space.

C has negative global and local spatial autocorrelation.

References


152
*Biometrika*, 37(1), 17-23. DOI: 10.2307/2332142
Multiple Links in Imported Data

The Problem
There has been a question of what to do when there is the possibility of multiple links between the same nodes in a file to be imported using the Data-Import Wizard > txt Data > Simple Table > Networks, Nodes and Node Attributes.

Normally the weight of the links in the final network which contains multiple links will be summed. [ node1 > node2 is 0.4 and node1 > node2, 0.5 ]. The expected result would be 4.5 but is in fact summed and becomes 0.9.

The Solution
If you don't know in advance which nodes have multiple links you need to use the Data Import Wizard to create one Network per link type.
Network Basics

Network Basic Terms

Networks are contain information with Weighted/Unweighted, Symmetric/Asymmetric, Connected Networks/Disconnected Networks, and Self Loops. Each makes for a unique network structure. Networks which are directed, weighted, unconnected, and which even contain self-loops are not unusual in social network analysis.

Binary Networks

A binary network is constructed by binary values (either 1 or 0) in its network matrix and contains only the information whether a link between two entities in the network exists or not. In the network matrix, 0 in the cell $w_{uv}$ indicates that there is no links from node u to node v while 1 indicates that there is a link. Because the weights of all links are 1 and therefore equal these networks are also called unweighted networks.

Weighted Networks

If the weights of the links are different we use the term weighted network. In a weighted network every link is represented by a real number $w_{uv}$ (continuously from $-\infty$ to $+\infty$) in its network matrix and contains not only the information about whether there is a link between entities, but also numerical information about the links (e.g., how far two entities are distant geographically or how often agents interact with each other). In the network matrix, 0 indicates there is no link between two entities while any value other than 0 indicate there is a link between the entities.

Self-Looped Networks

Self-loops (also called self-links or loops) are links from a node to itself. A self-looped network has therefore non-zero diagonal elements in the network matrix. Depending on the weight representation of the network (either binary network or weighted network), these diagonal elements can take the values 1 (in a binary network) or it can take any real number (in a weighted network).

Symmetric/Asymmetric Networks

In a symmetric network for every edge euv there is also an edge evu. All links are therefore reciprocal. In asymmetric networks this is not the case. In its matrix representation, a symmetric network has symmetric values about its diagonal. Asymmetric networks are also called directed networks, while undirected networks
are synonymous with symmetric networks. In weighted networks the link values of all paired symmetric matrix elements have to have the same value in order to be symmetric.

**Disconnected Networks**

A path in a network is a subset of nodes and edges which connects two nodes without repeating a node or an edge. All nodes which can be reached from a specific node using paths are called reachable. If subsets of nodes are arranged in a way that all nodes of group A are unreachable from all nodes from group B and vice versa, the network is disconnected. Therefore, there is no link connecting any pair of nodes between the subsets of nodes. These subsets of nodes are named components. Every component can be interpreted as a single network, but researchers are often interested in treating disconnected networks as a single network. In addition, it is important to know that even if a network is connected, it is possible that there are unreachable nodes for a specific node in case of directed networks.

**Network Characteristics**

<table>
<thead>
<tr>
<th>Network properties:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symmetric (undirected links)</td>
</tr>
</tbody>
</table>

Changing any of the characteristics above will affect the working of your network. Normally the creator of a network knows whether a specific network should be directed or undirected when it is created. Changing a weighted network from weighted to unweighted will remove link weight information and you end up with a binary network of 1s and 0s. Changing from a Asymmetric to Symmetric will force ORA to create extra links where the original network had none.

Independently from these network settings ORA offers additional options for treating these characteristics when network measures are calculated. So, your data can have link weights but it is your decision to ignore these link weights when calculating network measures. You will learn more about these options in the following section.

**Editor Display Options**

<table>
<thead>
<tr>
<th>Info</th>
<th>Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Links</td>
<td>Remove Links</td>
</tr>
</tbody>
</table>

Convert Links : This menu item includes different ways to manipulate the line weights of your network. You are able to binarize all links or just links within a specific range (collapse). Negate changes the algebraic sign of the links in the network while absolute value turns all line weights to positive numbers. Row-
normalize is a method to weight the importance of a single link with the number of links of a node.

Remove Links: With these methods you can remove specific links, e.g., links with a line value lower or higher than a given value or self-loops. It is also possible to set the self-loops (diagonals) of a network to a designated value. In this menu you can also find ways to symmetrize your networks using different methods (maximum, minimum, sum, average).

Highlight: Input a search parameter and all matching nodes will be highlighted in the matrix.

Hide: Input a search parameter and all matching nodes will be hidden in the matrix.

Display Options: Options for displaying links as binary check boxes or numeric values. You are also given the option to display row or column sums.

Measures
You can add a measure result as an attribute using the Measure button in the Info Tab of a nodeset. After clicking the button you specify which Network to use, which measure to run and give it a name. The result will display in the nodeset display under Editor. The following are the default settings for measures added.

Treat as symmetric: Symmetrizes the network for the calculation, e.g., if the line weight \( w_{uv} \) is larger than \( w_{vu} \) than \( w_{vu} \sim w_{uv} \).

Ignore self-loops: All diagonal elements are set to 0.

Treat as binary: The link weights for all \( w_{uv} \) with \( w_{uv} \neq 0 \) are set to 1.

Scaling Parameters for Measures
The results of measures is usually within the range 0 and 1 and is the result of scaling. It is used in order to compare networks with different sizes. You can change this to a scale of 0 to 100 under Preferences > Measures > Scale measures as percentage.

Network Characteristics on Measures
The characteristics of a network impact the way measures work, i.e. selecting self-loops affect the result of degree and eigenvector centrality as well as clustering coefficients. Below is a table with some examples.
<table>
<thead>
<tr>
<th>Measure</th>
<th>Allow/Ignore Self-Loops</th>
<th>Symmetric/Asymmetric</th>
<th>Binary/Weighted</th>
<th>Connected/Disconnected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree Centrality</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Betweenness Centrality</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Closeness Centrality</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Eigenvector Centrality</td>
<td>Yes</td>
<td>(No)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clustering Coefficient</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

If any option is set to True of False, ORA will add/remove links that the property holds in the network.
Ontology

What Is Ontology?

Ontology has to do with making clear and explicit statement about entities in a particular domain. What kinds of things can exist in this world we're trying to explain. What types of relationships do they have with each other. It is concerned with what is that and what is possible.

Categorization or Classification: Organizing a set of entities into groups based on their essences and possible relations. This assumes that for any new items added to the group a place will already exist.

Below is the Best Classification chart and I'm sure you recognize it.

![Periodic Table](image)

The Periodic Table has the most value, both descriptive and predictive, of any classification chart. The pink column on the right contains the noble gases. It is an odd category, because helium is no more a gas than mercury is a liquid. Helium is just a gas at most temperatures.

Even in a nearly perfect categorization scheme, there are these kinds of context errors, where people are placing something that is merely true at room temperature, and is absolutely unrelated to essence, right in the center of the categorization. And
the category 'Noble Gas' has stayed there from the day they added it, because we've
all just gotten used to that anomaly as a frozen accident.

If it is impossible to create a completely coherent categorization, even when you're
doing something as physically related to essence as chemistry, imagine the problems
faced by anyone who's dealing with a domain where essence is even less obvious.

**What Makes for a Good List?**

Here are the ideal situations you would like to cleanly classify your domain.

Small corpus
Formal categories
Stable entities
Restricted entities
Clear edges

**What Makes for Good Participants?**

The other important issue is in regards to who is doing the classifying. Here are a few
things that help to job go smoother.

Expert catalogers
Authoritative source of judgment
Coordinated users
Expert users
Parts of Speech

Parts of Speech assigns a single best Part of Speech, such as noun, verb, or preposition, to every word in a text. While many words can be unambiguously associated with one tag, (e.g. computer with noun), other words match multiple tags, depending on the context that they appear in.

<table>
<thead>
<tr>
<th>CC</th>
<th>Coordinating conjunction</th>
<th>PRP$</th>
<th>Possessive pronoun</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>Cardinal number</td>
<td>RB</td>
<td>Adverb</td>
</tr>
<tr>
<td>DT</td>
<td>Determiner</td>
<td>RBR</td>
<td>Adverb, comparative</td>
</tr>
<tr>
<td>EX</td>
<td>Existential there</td>
<td>RBS</td>
<td>Adverb, superlative</td>
</tr>
<tr>
<td>FW</td>
<td>Foreign word</td>
<td>RP</td>
<td>Particle</td>
</tr>
<tr>
<td>IN</td>
<td>Preposition or subordinating conjunction</td>
<td>SYM</td>
<td>Symbol</td>
</tr>
<tr>
<td>JJ</td>
<td>Adjective</td>
<td>TO</td>
<td>to</td>
</tr>
<tr>
<td>JJR</td>
<td>Adjective, comparative</td>
<td>UH</td>
<td>Interjection</td>
</tr>
<tr>
<td>JJS</td>
<td>Adjective, superlative</td>
<td>VB</td>
<td>Verb, base form</td>
</tr>
<tr>
<td>LS</td>
<td>List item marker</td>
<td>VBD</td>
<td>Verb, past tense</td>
</tr>
<tr>
<td>MD</td>
<td>Modal</td>
<td>VBG</td>
<td>Verb, gerund or present participle</td>
</tr>
<tr>
<td>NN</td>
<td>Noun, singular or mass</td>
<td>VBN</td>
<td>Verb, past participle</td>
</tr>
<tr>
<td>NNS</td>
<td>Noun, plural</td>
<td>VBP</td>
<td>Verb, non-3rd person singular present</td>
</tr>
<tr>
<td>NNP</td>
<td>Proper noun, singular</td>
<td>VBZ</td>
<td>Verb, 3rd person singular present</td>
</tr>
<tr>
<td>NNPS</td>
<td>Proper noun, plural</td>
<td>WDT</td>
<td>Wh-determiner</td>
</tr>
<tr>
<td>PDT</td>
<td>Predeterminer</td>
<td>WP</td>
<td>Wh-pronoun</td>
</tr>
<tr>
<td>POS</td>
<td>Possessive ending</td>
<td>WP$</td>
<td>Possessive wh-pronoun</td>
</tr>
<tr>
<td>PRP</td>
<td>Personal pronoun</td>
<td>WRB</td>
<td>Wh-adverb</td>
</tr>
</tbody>
</table>
Reduced Form Networks

Background

Several tools, e.g., NetMapper and AutoMap generate a meta-network in reduced form. Reduced form is a format to support the user by simplifying the structure of the extracted data. There are three elements to reduced form:

1. Symmetrization about the diagonal
2. No self-loops
3. Ordering of the ontology classes

Think of your meta-network as a set of matrices. Each of these matrices is characterized by two ontology classes: Agent x Agent, Resource x Task. The available sets are:

Agent (A)
Organization (O)
Knowledge (K)
Resource (R)
Belief (B)
Event (E)
Task (T)
Location (L)
Unknown (U)

These ontology classes are sometimes referred to by just their first letter. For example, A refers to agent.

As can be seen there are 9 ontology classes, hence there are 81 matrices s.t. each matrix is defined by an ontology class for the row nodes and an ontology class for the column nodes. As an example, one matrix is Resource x Task, often referred to as RT. In RT the rows are resources and the columns are tasks.

Of these 81 matrices 9 are "square"; i.e., both the rows and columns are the same ontology class. An example of a square matrix is Agent x Agent (AA). The square matrices (square networks) are:

Agent x Agent (AA)
Organization x Organization (OO)
Knowledge x Knowledge (KK)
Resource x Resource (RR)
Belief x Belief (BB)
Event x Event (EE)
Task x Task (TT)
Location x Location (LL)
Unknown x Unknown (UU)

Why use Reduced Form
Reduced form is useful when your data is naturally symmetric or when you have extremely large data and for initial analysis you just want to get a general picture. Keep in mind in a reduced form network - the data is symmetric - which means all ties are bi-directional.

Data extracted via text-mining tools such as AutoMap or NetMapper produce reduced form data as the default. The reason is that, for most assessments, the ordering of the concepts in a window (e.g., in a sentence) is not important. Rather, what matters is the co-occurrence of the concepts.

More details
This is what Reduced Form does and does not do:

Uni-modal networks are not changed (e.g. an AA is NOT symmetrized), but bi-modal networks are symmetrized in that the links from two or more networks are combined using the maximum method.

Bi-modal networks are combined:
For example, if there is an AK and a KA network, then the KA is transposed to AK2 and then AK and AK2 are unioned with the Maximum link weight from each (a,k) or (k,a) being used.

Network Names are normalized to their Node Classes, e.g., agent x agent, agent x knowledge, etc.

NOTE : The original networks are changed into their reduced network forms. If you want to maintain the originals, you need to work on a duplicate of the meta-network.

How and Where ORA does Reduced Form
remove self loops : Removes all links that connect a node to itself. Finally, most network measures, and most network data sets, do not consider self-loops. This means that the diagonal is "zeroed"; i.e., the value, if there is one, is replaced by 0. In
a reduced form network only the upper diagonal is saved and self loops are removed. This means that for any square matrix $X$, $X_{ii} = 0$.

Symmetrize by method: Turns directed or asymmetric network data into undirected or symmetric data. All three methods use a pair of values from the upper and lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1). If a network had a link from A to B but not from B to A then symmetrizing the network would create a reciprocal link from B to A. Within the overall meta-network, the data might be symmetric (recall for a network that means symmetric about the diagonal). If in fact the data is symmetric, then this structure has a lot of redundant information and we can save space and computation time, by only focusing on the unique data. For network data this unique part is often referred to as "the upper diagonal." In reduced form, for the square matrices, if the data is not symmetric then the matrix is symmetrized by adding the upper and lower diagonal elements. Thus for any square matrix, $X$, a new version $NEW$, is created by $NEW_{ij} = X_{ij} + X_{ji}$.

Combine networks of the same type using method: : See descriptions below.

Transpose networks according to node precedence : Transposes bimodal networks to ensure that certain Node Classes appear first. The order is: Agent, Organization, Knowledge, Resource, Belief, Event, Task, Location.

Combine networks of the same type using method: : See descriptions below.

**Combination Methods**

Maximum : Compares the values and uses the larger of the values. This is called using the strongest value.

Minimum : Similar to Maximum only it uses the lower, or weaker, value. Average takes the two values and averages them.

Sum : Adds weights of links from all combined networks.

Binary : Sets link to $[1]$ if there is a link an any two nodes or $[0]$ if no network contains a link for two nodes.

Average : Adds all links and divide by the number of links found.

**Order of Node Classes**

The Node Classes will be placed in the following order:

Agent
Organization
Knowledge
Resource
Belief
Event
Task
Location
Unknown

What this means is that the meta-network as a matrix has the rows ordered by first agents then organizations then knowledge .. to unknown. And this means that the columns nodes are ordered by first agents then organizations then knowledge .. to unknown.

In a reduced form network, since only the upper diagonal is saved, this means that the ordering defines how the off-diagonal matrices are referred to. The off-diagonal or non-square matrices are those formed by two different ontology classes. For example and Agent x Organization matrix (AO).

To create a reduced form network, the off-diagonal or non-square matrices are added together. This is effectively saying that the order of the links do not matter. This is done by transposing the lower diagonal matrix and adding it to the upper diagonal matrix. For example, given Agent x Organization (AO) and Organization x Agent (OA), a NEW-Agent x Organization is created as AO+OA(transposed).

Given the ordering of the ontologies this means that in a reduced form meta-network the only off-diagonal matrices are:

Agent x Organization (AO)
Agent x Knowledge (AK)
Agent x Resource (AR)
Agent x Belief (AB)
Agent x Event (AE)
Agent x Task (AT)
Agent x Location (AL)
Agent x Unknown (AU)
Organization x Knowledge (OK)
Organization x Resource (OR)
Organization x Belief (OB)
Organization x Event (OE)
Organization x Task (OT)
Organization x Location (OL)
Organization x Unknown (OU)
Knowledge x Resource (KR)
Knowledge x Belief (KB)
Knowledge x Event (KE)
Knowledge x Task (KT)
Knowledge x Location (KL)
Knowledge x Unknown (KU)
Resource x Belief (RB)
Resource x Event (RE)
Resource x Task (RT)
Resource x Location (RL)
Resource x Unknown (RU)
Belief x Event (BE)
Belief x Task (BT)
Belief x Location (BL)
Belief x Unknown (BU)
Event x Task (ET)
Event x Location (EL)
Event x Unknown (EU)
Task x Location (TL)
Task x Unknown (TU)
Location x Unknown (LU)
Regression

Regression analysis is also used to understand which among the independent variables are related to the dependent variable, and to explore the forms of these relationships. In restricted circumstances, regression analysis can be used to infer causal relationships between the independent and dependent variables ("Regression analysis," n.d.). The dependent and independent variables can be either network measure or numerical attributes of nodes.

To test the shape of the distribution or normality of the variables use…

Procedure

From the main menu select Analysis > Generate Reports… > Statistical Procedures and Diagnostics > QAP/MRQAP Analysis. Place a check mark next to the meta-network(s) to analyze. Click [ Next > ].
In the top section select the nodesets to analyze. In the bottom section select the networks to analyze. Place a check mark in the box next to Create a Meta-Network from select nodes and networks to create a new meta-network. Click [ Next > ].

Under Dependent network: select the meta-network and network to use.

Under Independent network(s): select the networks to keep independent.

Under Select the algorithms to run: select what to use for analysis.

Under Set the algorithm parameters: set the set and permutations.
Generate Reports - QAP/MRQAP Analysis

Select the unimodal networks for the analysis. The independent networks are taken from each meta-network.

**Dependent network:**
- Meta-network: Raiders, Tanis - all
- Network: characters x characters-12

**Independent network(s):**
- characters x characters-12
- characters x characters-14
- characters x characters-15
- characters x characters-16
- [characters x characters-19]

**Select the algorithms to run:**
- Correlation
- Y-Permutation Regression
- Double-Decker Semi-Partialling Regression

**Set the algorithm parameters:**
- Random seed value: 0
- Number of permutations: 100

[Back] [Next] [Cancel]
QAP/MRQAP Analysis Report

Input data: Raiders, Tanis - all

Start time: Mon Dec 12 13:59:48 2011

Data Description

Parameters

The random seed is 0

The number of permutations is 100

The dependent network is characters x characters-12 from the meta-network Raiders, Tanis - all
The independent network(s) used from each meta-network:

characters x characters-12
characters x characters-14
characters x characters-15
characters x characters-16

The total number of independent networks is 3

**Correlation Results**

<table>
<thead>
<tr>
<th>Network</th>
<th>Correlation</th>
<th>Significance</th>
<th>Hamming Distance</th>
<th>Euclidean Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raiders, Tanis - all : characters x characters-14</td>
<td>0.69</td>
<td>0.01</td>
<td>4</td>
<td>2.00</td>
</tr>
<tr>
<td>Raiders, Tanis - all : characters x characters-15</td>
<td>0.30</td>
<td>0.21</td>
<td>8</td>
<td>2.83</td>
</tr>
<tr>
<td>Raiders, Tanis - all : characters x characters-16</td>
<td>0.39</td>
<td>0.04</td>
<td>16</td>
<td>4.00</td>
</tr>
</tbody>
</table>

**Regression Results**

R-Squared: 0.470588

<table>
<thead>
<tr>
<th>Variable</th>
<th>Coef</th>
<th>Std. Coef</th>
<th>Sig. Y-Perm</th>
<th>Sig. Dekker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>0.00</td>
<td></td>
<td>0.04</td>
<td></td>
</tr>
<tr>
<td>Raiders, Tanis - all : characters x characters-14</td>
<td>0.50</td>
<td>0.69</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Raiders, Tanis - all : characters x characters-15</td>
<td>0.00</td>
<td>0.00</td>
<td>0.24</td>
<td>0.45</td>
</tr>
<tr>
<td>Raiders, Tanis - all : characters x characters-16</td>
<td>0.00</td>
<td>0.00</td>
<td>0.40</td>
<td>0.39</td>
</tr>
</tbody>
</table>
Hanneman & Riddle (2005) argue that predicting and testing hypotheses about a node's non-relational attributes can be done using a mixture of relational (network) measures and non-network measures. This tool allows such tests. An example would be to use the entity class agents - such as specific people, and then regress their performance on a combination of node metrics e.g., degree centrality and non-relational attributes e.g. age and gender. This process computes basic linear multiple regression statistics by ordinary least squares (OLS), and estimate standard errors and significance using the random permutations method for constructing sampling distributions of R-squared and slope coefficients.

References

Semantic Network

Semantic Network Union - Input
AutoMap outputs one meta-network per text. A semantic network is a meta-network with: Concept Nodeset, Semantic Network (Concept x Concept), DyNetML <source> element describing AutoMap processing of the input text.

You treat meta-networks as semantic networks. So you combine all nodesets into a Nodeset : Concept and also combine all networks into one Semantic network.

Semantic Union - Output
Meta-network called Consolidated. Nodeset : Concept contains special attributes:

Frequency : Sum of the node's frequency attribute across meta-networks
Frequency_distinct : Number of meta-networks the node was in
Frequency_isolate : Number of meta-networks in which the node was an isolate in the semantic network

Nodeset : Text with attributes:

One text node per input meta-network, corresponding to one text processed by AutoMap. Attributes describe how AutoMap processed the text (these are pulled from the <source> DyNetML tag).

Semantic Network
A union of the semantic networks can control how link weights are combined: sum, minimum, maximum, etc..

A Concept x Text network records which texts contain which concepts. Link weights are from the node's frequency attribute (how many times the node occurred in the text).
Simulated Annealing

Description
Simulated annealing is an optimization heuristic (an algorithm designed to solve a really difficult problem for which the best answers are computationally difficult to assess). This provides very good answers, but not always the best. You may have heard of other such algorithms, like the genetic algorithm (GA) or hill-climbing or A-star.

The method was independently described by Scott Kirkpatrick, C. Daniel Gelatt and Mario P. Vecchi (Kirkpatrick, Gelatt, & Vecchi, 1983) and by Vlado Černý (Černý, 1985). The method is an adaptation of the Metropolis-Hastings algorithm, a Monte Carlo method to generate sample states of a thermodynamic system, invented by M. N. Rosenbluth in a paper by N. Metropolis et al. (Metropolis, Rosenbluth, Rosenbluth, Teller, & Teller, 1953).

Source
The name and inspiration come from annealing in metallurgy, a technique involving heating and controlled cooling of a material to increase the size of its crystals and reduce their defects. The heat causes the atoms to become unstuck from their initial positions (a local minimum of the internal energy) and wander randomly through states of higher energy; the slow cooling gives them more chances of finding configurations with lower internal energy than the initial one.

References


Synchronization

NOTE: This feature is available in ORA version 1.9.5.4.5. and above

In ORA you can now work in synchronization between ORA's Main Interface and ORA's Visualizer. If you position a network visualization window in a manner where you can see the ORA main interface and or any of its visualization windows (e.g., Legend), you can then make changes directly into the Main Interface (e.g., such as changing links in the Editor) and that change will be immediately affect the visualization without any further action from the user.
**WGS84 Maps**

**WGS84**

WGS84 is based on satellite measurements.

**Glossary**

DMS : Degrees, Minutes, Seconds. Historically, maps have their scales in degrees and minutes. To use this with WGS it must be converted to decimal form.

WGS : Stands for World Geodetic System

Map Datum : A smooth surface somewhat arbitrarily defined as zero elevation, consistent with a set of surveyor's measures of distances between various stations, and differences in elevation, all reduced to a grid of latitudes, longitudes, and elevations.

Lat-Long : Stands for latitude-Longitude. For example, 50 degrees and 29 minutes north, 123 degrees and 50 minutes west. Latitude-Longitude coordinates are sometimes referred to as the "geodetic grid" which we abbreviate to "Geo". Latitude is written first, followed by the longitude

**DMS - Degrees, Minutes, Seconds**

As there is no degree symbol \(^\circ\) on the keyboard we use a colon to separate degrees and minutes 50:27.5. Note that there can be only one colon. Use a period (decimal point) to separate the minutes from the seconds.
ORA's Main Interface

The ORA interface is organized into five sections. The menu, the main icons, and three re-sizeable panes which are dockable. On each tab are two buttons: undock and close. In the upper right corner of each pane are three buttons: undock, maximize, and close. This will allow you to arrange the interface to suit your needs.

1 - The Menu

The main source for accomplishing your tasks within the editor. It contains all the functions for managing the meta-networks, generating reports and doing analysis.
2 - The Icons

Contains the main functions for adding or deleting meta-networks, nodesets, and networks and importing existing meta-networks. Clicking the down-facing triangle brings up a window which allows you to add buttons to the GUI for the functions you use the most.

3 - Meta-Network Manager Pane

This pane contains a tree directory of the current meta-network(s) loaded into ORA. This contains the meta-networks currently active plus all their nodesets and networks. Clicking on the plus icon will expand the meta-network showing all the nodesets and networks and clicking on the minus icon condenses the meta-network. Hovering the pointer over a graph it will display information about that network.

4 - Editor Pane

Contains the basic information about the highlighted meta-network such as how many nodes are represented. This panel also allows quick access to ORA’s visualizer, reports and chart tools. By selecting the Visualize button, the currently loaded network will render in the ORA Visualizer, which will load in a separate window.

With the meta-network selected panel 2 displays the information regarding the meta-network itself. The meta-network name and pathway at the top. In the bottom, under statistics, are information regarding the actual meta-network including source, node, link, and network counts.

When a meta-network is expanded it reveals nodesets and networks. Highlighting any of these will reveal information these items.
The Info Tab: Display relevant information whether a nodeset or network is highlighted.

The Editor Tab: Displays the information in a matrix which can be edited in either binary or numeric mode. The data can be directly manipulated in the grid. Nodes, links, and attributes can be added, removed, or edited.

With the Nodes and Attributes buttons you create, delete, or merge nodes and attributes. The Find box assists you in locating particular nodes and attributes.

5 - Reports Pane

This pane is initially empty when ORA is first started up. As reports are run they will be contained within this panel.

NOTE: All three panes can be resized to your preference.
Main Interface Tasks

There are a number of tasks that are performed from within the Main Interface to assist in controlling your meta-networks, nodesets, and networks. These are mostly functions not associated with any of the menu items.

**Aggregate Keyframes** - Combining time slices in a dynamic meta-network.

**Attributes** - Adding or deleting an attribute and the uses of attributes.

**Attribute Buttons** - Controls in the Editor for attributes.

**Clean Button** - Helps combine nodes into a single node with slight variances.

**Context Menus** - Right-clicking of several items brings up a context menu of additional functions for various items.

**Context Menus/Multi-Files** - Selecting multiple meta-networks and right-clicking.

**Context Menus/Network** - Selecting networks and right-clicking.

**Context Menus/Dynamic Meta-Networks** - Selecting a dynamic meta-network and right-clicking.

**Creating New Meta-Networks** - A brief overview of creating a meta-network.

**Create From Excel** - Create a meta-network using Excel.

**Create New Node** - Insert a single node into a nodeset.

**Dating Meta-Networks** - Attaching a date to your meta-network.

**Delimited Files** - Setting delimiters in flat data files.

**Document/URI Attributes** - Using links as attributes.

**Duplicate Items** - How to duplicate a meta-network, nodeset, or network.

**Editor Tab-Networks** - Description of items and functions in the Editor Tab

**Editor Toolbar** - Description of the Editor Toolbar functions.

**Filters** - Setting Filter parameters for searching nodesets.

**Fold Network** - How and why to fold a network.

**Hovering Tooltips** - A brief overview of the information given in the tooltips.

**ID Names** - Description of ID Names and why they are important.
Info Tab-NodeSet - Editor tabs for nodesets.

Info Tab-Networks - Editor tabs for networks.

Info Tab-Networks-Statistics - Description of the statistics pane.

Link Attributes - Distinguishing multiple link types.

Measure Charts - Creating charts from computed measures.

Meta-Node Analysis - Create meta-nodes (nodes containing nodes) suitable for analysis.

Network Editor - Working with the Editor tab with a network.

Node Buttons - Description of the buttons in the Editor GUI to work with nodes.

Search - Finding information within the Editor.

Visualize Buttons - The difference between Visualize this Network and Visualize Only this Network button.
I start out with the Star Wars dataset which consists of 1 keyframe and 23 deltas. Measures can not be run on this in its present form.

The dates for this dataset run from the arbitrary dates 10 NOV 2009 to 21 DEC 2009. This gives up a choice on how to aggregate the data. The most obvious would be in either weeks or months.

In this example we'll do it by months.

Right-click on the icon with the clock to bring up the context menu and select Aggregate which brings up the Aggregate dialog box.

Select the radio button By period, make sure it says 1 then from the drop down select Week (your choice of starting day).

We want to combine by Union so all links will be retained.

Click [ OK ].
A new meta-network will be created containing two KeyFrames each containing one week of data as instructed.

Now each of these KeyFrames can be analyzed individually with any measure.
Attributes

Attributes are extra containers that can be attached to an nodes in a nodeset. You can add a value to this container. To add an attribute to an nodeset right-click on the nodeset name. This will bring up the context menu below.

Add Attribute

Highlight a nodeset the right-click to bring up the menu. Then select Add Attribute...

Type in the name for your new attribute and select the Type form the drop down menu. Your choices are Text, Text Category, URI, Number Category, Number, or Date.

Then click [OK]. Let's say we want to add other languages spoken by the nodes.

The attribute you added will be inserted alphabetically in the editor.

You can now assign any text to this attribute for any of the rows in the network which can be used later to help define your network.

Edit Attribute

Click the downward triangle to bring up the filter/edit functions. Click the Edit Attribute tab. From here you can edit the Attribute name and Attribute type.
**Delete Attribute**

And attributes can be removed just as easily by pressing the Delete button. The dialog box will present you with a list of attributes. Any attribute with a check mark next to it will be deleted from meta-network.

![Delete Attributes dialog box](image)

**Import Attribute**

The [Import] button allows for the quick importing or an attribute(s) through the Editor panel. Use a .csv file with rows as nodes and columns as attributes. This can be done with, or without, an ID column.
1. Use the Textbox and Browse button to navigate to the csv file with the new attribute(s).
2. Select the radio button to use either 1) an ID column, or 2) a file in the same order as nodeset.
3. This section contains all the attributes in the file. If one was chosen to identify the nodeset then it will be greyed out. For attributes NOT greyed out you can choose to make them **Categorical** or **Continuous**.
4. Select All / Clear All buttons places a checkmark in all columns or removes same.
5. Placing a checkmark in the Create new nodes for unrecognized nodes creates new nodes into the select nodeset if no node for an attribute currently exists.
6. Import / Cancel tells ORA to begin the import or cancel the operation.

Note: Whenever you set a Node Display Attribute for a nodeset, the information is also set as an attribute of the nodeset. In other words, Node Display Attributes are now encoded in the data, allowing it to be retained from session to session.
Attribute Buttons

Attribute buttons are used within the Editor to manipulate the attributes of a nodeset.

Create: You will be asked for the name of the new attribute as well as the Type: Text, Text Category, URI, Number Category, Number, or Date.

Import: Import attributes from a file in the following format: columns contain values for a single attribute, and rows contain values for a single node. The first row must be attribute names.
Export: Make a copy of attributes to a different place.

To a file: Click the [Browse] button and select a place to save the file. Place a check mark for the parameters Only export nodes missing an attribute value or Only export visible nodes. The attributes which have a check mark next to them will be exported to the file.

To a network: This allows you to create a new network. Select a property. Next you can either 1] select an existing nodeset; or 2] select a new nodeset class. Lastly give this a new network name.
Delete: Ora will list the attributes. Place a check mark next to the attributes you want to delete and remove the check mark from attributes you want to keep.

Measures: Select the measure and input network to compute and the name of the new attribute to create.
Clean Button

When large datasets are created people's names are after written differently through many different documents. For example you could see someone referred to as John in one documents, John Smith in another documents, and John W. Smith in yet another document. All three of the these names refer to the same person but in ORA they would be considered different individuals.

The [Clean] function is used to condense all the different references of one person into a single node. In the example below there are three instances for Colonel Jack O’Neill (Colonel Jack O’Neil, Jack O’Neil, and Jack), three instances for Major Samantha Carter (Major Samantha Cater, Samantha Carter, and Sam), Two instance for Doctor Daniel Jackson (Doctor Daniel Jackson and Daniel Jackson) and finally two instance for General George Hammond (General George Hammond and Hammond).
Visualizing this network makes it appear there are quite a few more people there actually are in the network (12 as opposed to 5).
The Clean Button

The clean button has multiple functions. Clicking the downward triangle will reveal the menu.

Deduplication

Find and merge nodes with similar IDs or Titles. Similarity is based on edit distance which is the number of characters that would need to be changed to convert one string to another.
From observing in the Editor there are three instances of the agent Jack: Colonel Jack O'Neill, Jack O'Neil, & Jack. With the distance set to 0 the only agent visible is Colonel Jack O'Neill.

Increasing the Min-Edit to 9 makes visible a second agent, Jack O'Neil. The difference between the two agents in the spelling of the surname (one (l) as opposed to two (l)s) and the rank. Clicking the [Merge] button will combine these two together into a single node.

Apply Change List

Apply a previously created Change List to the selected meta-network.

View Changes

View the current Change List. Click the [Clear] button to clear all changes.
NOTE : The Change File can be edited in either Excel or a text editing program.

Save Changes

Allows you to save any modifications that have been done to the current Change List.

Entire Meta-Network

Opens up the Clean Function found on the main menu Data Management > Meta-Network Clean… from where you can work with all nodesets.

The Merge Button

After running the deduplication and merging any duplicates possible the final stage is to use the merge to combine any that may not, for various reasons, be caught by the deduplication process. Place a check mark in the tickybox next to each node to merge then click [ Merge ].

When merging nodes you will be asked for a new ID and Titles and also how to handle the links. There are four options for combining the links of merged nodes.

- Sum : Add the weights of all nodes.
- Minimum : Examines the link weights and uses the smaller number found.
• Average: Examines the link weights and uses the average of all the link weights.
• Maximum: Examines the link weights and uses the largest number found.
• Binary: If any link is a non-zero then the link becomes a [1]. Else it uses [0].

There is also an option to record the merged nodes as aliases

**After the Clean and Merge**

When you are finished with the Clean & Merge your editor grid will reflect the changes. Plus you will see a new columns, alias. This will contain all the node Titles/IDs that were eliminated during the process.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>alias</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Colonel Jack O'Neill</td>
<td>Jack;Jack O'Neil</td>
</tr>
<tr>
<td></td>
<td>Major Samantha Carter</td>
<td>Samantha Carter;Sam</td>
</tr>
<tr>
<td></td>
<td>Doctor Daniel Jackson</td>
<td>Daniel Jackson;Daniel</td>
</tr>
<tr>
<td></td>
<td>Teal'c</td>
<td>Teal'c</td>
</tr>
<tr>
<td></td>
<td>General George Hammond</td>
<td>Hammond</td>
</tr>
</tbody>
</table>

**Final**

After going through the entire meta-network and merging all the same people into single nodes I have ended up with a total of five nodes instead of 12 nodes.
Context Menus-Meta-Networks

Right-clicking on any meta-network, nodeset, or network in the Meta-Network Manager pane brings up a context menu containing common operations available for that element type such as add or delete as well as specialty functions.

NOTE : The context menu contents will vary depending on element characteristics, the current ORA state, and the number of elements currently selected.

The context menus described on this page are seen when a single meta-network, nodeset, or network is selected. See Context Menus-Multi-Files for context menus when multiple meta-networks are selected and Context Menus-Dynamic Meta-Network for context menus when dynamic meta-networks or their constituent components are selected.

The functions will be applied to the currently selected (highlighted) element, which is not necessarily the element right-clicked to access the context menu. Selection is performed by left-clicking on an element. For example:

The Sample Belief meta-network is right-clicked to display the context menu while embassy meta-network is selected with a left-click.

After the Convert to a dynamic meta-network function is clicked on the context menu, the selected embassy meta-network has been converted to a dynamic-meta network (the Sample Belief meta-network is unchanged)
Meta-Network Context Menu

The meta-network context menu appears when a meta-network is right-clicked in the Meta-Network Manager pane.

NOTE: The context menu functions will be applied to the currently selected (highlighted by a left-click) element which may not be the same element right-clicked to open the context menu.

Add New Meta-Network Create a new empty meta-network.

Remove Selected Meta-Network Delete the currently selected meta-network.

Add New Nodeset… Opens the Create Nodeset dialog in order to add a nodeset to the currently selected meta-network.

Add Blank Network… Opens the Create Network dialog in order to add a network to the currently selected meta-network.

Meta-Network Transform… Opens up the Meta-Network Transform dialog box. One or more predefined transformations can be applied to a meta-network. Multiple meta-networks can be transformed at once, either over-writing the original input meta-networks, or creating new and transformed meta-networks.
Meta-Network Groups… Opens up the Meta-Network Groups dialog box. The Meta-Network Groups dialog identifies groups in a network using a specified grouping algorithm and permits identified groups to be selectively extracted to a separate meta-network.

Meta-Network Anonymize… Opens the Meta-Network Anonymizer dialog box. The Meta-Network Anonymizer removes IDs (and optionally Titles) from any chosen meta-network.

Load into existing Visualization Add the network to an existing visualization window. [Only appears when a visualizer window is open.]

Convert to a dynamic meta-network Create a new dynamic meta-network containing the selected meta-network as a keyframe. The dynamic meta-network is created with the same name as the selected meta-network.

View Status Open a Status dialog showing the Attributes and Sources values for the selected meta-network.

Save Meta-Network Save the selected meta-network to it's current file (if no file exists, a Save Meta-Network dialog will open to set the name, type and location of the network file).

Save Meta-Network As… Save the selected meta-network to a new file. Opens a Save Meta-Network dialog to set the name, type and location of the network file.

**Nodeset Context Menu**

The nodeset context menu appears when a nodeset is right-clicked in the Meta-Network Manager pane.

NOTE : The context menu functions will be applied to the currently selected (highlighted by a left-click) element which may not be same element right-clicked to open the context menu.
Add New Nodeset… Opens the Create Nodeset dialog in order to add a nodeset to the meta-network containing the currently selected nodeset.

Remove Selected Nodesets Delete the currently selected nodeset or nodeset(s).

Add Attribute… Opens the Create Attributes dialog in order to add attributes to the currently selected nodeset.

**Network Context Menu**

The network context menu appears when a network is right-clicked in the Meta-Network Manager pane.

NOTE: The context menu functions will be applied to the currently selected (highlighted by a left-click) element which may not be same element right-clicked to open the context menu.

Add Blank Network… Opens the Create Network dialog in order to add a network to the meta-network containing the currently selected network.

Remove Selected Networks Delete the currently selected network(s).

Set Diagonal… Used on a square network to set cells 1,1 through x,x to the same value. In binary view the choices are 1: True (+1) 2: True (-1) 3: False (0). In Numeric view you can put any value into the diagonal.

Transpose… Rotates axis X 90 degrees clockwise and mirrors the image horizontally.
Fold Network… This function creates a new network using matrix algebra. Below are four variations of a four x four network and the results when each is folded.

<table>
<thead>
<tr>
<th></th>
<th>Knowledge_1</th>
<th>Knowledge_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>T2</td>
<td>0.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Symmetrize… Adds, removes, or modifies links to symmetrize each unimodal network. A network is symmetric if for each pair of nodes \{A,B\} the links (A,B) and (B,A) exist and have the same value. Note that the links can both have value zero. [Only appears when a unimodal network is selected.]

There are different ways to symmetrize a network:

- **Maximum** sets the values of links (A,B) and (B,A) to be the maximum of the two existing values
- **Minimum** sets the values of links (A,B) and (B,A) to be the minimum of the two existing values
- **Sum** sets the values of links (A,B) and (B,A) to be the sum of the two existing values
- **Average** sets the values of links (A,B) and (B,A) to be the average of the two existing values

Binarize Network Turns all non-zero numbers to [1] and leaving all [0] untouched.

Remove Links… Removes links in accordance to the selection in the dropdown menu (as seen in the images below).
Load Into Matrix Algebra Opens the Matrix Algebra dialog to apply matrix operations to the selected matrix.

Save Network… (also called Exporting a Network) Any network can be saved individually to a file in one of the following formats: CSV, DL, DyNetML, or UNCINET (.##h). Also check File Formats for more information.
Context Menus-Multi Files

Includes: Union Meta-Networks, Intersect Meta-Networks, Conform Meta-Networks

There's also a separate context menu when you've got two or more meta-networks selected. Open up multiple meta-networks in the Main Interface. Load two or more files into Panel 1. We'll demonstrate this on two meta-networks containing Bob, Carol Ted, & Alice. The agents are identical but the tasks in each are different, except for driving which appears in both and has slightly different values. Inbetween the time of cookingIn and eatingOut Alice's feelings for Ted have grown.

CookingIn and

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>shopping</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>carol</td>
<td>chief_cook</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>ted</td>
<td>waiter(ess)</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>alice</td>
<td>driver</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

EatingOut

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>driver</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>agenda</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>tipper</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>3.0</td>
</tr>
<tr>
<td>alice</td>
<td></td>
<td>0.0</td>
<td>3.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>driver</th>
<th>agenda</th>
<th>tipper</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>2.0</td>
</tr>
<tr>
<td>carol</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Highlight both of them by holding down the ctrl key while clicking on each file. Then Right-click on one of the files. This brings up the context menu.

The Add New Meta-Network & Remove Selected Meta-Network are self-explanatory.

The Union Meta-Network will create a new meta-network using one of five actions: sum, binary, average, minimum, or maximum.

- Sum: In any identical network all values from all networks are added together. (i.e. bob’s score of 4.0 in both meta-networks are added together for a total of 8.0).
• Binary: Then in the binary option it doesn't matter what numbers appeared in either meta-network as it uses only 1 or 0 as a result. If any cell has a non-zero it will contain a 1 as a result.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

• Average: This option takes the sum of all identical cell values and divides them by the number of cells used. In cookingInted x alice contained a 2 while in eatingOut the value for ted x alice was a 1. This was averaged out to 1.5.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.5</td>
<td>0.0</td>
<td>2.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

• Minimum: This function finds the smallest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x alice both cells use the smaller value of "1" even though they are from different meta-networks.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

• Maximum: This function finds the largest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x alice both cells use the larger value of "2" and "3" respectively, each taken from a different meta-network.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>3.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Intersect Meta-Network works similar to the Union function and has the same five options. But in creating the new meta-network only nodes that appear in all meta-networks are carried over to the new meta-network.

204
For example: All four agents appear in both meta-networks and are brought over into the new meta-network. But though there were six tasks in the cookingIn and three tasks in eatingOut there is only one task (driver) in the new meta-network created from the intersect function. Only nodes found in all meta-networks are brought over.

And even though bob has a value for driver in cookingIn only carol has a value for driver in both meta-networks.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
<th>driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
<td>bob</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
<td>carol</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>1.0</td>
<td>ted</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>alice</td>
</tr>
</tbody>
</table>

Conform Meta-Network alters the selected meta-networks and makes them equal. Union adds nodes that are found in one meta-network but not the other. Intersect removes nodes that are not common to both.
Context Menus-Networks

With a network selected in the Meta-Network Manager and the Editor tab opened in the editor pane, right-clicking on the row or column header brings up the context menu with a set of functions for working with networks.

Note: The context menus for row and column provide access to sort options only for rows or columns, respectively.

Sort

By default, nodes are displayed in the order they were entered. ORA gives you additional ways to order the display of the nodes. You can reorder rows and columns independently.

Note: The sort functions are also available in the edit pane menu under Sort Rows and Sort Columns.

Sort menu for row headers:

- High to Low by row sum: Arranges rows in order by the sum of link weights from highest to lowest.
- Low to High by row sum: Arranges rows in order by the sum of link weights from lowest to highest.
- A to Z by node name: Arranges rows by Node Title in lexical order lowest to highest.
- Z to A by node name: Arranges rows by Node Title in lexical order highest to lowest.

Sort menu for column headers:

- High to Low by column sum: Arranges columns by the sum of link weights from highest to lowest.
- Low to High by column sum: Arranges
columns by the sum of link weights from lowest to highest.

- A to Z by node name: Arranges columns by Node Title in lexical order lowest to highest.
- Z to A by node name: Arranges columns by Node Title in lexical order highest to lowest.

NOTE: Nodes will retain their sort order for the duration they are displayed on the screen. Changing this view and returning to a network will place the nodes back in their original order.

**Highlight**

Change highlights.

NOTE: Highlighted items (yellow fill) are different than selected items (blue fill). Highlights are set by searching when the Highlight matches option is set in the search bar. Selection occurs when the user clicks or shift-clicks in cells using a pointing device (e.g. mouse).

- Clear all: Clears highlights from all nodes.
Create Histogram

Creates a chart from the selected nodes (or the current node when multiple nodes are not selected).

Example

First I sorted the agent rows by [Right-Clicking] on any row title and selecting Sort > High to Low by row sum so the nodes with the highest numbers of links would rise to the top.

<table>
<thead>
<tr>
<th></th>
<th>abulurd_hark...</th>
<th>alia_atreides</th>
<th>arrakeen_as...</th>
<th>baron_vlad...</th>
<th>chani</th>
</tr>
</thead>
<tbody>
<tr>
<td>paul_atreides</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>baron_vladimir_harkonnen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>duke_leto_atreides</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>lady_jessica</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dr_wellington_yueh</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>feyd_rautha</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glossu_(the_beast)_rabban</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>piter_de_vries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>reverand_mother_gaius_hele...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>thufir_hawat</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>duncan_idaho</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>harah_(emis_wife)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For illustration purposes the ten agents with the most links are then highlighted:
I wanted the list sorted by name so I [Right-Clicked] a row title and selected Sort > A to Z by node name. Note how the highlighted rows have been redistributed.

<table>
<thead>
<tr>
<th>abulurd_hark...</th>
<th>alia_atreides</th>
<th>arrakeen_as...</th>
<th>baron_vlad...</th>
<th>chani</th>
</tr>
</thead>
<tbody>
<tr>
<td>paul_atreides</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>baron_vladimir_harkonnen</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>duke_leto_atreides</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>lady_jessica</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dr_wellington_yueh</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>feyd_rautha</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>glossu_(the_beast)_rabban</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>piter_de_vries</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>reverand_mother_gaius_helen...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>thufir_hawat</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>duncan_idaho</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>hadrah_(alemis_wife)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>abulurd_harkonnen</td>
<td>ala_atreides</td>
<td>arrakeen_assassin</td>
<td>baron_vladimir_harkonnen</td>
<td>chani</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>------</td>
</tr>
</tbody>
</table>

**NOTE:** Sorting works in the same manner with regards to columns.
Context Menus-Dynamic Meta-Networks

In the ORA Editor's Meta-Network Manager, a dynamic meta-network is distinguished by a special icon:

In the meta-network Panel click the [+] button to the left of the icon to expand the contents. Clicking on any of the just revealed icons will display the contents of the individual components. The first one (with the regular meta-network icon) contains the general data. Each of the other components are the individual time slices within the dataset which also contain the same number of nodesets and networks.

Right-clicking on any meta-network with the clock icon brings up the context menu to work with these types of files.

**Context Menu for Dynamic Meta-Network**

Remove selected : Remove selected meta-networks from ORA.

Import keyframes… : Merges the new keyframe into the selected meta-network based on the new date. If the new keyframe has no date it will be placed at the beginning of the dynamic meta-network.

Import keyframes as deltas… :

Create a new delta… : Add new delta either at the end of the all time periods or inserted after a specific date.

Aggregate… : Combine data from individual parts of meta-network determined by parameters.

Meta-Network Transform… : Use to transform each keyframe in the dynamic meta-network according to the parameters selected.

**Context Menu for Keyframe**

Select one or more keyframes. The context menu displayed varies depending on the number of selected keyframes.

**Single Keyframe Selected**

NOTE : This menu appears when a single keyframe is selected.

Add New Meta-Network : Create blank meta-network
Remove Selected Meta-Network : Remove selected meta-networks from ORA.

Add New Nodeset… : Create blank nodeset in selected meta-network.

Add Blank Network… : Add blank network to selected meta-network

Meta-Network Transform… : Use to transform each keyframe in the dynamic meta-network according to the parameters selected.

Meta-Network Anonymize… : Resets the NodeID (and optionally the Node Title) to anonymous values.

Save Selected : Save the selected meta-network as a DyNetML file in the selected directory using a user-supplied file name.

View Status : Display the meta-network status, including automatically calculated attributes.

Save Meta-Network : Save the meta-network as a DyNetML file, using the existing name and directory, if any.

Save Meta-Network As… : Save the meta-network as a DyNetML file under a new name or directory, as desired.

**Multiple Keyframes Selected**

NOTE : This menu appears when a multiple keyframes are selected.

Add New Meta-Network : Create blank meta-network

Remove Selected Meta-Network : Remove selected meta-networks from ORA.

Load Into Visualizer : Display the selected keyframes in the visualizer.

Meta-Network Transform… : Use to transform each keyframe in the dynamic meta-network according to the parameters selected.
Meta-Network Union… : Creates a single meta-network from the selected meta-networks by union.

Meta-Network Intersect… : Creates a single meta-network from the selected meta-networks by intersection.

Meta-Network Conform… : Make the nodesets of the selected meta-networks identical.

Create a dynamic meta-network : Use the selected keyframes to create a new dynamic meta-network.

Save Selected : Save the selected meta-networks as a DyNetML files in the selected directory using the meta-network names.

**Context Menu for Other Deltas**

Insert a keyframe : Inserts new keyframe after selected delta. This keyframe will contain all the information from the previous delta which can then be modified by additions, Deletions, and modifications.

Convert to keyframe : Converts a delta into a keyframe.

NOTE : You can not convert a keyframe into a delta.

Create a new delta : Create a new delta. You can choose to add one to the end of the time by various increments or use the Custom date function to insert it into the list. The new delta will contain all the information from the previous delta or keyframe.

Remove selected : Delete the selected deltas from the dynamic meta-network (no undo).

Save selected : Save the selected meta-networks as separate DyNetML files in the selected directory using the meta-network names.
Create a New Meta-Network

What follows are procedures for creating a new meta-network.

There are times you need to run measures on or visualize only part of an existing meta-network. This section will show you the easy way to create sub-sets of an existing meta-network.

First duplicate the meta-network. Highlight the meta-network then from the main menu select Edit > Copy Meta-Network. Then from the main menu select Edit > Paste Meta-Networks. It would be a good idea to rename this new meta-network immediately so as to not get it confused with the original. You can do this in the Editor tab, see Renaming.

Next, expand the meta-network you want by clicking the [+] if it isn't expanded already. Highlight the nodeset with the nodes you want to remove.

In panel 2 select the Editor tab which brings up the matrix with nodes on the vertical and attributes on the horizontal. Below each attribute is a <set filter>. Below left is the stargate_summit meta-network along with the ally attribute. I wish to make a new meta-network of the good guys only. In the dropdown menu under ally I select no. These are the nodes I want to remove.
Place a checkmark in the box of each node. Below the matrix in the section called Nodes are three buttons. Click the [Delete] button. The nodeset now contains only the nodes that had yes in the attribute ally.

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity Title</th>
<th>ally</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
<td>yes</td>
</tr>
<tr>
<td>A02</td>
<td>mai_sam...</td>
<td>yes</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
<td>yes</td>
</tr>
<tr>
<td>A04</td>
<td>tearc</td>
<td>yes</td>
</tr>
<tr>
<td>A05</td>
<td>jacob_cart...</td>
<td>yes</td>
</tr>
<tr>
<td>A06</td>
<td>lt_elliott</td>
<td>yes</td>
</tr>
<tr>
<td>A07</td>
<td>ren' al</td>
<td>yes</td>
</tr>
<tr>
<td>A08</td>
<td>aldwin</td>
<td>yes</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
<td>yes</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
<td>yes</td>
</tr>
<tr>
<td>A11</td>
<td>gen_ham...</td>
<td>yes</td>
</tr>
<tr>
<td>A12</td>
<td>lantash</td>
<td>yes</td>
</tr>
<tr>
<td>A13</td>
<td>narm</td>
<td>yes</td>
</tr>
<tr>
<td>A14</td>
<td>travel</td>
<td>yes</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
<td>no</td>
</tr>
<tr>
<td>A16</td>
<td>yu</td>
<td>no</td>
</tr>
</tbody>
</table>

With this same procedure I created a meta-network of only the allies.
Create Meta-Network from Excel File

If you don't have a Network, you can create one from scratch. Below is step-by-step instruction on how to do this in Excel.

We will create a square, agent-by-agent Network. We say it is square because all row headings correspond directly to column headings. This is important as it relates to specific measures ORA can run on a graph. If the graph is not square, some measures will not work.

Open a blank Microsoft Excel work book. In column A we will enter the name of all the nodes that make up our social network or organization.

NOTE: When creating your spreadsheet, do not add any additional titles, notes, or other headings, which will interfere with the "square" properties of the Network.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>bob</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>carol</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>alice</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Next, create column headings using the correlating names as they appear in row headings. Again, this will ensure that our Network will be square.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>bob</td>
<td>carol</td>
<td>ted</td>
<td>alice</td>
</tr>
<tr>
<td>2</td>
<td>bob</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>carol</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>alice</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Next we will create links between each agent. We do this by entering a 1 if a direct connection or relationship exists and a 0 if it does not. Please note that headings that cross-reference themselves are considered redundant and thus are left blank or 0.

In the example below, Redundant cells [i.e., the diagonal] are filled in with red strips to illustrate the self-loops. This redundancy should continue as a smooth diagonal line from the top left corner of your Network to the bottom right.
NOTE: If you don’t end up with a diagonal line then your graph is not square.

Using 1s and 0s to establish link, complete your spreadsheet.

In the Network example, we have assigned links randomly. Within your organization or network, however, you can describe any direct connections or relationships you are interested in analyzing. For instance, you may determine that a direct connection exists if agents within your network consult with each other at least once a month; literally, it can be anything you decide.

Below is our completed Network (The red fill illustrates cells that do not require input due to their redundancy).

Now that we have essentially built a Network from scratch using Excel, the next step is to save it in a compatible file format ORA can interpret. For Excel spreadsheets this will be the CSV file format.

From the main menu select File > Save As

Make sure you save this file as a CSV (comma delimited)

You have now created a Network from scratch which can be loaded into ORA.

Now return to ORA and load up your new Network. Below is our new Network rendered in the ORA Visualizer. Notice the arrows only point from one node to another if there is a 1 in the column for a particular node. i.e. There is a "1" in the bob column for ted but a "0" in the ted column for bob. So an arrow points from ted to bob but NOT from bob to ted.
For a more in-depth explanation for creating meta-networks see the **lessons section** under **meta-network**.
Create New Node

With the [Create] button in the editor you can create any number of nodes at one time. But there are times you only need to insert a single node into a nodeset. Such as while building a dataset you forgot to include it in the original construction. ORA gives you a quick method of adding a single node.

Below is the small Star Wars set containing 11 agents. And for some reason you needed to include a 12th agent, say Jabba the Hutt.
I typed jabba_the_hutt into the Search box and since he's not in this set ORA display no nodes. But notice to the right of the Search box a [Create a new node] button has appeared. If the node you want does not exist this allows you to instantly add it to the Node Class.

Upon click the [Create a new node] button the jabba_the_hutt node is added to the bottom of the list.
Dating Meta-Networks

Certain functions require a meta-network to have a date attached to it. These include: Measures Over Time, Networks Over Time, and Loom. To add a date first highlight the meta-network. In the Editor pane find Meta-Network Date. Click on the [Click to create...].

Now you can set the parameters for the date which include year, month, day, and time.

Remove Meta-Network Date

If, at any time, you need to remove the date from a meta-network click on the [X] to the right of the date.
Delimited Files

Excel, when reading in a flat file (i.e. txt or .csv), is sensitive to the kind of delimiter used. In the American version of excel, it assumes that a comma or tab is used to separate columns. In other versions, it often assumes that a semicolon or tab is used to separate columns. This is because in many other languages the comma is used as a period in showing the price of items.

AutoMap and ORA export data as comma separated and can import comma separated data. This means if you are reading into or reading from a non-American version of excel you may have problems.

Reading in the .csv file into Excel that uses something other than commas will cause the data to appear as a set of text in column A. There are two ways to fix this.

NOTE : And if you data contains commas change to another character before changing the delimiting characters to commas.

First read the file into a text editor and globally change all the delimiting characters to commas.

Second read the file into excel and use the Text to Columns function and use a different delimiter.

Excel Example

Let's start with a simple three line file using semicolons as delimiters.

NOTE : Remember, data can be separated with a variety of characters. This procedure allows you to import data with any of them.

100;apple;red
101;lime;green
102;lemon;yellow

Opening this file in Excel will place each line of text into a single cell. You need to separate this into individual columns.
Select the cells you want to convert then click the Data tab. Click the Text to Columns function.

This brings up the Convert Text to Columns Wizard. Make sure the Delimited radio button is selected. Then click [ Next > ].
Under the Delimiters header make sure the Semicolon box contains a check mark. In the Data preview area it will show you what your data will look like after the conversion. Click [Next >].
Lastly you can do some final tweaks to how your data will be converted if you want such as your data format or a different destination. In this example we want the data to be inserted back into the original starting cell. Click [ Finish ].
Each piece of data now resides in a separate cell.

The new file can now be imported into ORA through the Data Import Wizard.
Document/URI Attributes

The following section describes how to add a document attribute or a URI to a Node.

Adding a document links in the Editor

Load a meta-network into ORA. Then expand the meta-network using the [+ ] icon to display all the nodesets and networks in the meta-network. Then right-click on a nodeset and this will access the context menu. From here, select Add Attribute. Give the new attribute a name.

In Pane 2 click the Editor tab to display the matrix and find the new attribute just created. All cells will be empty. A new pathway can be inserted in the cell at this time.

Once the node title has been changed, you can now enter a URI directly inside the corresponding blank field. This can either be an absolute pathway to a document on the user's hard drive or a web URL.

Adding a URI in the Visualizer

Visualize a meta-network, select a node, and right-click to access it's context menu. From the context menu select, choose URI submenu > Attach URI. This brings up the Add URI box where the new URI can be entered.

When viewing the meta-network in the Editor a new column appears with the title you inserted in the field Name:.

NOTE : When using an absolute path to a document the link will not work if the meta-network is opened on another computer. It's much safer to use URIs from the internet to connect documents.

The same document pathway can be used for multiple nodes.

When the meta-network is displayed in the Visualizer the document URI will appear in the Node Status tooltip. You can go to this URI by right-clicking a node and use the URI submenu to Go To URI. A new explorer window will be launched showing the location of the document file. It can then be opened with the appropriate program.
Multiple URIs/URLs

A node can have multiple URIs and you can still launch from the URI SubMenu. The preferred method for launching URIs is through the Node Status dialog where you can choose an individual URI to launch.

There's a new URI tab that allows you to view URI's, launch them, and add new ones. When adding new ones, the current convention is to create a new attribute with name URI-X, where X is the earliest number that doesn't already exist. So, adding a URI to nodes will create results such as URI-1, URI-2, etc. Currently, when finding URI's to launch, only those that follow the above convention are included, but it will be expanded to include any attribute with URI or URL in it anywhere.
Duplicate Items

ORA allows for the quick duplication of meta-networks, nodesets, and networks. It uses the Copy and Paste commands but some aspects work in a different manner than most users are familiar with.

Meta-Network

Duplicating a meta-network can be done with the menu, Edit > Copy Ctrl+C then Edit > Paste Ctrl+V. This will create a duplicate of the highlighted meta-network. And as the menu items show you can also use the keyboard shortcuts, Ctrl+C and Ctrl+V.

There is also a method for duplicating two or more meta-networks simultaneously. Highlight all the meta-networks you need to duplicate. Press and hold the [Alt] key. Place the mouse cursor over one of the highlighted meta-networks then Click and hold. Drag the cursor into an unused area of the meta-network Manager pane and release the mouse button. All highlighted meta-networks will be duplicated.

Nodesets and Networks

Using the Menu items Edit > Copy Ctrl+C and Edit > Paste Ctrl+V work differently with nodesets and networks. This can be used to either create new meta-networks or duplicate nodesets and networks in existing meta-networks.

This leads to an interesting side benefit. You can highlight nodesets and networks from different meta-networks, Copy, and Paste. This will create a new meta-network with all the highlighted items.

Create new Meta-Network : As with meta-networks click, hold and drag a nodeset(s) or network(s) to an unused space in Meta-Network Manager pane. Upon releasing the mouse button ORA will create new meta-networks containing those nodesets and networks.

NOTE : If you highlight two nodesets or networks with the same name ORA will ask you to give the second one a different name.

Add to existing Meta-Network : Dragging a nodeset or network to an existing meta-network will add that nodeset or network to the new meta-network. If that nodeset name is currently in use ORA will as you to rename the nodeset or network you want to append.
ORA provides numerous ways to modify networks through the Editor pane.

Note that to change the nodes included in a network, the nodeset must be modified.

**WARNING:** ORA does not provide undo/redo functionality during editing. Be sure to make a copy of any important meta-networks before editing.

### Presenting Networks: Matrix Versus List Views

The Editor pane can present a network several ways. The selected view will be used for all networks shown in the Editor pane until changed. The current view is selected using the Display Options command in the Editor menu.

- **Matrix Views** Display network as a matrix labeled with the node names for the source node (or from node) in the leftmost column and target node (or to node) in the top row. A "0" at an intersection means there is no link (connection) while a non-zero number means there is a link.
  - Numeric link values - Show links as decimal values. Use this option where links can be different (e.g. strong or weak) not just present or absent.
  - Binary link values - Show links as binary (0/1) values. Use this option for binary (present/absent) links where all links are assumed to be the same.
• List View - Show only linked nodes in a list form, of the form Source Node (from node name), Target Node (to node name) and Value. This view is useful when checking for the existence of individual links.

**Note:** These views are simply different ways to view the underlying matrix. All links are capable of having link weights and using the binary view will not change existing link weights (adding or deleting the link will, of course alter the link value).

---

**Editing Individual Links**

In either of the matrix views, you can create, delete and alter individual links.

**Example: Editing Numeric Link Values**

This brief example describes adding a (negative) link and removing an existing link (by setting the value to zero).

If the Editor is not showing a numeric link values in matrix form, click Display Options in the menu then select Numeric link values.

Place the mouse pointer in a cell and select with the left mouse button. The cell will be highlighted.

Enter a link with a weight of ",-6.7".

Hit the Enter key; the value will appear in the cell and the cursor will advance to the next cell. (ORA will advance to the next cell down in the column, wrap to the top of the next column as required and will wrap from the last (lower right) cell to the first cell in the matrix (upper left) when necessary.

Navigate to an existing link. You can use the keyboard arrow keys to move to adjacent cells as well was the mouse. Enter a "0" value. This will remove the existing link.
Example: Editing Binary Link Values
This example describes adding a binary link (link value set to 1) and removing an existing link (link value becomes 0).

If the Editor is not showing a check boxes in matrix form, click Display Options in the menu then select Binary link values.

Select an unchecked cell and double-click the check box. A link is created.

Navigate to an existing link and uncheck it by double-clicking. (As with the numeric matrix view, you can use the arrow keys to move to adjacent cells as well as the mouse.)

Return the matrix view to Numeric link values using the Display Options category of the Editor menu. The links created in the binary view contain the numeric link value "1".

Keyboard Navigation
In addition to the mouse, the following keyboard keys can be used to navigate in the matrix views:

**Keyboard Arrow Keys**: The arrow keys move the selection to the adjacent vertical and horizontal cells.

**Keyboard Page Keys**: Move to the table edge using the Page keys.

Page Up : Move to the top of the column.

Page Down : Move to the bottom of the column.

Ctrl+Page Up : Move to the start of the row.

Ctrl+Page Down : Move to the end of the row.

Edit Command Menu
The editor command menu supports changing the appearance and values in the entire matrix.

Convert Links
This allows you to mathematically transform all links values in your network.
Symmetrize by method:

Binarize link values \((x \neq 0 \Rightarrow x = 1)\):

Collapse link values \((a \leq x \leq b \Rightarrow x = 1)\):

Negate link values \((-x)\):

Invert the link values \((1/x)\):

Logorithm of the link values \((\log_{10}(x))\):

Absolute value of the link values \(|x|\):

Scale the link values \((c \times x)\):

Row Sum Normalize the link values \((x_{ij}/(\text{sum of row } i))\):

Column Sum Normalize the link values \((x_{ij}/(\text{sum of column } j))\):

Sum Normalize the link values \((x_{ij}/(\text{sum of all values}))\):

Increment the link values \((c + x)\):

Subtract link values \((c - x)\):

Remove self-loops (diagonal): Removes all links from a node to itself. NOTE: Only works on symmetric Networks.

**Remove Links**

Remove All links: All links will be removed from the network.

Remove links by value: Remove selected links (set the link value to "0", no connection) based on a numeric comparison of the link value. Supported comparison types include:

- Less than
- Less than or equal to
- Equal to
- Not equal to
- Greater than or equal to
- Greater than
Remove self-loops (diagonal): Removes all links from a node to itself. NOTE: Only works on symmetric Networks.

**Highlight**

Clear all: Clears all highlights from editor.

Highlight isolates: Highlights in yellow any nodes not connected to any other nodes in the network.

**Hide**

Show all: Displays all hidden nodes and links

Hide highlighted rows: Any rows that are highlighted yellow will be hidden.

Hide highlighted columns: Any columns that are highlighted yellow will be hidden.

**Sort Columns**

High to Low by row sum: Arranges rows in order by the sum of link weights from highest to lowest.

Low to High by row sum: Arranges rows in order by the sum of link weights from lowest to highest.

A to Z by node name: Arranges rows by Node Title in lexical order lowest to highest.

Z to A by node name: Arranges rows by Node Title in lexical order highest to lowest.

**Sort Columns**

High to Low by column sum: Arranges columns by the sum of link weights from highest to lowest.

Low to High by column sum: Arranges columns by the sum of link weights from lowest to highest.

A to Z by node name: Arranges columns by Node Title in lexical order lowest to highest.

Z to A by node name: Arranges columns by Node Title in lexical order highest to lowest.
**Display Options**

Binary link values: Changes the grid to display check boxes. If a link exists, regardless of the weight, a check mark will appear in that cell.

Numeric link values: Changes the grid to display cells. The weight of the link will be displayed as a negative value, 0, or a positive value.

Display row sums: Creates a column to the right of the row names and displays the sum of all links in that row.

Display column sums: Creates a row below the columns names and displays the sum of all links in that column.

Change to list view: Displays the matrix as a list of links.

**Searching**

The Editor pane supports searching row and column labels (link values are not searched). Rows and columns are searched independently and simultaneously. Note that the row and column labels used in the matrix view can be altered to use a different attribute for the label by changing the key field value Display nodes by for the constituent nodeset(s) under the nodeset Info tab.

The search bar includes the following elements (from left to right):

- **Row Text Entry Field** Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the matrix display. Use quotation marks to search for a phrase (spaces are treated as part of the search). Only the row label is searched.

- **Row [ And ▼ ] / [ Or ▼ ]** This button controls the row text match policy. And matches rows which include all specified strings. Or matches rows which have any one of the specified strings.

- **Column Text Entry Field** Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the matrix display. Use quotation marks to search for a phrase (spaces are treated as part of the search). Only the column label is searched.
Column [ And ▼ ] / [ Or ▼ ] This button controls the column text match policy. And matches columns which include all specified strings. Or matches columns which have any one of the specified strings.

Match : Pulldown list to determine how search results are presented:

Show Matches : Display only rows and columns which satisfy their respective search conditions.

Highlight Matches : Display the entire matrix and highlight rows and columns which independently match their search conditions.

Hide Matches : Show rows and columns which do not satisfy their respective search conditions.
Editor Toolbar

To help facilitate your workflow ORA allows you to mount/unmount tool buttons in the Editor's toolbar (and also in the Visualizer toolbar). Click the down-triangle to open the dialog box.

The Configure Toolbar dialog box will appear. You will notice that some items are already checked. These correspond to the buttons already present. Placing a check mark next to any tool instantly mounts it on the toolbar. Removing the check mark from a button instantly removes the button.

When you are finished click [Close].

If at any point you can select the [Restore Default] button which will remove all the changes you made and restore the toolbar to the buttons found in the image at the top.

NOTE: The buttons appear from left to right in the order you select them. You can not re-arrange buttons once they are placed on the toolbar.
Filters

Use of this function allows you to reduce the number of nodes that appear in the Editor. By clicking the double up-pointing arrows in the top right of the Editor pane you will reveal the filtering tabs. Using the [+] you can add additional filtering parameters. Likewise you can remove filters by using the [X].

General Filter

The General Filter works across all columns. Think of it as a blunt force filter. The terms you are searching for are either in or are not in the dataset.

Attribute Filter

With the Attribute Filter you can do finely tuned searches specifying whether a term is found, or not, within a specific attribute.

NOTE: At any point you need to backtrack or start over select the General Filter tab and click the [ Reset ] button.

General Filtering

Here is the character nodeset from part 7 of the Foundation dataset.
Using the General Filter on the Foundation dataset we'll use it to find the military officers on the world Kalga. Note that Kalga is in the attribute HomeWorld and police is in the attribute profession. After typing kalga into the search box ORA filters out all entries which do not contain the world kalga.
Next military is typed into the search box. Remember to leave a space in-between each word. And since Match all is selected ORA filters out all entries with do not include BOTH kalgan and military. Only one entry corresponds to both.

Now let's change the conditions from Match all to Match at least one. Now every entry which has either kalgan -OR- military shows up.
Attribute Filtering

Single Attribute Filter: Click the leftmost drop down and select profession. Click the middle drop down and select is one of. Type politician or spy into the textbox. Four characters fit this filter and are displayed in the Editor.
Multiple Filters using AND: The search can be further refined by adding additional parameters. Click the [New filter] button to create a second filter parameter. It will appear directly beneath your first filter. Click the leftmost drop down and select home world. Click the middle drop down and select is one of. Type terminus into the textbox. This eliminates the character portirat_hart from the search as there is no home world specified for that character.

Multiple Filters using OR:

Leaving the filter parameters the same we'll now change the condition from AND to OR. This means that a character will be displayed in the Editor if either the profession or home world match.
Fold Network

Folding a Network answers the question of what the row or column nodes have in common.

For example, folding the rows of an Agent x Knowledge network creates a new Agent x Agent network whose agent to agent link values are the number of knowledge the two agents have in common.

Folding the columns of an Agent x Knowledge network creates a new Knowledge x Knowledge network whose knowledge to knowledge link values are the number of agents that have both knowledge.

Mathematically, Folding a Network by row multiplies the network by its transpose, and folding by column multiplies the network transpose by the network. Both result in a square, symmetric network.

To fold a network within ORA, right-click on any network from a meta-network in the Meta-Network Manager. A context menu will appear from which you select Fold Network...
First choose whether to fold by rows or columns, and supply an output network name:

![Fold Network - knowledge dialog box with options and output network name.](Image)

The new network agent x agent - shared Knowledge will appear in the Meta-Network Manager.

Examining the network in the Network Editor will show that the diagonal gives the number of knowledges each agent has, and the off-diagonal is the knowledge agents have in common.

Folding can also be done in the Matrix Algebra tool under Data Management and selecting the Fold Rows or Fold Columns operation (or manually by multiplying the network by its transpose):
Hovering Tooltips

Pausing the mouse pointer (hovering) over window elements such as buttons or text will often bring up information about the item and sometimes additional functionality after a brief delay. These tooltips will disappear after the mouse pointer is moved or automatically on a timeout. The presence and content of the tooltip is dependent on the object hovered over.

- Hovering over buttons gives a brief text description of their function.
- Hovering over some text elements will describe the contents.
- For information about meta-networks, networks and nodesets, instead of hovering select the meta-network in the Meta-Network Manager Pane (3) and examine the details in the Editor Pane (4).

Hovering over the Add Network button produces the tooltip text "Add Blank Network" describing the button's function.
ID Names

Working with Names

Each meta-network, nodeset, and network can be given a distinct Name. At times this can be very helpful when working with multiple meta-networks it can also cause problems with certain functions.

```
<table>
<thead>
<tr>
<th>Node Class ID</th>
<th>Node Class Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg1_universe</td>
<td>agent</td>
</tr>
<tr>
<td>stargate_summit</td>
<td>agent</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Class ID</th>
<th>those guys</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg1_universe</td>
<td>agent</td>
</tr>
<tr>
<td>stargate_summit</td>
<td>agent</td>
</tr>
</tbody>
</table>
```

Here I renamed one of the nodesets to those guys. It is also reflected throughout all of meta-network Panel. You can rename any meta-network, nodeset, or network for better readability.

Areas Where It's Important to Maintain Name ID Integrity

View Measures Over Time: This function allows an analyst to see how a network measures change over multiple time periods. So in order to track measures over time it is necessary that the ID Names of the networks are the same in all instances.

View Networks Over Time: This function allows you to set up multiple networks that encompass various time frames and view them in succession. Since you want to see what happens over the same Network Over Time it becomes virtually important to make sure the ID Names of these networks are all the same. Else ORA will not be able to analyze them correctly.

Comparing Networks: When ORA runs measures on networks it's sometimes necessary to do have identical Network names. This will be listed in the Measures section.
Info Tab-Node sets

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to display information regarding the meta-networks, nodesets, and networks. But this is the area where you can rename the Nodeset Name and change the Nodeset Class to a different MetaOntology. To rename a nodeset place the cursor in the box, make sure the entire name is highlighted, and type in your new name. The Display nodes by function determines what attribute will be displayed when visualized.

This area also gives you the Node Count of the selected nodeset as well as the Attribute Names contained within the nodeset.

The Display nodes by dropdown allows you to select the text that will be displayed for the nodes of this nodeset in the Visualizer. Each nodeset can be set individually.

The Editor tab contains most of the editing functions.
The Search box (with the magnifying glass) is for finding particular node(s) in a nodeset.

The Set filter (the downward facing triangle) is for displaying only a particular subset of node(s).

The Check boxes to designate which nodes to Delete or Merge.

The Nodes buttons are to Create, Delete, Merge, Move, and Clean nodes in a nodeset.

The Attributes buttons allow you to Create, Import, Export, Delete, and add measure values to a nodeset.

The Meta-Network Create button will create a blank meta-network based on the nodes in the Editor. You can select either or both Visible nodes and Selected nodes. This is noted near the bottom of the frame.
**Info Tab - Networks**

When a network is selected there are also two tabs, Info and Editor.

The Info tab contains a textbox, Network ID in which you can change the name of any network, the source and target nodesets, and whether this network is directed or not, the link count, and the density.

The two buttons underneath allow the choice of Visualize this Network which will send the entire meta-network to the visualizer or Visualize Only this network which display only the currently selected network.

Below is an image of Info and Editor tabs in ORA.

![Info and Editor tabs in ORA](image)

Network ID: Allows you to rename the network.

Source class: Displays the source nodeset i.e., the leftmost column in the graph.
Target class: Displays the target nodeset i.e., the topmost row in the graph.

**Network Properties: Symmetric, No Self-loops, and Binary Link Weights**

Place a check mark in the box(es) which you want to include.

**Network Statistics**

Gives information regarding the selected network.

**When Computing Measures**

The purpose of this is to let the user tell ORA what links should be used and how they should be interpreted when computing measures, as this affects the results. The areas are: Symmetric/Or Not, Self-loops/Or Not, and Binary/Weighted.

If you want ORA to treat the data as symmetric if it is symmetric, then use Auto-Detect. This option will test if the network is symmetric, record the result, and use that result when computing measures. The same goes for binary and self-loops. If all the links in the network are of weight one, then the network assumed to be binary (but if there is a link with a weight other than one, then it is assumed weighted). Lastly, if the network has no self-loops, then it is assumed it cannot have any.

If, for example, there just happens to be no self-loops, but there could be, and the user wants the measure to take that into account, then the user would select TRUE. On the other hand, if are self-loops and they should always be ignored, then the user can choose FALSE. Note that FALSE does not change the network data in any way, but the measures just ignore the loops.

The Editor tab has two views: Binary and Numeric.

Binary view is used when you only need to establish a connection between two nodes with no weights. It's a simple Yes or No arrangement.
The Numeric view allows you to treat links between various nodes with more or less importance. Notice that all the row nodes have a check marked connection to the column containing [yu] in the binary mode. This denotes they know one another. But in the numeric mode this value is a 0.5 which is used to denote previous acknowledgement but is an adversary.

The Convert Links button contains options for converting links in a network.
Binarize link weights (x 0 -> x = 1)

Collapse link weights (a=x=b -> x = 1)

Negate link weights (-x)

Invert the link weights (1/x)

Logorithm of the link weights (log10(x))

Absolute value of the link weights (|x|)

Row-Normalize the link weights (x/OutDegree)

Increment the link weights (c + x)

The Remove Links buttons deletes all links for the selected condition and the value of the links you wanted removed.

Less than

Less than of equal to

Equal to

Not equal to

Greater than or equal to

Greater than
Info Tab - Network - Statistics

The Info Tab: Display relevant information whether a nodeset or network is highlighted.

**Network properties:**
- Symmetric (undirected links)
- No self-loops
- Binary link weights

**Network statistics:**
- Source count: 31
- Target count: 31
- Link count: 168 (excludes self-loops)
- Link weights: Binary
- Density: 0.17481790
- Self-loops (diagonal): None
- Symmetric?: Yes

**When computing measures:**
- Treat as symmetric: Auto-detect
- Ignore self-loops: Auto-detect
- Treat as binary: Auto-detect

**Network Properties**

Symmetric (undirected links): Create additional links to maintain symmetry of the network. [e.g. you create a link A > B and ORA would automatically create the link B > A of the same weight.]

No self-loops: Disallows a link to be set back to node to itself.

Binary Link Weights: This will set all link weights that are not [0] to [1]

NOTE: Changing these options for existing networks can have huge impact to your data. Changing a network from weighted to unweighted will set all link weights $w_{uv}$ to 1.0. These options also have implications for the editor. If the option is set to directed network then changing the value $w_{uv}$ in the matrix will automatically change the value $w_{vu}$. 
Select How to Treat Links When Computing Measures

You can use this to control how Links and Properties are handled for each individual network when measures are run on the networks.

NOTE: These options are "temporary" version of the network properties. They do not affect the actual meta-network.

Under Select how to treat the links when computing measures: you can select between True, False, and Auto-detect.

Treat as symmetric: Symmetrizes the network for the calculation, e.g., if the line weight \( w_{uv} \) is larger than \( w_{vu} \) then \( w_{vu} \rightarrow w_{uv} \).

Ignore self-loops: All diagonal elements are set to 0.

Treat as binary: The link weights for all \( w_{uv} \) with \( w_{uv} \neq 0 \) are set to 1.

The default setting for these is Auto-detect. If the network is symmetric, then when computing measures the network is considered as symmetric. Similarly, if the network has only binary link weights, then when computing measures the network is considered binary. The user can also explicitly set to True or False whether the network should be treated as symmetric, without self-loops, or binary.

To change the settings, select the network and change one or more of the three controls in the info window of a network in the section Select how to treat the links when computing measures.

Whenever ORA calculates a measure (independent from which measure calculation you select) a network will be pre-prepared based on the settings of these primary measure parameters. These setting do not change the original data but the way ORA handles the data when calculating measures. To actually convert the data you can change the network parameters (see section 2) or use other procedures to have more detailed options (e.g. symmetrize by minimum value). You can find an introduction into these procedures in section 2.7.
Link Attributes

Links between nodes may be of different types. For instance a single group of individuals may be multiply connected by different kinds of links: kinship or marriage, shared location, business or social connections, gender and so on. To distinguish linkages of different types in ORA, create multiple networks within a meta-network using a common nodeset or nodesets. Each network represents a different link type. ORA supports the visualization and analysis of meta-networks as a unit or using selective components.

Some network representations distinguish multiple link types by adding attributes to links (e.g. links are labeled in addition to being given weights). In ORA, such link attributes have been deprecated in favor of using multiple networks associated within a meta-network.

Example

Napoléon Bonaparte, as Napoleon I, Emperor of the French, was both head of state and commander-in-chief. As such, he rewarded selected individuals with promotions and titles. At the highest levels, certain military officers were were honored with the rank of Maréchal d'Empire (Marshal of the Empire), based on their perceived loyalty to Napoleon, battlefield record or past achievements. He also selected certain individuals as heads of state for conquered or satellite states which were not incorporated directly into France. Generally Marshals were selected from officers with distinguished records or direct connection to Napoleon while sovereigns of nominally independent states were selected from Napoleon's siblings or children. (Marshals were often granted titles, some honorary and some representing small principalities, but, with two exceptions, Marshals were not made sovereign even in cases where they were effectively ruling foreign states.)

To represent the linkages, the following components were created in a meta-network "Napoleon I Relations":

- **Nodesets**
  - **Agent** - List of historical individuals, undifferentiated (agent characteristics can be held as attributes if desired). Nodeset class Agent.
- **Networks** - (all networks are Agent x Agent)
  - **Children** - Child/parent relations, whether natural or adopted. Links are reciprocal.
  - **Made Sovereign** - Unidirectional links from Napoleon to selected individuals who were made ruler of a (nominally) independent state.
  - **Marriage** - Reciprocal links between married couples.
- **Promoted to Marshal** - Unidirectional links from Napoleon to all individuals created marshals in the First Empire (between 1804 and 1815).
- **Siblings** - Reciprocal links between siblings.

Note that the various kinship relationships are differentiated by holding them in separate networks. This provides a more nuanced view of relationships that could, more simplistically, be rendered as "Kinship to Napoleon".

Visualization of the marshals of the empire and Napoleon's siblings, spouses and children (some selected linking individuals are also included). Blue links show kinship and marriage connections. Red shows individuals promoted to marshal. Green shows individuals made sovereign.

This visualization shows Napoleon's preference to choose sovereigns from close relatives. Hence most of Napoleon's siblings were made sovereigns, which results in multiple links between Napoleon (center) and his siblings. The notable exception is his brother Lucien, who, after working with his brother throughout the Consulate, opposed his brother assuming the title of emperor and left France for self-imposed exile.
Selected marshals (Murat, Davout, and Bernadotte) and their relationships to Napoleon. Blue links show kinship and marriage connections. Red shows individuals promoted to marshal. Green shows individuals made sovereign.

In this visualization, showing a subset of the meta-network, three Marshals of France with multiple relationships to Napoleon are shown. Davout married the sister of Pauline Bonaparte's husband, a French general. This connection is not generally invoked as central in Davout's relationship with Napoleon (although the couple was notably devoted to each other). Bernadotte married Désirée the sister of Joseph Bonaparte's wife Julie, who had been engaged to Napoleon prior to his marriage to Josephine. This relationship is sometimes invoked to explain Bernadotte's relatively gentle handling after he displeased Napoleon on multiple occasions (Bernadotte eventually became the King of Sweden, with Napoleon's approval but not on Napoleon's initiative, hence no "Made Sovereign" link is shown). Murat, married to Napoleon's sister Caroline, was made the King of Naples, the only marshal made a sovereign by Napoleon.

Note that this rendering is a highly simplified representation of the relationships of one of the most famous and studied individual in European history. Napoleon promoted and demoted sovereigns, marshals died in battle or were sidelined without assignment for non-performance and states were created and extinguished as politics and the fortunes of war dictated. A more detailed representation in ORA, adding the dimension of time using a dynamic meta-network, would capture some of this complexity.
Measure Charts

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, Histogram, and Regression.

NOTE: The measures run can be changed by select from the main menu Analysis > Measures Manager.

Save Measures

Use this button to save results measures to a text file. This file can be opened in either Excel or a text editor. ORA will not attach an extension to this file and it is suggested to give it either a .txt or .csv extension.

Opening the File

Opening this file in Excel, making sure to import it as a delimited file, will give you the measures it can use and the values associated with each node in the nodeset chosen. You will notice that the names of the characters are characters_1, characters_2, and so forth. In this particular nodeset the Node ID contained the text characters_ plus a number and the Node Title contained the actual name of the character. This function used the Node ID when it exports this information.
<table>
<thead>
<tr>
<th></th>
<th>Measure</th>
<th>Input networks</th>
<th>Input node classes</th>
<th>Input parameters</th>
<th>characters 1</th>
<th>characters 2</th>
<th>characters 3</th>
<th>characters 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>capability</td>
<td>characters x Location</td>
<td></td>
<td></td>
<td>0.9933072</td>
<td>0.9338295</td>
<td>0.2926904</td>
<td>0.0378589</td>
</tr>
<tr>
<td>2</td>
<td>cognitive distinctiveness</td>
<td>characters x Location</td>
<td></td>
<td></td>
<td>0.42</td>
<td>0.33</td>
<td>0.29</td>
<td>0.37</td>
</tr>
<tr>
<td>3</td>
<td>cognitive expertise</td>
<td>characters x Location</td>
<td></td>
<td></td>
<td>0.015625</td>
<td>0.1041667</td>
<td>0.2291667</td>
<td>0.3352273</td>
</tr>
<tr>
<td>4</td>
<td>cognitive resemblance</td>
<td>characters x Location</td>
<td></td>
<td></td>
<td>0.58</td>
<td>0.67</td>
<td>0.71</td>
<td>0.69</td>
</tr>
<tr>
<td>5</td>
<td>cognitive similarity</td>
<td>characters x Location</td>
<td></td>
<td></td>
<td>0.3860295</td>
<td>0.4101945</td>
<td>0.3309044</td>
<td>0.0890994</td>
</tr>
</tbody>
</table>
Meta-Node Analysis

Meta-nodes are nodes which contain other nodes. Meta-nodes can be created by a number of methods, some of which create a single merged node from the input nodes and others which allow the meta-node be decomposed back into the constituent nodes. For analysis purposes, merged meta-nodes are required. Such merged meta-networks are equivalent to ordinary meta-networks and can be analyzed using ORA's regular analysis tools and reports.

Creating an Analysis Ready Meta-Network of Merged Meta-Nodes

ORA provides attribute based meta-node creation methods to create meta-networks containing merged meta-nodes:

- Attribute Value Tool - this tool contains a Meta-Nodes operation which provides the most control over meta-node creation.
- Combine nodes by attribute value - included under the nodeset editor Attribute command, this command allows a user to create merged meta-nodes in a single meta-network.

For these commands, the content of a single attribute controls the creation of merged meta-nodes. Nodes with identical attribute values are merged into meta-nodes; nodes with a unique attribute value are maintained unchanged. All types of attributes can be used; categorical attributes are often employed for this purpose.

For example purposes, a categorical text attribute was added to agent nodes representing employees in a fictive software company. The Job Category attribute identifies two sets of multiple agents with the same job. The remaining agents have unique job categories.

Note: Meta-nodes created in the ORA Visualizer are decomposable rather than merged meta-nodes and are not directly analyzable.

Considerations in Creating Merged Meta-Networks

Creating merged meta-nodes will either add additional networks and nodesets to a meta-network or alter original nodesets and networks depending on the command employed. These differences are noted in the examples below. When performing analyses on the merged data, the user must identify the required input data format and perform any necessary restructuring or renaming within the merged meta-network.
Creating a Merged Meta-Network with the Attribute Value Tool

This command will create a new meta-network containing the merged meta-nodes. The source meta-network will not be altered.

In the menu bar, select the Data Management > Attribute Value Tool... to open the Attribute Value Operations dialog.

Select Meta-Networks

Select the meta-networks to manipulate - From the list of meta-networks below, check one or more meta-networks for merged meta-node creation. In this instance, a single meta-network was selected.

After selecting the meta-networks, click the [ Next > ] button to advance to the Attribute Value Operations pane. (Alternatively use the [ Close ] button to close the dialog.)
Attribute Value Operations

Set the operations to run. Select the Meta-Nodes operation in the left pane. The right pane will show meta-node creation options.

This page creates a new meta-network that uses the attribute values to create meta-nodes.

Nodeset - From the pulldown select the nodeset containing the attribute to create merged meta-nodes. In this example, the agent nodeset is selected.
Attribute - From the pulldown select the attribute which will control the creation of merged meta-nodes. In the example, the Job Category attribute is selected. Nodes which have the same attribute value will be merged.

Select the attribute values to use when creating meta-nodes, and also which links to create: Each of the tabs allows the user to control the inclusion of nodes in the new meta-network.

Attribute values - Provides a list of the attribute values for the attribute selected to control the creation of merged meta-nodes. Checking a value will include it in the creation of merged meta-nodes, unchecking the value will exclude it. Note that nodes with unchecked values will be excluded from the merged meta-network entirely. To prevent meta-node creation while including the node, the attribute value should be changed. In the example, all values are checked (the default).

Internal links - Provides a list of the links between the selected nodeset nodes (i.e. the one mode networks). Checking a link will include it in the merged meta-network and unchecking it will exclude it. In the example, the agent nodeset is selected, so all links in agent x agent networks will be listed here.

External links - Provides a list of the links between the selected nodeset nodes and other nodesets (i.e. the two mode networks). Checking a link will include it in the merged meta-network and unchecking it will exclude it. In the example, the agent nodeset is selected, so all links in agent x <not-agent> networks will be listed here.

For all tabs, use the [ Select All ] button to check all values and the [ Clear All ] button to uncheck all values.

Copy the input networks and links used - Controls whether the new meta-network containing the merged meta-nodes also includes copies of the before merge inputs. Check this option to include copies of the original nodeset and networks. Unchecking it will create a copy including only merged items. In both cases copies of the nodesets and networks not affected by the merge will be included. In the example, checking the option will include both the original nodeset "agent" and a "Meta agent" nodeset as well as the relevant networks (e.g. both "agent x agent" and "Meta agent x Meta agent - agent x agent" networks will be included). The unaffected nodesets "knowledge" and "task", plus associated networks are always included.

Create meta-nodes with link values - Check to compute link values during the meta-network creation (checked by default). Then, from the pulldown menu, select which method will be used to compute the link values:

Link sum (default) - Link value is the sum of the constituent node's link values.
Link count - Link value is the number of times the link was present in the constituent notes.

Density - Link value is proportion of constituent links which have a given link. For example if four nodes are merged and one has a link to a different node, the link value will be 0.25 and if all four are linked the value will be 1.0.

After entering all input options, click the [ Run ] button to create the merged meta-nodes. The dialog will remain open to allow additional merged meta-nodes to be created. (Alternatively use the [ < Back ] button to change the input meta-network.) When all merged meta-nodes have been created, use the [ Close ] button to close the dialog.

After performing the attribute merge, a copy of the meta-network software_company - w/Job Category has been created with an additional nodeset ("Meta agent") and networks ("Meta agent x knowledge - agent x knowledge", "Meta agent x Meta agent - agent x agent", "Meta agent x task - agent x task") containing the merged meta-nodes.

Creating a Merged Meta-Network in the Editor Pane

An existing meta-network can be modified into a meta-network containing merged meta-nodes using the meta-network editor. Note however, that using this method to
perform the merger will permanently alter the meta-network contents. Generally a copy of the meta-network should be preserved prior to starting the merge process.

This merge uses a single attribute to merge a single nodeset and all networks using the nodeset. In the following example, in a list of employees (nodeset agent), the attribute Job Category, containing a set of text categories, is used to create meta-nodes containing all employees of a given type.

To perform the merge, expand the meta-network in the Meta-Network Manager pane and select the nodeset containing the attribute to control the merge. Then select the Editor tab in the edit pane and select the command Attributes > Combine nodes by attribute value to open the Merge Nodes By Attribute Value dialog.

In this example, the agent nodeset is selected, then the Attributes > Combine nodes by attribute value command is run.
In Merge Nodes By Attribute Value dialog select the attribute to merge nodes.

Use this merge nodes that have the same value for a particular attribute. Select an attribute and each distinct attribute value becomes a node.

Select an attribute: - from the pulldown list select the attribute containing the merge. "Job Category" is selected in the example.

After selecting the attribute, click the [Merge] button to create the merged meta-nodes. (Alternatively use the [Cancel] button to close the dialog.)

When nodes are merged, the merged node combines elements of the constituent nodes:

- **Links**
  - The meta-node's links are the union of links of the constituent node's links.
  - The link value is the sum of the constituent node's link values.
- **Attributes**
  - The categorical attributes are unioned and duplicates eliminated. Multiple values can occur for a single node.
  - The numerical attributes are summed.

In the example above, note the multiple values present for the "Alias" and "US Resident" attributes for the nodes "Business Analyst" and "Software Engineer". Also note that the agent nodeset size has been reduced from 16 to 12 due to merged meta-node creation.
Analyzing Merged Meta-Nodes

A meta-network containing merged meta-nodes can be analyzed as a regular meta-network. Normal caveats regarding structure and data types apply. For instance, for some reports (e.g. Twitter, Blog) the input meta-network must contain a specific set of input matrices; any merged meta-network must maintain the appropriate structure.
Network Editor

With a network highlighted and the Editor tab displayed ORA has many functions for working with nodes and links in a network.

Search Nodes...

Search type 1

Using the Search box and the [AND/OR] selector you can refine a search on a network.
With the [AND/OR] selector set to AND I type lady into the Search box. This results in two rows/columns being highlighted, lady_jessica and lady_fenring.

To refine the search I type jessica into the Search box (making sure to place a space between the words). This eliminates lady_fenring leaving only lady_jessica highlighted.

Without changing anything in the Search box I change the AND to OR in the [AND/OR] selector and it now reveals any node with either lady OR jessica.

NOTE: Identical search results were achieved with different parameters.
Search type 2

This search is similar as the primary search but with two Search boxes for added refinement.

Find a link...

Choosing two nodes in the two dropdown menus will locate the link in the matrix.

NOTE : The box to the right of the node dropdowns is for setting the weight of the link.

Remove All Links : Removes all links from network.

Remove links by value : Allows you to set parameters for the values of links which you want to remove.

Remove self-loops (diagonal) :
Removes links connecting a node to itself/

Symmetrize by method : Gives for options : Maximum, Minimum, Sum, and Average.
Convert Links: Gives options for changing the value of links in a network.

- **Binarize** link weights \( x \neq 0 \Rightarrow x = 1 \)
- **Collapse** link weights \( a \leq x \leq b \Rightarrow x = 1 \)
- **Negate** link weights \(-x\)
- **Invert** the link weights \( \frac{1}{x} \)
- **Logarithm** of the link weights \( \log_{10}(x) \)
- **Absolute value** of the link weights \( |x| \)
- **Scale** the link weights \( c \cdot x \)
- **Row-Normalize** the link weights \( x / \text{OutDegree} \)
- **Increment** the link weights \( c + x \)

**Highlight**

- **Clear all**
- **Highlight isolates**

Clear all: Clears all highlighting from rows and columns.

Highlight isolates: Highlights rows and columns of any node with has no connections to any other nodes in the network.

| aramlee_ass. | barn_pilgrim | chen | count_has | g_pardot | g_welling | dhu_wells | duncan_n. | elwood_l. | first_under | gordon | glossu_r. | guildman | gummers_blow | haran_jams | harkonnen_c. | jame | kari_whiffs | lady_fennig | lady_jessica | lea_lawrence | leonard_k | let_ik_rans. | paul_abides | pilot_de_vito | powell_island | reverend_roth | reverend_roth_2 | shudder_mage | space_guild | stirgar | thufy_husk | tila_yorke | vogue | wrenn | yarvik | zélie | \# |
|-------------|--------------|------|-----------|----------|-----------|-----------|-----------|-----------|------------|--------|-----------|----------|-------------|------------|-------------|------|-----------|-------------|-------------|-------------|-----------|------------|-----------|-------------|--------------|--------------|------------|--------|-----------|-----------|-----|--------|--------|-----|---------|-------------|----------|------------|--------|-----------|-------------|------------|------------|--------|---------|---------|-----|
| 0           | 0            | 0    | 0         | 0        | 0         | 0         | 0         | 0         | 0          | 0      | 0         | 0        | 0           | 0          | 0           | 0    | 0         | 0           | 0           | 0           | 0         | 0         | 0         | 0           | 0          | 0           | 0      | 0        | 0         | 0    | 0       | 0      | 0 |
Show all:
Hide highlighted rows:
Hide highlighted columns:
Node Buttons

Used within the Editor you can manipulate nodes in a nodeset.

NOTE : Any changes done to a nodeset are permanent. There is no Undo.

Create : Inserts a new node(s) into the nodeset. You will be asked for the number of new nodes to create and a node ID. If multiple nodes are to created then a number will be appended to each new node.

Delete : Removes node(s) and all associated link(s) from the meta-network. There are four sub-options viewable by clicking the downward triangle. The nodes deleted are kept in a log which is used for creating a delete list.

Merge : Removes all selected nodes and replaces them with a single node with all previous links and attributes. This is used primarily when data needs to be consolidated. Example : A nodeset contains two nodes, jack and col_o'neill. These are actually the same person. Merge could combine their information into one which could be named col_jack_o'neill.

Move : Move all check marked node(s) to another designated nodeset. ORA will prompt you for the movement of links to other networks that are associated with these node(s).

NOTE : Information on both deleted nodes and merged nodes is kept in a log file which ORA used to create a change list.

Clean : finds all nodes whose IDs are within the edit distance of the selected node. An edit is a change of a single character.
Sub-Set of a Nodeset

With the Search feature you can quickly locate specific nodes. Typing a term into the Search box will display all nodes with that term in their name or attributes.

To the right of the Search box is the AND/OR selector. This is a boolean search tool. AND requires all terms in the Search box to be present in every node. OR will display all nodes with any of the Search terms present.

NOTE: Be aware of how sub-strings work in searches. A search for male will find all values of male as well as female because male is a sub-string of female.

Example

When you start, all nodes will be visible in the Editor. Using the wildcards you can reduce and control what is displayed.

The [*] wildcard

The use of the [*] tells ORA to find all nodes with the string enclosed by the astericks. That string can occur anywhere in the name.
NOTE: Search requires the use of the wildcard character [ * ] both before and after the search term.

```
<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adam</td>
<td>Adam</td>
<td>Create</td>
</tr>
<tr>
<td>Adam Mitchell</td>
<td>Adam Mitchell</td>
<td>Delete</td>
</tr>
<tr>
<td>Adam's Mum</td>
<td>Adam's Mum</td>
<td>Merge</td>
</tr>
<tr>
<td>Corporel Adams</td>
<td>Corporel Adams</td>
<td>Novo</td>
</tr>
<tr>
<td>Madame Kovarian</td>
<td>Madame Kovarian</td>
<td>Clean</td>
</tr>
<tr>
<td>Madame Lamia</td>
<td>Madame Lamia</td>
<td>Attributes</td>
</tr>
<tr>
<td>Madame Vastra</td>
<td>Madame Vastra</td>
<td></td>
</tr>
<tr>
<td>Madame Vernet</td>
<td>Madame Vernet</td>
<td></td>
</tr>
<tr>
<td>Professor Adam Colby</td>
<td>Professor Adam Colby</td>
<td></td>
</tr>
</tbody>
</table>
```

NOTE: Highlights done to emphasize the search. ORA does not highlight these in the actual program.

NOTE: The Search functions works on the nodeset as a whole meaning there's no selecting one single attribute to search. A term found anywhere marks that node to be displayed.

**The [?] wildcard**

Unlike the asterick the question mark substitutes for only a single character. In the example the first node is 3rd Officer Jane Blythe. Typing ?rd* tells ORA to search for the string rd which contains any one preceeding character and any amount of trailing characters. It locates three nodes which match
Adding a second ? tells ORA to search for the string rd which contains any two preceeding character and any amount of trailing characters. 3rd Officer Jane Blythe is no longer found as there is only one character preceeding the rd string.

Adding a third ? to the search produces a third set of results.
Filters

Filtering allows you to select specific nodes to display in the Editor. A check mark tells ORA to display a node with an equal value.

The [Clear all filters] button removes the filter parameters from that particular column only. It does not affect any other filters you have set elsewhere.

Deselecting all except (blanks) will display any node which has a null value. This is useful when you need to fill in attributes for blank nodes.

With Define a custom filter you can specify a filter in greater detail. If there were three nodes with attributes of city-1, city-2, and city-3 defining *city* as the filter would display all three. This also contains the Matching [shows only what matches the filter] and Not matching [which shows only what does not match the filter].

When finished click the [Apply] button activate the filter.

You can also set filtering to multiple columns to better define your search. This search required the home world to equal trantor and also sector to equal dahl. Only nodes with both attributes are displayed.
<table>
<thead>
<tr>
<th>Node Title</th>
<th>Corr</th>
<th>Corr</th>
<th>home world</th>
<th>job_title</th>
<th>sector</th>
</tr>
</thead>
<tbody>
<tr>
<td>yugo_amaryl</td>
<td>0.0498787</td>
<td></td>
<td></td>
<td>trantor</td>
<td>dahl</td>
</tr>
<tr>
<td>gambol_deen_namarti</td>
<td>0.181356</td>
<td>male</td>
<td></td>
<td>trantor</td>
<td>doctor</td>
</tr>
<tr>
<td>raych</td>
<td>0.30508</td>
<td>male</td>
<td></td>
<td>trantor</td>
<td></td>
</tr>
</tbody>
</table>
Visualize Buttons

There are two Visualize buttons and they work slightly differently.

Visualize this Network

The Visualize this Network visualizes the chosen network. In the Legend dialog box all nodesets and networks are available.
Visualize Only this Network

The Visualize Only this Network visualizes the chosen network. But in the Legend only the nodesets and networks chosen are displayed. This is a much quicker means to display a network as ORA only makes computations for the chosen network.

Clicking on the downward triangle brings up the dropdown menu with additional options for visualizations: Network Drill Down, Visualizer 3D, Visualizer 2D, Node Cloud, Path Finder, Sphere of Influence, and Node Selector
File Menu

Below is an image of the File Menu accessible from ORA’s main title bar menu. Further below are descriptions of the various tools accessible through the File Menu.

Open Meta-Network… Open a single network stored using DyNetML format (the native ORA xml format).

Large-Scale Load… Open a tool is specifically intended to handle large files which otherwise may be difficult to manipulate due to the sheer number of entries (particularly tab-separated (TSV) or comma-separated (CSV) values files).

Data Import Wizard… Import date to augment or create meta-networks using a wide variety of data types.

Data Export… Allows you to export a meta-network in a variety of formats: DyNetML, Table format, Advanced Table Format, Matrix, Node List, UCINET (binary), UCINET (text), NetDraw (.vna), Pajek (.net), C3Trace, CMapTools, or Analyst Notebook.

Manage CASOS Database...

NOTE : This function only available in a full version of ORA.

Open Workspace… Allows you to open an entire workspace that you were previously using. A workspace consists of a set of meta-networks that were all open at the same time, and saved as a workspace.

Pile Sort… Allows a user to load a series of entities such as concepts which can then be organized into a piles. The output will be a network in DyNetML format.

NOTE : This function is not available in all ORA versions.

Text to Network Wizard : Extract networks from texts and assign sentiment at the context level using NetMapper.

NOTE : This function is not available in all ORA versions.

Save Meta-Network : Save a copy of the currently selected meta-network(s) to file(s). If a file copy of the meta-network does not already exist, a dialog will open to set the file name and location.

Save Meta-Network As… Allows you to save the changes in a meta-network under a new filename.

Save Workspace : Saves the active meta-networks into a Workspace which can be opened up at a later date.

Exit : Closes ORA after providing an opportunity to save any unsaved data and set options for the next time you open up ORA.
NOTE: Save options are only displayed when unsaved meta-networks or change lists are present.

Meta-networks are modified. - If you have any meta-networks with unsaved changes you can save them by clicking [Save]

The change list is modified. - If you have any change lists with unsaved changes you can save them by clicking [Save]

NOTE: The restart settings, once set, will be retained from run to run.

What should ORA do when it starts again?

Restore the workspace - If checked, the next time ORA is started it will load any meta-networks currently open when it was last closed.

Restore preferences - If checked, all preferences from Edit > Other... will remain in effect. If not then ORA will resort back to it's defaults.
Opening Files in ORA

ORA provides several commands to process and load data from files and other data sources:

- **Open Meta-Network…** - Loads a meta-network stored in DyNetML format. DyNetML is an XML derivative language for networks used by ORA to store meta-networks in files.
- **Large-Scale Table Importer…** - Is a tool specifically intended to handle large files which otherwise may be difficult to manipulate due to the sheer number of entries.
- **Data Import Wizard…** - The Data Import Wizard provides methods for building meta-networks from data in formats other than DyNetML.

**Open Meta-Network**

The Open Meta-Network command reads networks stored in DyNetML format. DyNetML is an XML derivative language for networks used by ORA to store meta-networks in files.

From the Main Menu select File > Open Meta-Network… to bring up the initial open dialog box. Navigate to the folder containing the DyNetML format input file and select it. In the right pane, select one of the load options described below and click the [Open] button to load the file (the Load some things and Create a custom load filter options require additional steps, as described below).
There are three Load Options available:

Load everything - Select to load the entire contents of the DyNetML file.

Load some things: - Select to load only selected parts of the DyNetML file. Then select any or all meta-network elements from the list below. (Deselect items to reduce load times.)

Load sources - Load meta-network sources. Sources are used to describe where objects come from.

Load networks - Load networks and links.

Load link attributes - Load any attributes.

Load as Reduced Form - Convert to meta-network to reduced form during the load. This does the following:

- Symmetrizes unimodal networks (union method).
- Creates only one network per source and target nodeset pair (networks are added together).
- Bimodal networks are combined with their counterpart (e.g. \( AK = AK + AK' \)).
- Networks are put in nodeset precedence order (Agent, Knowledge, Resource, Task).
Create a custom load filter - Select this option to customize the file load in detail. The custom load includes several steps:

- Select the DyNetML file for custom load using the initial dialog and click the [Open] button.
- ORA will compute size and degree statistics for each nodeset and network and open a new dialog to display these values (the Summary tab).

- Using the remaining tabs in the dialog choose the nodes, networks and components and links to load.
  - General Options - This tab controls the following options.
    - Load sources - Check to load meta-network sources. Sources are used to describe where objects come from and can be memory intensive.
    - Load attribute values - Check to load any attributes. Attributes can be memory intensive.
  - Filter by Nodeset - Select/unselect nodesets to load. (NOTE: Unselecting a nodeset removes the nodes contained in it and the
networks it is part of from all following tabs. Re-selecting the nodeset will restore them.)

- Filter by Network - Select/unselect networks to load.
- Filter by Link Value - Select how to load the links from each network based on link value.
- Filter by Node - Select/unselect individual nodes to load.

- After selecting all filter options, click the [ Filtered Load ] button to load the meta-network. (Alternatively click the [ Close ] button to cancel the load.)

The selected file will then appear in Meta-Network Manager pane of the main interface.

NOTE: ORA is designed to work with DyNetML format files. However, data in formats other than DyNetML can be imported and converted using the Data Import Wizard.

Large-Scale Load

The Large-Scale Table Importer is a tool specifically intended to handle large files which otherwise may be difficult to manipulate due to the sheer number of entries (particularly tab-separated (TSV) or comma-separated (CSV) values files).

From the Main Menu select File > Large-Scale Load… to bring up the Large-Scale Load dialog box.

Data Import Wizard

The Data Import Wizard imports and translates data in various formats into ORA data structures.

The Data Import Wizard is intended to allow users to come to ORA with data from various sources in multiple file formats, with sources including (but not limited to) network analytical tools, social media, datasets and general file formats. The Data Import Wizard can be used to create new meta-networks or append data into preexisting meta-networks.

From the main menu bar select File > Data Import Wizard… to bring up the Data Import Wizard dialog box (or click the DIW icon in the toolbar or type Ctrl+w in the ORA editor pane).
Large Scale Table Importer

Description

The Large Scale Table Importer supports the examination and characterization of network data stored in delimiter-separated values files (particularly tab-separated (TSV) or comma-separated (CSV) values files). While files of any size can be checked, the tool is specifically intended to handle large files which otherwise may be difficult to manipulate due to the sheer number of entries. The tool does not currently attempt to interpret the contents of formatted files (e.g. Excel spreadsheet files will not be readily interpretable using this tool).

After file selection, the user can preview file contents, identify the network elements, and perform a number network analyses on the file contents.

Input

The input file must be in a supported delimiter-separated format (tab-separated values (TSV) or comma-separated (CSV) format). The raw data contained in all files using supported file formats can be viewed. To compute network statistics on file contents, the file should contain one-mode or two-mode network data plus optional link weights.

```
"index" "Source" "Target" "weight"
1 901275384 1478802848 1
2 995451746 339617307 1
3 502930441 339617307 1
4 251477464 284991023 1
5 44317593 166109668 1
6 464856468 821451530 1
7 968842267 821451530 1
8 379327714 821451530 1
9 3069584019 821451530 1
```

*Initial 10 lines of a sample four column file in tab-separated value (TSV) format containing two-mode network data*

Result

Displays raw data, selected network statistics computed from the designated input file and identifies groups within the network data. Groups can be selectively saved in files or added to ORA's Meta-Network Manager.
NOTE: To create an ORA meta-network containing the entire input file it can be simpler to use the Data Import Wizard's methods Table of network links or Advanced table.

**Procedure**

Open the Large Scale Table Importer dialog from the GUI command menu: File > Large-scale Load….

![Large Scale Table Importer Dialog](image)

The initial dialog selects the input file and supports viewing the file contents in whole or part.

Select a file to import: Choose the input file. Use the [Browse] button to open a file browser. Navigate to the data file, select the file and click [Open].

Has header row: Check to indicate that the first line of the file contains column headings rather than data.

Load all lines… Check to load all lines in the file for viewing. When unchecked, only selected lines will be loaded (the first/last line controls are activated).

First line:… Set the first line of the file to load for viewing. Type a line number in the text area or use the up and down arrows to increment or decrement the value by 100.
Last line: Set the last line of the file to load for viewing. Type a line number in the text area or use the up and down arrows to increment or decrement the value by 100. (If the value is lower than First Line value, no lines will be loaded.)

[ View ] Click button to load lines for viewing. The button must used to refresh the display if the line parameters are changed.

Results after file selection and view button clicked

Use the [ Next > ] button to advance to the column selection dialog or use the [ Close ] button to close the importer.
To compute network statistics, the input file columns holding the source and target nodes must be identified using the column selector dialog. Each pair of nodes is assumed to be a linked. An optional weight column can also be selected which holds the link weight, an integer or decimal value holding a positive or negative number; a value of zero means no link exists.

Columns
Specify the contents of the columns to import

Source column: Select the column in the input file containing the source node. A network will be created by creating nodes and links for each source and target pair.

Column in File: From the pulldown, select the column containing the source node. The pulldown will contain either a list of column headings (when the Has header row option is checked in the file selection/preview dialog) or column numbers (where the first column is number 1).

Label Format: Indicate the format of the source column. When the source node is identified using a positive integer, ORA can process larger data files by using compact internal representations. Labels can be further compressed by setting a Max label value (below).
INTEGER_ZERO_BASED - Column contains a positive integer, lowest value 0. Can handle values up to at least 4,294,967,295. (Highly compact.)

INTEGER_ONE_BASED - Column contains a positive integer, lowest value 1. Can handle values up to at least 4,294,967,295. (Highly compact.)

LONG_ZERO_BASED - Column contains a positive integer, lowest value 0. Can handle values up to at least 9,223,372,036,854,775,807. (Compact.)

LONG_ONE_BASED - Column contains a positive integer, lowest value 1. Can handle values up to at least 9,223,372,036,854,775,807. (Compact.)

STRING - Column contains a string; all characters supported (including numbers). (Least compact)

Nodeset class: Select one of the predefined nodeset classes for the input.

Agent
Organization
Knowledge
Resource
Belief
Event
Task
Location
Role
Action
Unknown

Labels are node indices: Activates when a Label Format of INTEGER_ZERO_BASED or INTEGER_ONE_BASED is selected. To process larger files, check if the maximum label value is known and enter the maximum value.

Max label: Enter the maximum label value.

Target column: Select the column in the input file containing the target node. When the target node is identified using a positive integer, ORA can process larger data files by using compact internal representations. Labels can be further compressed by setting a Max label value (below).

Column: From the pulldown, select the column containing the target node. The pulldown will contain either a list of column headings (when the Has header row option is checked in the file selection/preview dialog) or column numbers (where the first column is number 1).
INTEGER_ZERO_BASED - Column contains a positive integer, lowest value 0. Can handle values up to at least 4,294,967,295. (Highly compact.)

INTEGER_ONE_BASED - Column contains a positive integer, lowest value 1. Can handle values up to at least 4,294,967,295. (Highly compact.)

LONG_ZERO_BASED - Column contains a positive integer, lowest value 0. Can handle values up to at least 9,223,372,036,854,775,807. (Compact.)

LONG_ONE_BASED - Column contains a positive integer, lowest value 1. Can handle values up to at least 9,223,372,036,854,775,807. (Compact.)

STRING - Column contains a string; all characters supported (including numbers). (Least compact)

Nodeset class: Select one of the predefined nodeset classes for the input.
Agent
Organization
Knowledge
Resource
Belief
Event
Task
Location
Role
Action
Unknown

Labels are node indices: Activates when a Label Format of INTEGER_ZERO_BASED or INTEGER_ONE_BASED is selected. To process larger files, check if the maximum label value is known and enter the maximum value.

Max label: Enter the maximum label value.

Specify how to create links from the file:

Create directed links… Check to create directional links, from the source column entry to target column entry. Uncheck to create bidirectional links where each link connects in both directions.

Create self-loop links Check to create a link from each node to itself.
Use the [ Next > ] button to advance to the file analysis dialog or use the [ < Back ] button to return the file selection/preview dialog. Use the [ Close ] button to close the importer.

![Large Scale Table Importer](image)

*Analysis dialog showing the default selections*

Analyses
Select an analysis to perform. Select the analysis type from the left side panel to display the input parameters.
- **Node Degree**: Identify nodes with high degree values.
- **Components**: Identify groups using the components method.
- **K-Cores**: Identify groups using the K-Cores algorithm.
- **Parsing Errors**: Show errors encountered while reading the input file.

The right pane will change to display the inputs and results for each analysis (the current analysis results will not be lost by switching to a different analysis pane). Each analysis is described in turn below.

Use the [ < Back ] button to return the column selection dialog. Use the [ Close ] button to close the importer.
Node Degree Analysis

Identify nodes with high degree values and display them.

[ Compute ] Click the compute button to determine groups using the current parameters.

Number of top nodes to display:…. Enter the number of nodes to list, starting from the node with the highest degree.

Use link weights : Check to compute the node degree using the link weight instead of the fixed value of 1.

Out-Degree Weighted Tab : Select to list nodes by out-degree.

In-Degree Weighted Tab : Select to list nodes by in-degree.

Total-Degree Weighted Tab : Select to list nodes by total-degree.
Components Analysis

Identify groups using components analysis. A component is a group in which all nodes are connected to each other. Individual components are completely disconnected from each other. In this analysis, link direction is not considered in component determination (weak components as opposed to strong components where link direction is considered). Nodes are placed in at most one component.

[ Compute ] Click the compute button to determine groups.

Results Pane: Output from the Components analysis will be displayed when after the compute button is clicked. The results panel includes the following:

Group Summary: Each line describes a component identified using components analysis. The columns are:
[Select] - Checkbox to select this component for save operations.
Nodes - The number of nodes in the component.
Link Count - The number of links in the component.
Link Sum - The sum of the link weights within the component.
Density - The density of the component.

Sort/Select Options: Operations to organize and select results in the results pane. Selected items can be saved. For a further description, see the Sort/Select Options section for the K-Cores Analysis entry below.
[ Save selected components ] Click this button to save the components (groups) selected in the results pane to disk.

[ Add selected components to Ora ] Click this button to save the components (groups) selected in the results pane to the ORA Meta-Network Manager.

**K-Cores Analysis**

K-Cores identifies groups in a network by recursively removing all nodes with fewer than k links (thus 0-core includes all nodes in a network while 2-core includes only nodes with two or more links). This implementation will apply a series of k values to the input file. Identified groups can be saved to disk or entered into ORA.

The following inputs and controls are provided:

K initial: The initial (lowest) link count used to identify groups.
K increment: An increment value, added to the initial k value repetitively until no further groups are found.

Degree: The type of links counted to determine node degrees.

TOTAL : Use the node total-degree count (both in and out links).
IN : Use the node in-degree count.
OUT : Use the node out-degree count.

Use link weights : Check to use link weights as the link count instead of 1.

Compute k-core component count : Check this option to determine and display the number of groups identified for each k-degree.

[ Compute ] Click the compute button to determine groups using the current parameters.

Results Pane : Output from the K-Cores analysis will be displayed when after the compute button is clicked. The results panel includes the following:

**Group Summary** : Each line describes a group identified for a given k value. The columns are:
- [Select] - Checkbox to select this set of groups for save operations.
- K-degree - K value used to determine groups.
- Nodes - The count of nodes included in the identified groups.
- Components - The count of groups identified.
- Link count - The count of links within the identified groups.
- Link sum - The sum of the link weights within the groups (weight 1 is used unless Use link weights is checked).
- Density - The overall density value for the identified groups.

Sort/Select Options : Operations to organize and select results in the results pane. Selected items can be saved.

Column Sort : The displayed list of blog sites can be sorted by clicking on a column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is ascending. A second click sorts the list in descending order. Clicking a different column header will re-sort the list based on that column's content.

Column Filter : Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu. Select the Filter tab.
The filter menu supports two types of filtering:

**Standard**: The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.

**Custom**: Checking the Define a custom filter: option allows selection of a range of values. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The filter menu allows construction of a logical comparison; line items matching the comparison will be displayed, all other lines hidden:

To create a custom filter, first check Define a custom filter. Then build a conditional statement using the following steps:

Select a relational operator from the pulldown menu:

- Greater or equals
- Greater than
- Less or equals
- Less than
- Equals
- Not equals

Enter a number value for the comparison by typing in the text box.

Optionally, check a boolean operator if a second condition will be defined.

- And
- Or

Select an additional relational operator from the pulldown menu:

- Greater or equals
- Greater than
- Less or equals
- Less than
- Equals
- Not equals

Enter a number value for the comparison by typing in the text box.

[ Apply ] Click to apply the current filter.
[ Cancel ] To close the filter menu. (NOTE: To remove the filter, click the
[ Clear Filter ] button.)

**Selection**

**Individual Selection** : To select individual groups, place a check mark in the left-hand box.

**Multiple Selection** : To select multiple groups, use the controls at the bottom of the Editor pane:

Select/Clear All : Checking this box selects all groups (whether the group is currently displayed or not; items hidden by filtering or outside the viewing window are still selected). Unchecking the box deselects all groups.

Select/Clear Visible : Checking this box selects visible groups under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all groups found by filtering. Unchecking the box deselects just the displayed groups.

For a short tutorial on search features, including additional options, see 9.2 Searching, Sorting, Filtering and Selecting Nodes on the QuickStart Main Interface page.

[ Save selected k-cores ] Click this button to save the groups selected in the results pane to disk.

[ Add selected k-cores to Ora ] Click this button to save the groups selected in the results pane to the ORA Meta-Network Manager.
Parsing Errors

The Parsing Errors dialog lists any parsing errors encountered when reading the input file. There are no user defined parameters.

Special Considerations

The Large Scale Table Importer does not attempt to interpret encoded files (e.g. Excel spreadsheets).

References

None.
Data Import Wizard

The Data Import Wizard provides methods for building meta-networks from data in formats other than DyNetML.

The Data Import Wizard is intended to allow users to come to ORA with data from various sources in multiple file formats, with sources including (but not limited to) network analytical tools, social media, datasets and general file formats. The Data Import Wizard can be used to create new meta-networks or append data into preexisting meta-networks. Data processed into meta-networks can then be saved in using DyNetML (the standard ORA format) or exported using a different data format for other tools or purposes.

Entries in this section instruct you how to use the Data Import Wizard to:

- Design a meta-network - Create blank nodesets and networks that can then be manually populated with nodes and links.

- Import Excel or text delimited files - Create meta-networks from table data:
  - Rectangle of link values (matrix) - Create or augment a meta-network by reading a file or files containing a matrix of node links.
  - Table of network links - Create or augment a meta-network by reading a file or files of linked nodes.
  - Table of node attributes - Augment an existing meta-matrix with attribute data.
  - Advanced Table - Create or augment a dynamic meta-network or meta-network with nodes, attribute or networks by reading a file in advanced table format.
  - Trail importer - Import transition data and create a meta-network or dynamic meta-network suitable for trail analysis.

- Import from another analysis tool - Import network data from files in formats used by other network analysis tools:
  - UCINET (text or binary) - Import data from UCINET, a software package for the analysis of social network data.
  - Pajek - Import data from Pajek, a program package for analysis and visualization of large networks.
**Analyst's Notebook** - Import data from Analyst's Notebook, a software product from IBM used for data analysis and investigation.

**Pen-Link** - Import data from Pen-Link, a telecommunications intelligence and analysis software suite.

**Pathfinder** - Import data from Pathfinder, a software package designed to create networks from proximity data.

**ThingFinder** - Import data from ThingFinder, a tool that analyzes text and automatically identifies and extracts key entity types.

**PersonalBrain** - Import data from PersonalBrain, an application to create diagrams, networks or simply sketch out your thoughts.

**CmapTools** - Import data from the CmapTools, programs used to construct, navigate, share and criticize knowledge models represented as concept maps.

**Palantir XML** - Import information in the interchange format for data derived by Palantir tools.

**C3TRACE** - Import data from C3TRACE, a modeling tool used to conduct "what if" analyses of alternative organizational, personnel, and system configurations, all as a function of information flow and information quality:

**Model** - Import a C3TRACE model.

**Communication Details report** - Import a C3TRACE Communications Details report.

**Pythia** - Import data from Pythia, a tool to create timed influence net models.

**CAESAR III** - Import data from CAESAR III, an application for the design of decision making organizations at the operational and tactical levels.

**Import XML network data** - Create meta-networks using a predefined Extensible Markup Language (XML) format:

**DyNetML** - Import files in the DyNetML format for the exchange of rich social network data.

**GraphML** - Import data using the GraphML file format for graphs.

**Palantir XML** - Import information in the interchange format for data derived by Palantir tools.
**Import other data formats** - Use data from other tools and sources to create networks:

- **JSON data** - Create or augment a dynamic meta-network or meta-network with nodes, attributes or networks by reading one or more files in JSON format.

- **Twitter data** - Create meta-networks from Twitter data stored in different formats.

- **Blogtrackers data** - Create meta-networks from one or more Blogtrackers JSON output files.

- **GitHub data** - Create meta-networks from one or more GitHub JSON output files.

- **YouTube data** - Create meta-networks from one or more YouTube JSON files.

- **Talkwalker data** - Create meta-networks from one or more Talkwalker output files.

- **Pulse data** - Create meta-networks from one or more Pulse output files.

- **NexaIntelligence data** - Create meta-networks from one or more NexaIntelligence Twitter JSON files.

- **VK data** - Create meta-networks using data from the Russian-based online social media and social networking service VK.

- **Survey Monkey data** - Import one or more Survey Monkey XLS+ formatted output files into a meta-network.

- **Shapefile data** - Import geographic shapefiles as a location nodeset.

- **Bibliography & Citations data** - Import citation data output from bibliographic tools.

- **TAVI data** - Import data produced by the CASOS TAVI project.

- **THINK data** - Import data produced by the CASOS THINK project.

- **Import Email** - Import emails from an email server into a dynamic meta-network or meta-network.

- **Import from a database** - Import data from an database using an ODBC connection.
Design a Meta-Network

Description
ORA allows you to create a blank meta-network (a network with no links) using the Data Import Wizard. This meta-network will contain nodesets and networks which can be populated with information either using ORA’s editing features or by importing data from files.

Input
No files are used, all information is entered through the graphical user interface.

Result
A blank ORA meta-network. After creating the empty network you can use the ORA Editor to type in information or use the Data Import Wizard to import information from externally created files.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left box select Design a meta-network then click [ Next > ].

This brings up the dialog box for creating a blank meta-network. (Alternatively, click [ Cancel ] to abort the import.)

Using the following steps you can create a blank meta-network with any number of nodesets and networks.

Step 1: Specify a meta-network name: Use the default name or type the name for your new meta-network in the text box. The meta-network name does not have to be unique.

Step 2: Specify the nodesets to create: Define all nodesets needed. These nodesets may be used to define networks in the following step (nodesets do not have to be used to create a network).

1. Click the [ New ] button to insert a new nodeset.

2. Select a nodeset class from the pulldown menu under Nodeset Class.

3. Optionally, change the default nodeset name to a custom name in the text field under Nodeset Name. Nodeset names must be unique.
4. Specify the size (number of nodes) of the new nodeset in the Initial Size field.

Repeat Step 2 to define all desired nodesets.

NOTE: In the above image two nodesets were created, **employee** and **skill**.

NOTE: The **X** button will remove that particular nodeset from the screen. It will not affect any other nodeset.

NOTE: The [ Clear ] button will remove all current nodeset definitions.

Step 3: Define networks that link nodesets: Define networks to link the nodesets defined in Step 2.

1. Click the [ New ] button to insert a new network.

2. Select a source nodeset and a target nodeset from the pulldown menus under Source Nodeset Name and Target Nodeset Name columns respectively.

3. Optionally, change the default network name to a custom name in the text field under Network Name. Network names must be unique.

Repeat Step 3 to define all necessary networks.

NOTE: The employee x employee network default name was changed to **works with** while the employee x skill network keeps the default name **employee x skill**.

NOTE: The **X** button will remove that particular network from the screen. It will not affect any other network.

NOTE: The [ Clear ] button will remove all current network definitions.

Check to visualize the meta-network Check this option to open a visualizer window containing the new meta-network.

**Create the meta-network:** When you are done defining nodesets and networks click the [ Finish ] button to create the meta-network. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort meta-network creation.)

You will see you newly created meta-network in the Meta-Network Manager Pane.
After creating the empty network you can use the ORA Editor to type in information or use the Data Import Wizard to import information from externally created files.

**Special Considerations**

*None.*

**References**

*None.*
Import Excel or Text Delimited Files

Use the Data Import Wizard to create meta-networks from table data:

**Rectangle of link values (matrix)** - Create or augment a meta-network by reading a file or files containing a matrix of node links.

**Table of network links** - Create or augment a meta-network by reading a file or files of linked nodes.

**Table of node attributes** - Augment an existing meta-matrix with attribute data.

**Advanced Table** - Create or augment a dynamic meta-network or meta-network with nodes, attribute or networks by reading a file in advanced table format.

**Trail importer** - Import transition data and create a meta-network or dynamic meta-network suitable for trail analysis.
Rectangle of Link Values (Matrix)

Description
Network data coded in matrix form can be imported using the Data Import Wizard to create a new meta-network or be appended to an existing meta-network.

Input
Input must be a rectangular collection of numbers as link values. The rows create source nodes and the columns target nodes. The rows and columns can have optional labels. If labels (node names) are included in the file then the upper left cell of the matrix should be empty.

Supported file formats include Excel spreadsheets (including spreadsheets with multiple worksheets) and text delimited value files (including but not limited to comma separated (CSV) and tab separated (TSV) formats).

Result
File contents rendered as a matrix in a new or existing or meta-network. Nodes and nodesets are also created as necessary.

Procedure
The following example will create a new meta-network containing an Agent x Agent matrix using imported data. Additional files will be used to augment the meta-matrix with Agent x Knowledge and Agent x Task networks.

The first file contains agent to agent connections in comma separated value (CSV) format:
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

Select the Import Excel or text delimited files > Rectangle of link values (matrix) option then click [Next >]. (Alternatively, click [Cancel] to abort the import.)
Select a destination: a new Meta-Network, or adding to an existing Meta-Network.

Create a new meta-network with name: Check this option to create a new meta-network. If desired, then enter a meta-network name in the text area to the right (a default name is provided by ORA). In this example, the new meta-network option was selected and a new meta-network name "software company" has been entered.

Add to an existing meta-network: Check this option to append the file contents to an existing meta-network opened in ORA, then select a meta-network from the pulldown menu to the right.

After selecting the target meta-network, click [Next >]. (Alternatively, click [< Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

For this example use the dialog to enter information an import file and the new meta-matrix created from it.

Construct a meta-network by combining data from one or more files. The file format is determined by the filename extension.

Import file: Select an input file containing a matrix and describe the contents.
[Browse] Select an input file. Click the [Browse] button to open a file browser. Navigate to a file containing network data in matrix form, select the file and click [Open]. In the example, a file containing an agent x agent matrix is opened.

NOTE: ORA will use the file type to determine the file format and consequently what questions to ask about the file contents. This example used a character delimited file in CSV format.

File has source headers Indicates that the first item in a row is the source node identifier. Leave checked for this example (default).

File has target headers Indicates that the first item in a column is the target node identifier. Leave checked for this example (default).

File delimited by Specify the delimiter character for character delimited files (default is comma, the standard delimiter for CSV (comma separated values) files). Example file is comma separated, no change is required.

Source type: Set the nodeset class for the source from the pulldown list. For the example file, select Agent.

Name: Set the source nodeset name. A default nodeset name is generated based on the nodeset class. Optionally, you can supply your own name. For the example, use the generated value of Agent.

Target type: Set the nodeset class for the target from the pulldown list. For the example file, select Agent.

Name: Use the generated value of Agent. Optionally, you can supply your own name which should be the same as the value used for the Source type Name value.

Create new nodes Check to add new nodes to nodesets when encountered in the input file. If unchecked, only source/target headers matching existing nodes will be entered in the matrix. The unchecked option is useful when augmenting an existing meta-matrix. Leave checked for the example.

Network name: Set the network name; a default choice is generated by ORA. Optionally, you can supply your own name. Use the generated value of Agent x Agent.

[Click to import from another file] Click this button to describe an additional input file for import. Not used in this example, however see below for an example where this button is employed.
Click [ Finish ]. (Alternatively use the [ < Back ] button to revise the destination parameters or the [ Cancel ] button to cancel the import entirely.)

The Meta-Network Manager pane now contains a new meta-network with the imported network and in the process has created a new nodeset. You can examine these in the ORA Editor.

NOTE : To incorporate additional matrix files into an existing meta-matrix follow the above procedure but use the Add to the existing meta-network option as shown below.

To continue the example, two additional network files are imported. Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane). Select the Import Excel or text delimited files > Rectangle of link values (matrix) option then click [ Next > ].

Check Add to an existing meta-network: then select the software company meta-network from the pulldown menu to the right. Click [ Next > ].
Click the [Browse] button to select the first file to import and incorporate into the existing meta-network. Set the Source type and the Target type parameters each file imported. Add an additional file by clicking the [Click to import from another file] button to import another network.

After all information has been entered for both files click the [Finish] button.

The augmented meta-network can be viewed in the Meta-Network Manager pane.
Special Considerations
None.

References
None.
Import Table of Network Links

Description
The Data Import Wizard can create or augment a meta-network by reading a file or files of linked nodes.

Input
Network data coded with pairs node names and a link weight (contained in Excel or text delimited format files). See Procedure below for a CSV format example.

Result
A new meta-matrix or data appended to an existing meta-matrix.

Procedure
The following example will create a new Agent x Task meta-matrix using imported data.

The input file used for this example contains agent to task connections in comma separated value (CSV) format. The first line is treated as header information. Each of the following rows contains a link between an agent (first column, "Source Id") and a task (second column, "Target ID") with the link weight specified in the third column ("Weight"). Note that these columns can be in any order and the file may contain data in other columns not needed for this network:

NOTE: Although this example uses a link weight of 1, weights may be zero, positive, negative and may be integer or real values. A zero value will not create a link but the nodes will be included in the generated network.
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

From the dialog box select Import Excel or text delimited files > Table of network links. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Select the Create a new meta-network with name option and enter a name for the new meta-network. Then click [ Next > ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Step 1: Select a file containing table data with column headers

Locate the table data file. ORA will scan the file for information used in the following steps prior to creating the network.

Use the [ Browse ] button to open a file browser. Navigate to a file containing the table data for the Agent x Task network, select the file and click [ Open ].

Step 2: Check the columns that contain node names and enter the nodeset information

Describe each of the relevant columns in the input file.

Source Id Column
This column contains agent names.

SOURCE ID column contains: select Node names in the pull down.

Nodeset class: select Agent in the pull down.

Nodeset name: no change, use the generated name "Agent" (you can optionally input your own name).

Make unique: leave unchecked.

**Target Id Column**

This column contains task names.

SOURCE ID column contains: select Node names in the pull down.

Nodeset class: select Task in the pull down.

Nodeset name: no change, use the generated name "Task" (you can optionally input your own name).

Make unique: leave unchecked.

**Weight Column**

This column contains link weights; a non-zero value establishes a link between nodes.

SOURCE ID column contains: leave unchanged. No further inputs required.

Step 3: Define networks and attributes based on the columns

Define a single network.

Use the Networks tab (normally selected by default) to define the network composition.

Click [ New ] to insert a new network definition, then enter the following choices.

Source Node Name - select Source ID in the pulldown.

Target Node Name - select Target ID in the pulldown.
Link Value - select Weight in the pulldown.

Network Name - no change, the generated name "Agent x Task" is fixed.

Network Name Column no change, the input file does not contain a network name column.

Click [ Next > ]. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)

Specify these general input options for the data selections are:

Create new nodes for unrecognized node name leave unchanged, checked by default.

Select how to handle parsing errors default value of Log and continue is acceptable.

Click [ Finish ]. (Alternatively, click [ < Back ] return to the file description dialog to select a different options or [ Cancel ] to abort the import.)
A visualization of the resulting Agent x Task network shows the links between Tasks (blue hexagons) and Agents (red circles).

**Special Considerations**

*None.*

**References**

*None.*
Import Table of Node Attributes

Description
Node attributes are optional information fields which contain additional data about nodes. Attributes are defined at the nodeset level while attribute data is held at the node level (e.g. the attribute age is defined for an agent nodeset and each node will hold a numeric value recording that agent's age).

Input
Attribute data is contained in a single file containing one or more columns of attribute data (.csv, .xls, or .xlsx file extension). The user selects relevant columns, allowing unneeded data to be skipped.

Result
Input file contents appended to an existing ORA meta-network or inserted into a new meta-network. See the Procedure section below for an example of attribute data appended to an existing meta-network.

Procedure
For this example, we augment agent nodes in the "software company" meta-matrix which was created in the Import Matrix Data entry.

The node attribute information for this example is stored in comma separated value (CSV) file with the node (agent) name in the first column and attribute data in the remaining columns. The first item in each of the columns will be used as the attribute name (this file will create attributes named Title, Years Experience, US Resident and Note). In this example, the name field will be used to match the attribute information to the agent nodes. Alternatively, the attribute file row order can be used (where the rows of attribute data are assumed to be in the exact same order as the agent node list in the meta-matrix).
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

From the dialog box select Import Excel or text delimited files > Table of node attributes. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Chose the meta-network to augment with attribute data. Attributes may be added to a new or existing meta-network.

For this example, select Add to the existing meta-network:

Check the **software company** meta-network to add attributes to.

Click [ Next ] to select where to import attribute data. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Indicate if the attribute data should be appended to an existing nodeset(s) or used to create a new nodeset(s).

For this example, select the Import into existing nodesets: option.

Check the **agent** nodeset and uncheck the **knowledge** and **task** nodeset names. Attributes will only be added to the checked nodesets.
Click [ Next > ] to bring up a dialog to describe the attribute input file. (Alternatively, click [ < Back ] return to the meta-network selection dialog to select a different option or [ Cancel ] to abort the import.)

Step 1: Select an attributes file:

Locate the attribute data file. ORA will scan the file for information used in the following steps prior to adding attributes to the network.

Use the [ Browse ] button to open a file browser. Navigate to a file containing the attribute data for the Agent nodes, select the file and click [ Open ].

Step 2: Select how to identify the node(s) to get attribute values from a line of the file:

Define how the attributes will be matched to existing nodes.

Select the Match node names with file column entry.

Select the Name entry from the drop down list. The attributes data file contains a first column with the header entry Name whose values match the existing Agent node names. Each row should contain the attributes for that agent of that name.

Step 3: Select the columns of the file to import as attribute values:
ORA presents the selected attribute file's columns headers. For each column in the input file, indicate if it contains an attribute and, if so, the content type.

**Attribute Specification**

**Select Attributes** The Name entry is inactive because it has already been selected as containing node names in Step 2. The remaining columns (Title, Year Experience, US Resident and Note) contain attribute data and should be checked. (You can use the [Select All] button or check the individual entries.)

**Attribute Type** Define the attributes data type and purpose.

- **Name** Inactive, no attribute type.
- **Title** Select Text Category. The attribute groups nodes into categories (e.g. "Art Director", "Designer", etc.).
- **Year Experience** Select Number. The attribute contains a numeric value.
- **US Resident** Select Text Category. The attribute groups nodes into categories (i.e. "Yes" and "No").
- **Note** Select Text. The entry contains unstructured text for informational purposes.

**New Node Creation** Decide if new node names (names not currently in the nodeset) should create new nodes.

Select the Create nodes for new names entry

Select the Keep all values option

Click [Finish] to import. (Alternatively, click [Back] return to the nodeset selection dialog to select a different options or [Cancel] to abort the import.)
After the import the nodes in the Agent nodeset include the new attributes.

**Special Considerations**

*None.*

**References**

*None.*
Import Advanced Table

Description
Import multi-mode table data (in Excel xlsx, comma separated value (CSV) or tab delimited format) where each row has data for an item. A multi-mode table can contain information for multiple nodesets and networks.

A simple table might represent an address book, where each row contains data about a particular person. A more complex table could encode a dynamic-network, with network, time and attribute information contained in a single file, each row representing a network link with ancillary attribute values.

Input
The advanced table format encodes two types of ORA components:

- Nodesets (nodes and their attributes)
- Networks (networks with constituent nodes, links and date information)

Advanced table processing of these component's characteristics, values and constituent components will automatically create and populate:

- Attributes
- Nodes
- Nodesets
- Networks
- Meta-networks
- Dynamic meta-networks

Advanced table data is encoded in a rectangular table format with each row representing a piece of information. Columns contain categories of information about a piece of information and multiple rows may be used (e.g. to provide multiple values). Column headers are used to label the column contents; conventional heading values are described below but any value is acceptable as long as the column contents are in the correct format.

Since the user dynamically selects individual columns to define the networks, nodes and attributes, the input data file can contain additional data columns holding other information such as notes or references, multiple data items can appear in a table row and columns can appear in the table in any order. In some cases, columns can be
"reused", employed in multiple definitions for a single import, for instance when a single mode network is created using nodes of the same nodeset class.

**Note:** Meta-networks exported using the Data Export Dialog (File > Data Export…) can be saved in advanced table form by selecting the Link List output format option (any file format). Such files can provide a useful guide to formatting input.

The following tables describe the Advanced Table Format for nodeset and networks separately. Note however that both kinds of information can be included in a single file or as separate worksheets in a single spreadsheet, depending on user needs.

<table>
<thead>
<tr>
<th>Advanced Table Input Format - Nodeset</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column Header (Default)</strong></td>
</tr>
<tr>
<td>Nodeset Class</td>
</tr>
<tr>
<td>Nodeset Name</td>
</tr>
<tr>
<td>Node</td>
</tr>
<tr>
<td>Attribute Name</td>
</tr>
<tr>
<td>Attribute Type</td>
</tr>
</tbody>
</table>
| Attribute Value | Attribute Value | The attribute value, text or number depending on the attribute type. Case sensitive (e.g. "Father" and "father" are considered
separate values.) Multiple values are allowed for a given node. Multiple values may be input on separate lines or on a single line delimited by semi-colons ';' (e.g. "231;56;18" will add three number values to the value field). The advanced table import process will concatenate values on separate lines using the node column as the match key but duplicate values will only be entered once.

### Advanced Table Input Format - Networks

<table>
<thead>
<tr>
<th>Column Header (Default)</th>
<th>ORA Name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Class</td>
<td>Source</td>
<td>Nodeset class for the source node, rendered as text. One of the standard nodeset class values: &quot;Agent&quot;, &quot;Organization&quot;, &quot;Knowledge&quot;, &quot;Resource&quot;, &quot;Belief&quot;, &quot;Event&quot;, &quot;Task&quot;, &quot;Location&quot;, &quot;Role&quot;, &quot;Action&quot; or &quot;Unknown&quot;. (Case is ignored.)</td>
</tr>
<tr>
<td>Source Nodeset</td>
<td>Nodeset, Source Nodeset</td>
<td>The source nodeset name, rendered as text. For matching purposes, case is ignored. The capitalization of the first entry found is used for the node name in ORA. The nodeset name must be unique within the meta-network even if the nodeset class is different. If the standard nodeset class values are used for the nodeset name values, the Source Class column is not required as the advanced table import process will assign the corresponding node class automatically.</td>
</tr>
<tr>
<td>Source Node</td>
<td>Node Name, Name</td>
<td>The source node name, rendered as text. For matching purposes, case is ignored. The capitalization of the first entry found is used for the node name in ORA.</td>
</tr>
<tr>
<td>Target Class</td>
<td>Target</td>
<td>Nodeset class for the target node, rendered as text. One of the standard nodeset class values: &quot;Agent&quot;, &quot;Organization&quot;, &quot;Knowledge&quot;, &quot;Resource&quot;, &quot;Belief&quot;, &quot;Event&quot;, &quot;Task&quot;, &quot;Location&quot;, &quot;Role&quot;, &quot;Action&quot; or &quot;Unknown&quot;. (Case is ignored.)</td>
</tr>
<tr>
<td>Target Nodeset</td>
<td>Nodeset, Target Nodeset</td>
<td>The target nodeset name, rendered as text. For matching purposes, case is ignored. The capitalization of the first entry found is used for the node name in ORA. The nodeset name must be unique within the meta-network even if the nodeset class is different. If the standard nodeset class values are used for the nodeset name values, the Target Class column is not required as the advanced table import process will assign the corresponding node class automatically.</td>
</tr>
<tr>
<td>Target Node</td>
<td>Node Name, Name</td>
<td>The target node name, rendered as text. For matching purposes, case is ignored. The capitalization of the first entry found is used for the node name in ORA.</td>
</tr>
</tbody>
</table>
As an example, a single file is used to create a dynamic meta-network of the Welsh canal network over time (as described in Wikipedia in 2016). In this encoding, a series of geographic places form the nodes which are connected by links representing the canals. Since the number of places is small, the resulting network is only approximate in a geographic sense but, like a subway map, provides an abstract representation of the network. The date information defines the duration of the link from completion to abandonment on a decade scale. (Interestingly, the choice of places mentioned varies between articles, depending on the author's orientation and might link original canal features, towns and villages or modern transportation features.)

Using Advanced Data Import, the input file will be used to create:

- A dynamic meta-network "Welsh Canals" containing:
  - One meta-network per decade with:
    - "Location" nodeset of places with the attributes:
      - Canal (may contain multiple values since more than one canal may serve a location)
      - Latitude
      - Longitude
    - "Route" matrix (Location x Location) coding canal connections

See Dynamic Networks for an overview of dynamic meta-networks.

It should be noted that while including networks and attributes in the same input file is feasible, it requires some duplication of attribute data. This makes changing and updating the file more difficult and, in consequence, it is often more convenient to maintain the nodeset and network information in two separate files (or two worksheets in an Excel spreadsheet). Two passes with the advanced table data import are required in this case, one per file (or worksheet).
<table>
<thead>
<tr>
<th>Column Name</th>
<th>Advanced Table Format</th>
<th>Used for</th>
<th>Content and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canal</td>
<td>Node</td>
<td>Attribute</td>
<td>Name of canal.</td>
</tr>
<tr>
<td>Canal Nodeset</td>
<td>Network</td>
<td></td>
<td>Set to &quot;Organization&quot;. Not used in this example. Available to create a canal to place network.</td>
</tr>
<tr>
<td>Canal Attribute Name</td>
<td>Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Canal&quot;.</td>
</tr>
<tr>
<td>Canal Attribute Type</td>
<td>Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Text&quot;.</td>
</tr>
<tr>
<td>Place 1</td>
<td>Node Name, Source Node</td>
<td>Attribute, Network</td>
<td>Name of a location on a canal. Case sensitive and must match all other instances in the Place 1 and Place 2 columns. Creates nodeset entries.</td>
</tr>
<tr>
<td>Place 1 Nodeset</td>
<td>Source Nodeset</td>
<td>Attribute, Network</td>
<td>Set to &quot;Location&quot;.</td>
</tr>
<tr>
<td>Place 1 Latitude Attribute Name</td>
<td>Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Latitude&quot;. (Default name for geographic visualizer.)</td>
</tr>
<tr>
<td>Place 1 Latitude Attribute Type</td>
<td>Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Number&quot;.</td>
</tr>
<tr>
<td>Place 1 Latitude Value</td>
<td>Attribute Value</td>
<td>Attribute</td>
<td>Decimal latitude value for Place 1.</td>
</tr>
<tr>
<td>Place 1 Longitude Attribute Name</td>
<td>Attribute Name</td>
<td>Attribute</td>
<td>Set to &quot;Longitude&quot;. (Default name for geographic visualizer.)</td>
</tr>
<tr>
<td>Place 1 Longitude Attribute Type</td>
<td>Attribute Type</td>
<td>Attribute</td>
<td>Set to &quot;Number&quot;.</td>
</tr>
<tr>
<td>Place 1 Longitude Value</td>
<td>Attribute Value</td>
<td>Attribute</td>
<td>Decimal longitude value for Place 1.</td>
</tr>
<tr>
<td>Value</td>
<td>Place 2</td>
<td>Attribute, Network</td>
<td>Name of a location on a canal. Case sensitive and must match all other instances in the Place 1 and Place 2 columns.</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Place 2 Nodeset Target Nodeset Attribute, Network</td>
<td>Set to &quot;Location&quot;. Redundant to Place 1 Nodeset, included for clarity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Attribute Name Attribute</td>
<td>Set to &quot;Latitude&quot;. (Default name for geographic visualizer.) Redundant to Place 1 Latitude Attribute Name, included for clarity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Attribute Type Attribute</td>
<td>Set to &quot;Number&quot;. Redundant to Place 1 Latitude Attribute Type, included for clarity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Latitude Attribute Value Attribute</td>
<td>Decimal latitude value for Place 2. (Not redundant; Place 2 may or may not be duplicated in the Place 1 column.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Attribute Name Attribute</td>
<td>Set to &quot;Longitude&quot;. (Default name for geographic visualizer.) Redundant to Place 1 Longitude Attribute Name, included for clarity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Attribute Type Attribute</td>
<td>Set to &quot;Number&quot;. Redundant to Place 1 Longitude Attribute Type, included for clarity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place 2 Longitude Attribute Value Attribute</td>
<td>Decimal longitude value for Place 2. (Not redundant; Place 2 may or may not be duplicated in the Place 1 column.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Network Network</td>
<td>Name of network, &quot;Route&quot; in this example (which contains a single network).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Link Weight Link Value Network</td>
<td>Link value for segment, set to 1.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dates Dynamic Network</td>
<td>Dates for existence of given a canal segment, by decade. Uses first and last year and the first year of each intervening decade. For example &quot;1790;1800;1810;1818&quot;. Note that gaps in service of less than one decade will not be visible. Since the Advanced Table importer can aggregate dates, the date values could be at lower level of granularity (e.g. year).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Miscellaneous information, not used here but could be added as an attribute.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Result

Data in the input file is inserted into an existing or new meta-network or dynamic meta-network as nodes, attributes and networks.

The 1830 Location nodeset in the Welsh Canals dynamic meta-network example after import, with attributes:

The 1830 Route matrix in the Welsh Canals example (using the ORA editor's list view, with source and target place names):
Visualization of a portion of the Welsh Canals example: 1830 in southern Wales near Pembrey and Swansea.
Procedure
Select the Import Wizard with File > Data Import Wizard
In the left box select Import Excel or text delimited files > Advanced table then click [Next >].

This brings up the dialog box for importing advanced table data.

Select a destination: a new meta-network, or adding to an existing meta-network.

Create a new meta-network with name: Check to create a new meta-network with the imported data, then enter a name for the meta-network. In this example a new metanetwork named "Welsh Canals" will be created.

Add to the existing meta-network: Check to add the data to an existing meta-network then select the target meta-network from the pull-down menu.

Click [Next >] to continue. (Alternatively use the [ < Back ] button to select a different import tool or the use the [ Cancel ] button to cancel data input.)

This brings up the dialog box for defining the mapping from the input data columns to the meta-network elements.
Step 1: Select a file containing table data with column headers: Select the file containing the input data. ORA will scan the file for column headers required for step 2.

Use the [Browse] button to open a file browser. Navigate to the file containing table data, select the file and click [Open]. If the file is an Excel format spreadsheet with multiple worksheets, a popup dialog will appear, listing worksheet names. Select the appropriate worksheet. In this example the file "Welsh_Canals.csv" is entered.

Step 2: Define networks and attributes based on the columns: Define the networks and attributes contained in the input file. Nodesets and matrices will automatically be created as necessary. In the example case, a dynamic network containing three attributes (in one nodeset) and one network per time period will be created (see description under Input above).
Networks

Click on the network tab to describe the networks contained in the input file.

The Import Advanced Table dialog will retain network definitions throughout an ORA session. To remove all prior definitions, use the [Clear] or use the [ ] button to remove individual definition lines. Then use the [New] button to add an empty network definition and select the appropriate columns from the input file (see the Advanced Table Format definitions under Input above).

The Welsh Canals example file contains a single one-mode network "Routes", defining links between Locations (see image above).

For each network definition line, select the appropriate column headers from the pulldown menu under each heading. A network is defined by pairs of source and target entries under the defined network name.

Source Class Select the header for the column containing the source Nodeset Class entry (not required if the Source Nodeset uses standard Nodeset Class values).

Source Nodeset Select the header for the column containing the source Nodeset Name.

Source Node Select the header for the column containing the source Node Name.

Target Class Select the header for the column containing the target Nodeset Class entry (not required if the Target Nodeset uses standard Nodeset Class values).

Target Nodeset Select the header for the column containing the target Node Name.

Target Node Select the header for the column containing the target Node Name.
Link Value Select the header for the column containing the link value. A value of 0 would create the nodes but no link; if no Link Value is specified a link value of 1 is assumed.

Network Select the header for the column containing the network name.

Click to delete this network definition (only).

Attributes Click on the attributes tab to describe the attributes contained in the input file.

The Import Advanced Table dialog will retain attribute definitions throughout an ORA session. To remove all prior definitions, use the [Clear] or use the button to remove individual definition lines. Then use the [New] button to add an empty network definition and select the appropriate columns from the input file (see the Advanced Table Format definitions under Input above).

The Welsh Canals example file contains a three attributes for the Location nodes: "Canal", "Latitude" and "Longitude". Note however that there are six definition lines (see image above). This is required because a given location may be defined as a source node (Place 1), a target node (Place 2) or in both columns. ORA will merge duplicate definitions but all possible values must be read.

For each attribute definition, select the appropriate column headers from the pulldown menu under each heading.

Nodeset Class Select the header for the column containing the attribute Nodeset Class entry (not required if the nodeset selected under Nodeset Name uses standard Nodeset Class values).
Nodeset Name Select the header for the column containing the attribute Nodeset Name.

Node Name Select the header for the column containing the attribute Node Name. (Note that the example uses the same columns used in the network definition source and target columns.)

Attribute Name Select the header for the column containing the attribute Attribute Name.

Attribute Type Select the header for the column containing the Attribute Type.

Attribute Value Select the header for the column containing the Attribute Value (i.e. the attribute data). If multiple different values are present, ORA will retain them all. Only one instance of duplicate values is retained. (The Welsh Canals examples uses the duplicate merger to allow redundant definitions for locations that are linked to multiple canal segments.)

Click to delete this attribute definition (only).

Dynamic meta-network… Check to create a dynamic meta-network based on time information included in the input file. (Checked for the example).

…date: Select the column header for the column in the input file containing time information from the pulldown list. (In the example, "Dates" is the appropriate column header.)

Date format: Select the date format from the pull-down list. (In this example yyyy-MM was selected, then edited.)
yyyy-MM-dd'T'HH:mm:ssX
yyyy-MM-dd HH:mm:ssX
yyyy-MM-dd HH:mm:ss
yyyy-MM-dd
yyyy-MM
MM/dd/yyyy
EEE MMM dd HH:mm:ss ZZZZ yyyy

Time period string Dates are strings to be compared lexicographically.

**Note:** Date format strings are customizable by editing after selection, which may permit input of files containing date formats not otherwise listed by removing or reordering elements. (In this example, "yyyy-MM" was selected, then edited to "yyyy". Compare image above with the image just prior to Attributes showing the edited value.)

**Note 2:** Time period string Select to treat time values as arbitrary strings (e.g. "early", "middle", "late"). Note however that ORA organizes time period strings in lexicographical (also known as dictionary order, a generalization of alphabetical order) so these period strings would be ordered as "early", "late", "middle" in the dynamic meta-network.

See [Meta-Network Times from Outside ORA](#) for more information on time format and customization.

Create deltas Check to create difference (delta) networks instead of full networks for each time period. See [Deltas and Keyframes](#) for more information. (Not used for the example.)

Aggregate by… Select to define a time interval to group together entries (e.g. group messages time-stamped down to the minute into a network for each day). A meta-network is created for each time interval. (Selected for this example.)

**Enter time value** – enter a numeric value. (Set to "10" for the example.)

**Enter time unit** – select one of the following time units (Year(s) was selected for the example.):

Year(s)
Month(s)
Week(s) - Sunday Start
Week(s) - Monday Start
Day(s)
Hours(s)
Minutes(s)
See Aggregation for more information.

Create new nodes for unrecognized node names Check to create new nodes during import. Uncheck to use only existing nodes. Checked for the example.

Click the [ Finish ] button to initiate the data import. (Alternatively use the [ < Back ] button to revise the import parameters or the [ Cancel ] button to cancel the import entirely.)

**Special Considerations**

None.

**References**

None.
Trail Importer

Description
Import single-mode table data (in Excel, CSV or tab delimited format) with a single ego node column and one or more state columns. Transition links are created for an ego based on the change of values in each state column from one time period to the next.

Input
The trail importer reads one or more input files and successively amalgamates them into a single dynamic meta-network. Input files contain either:

- **Trail data** - The states one or more egos assume. For instance a group of people move from location to location for different purposes, where people are egos and the location and purpose are states.
- **Attribute data** - Additional information about the egos, stored as attributes.

Trail Data File
An input file usually has an Ego node column (for example a list of agents), and one or more Path node columns. If the file lacks an Ego column, the user can specify an ego value used for the entire file. Each path column will produce a Ego x Path transition network where link values record the number of times an ego transitioned from one path node to another during a given time period.

The input file can be in Microsoft Excel (XLSX), comma separated value (CSV) or tab separated value (TSV) format.

The input data is ordered by time, where records for a given Ego are assumed to represent transitions over time. The time dimension may simply be indicated by the order of the file (i.e. the file's Ego records in the file are in order from early to late for each Ego; the records for an individual ego do not have to adjacent as long as they are in time ascending order from top to bottom) or by explicit time values included the file. Time information can be actual time values in various formats (e.g. "6/15/1999") or by categorical values (e.g. "early", "middle", "late"). Note however that more than one transition can occur in a single time period either due to identical time values or by aggregation of time values.
Attribute Data File

An attribute data file contains an Ego node ID column and columns containing additional data about the ego nodes. The user can select which data columns are read.

The input file can be in Microsoft Excel (XLSX), comma separated value (CSV) or tab separated value (TSV) format.

Attribute data is not time stamped and ego nodes can be in any order. Attribute data can be split between multiple files and the number of Egos in the file does not have to match the number of Ego nodes in the trail data (i.e. both missing and extra egos are allowed). Multiple records for a given ego are allowed (note that the Allow multiple values? option controls how multiple attribute records are processed). Multiple attribute values are allowed and are entered as semi-colon separated values within a column (e.g. a hobby attribute could be set to multiple values with the input "tennis;mountain biking;cribbage") or as separate records.

See Procedure, below for a simple input example.
Result

Example output from example in Procedure section (below).

The generated networks can be one or both of the following:

- **Transitions Meta-Network** - *(Transitions-Days above)* contains information about the transitions:
  - **Nodesets**
    - **Ego Nodeset** - One nodeset for the Ego node *(Agent above)* containing a list of ego nodes and their attributes.
    - **Path Nodesets** - Two nodesets for each Path, one containing a list of nodes *(City and Purpose above)* and the second
containing transition statistics for each Path as attributes (*City-Trail Summary* and *Purpose-Trail Summary* above).

- **Networks**
  - **Frequency** - Counts the number of times Ego is linked to a Path (*City-Frequency, Purpose-Frequency* above).
  - **Transition Avg Duration** - Counts the number of times Ego transitions between elements of a Path nodeset. This includes transitions to the same Path node, thus in the example an agent in Seattle on days 1 and 2 causes a Seattle to Seattle transition (*City-Transition Avg Duration, Purpose-Transition Avg Duration* above).
  - **Transition Count** - Path x Path count of transitions between a given path nodeset (*City-Transition Count, Purpose-Transition Count* above).

- **Trails Dynamic Meta-Network** - (*Trails-Days* above) contains a dynamic meta-network with one meta-network per time period, showing the Ego x Path network during a given time interval. Each meta-network contains:
  - **Nodesets** - One Ego nodeset (*Agent* above) and a nodeset for each Path (*City* and *Purpose* above).
  - **Networks** - For each path type an Ego x Path network (*City* and *Purpose* above).

The trails data can be visualized using ORA visualizers:
Visualization of one time period (day) in the dynamic meta-network created from the trails dynamic meta-network.
Trail visualization of city to city movement during a one-week period using the trails dynamic meta-network.

**Procedure**

In this example two files containing fictitious information about agent travel over the period of a week are used to create meta-networks. One file contains trail data and the second contains attribute data about the Egos in the trail data. Both files are in comma separated value (CSV) format. After both files are read in by the Trail Importer, a transitions meta-network and a trails dynamic meta-network are created incorporating the full set of Egos and Paths contained in the files.
Trail data (file "Travel_2000.csv")

Trail data for five individuals over a period of a week. The individual records indicate the agent's location and purpose (task) on one day.

The two column layout in the image above is for display purposes, the actual file contains a single column of records. Note the shaded area for "Carl", which contains only two data records instead of the seven for other agents. Incomplete data of this nature is allowable (whether it represents missing data or an Ego, such as a new hire, entering or leaving the data set).

Attribute data (file "Travel_2000 - Attributes.csv")

Attribute data for each of the Ego agents in the trail data file. The first column contains the ego name and the remaining columns contain information about the attributes. Note that the attribute data is not timestamped; values apply to the agent for the entire period.
To start the import, open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left box select Import Excel or text delimited files > Trail importer then click [ Next > ].

This brings up the initial dialog box for importing the trail data.

Use the data import dialog to import trail and attribute data from a file or files. The imported data is held in temporary storage prior to meta-network creation allowing multiple files to imported in succession and amalgamated into a single collection of trails.
NOTE: These steps in this dialog should initially be performed line by line from top-bottom, working from left to right on each line. In many cases the selection above (or to the left) will be used by ORA to create the steps and options presented below. Once parameters are set, they can be adjusted individually but following lines should be examined to determine if they have been affected by a change.

**Format Selector** - Use the pulldown menu to indicate the type of file to import. Note that you may import more than one file and files of different types before generating networks.

Trail data - The input file or files contains transition information about one or more Egos with implicit or explicit time ordering information. In the image above, trail data has been selected, prior to opening the example's trail data file "Travel_2000.csv".

Attribute data - The input file or files contains an Ego node column and columns containing additional data about the ego nodes.

**File Selector** - After choosing the format type, use the [Browse] button to open a file browser. Navigate to a file containing ego data, select a file or files and click [Open]. ORA will scan the file for information to use in the next steps. In the image
above the file "Travel_2000.csv" is entered; the attribute file "Travel_2000 - Attributes.csv" (not shown) is also used in the example.

NOTE: When selecting multiple files for simultaneous input, the file contents must use identical identifiers (e.g. the Ego nodeset column header value must be the same) and use same content format for fields selected for processing. For example Excel's internal date representation is a single number that is automatically converted for display to the user according to the cell display setting; this format is not equivalent to a textual representation in a CSV file although the presentation may appear identical. If a format conflict occur, process the files separately, adjusting input parameters as needed. For example, by processing CSV and Excel files separately, the Timestamp format can be set to Date pattern and Excel dates respectively.

The center area of the dialog will change based on the file format selected:

**Trail data File Type Selected**

Use the Ego and timestamp tab to define how to extract ego nodes and how to timestamp the trail. Choose one or more State Info tabs to choose columns with states through which the ego moves.

In the tab area below, use the Ego and timestamp and one or more State Info tabs to describe the location and ego and state data in the input file.
Ego and timestamp **Tab** - This tab is used to identify the Ego and timestamp sources for the trail data (note that the ego can either read from the input file or set by the user).

Specify the Ego nodeset: Set the name and type of the Ego which will create trails (an ego might be a person, vehicle, message, etc.)

Nodeset Class: From the pulldown, select one of ORA's standard nodeset classes for the Ego nodeset (Agent in this example).

Nodeset ID: Enter the nodeset ID by typing into the text area. A default value is automatically generated when the Nodeset Class is set. In this example, the default ID of "Agent" was used.

Specify how to determine the Ego node for each row: Indicate how to identify the Ego the trail data in the file is for.

Column:... Check this item if the Ego node id will be read from a column in the file.

**Ego Node Column Pulldown** - Use the pulldown to the right to select the column containing the Ego node ID. In this example the column "Ego Name" is selected.

Fixed name:... Check this item if all the data in this file is for a single Ego and you wish to enter the Ego node ID manually.

**Text Area** - Type the Ego's Node ID value in the text area to the right.

Specify how to define the Timestamp for each row:

Column:... Check this item when the timestamp is held in a column in the input file.
**Column Selection Pulldown**… - Use the pulldown to select the column containing time information. In this example the "Date" column is selected. (The sample data also includes a "Time Period String" column which identifies the time periods as letters "A".."G".)

**Timestamp Format Selection Pulldown** - Select the timestamp format from the following options:

Date pattern- The timestamp is formatted in a pattern (e.g. 2016, or 2012-09-23) A "date" string contains quantitative time information. Select the date format from the pull-down list below. In the example, "MM/dd/yyyy" is appropriate.

- yyyy-MM-dd'T'HH:mm:ssX
- yyyy-MM-dd HH:mm:ssX
- yyyy-MM-dd HH:mm:ss
- yyyy-MM-dd
- yyyy-MM
- MM/dd/yyyy
- EEE MMM dd HH:mm:ss ZZZZ yyyy

**Note:** Date strings are customizable by editing after selection, which may permit input of files containing date formats not otherwise listed by removing or reordering elements.

See [Meta-Network Times from Outside ORA](#) for more information on time format and customization.

Time periods - The timestamp is strings to be compared lexicographically. Input identifies time periods with arbitrary strings (e.g. "early", "middle", "late"). Note however that ORA organizes time period strings in lexicographical (also known as dictionary order, a generalization of alphabetical order) so the above example would be listed as "early", "late", "middle".

Unix timestamp - The timestamp is in Unix internal time notation (the number of seconds since 1970).

Excel dates - The timestamp is in Excel internal time notation.

File is sorted increasing by time - Check this option if the file is sorted in time order from early to late (i.e. the file's Ego records in the file are in order from early to late for each Ego; the records for an individual ego do not have to adjacent as long as they are in time ascending order from top to bottom).
State Info Tab - This tab is used to describe a single column of trail information in the selected input file(s). The example data contains two columns of trail information so a second tab was added using the Add State tab, as shown in the image below.

NOTE: One state column is required. Use the Add State tab to add additional tabs. Use the [X] icon to remove unneeded extra Add State tabs.

For each State Info tab enter the following information:

State column: Using the pulldown below, select the column in the input file containing the trail information. In the image above the "City" column was selected (the second state tab selected the "Purpose" column).

Choose how to record the trail: Use the two fields below to indicate if the data is for a new or existing trail.

Trail Create/Append Pulldown - Select one of the following options:

Create a new trail: Use the data to create a new trail, use the Trail Identifier Area value for the new trail identifier. (Since a single trail data file was used for the example, this trail option was used.)

Add to an existing trail: Append the data to an existing trail, selecting the append target in the Trail Identifier Area.

Trail Identifier Area - Use this area to set the Trail Identifier. The field format will vary depending on the Trail Create/Append Pulldown value selected.

If Create a new trail: was selected - A text area will open with the State column entry entered automatically. The user can change this value as desired by typing in the text area. (The generated value was employed for the example.)

If Add to an existing trail: was selected - A pulldown is created with all existing trail identifiers created by prior file inputs. Select the desired trail.
Select state Nodeset Class: If a new trail is to be created, then from the pulldown below select one of ORA's standard nodeset classes for the new nodeset (Location in this example). If the trail data is to be added to an existing trail, this control is inactive.

State Nodeset ID - If a new trail is to be created, enter the nodeset ID by typing into the text area below. The State column entry is entered automatically inserted as a default. In this example, the default ID of "City" was used. If the trail data is to be added to an existing trail, this control is inactive.

Use Entry state Node ID: Check this option to insert a node to identify the start of a trail. Once the entry state node ID option is checked, then text field below can be used to change the default Node ID value of "Entry" by typing in the text area.

Use Exit state Node ID: Check this option to insert a node to identify the end of a trail. If the exit state node ID option is checked, then use the text field below to change the default Node ID value of "Exit" by typing in the text area.

NOTE : The entry and exit node IDs are particularly useful in presenting visualizations of sequential time periods where the start and end of trails may not be easily recognized.

Add State Tab - Click to add a State Info tab before the Add State tab (note the presence of a second tab in the example illustration above as the example input has two state columns "City" and "Purpose").

NOTE : Added state tabs can be deleted by using the [X] icon (❌) in the tab. The first state tab is required and cannot be deleted..

**Attribute data File Type Selected**
Select the column that contains Ego Node IDs and one or more attribute columns to import.

Select the column that has the Ego node IDs: Use the pulldown menu below to select the column containing the ego node IDs. The ID will be used as a match key to add attribute data to existing egos and to create new ego nodes where needed.

Select the columns with Ego attribute values: ORA will display all column headers in the attribute file(s); the Ego Node ID column will be grayed out. The remaining columns can be selected as containing attribute data. Unselected columns are ignored. (The example attribute file contains three attribute columns, "Home City", "Years Employed", and "Assignment" in addition to the Ego Node ID column "Ego Name".)

Text Search Area - Type a word or phrase to search the column headers. The list of columns will be updated dynamically to show only entries that contain the search string (i.e. the search is for a partial or exact match). Clearing the search area will restore the full list.

Column Entries - For each column in the input file a column entry is presented. The Ego node ID column will be grayed out. (Note that searching will hide non-matching entries.)

Column title - The column header is listed; to select the column for import as attribute data, check the box next to the column title.
ID: The name for the attribute in ORA. The column title is entered as the default value. Type into the text area to the right to change the value.

Type: Use the pulldown to set the attribute type one of a predefined set of types. The attribute type identifies the field contents for certain ORA tools.

Text
Text Category
URI
Number Category
Number
Date

Allow multiple values? - Check to accumulate all values when a given Ego has more than one record of attribute data. If not checked, the last record for the Ego will be used. Note that this argument only affects processing of multiple attribute records. Multiple values in a single attribute record are always read as such (e.g. a hobby attribute set to multiple values with the input "tennis;mountain biking;cribbage" will be read in if it is included in the final record when this argument is set).

[ Select All ] - Click this button to select all columns in the file as containing attributes except the Ego Node ID column. (Note that entries hidden by searching will still be selected.)

[ Select None ] - Click this button to unselect all columns.

Create new Ego nodes during import - Check this item to create new ego nodes while importing trail data. Uncheck to only import trails and attributes for existing ego nodes (i.e. nodes already created by reading attribute or trail data files).

NOTE: When reading attribute data, any new attribute columns selected will cause the corresponding attributes to be created in ORA even when no ego matches are found in the input file (the attribute values will be blank).

[ Clear Dataset ] - Click this button to clear all data previously read. Any networks already created and present in the Meta-Network Manager will be retained. (The importer will also retain the entered argument values where appropriate.)

[ Import Files ] - Click this button to process the file or files selected. After processing the input file, you may select additional files and add them to the data already held in memory. (In the example, two files, the trail data file "Travel_2000.csv" and the attribute file "Travel_2000 - Attributes.csv" were
imported in succession before any meta-networks were created in the following network creation dialog.)

NOTE: After importing a given input file or file(s), you may wish import additional files before creating meta-networks. Simply return to the top of the dialog, select additional file(s) and set the parameters as needed.

After reading in all trail and attribute data, click [Next>] to continue to advance to the network creation dialog. (Alternatively, click [<Back>] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

Use the network creation dialog to create networks from the previously imported trails data. Note that you may create more than one network from the imported data and the existing data may be augmented or replaced by returning to the prior file input dialog.

Select one or more Ego nodes to analyze by selecting the trails to consider and the states to pass through.

The tab area allows the user to select which trail elements will be included in the created networks.
Tab Area

Select Ego Nodes Tab - Select one or more ego node for the network (at least one ego node must be selected). Unselected nodes will not be included in any generated meta-network. Initially no egos are selected.

In the example, all Ego nodes were selected.

You may find Ego nodes by searching and select multiple nodes by using the controls in this tab. For a short tutorial on search features, including additional options, see 9.2 Searching, Sorting, Filtering and Selecting Nodes on the QuickStart Main Interface page.

Selection

Individual Selection - To select individual nodes, place a check mark in the left-hand box.

Multiple Selection - To select multiple nodes, use the controls at the bottom of the Editor pane:

Select/Clear All - Checking this box selects all nodes (whether the node is currently displayed or not; items hidden by searching, filtering or outside the viewing window are still selected). Unchecking the box deselects all nodes.

Select/Clear Visible - Checking this box selects visible nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all nodes found by filtering. Unchecking the box deselects just the displayed nodes.

Searching - Operations to find ego nodes.
Text Search Area - Search for ego nodes. Type one or more search words separated by a space. The results of the search changes the list of nodes to show any records which contain matching text. Searching is case insensitive. All fields (including attribute data) is searched. The match policy can be varied by the user (see below). Use quotation marks to search for a phrase (spaces are treated as part of the search).

[ Contains ▼ ] / [ Equals ▼ ] - This button controls the text match policy. Contains matches all lines which include the string in any position. Equals matches only complete words.

Options - Additional options for searching are revealed when the button is clicked (use to close).

[ Clear filters ] - Clear all filters, including search strings. Displays the entire nodeset.

Match all - Show only node names that match all filters (equivalent to a logical and). (Match all is selected on start up.)

Match at least one - Show node names that match any filter (equivalent to a logical or).

Sort/Filter Options - Operations to organize and find ego nodes.

Column Sort - The displayed list of nodes can be sorted by clicking on a column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is ascending. A second click sorts the list in descending order. Clicking a different column header will re-sort the list based on that column's content.

Column Filter - Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu. Select the Filter tab.

The filter menu supports two types of filtering:

Standard - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.
**Custom** - Checking the Define a custom filter: option allows selection of a range of values. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The filter menu allows construction of a logical comparison; line items matching the comparison will be displayed, all other lines hidden.

Select Trails **Tab** - Select one or more trails for network (at least one trail must be selected). Unselected trails will not be included in any generated meta-network. Initially all trails are selected (the default was used for the example).

The trails are listed, one per line, in the display area. To select a trail, check the box in the Include? column for that line. To deselect a trail, uncheck the box.

**NOTE** : Searching and filtering options are not available in this tab.

Select State Nodes **Tab** - Select one state nodes for the network (at least one state node must be selected). Unselected state nodes will not be included in any generated meta-network. Note that the state nodes for each trail are listed under separate tabs. Initially all nodes are selected (the default was used for the example).

A separate tab is created for each trail with the state nodes listed, one per line, in the display area. To select a trail, click the tab entry. To select a state node, check the box in the Include? column for that line. To deselect a trail, uncheck the box.

Searching and selection controls apply independently to each state node tab (e.g. the Select/Clear All option shown above will only affect nodes in the **Purpose** tab; the
City nodes must be changed independently by selecting the **City** tab. For information on selecting, searching and filtering see **Select Ego Nodes** above.

Select the output to create:

**Time unit for transition duration:** Set the time unit used in the generated networks. Select the date format from the pull-down list below.

- **Sequential - Ignores duration.**
- **Years**
- **Months**
- **Days**
- **Hours**
- **Minutes**
- **Seconds**
- **Milli-seconds**

**NOTE :** Each time unit uses a duration of 1, for example selecting "Years" means each time slice is 1 year.

**Remove gaps in the trail from filtered states -** This option is available when using fixed duration units (e.g. Sequential). When using fixed units and filtering out some states, gaps are made in the sequential output. Check this option to remove gaps and compress the trail. Keep it unchecked to see skipped states.

**Create transitions meta-network:** Check to create a transitions meta-network in the Meta-Network Manager.

**Create trails dynamic meta-network:** Check to create a trails dynamic meta-network in the Meta-Network Manager.

**Start trails at same timestamp -** Check to align all trails in the trails dynamic meta-network at the first timestamp in the network (this will alter time values stored in the created dynamic meta-network for any trails moved however the imported data held in temporary storage is not altered, allowing creation of additional meta-networks with unadjusted trails if desired).

After setting the input options, processing the input files, and setting the network creation options click the **Finish** button to create the meta-networks. The dialog will remain open, allowing additional networks to be created with changed options. (Alternatively, click [ < Back ] return to the file input dialog to read additional trail and attribute data or use the [ Cancel ] to abort the import.)
Special Considerations

As noted above, the input data needs to either be ordered by time or include time information.

References

None.
Import from Other Network Analysis Tools

Use the Data Import Wizard to import network data from files in formats used by other network analysis tools:

**UCINET (text or binary)** - Import data from UCINET, a software package for the analysis of social network data.

**Pajek** - Import data from Pajek, a program package for analysis and visualization of large networks.

**Analyst's Notebook** - Import data from Analyst's Notebook, a software product from IBM used for data analysis and investigation.

**Pen-Link** - Import data from Pen-Link, a telecommunications intelligence and analysis software suite.

**Pathfinder** - Import data from Pathfinder, a software package designed to create networks from proximity data.

**ThingFinder** - Import data from ThingFinder, a tool that analyzes text and automatically identifies and extracts key entity types.

**PersonalBrain** - Import data from PersonalBrain, an application to create diagrams, networks or simply sketch out your thoughts.

**CmapTools** - Import data from the CmapTools, programs used to construct, navigate, share and criticize knowledge models represented as concept maps.

**Palantir XML** - Import information in the interchange format for data derived by Palantir tools.

**C3TRACE** - Import data from C3TRACE, a modeling tool used to conduct "what if" analyses of alternative organizational, personnel, and system configurations, all as a function of information flow and information quality:

**Model** - Import a C3TRACE model.

**Communication Details report** - Import a C3TRACE Communications Details report.

**Pythia** - Import data from Pythia, a tool to create timed influence net models.
CAESAR III - Import data from CAESAR III, an application for the design of decision making organizations at the operational and tactical levels.
Import from UCINET

Description
UCINET has been supported for many years, for both import and export.

Input
UCINET employs several data formats. The file extension is used by ORA to
determine the file type.

- **CSV** - File extension .csv.
- **UCINET Text** - File extension .dl.
- **UCINET Binary** - File extensions .##h (header) and .##d (body)

UCINET Text
The UCINET Text protocol (.dl extension) is a flexible language for describing data
and itself encompasses a number of different formats. Three of these formats -
nodelist, edgelist and fullmatrix. nodelist is a file with node descriptions. edgelist is a
file with link descriptions. fullmatrix is a file which contains both.

NOTE : The Italicized text is for reference only.

```
DL
FORMAT = FULLMATRIX The type of data
N = 3 The Number of Nodes
NM = 1 The Number of Matrices
LABELS: Node Names
ALPHA
BRAVO
CHARLIE

MATRIX LABELS: Matrix names
FRIENDS

DATA: The Actual Data
0 0 1
1 1 0
1 0 1
```

369
Result
The UCINET input file(s), rendered as an ORA meta-network. See also the example under Procedure below.

Procedure
In this example, a notional software company is described with four networks. Each network is contained in a separate pairs of UCINET binary format files. All four files are imported at the same time to create a meta-network.

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

From the dialog box select Import from another network analysis tool > UCINET (text or binary). Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Select a destination: a new meta-network, or adding to an existing meta-network.

Create a new meta-network with name: Check this option to create a new meta-network. If desired, then enter a meta-network name in the text area to the right (a default name is provided by ORA). In this example, the new meta-network option was selected and a new meta-network name "software company" has been entered.

Add to an existing meta-network: Check this option to append the file contents to an existing meta-network opened in ORA, then select a meta-network from the pulldown menu to the right.

After selecting the target meta-network, click [ Next > ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)
Locate and describe each input file or file pair. Four file pairs are used in the example.

Construct a meta-network by combining data from one or more files. The file format is determined by the filename extension.

Import file: Use the [Browse] button to open a file browser. Navigate to a file containing a UCINET network, select the file and click [Open]. Based on the file type, the options below are adjusted.
Note: For UCINET Binary format files, select one of the file pair (either the head or body). ORA will locate the corresponding file, which must be co-located and use an identical file name with the appropriate file extension.

**Character Delimited File Description** – Describe the contents of character delimited files (e.g. CSV). In the example, these options are not used as the input file is not character delimited (the fields therefore do not appear in the image above.)

File has source headers Check if the file contains labels for the source data.

File has target headers Check if the file contains labels for the target data.

File delimited by: Set the delimiter character for the file. The default is the comma (',') character.

**Nodeset Class Description** – Set the nodeset class values for the source and target.

Source type: From the pulldown list, select the nodeset class for the source. For the first file in the example, the source nodeset class is **agent**.

Name: Set the source nodeset name. ORA will generate a default nodeset name based on the nodeset class. The user may alter or replace the nodeset name in the text area. In the example, the generated name was used.

Target Type: From the pulldown list, select the nodeset class for the target. For the first file in the example, the target nodeset class is **agent**.

Name: Set the target nodeset name. ORA will generate a default nodeset name based on the nodeset class. The user may alter or replace the nodeset name in the text area. In the example, the generated name was used.

Create new nodes Check to create new nodes in the meta-matrix when new values are found in character delimited files. In the example, this option is not used as the input file is not character delimited (the item therefore does not appear in the image above.)

Network Name: Set the network name. ORA will generate a default network name based on the nodeset description. The user may alter or replace the matrix name in the text area. In the example, the generated name was used.

[ Click to import from another file ] Click this button to add an additional file description to the dialog. In the example, three additional files were entered.
After selecting and describing the input files, click the [Finish] button to begin the import process. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

After the import process is complete, the resulting meta-network displayed in the Meta-Network Manager pane contains four networks and the requisite nodesets.

**Special Considerations**

*None.*

**References**

*UCINET Software.* (n.d.). Retrieved from https://sites.google.com/site/ucinetsoftware/home
Import from Pajek

Description
Pajek is a program package for analysis and visualization of large networks.

Input
Pajek data is contained in a single file containing one or more networks (.net file extension).

Result
The Pajek input file contents, rendered as an ORA meta-network.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > Pajek. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**
None.

**References**


Import from Analyst's Notebook

Description
Analyst's Notebook is a software product from IBM used for data analysis and investigation.

Input
Analyst's Notebook data consists of two comma separated value (CSV) files that are exported from Analyst's Notebook: one containing entity information, and another containing link information. Together these are used to create a meta-network with multiple nodesets and multiple networks.

Result
The Analyst's Notebook input files content, rendered as an ORA meta-network.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import from another analysis tool > Analyst Notebook. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Select a destination: a new meta-network, or adding to an existing meta-network.

Create a new meta-network with name: Check this option to create a new meta-network. If desired, then enter a meta-network name in the text area to the right (a default name is provided by ORA). In this example, the new meta-network option was selected and a new meta-network name "software_company" has been entered.

Add to an existing meta-network: Check this option to append the file contents to an existing meta-network opened in ORA, then select a meta-network from the pulldown menu to the right.

After selecting the target meta-network, click [ Next > ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)
Analyst's Notebook data consists of two comma-separated-value files that are exported from Analyst's Notebook: one containing entity information, and another containing link information. Together these are used to create a meta-network with multiple nodesets and multiple networks. In this example, input files for the software_company meta-matrix have been entered and the columns containing relevant network data have been identified by selecting the appropriate column headers.

Select the Entities file: The entity file will be used to create ORA nodes. Click [Browse] and select the input file. After file selection is complete, ORA will read column headers. Using the pulldown menus, identify the following data categories by selecting the appropriate column header:

- **Type column (optional)** Select a column containing nodeset class information. Type information will be used to create nodes in separate nodesets, one per distinct type value. If the type values correspond to standard ORA nodeset class values, that nodeset class will also be assigned to the nodeset. Unrecognized values will be assigned to nodeset class unknown. If no type information is provided, all nodes will be placed in a single nodeset of type unknown.

- **Identity column (required)** Select a column containing node names. ORA requires unique node names and will ignore duplicate identity values.
Label column (optional) Select a column containing node titles.

Select the Links file: The links file will be used to create node to node connections. Click [Browse] and select the input file. After file selection is complete, ORA will read column headers. Using the pulldown menus, identify the following data categories by selecting the appropriate column header:

Source identity column (required) Select the column containing the source node for a link. Values must correspond to those used in the type column selected for the entities file (see Type column above).

Target identity column (required) Select the column containing the target node for a link. Values must correspond to those used in the type column selected for the entities file (see Type column above).

Value column (optional) Select the column containing the link value. If not provided, the link weight will be set to 1.

Network identity column (optional) Select the column containing the network containing the link. If not provided, all links will be created in a single network.

After selecting and describing the input files, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the meta-network selection dialog or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

Special Considerations
None.

References
Import from Pen-Link

Description
Pen-Link is a telecommunications intelligence and analysis software suite.

Input
A Pen-Link file (file extension .csv).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > PenLink. Click [ Next > ].
(Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

*None.*
Import from Pathfinder

Description
Pathfinder is a software package designed to create networks from proximity data.

Input
A Pathfinder file (file extension .lo).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > Path Finder. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.

**References**


Import from ThingFinder

Description
ThingFinder is a tool that analyzes text and automatically identifies and extracts key entity types.

Input
A ThingFinder file.

Result
_Not available at this time._

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > Thing Finder. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [<Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

*None.*
Description
PersonalBrain is an application to create diagrams, networks or simply sketch out your thoughts.

Input
A PersonalBrain file (file extension .xml).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > PersonalBrain. Click [Next >]. (Alternately, click [Cancel] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

Import from CmapTools

Description
CmapTools are programs used to construct, navigate, share and criticize knowledge models represented as concept maps.

Input
Cmap data is contained in XML format files (.cxl file extension).

Result
The CmapTools input file contents, rendered as an ORA meta-network.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > CmapTools. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.

**References**

Import Palantir Data

Description
Palantir data is information derived by Palantir tools in the Palantir XML interchange format.

Input
A Palantir data file (file extension .xml).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import from another analysis tool > Palantir XML or select Import XML network data > Palantir XML. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

Import from C3TRACE

Use the Data Import Wizard to import data from C3TRACE, a modeling tool used to conduct "what if" analyses of alternative organizational, personnel, and system configurations, all as a function of information flow and information quality.

**Model** - Import a C3TRACE model.

**Communication Details** - Import a C3TRACE Communications Details report.
Import C3TRACE Model Data

Description
C3TRACE model data is a representation of a model from C3TRACE, a modeling tool used to conduct "what if" analyses of alternative organizational, personnel, and system configurations, all as a function of information flow and information quality.

Input
A C3TRACE model data file (file extension .xls).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > C3TRACE > Model. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.

**References**

Import C3TRACE Communication Details Report Data

Description
A C3TRACE Communications Details report is produced by C3TRACE, a modeling tool used to conduct "what if" analyses of alternative organizational, personnel, and system configurations, all as a function of information flow and information quality.

Input
A C3TRACE Communication Details report XML format file (file extension .xml).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > C3TRACE > Communication Details report. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.

**References**

Import from Pythia

Description
Pythia is a tool to create and analyze timed influence net models created at George Mason University (GMU).

Input
A Pythia file (file extension .slt).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import from another analysis tool > Pythia. Click [ Next ].
(Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the
[Finish] button to begin the import process. (Alternatively, click [< Back] return to
the Data Import Wizard initial dialog to select a different option or [Cancel] to abort
the import.)

If the import process completes successfully, a new meta-network will appear in the
Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

*None.*
Import from CAESAR III

Description
CAESAR III is an application created at George Mason University (GMU) for the design of decision making organizations at the operational and tactical levels based on Petri net theory.

Input
A CAESAR III file (file extension .cae).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import from another analysis tool > Caesar III. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

*None.*
Import XML Network Data

Use the Data Import Wizard to create meta-networks using a predefined Extensible Markup Language (XML) format:

- **DyNetML** - Import files in the DyNetML format for the exchange of rich social network data.
- **GraphML** - Import data using the GraphML file format for graphs.
- **Palantir XML** - Import information in the interchange format for data derived by Palantir tools.
Import DyNetML Data

Description
DyNetML is a format for the exchange of rich social network data, using XML syntax. ORA meta-networks are stored using DyNetML by default.

Input
One or more DyNetML format files (file extension .xml, .dynetml, or .zip).

Result
One or more dynamic meta-networks or meta-networks.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import XML network data > DyNetML. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

**Import GraphML Data**

**Description**
GraphML is a file format for graphs. It includes support for:

- Directed, undirected, and mixed graphs
- Hypergraphs
- Hierarchical graphs
- Graphical representations
- References to external data
- Application-specific attribute data
- Light-weight parsers

**Input**
Files in the GraphML format consists of a description of the structural properties of a graph and an extension mechanism to add application-specific information. The file format uses Extensible Markup Language (XML).

**Result**
The GraphML input file contents, rendered as an ORA meta-network.

**Procedure**
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import XML network data > GraphML. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.

**References**

Import Palantir Data

Description
Palantir data is information derived by Palantir tools in the Palantir XML interchange format.

Input
A Palantir data file (file extension .xml).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import from another analysis tool > Palantir XML or select Import XML network data > Palantir XML. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file. After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

Import Other Data Formats

Use the Data Import Wizard to use data from other tools and sources to create networks:

**JSON data** - Create or augment a dynamic meta-network or meta-network with nodes, attributes or networks by reading one or more files in JSON format.

**Twitter data** - Create meta-networks from Twitter data stored in different formats.

**Blogtrackers data** - Create meta-networks from one or more Blogtrackers JSON output files.

**GitHub data** - Create meta-networks from one or more GitHub JSON output files.

**Talkwalker data** - Create meta-networks from one or more Talkwalker output files.

**YouTube data** - Create meta-networks from one or more YouTube JSON files.

**VK data** - Create meta-networks using data from the Russian-based online social media and social networking service VK.

**Survey Monkey data** - Import one or more Survey Monkey XLS+ formatted output files into a meta-network.

**Shapefile data** - Import geographic shapefiles as a location nodeset.

**Bibliography & Citations data** - Import citation data output from bibliographic tools.

**TAVI data** - Import data produced by the CASOS TAVI project.

**THINK data** - Import data produced by the CASOS THINK project.
**Import JSON Data**

**Description**

The Data Import Wizard can create or augment a dynamic meta-network or meta-network with nodes, attributes or networks by reading one or more files in JSON format. The importer lets you choose JSON fields to create nodes, links, and attributes.

**Input**

JSON (JavaScript Object Notation) is an open-standard file format using human-readable text containing attribute-value pairs and ordered lists of values (realized as an array, vector, list, or sequence).

**Result**

*Not available at this time.*

**Procedure**

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left box select Import other data formats > JSON data then click [ Next ].

This brings up the dialog box for importing JSON data.
Identify the file and file format for import.

Select one or more data file: Use the Browse button to open a file browser. Navigate to a file containing the JSON data, select the file and click [ Open ]. ORA will scan the file and present a list of field found in the file.

**Assign JSON fields to nodesets:** From the list of fields, identify data fields that should read into nodesets. For each relevant field, specify a nodeset type in the dropdown and then enter a nodeset name. Each selected field will be used to create a nodeset. Fields not assigned a type will be ignored.
Use date field: To create a dynamic meta-network, select a date field in the JSON file. Check the option and select a field and data format. This will create a dynamic meta-network by putting nodes and links into the meta-networks by date. See Dynamic Networks for an overview of dynamic meta-networks and Meta-Network Times from Outside ORA for more information on time formats and customization.

Aggregate by When a date field has been identified, use this entry create a dynamic meta-network where each meta-network is a time span, such as 3 months or one week. Check the option and select the aggregation period. If this option is not used, a separate meta-network will be created for each distinct time value present in the input data. See Aggregation for more information on aggregation.

**Assign JSON fields to networks and attributes:**

**Networks** Use the Networks tab to assign JSON fields to networks. Select the Networks tab then select a source node field and a target node field based on the nodesets specified in the previous step. A link is created from each JSON record by linking the source and target nodes that are parsed. They are placed into the network with the specified name.

**Attributes** Use the Attributes tab to assign JSON fields to attributes. Select the Attributes tab and add attributes to a node field, and specify the attribute type and name.

Click [ Finish ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

ORA scans the JSON file and creates a single meta-network model or a dynamic model (if a date field is used) based on the nodeset, networks, and attributes specified above.

**Special Considerations**

*None.*

**References**

Import Twitter Data

Description
The Twitter importer creates meta-networks from Twitter data stored in different formats.

Input
A tweet is a short (initially 140 character, later 280 character) message broadcast from a single user (the tweeter). The tweeter has registered followers who receive the tweet, and the tweet itself has a timestamp, hashtags (keywords), URLs, and mentions of other tweeters. In addition, the tweeter's location when sending the tweet can be measured (geotagged) and there is information about the sender such as user name, country of origin, etc.

Twitter sends and stores all tweets and makes a portion of them available via a web-interface, or via third-party vendors, in a standard JSON format. The importer can handle a variety of these predefined Twitter output formats. ORA can import one or multiple Twitter input files at a time (the files must use the same format). When multiple files are to be input during a run, they must reside in the same directory (folder).

Result
A combined meta-network or one meta-network per input file.

Procedure
Collections of tweets can be imported into ORA using the Twitter Data option in the Data Import Wizard.

TweetTracker from Arizona State is an example of a third-party source of Twitter data. For this demonstration, a small collection of tweets containing keywords relating to cancer was downloaded from TweetTracker in JSON format.

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left box select Import other data formats > Twitter data then click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Select the file, file format and import options:
Select the twitter data format: Select the input file format from the pulldown list (for this example Twitter TweetTracker json was selected):

- Twitter JSON
- Twitter TweetTracker tsv
- Twitter TweetTracker json
- Twitter ITC
- Twitter SR
- Twitter GDIT
- VK JSON
- Twitter twitonomy
- twitteR
- R Tweet
- Leidos Twitter json
- NexaIntelligence json
- Scraawl json

Select one or more data files: Click the [Browse] button and use the browse dialog to navigate to the folder holding Twitter data. Select one or more files then click [Open]. In the image above, a single file was selected for input.

Note: When importing multiple files simultaneously, the files must reside in the same directory (folder).

Create a separate dynamic meta-network per file – Check to parse each input file into a separate dynamic meta-network. Otherwise all files are parsed into a single dynamic meta-network.

**Options Pane**

The options pane contains tabs for various options and outputs.
Select the Import Options tab to control how the input is read and aggregated. Check or uncheck options as desired; the default options were used for this example.
General options:

Create only nodes – Check to only create nodes during the import, and do not create links or networks.

Anonymize tweeter names – Check to anonymize tweeter names.

Filter options:

Ignore tweets before: Check to ignore tweets before a specified time. Then enter the time value, working from left to right:

**Year** – Use the up/down arrows to change the year value by one or type the year directly into the field. All years are assumed to be in the Common Era (CE) (also known as the Current Era).

**Month** – Select a month from the pulldown menu or type the month name which will search for the month letter by letter (e.g. typing 'j' will bring up "January", 'ju' will show "June" and 'jul' will select "July"). Repeating the initial letter will cycle through the months starting with that letter (e.g. typing 'jjj' with cycle through "January", "June" and "July").

After the month is set, ORA will check the current day value and will set the day to ‘1’ if the value is too large for the selected month (e.g. if the date is currently January 31, selecting the month September will change the day value to 1; selecting July will not change the day). The allowable value for February varies depending on the year to account for leap years.

**Day** – Use the up/down arrows to change the day of month value by one or type the day directly into the field. Allowable day values are constrained based on the month (e.g. if the month is September allowable days are 1..30). Allowable maximum February day values are adjusted to reflect leap years (28 or 29, depending).

**Time** – Enter the time value using 24 hour notation. The time value can be set by typing a value in the time field or by using the up/down arrows. For direct entry, set the hour values from 00 to 23 followed by minutes and seconds, separated by colon (‘:’) characters. The up/down arrows will change the currently active field value by one (for example, if the cursor is currently in the minutes field, the minute value will be incremented). If no field is selected, the hours value is incremented.

Hour, minute and second values may be any integer value. ORA will automatically adjust values to the correct range, increasing higher values as needed. For instance if the value 121 is entered in the seconds field, ORA will increase the minutes field by
two and set the seconds value to 1; the hour value will be incremented if the minutes value rolls over (however, the hours field will roll over at midnight without affecting the day of month value).

NOTE : When entering a time value by typing values in the editor pane into an input field, the cursor must leave the field, either by use of the enter key or selecting another field to record the change. Selecting another item in the Meta-Network Manager pane before this is done will silently restore the original value.

Ignore tweets after: Check to ignore tweets after a specified a specified time.

Ignore concepts: Ignore tweets containing a concept listed in the text field. Leave blank to process all tweets. Delimit concepts by spaces or commas.

Accept only concepts: Only include tweets that contain at least one concept from the list in the text field. Leave blank to accept all tweets. Delimit concepts by spaces or commas.

Accept only languages: Only tweets using the specified languages will be included. Leave blank to accept all languages. Delimit languages by spaces or commas. Language codes are standard BCP 47 codes.

Tweet message options:

Store the tweet message as a tweet node attribute – Check to add an attribute to the Tweet nodeset containing the tweet message text.

Parse the tweet message into words with options: Check this option to create a network of shared words between tweets. (Checking this option activates a set of subsidiary options for processing the text sources, listed below.):

Note : The following sub-options are applied during word parsing in the order shown, from top to bottom (i.e. character removal will occur before the domain thesaurus is applied).

Characters to remove before applying thesaurus and delete list: The list of characters in the text area will be removed from the text prior to further processing. This list can be changed by the user. Only single characters can be used; to change words use the domain thesaurus and domain delete list options below. Note that these characters will be removed even when no thesauri or stop lists are applied.
Warning: When the character list is modified, it is not possible to restore the original list until ORA is restarted. Keep a side copy of the list if restoration is desired during an ORA session.

Use domain thesaurus: Check to translate selected words prior to processing by applying a user-prepared list of word mappings then click the [Browse] button and use the browse dialog to select the thesaurus file. A user-supplied thesaurus allows, for instance, merging of synonymous terms or spelling variations.

A domain thesaurus file is a file with three columns and a header row. The file can be an Excel spreadsheet file, or in comma separated (CSV) or tab separated (TSV) format. The header row must be (tab separated example shown):

```
conceptFrom conceptTo metaOntology
```

When a word from the conceptFrom column is found, it is converted to its conceptTo value. Case is ignored when matching text. A legal metaOntology value must be present although it is not used in this instance (use "Knowledge" or "Unknown" if the thesaurus will not be used elsewhere).

Note: Use a domain delete list to delete words.

Use domain delete list: Check to ignore selected words prior to processing by applying a user-prepared delete list then click the [Browse] button and use the browse dialog to select the delete list file.

A domain delete list is a file with one word per line and no header row. Case is ignored when matching text. The file can be an Excel spreadsheet file, or in comma separated (CSV) or tab separated (TSV) or plain text (TXT) format.

Use built in delete lists: Check any or all of the following to remove certain words and other text entities from consideration.

- stopwords: Apply a standard list of stop words. Stop words are extremely common words which may be of little analytical value (for example, a, an and and are often used as stop words on English).
- numbers: Remove numeric values (for example, 1, 1984, and 911).
- ordinal numbers: Remove ordinal number words (for example, first, second, and third in English are ordinal numbers).

Date aggregation options:
Aggregate by… – Check to perform aggregation tweet by fixed time intervals using the specified arguments (e.g. tweets time-stamped down to the minute into a network for each day). A meta-network is created for each time interval.

**Time value** – Enter a numeric value for the number of time unit in an interval. (Set to "6" by default.)

**Time unit** – Select the time unit for aggregation from the pulldown list. (Set to "Hour(s)" by default.)

- Year(s)
- Month(s)
- Week(s) - Sunday start
- Week(s) - Monday start
- Day(s)
- Hour(s)
- Second(s)

See [Aggregation](#) for more information.

Create uniform time periods – Check to create an empty meta-network (keyframe) for time periods without tweets. This keeps the time periods uniform.

Create retweets in creation time period – Check to create the retweeted tweet in its original time period of creation in addition to the time period of the retweet.

Note: The creation period of a retweeted tweet can be arbitrarily long ago.

Geospatial options:

Automatically locate county and add as an attribute – Check to an attribute containing the originating country (if available).

Automatically locate US state and add as an attribute – Check to an attribute containing the United States state (if available).
Derived network and attribute data is computed from other meta-network data, and when this data changes the derived data needs to be recomputed.

Select the derived networks to create during import; ORA automatically creates any derived networks when creating Twitter measures for reports. Un-check these to save memory during import.

In the image above, two derived meta-networks have been deselected and will not be created during the import process.

Note: Derived networks are not created for a time period if the requisite data is not present in the input file(s).
**Derived Network List** – Lists the predefined derived networks. If the line is checked, the derived network will be created for each time period, if possible.

The [ **Select All** ] and [ **Clear All** ] buttons at the bottom of the list select or clear (check or uncheck) all the networks in the list.

![Custom Attributes Tab](image)

**Custom Attributes Tab**

Use this tab to add additional attributes in the **Tweet** and **Agent** nodesets containing chosen input data. After the input file(s) are selected, a list of fields present in the input file is provided for each sub-tab, with the option to create an attribute containing data from each field.

In the image above, two custom attributes are defined for the **Agent** nodeset: **id** and **screen_name**.

Choose a nodeset and the attributes to create from the JSON fields.

**Tweet Nodes Tab**

For each field in the input file, the following column items are presented:
JSON Field – Lists the field name.

Attribute Type – From the pulldown, select the attribute type (this causes an attribute to be created; choosing Select… cancels creation):
Select…
Text
Text Category
URI
Number Category
Number
Date

Attribute ID – Automatically populated with the field suffix when an Attribute Type is selected. The user may edit or replace the ID by typing into the field.

Agent Nodes Tab

See the Tweet Nodes entry, above, for information on the attribute creation process.

Import Error List Tab

This tab lists any errors encountered while processing the input file(s).

After the file and parameter selection is complete, click the [ Finish ] button to begin the import process. Select the Import Error List tab to view import errors. (Alternatively use the [ < Back ] button to return to the Data Import Wizard dialog or the [ Cancel ] button to exit the Data Import Wizard.)
Sample meta-networks created by Twitter import.

The resulting meta-network should appear in ORA's Meta-Network Manager Pane. The Twitter Report can be used to analyze the meta-network.

In the image above, two Twitter meta-networks were created. Dynamic meta-network "Twitter JSON - Movie Tweets 6 Hour subset" (above) was created by aggregating tweets in six hour intervals into separate meta-networks. The meta-network "Twitter JSON cancer-cure_tweet_data" (below, content expanded) was parsed into a single time interval, creating an ordinary meta-network.

Special Considerations

When importing multiple files simultaneously, the files must reside in the same directory (folder).

References

None.
Import Blogtrackers Data

Description
Imports one or more Blogtrackers output files and renders them as a combined meta-network or as separate meta-networks, one per input file.

Blogs, a contracted form of weblog are websites that present collections of discrete online posts usually presented in reverse chronological order. Blogs may be the work of single or multiple authors and often are focused on a particular topic. Short format social media such as Twitter are described as microblogs.

Information from the universe of blogs, the blogosphere, is a useful source of network data. Techniques and tools for collecting, cleaning, recording and analyzing a related set of blogs, particularly long form blogs, is discussed in papers by Agarwal (2009) and Hussain (2017). In addition to tools and techniques for obtaining and analyzing blog data, the authors and their associates have made blog datasets from their work available through the Blogtrackers tool (http://blogtrackers.host.ualr.edu). ORA can import files obtained from Blogtrackers and process the datasets to create meta-networks for use within ORA.

Input
One or more Blogtrackers output files in JSON format. When multiple files are to be input during a run, they must reside in the same directory (folder).

Result
One or more meta-networks.
Sample meta-networks created by Blogtrackers import from the same input file using different options. Meta-network "blogtrackers" (above) was created with no word parsing selected, "blogtrackers-words body and title" (below) with word parsing of titles and body text enabled.

Procedure

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > Blogtrackers data then click [ Next > ].

This brings up the dialog box for importing Blogtrackers files.
Select one or more Blogtrackers json files: Click the [ Browse ] button and use the browse dialog to navigate to the folder holding the Blogtrackers file. Select one or more Blogtrackers files then click [ Open ]. In the image above, 3 files were selected for input.

Note: When importing multiple files simultaneously, the files must reside in the same directory (folder).

Parse each file into a separate meta-network: When importing more than one file, check this option to parse each input file separately and create a separate meta-network for each file. If unchecked all input files will be combined into a single meta-network.

Import options: Select options from the list below. The options are independent and importing does not require any options be selected.

Aggregate by... Select to define a time interval to group together entries (e.g. group messages time-stamped down to the minute into a network for each day). A meta-network is created for each time interval. (Selected for this example.)

**Enter time value** – enter a numeric value.

**Enter time unit** – select one of the following time units:

- Year(s)
- Month(s)
- Week(s) - Sunday Start
- Week(s) - Monday Start
- Day(s)
- Hours(s)
- Minutes(s)

See [Aggregation](#) for more information.

Parse words from: Check this option to create a network of shared words between bloggers. (Checking this option activates a set of subsidiary options for processing the text sources, listed below.) The word source is selected from the pulldown list:

- Titles only - Use only blog post titles as a word source.
- Body only - Use only blog post body text as a word source.
- Body and Title - Use both the blog post titles and body text as word sources.
Note: The following sub-options are applied during word parsing in the order shown, from top to bottom (i.e. character removal will occur before the domain thesaurus is applied).

Characters to remove before applying thesaurus and delete list: The list of characters in the text area will be removed from the text prior to further processing. This list can be changed by the user. Only single characters can be used; to change words use the **domain thesaurus** and **domain delete list** options below. Note that these characters will be removed even when no thesauri or stop lists are applied.

Warning: When the character list is modified, it is not possible to restore the original list until ORA is restarted. Keep a side copy of the list if restoration is desired during an ORA session.

Use domain thesaurus: Check to translate selected words prior to processing by applying a user-prepared list of word mappings then click the [Browse] button and use the browse dialog to select the thesaurus file. A user-supplied thesaurus allows, for instance, merging of synonymous terms or spelling variations.

A domain thesaurus file is a file with three columns and a header row. The file can be an Excel spreadsheet file, or in comma separated (CSV) or tab separated (TSV) format. The header row must be (tab separated example shown):

```
conceptFrom conceptTo metaOntology
```

When a word from the conceptFrom column is found, it is converted to its conceptTo value. Case is ignored when matching text. A legal metaOntolgy value must be present although it is not used in this instance (use "Knowledge" or "Unknown" if the thesaurus will not be used elsewhere).

Note: Use a **domain delete list** to delete words.

Use domain delete list: Check to ignore selected words prior to processing by applying a user-prepared delete list then click the [Browse] button and use the browse dialog to select the delete list file.

A domain delete list is a file with one word per line and no header row. Case is ignored when matching text. The file can be an Excel spreadsheet file, or in comma separated (CSV) or tab separated (TSV) or plain text (TXT) format.

Built in delete lists to use: Check any or all of the following to remove certain words and other text entities from consideration.
stopwords: Apply a standard list of stop words. Stop words are extremely common words which may be of little analytical value (for example, a, an and and are often used as stop words on English).

numbers: Remove numeric values (for example, 1, 1984, and 911).

ordinal numbers: Remove ordinal number words (for example, first, second, and third in English are ordinal numbers).

Remove words not used by at least this many distinct bloggers: Check to ignore words not used by a set number of bloggers and, optionally, change the number value in the entry area. For example, the default value of 3 indicates that a word must appear at least once in the postings from 3 different bloggers to be included in the network.

Create derived networks Check this option to create additional networks after the data is used to create a predefined set of networks.

Click the [Finish] button to initiate the data import. (Alternatively use the [<Back] button to return to the Data Import Wizard dialog or the [Cancel] button to exit the Data Import Wizard.)

Special Considerations
When importing multiple files simultaneously, the files must reside in the same directory (folder).

References

Import GitHub Data

**Description**
Imports one or more GitHub event files and renders them as a combined meta-network or as separate meta-networks, one per input file.

**Input**
One or more GitHub event files in JSON format.

**Result**
One meta-network per input file.

**Procedure**
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > GitHub data. Click [ Next > ].
(Alternatively, click [ Cancel ] to abort the import.)

![Import Data into ORA dialog box](image)

Chose whether the data should be added to a new or existing meta-network. As shown, a new meta-network named **GitHub Example** is to be created.

Click [ Next > ] to select the input files and set input options. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)
Select the file, file format and import options:

Select one or more GitHub json files: Use the [ Browse ] button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [ Open ].

Select the Select Files tab to add attribute data from additional files.

Parse each file into a separate meta-network - Check to parse each input file into a separate meta-network.
Select the Select Files tab to add attribute data from additional files.

Select files to import as attributes to the nodes created from the import of the Event files above. New nodes are not create when importing attributes.

User files:

[ Browse ] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [ Open ].

[ Clear ] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.

User Gender files:

[ Browse ] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [ Open ].

[ Clear ] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.

User Language files:

[ Browse ] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [ Open ].

[ Clear ] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.

Repo files:

[ Browse ] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [ Open ].

[ Clear ] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.
Organization files:

[Browse] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [Open].

[Clear] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.

Followers (deprecated) files:

[Browse] - Use the browse button to open a file browser. Navigate to a file containing the GitHub data, select the file and click [Open].

[Clear] - Use the clear button remove file information.

Create new nodes during import - Check to add nodes if new node names are found in the input file. Uncheck to only add attribute data to existing nodes.

Select the Other Import Options tab to select additional input options options:

Choose additional options for the import:

Aggregate by… Select to define a time interval to group together entries (e.g. group messages time-stamped down to the minute into a network for each day). A meta-network is created for each time interval.
**Enter time value** – enter a numeric value.

**Enter time unit** – select one of the following time units:

- Year(s)
- Month(s)
- Week(s) - Sunday Start
- Week(s) - Monday Start
- Day(s)
- Hours(s)
- Minutes(s)

See [Aggregation](#) for more information.

Create derived networks - Check to create additional (derived) networks based on the data read.

Binarize the User x Repo - Event networks - Check to binarize (set link values to 0 or 1 only) the User x Repo - Event networks.

After the file and parameter selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)

The resulting meta-network should appear in ORA's Meta-Network Manager Pane.

**Special Considerations**

None.

**References**

None.
Import YouTube Data

Description
YouTube is an American video-sharing website.

Input
One or more files of YouTube data in JSON format.

Result
A combined meta-network or one meta-network per input file.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > YouTube data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Chose whether the data should be added to a new or existing meta-network. As shown, a new meta-network named **New_YT** is to be created.

Click [ Next > ] to select the input files and set input options. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Select the file(s) and import options:

Select one or more YouTube json files: Use the [ Browse ] button to open a file browser. Navigate to a directory containing the YouTube data, select a file or files and click [ Open ].

**NOTE**: Multiple input files must reside in the same folder.

Parse each file into a separate meta-network: This option is available when multiple files have been selected for processing. When a new meta-network is to be created, check to create one meta-network for each input file instead of combining the files into a single meta-network. The input file names will be used to name the individual
meta-networks (the new meta-network name entered in destination selection step will be ignored).

NOTE: This option will be ignored if the Add to the existing meta-network option has been selected.

Other Import Options

Choose additional options for the import: Select options from the list below. The options are independent and importing does not require any options be selected.

Aggregate by... Select to define a time interval to group together entries (e.g. group messages time-stamped down to the minute into a network for each day). A dynamic meta-network is created with a meta-network for each time interval. (Not selected for this example.)

**Enter time value** – enter a numeric value.

**Enter time unit** – select one of the following time units:

- Year(s)
- Month(s)
- Week(s) - Sunday Start
- Week(s) - Monday Start
- Day(s)
- Hours(s)
- Minutes(s)

See [Aggregation](#) for more information.

Create derived networks - Click to create networks that are derived from network directly created from data read during import.

After the file and parameter selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)
With derived networks

Meta-networks created by YouTube import

The resulting meta-network should appear in ORA's Meta-Network Manager Pane.

Special Considerations
None.

References
None.
Import Talkwalker Data

Description

"Talkwalker is an easy to use media monitoring tool allowing you to:

- Identify and monitor news as well as online conversations and mentions in real time
- Analyse social media to measure, assess and refine your social strategy and action plan
- Monitor and compare the performance and engagement of your social media profiles to those of your competition
- Export your results and display them in customized dashboards
- Determine the reach and engagement of your online presence and its evolution within a given time frame
- Use an automated notification system to quickly detect sensitive subjects"

(User Manual Talkwalker, 2018)

Input

One or more Talkwalker output files.

Result

A combined meta-network or one meta-network per input file.

Procedure

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > Talkwalker data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Chose whether the data should be added to a new or existing meta-network. As shown, a new meta-network named TW_Scan is to be created.

Click [ Next > ] to select the input files and set input options. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)
Select the file(s) and import options:

Select one or more talkwalker files: Use the [Browse] button to open a file browser. Navigate to a directory containing the Talkwalker data, select a file or files and click [Open].

NOTE: Multiple input files must reside in the same folder.

Parse each file into a separate meta-network: This option is available when multiple files have been selected for processing. When a new meta-network is to be created, check to create one meta-network for each input file instead of combining the files into a single meta-network. The input file names will be used to name the individual meta-networks (the meta-network selected in the destination selection step will be ignored).

After the file and parameter selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [Back] to return to the meta-network selection dialog or [Cancel] to abort the import.)
The resulting meta-network should appear in ORA's Meta-Network Manager Pane.

**Special Considerations**

*None.*

**References**

Import Pulse Data

Description
Pulse is a tool from IST research that enables real-time information collection across the Internet and from hard-to-reach populations. Pulse incorporates:

- Passive monitoring of open data sources
- Active population engagement
- Blended passive monitoring and active engagement

Input
One or more Pulse output files.

Result
A combined meta-network or one meta-network per input file.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > Pulse data. Click [Next >].
(Alternatively, click [Cancel] to abort the import.)
Select the file(s) and import options:

Select one or more Pulse files: Use the [ Browse ] button to open a file browser. Navigate to a directory containing Pulse data, select a file or files and click [ Open ].

Note: When importing multiple files simultaneously, the files must reside in the same directory (folder).

Parse each file into a separate meta-network: This option is available when multiple files have been selected for processing. When a new meta-network is to be created, check to create one meta-network for each input file instead of combining the files into a single meta-network. The input file names will be used to name the individual meta-networks.

**Options Pane**

The options pane contains tabs for various options and outputs. See the Import Twitter Data help entry for a detailed description of the tabs and options.

After the file and parameter selection is complete, click the [ Finish ] button to begin the import process. Select the Import Error List tab to view import errors. (Alternatively use the [ < Back ] button to return to the Data Import Wizard dialog or the [ Cancel ] button to exit the Data Import Wizard.)

The resulting meta-network should appear in ORA’s Meta-Network Manager Pane.

**Special Considerations**

When importing multiple files simultaneously, the files must reside in the same directory (folder).

**References**

*None.*
Import NexaIntelligence Data

Description
NexaIntelligence is a social media discovery and monitoring tool from Nexaology that specializes in the lexical and qualitative dimension of social media data e.g. semantic discovery.

Input
One or more NexaIntelligence Twitter JSON files.

Result
A combined meta-network or one meta-network per input file.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > NexaIntelligence data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Select the file(s) and import options:

Select the twitter data format: The NexaIntelligence json format is automatically selected.

Select the twitter data format: The NexaIntelligence json format is automatically selected.

Select the file(s) and import options:

Select the twitter data format: The NexaIntelligence json format is automatically selected.
Select one or more data files: Use the [Browse] button to open a file browser. Navigate to a directory containing NexaIntelligence data, select a file or files and click [Open].

Note: When importing multiple files simultaneously, the files must reside in the same directory (folder).

Parse each file into a separate meta-network: This option is available when multiple files have been selected for processing. When a new meta-network is to be created, check to create one meta-network for each input file instead of combining the files into a single meta-network. The input file names will be used to name the individual meta-networks.

Options Pane

The options pane contains tabs for various options and outputs. See the Import Twitter Data help entry for a detailed description of the tabs and options.

After the file and parameter selection is complete, click the [Finish] button to begin the import process. Select the Import Error List tab to view import errors. (Alternatively use the [< Back] button to return to the Data Import Wizard dialog or the [Cancel] button to exit the Data Import Wizard.)

The resulting meta-network should appear in ORA's Meta-Network Manager Pane.

Special Considerations

When importing multiple files simultaneously, the files must reside in the same directory (folder).

References

None.
Import VK Data

Description
VK is a Russian-based online social media and social networking service.

Input
One or more files of VK message data in VK JSON format.

Result
A combined meta-network or one meta-network per input file.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > VK data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Select the file, file format and import options:
Select the twitter data format: The VK JSON format is automatically selected.

Select one or more data files: Use the [Browse] button to open a file browser. Navigate to a file containing VK data, select the file and click [Open].

Note: When importing multiple files simultaneously, the files must reside in the same directory (folder).

**Options Pane**

The options pane contains tabs for various options and outputs. See the Import Twitter Data help entry for a detailed description of the tabs and options.

After the file and parameter selection is complete, click the [Finish] button to begin the import process. Select the Import Error List tab to view import errors. (Alternatively use the [< Back] button to return to the Data Import Wizard dialog or the [Cancel] button to exit the Data Import Wizard.)

The resulting meta-network should appear in ORA’s Meta-Network Manager Pane.

**Special Considerations**

When importing multiple files simultaneously, the files must reside in the same directory (folder).

**References**

None.
Import Survey Monkey Data

Description
SurveyMonkey provides support for user created, customizable online surveys. Survey results can be downloaded as an XLS+ formatted file. The Data Import Wizard lets you choose which questions to import and how to create nodes, links, and attributes from the user responses.

Input
One or more Survey Monkey XLS+ formatted output files.

Result
A meta-network containing the nodesets and networks specified by the user. See below for an example of a created meta-network.

Procedure
This example uses a single Survey Monkey data file to generate meta-networks from Survey Monkey data.

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > Survey Monkey data. Click [Next >]. (Alternatively, click [Cancel] to abort the import.)

This brings up the dialog box for importing Survey Monkey data.

Select one or more data files: Use the Browse button to open a file browser, select the file and click [Open]. The Survey Monkey file must be output in XLS+ format with the actual response values stored in the cells. The XLS+ format uses the first (top) header row to record the questions.

Responder nodeset: Each survey taker is called a responder and each row from the data file contains the answers (responses) for the responder. Each row, therefore, in the output file creates a new responder node to be created within the responder nodeset that you specify. It would usually be Agents and called Responder, but can be anything.

Create Responder Attributes Use the Create Responder Attributes tab (shown above) to create attributes in the responder nodes from either survey meta-data (when the survey was taken, from which computer, etc.) or from question response values. In the example above, we have chosen to create two attributes: StartDate and EndDate.
Use the Create Responder Links tab (shown below) to link the responder node to question response nodes.

Create Responder Links For example, our question is "Which flavor of ice cream is your favorite?" The response will create an Ice Cream node, and a link from the Responder node to the Ice Cream node in the "Responder x Ice Cream - Favorite" network.

To summarize the import process: you choose to import a question by specifying a nodeset for the response nodes (e.g. the Ice Cream nodeset in our example) and a network name. A link is created from the responder node to each response value and added to the network of type: responder nodeset x response nodeset, with the network name you specified.

Click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)
The resulting meta-network should appear in ORA's Meta-Network Manager Pane.

**Special Considerations**

*None.*

**References**

*None.*
Import Shapefile Data

Description

Input
One or more shapefiles (file extension .dbf, .shp, or .shx).

Result
One or more location nodesets inserted into a new or existing meta-network. See Procedure below for an example of adding location data to an existing meta-network.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > Shapefile data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

Chose whether the data should be added to a new or existing meta-network. As shown, a location nodeset will be added to an existing meta-network named **Survey Monkey**.

After selecting the target meta-network, click [ Next > ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Click [ Browse ] and select the input file(s). After file selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.
Special Considerations
None.

References
None.
**Import Bibliography & Citations Data**

**Description**

The Data Import Wizard can generate meta-networks from bibliographic citation data stored in files.

**Input**

The following bibliographic formats are supported:

- BibTeX
- RIS
- Scopus (CSV format)

Citation data from other tools, such as Zotero, can be loaded into ORA by exporting the bibliographic data in one of the supported formats.

**NOTE**: Zotero can export citations in BibTeX and RIS format. Zotero's CSV output option is not in Scopus format.

**Result**

The input file contents, rendered as an ORA meta-network. The exact meta-network content depends on the input file format and contents. A meta-network can include the following nodesets and network:

<table>
<thead>
<tr>
<th>Nodesets</th>
<th>BibTeX</th>
<th>RIS</th>
<th>Scopus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Author</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Publication Venue</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Topic</td>
<td>Yes*</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*When keywords are included in the BibTeX file.

<table>
<thead>
<tr>
<th>Networks</th>
<th>BibTeX</th>
<th>RIS</th>
<th>Scopus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article x Author</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Article x Publication Venue</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Article x Topic</td>
<td>Yes*</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Co-Authorship</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Author x Publication Venue</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Author x Topic</td>
<td>Yes*</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

463
Publication Venue x Publication Venue - Co-Authorship  Yes  Yes  Yes
Co-Topic  Yes*  Yes  Yes
*When keywords are included in the BibTex file.
See the Procedure selection below for additional information.

**Procedure**

In this example, a small bibliographic file output in Scopus CSV format is imported to create a meta-network.

Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

![Import Data into ORA](image)

In the left box select Import other data formats > Bibliography & Citations data then click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)

This brings up the dialog box for importing bibliographic citation data.
Set the meta-network to hold the bibliography and citation data.

Select a destination: a new meta-network or adding to an existing meta-network.

Create a new meta-network with name: Check to create a new meta-network and, optionally, type a meta-network name in the text area to the right.

Add to the existing meta-network: Check to add citation data to an existing meta-network then select a meta-network from the pulldown menu to the right.

Click [ Next > ] to advance to the file selection dialog. (Alternatively, click [ < Back ] to return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Identify the file and file format for import.

Select a citations file: Use the [ Browse ] button to open a file browser. Navigate to a file or files containing the citation data, select the file(s) and click [ Open ].

Create a separate meta-network per file - Check to create individual meta-networks when multiple input files are input. Uncheck to create a single meta-network containing data from all input files.
Select a file format: From the pulldown list, select the bibliography file format. In the example, Scopus - CSV was selected.

NOTE: The following option is only displayed for Scopus - CSV format files.

Authors have embedded commas - Check if the author name contains embedded commas (for example if author names of the form "Cass, Ruth, Parsons, William and Smith, Emma" are used).

Click [Finish] to import the citation data. (Alternatively, click [<Back] to return to the destination dialog to change the destination or [Cancel] to abort the import.)

ORA scans the input file and creates a meta-network model of the citation data.

The import created the following nodesets:

Article (Nodeset Class: Task) – A list of article names (titles).

Articles with identical titles are listed separately (i.e. a bibliography containing three entries with the title "Big News!" would generate three nodes in the Article nodeset).

Author (Nodeset Class: Agent) – A list of authors.

The Node Name contains a single author's name. Papers with multiple author names will create multiple entries. An author name appears only once but ORA does not attempt to resolve variations such as name ordering (last name first versus last), use of initials versus full names, etc.
Publication Venue (Nodeset Class: Location) – A list of journals (or equivalent).

The Node Name contains the venue where the entry published. A given publication venue appears only once but ORA does not attempt to merge differences in spelling, word ordering, or the use of abbreviations versus full titles.

Topics (Nodeset Class: Knowledge) – Contains the topics (keyword) for the articles.

The Node Name contains a topic (keyword or key-phrase). There is one entry per unique keyword; a bibliography entry may contain zero or many keywords. In some cases the inclusion of keywords in generated bibliographies is optional and must be explicitly set when the bibliography is exported.

The import creates some or all of the following node attributes, depending on the input file type and contents:

Article Title (Nodeset: Article, Type: Text) – This attribute contains full title of the article from the bibliography entry.

Date (Nodeset: Article, Type: Text) – This is the date of publication of the article in YYYY (4 digit year) format.

DOI (Nodeset: Article, Type: Text) – The digital object identifier (DOI). A unique alphanumeric string assigned by a registration agency (the International DOI Foundation) to identify content and provide a persistent link to its location on the Internet.

PMID (Nodeset: Article, Type: Text) – PubMed identifier (PMID). The PMID is the unique identifier number used in PubMed.

URL (Nodeset: Article, Type: Text) – Uniform resource locater (URL), the address of the article on the Internet.

Volume (Nodeset: Article, Type: Text) – The volume number for the article.

ISSN (Nodeset: Publication Venue, Type: Text Category) – The international identifier for serials (ISSN), an 8-digit code used to identify newspapers, journals, magazines and periodicals of all kinds and all media—print and electronic.
Type (Nodeset: Publication Venue, Type: Text Category) – Publication type.

The import creates the following networks:

Article x Author – This network links an article to its author(s). An article can have more than one author, and the links are binary.

Article x Publication Venue – This network links an article to the venue where it was published. This should be a one-to-one binary relationship (since articles are typically only published in venue).

Article x Topics – This network links an article to the topic keywords that it contains. An article can have more than one topic, and the links are binary.

Co-Authorship – This network links authors together that co-author articles (Author x Author). This is the product of the Article x Author (transposed) and Article x Author networks. The link values are the number of times authors co-authored an article.

Author x Publication Venue – This network links authors to the venues in which they publish. This is the product of the Article x Author (transposed) and Article x Publication Venue networks. The link values are the number of times an author published in a venue.

Author x Topics – This network links authors to the topics in their articles. This is the product of the Article x Author (transposed) and Article x Topics networks. The link values are the number of distinct articles in which an author used a topic.

Publication Venue x Publication Venue - Co-Authorship – This network links venues through authors that have published articles at both venues. The link values are the number of distinct authors that have published at each venue.

Co-Topic – This network links topics that appear together in articles (Topic x Topic). This is the product of the Article x Topics (transposed) and Article x Topics networks. The link values are the number of times topics co-occur in an article.
Special Considerations

1. Each citation format has different conventions for specifying author first, middle, and last names; in some cases the author name formation is under the control of the citation creator. No attempt is made to normalize the names into a particular format (e.g. last_name_first_name).

2. The BibTeX format can contain Latex formatting commands; no attempt is made to translate them into UNICODE characters. The mark-up characters are passed through the parser without changing them. (Consider this title for example: “On theories $ST$ categorical in $|T|$”, no attempt is made to translate $ST$ into a UNICODE character).

References

None.
Import TAVI Data

Description
TAVI data is data produced by the CASOS TAVI project.

Input
A TAVI data file (file extension .xml).

Result
Not available at this time.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).

In the left pane select Import other data formats > TAVI data. Click [ Next > ]. (Alternatively, click [ Cancel ] to abort the import.)
Click [Browse] and select the input file. After file selection is complete, click the [Finish] button to begin the import process. (Alternatively, click [< Back] return to the Data Import Wizard initial dialog to select a different option or [Cancel] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

*None.*

**References**

Import THINK Data

Description
THINK data was produced by the CASOS THINK project. THINK data consists of a collection of processed messages, each of which has a header and a body. The message header data is held in a single file while the message body is processed into a DyNetML network using the AutoMap tool.

Input
THINK communications data is contained in multiple files: a single file containing header data in either CSV or Excel format (file extension .csv, .xls or .xlsx) and a directory (or folder) containing networks derived from individual messages in DyNetML format, one per message (file extension .xml, .dynetml, or .zip).

Result
The THINK input files, rendered as an ORA meta-network.

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left pane select Import other data formats > THINK. Click [ Next > ].
(Alternatively, click [ Cancel ] to abort the import.)

Chose whether the data should be added to a new or existing meta-network. As shown, a new meta-network named **THINK Example** is to be created.

Click [ Next > ] to select the input files. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

Select the inputs. For Select a header header file:, click [ Browse ] and select the message header file. Then for Select a body directory:, click [ Browse ] and select the message directory.

After input selection is complete, click the [ Finish ] button to begin the import process. (Alternatively, click [ < Back ] return to the meta-network selection dialog or [ Cancel ] to abort the import.)

If the import process completes successfully, a new meta-network will appear in the Meta-Network Manager pane.

**Special Considerations**

None.
References

Import Email

Description
The Data Import Wizard can generate meta-networks from email data retrieved from an IMAP server. The importer automatically creates an agent nodeset of senders and receivers, and three networks detailed below.

Input
Email data from an IMAP server.

Result
The import produces two nodesets and multiple networks. If the Aggregate by Date option was used, then there will be multiple meta-networks created all of the same format.

- **Nodesets**: the following nodesets are created:
  - **Agent nodeset**: contains the sender and receivers of the emails.
  - **Email nodeset**: contains one node per email sent. Each email node will also have three attributes imported: Date, Sender, and Subject.

- **Networks**: the following networks are created:
  - **Agent x Email - Sender**: this is a directed, binary network that links an agent node (the email sender) to the email sent
  - **Email x Agent - Recipient**: this is a directed, binary network that links an email to the agents to whom it was sent (receivers)
  - **Agent x Agent - Sender x Receiver**: this is a directed, weighted network that links each sender to receiver with a link weight of the number of emails sent

Note: In order to create the Agent x Agent "Sender x Recipient" network we would multiply together the networks "Agent x Email - Sender" and "Email x Agent - Recipient".

Procedure
Open the Data Import Wizard: from the command menu select the Import Wizard with File > Data Import Wizard (or type Ctrl+w in the ORA editor pane).
In the left box select Import Email. Click [Next >]. (Alternatively, click [Cancel] to abort the import.)

This brings up the dialog box for importing Email data.
Select an Email server format: Use the server type drop down button to select the type of email server format, either a general IMAP server (your workplace email server, for example) or Gmail IMAP server.

Note: In order to import from Gmail your account must allow less secure apps access. Refer to this site for instructions on how to configure your Gmail account to enable ORA to import from it: https://support.google.com/mail/answer/14257

Enter server information: Enter the email server's address, your email account username, and your email account password. If you currently use an email client (e.g. Outlook, Thunderbird, etc.) you can find these settings in the configuration section of your email client.

Select an account folder: Click on the Select… dropdown and ORA will try to connect to your email server. If it succeeds, then you will see a selection of email folders; choose one from which to import. If the connection attempt fails, then read the error message, correct your server name or password, and retry.

Import options: There are options when importing emails:

General Options:

Create only nodes: Click this to import only nodes and not create any links

Create Sender x Receiver network (agent x agent): Click this to create a network that directly records who sent an email to whom. This is the product of two other networks created during import, and could therefore be left unchecked and the product created later in the Matrix Algebra Tool.

Filter Options:

Ignore emails before: Check the option and enter a date to import only emails after the date

Ignore emails after: Check the option and enter a date to import only emails before the date

Date Aggregation Options:

Aggregate by Check the option and then enter a time period (e.g. 6 weeks, one month, 4 hours) to put all emails within that time period into a single meta-network. This creates a dynamic meta-network, with one meta-network per time period.
Click [ Finish ]. (Alternatively, click [ < Back ] return to the Data Import Wizard initial dialog to select a different option or [ Cancel ] to abort the import.)

**Special Considerations**

*None.*

**References**

*None.*
Import Arbitrary Database

Description
ORA can import data from other databases such as MySQL. This is done through the Data Import Wizard. You will need to configure your database via an ODBC connection, and place the jODBC driver into the requisite ORA JRE installation folder.

Input
Database content.

Result
Not available at this time.

Procedure
If you want to write a DyNetML file to a database, such as one in MySQL, then you would use File Manage CASOS Database.

The jODBC installer deploys the following files:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jodbc.dll</td>
<td>jBASE ODBC Driver Library</td>
</tr>
<tr>
<td>libjODBCSetup.dll</td>
<td>jBASE ODBC Setup Library</td>
</tr>
<tr>
<td>jODBCManager.exe</td>
<td>jBASE ODBC Manager</td>
</tr>
<tr>
<td>ACE.dll</td>
<td>ACE (Adaptive Communication Environment) Libraries</td>
</tr>
<tr>
<td>ACE_SSL.dll</td>
<td></td>
</tr>
<tr>
<td>libeay32.dll</td>
<td>OPENSSL Libraries</td>
</tr>
<tr>
<td>ssleay32.dll</td>
<td></td>
</tr>
<tr>
<td>icuuc40.dll</td>
<td>ICU (International Components for Unicode) libraries</td>
</tr>
<tr>
<td>icudt40.dll</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: The ODBC installer copies the ODBC driver and setup libraries under the Windows\System32 directory.

ODBC Setup library is a separate library implementing the ODBC Setup API required by the driver manager to display graphical components such as connection dialogs. Connection dialogs enables users to configure DSNs inside Windows'
ODBC Manager (odbcad32.exe) or input connection details when requested by the driver.

jBASE ODBC Manager is a small console application used to register the ODBC libraries with the system, create/remove DSNs or test a connection to a remote jBASE instance. Please run jODBCManager -h to obtain more information on how to use this utility.

Installing the driver

The ODBC installer will automatically register the ODBC driver and ODBC Setup libraries. The registration process is required to inform the ODBC Manager about the location of the ODBC driver libraries. The ODBC installer will also add the installation directory to the global user environment variable PATH. This is necessary since the jBASE ODBC driver depends on other shared libraries as e.g. ACE, etc.

When installing on Windows 7 x64, the following extra steps are required:

Start a command shell as Administrator.

Navigate to the directory where you installed the driver then run the following 'jodbcmanager' command.

C:\Program Files (x86)\jBASE ODBC Connector>jodbcmanager -i -driver="C:\WINDOWS\system32\jodbc.dll" -setup="C:\WINDOWS\system32\libjODBCSetup.dll"

Configuring DSNs

ODBC applications usually obtain the connection details from DSNs which may be configured via Microsoft's ODBC Data Source Administrator (also known as ODBC Manager / odbcad32.exe or Control Panel > Administrative Tools > Data Sources (ODBC))

When installing on a 64 bit client, the version of ODBCAD that should be used is the version in c:\windows\syswow64

If the installation has been successful, the following driver should appear in the list of available ODBC drivers:

jBASE ODBC Driver

Adding a DSN for this driver will present the following dialog:
Most of the parameters shown in the previous picture refer to the connection details required by the remote jAgent instance. Server specifies the IP/machine name and Port specifies the TCP port of the remote jAgent instance.

Please refer to the jAgent user guide for more information about the available options.

Pressing the test button will attempt to establish a connection to the server using the provided user/account credentials. If the driver is not correctly registered with the system or the PATH environment variable does not contain the path to the installation directory, the following message box will appear:
Connection strings

Connection strings, as defined by the ODBC SQL CLI, specify the connection parameters supplied to the server when attempting to establish a connection. All connection attributes are defined in a single string separated by semicolons. jBASE ODBC Connector accepts the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSN</td>
<td>Data Source Name</td>
</tr>
<tr>
<td>DRIVER</td>
<td>Name of ODBC Driver. Must be jBASE ODBC Driver</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>DSN Description</td>
</tr>
<tr>
<td>SERVER</td>
<td>Server Address</td>
</tr>
<tr>
<td>PORT</td>
<td>jAgent Port Number</td>
</tr>
<tr>
<td>UID</td>
<td>User ID</td>
</tr>
<tr>
<td>ACCOUNT</td>
<td>jBASE Account. User Authentication will be used if this field is blank</td>
</tr>
<tr>
<td>PWD</td>
<td>User/Account Password</td>
</tr>
<tr>
<td>SCHEMA</td>
<td>Schema Name. Used. Reserved for future use</td>
</tr>
<tr>
<td>SSL</td>
<td>Enable SSL Encryption (1 = Enable SSL, 0 = Disable SSL [default])</td>
</tr>
<tr>
<td>SSL_CERTIFICATE</td>
<td>Path to SSL Certificate File</td>
</tr>
<tr>
<td>SSL_KEY</td>
<td>Path to SSL Public Key File</td>
</tr>
<tr>
<td>COMPRESSION</td>
<td>Enable Data Compression (1 = Enable comp., 0 = Disable comp. [default])</td>
</tr>
<tr>
<td>COMP_THRESHOLD</td>
<td>Compression Threshold. Default = 1024 byte</td>
</tr>
</tbody>
</table>

DSN, DRIVER, UID and PWD are attributes defined by the SQL CLI, all other attributes are jBASE ODBC Connector specific attributes. Attributes highlighted in bold are mandatory attributes.

Example:

DSN=T24;SERVER=127.0.0.1;PORT=20002;UID=test;PWD=test

Special Considerations

None.
References

None.
Data Export

ORA can export your meta-network into a variety of formats using the Data Export dialog available from the main File menu.

Open the dialog from the Main Menu by selecting File > Data Export… to bring up the initial open dialog box. Use the following steps to execute the export:

1. With Meta-Networks selected in the left pane, select the meta-network or meta-networks for export.
2. Optionally, select Filter Data in the left pane to select networks and nodesets for export (by default all meta-network elements are exported). All nodesets and network names are listed in the right pane:
1. Nodesets to analyze: Lists all nodesets contained in the selected meta-networks. Nodesets checked will be exported and unchecked nodesets will be excluded. The networks list below is updated automatically to include only selected nodesets.

The Select All and Clear All buttons at the bottom of the list select or clear (check or uncheck) all the nodesets in the list.

2. Networks to analyze: The list only includes networks where both nodesets have been selected for analysis. Networks checked will be exported and unchecked networks will be excluded.

The Select All and Clear All buttons at the bottom of the list select or clear (check or uncheck) all the networks in the list.

3. After entering all input options, click the [ Next > ] button to proceed to the format selection dialog. (Alternatively use the [ Cancel ] button to cancel the export.)
4. Select the output format and any associated options (see list below).
5. Click the [Export] button. A file chooser will open. (Alternatively use the [Back] button to return to the data selection dialog or the [Cancel] button to cancel the export.)
6. Using the file chooser, select the output directory and adjust the file name if desired (note that when multiple files are produced while exporting suffix text will be automatically added to the file name to distinguish the various files). Click the [Save] button to complete the export (alternatively, click the [Cancel] button to return to the format selection dialog). If the export succeeds, an "Export Success" dialog will appear. Click the [OK] button to finish.
The available export output formats are:

- **DyNetML** - Exports to the standard data format for ORA. DyNetML is a format that contains all node and network information in a single file. This is equivalent to just selecting File > Save Meta-Network from the menu.
- **Table Format** - *(aka Edge List format)* exports each nodeset to a separate file and each network to a separate file. The tables are similar to data base tables and can be imported using the Data Import Wizard.

The following options are available:

- Save links by node name - Exports links using the source and target node names.
- Save links by node index (0-based) - Export links using the source and target node indices (nodes numbered from zero).
- Save links by node index (1-based) - Export links using the source and target node indices (nodes numbered from one).

The file format is determined by the file extension (or the file type selected in the file chooser): tab-separated (tsv), comma-separated (csv) or Microsoft Excel (xlsx).

- **Advanced Table Format** - Exports multiple nodesets to a single file and multiple networks to another file. These files can be directly imported back into ORA using the Data Import Wizard.

The following options are available:

- Combine meta-networks - Export the meta-networks into a combined file.

The file format is determined by the file extension (or the file type selected in the file chooser): tab-separated (tsv), comma-separated (csv) or Microsoft Excel (xlsx).

- **Matrix** - Exports a single file per network in a format similar to that of a spreadsheet: rows are source nodes for links, columns are target nodes for
links, and cells contain link values. Row and column headers can be used to export node names.

The following options are available:

- Include row headers - Export networks with node names as row headers.
- Include column headers - Export networks with node names as column headers.

The file format is determined by the file extension (or the file type selected in the file chooser): tab-separated (tsv), comma-separated (csv) or Microsoft Excel (xlsx).

- Node List - Exports a single file per network where each row contains a source node followed by the target nodes to which it is connected. This format does not contain link values.

The following options are available:

- Save links by node name - Exports links using the source and target node names.
- Save links by node index (0-based) - Export links using the source and target node indices (nodes numbered from zero).
- Save links by node index (1-based) - Export links using the source and target node indices (nodes numbered from one).

The file format is determined by the file extension (or the file type selected in the file chooser): tab-separated (tsv), comma-separated (csv) or Microsoft Excel (xlsx).

- UCINET - Binary - Exports each network to a pair of binary files (.##d, .##h) that can be directly loaded into UCINET.
- UCINET - Text - Exports each network to a human-readable file (.dl) that can be directly loaded into UCINET.
- NetDraw - Exports multiple nodesets and networks to a single file (.vna) that can be directly loaded into UCINET's NetDraw program.
- Pajek: Export nodesets and networks into one or more files (.net) that can be directly loaded into Pajek.
- C3Trace : Exports nodesets and networks into one or more files that can be directly loaded into C3Trace.
- CMapTools : Exports nodesets and networks into one CXL file that can be directly loaded into CMapTools.
• Analyst Notebook: Exports nodesets and networks into one or more files that can be directly loaded into Analyst Notebook.

The file format is determined by the file extension (or the file type selected in the file chooser): tab-separated (tsv), comma-separated (csv) or Microsoft Excel (xlsx).
Saving Files in ORA

Save Meta-Network

This option is initially grayed out when you first load a meta-network. This signifies that the meta-network is currently unchanged. Whenever you make ANY change within the meta-network the option will become full-color indicating it is time to save changes.

After clicking the icon in the toolbar, or selecting the menu item, it will become grayed out again till you change your meta-network once again.

No change needs saved in the meta-network

Changes made to meta-network and need saved

Save Meta-Network As...

If you need to save a meta-network under a different name use select File > Save Meta-Network As.... This will leave the original file intact and create a new meta-network with the new file name.

Save Workspace

While working with multiple meta-networks you may want to retain the information of what files you had open for later use. Saving your workspace creates a file which can be opened later and will recreate your workspace as before.

From the Main Menu select File > Save Ora Project. After selecting [ OK ] on the initial dialog box the Save Ora Project dialog box will appear. Navigate to the folder where you want to save your workspace.

This Workspace can then be called up with the Load Workspace in a future session.

490
Pile Sort

The PileSort module allows a user to load a series of entities such as concepts or people's names. These entities are displayed in a deck, which can then be organized and grouped into a pile, which will contain entities that are similar to one another. The output of the PileSort module will be a network in DyNetML format.

The user can use either a text editor or a spreadsheet to create a two-column comma-separated file (i.e. a .csv file). The first column contains the concept and must not be blank. The second column is optional and can contain metadata.

NOTE: Concepts can not contain embedded commas.

Pile Sort GUI

Pile Sort Interface: consists of two panes: The Side Deck and the Canvas. The Side Deck displays cards that have not been organized into piles, such as initially when the input file is read. The Canvas contains the piles where the cards are placed from the Side Deck.
**Pile Sort Menus**

File > Load a File : Navigate to a directory with a new Pile to Sort.

File > Exit : Leave the Pile Sort program.

Edit > Add an Empty Pile : Creates an additional empty pile on the canvas.

Generate > Create a Network DyNetML File : Creates a DyNetML file from the current state of organization. All cards in a pile are fully connected and cards remaining in the deck are isolates.

Help > Show Help Topics : Accesses the ORA Help files

**Other Functions**

Add Card : takes the concept that has been filled into the text field next to the [ Add ] button and creates a card with that name at the end of the card deck.

Transfer All Cards to Another Pile : Click and hold the icon of a pile and drag it to another pile. All cards in the first pile will be transfered to the new pile.

Cycle Through the Cards in the Pile : Rotates the cards in a pile that the card currently beneath the currently highlighted card becomes highlighted. The newly highlighted card becomes the pile's representative.

Return Cards to the Side Deck : Removes all cards from a pile and returns them to the side deck.

Mark a Card as a Pile's Representative : marks the currently highlighted card as a pile's representative.

Move Card to Another Pile : Click and hold a card in a pile and drag it to another pile.

Click to Add a Title : allows the entire pile to be given a name. Either click on the title bar or use the drop down menu item.

Drag and Drop Here : allows the user to drag cards from the side deck onto a pile.

**Loading a List of Concepts**

All piles are initially empty. The concepts appear in the side deck to the left. A scrollbar will appear if the number of concepts is greater than the screen length. An empty pile contains the banner drag and drop here signifying an empty pile. Once a concept is placed in a pile it will all concepts will be displayed in it's window.

NOTE : To have duplicate concepts in more than one pile requires the creation of duplicate cards.
NOTE: You can leave cards in side deck. Any card not so placed will become an isolate in the resulting network.

Viewing in ORA

Saving a sorted Pile: Sorted piles are saved to the DyNetML format. Networks are formed from the individual piles which include the metadata from each card.

Viewed in the Editor you can see all the saved information from Pile Sort. The column containing pile is the name you gave the pile into which a card was placed. meta-information is the optional second column from the .CSV file originally loaded into Pile Sort. If that was empty, then the meta-information cell would also be empty.
Clicking the [ Visualize this Network ] button displays your Pile in the ORA Visualizer. How networks are formed is based upon the cards placed in each pile. The four cards not placed into a pile (cuttlefish, seal, sea horse, and shark) became isolates in the Visualizer.
Edit Menu

The Copy/Paste functions are dynamic in nature. ORA understands what you have highlighted and will copy it onto the clipboard. Whatever is currently in the clipboard can be copied back into ORA any number of times.

The first two options are to Copy/Paste Editor values.

- **Copy**: The copy function will place a copy of whatever is currently highlighted into the clipboard. That will remain until another item is copied.
- **Paste**: The Paste function will create a copy of whatever is stored in the clipboard. This can be repeated as many times as necessary.

**NOTE**: ORA’s menus change as different items are highlighted. They also change after something has been copied. If a nodeset had previously been copied the menu item will change to Paste Nodeset. If you then copy a meta-network the menu item will change to Paste Meta-Network.

- **Find Entities**: Search all selected meta-networks for named node.
Find Entities

You can do a quick search of any loaded meta-network for a name of an individual node. Remember: The name must be spelled exact or the search will fail.

Standard Search

Place a check mark next to the meta-networks to search. Above this box are three check boxes, Search node IDs, Search node titles, and Search attributes. First we will search only IDs and titles.

Type in the name of a node to search for. Make sure it is spelled correctly or ORA will find no results. In the pane at the bottom it display the meta-network, name of the node, and size for each occurrence.

Next we do a search for robot. In this instance ORA finds no match. But knowing this dataset I know it exists. In this case you need to place a check mark in the check box Search attributes in order for ORA to search the entire dataset.
And the result is one entry.
Find Nodes

Enter a search criteria to match (? and * are wildcards):

robot

✓ Search node IDs ✓ Search node titles ✓ Search attributes

Select the meta-networks to search:

- ✓ Foundation-Forward-1
- ✓ Foundation-Forward-2
- ✓ Foundation-Forward-3
- ✓ Foundation-Forward-4
- ✓ Foundation-Forward-5
- ✓ US Population-1

<table>
<thead>
<tr>
<th>Meta-Network</th>
<th>Node</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation-Forward-1</td>
<td>danel_elivaw_fchott... Agent</td>
<td>size 21</td>
</tr>
</tbody>
</table>

1 Matching nodes.
Preferences Menu

The View Menu shows a log of all activity performed in ORA.

Default Layout: Resets the Editor GUI layout to its default panes position.

Change Font: Allows you to change the GUI font to any font on your system. Be careful with the font chosen as some fonts are built more for custom design rather than readability.

Load Font: Add font to use for the ORA display. ORA will ask whether to make this the default font. If Yes the GUI will be displayed with the new font. These loaded fonts can be found in C:\Documents and Settings\{username}\Ora Fonts.

NOTE: Some fonts may make reading the GUI difficult. Take note of your previous font before making any changes.

Measure Preferences: Allows you to select the type of measures to run.

Use only fast measures:

Do not use slow measures:

Scale measures as percentages (like UCINET):

All Preferences: Contains settings for controlling the environment for working within ORA.
Enable tooltips toggles whether the tooltips are shown when you hover over an object.

Restore docking window layout will restore any changes you've made to the GUI layout. Unchecked at time of closing will result in ORA going back to it's default layout.

Look and Feel Classname

Large toolbar icons
Datasets

Maximum Meta-Networks to fully load

Load DyNetML sources

Load DyNetML link properties

Specify set of files to load at startup gives three options. 1) Do not load any files at startup starts ORA with an empty Meta-Network pane. 2) Restore previously loaded workspace files at startup loads the files stored in the Workspace file. 3) Load specified files below allows you to pick which files you want loaded the next time you start ORA.
Select reports display as list of all reports available. Check marked reports will be used in the report generator. Report names can be changed by right-clicking a report and typing a new name. There is a Reset report names button which changes all names back to their default.
You can type in text for the header and footer of your reports. It will appear on all pages. The Decimal precision controls the number of decimal places for all numbers.
Custom Reports

Allows you to name, describe, and set up the measures to be used. If there are variable parameters for a measure they can be set also. If you have created any previous Custom Reports they will appear in this window. This is where they can be Modified or Deleted.
Preferences Panes

Preferences are global variations which control aspects of how ORA works.

General

Enable tooltips Toggles whether tooltips are shown when you hover over an object.

Restore docking window layout Restores the layout to the default settings. Any changes you've made to the GUI layout will be removed. If it unchecked at time of closing the program ORA startup in the default arrangement.

Look and Feel Classname : Sets the style of the ORA GUI.

Large toolbar icons : Placing a checkmark toggles between using the 16x16 or 24x24 icons.
Data Sets

Maximum Data Files to Load: Tells ORA the maximum number of files to load upon start-up. The checkboxes let you select what to load from the individual meta-networks.

Load DyNetML sources:

Load DyNetML link properties: Unchecking will stop ORA from loading in attributes for all links.

Load DyNetML properties: Unchecking stops ORA from loading in attributes for all nodes.

Load DyNetML networks: Unchecking stops ORA from loading any networks.

What To Load: You have three options for loading files when ORA is started up.

Do not load any files at startup: Ignores any files that were loaded during the last session.
Restore previously loaded workspace at startup: Loads the files that were current when ORA was last shutdown.

Load specified files below: Loads the files specified in the box below the option.

Reports

Selecting Reports to Display: Any reports with a checkmark will appear in the report generator window. Check marked reports will be used in the report generator. Report names can be changed by right-clicking a report and typing a new name.

Reset report names: Resets the names of all reports back to their default names.

Import/Export Settings: These two buttons are used if multiple people work on the same computer. Each individual can use the Export Settings button to export the settings they are using at the end of a session then use the Import Settings when they return to the computer.
You can type in text for the header and footer of your reports. It will appear on all pages. The Decimal precision controls the number of decimal places for all numbers.

Decimal Precision : Sets the precision to which results are calculated.

Enable Flash Charts : Toggles whether flash charts will be rendered in reports.
Custom Reports

The Create, Modify and Delete buttons.

Allows you to name, describe, and set up the measures to be used. If there are variable parameters for a measure they can be set also. If you have created any previous Custom Reports they will appear in this window. This is where they can be modified or deleted.
Data Management

The Data Management menu contains operations to manipulate meta-networks. Special data types can also be managed. The following options are available:

- File Operations… - Trim and merge data files that can then be imported into ORA. More…
- Matrix Algebra… - Create new networks by applying matrix algebra operations to existing networks. More…
- Meta-Network Transform… - Apply predefined transformations to meta-network components. More…
- Meta-Network Sets… - Commands to manipulate meta-networks using set operations…
- Meta-Network Union… - Creates a single meta-network from two (or more) existing meta-networks by union. More…
- Meta-Network Intersect… - Creates a single meta-network from two (or more) existing meta-networks by intersection.
- Meta-Network Difference… - Create a new meta-network from the difference of meta-networks open in ORA.
- Meta-Network Conform… - Make the nodesets of the meta-networks identical.
- Meta-Network Groups… - Define and extract groups from a meta-network.
- Meta-Network Derived Data… - Compute and/or remove data derived from existing meta-
network data. More…
Meta-Network Anonymize… - Render personally identifiable meta-network elements anonymous. More…
Attribute Value Tool… - Create meta-nodes or split meta-networks based on attribute values. More…
Change List Manager… - Create, edit and apply lists of editing commands.
Thesaurus Manager… - View and edit thesaurus files.
GeoSpatial Manager… - Apply supplementary geospatial data to a meta-network.
Meta-Network… ▶ Commands to create and delete meta-networks.

Add New Meta-Network - Add an additional (blank) meta-network.
Remove Selected Meta-Network - Delete the currently selected meta-network.

Nodeset… ▶ Commands to create and delete nodesets within a selected meta-network.

Add New Nodeset… - Add a new nodeset to the selected meta-network.
Remove Selected Nodeset - Delete the selected nodesets.
Add Attribute… - Add an attribute to the selected nodeset..

Network… ▶ Commands to create and delete networks within a selected meta-network.
Add Blank Network… - Add a network to the selected meta-network using existing nodes.

Remove Selected Network - Delete the selected networks.

Set Diagonal - Set the diagonal value in the selected network. Allows user to constant values to the diagonal of a square network (only).


Infer Links… ►

Beliefs -

NOTE: This function only available in a full version of ORA.

Randomize Links - A new meta-network is created with identical nodesets, and with networks of the same size and density, but with links distributed randomly according to Erdos-Renyi. More…

NOTE: This function only available in a full version of ORA.
File Operations

Trim and merge data files that can then be imported into ORA. The input file(s) must be in a delimited format, either comma separated value (CSV) or tab separated value (TSV).

Available operations include:

- **View File** - View a file starting at a particular line. The columns to display can be selected, and lines can be filtered by cell value. The resulting file can be save to a new file.
- **Merge Two Files** - Merge two delimited files by selecting a column that they have in common - the key column. Each pair of lines whose key values match will be concatenated and output.

NOTE: Certain versions of ORA include a tool for importing large files, the Large Scale Table Importer, that includes additional utilities for characterizing the file contents (from the command menu: File > Large-scale Load…).

Operation Selection

In the main menu select Data Management > File Operations… to open the dialog.
Select a file operation. - In the left pane, select the file operation. The right pane will present options for the selected entry. In the image above, the View File operation has been selected.

- **View File** - View a file starting at a particular line. The columns to display can be selected, and lines can be filtered by cell value. The resulting file can be saved to a new file.
- **Merge Two Files** - Merge two delimited files by selecting a column that they have in common - the key column. Each pair of lines whose key values match will be concatenated and output.

**View File Operation**

View a file starting at a particular line. The columns to display can be selected, and lines can be filtered by cell value. The resulting file can be saved to a new file.

The operation is uses two panes. The first pane allows file selection and optional filtering of file contents. The second pane allows viewing of the file contents after filtering is applied with the option of saving the filtered data.

As an example of file viewing, a comma-delimited file containing notional trail data is opened and a subset of lines previewed.

**Selection Pane**

View a file starting at a particular line. The columns to display can be selected, and lines can be filtered by cell value. The resulting file can be saved to a new file.
The selection pane allows file selection and filtering using controls presented under a series of tabs. In this example a comma-delimited (CSV) file is selected and the contents filtered to select only lines containing a single text category value.

NOTE: Use the tabs in order from left to right. The Select File tab is required, the remaining tabs are optional.

Select File Tab

![Data File Management](image)

This tab is used to select a file for previewing. In this example, the file "Travel_2000.csv" is selected and marked as containing a header line. ORA automatically scans the file for information required by the remaining tabs.

Select a file to use and check whether it has a header row.

File Selector - Use the [Browse] button to open a file browser. Navigate to the folder containing the file for preview, select the file and click [Open]. ORA will scan the file for information to use in the next steps. In the image above the file "Travel_2000.csv" is entered.

File has a header row? - Check this option if the first line of the file contains header text rather than data. The example file contains a header line so this option is selected.

Select Columns Tab

515
This tab can be used to limit the preview to selected columns. As shown in the image above, the example file contains five columns, presented from left to right in the same order as in the file. In this instance all columns are relevant and are selected for the preview (the default condition).

Select columns to use in the operation - A column will be included in the preview if a check mark appears in the box to the left and excluded if the box is empty.

**Column List** - File columns are listed in the same order they occur in the file. Click the box to the left of the column to change the selection status.

To select/deselect all columns use the buttons below the list:

- [ Select All ]: Click to select (check) *all* columns.
- [ Clear All ]: Click to deselect (uncheck) *all* columns.

Select Rows Tab
This tab can be used to limit the preview to selected rows. In this example only rows with the word "Business" (only) in the "Purpose" column (plus the header line) will be included in the preview.

Select which rows to use by defining a filter on a column value.

Create a filter and use only rows where column: Check this item to create a filter. The filter consists of a single comparison using the contents of a selected column (which can contain numeric or character data).

**Column selector** - Use the pulldown menu to select the column containing the filter values (in this example "Purpose" was selected).

**Logical operator** - Select the logical operator from the pulldown list (operators apply only to numeric values unless noted):

- EQUALS - Numeric or (case insensitive) text comparison.
- NOT_EQUALS - Numeric or (case insensitive) text comparison.
- CONTAINS - Numeric or (case insensitive) text comparison.
- LESS_THAN
- LESS_THAN_EQUALS
- GREATER_THAN
- GREATER_THAN_EQUALS

In the example, the EQUALS was selected since the Purpose column contains text category data, making an exact match desirable.
**Value field** - Use the text area to enter the value for comparison, which can be a number or text ("Business" was entered for the example).

After choosing the file and optional filter options, use the [Next >] button to advance to the Preview and Save Pane. (Alternatively use the [Close] button to close the dialog.)

**Preview and Save Pane**

The preview pane shows the filtered file. In this example, the rows containing "Business" in the Purpose column (along with the header) are shown.

**Preview and Save**

Preview the result of the operation and save to an output file.

**Starting row number**: Set the first line for preview display. The line number always begins with the first line in the file, whether a header line is present in the file or not. This value *is not* affected by the View all rows option. (Note that the header line, if present, is always shown, regardless of the value set.)

**Number of rows**: Set the number of rows to display, starting with the Starting row number.
View all rows - Select to show all rows from the Starting row number to the end of the file (overrides the Number of rows value).

NOTE: For large files, previewing all lines in the input file may be slow.

View with columns - Select to format the preview by aligning data into columns (delimiter characters are not included). Uncheck to show the file lines including delimiter characters.

[Run Preview] - Click this button to refresh the preview after parameters are changed.

Viewing Area - The file contents are displayed in this area.

Click the Save button to select an output file for the full result set.

After previewing the file, use the [Save] button to save a copy of the filtered file or use the [< Back] button to return to the Selection Pane to view a different file or update filter selections. (When finished, use the [Close] button to close the dialog.)

**Merge Two Files Operation**

Merge two delimited files by selecting a column that they have in common - the key column. Each pair of lines whose key values match will be concatenated and output. The columns to include can be selected, and lines can be filtered by cell value. The merged file can be saved to a new file.

The operation is uses two panes. The first pane allows file selection and optional filtering of file contents. The second pane allows viewing of the merged file contents after filtering is applied with the option of saving the filtered data.

As an example of file merging, two tab-delimited files drawn from the Wikepedia article "List of tallest buildings in Pittsburgh" (viewed November 2018) are selectively merged to produce a list of buildings 500 feet or more in height.
Selection Pane

Merge two delimited files by selecting a column that they have in common - the key column. Each pair of lines whose key values match will be concatenated and output.

The selection pane allows file selection and filtering using controls presented under a series of tabs. In this example two tab-delimited (TSV) files are selected and the contents filtered to include columns selected from each files and only lines exceeding a selected building height.

NOTE : Use the tabs in order from left to right. The Select File tabs are required, the remaining tabs are optional.

First File: Information on the first merge file. Columns from this file will be inserted into the merged file first, in the same order they occur in the source file.
Select File **Tab**

This tab is used to select a file for merging. In this example, the file "Tallest_Buildings_in_Pittsburgh-List.tsv" is selected, marked as containing a header line, and the match column "Name" is selected. ORA automatically scans the file for information required by the remaining tabs.

Select a file to use and check whether it has a header row.

**File Selector** - Use the [Browse ] button to open a file browser. Navigate to the folder containing the first file for merge, select the file and click [ Open ]. ORA will scan the file for information to use in the next steps. In the image above the file "Tallest_Buildings_in_Pittsburgh-List.tsv" is entered.

File has a header row? - Check this option if the first line of the file contains header text rather than data.
Select Columns Tab

This tab can be used to limit the merged file to selected columns from this file. As shown in the image above, the example file contains six columns, presented from left to right in the same order as in the file. In this instance the "Height (meters)" column is unselected and the remaining columns are selected for the merge.

Select columns to use in the operation - A column will be included in the merge if a check mark appears in the box to the left and excluded if the box is empty.

Column List - File columns are listed in the same order they occur in the file. Click the box to the left of the column to change the selection status.

To select/deselect all columns use the buttons below the list:
[ Select All ] : Click to select (check) all columns.
[ Clear All ] : Click to deselect (uncheck) all columns.

Select Rows Tab

This tab can be used to limit the merge to selected rows. In this example only rows with a value greater or equal to 500 in the "Height (feet)" column (plus the header line) will be included in the merge.

Select which rows to use by defining a filter on a column value.

Create a filter and use only rows where column: Check this item to create a filter. The filter consists of a single comparison using the contents of a selected column (which can contain numeric or character data).
**Column selector** - Use the pulldown menu to select the column containing the filter values (in this example "Height (feet)" was selected).

**Logical operator** - Select the logical operator from the pulldown list (operators apply only to numeric values unless noted):

- **EQUALS** - Numeric or (case insensitive) text comparison.
- **NOT_EQUALS** - Numeric or (case insensitive) text comparison.
- **CONTAINS** - Numeric or (case insensitive) text comparison.
- **LESS_THAN**
- **LESS_THAN_EQUALS**
- **GREATER_THAN**
- **GREATER_THAN_EQUALS**

In the example, the **GREATER_THAN_EQUALS** was selected since the Height (feet) column contains numeric data.

**Value field** - Use the text area to enter the value for comparison, which can be a number or text ("500" was entered for the example).

Select the Key column used to merge with the other file: From the pulldown list, select the column containing the key value used to match lines in the other file. In this example the "Name" column was selected.

Second File: Information on the second merge file. Columns from this file will be inserted into the merged file second, in the same order they occur in the source file.

Select File Tab
This tab is used to select a file for merging. In this example, the file "Tallest_Buildings_in_Pittsburgh-Notes.tsv" is selected, marked as containing a header line, and the match column "Name" is selected. ORA automatically scans the file for information required by the remaining tabs.

Select a file to use and check whether it has a header row.

File Selector - Use the [Browse ] button to open a file browser. Navigate to the folder containing the first file for merge, select the file and click [ Open ]. ORA will scan the file for information to use in the next steps. In the image above the file "Tallest_Buildings_in_Pittsburgh-Notes.tsv" is entered.

File has a header row? - Check this option if the first line of the file contains header text rather than data.
Select Columns Tab

This tab can be used to limit the merged file to selected columns from this file. As shown in the image above, the example file contains six columns, presented from left to right in the same order as in the file. In this instance only the "Name" and "Wikipedia Main Article URL" columns are selected and the remaining columns are unselected for the merge.

Select columns to use in the operation - A column will be included in the merge if a check mark appears in the box to the left and excluded if the box is empty.

Column List - File columns are listed in the same order they occur in the file. Click the box to the left of the column to change the selection status.

To select/deselect all columns use the buttons below the list:
[ Select All ]: Click to select (check) all columns.
[ Clear All ]: Click to deselect (uncheck) all columns.

Select Rows Tab

This tab can be used to limit the merge to selected rows. In this example no filter is used (a filter was created for the first file).

Select which rows to use by defining a filter on a column value.

Create a filter and use only rows where column: Check this item to create a filter. The filter consists of a single comparison using the contents of a selected column (which can contain numeric or character data).
**Column selector** - Use the pulldown menu to select the column containing the filter values.

**Logical operator** - Select the logical operator from the pulldown list (operators apply only to numeric values unless noted):

- EQUALS - Numeric or (case insensitive) text comparison.
- NOT_EQUALS - Numeric or (case insensitive) text comparison.
- CONTAINS - Numeric or (case insensitive) text comparison.
- LESS_THAN
- LESS_THAN_EQUALS
- GREATER_THAN
- GREATER_THAN_EQUALS

**Value field** - Use the text area to enter the value for comparison, which can be a number or text.

Select the Key column used to merge with the other file: From the pulldown list, select the column containing the key value used to match lines in the other file. In this example the "Name" column was selected.

After choosing the file and optional filter options, use the [ Next > ] button to advance to the Preview and Save Pane. (Alternatively use the [ Close ] button to close the dialog.)
The preview pane shows the filtered file. In this example, only rows with values in the "Height (feet)" column greater or equal to 500 (along with the header) are shown. The merge includes six columns, selectively drawn from the two files.

Preview and Save

Preview the result of the operation and save to an output file.

Starting row number: Set the first line for preview display. The line number always starts with the first line in the file, whether a header line is present in the file or not. This value is not affected by the View all rows option. (Note that the header line, if present, is always shown, regardless of the value set.)

Number of rows: Set the number of rows to display, starting with the Starting row number.

View all rows - Select to show all rows from the Starting row number to the end of the file (overrides the Number of rows value).
NOTE: For large files, previewing all lines in the input file may be slow.

View with columns - Select to format the preview by aligning data into columns (delimiter characters are not included). Uncheck to show the file lines including delimiter characters.

[Run Preview] - Click this button to refresh the preview after parameters are changed.

**Viewing Area** - The file contents are displayed in this area.

Click the Save button to select an output file for the full result set.

After previewing the file, use the [Save] button to save a copy of the filtered file or use the [< Back] button to return to the Selection Pane to view a different file or update filter selections. (When finished, use the [Close] button to close the dialog.)
Matrix Algebra

Matrix Algebra allows you to perform mathematical operations on two meta-networks. Methods available in ORA include addition, subtraction, and multiplication. These functions help spot strong and weak connections within a meta-network.

Matrix Algebra Definitions

Matrix Multiply - Technically this is the out product.

Inner Product - This is a form of matrix multiplication, sometimes referred to as the dot product. Both matrices must be of the same dimensions - e.g, both 10 x 5. The resulting matrix will be of the same dimensions. For the inner product each term is simply multiple by it's corresponding term in the other matrix.

Procedure

In the Meta-Network pane highlight the meta-networks to analyze. Then select Data Management > Matrix Algebra…. If you want to include any additional meta-networks place a check mark next to their names. When finished click [ Next > ].
The Network Algebra dialog appears.

The Network Algebra dialog appears.

The Select an operation dropdown menu contains the various ways to manipulate your networks. The Select the input networks section allows you to select networks from your meta-networks.

NOTE: Only networks which are the same size will show up in the dropdowns.

- Add Networks - Adds together corresponding cells of two different networks.
- Subtract Networks - Subtracts corresponding cells of two different networks.
- Multiply Networks - Multiplication is slightly different than the add or subtract. The number of rows in the first meta-network must equal the number of columns in the second. A meta-network can be multiplied by itself to help reveal specific strong and weak areas.
- Add a Scalar to existing links -
- Add a Scalar (dense matrix operation) -
- Subtract a Scalar from existing links -
- Subtract a Scalar (dense matrix operation) -
- Multiply by a Scalar -
- Divide by a Scalar -
- Outer Product -
• Set the Diagonal -
• Extract the Diagonal -
• Transpose -
• Create Identity Matrix -
• Fold Rows -
• Fold Columns -
• Pearson's Correlation Rows -
• Pearson's Correlation Columns -
• Row Sum Normalize the link values (x_ij/(sum of row i)) -
• Column Sum Normalize the link values (x_ij/(sum of column j)) -
• Sum Normalize the link values (x_ij/(sum of all values)) -

Select Network 1:
Next select the first network you want to work with.

Select Network 2:
Then select the second network in order to perform the algebra.

Name for the output network:
If you wish, you can change the default name for the newly created network.

Click [ Run ] to create your new network. You can then create more networks if desired. When done, select [ Cancel ] to remove the dialog box from the screen.

Your new network will now appear in the box with your meta-network. Next highlight the network you just created.

**Visualize The Networks**

The meta-network example has one Agent Nodeset with ten agent nodes. Then three Agent x Agent networks were generated using Erdos-Reyni. Below are the three networks. The bi-directional links are shown.
Add

Subtract
Meta-Network Transform

Transform meta-networks using the Meta-Network Transform dialog. Multiple meta-networks can be transformed at once, either over-writing the original input meta-networks, or creating new and transformed meta-networks.

In the main menu select Data Management > Meta-Network Transform.

First, select on the left the meta-networks to transform:

Click [ Next ] and select a transform category in the left pane. (Alternatively, click [ Close ] to abort the transformation.)

General Transform

Click the [ General ] button and check the transforms to run. Transformations are applied in the order shown from top to bottom.
NOTE: To apply transformations in a different order, select the first desired transform and click the [Run] button. Deselect the completed transformation, select the next transformation and click the [Run] button again. Repeat until you have performed all necessary transformations.

Remove isolates based on: Remove isolates based on the entire meta-network or individual networks. An isolate in the entire meta-network means a node has no links from any network. An isolate based on a particular network has no links in that network.

Remove pendants based on: Remove pendants based on the entire meta-network or individual networks. A pendant node is connected to exactly one other node (the connection can be uni or bi-directional).

Remove self loops: Remove self loops (diagonal) in all unimodal networks. A self loop is a link that has an equal source and target node.

Symmetrize by method: Adds, removes, or modifies links to symmetrize each unimodal network. A network is symmetric if for each pair of nodes \(\{A,B\}\) the links \((A,B)\) and \((B,A)\) exist and have the same value. Note that the links can both have value zero. There are different ways to symmetrize a network.
Maximum sets the values of links (A,B) and (B,A) to be the **maximum** of the two existing values

Minimum sets the values of links (A,B) and (B,A) to be the **minimum** of the two existing values

Sum sets the values of links (A,B) and (B,A) to be the **sum** of the two existing values

Average sets the values of links (A,B) and (B,A) to be the **average** of the two existing values

Binarize (set link values to one): sets non-zero link values to have value 1, and therefore a binarized network has only links of value 0 and 1.

Remove Links: removes valued links that match a particular criteria:

- Less Than removes links less than a specific value
- Less than or equal to removes links less than or equal to a specific value
- Equal to removes links equal to a specific value
- Not equal to removes links not equal to a specific value
- Greater than or equal to removes links greater than or equal to a specific value
- Greater than removes links greater than or equal to a specific value

Create union networks: Creates new networks that are the union of all networks of the same type.

For example, if the meta-network had two Agent x Agent networks, then this would create a new Agent x Agent network called "Agent x Agent Union" containing all of the links in the original two networks. The original networks are not removed.

Create implicit locations and networks: If a meta-network has no location nodeset but does have an Agent and/or Organization nodeset with latitude and longitude attributes, then this routine does the following:

1. creates one Location nodeset with the distinct latitude, longitude locations of the Agent and/or Organization nodes
2. creates an Agent x Location and/or Organization x Location network linking each Agent and Organization to its location

Create partition networks by attribute: If a nodeset contains a category-valued attribute, then the unimodal networks based on the nodeset can be partitioned into different networks.
Example: if you have an Agent meta-node that has a gender attribute for each node that takes on values male and female, then using this feature four new Agent x Agent networks would be created that contained links from males to males, males to females, females to males, and females to females. No new meta-node is created and no data is changed.

Combine all selected nodesets into one: Creates a new meta-network with a single nodeset and a single network. The nodes are prefixed with the name of the nodeset they were taken from. Networks of the same type are combined by the union sum method.

Example: if you have a meta-network with three networks, Agent x Agent, Agent x Organization, and Organization x Organization, then this transformation would create a single nodeset that contains each Agent and Organization node, and a single network that combines the links from all three networks.

Negative links: Transforms negative link values into positive link values in different ways:

- Remove negative links removes the negative-valued links from all networks
- Make them positive (absolute value) sets negative-valued links to its absolute value
- Scale negative into (0,½) and positive into (½,1) transforms each link as follows: let scale be one plus the largest absolute link value, then each link value $t$ is transformed to $(t + \text{scale}) / 2*\text{scale}$, which achieves the desired result.
- Partition links into positive and negative networks partitions each network into two networks, one containing positive and the other the negative links (converted by absolute value)

After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

**Networks Transform**

This tab allows you to Select the networks to transform within the meta-network by placing a checkmark in the box. All marked networks will be processed.
The transformations here that are in the General tab operate the same way, except that they are performed only on the selected networks.

Transpose the network creates for each selected network a new network that has the rows and columns reversed. For unimodal networks, this effectively reverses the link direction.

After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)
Recode Links Transform

After parameter selection is complete, click the [Run] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

Create Backbone Transform

Retain only the most highly embedded links in a weighted network, per the method described by Nick, Lee, Cunningham and Brandes (2013) (see References, below):

We presented an approach to uncover deeply embedded relations that are likely to be internal to primary groups, referred to as communities. The method serves, among other things, to reveal essential structure in networks with insufficient variation in local density for standard community detection approaches to work.

The main ingredient of our method is the concept of ranked neighborhood comparisons to infer the structural embeddedness of ties.
The corresponding notion of triadic cohesion has three desirable aspects: (i) it implements sociological theory and should therefore be easier to justify in empirical settings, (ii) it is defined locally and therefore applicable to ego networks as well, and (iii) it is computationally efficient and scales to big network data. (Nick et al., p. 532)

A network backbone is the links most embedded in the network. The networks must be unimodal, and have link values that indicate similarity.

Select the networks for which to compute the backbone: Check the target network or networks for Simmelian backbone transformation.

The [ Select All ] and [ Clear All ] buttons at the bottom of the list select or clear (check or uncheck) all the networks in the list.

Sparsification Choose a value between 0 and 1 to choose how much to trim the network links. A value of 0 means to fully trim it to no links, whereas 1 means do not remove any links.

Created connected backbone Check to enforce the requirement that enough links are retained to keep the input network connected if it was initially connected.
After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

**Reduced Form Transform**

A meta-network is said to be in **Reduced Form** if the unimodal and bimodal network transformations below have been applied to it. Reduced Form is useful for reducing the size of a dataset.

The transformations here that are in the General tab operate the same way.

Transpose networks according to node precedence transposes networks to their ontological order, i.e., if there is an Agent x Location network and a Location x Agent network, then a single Agent x Location network is created by combining the links from both networks. The nodeset order is: **Agent, Organization, Knowledge, Resource, Belief, Event, Task, Location**.

After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

**Delta Operations Transform**

Delta operations add or remove particular nodesets, nodes, and networks to/from the meta-networks.
After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

**Lexis Nexis Transform**

The Lexis Nexis transform is used to convert data imported from LexisNexis into the standard meta-network node classes. Each nodeset is assigned a standard class, the type is recorded, and node names are transformed to lowercase without punctuation and underscore-separated words.
After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

**Miscellaneous Transform**

These are extra transformations.
Change keyframe to date pattern: sets the name of each keyframe to be its date in the specified format

Set image folder name: sets the folder location for node images

Retain only nodes from this class that match: removes all nodes from the selected nodeset that do not have the specified attribute value

Remove node properties: removes the selected node attributes from all nodesets

After parameter selection is complete, click the [ Run ] button to perform the transformation. (Alternatively, click [ < Back ] to select a different meta-matrix or [ Close ] to abort the transformation.)

References

Meta-Network Union

Meta-Network Union is used to combine two or more meta-networks together. There are tools to select which meta-networks to use or exclude and how to combine the link weights. ORA can save out the result as an entirely new meta-network file.

Select Meta-Networks

Place a check mark next to all meta-networks you want to select networks from for the new union meta-network. You can also select the radio button to union the meta-networks files (.xml) in the directory and navigate to a folder.

Here I selected all three of the current meta-networks. You can chose any set to union.
Select Networks

**Select nodesets and networks**
Select the nodesets and networks to include in the union. If loading from a directory, then all nodesets and networks will be used.

**Nodesets to union:**
- Agent
- Knowledge
- Location
- Organization
- Profession
- Resource
- Task

Select All | Clear All

**Networks to union:**
- Agent x Agent
- Agent x Knowledge
- Knowledge x Knowledge

Select All | Clear All
Place a check mark next to all networks you want to place into the new union meta-network.

I deselected all but the agent and knowledge nodesets. I could have also deselected any of the networks.

**General Union**

The Link Options allow you to select the meta data that will be ported into the union. You can also select whether to add the new union to the Meta-Network pane or save it out to a file. Choose to combine the link options with: sum, average, maximum, minimum, and binary values.
Select how to handle both numeric and text attributes. For numeric attributes choose from keep first value, overwrite values, keep all values, sum values, average values, keep maximum value, keep minimum value. For text attributes you can choose from keep first value, overwrite values, or keep all values.
For custom attributes select for each one how to transfer their values from keep first value, overwrite values, keep all values, sum values, average values, keep maximum value, keep minimum value.

**AutoMap Union**

![AutoMap Union](image)

Select how to transfer your link values from the AutoMap file, sum, average, maximum, minimum, or binary values.

You can also chose to add the union to the Meta-Network pane or save it to a file.

**Examples**

The Foundation-Union
I started out with three meta-networks from the Foundation dataset. I selected all three, right-clicked on them and selected union. I deselected all the nodesets except agent and knowledge. Then clicked the [ Compute ] button.

ORA combined these three meta-networks into one combining only the nodesets and networks that were selected.
Meta-Network Derived Data

For meta-networks created using one of several data formats (or schemas) this tool allow selective deletion and recomputation of derived networks currently opened in ORA. This process can be useful when the meta-network is edited or augmented by removing the need to manually update networks which are derived from the primary nodesets and networks.

NOTE : A schema is a pre-defined set of nodesets, node attributes, and networks used create a meta-network containing data of a specific type. A schema can include derived attributes and networks that are created from the other nodesets and networks (called primary nodeset and networks in this document). Some Data Import Wizard importers create meta-networks using a schema with derived data and these meta-networks are the most common inputs for this tool.

Example

As an example, derived networks in a meta-network created using the Data Import Wizard's Bibliography & Citations data importer are deleted using the Remove networks option (see the Procedure section below). After deletion the user can modify or augment the remaining nodesets and networks using ORA's editing and import tools. (Although not shown in the example images, after the contents are updated the Recompute networks operation can be used to recreate the derived networks. All derived meta-networks shown in left image will be recreated using the updated information.)
Procedure

In the main menu select Data Management > Meta-Network Derived Data… to open the tool.

Select Meta-Networks Dialog

Use this dialog to identify meta-network(s) containing derived data to be modified. When multiple meta-networks are selected, they must use the same schema.

Select Meta-Networks

Derived network and attribute data is computed from other meta-network data, and when this data changes the derived data needs to be recomputed.

Select meta-networks with the same format:

Select All
- Erdos-Renyi - Size 75
- Kazman_Bib_01
- Recent ORA Citations

To select/unselect all meta-networks, use the Select All box. Clicking the box will select all meta-networks if there are any currently unselected meta-networks and will unselect all meta-networks otherwise.

After selecting the meta-network(s), click [ Next ] to advance to the Derived Data dialog. (Alternatively, click [ Close ] to cancel operations on derived data.)
Derived Data Dialog

Use this dialog to identify the data schema and operations to perform on the selected meta-network(s).

Derived Data

Select the data format of the meta-networks and the operation.

Select the format for the selected meta-networks:
- Bibliography & Citation

Select the operation to perform on the networks:
- Remove networks

Select the derived data to change:
- Derived Networks
  - Author x Publication Venue
  - Author x Topic
  - Co-Authorship
  - Co-Topic
  - Publication Venue x Publication Venue - Co-Authorship

Select All | Clear All

Derived Data

Select the data format of the meta-networks and the operation.

Select the format for the selected meta-networks: Use the pulldown menu to identify meta-network type:

Twitter - Meta-network conforms to the Twitter schema (for example a meta-network created using the Data Import Wizard's Twitter data importer or related importers).
Bibliography & Citation - Meta-network conforms to the Bibliography & Citation schema (for example a meta-network created using the Data Import Wizard's Bibliography & Citations data importer).

YouTube - Meta-network conforms to the YouTube schema (for example a meta-network created using the Data Import Wizard's YouTube data importer).

In this example the Bibliography & Citation schema is selected.

NOTE : ORA will not attempt to validate the network type provided by the user. Any component in the selected meta-network with the correct ID values for nodesets and networks will be modified. Data deleted or overwritten in these cases cannot be recovered within ORA.

Select the operation to perform on the networks: Use the pulldown list below to select the operation to perform on the derived data.

Remove networks - Delete some or all derived networks.

Recompute networks - Recreate any missing derived networks using the primary networks.

In this example the Remove networks option is selected.

Select the derived data to change: From the list below, choose the target networks for the selected operation. Only derived networks are listed. Use the check boxes to the left of the networks to select (check mark) or unselect (empty) individual networks. You may select/unselect the entire list using the choices at the bottom of the list:

Select All : Click to select (check) all derived data items.
Clear All : Click to deselect (uncheck) all derived data items.

In this example all derived networks were selected for deletion.

After selecting options, use the [ Run ] button to perform the selected operation. (Alternatively, use the [ < Back ] button to return to the Select Meta-Networks dialog or use the [ Close ] button to close the dialog without changing derived data.)
Special Considerations

Only meta-networks conforming to predefined schema should be modified using this method. ORA will not attempt to validate the network type provided by the user. Any component in the selected meta-network with the correct ID values for nodesets and networks will be modified. Data deleted or overwritten in these cases cannot be recovered within ORA.
Meta-Network Anonymize

Meta-Network Anonymizer removes IDs (and optionally Titles) from any chosen nodeset. This is particularly helpful if you are discussing sensitive network information about real people and wish to remove their names from the network model.

The Visualizer

Visualizer Before Anonymizing

When you load your network model into the Visualizer, you will see (by default) the names of your agents or applicable nodesets. You may, for a number of confidentiality reasons, wish to hide this information from your audience yet still show them visually what the network can reveal.
**Visualizer After Anonymizing**

None of the nodes have recognizable names and only the link and network information is known.

---

**Meta-Network Anonymizer Dialog**

From the main menu select Data Management > Meta-Network Anonymize....

The Meta-network Anonymizer tool will appear in a pop-up window. Here you can select a number of parameters pertinent to the nodesets you wish to anonymize.
1. Select a Meta-Network: All active meta-networks appear in the drop-down menu. Select the meta-network to anonymize.
2. Friendly names: The user can create a list for each nodeset of names that will not be anonymized.
3. Anonymizer values:
4. Options:
   - Remove alias attribute
   - Remove latitude/longitude attributes: Removes geospatial attributes from the meta-network.
   - Anonymize only titles
   - Create anonymized name attribute: If you would like to use descriptions other than names, you can generate your own terms. This is intended to be used with the friendly anonymizer tool but can be used for whatever reasons you deem fit. To do so, be sure the Create anonymized name attribute is checked then enter your own term.

After entering all options, click the [Anonymize] button to create an anonymized file. (Alternatively, click the [Close] button to quit the dialog without creating an anonymized file.)
Writing an Anonymized File

When the [Anonymize] button is clicked, ORA writes a .CSV file. The Save box allows the user to navigate to a directory to save the file.

Encoded ID, Original ID
A-1, A01
A-2, A02
A-3, A03
A-4, A04

If the Anonymize node title option is selected then ORA will also write the original Title to the file.

Encoded ID, Original ID, Title
E-1, E01, revanna_meeting
E-2, E02, summit_meeting
E-3, E03, revanna_bombardment
E-4, E04, sgc_meeting
Attribute Value Tool

The Attribute Value Tool creates new meta-networks from existing meta-networks, based on attribute values present the meta-network. Available operations include:

- **Meta-Nodes** - Create a new meta-network containing meta-nodes, using attribute values to aggregate nodes into meta-nodes.
- **Partition** - Split a meta-network into a new meta-networks based on attribute values.

**Meta-Nodes Operation**

The Meta-Nodes operation will create a new meta-network containing merged meta-nodes. The source meta-network will not be altered. For more information on creating meta-nodes, see the Meta-Node Analysis entry.

For example purposes, a categorical text attribute was added to agent nodes representing employees in a fictive software company. The Job Category attribute identifies two sets of multiple agents with the same job. The remaining agents have unique job categories. A new meta-network containing a single node per job category will be created, merging agents when necessary.

In the menu bar, select the Data Management > Attribute Value Tool... to open the Attribute Value Operations dialog.

![Attribute Value Tool](image)

Select Meta-Networks
Select the meta-networks to manipulate - From the list of meta-networks below, check one or more meta-networks for merged meta-node creation. In this instance, a single meta-network was selected.

After selecting the meta-networks, click the [ Next > ] button to advance to the Attribute Value Operations pane. (Alternatively use the [ Close ] button to close the dialog.)

Attribute Value Operations

Set the operations to run. Select the Meta-Nodes operation in the left pane. The right pane will show meta-node creation options.
This page creates a new meta-network that uses the attribute values to create meta-nodes.

Nodeset - From the pulldown select the nodeset containing the attribute to create merged meta-nodes. In this example, the agent nodeset is selected.

Attribute - From the pulldown select the attribute which will control the creation of merged meta-nodes. In the example, the Job Category attribute is selected. Nodes which have the same attribute value will be merged.

Select the attribute values to use when creating meta-nodes, and also which links to create: Each of the tabs allows the user to control the inclusion of nodes in the new meta-network.

Attribute values - Provides a list of the attribute values for the attribute selected to control the creation of merged meta-nodes. Checking a value will include it in the creation of merged meta-nodes, unchecking the value will exclude it. Note that nodes with unchecked values will be excluded from the merged meta-network entirely. To prevent meta-node creation while including the node, the attribute value should be changed. In the example, all values are checked (the default).

Internal links - Provides a list of the links between the selected nodeset nodes (i.e. the one mode networks). Checking a link will include it in the merged meta-network and unchecking it will exclude it. In the example, the agent nodeset is selected, so all links in agent x agent networks will be listed here.

External links - Provides a list of the links between the selected nodeset nodes and other nodesets (i.e. the two mode networks). Checking a link will include it in the merged meta-network and unchecking it will exclude it. In the example, the agent nodeset is selected, so all links in agent x <not-agent> networks will be listed here.

For all tabs, use the [Select All] button to check all values and the [Clear All] button to uncheck all values.

Copy the input networks and links used - Controls whether the new meta-network containing the merged meta-nodes also includes copies of the before merge inputs. Check this option to include copies of the original nodeset and networks. Unchecking it will create a copy including only merged items. In both cases copies of the nodesets and networks not affected by the merge will be included. In the example, checking the option will include both the original nodeset "agent" and a "Meta agent" nodeset as well as the relevant networks (e.g. both "agent x agent" and "Meta agent x Meta agent - agent x agent" networks will be included). The unaffected nodesets "knowledge" and "task", plus associated networks are always included.
Create meta-nodes with link values - Check to compute link values during the meta-network creation (checked by default). Then, from the pulldown menu, select which method will be used to compute the link values:

Link sum (default) - Link value is the sum of the constituent node's link values.

Link count - Link value is the number of times the link was present in the constituent notes.

Density - Link value is proportion of constituent links which have a given link. For example if four nodes are merged and one has a link to a different node, the link value will be 0.25 and if all four are linked the value will be 1.0.

After entering all input options, click the [Run] button to create the merged meta-nodes. The dialog will remain open to allow additional merged meta-nodes to be created. (Alternatively use the [< Back] button to change the input meta-network.) When all merged meta-nodes have been created, use the [Close] button to close the dialog.

After performing the attribute merge, a copy of the meta-network software_company - w/Job Category has been created with an additional nodeset ("Meta agent") and networks ("Meta agent x knowledge - agent x knowledge", "Meta
agent x Meta agent - agent x agent", "Meta agent x task - agent x task") containing the merged meta-nodes.

**Partition Operation**

The Partition operation will create a new meta-networks by splitting an existing meta-network. The new meta-networks contain subsets of nodes from the original meta-network using an attribute to control the split.

For example purposes, agents in a fictive software company are divided based on a categorical text attribute. The **US Resident** attribute has contains simple text values, "Yes" and "No". After the partition operation, two new meta-networks will be created, dividing the agents and networks.

In the menu bar, select the Data Management > Attribute Value Tool... to open the Attribute Value Operations dialog.

![Attribute Value Tool](image)

**Select Meta-Networks**

Select the meta-networks to manipulate - From the list of meta-networks below, check one or more meta-networks for merged meta-node creation. In this instance, a single meta-network was selected.

Note: Multiple meta-networks may be split simultaneously, provided they contain identical attributes; each meta-network will be processed separately. (Meta-networks without common attributes can be selected but any meta-network without the relevant attribute will be ignored.)
After selecting the meta-networks, click the [Next >] button to advance to the Attribute Value Operations pane. (Alternatively use the [Close] button to close the dialog.)

![Attribute Value Operations dialog](image)

Attribute Value Operations

Set the operations to run. Select the Partition operation in the left pane. The right pane will show the partition options.

Select the nodesets to partition by attribute value. Nodesets not selected will be added in their entirety to each new meta-network. Check one or one or more nodesets for attribute selection. In this example, the agent nodeset was checked.

Use the [Select All] button to check all nodesets and the [Clear All] button to uncheck all nodesets.

Select a Text or Number Category attribute: From the pulldown list, select an attribute to control the partition operation. Only categorical attributes from the nodesets checked above will be included in the list. In this example, the "US Resident" attribute was selected.
Each attribute value selected below creates a new meta-network that contains only the nodes with the value. After an attribute is selected, the attribute values are listed. Check one or more attribute values. Each attribute checked will create a new meta-network. In this example, both "Yes" and "No" were checked.

Use the text area above the attribute value list to search for specific attribute values, particularly in longer lists. When text is entered, only attribute values containing that text will be displayed. Clearing the text will restore the full attribute value list. Selection values are preserved when entries are hidden or revealed.

After entering all input options, click the [Run] button to split the meta-network. The dialog will remain open to allow additional splits to be performed. (Alternatively use the [< Back] button to change the input meta-network.) When all splits have been performed, use the [Close] button to close the dialog.

After performing the attribute partition, two additional meta-networks have been created: software_company - w/Job Category US Resident=No and software_company - w/Job Category US Resident=Yes. Each contains a partitioned agent nodeset, copies of the other nodesets and networks revised to include only the selected agents.

Shown below are the agent x agent networks before and after partition:
The initial **agent x agent** network showing the original agent connections.

**software_company - w/Job Category**

The partitioned "US Resident=No" **agent x agent** network. Note that **Software Engineer 3** is disconnected since their only link was to a US resident.
The partitioned "US Resident=Yes" agent x agent network.
Randomize Links

NOTE: This function only available in a full version of ORA.

Randomizing Links is commonly done to test a hypothesis about a given network. If after conducting experiments, there is no significant difference between a hypothesis and a random graph, the evidence supporting the hypothesis could be weak.

A Random Graph is obtained by starting with a set of n nodes and adding Links between them at random. Different random network models produce different probability distributions on networks.

The theory of random networks studies typical properties of random networks, those that hold with high probability for networks drawn from a particular distribution. For example, we might ask for a given value of n and p what the probability is that G(n,p) is connected. In studying such questions, researchers often concentrate on the limit behavior of random networks—the values that various probabilities converge to as n grows very large. Percolation theory characterizes the connectedness of random networks, especially infinitely large ones.

Random networks are widely used in the probabilistic method, where one tries to prove the existence of networks with certain properties. The existence of a property on a random network implies, via the famous Szemerédi regularity lemma, the existence of that property on almost all networks.

Creating a Random Graph is a function which randomizes the links in a network. From the main menu select Data Management > Randomize Links. From the dialog box select from the drop-down menu. A new meta-network will appear in Pane 1 and its name will denote it has been randomized.

The original meta-network is selected and the network agent x agent is chosen. From the Info Tab in the Editor the Visualize Only this Graph button is clicked. This displays the network as it appears in the original meta-network.
Now select the newly created randomized network and select the agent x agent network. From the Info Tab in the Editor the button is clicked. This displays the network as it appears in the randomized meta-network.

As shown in the visualizer the links have been randomized.
Generate Networks

- Create New Meta-Network: Creates a new blank meta-network.
- Influence Network Generator: Creates an Influence Network file for use in the external program Pythia.
  
  **NOTE:** This function only available in a full version of ORA.

- Command and Control Structure Generator: Creates network files for use in the external program CAESAR III.
  
  **NOTE:** This function only available in a full version of ORA.

- Create New Meta-Network In Visualizer: Creates a blank meta-network in the Visualizer which can be populated with nodesets and networks from scratch.
- Create Expected Interaction Network: Predicts the expected interaction of a network given known tasks and other available network data. You can create: Expertise Correlation, Similarity Correlation, Distinctiveness Correlation, and Resemblance Correlation.
Influence Network Generator

**NOTE:** This function only available in a full version of ORA.

Influence Network: is a hypotheses regarding tasks, performance, event happening, and related events. This functions covers how to generate an influence network from a social network using ORA and examines the probability of event happenings based on the state and influence of supporting nodes.

The Influence Network Generator tool in ORA takes a meta-network and outputs an influence network that is readable by another software program, Pythia. Pythia, a software tool developed by George Mason University, has the ability to reason about an influence network's structure extracted by ORA. Therefore, ORA and Pythia can work in conjunction to perform an influence network analysis. Essentially, ORA generates the network and Pythia tells you something about it.

ORA generates influence nets for Pythia from meta-networks. ORA can also read in a Pythia influence net and assess its structure. After ORA generates an influence network, the user then has to work with Pythia and a SME (subject matter expert) to get the probability distributions to make sense. The key advantage is by inferring the influence network from the meta-network via ORA you save a lot of the start-up time in performing an influence network analysis.

The ORA file generated by this function is directly loadable in Pythia. It is not a complete influence network and the user will need to make adjustments to the generated networks. It uses basic ontological interpretations and inferred baseline probabilities where the user specifies positive/negative probability.

We create an influence network based on: Extracting a task network which directs the target task to analyze. Then examine the complexity, importance, personnel/resource/expertise assignment of the tasks.

The examinations become influence network nodes containing ontological interpretation when: The task is done — the task is complex — the task is important — there are sufficient actors associated with the task — resources are available — expertise is available.

Then links are created as in the task network and background hypotheses nodes link to a task node.

Running the Routine: From the main menu: File > Influence Network Generator. This brings up the Influence network step by step creation dialog box. There are three options: Task Based, Event Based, and Belief Based.
After selecting the creation type and clicking [Next] you will be presented with a number of steps depending on what information needs created.

Information on the thresholds you want and other data will be input in the dialog boxes until the final screen is reached.
When all the information is input a dialog box with the results will display. This is the final check before clicking the [Convert] button and saving the file.

Extracting a Task Network for the Influence Network Generator

NOTE: This function only available in a full version of ORA.

What follows are procedures to extract a task network for the Influence Network Generator.

In a meta-network there is an event-to-event network and a task-to-task network. Choose one task to analyze.

Here we look at bomb preparation. Find the tasks that need completed to accomplish the objective. Then trace from provide_money, get_money, purchase_oxygen.
The complexity of the task depends on three items. Resources / Expertise required and number of person required.

- Very Low (default baseline=1.0): 0 resource/expertise required / 1 person required.
- Low (default baseline=0.9): 1 resource/expertise required / Less than 3 persons required.
- Medium (default baseline=0.8): Less than 4 resource/expertise required / Less than 4 persons required.
- High (default baseline=0.7): Less than 8 resource/expertise required / Less than 7 persons required.
- Very High (default baseline=0.6): More than 7 resource/expertise required / More than 6 persons required.
The importance of the task is determined by using standardized degree centrality and betweenness (ranging (0~1)):

- Very Low (default baseline=0.4): Not connected to other tasks
- Low (0.5): Low out-degree density and low betweenness in task network
- Medium (0.6): Medium out-degree density and low betweenness in task network
- High (0.7): High out-degree density or medium betweenness in task network
- Very High (0.8): High out-degree density in task network

The actor assignment of the task is determined by sufficient actors, which are associated with the task.

- No personnel (default baseline=0): No assigned actors
- Insufficient (0.25): Only 75% of resources/expertise are covered by assigned actors.
- Almost sufficient (0.5): More than 75% of resources/expertise are covered by the assigned actors.
- Sufficient (0.7): At most one person associated with each resource and each expertise connected to the task.
- More than sufficient (0.8): More than one person associated with some resources and expertise connected to the task.
Resource / Expertise Availability

Finds if Expertise and Resource are directly accessible. The availability is determined as follows:

- Redundantly available/accessible baseline probability=0.75): More than one person with the expertise associated with the task.
- Available/accessible (0.6): One person with the expertise/resource is associated with the task.
- Unavailable/unaccessible (0.25): No person with the expertise/resource is associated with the task.

To Learn More…

Pythia

NOTE: This function only available in a full version of ORA.

Pythia is a timed influence net application. Conversely, data from Pythia can be loaded into ORA using the Data Import Wizard.

In conjunction with the Pythia application from George Mason University, data from ORA can be loaded into Pythia to create organizational displays.

What follows is a brief example of creating an organizational display using ORA with Pythia.

Start from an ORA Task Network (shown below)

The data can be loaded into Pythia to create an organizational display.
Contact George Mason to download Pythia and for additional instructions on how to use the tool.

Learn more...

Command and Control Structure Generator

NOTE: This function only available in a full version of ORA.

C2 Structure and Meta-Network

A meta-network is a representation of a complex adaptive system. This system it has agents, expertise, resources and tasks. And inherent in this data are meta-networks that contain the C2 structure of an organization, which are the links of a social network among commanders represented in the following ways:

- Command chains
- Information sharing relations
- Result/response sharing relations

However, meta-networks may only have one commander-to-commander network without classifying the nature of links. An analyst oftentimes needs a method to infer the nature of relations among commanders based on a given meta-network. That is where this tool can help. ORA uses the task assignment and communication directions to infer the nature of a link.

C2 structure in CAESAR III: Design View and Analysis View can be generated from a series of matrices describing the communications among decision makers (agents). The goal should be producing the matrices out of a social network. The analysis view has cognition aspects. The nature of a link is determined by the timing of communication during the decision making process.

Meta-Network: Network among people (knowledge, resources, tasks, etc). Data for statistical analysis, not exactly an analysis tool. Reveal the organizational structure, influence propagation, command and control structure, etc. Widely used in organizational science, counter-terrorism, structure reformation, etc.

C2 structure extraction in ORA: ORA provides a function, Command and Control Structure Generator. Automatic generation of C2 structure based on a target task and a social network among decision makers. Generated influence network is directly loadable in CAESAR III. It is not a complete C2 structure but a reasonable inference (or approximation).
**C2 Structure Generation Procedure**

Determine a target task to analyze. Extract the task network of the target task. Extract the related (assigned) agents of the task network. The other agents are aggregated and represented as the outside world (IN and OUT). Regard the agent-to-agent network as a information sharing network. Determine the network level based on the link directions and network topology. Then, extract a command chain from links bridging different network level. Determine the result sharing requirement based on the task network (i.e. the link direction between the two tasks indicate the result sharing requirement) Then, create a result sharing network based on the requirements.
Extracting a Task Network for the Command and Control

NOTE: This function only available in a full version of ORA.

What follows are procedures and an overview of extracting a task network for command and control analysis using ORA in conjunction with CAESAR III, an external software tool for task network analysis.

In a meta-network, there are event-to-event networks and task-to-task networks contained in most data sets. We select one task to analyze and use ORA’s command and control tool to discover the steps needed to complete this task from beginning to completion.

In the images below, we are extracting a task network needed for the bomb_preparation task node.

The idea is to find how tasks should be completed to accomplish the objective, bomb_preparation (e.g., find the trace to a purchase_oxygen task. Provide_money — > get_money —> purchase_oxygen).
Assigned Agents

Identify the task network. Find all the assigned agents. Agents directly linked to a task in the task network.

Approximated Information Sharing Network

Just the agent-to-agent network in a meta-network.
Inferred Command Chain

Determine the network level. Find the inferred hierarchy of the organization. Find the command chain from the hierarchy.

Inferred Result Sharing Network

The task network defines the task prerequisites. Then, the result of a task should be informed to the agents doing the next task. Create a result sharing network by using the above inference rule.
Ahmed_ghallani should inform the result of purchase_oxygen to the agents doing bomb_preparation. Purchase_oxygen is a prerequisite of bomb_preparation.

**Visualization by CAESAR III**

Generated by ORA. Target task: surveillance. Design view and analysis view in CAESAR III.

CAESAR III

NOTE: This function only available in a full version of ORA.

CAESAR III is a software application for the design of decision making organizations at the operational and tactical levels; it takes into consideration cultural differences in coalitions and of adversaries. What follows in overview of how CAESAR III and ORA can work together.

ORA can import data from CAESAR III. See the Data Import Wizard for detailed instructions.

The Design View and Analysis View can be generated from a series of matrices describing the communications among decision makers (agents). The goal should be producing the matrices out of a social network. The analysis view has cognition aspects. The nature of a link is determined by the timing of communication during the decision making process.

Meta-networks are generated by ORA. Then through CAESAR III's Design and Analysis Views their structure is analyzed.

Reference at the George Mason University web site:
http://sysarch.gmu.edu/main/software/

Contact George Mason University at the above URL for instruction on downloading CAESAR III data.
New Meta-Network in Visualizer

From the main menu select Generate Networks > Create New Meta-Network in Visualizer. This does two things:

1) It creates an empty meta-network in the Meta-Network Manager Pane.
2) It brings up an empty visualizer window to create a meta-network.

NOTE : The main interface and the visualizer are linked. What you do in one is reflected in the other.

The Windows

Your work area contains, from left to right, Meta-Network Designer, Visualizer window, and Legend.
The Meta-Network Designer Window

The Designer Window contains the following controls:

- [ Nodes ]: Button to switch the Designer Window to the node view (initial view).
- [ Links ]: Button to switch the Designer Window to the link view.

Node View (shown):

- [ Agent ]: Dropdown menu used to select the nodeset class for placing a new node. Displays the current nodeset class selection (Agent… Unknown). Creates a nodeset of the selected type (if it doesn't already exist) and displays first page of icons.
- [ Avatars ]: Dropdown menu to select predefined icons for nodes. Displays the name of the current group selected.
- Icon Pane: Display area shows the currently selected icon set. Icons can be dragged and dropped to create nodes (see Creating New Nodes below).
- [ New Nodeset ]: This dropdown menu starts out empty until you create a nodeset. Once nodesets are created they will appear in this menu.

Link View:

- [ Link Value: 1.0 ]: Select to create links with a value (weight) of 1 (see Creating New Links below).
- ...
- [ Link Value: 10.0 ]: Select to create links with a value (weight) of 10.
- Auto-Find and Create Networks:
Creating New Nodes

To create a new node select a nodeset, select a link weight, then click, and hold, an icon and drag it into the Visualizer window.

- Link creation mode; current Auto-Create is the only option.
- Auto-Create Symmetric Links: Check to automatically create a return link from the target node.
Creating New Links

In the Designer window click the [Links] button. This brings up buttons to set the weight of new links.

The drop down at the bottom defaults to Auto-Find and Create Networks.

If you place a check mark in the Auto-Create Bidirectional Links when you create a link. (e.g. You create a link from Node A to Node B) ORA will automatically create a complementary link (e.g. a link from Node B to Node A will be added).

To create links, click and hold the left mouse button on a node. Then drag the cursor to another node and release the button.
Final Network
Create Stylized Networks

Stylized Networks are models built upon common network structures evident in many real world environments.

Erdős-Rényi Network: A model for generating random graphs by setting an link between each pair of nodes with equal probability, independently of other links.

Core-Periphery Network: The core-periphery structure of the network has a dense central core of key agents and a large periphery of marginal agents.

Scale-Free Network: Some nodes act as highly connected hubs (high-degree), although most nodes are of low degree. Scale-free networks' structure and dynamics are independent of the system's size N, the number of nodes the system has. In other words, a network that is scale-free will have the same properties no matter what the number of its entities is.

Cellular Network: Highly connected cells connected by a few links.

Lattice Network: A Lattice Network is a large-world network.

Small-World Network: Where most nodes are NOT neighbors but can be reached from every other node by a small number of hops or steps.

Fixed Degree-Distribution Network: A random graph is constructed by specifying as input: (a) the number of nodes in the network, and (b) the number of link for each node. The graph is random according to the input, however it should be noted that not all degree sequences are illogical so this algorithm may produce an empty graph as a result. read more
**Cellular Network**

**General**
A small number of tight clusters with few links between clusters.

**Properties**
Large distances.
High local structure [clustering].

**Dialog Box**
Number of Cells: How many groups [clusters] for the network.
Inner Density: How dense should the network within each cell be?
Outer Density: How dense should the connections between cells be?
Core Periphery Network

The core-periphery structure is an ideal typical pattern that divides both the rows and the columns into two classes. One of the blocks on the main diagonal (the core) is a high-density block; the other block on the main diagonal (the periphery) is a low-density block. The core-periphery model is indifferent to the density of ties in the off-diagonal blocks.

When we apply the core-periphery model to actor-by-actor data (Core/Periphery), the model seeks to identify a set of actors who have high density of links among themselves (the core) by sharing many events in common, and another set of actors who have very low density of ties among themselves (the periphery) by having few events in common. Actors in the core are able to coordinate their actions, those in the periphery are not. As a consequence, actors in the core are at a structural advantage in exchange relations with actors in the periphery.

There are Two kinds of nodes

Core of interconnected nodes.

Periphery of pendants with single connection to Core.
Properties

Short distances

Some local structure (core vs non-core)

Dialog Box

Proportion of core nodes :

Density of core nodes : How dense should the within-core network be?
Erdos-Reyni Network

**General**
Networks are purely random
They are the most commonly form studied.

**Properties**
Short distances.
No local structure (clustering).
Very different than real-world networks.

**Dialog Box**
Input: Approximate density of resulting network.
Lattice Network

Lattice

Nodes are placed at the integer coordinate points of the n-dimensional Euclidean space and each node connects to nodes which are exactly one unit away from it. (i.e. if the lattice is two dimensional and the length of the lattice is 2 along the first and 2 along the second dimension, then it has 4 nodes and they're placed at coordinates (1,1), (1,2), (2,1), (2,2)) The two nodes are connected if the difference of one of their coordinates is one or minus one and all their other coordinates are exactly the same.

General

Nodes laid out in a circle and connected to their K closest neighbors.

Properties

High clustering.

High average path length

Dialog Box

Number of agents : Network size.

Number of neighbors : Number of neighbors each node is connected to

602
Their most distinguishing characteristic is that their degree distribution follows a power law relationship, 
$$P(k) \sim k^{-\gamma},$$

Where the probability $P(k)$ that a node in the network connects with $k$ other nodes was roughly proportional to $k^{-\gamma}$, and this function gave a roughly good fit to their observed data. The coefficient $\gamma$ may vary approximately from 2 to 3 for most real networks.

**Process**

New nodes more likely to connect to existing nodes with high degree.

**Properties**

Short Distances.

No local structure.
**Dialog Box**

Density: How dense should the resulting network be?

Initial network: How big should the simple (erdos-renyi) seed network be?

Initial density: How dense should the simple (erdos-renyi) seed network be?
Small World Network

A type of graph in which most nodes are NOT neighbors of one another, but most nodes can be reached from every other node by a small number of hops or steps. A small world network, where nodes represent people and links connect people that know each other, captures the small world phenomenon of strangers being linked by a mutual acquaintance.

The small-world behavior is characterized by the fact that the distance between any two inks is of the order of that for a random network and, at the same time, the concept of neighborhood is preserved.

A Small-World Network is a regular network with a degree of random long range connections. It is rarely disrupted by the elimination of one node.

Creation in Three Steps

Begin with a lattice, e.g., 2D grid with k nearest neighbors connected.

Randomly remove connections.

Randomly add long distance connections.
Properties
High local structure (clustering).
Short maximum distances

Dialog Box
Number of neighbors : Dimensionality of embedding space/lattice. Alternatively, average degree.
Probability of removing a neighbor : Remove any local structure?
Probability of adding a neighbor : Add long-range connections?
Power law exponent : How much should long-range connections ignore local structure?
Fixed Degree-Distribution Network

Create Fixed Degree Distribution: creates a random graph constructed by specifying as input: (a) the number of nodes in the network, and; (b) the number of links for each node. The graph is random according to the input, however it should be noted that not all degree sequences are illogical so this algorithm may produce an empty graph as a result.

Allow self-loops: **Checked** allows the generation of a node tied to itself. **Unchecked** disallows the generation of a node tied to itself.

Construct directed-tie network: **Checked** generates directed network. **Unchecked** generates an undirected network.

If directed, then count is inbound, else outbound: **Checked** the degree list is incoming ties. **Unchecked** the degree list is outgoing ties.

Degree list: Enter the degree listing – in the desired node order. The input for the degree sequence is a comma delimited list of the number of edges. Correspondingly, the number of nodes is determined by the number of parameters entered.

To facilitate simplified entry, a shortcut can be made by specifying the number of nodes at a specific number of edges. Further, the node id in the generated graph will correspond with the position in the input string.

Degree sequences that are illogical will be impossible to generate, e.g., 2@20 (two nodes with 20 ties each; impossible because the maximum ties a node can have in this network of size two is 1 tie.) Further, some networks can be difficult to produce due to the specific degree distribution and the random process used to construct the network, so the algorithm is designed to make up to 10 separate attempts at
constructing the exact distribution. After 10 attempts, the algorithm will return the error meta-network. The user may choose to resubmit the same request for another up-to-10 attempts at making the network.

For example, the following are valid input strings (with self-loops off and undirected):

- 1,5,3,0,1 - produces a 5 node network with one isolate and 2 pendants, etc.
- 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes with 2 edges.
- 10@5,10@3 - will produce a 20 node network

The following are valid input strings but illogical:

- 100,0,1 - is illogical and will produce a null meta-network named with an error message
- 3@2,1 - is illogical and will produce a null meta-network named with an error message
- 10@5,10@3,1 - is illogical will produce a null meta-network named with an error message
Create Expected Interaction Networks

NOTE: This function only available in a full version of ORA.

Below is an image of the Expertise Correlation tool in ORA and procedures on using the various options it contains:

![Expertise Correlation](image)

Below are links to the Measures section pertaining to each Correlation.

**Expertise Correlation**: Measures the complementarity of two agents based on their knowledge.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samant...</th>
<th>daniel_jackson</th>
<th>tealc</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.14235715</td>
<td>0.2857143</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>maj_samant...</td>
<td>0.14235715</td>
<td>0.0</td>
<td>0.2857143</td>
<td>0.14235715</td>
<td>0.14235715</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.16666667</td>
<td>0.16666667</td>
<td>0.0</td>
<td>0.16666667</td>
<td>0.16666667</td>
</tr>
<tr>
<td>tealc</td>
<td>0.0</td>
<td>0.14235715</td>
<td>0.2857143</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.125</td>
<td>0.25</td>
<td>0.375</td>
<td>0.125</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Jaccard Similarity Correlation**

Measures the degree of similarity between agents based on the number of knowledge bits they both have.

609
### Distinctiveness Correlation

Measures how distinct are two agents based on the number of knowledge bits they hold oppositely.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_sanant...</th>
<th>daniel_jackson</th>
<th>teaf/c</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>1.0</td>
<td>0.333333334</td>
<td>0.25</td>
<td>1.0</td>
<td>0.5</td>
</tr>
<tr>
<td>maj_sanant...</td>
<td>0.333333334</td>
<td>1.0</td>
<td>0.25</td>
<td>0.333333334</td>
<td>0.0</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.25</td>
<td>0.25</td>
<td>1.0</td>
<td>0.25</td>
<td>0.0</td>
</tr>
<tr>
<td>teaf/c</td>
<td>1.0</td>
<td>0.333333334</td>
<td>0.25</td>
<td>1.0</td>
<td>0.5</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.5</td>
<td>0.0</td>
<td>0.0</td>
<td>0.5</td>
<td>1.0</td>
</tr>
</tbody>
</table>

### Resemblance Correlation

Measures the degree of resemblance between agents based on the number of knowledge bits they both have or both do not have.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_sanant...</th>
<th>daniel_jackson</th>
<th>teaf/c</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.222222222</td>
<td>0.333333334</td>
<td>0.0</td>
<td>0.111111111</td>
</tr>
<tr>
<td>maj_sanant...</td>
<td>0.222222222</td>
<td>0.0</td>
<td>0.333333334</td>
<td>0.222222222</td>
<td>0.333333334</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.333333334</td>
<td>0.333333334</td>
<td>0.0</td>
<td>0.333333334</td>
<td>0.444444445</td>
</tr>
<tr>
<td>teaf/c</td>
<td>0.0</td>
<td>0.222222222</td>
<td>0.333333334</td>
<td>0.0</td>
<td>0.111111111</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.111111111</td>
<td>0.333333334</td>
<td>0.444444445</td>
<td>0.111111111</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Analysis Menu

Generate Reports: Create reports from the meta-network data. Reports are grouped into categories to help in finding a particular report.

Measures Manager: Choose which measures to use when generating reports, charts, or visualizations. These are measures to use by default. Certain operations in ORA will ask which measures, and that selection would override these general, default measures.

Correspondence Analysis: Runs a correspondence analysis on the selected network to find patterns in the row and column entries.

Socio-cultural Cognitive Maps (SCMs): Creates the best-fit network model for the set of underlying node to variable data.

Geary-C & Moran-I Analysis...: Performs Moran's I test using phylogenetic and spatial link matrix (binary or general). It uses neighboring weights so Moran's I and Geary's C randomization tests are equivalent.

Machine Learning...: Applies machine learning algorithms to selected training data.
Generate Reports

Creates reports on the selected meta-networks. These reports are detailed in the Reports Section.

You can choose an individual report from the drop-down menu or use the By Category drop-down menu which forms them into groups by function. All measures are in both drop-downs.

After choosing a report from the drop down menu a description and output format will appear beneath it.
The next section allows you to choose which meta-networks to run the report on. Place a check mark next to all reports to use.

Clicking on the downward pointing double arrow reveals the Transform section which allows you to select the method the meta-networks are changed prior to running the report.

- General mathematical transformation:
- Remove node:
- Partition nodes into separate Meta-Networks by attribute value:

Click [Next]

This next screen will differ depending on which report was chosen. For some reports you will be taken directly to the print screen. For others there will be additional information you need to specify.

The Final Print Screen: allows you to choose whether to write the file to a Text, HTML, CSV, or PowerPoint file and tell ORA where to save it. You can also choose to use a different filename for all the reports written.
Before you run any measures on a meta-network you can use the Measures Manager to set exactly the measures you wish to compute.

Form the main interface menu select Analysis > Measures Manager.

NOTE: You can sort the measures by clicking on any of the headers.

The dialog box has multiple sections:
**Filter Commands:**

This section comprises two radio buttons (Match at **least one** filter | Match **all** filters) which allow for complex filtering, a [Reset Filters] button, and a Search text box used for inputting your search. Whatever searches you input in this section are reflected in the Tabbed Window below. It will display only the nodes which match the search(es).

**Item(s) Selected | Visible | Total**

When first called up the All Measures tab defaults to showing every measures available. When started there were 137 item(s) selected, 137 visible, 137 total.

Selecting the Slow Measures tab this changes to 16 item(s) selected, 16 visible, 16 total.

Typing Cognitive into the search text box reduces this to 16 item(s) selected, 8 visible, 16 total showing that only 8 out of the 16 Slow Measures contain the word Cognitive.

Furthermore you can unselect measures by removing the check mark next to the measure's name. With each measure deselected the number of selected items will reduce by one.

With these tools you can select only the measures you want to run reports on.

**Buttons**

- Reorder
- Select All: Selects (puts a check mark in the box) all visible measures
- Clear All: De-Selects (removes check marks) from all visible measures.

**Tabbed Window**

This section contains tabs which sort the measures into various categories.

Each of the nine tabs sorts out the measures in different categories. This is very useful for large meta-networks when you'd prefer not run, say the **Slow Measures** cause it would put too much a drain on your machine. By removing the check boxes for the Slow Measures they are taken out of the mix and the reports will effectively ignore them. You can turn them back on when you're finished by placing a check mark back in the box.
In the Tabbed Window there are four columns:

1. Last Name : Deals the general type of measure (Congruence, Exclusivity, Cognitive...). Most entries in this column will display one row as they are singular in what they need to show. Others will display two rows as it’s nearly the same measure run on both knowledge and resources. Then a few (like Centrality) will display quite a few rows the types of measures written for that type of measures are somewhat varied.
2. First Name : Deals with the category of the measure (Betweenness, Closeness, Centrality...). This is a secondary factoring.
3. Graph Level : Graph Level produces a single number as output.
4. Entity Level : Entity Level produces one number per entity.

Drop-Down Menu

Gives the user the ability to select which currently active meta-network to run the measures on, as well as, which individual networks.
Categories of Reports

This chart shows the ORA report categories with the reports assigned to each category. A report may be assigned to more than one category. The All Measures by Category report is treated as a separate category.

Categories with Reports Assigned

<table>
<thead>
<tr>
<th>Category</th>
<th>Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Networks &amp; Network Text Analysis</td>
<td>Bibliography and Citation</td>
</tr>
<tr>
<td></td>
<td>Communications Network Assessment</td>
</tr>
<tr>
<td></td>
<td>Communicative Power</td>
</tr>
<tr>
<td></td>
<td>Group Talk</td>
</tr>
<tr>
<td></td>
<td>Hot Topics (Content Analysis)</td>
</tr>
<tr>
<td></td>
<td>Part Of Speech</td>
</tr>
<tr>
<td></td>
<td>Semantic Network</td>
</tr>
<tr>
<td></td>
<td>Topic Analysis</td>
</tr>
<tr>
<td>Statistical Procedures and Diagnostics</td>
<td>Context</td>
</tr>
<tr>
<td></td>
<td>Missing Links</td>
</tr>
<tr>
<td></td>
<td>Network Comparison</td>
</tr>
<tr>
<td></td>
<td>Optimizer</td>
</tr>
<tr>
<td></td>
<td>Potential Errors</td>
</tr>
<tr>
<td></td>
<td>QAP/MRQAP Analysis</td>
</tr>
<tr>
<td></td>
<td>Statistical Change Detection</td>
</tr>
<tr>
<td></td>
<td>Statistical Distribution</td>
</tr>
<tr>
<td>Social Media</td>
<td>Blog</td>
</tr>
<tr>
<td></td>
<td>Twitter</td>
</tr>
<tr>
<td></td>
<td>YouTube</td>
</tr>
<tr>
<td>Geospatial</td>
<td>Detect Spatial Patterns</td>
</tr>
<tr>
<td></td>
<td>Geospatial Assessment</td>
</tr>
<tr>
<td></td>
<td>Key Entities Ranking</td>
</tr>
<tr>
<td>Characterize Groups and Networks</td>
<td>Core Network</td>
</tr>
<tr>
<td></td>
<td>Ego Net</td>
</tr>
<tr>
<td></td>
<td>Locate Groups</td>
</tr>
<tr>
<td></td>
<td>Triad Census</td>
</tr>
<tr>
<td>Dynamics</td>
<td>Belief Propagation</td>
</tr>
<tr>
<td></td>
<td>Change in Key Entities</td>
</tr>
<tr>
<td></td>
<td>Immediate Impact</td>
</tr>
<tr>
<td></td>
<td>Influence Net</td>
</tr>
<tr>
<td></td>
<td>QAP/MRQAP Analysis</td>
</tr>
<tr>
<td></td>
<td>Statistical Change Detection</td>
</tr>
</tbody>
</table>

617
<table>
<thead>
<tr>
<th>Custom Reports</th>
<th>Tactical Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate Key Entities</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td></td>
<td>Capabilities</td>
</tr>
<tr>
<td></td>
<td>Communicators</td>
</tr>
<tr>
<td></td>
<td>Critical Sets</td>
</tr>
<tr>
<td></td>
<td>K-Centrality</td>
</tr>
<tr>
<td></td>
<td>Key Entities Ranking</td>
</tr>
<tr>
<td></td>
<td>Management</td>
</tr>
<tr>
<td></td>
<td>Node of Interest Characterization</td>
</tr>
<tr>
<td></td>
<td>Simmelian Ties Analysis</td>
</tr>
<tr>
<td></td>
<td>Tactical Insight</td>
</tr>
<tr>
<td></td>
<td>Trails</td>
</tr>
<tr>
<td>Locate Key Relations</td>
<td>Shortest Path</td>
</tr>
<tr>
<td></td>
<td>Simmelian Ties Analysis</td>
</tr>
<tr>
<td></td>
<td>Socio-cultural Cognitive Mapping</td>
</tr>
<tr>
<td>All Measures by Category…</td>
<td></td>
</tr>
</tbody>
</table>
Reports In Which Category

ORA contains many reports for data analysis. The table below shows all the reports and the categories they are assigned to. A report may be assigned to more than one category. The All Measures by Category report is treated as a separate category.

### Reports and the Categories Assigned

<table>
<thead>
<tr>
<th>Report</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Measures by Category</td>
<td>Dynamics</td>
</tr>
<tr>
<td>Belief Propagation</td>
<td>Dynamics</td>
</tr>
<tr>
<td>Bibliography and Citation</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Blog</td>
<td>Social Media</td>
</tr>
<tr>
<td>Capabilities</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Change in Key Entities</td>
<td>Dynamics</td>
</tr>
<tr>
<td>Communications Network Assessment</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Communicative Power</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Communicators</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Context</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Core Network</td>
<td>Characterize Groups and Networks</td>
</tr>
<tr>
<td>Critical Sets</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Detect Spatial Patterns</td>
<td>Geospatial</td>
</tr>
<tr>
<td>Ego Net</td>
<td>Characterize Groups and Networks</td>
</tr>
<tr>
<td>Geospatial Assessment</td>
<td>Geospatial</td>
</tr>
<tr>
<td>Group Talk</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Hot Topics (Content Analysis)</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Immediate Impact</td>
<td>Dynamics</td>
</tr>
<tr>
<td>Influence Net</td>
<td>Dynamics</td>
</tr>
<tr>
<td>K-Centrality</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Key Entities Ranking</td>
<td>Geospatial; Locate Key Entities</td>
</tr>
<tr>
<td>Locate Groups</td>
<td>Characterize Groups and Networks</td>
</tr>
<tr>
<td>Management</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Missing Links</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Network Comparison</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Node of Interest Characterization</td>
<td>Locate Key Entities</td>
</tr>
<tr>
<td>Optimizer</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
</tbody>
</table>

619
<table>
<thead>
<tr>
<th>Part of Speech</th>
<th>Knowledge Networks &amp; Network Text Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potential Errors</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>QAP/MROAP Analysis</td>
<td>Dynamics; Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Semantic Network</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Shortest Path</td>
<td>Locate Key Relations</td>
</tr>
<tr>
<td>Simmelian Ties Analysis</td>
<td>Locate Key Entities; Locate Key Relations</td>
</tr>
<tr>
<td>Socio-cultural Cognitive Mapping</td>
<td>Locate Key Entities; Locate Key Relations</td>
</tr>
<tr>
<td>Statistical Change Detection</td>
<td>Dynamics; Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Statistical Distribution</td>
<td>Statistical Procedures and Diagnostics</td>
</tr>
<tr>
<td>Tactical Insight</td>
<td>Dynamics; Locate Key Entities</td>
</tr>
<tr>
<td>Topic Analysis</td>
<td>Knowledge Networks &amp; Network Text Analysis</td>
</tr>
<tr>
<td>Trails</td>
<td>Geospatial</td>
</tr>
<tr>
<td>Triad Census</td>
<td>Characterize Groups and Networks</td>
</tr>
<tr>
<td>Twitter</td>
<td>Social Media</td>
</tr>
<tr>
<td>YouTube</td>
<td>Geospatial; Social Media</td>
</tr>
</tbody>
</table>
**Correspondence Analysis**

### General Purpose

Correspondence analysis is a descriptive/exploratory technique designed to analyze simple two-way and multi-way tables containing some measure of correspondence between the rows and columns. The most common kind of table of this type is the two-way frequency cross tabulation table. For a comprehensive description of this method, computational details, and its applications (in the English language), refer to the classic text by Greenacre (1984).

Applies to categorical rather than continuous data. It provides a means of displaying or summarizing a set of data in two-dimensional graphical form. All data should be nonnegative and on the same scale for CA to be applicable, and the method treats rows and columns equivalently.

<table>
<thead>
<tr>
<th>Staff Group</th>
<th>Smoking Category</th>
<th>(1) None</th>
<th>(2) Light</th>
<th>(3) Medium</th>
<th>(4) Heavy</th>
<th>Row Totals</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Senior Managers</td>
<td>None</td>
<td>4</td>
<td>2</td>
<td>3</td>
<td>2</td>
<td>11</td>
</tr>
<tr>
<td>(2) Junior Managers</td>
<td>Light</td>
<td>4</td>
<td>3</td>
<td>7</td>
<td>4</td>
<td>18</td>
</tr>
<tr>
<td>(3) Senior Employees</td>
<td>Medium</td>
<td>25</td>
<td>10</td>
<td>12</td>
<td>4</td>
<td>51</td>
</tr>
<tr>
<td>(4) Junior Employees</td>
<td>Heavy</td>
<td>18</td>
<td>24</td>
<td>33</td>
<td>13</td>
<td>88</td>
</tr>
<tr>
<td>(5) Secretaries</td>
<td></td>
<td>10</td>
<td>6</td>
<td>7</td>
<td>2</td>
<td>25</td>
</tr>
<tr>
<td>Column Totals</td>
<td></td>
<td>61</td>
<td>45</td>
<td>62</td>
<td>25</td>
<td>193</td>
</tr>
</tbody>
</table>

Mass: To continue with the simpler example of the two-way table presented above, computationally, the program will first compute the relative frequencies for the frequency table, so that the sum of all table entries is equal to 1.0 (each element will be divided by the total, i.e., 193). You could say that this table now shows how one unit of mass is distributed across the cells. In the terminology of correspondence analysis, the row and column totals of the matrix of relative frequencies are called the row mass and column mass, respectively.

Inertia: The term inertia in correspondence analysis is used by analogy with the definition in applied mathematics of "moment of inertia," which stands for the integral of mass times the squared distance to the centroid (e.g., Greenacre, 1984, p. 35). Inertia is defined as the total Pearson Chi-square for the two-way divided by the total sum (193 in the present example).

According to the well-known formula for computing the Chi-square statistic for two-way tables, the expected frequencies in a table, where the column and rows are
independent of each other, are equal to the respective column total times the row total, divided by the grand total. Any deviations from the expected values (expected under the hypothesis of complete independence of the row and column variables) will contribute to the overall Chi-square.

<table>
<thead>
<tr>
<th>No. of Dims</th>
<th>Singular Values</th>
<th>Eigen-Values</th>
<th>Perc. of Inertia</th>
<th>Cumulatv Percent</th>
<th>Chi Squares</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>.273421</td>
<td>.074759</td>
<td>87.75587</td>
<td>87.7559</td>
<td>14.42851</td>
</tr>
<tr>
<td>2</td>
<td>.100086</td>
<td>.010017</td>
<td>11.75865</td>
<td>99.5145</td>
<td>1.93332</td>
</tr>
<tr>
<td>3</td>
<td>.020337</td>
<td>.000414</td>
<td>.48547</td>
<td>100.0000</td>
<td>.07982</td>
</tr>
</tbody>
</table>

References

Correspondence Analysis Example

From the Editor Menu select Analysis > Correspondence Analysis.

The Correspondence Analysis box will appear with a list of all currently loaded meta-networks. Place a check mark next to the meta-network(s) to analyze. For Select an input network: select the network to analyze. When you are finished click [ Compute ]. This brings up the Scatter Plot.
The buttons at the bottom are navigation buttons:

[ |<< ] Go To First Graph
[ << ] Go To Next Graph
[ >> ] Go To Previous Graph
[ >>| ] Go To Last Graph

The number in the middle of the buttons tells you which graph is currently displayed.
Socio-cultural Cognitive Mapping (SCM)

Description

Socio-cultural Cognitive Mapping (SCM) is a best-fit network model to the set of underlying node to variable data. SCM permits objective visualization of the network, inference about the impact of changes in the underlying conditions influencing the nodes and comparison of disparate data.

SCM is a method designed to help analysts make sense of communities and to understand and predict changes in these communities. From a socio-cultural perspective addressing these questions means attaining a structural understanding of actors, issues, and the relations connecting them. Or in other words, it means answering these questions: 1) Who are the critical actors, particularly the political, tribal, religious, economic, educational and religious elite and associated groups. 2) On what specific micro-issues are the interests of these elites and their groups aligned, and on what issues do they complete? 3) What is the basis for those relations, alliances and conflicts e.g., are they based in economics, status, education, religion, or location. Further it is important to not only understand the lay of the land, but to use that information to assess the community of actors of interest vis-à-vis some issue, e.g. resilience, cyber-attacks, or deterrence given those relations and the basis for them. And 4) How will the community change its position on a broad area of concern, an issue, given changes in the alliances and competitions on the more micro issues, perhaps due to the underlying basis for a relation being altered, or an actor being removed? That is, how stable is the community, how resilient is the community, given change at the actor level or basis for alliance/competition level?

Mathematically, the SCM process is a reduction of the more complex detail available in the hyper-cube where the dimensions are actors by actors by topics by topics; the topic-topic links are the co-presence or covariance of the topics; and the actor-actor links are inferred from the other dimensions give the degree to which two actors share the same topics and the extent of the connectivity between those topics.

The core of the SCM process relies on the Minkowski metric (or semi-metric). Two models are supported in ORA to apply the metric:

Levine Statistical Segregation (LSS):

- Users set power and attenuation for geometries.
- Controls node prominence in similarity matrix via row and column multipliers.
- Calculates a fitted frequency and compares against original frequency.
Morgan Visual Segregation (MVS):

- Users set power for geometries.
- Identifies maximal similarity and generates an inverse similarity matrix.
- Calculates distance based on geometries and compares against inverse similarity.

For detailed appreciation of SCM and description of the LSS model, Levine and Carley (2016) provides further detail (see References, below).

**Input**

The SCM process accepts as input for analysis a single one or two-mode network or a nodeset with attributes. These inputs are treated as an actor x topics matrix for SCM purposes.

For valid results, column (for networks) or attribute data should not be mutually exclusive.
Result

The SCM analysis will generate a set of optimized models, one for each combination of inputs (Minkowski power and attenuation values) and present a summary list of models to the user as shown above. Based on the presented summary statistics (chi-square, dispersion, and z-score) the user may select individual models (highlighted line in the image above) to save for further use along with the input parameters and the summary table itself.

Procedure

Select a meta-network: From the pulldown list, select the meta-network containing the input data for SCM analysis from the list of all meta-networks currently loaded into the ORA Meta-Network Manager.

Choose what data to extract: From the pulldown list, identify the type of input contained in the selected meta-network.

Frequency network - A network whose links are frequency values. Link (i,j) is the frequency of nodes i and j. The network can be unimodal or bimodal, and binary or weighted.

Attribute value network - A network whose columns nodes are interpreted as attributes for the row nodes, and whose links are therefore attribute values. Link(i,j) is the value that node i has for attribute j. The resulting frequency network is unimodal and weighted.

Attribute value nodeset - Attribute values from a nodeset are used to construct a network where link(i,j) is the frequency of nodes i and j. The resulting frequency network is unimodal and weighted.

Attribute frequency from nodeset - A set of row attributes and set of column attributes are chosen from the nodeset to construct a frequency network where link(i,j) is the frequency between row attribute i and column attribute j. The resulting frequency network is bimodal and weighted.
The remaining inputs in the dialog depend on data selection made above. The following sections describe the inputs for each data type:

**Frequency Network**

A frequency network is a network whose links are frequency values. Link (i,j) is the frequency of nodes i and j. The network can be unimodal or bimodal, and binary or weighted.

Select a network: Use the pulldown menu to select an input network.

**Attribute Value Network**
The following options apply when an attribute value network has been selected as input. An attribute value network is a network whose columns nodes are interpreted as attributes for the row nodes, and whose links are therefore attribute values. \( \text{Link}(i,j) \) is the value that node \( i \) has for attribute \( j \). The resulting frequency network is unimodal and weighted.

Select a network: Use the pulldown menu to select an input network. The pane below will display the columns of the available in the network.
**Column List**

Column Attribute Node - Lists all columns in the selected network.

Include? - Check to include the column in the analysis.

[ Select All ] - Click to check all columns listed in the column list.

[ Un-select All ] - Click to uncheck all columns listed in the column list.

Shared non-zero value - Check to have frequency include the number of times nodes both **have** an attribute.

Shared zero value - Check to have frequency include the number of times nodes both **do not have** an attribute.

Check for mutually exclusive and redundant attributes - Check to perform a check for exclusive and redundant attributes. The check will be performed when the [ Next > ] button is clicked; if the check detects exclusive or redundant attributes a popup will report the error and ORA will remain on the current dialog for correction.

---

**Attribute Value Nodeset**
The following options apply when an attribute value nodeset has been selected as input. Attribute values from an attribute value nodeset are used to construct a network where link(i,j) is the frequency of nodes i and j. The resulting frequency network is unimodal and weighted.

Select a nodeset: From the pulldown menu, select the input nodeset. The attributes of the selected nodeset are displayed in the pane below.

Select how to treat continuous-value attributes: For attributes containing continuous values (e.g. the attribute type is Number) define how the attribute should be processed for analysis.
Bin continuous attribute values into # bins - Check this option to convert continuous attributes into category counts (bins). Then use the number spinner to set the number of bins. Bin size is set by the maximum and minimum attribute value divided by the number of bins. The attribute value for each node is used to increment count in the appropriate bin by one.

Use attribute values directly - Check this option to use attribute values without binning. Unweighted Gowers will be used to compute the attribute matrix. More…

Attribute List

Select attributes: Check to check all attributes listed below, uncheck to uncheck all attributes listed below.

Attribute… - Check individual attributes to select them for input.

Check for mutually exclusive and redundant attributes - Check to perform a check for exclusive and redundant attributes. The check will be performed when the [ Next > ] button is clicked; if the check detects exclusive or redundant attributes a popup will report the error and ORA will remain on the current dialog for correction.

-----------------------------

Attribute Frequency from Nodeset
The following options apply when attribute frequency from nodeset is selected for input. The attribute frequency from nodeset uses a set of row attributes and set of column attributes are chosen from the nodeset to construct a frequency network where link(i,j) is the frequency between row attribute i and column attribute j. The resulting frequency network is bimodal and weighted.

Select a nodeset: From the pulldown menu, select the input nodeset. The attributes of the selected nodeset are displayed in the pane below.

Select how to treat continuous-value attributes: For attributes containing continuous values (e.g. the attribute type is **Number**) define how the attribute should be processed for analysis.
Bin continuous attribute values into # bins - Check this option to convert continuous attributes into category counts (bins). Then use the number spinner to set the number of bins. Bin size is set by the maximum and minimum attribute value divided by the number of bins. The attribute value for each node is used to increment count in the appropriate bin by one.

Use attribute values directly - Check this option to use attribute values without binning. Unweighted Gowers will be used to compute the attribute matrix. More...

**Attribute List**

Attribute - List attributes by name.

Is Row? - Check to use the attribute as a row in the input matrix. Uncheck to remove the attribute.

Is Col? - Check to use the attribute as a column in the input matrix. Uncheck to remove the attribute.

NOTE : The Is Row? and Is Col? choices are mutually exclusive. Checking one will automatically uncheck the other.

After entering all input options, click the [ Next > ] button to advance to the Model and Optimization dialog. (Alternatively use the [ Cancel ] button to cancel the analysis.)
Model and Optimizations

Select the models to run and how to optimize them

Model Parameters:

Type: Select the model type. Morgan Visual Segregation tends to be more robust to data, but creates much less tightly defined grouping than the Levine Statistical Segregation method. The models are further characterized in Description above.

Levine Statistical Segregation
Morgan Visual Segregation
NOTE : The model type selected will affect the availability of some of the model parameters below.

Dimensions: Specify the number of dimensions (Ndim) of the desired solution from the pulldown menu (from 1-3, 2 is the usual value).

1-Dimensional
2-Dimensional
3-Dimensional

Minkowski power values: Shows the current power settings. Change settings by entering any number of values ranging from 0.0 to positive infinity separated by spaces. (Default is .7 1 2 3)

Attenuation values: Shows the current attenuation settings. Change settings by entering any number of values ranging from 0.0 to positive infinity separated by spaces. (Default is .7 1 2 3)

Frequency data options:

Ignore zero frequencies - Click this to ignore frequency cells of value zero. The model will not attempt to match zero values. This will likely lead to a lower chi-square error.

Invert frequency values - Click to invert frequency values before optimizing. Zero frequency values when inverted are set to the maximum frequency value.

Optimization Parameters:

Number of repetitions: Set the number of optimization passes for fitting the SCM (default is 5).

Allow negative multipliers

NOTE : The following two parameters are mutually exclusive. Using the same seed value, input data and parameters generates repeatable results.

Seed the random number generator with Zero - Select to use an initial (seed) value of zero (0) for the random number generator. (This is the default seed value.)
Seed the random number generator with: Select to provide an initial (seed) value then enter a number in the entry area to the right.

After entering all model parameters, click the [ Next > ] button to advance to the Results dialog. (Alternatively use the [ < Back ] button to revise the input data or use the [ Cancel ] button to cancel the analysis.)

Click the [ Run ] button to perform the analysis. (Alternatively use the [ < Back ] button to revise the model parameters or the [ Close ] button to close the analysis dialog.)
As analysis begins, a Progress… dialog will be displayed, showing the current parameter values being employed. As the analysis runs, lines in the Results pane are filled in one at a time (for more complex analysis, this process is visible to the user). The analysis run can be halted by clicking the [Stop] button. When the analysis completes, a Completed popup will appear.

Click the [OK] button to dismiss the Completed dialog.
The table in the Results dialog summarizes the resultant models. Each line in the table summarizes the optimized model for a given combination of Minkowski power and attenuation parameter values.

NOTE: The best model from a run is considered to be model with the minimum Chi-Square statistic between the estimated and actual frequency values.

Inputs and results can be saved using the buttons below the table. (Models are selected by clicking the appropriate line in the output table):

[ Add Input to ORA ] - Click to save the nodesets and network used as input for the current analysis run as a separate meta-network named **SCM-Input**. Only components employed in the analysis are saved.

[ Add Output to ORA ] - Click to save the currently selected model as a meta-network in the Meta-Network Manager (the meta-network is named **SCM-Output**).
$M = #A = #$, where # are the Minkowki and Attenuation parameter values, respectively).

[ Save Table Values ] - Click to save the results summary as a tab-separated values (TSV) file.

Click the [ Close ] button to close the analysis dialog. (Alternatively use the [ < Back ] button to revise the model parameters or the [ Run ] button to perform another analysis run.)

References
Moran-I and Geary-C

Moran's-I: The measure of spatial autocorrelation to study stochastic phenomena which are distributed in space in two or more dimensions. The values of Moran's I range from +1 meaning strong positive spatial autocorrelation, to 0 meaning a random pattern to -1 indicating strong negative spatial autocorrelation.

This particular statistic is designed for the measurement of global spatial autocorrelation of ordinal, interval or ratio data.

Geary's-C: Based upon a paired comparison of juxtaposed map values and ranges between 0 and 2. Positive spatial autocorrelation is found with values ranging from 0 to 1 and negative spatial autocorrelation is found between 1 and 2. However, values can be found greater than 2 on occasion (Griffith, 1987). As similar values are in juxtaposition the numerator which measures the absolute difference squared between juxtaposed values will tend toward zero. Whereas, as non-similar values become juxtaposed the statistic will tend toward larger values in the numerator and thus toward its maximum value of two.

This particular statistic is designed for the measurement of local spatial autocorrelation of ordinal, interval or ratio data.

Example

<table>
<thead>
<tr>
<th>Moran's I</th>
<th>Geary's C</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>.04</td>
</tr>
<tr>
<td>B</td>
<td>0.2</td>
</tr>
<tr>
<td>C</td>
<td>-0.8</td>
</tr>
<tr>
<td>D</td>
<td>1.8</td>
</tr>
</tbody>
</table>

A has positive global spatial autocorrelation and local spatial autocorrelation.

B is random with respect to space.

C has negative global and local spatial autocorrelation.

References


Near-Term Analysis: The Near Term Analysis (NTA) is a tool that allows for the removal of nodes from a given organizational structure to evaluate how the organization will likely perform as a result.

OrgAhead: OrgAhead is an organizational learning model designed to test different forms of organizations under a common task representation. Each member of the organization receives information from a subordinate or from the environment, makes a decision based on the information and what he or she has learned so far, and provides superiors with an answer to the decision. These decisions are either yes/no or yes/maybe/no; again, we're dealing with an intellective model.

Micro Simulations: Micro Simulation allows you to run some basic simulations on the currently loaded visualization. Link weights are important as once they are normalized, they correspond to the probability of a transmission.
The Near Term Analysis (NTA) is a tool that allows for the removal of nodes from a given organizational structure to evaluate how the organization will likely perform as a result. The Near Term Analysis tool uses a multi-agent model as input, DyNetML.

The goal is to provide an answer to the question on how an organization will behave and change after considering a sequence of strategic interventions or personnel loss by way of agent removal. In other words, we want to know what happens when we remove nodes from an organization, be they people, places, resources, knowledge sets or other common nodesets.

This example will use the Stargate dataset (SG-1). This dataset is included with the version of ORA downloaded and can be found on-line at the following url: http://www.casos.cs.cmu.edu/projects/ora/sample.php.

From the menu bar select File > Open Meta-Network then select SG1.xml.

In this example, we will remove two agents: daniel_jackson and maj_samantha_carter

1. Open the SG1 Meta-Network into ORA.
2. Highlight the SG1 Meta-Network before starting NTA in the ORA Meta-Network Manager panel.
3. From the main menu select Simulations > Near-Term Analysis.

NOTE: If your dataset contains an Organization Node Class ORA will display the NTA main window. If not, it will ask for you to chose a substitute Organization nodeset.
When a meta-network is first loaded into ORA's the Near Term Analysis, a pop-up may appear asking for a location node. Select Cancel and proceed with the Near Term Analysis.

The NTA main window consisted of four sub panels: Input Data, Settings, Simulation time line and Cases to simulate. Below is a brief description of each panel:
1. Input Data
In this section is the file name of the meta-network loaded.

2. Settings (Global Parameters)
In the Setting area are two text boxes. The first, The Number of replications informs ORA how many times to run the simulation. The second, The number of simulated time-points defines the range in the section Simulation time line.

In the settings area, there are two critical factors: 1) the number of replications and 2) the number of simulated time points.

Why is this important?

The number of replications if set at a higher versus lower value, will result in more experiments being conducted on the scenario the tool is presented. Therefore, the more replications the more likely the results will mirror those in a real world example.
The number of time points determines the length of the Near Term Analysis iterations. If this number is also set to a relatively high value, the simulation will take longer.

NOTE: Be mindful of any memory considerations when running high value replications or time points.

3. Simulation timeline

This area of the Near Term Analysis tool shows a visual representation of the time points selected in Settings area above.

4. Cases to simulate

After the settings (global parameters) are set, the virtual experiment cells need set.

Initially, there is a pre-defined simulation cell, the Baseline. The Baseline is the cell without any entities removed as is the control situation when the organization does not experience any interventions. Besides Baseline, any other cells need set up. Start by selecting Add new simulation instances, the leftmost of the four buttons.

Add new simulation cases

To run a Near Term Analysis, we will begin by selecting the Add new simulations cases button from the main Near Term Analysis Tool (see area highlighted in red ellipse below).
After selecting Add new simulation instances button, a dialog box titled Near Term Analysis– Simulation scenario create wizard will appear. This wizard supports the creation of virtual experiment cells in three different ways. The first allows for the most freedom of choice. The second and the third options will ask for a set of criteria for selecting important agents in the network and make experiment cells according to the selection. Therefore, the first option gives full flexibility to users, and the second and the third option provides a systematic analysis setup method. To proceed this demonstration, select the first option and select [Next].
There are four options:
The next section explores all four of the Near Term Analysis Options:

**Run the Step-by-Step Wizard** – This process will help walk through setting up a near
term analysis experiment on the meta-network loaded into the Near Term Analysis
tool.

**Create one simulation case** – In this simulation experiment, events and user-specified
time can be applied to agents.

**Create a set of cases by isolating agents** – This scenario isolates one agent and
perform an experiment. Then the experiment can be performed again with the agent
removed.

**Create a set of cases by isolating a set of agents relating to a specific measure.** –
Based on measures contained in the ORA intel report, a set of agents can be isolated
and a simulation case can be created.
**Near Term Analysis Menu**

**File Menu**

Save the current simulation setting: Brings up a save box where you can navigate to a directory and save all the current simulation settings.

Load a simulation setting from a file: Navigate to a directory to load a previously saved simulation setting.

NOTE: This will remove any settings that are currently active.

Close: Closes the Near Term Analysis window.

**Simulation Menu**

Execute simulation cases: Begins running the simulation. Same function as the [ Execute ] button at the bottom of the window.
Show the add simulation wizard: Brings up the creation window. Same as the [Add new simulation cases] button.

Add ORA-Intel report based simulation cases: Same as [Add ORA-Intel report based simulation cases] button.

Edit the highlighted case: Brings up the dialog box to edit parameters for selected event.

Remove the selected cases: Removes selected event from simulations.

Remove all of the cases: Same as the [Remove all the simulations] button.

---

**Output Options**

<table>
<thead>
<tr>
<th>Output Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate evolved Interaction Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Agent Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Knowledge Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Task Matrix</td>
</tr>
</tbody>
</table>

These menu items will display in the Near Term Results menu:

Generate evolved Interaction Matrix:

Generate evolved Agent-to-Agent Matrix: Displays how agents interact with one another.

Generate evolved Agent-to-Knowledge Matrix: Displays how knowledge is diffused within the agent network.

Generate evolved Agent-to-Task Matrix: Display how tasks are used within a network.
Near Term Impact Option 1

**Step-by-Step wizard**

Selecting the first option brings up the step-by-step creation dialog box.

![Step by step creation dialog box]

Under Options select whether to isolate an agent, knowledge, or resource. We’ll leave it at agent. Then select the [Next] button.

![Step by step creation dialog box with daniel_jackson selected]

Under Options select the agent to isolate. Here we select daniel_jackson. Then select the [Next] button.
Under Options select the time-step to isolate the agent. For this simulation we select 5. The select the [ Next ] button.

At this point you are asked if you want to add more events to the simulation or not.

You can add as many events as you wish. But for this example we'll only use only one event. Select [ No ] to continue.

Now repeat the steps above and add a second simulation. But this time let's remove daniel_jackson at time-step 25.
Now proceed to Analysis Results.

<table>
<thead>
<tr>
<th>Isolation</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A03_25</td>
<td>Isolation daniel_jackson at time 25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A03_5</td>
<td>Isolation daniel_jackson at time 5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Near Term Impact Option 2

Apply events to specified agents

The second option for creating simulation files is to create one simulation case and apply events to specified agents, knowledge, or resource nodes.

Select the [ Add new simulation cases ] button to bring up the wizard.

1. Type in a search criteria to highlight only the agents to work with (i.e. typing in dan brought up only daniel_jackson.
2. Place a checkmark on the line. Notice that when you placed a checkmark in the box the Event automatically changed to Isolation.
3. Double-click in the Timing cell to select it and type in a number from 0 to the highest number you selected for your simulation. In this case we'll repeat with the timing of "5".
4. Select the [ Add events ] button. This places the event in the Simulation event edit list section.
5. If there were more events to add you could continue with the same procedure. When you are done, select the [Add a simulation] button at the bottom.

The two buttons beneath the Simulation event edit list section to remove events from the list. The [Remove all the events] button removes everything in the Simulation event edit list but the [Remove the selected events from the event list] only removes the events with a checkmark beside them.

The [Reset selection] button removes all check marks placed in the bottom table and sets the Event to No Event.

The [Previous] button returns to the main Wizard screen.

When you have finished you will have created the same two simulations as in Option 1.

<table>
<thead>
<tr>
<th>Cases to simulate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total 6 runs = 3 simulation cases X 2 replications for each case</strong></td>
</tr>
<tr>
<td>Isolation ...</td>
</tr>
<tr>
<td>baseline</td>
</tr>
<tr>
<td>A03_25</td>
</tr>
<tr>
<td>A03_5</td>
</tr>
</tbody>
</table>

Now proceed to Analysis Results.
Near Term Impact Option 3

Create a Set of Cases Using Measures

Option 3 allows for selecting agents/knowledge/resources based on their ranking when certain measures are run on them.

Here are three examples run with the same Isolation Time and Cut-offs. Only the measures were changed.

**Centrality, Total Degree**

<table>
<thead>
<tr>
<th>Isolation Case</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>daniel_jackson_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>jacob_carter_selmae_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>ren'al_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
</tbody>
</table>
### Cognitive Demand

<table>
<thead>
<tr>
<th>Isolation Case</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ren'al_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>jacob_carter_selmak_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>daniel_jackson_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Clique Count

<table>
<thead>
<tr>
<th>Isolation Case</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>col_jack_o'neil_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ren'al_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>daniel_jackson_20</td>
<td>Isolation null at time 20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you have run the measures proceed to [Analysis Results](#).

659
Near Term Impact Option 4

A Set of Agents by a Set of Cases by Measure(s)

Option 4 allows the addition of Time gaps between the isolations and whether to isolate them in descending, ascending, or random order.

Now proceed to Analysis Results.
Near Term Impact Results Menu

Save the Construct launch scripts: Information on Construct can be obtained at the following URL: http://www.casos.cs.cmu.edu/project/construct/index.html.

Show text report on the ORA main window: Displays the report in Panel 3 of the ORA Main Interface.

Save the completely evolved Meta-Networks: Will save as an ORA Meta-Network any of the simulation cases with a checkmark in the Select column.

Save the html report: Navigate to a directory to save an html file that can be displayed in a browser.

Save the text report: Navigate to a directory to save an text file.

Save the Knowledge Diffusion line chart: Saves the chart as a .png file that can be used in other documents.

Save the Task Accuracy line chart: Saves the chart as a .png file that can be used in other documents.

Save the Energy Task line chart: Saves the chart as a .png file that can be used in other documents.

Save the Knowledge Diffusion result CSV file: Saves the results as a .csv file that can be used in other programs.

Save the Task Accuracy result CSV file: Saves the results as a .csv file that can be used in other programs.

Save the Energy Task result CSV file: Saves the results as a .csv file that can be used in other programs.

Close:

Copy the chart in the clipboard: Copies the window to the clipboard that can be pasted into other programs.
Standard Deviation ranges: Standard Deviations* displays the range of values for a particular instance.

Grid lines in the chart: Displays the grid lines for values.

Legends in the chart: Displays the legend underneath the chart.

Event annotations in the chart: Displays the event annotations within the chart.
Deviation from the baseline: Using the baseline numbers the chart shows the offset for the simulation.

Show actual values: Uses the actual calculated values in the chart.

Background color: Choose the background color of the chart of either white or gray.
Near Term Impact Results

Now we're ready to execute the simulations. But before that you must select the type of Output Options you want. From the Near Term Analysis menu select Output Options > {any or all of the four options}.

Now click the [ Execute ] button in the bottom-right corner. This will bring up two dialog boxes asking you to confirm the selected output options and then an alert telling you that processing may take a while with a large meta-network and a lot of simulation runs.

After clicking the [ Yes ] button, an alert box will display advising you that the near term calculation may take a long time depending on settings of your experiment.

After the [ OK ] is clicked, the Processing Near Term analysis dialog will appear to show you the progress.
After processing is completed, the Near term analysis results window is displayed.

The results of the experiment will compare against the baseline data established prior to the removal of any isolated agents. In the example above, we can see how the network was impacted in the time line when we isolated daniel_jackson and removed this node from the data set.

References

Knowledge Diffusion and Energy Task


Binary Task Accuracy
Micro Simulations

The Micro Simulation exists in both the Editor and in the Visualizer. The difference is the Visualizer version is mainly used to visualize as it happens. The Editor version is used to create simulation data.

Procedure

The first thing it requests is a nodeset. After that it will give you a choice the square networks comprised of that nodeset. This creates a new meta-network consisting of a single nodeset with the same nodes as the input nodeset, and a single network with the same links present in the selected networks. If multiple networks are selected and multiple links from node A -> node B are present, the resulting link from A -> B has a weight equal to the sum of all A -> B links.

Once a new meta-network is defined it takes all the links and normalizes them between zero and one. The link weight then corresponds to the probability that a transmission will occur down that link. This means that both Link Direction and Link Weight play an important role.

The Simulations

The Simulations are Disease, Money, Information, and Technology and are types of flows. At any given time point, any node that has one of those things is going to try to give it to someone else. And each flow has its own rules.
Types of Simulation Flows

Disease: An entity can not re-get the disease, and an entity can only give out the disease while it has the disease. The entity can also give out a disease to multiple other entities. After a user-specified number of time periods, the entity loses the disease.

Money: Once an entity gives away the money, he cannot give the money to anyone else. There is no limit on re-getting the money.

Information: Once an entity gets information, they cannot lose it. They also never stop giving out the information.

It's important to understand how these transmissions occur. During the transmission phase ORA looks at every node that has a resource. It then iterates through all outgoing links, trying to give that resource through that link (in the case of money, since it can only go through one link, we randomize the order links are tested). When looking at a link, if checks to see if the transmission can occur based on the link weight. Another check is made to see if the transmission can overcome the transmission resistance.

These checks are continued based on the rules outlined above for the user specified number of time periods. Then a dynamic meta-network is generated that shows for any given time period what node was associated with a resource.

Adoption of Technology: is a unique simulation. A node is more likely to adopt a piece of tech if it has many neighbors trying to convince it to adopt the tech. A node is more likely to un-adopt a piece of tech if the node has fewer neighbors also using the tech.
OrgAhead

NOTE: This function only available in a full version of ORA.

Description

An organization should be capable of estimating its short-range performance. ORGAHEAD is an organizational learning model designed to test different forms of organizations under a common task representation. Each member of the organization receives information from a subordinate or from the environment then makes a decision based on the information and what he or she has learned so far. They then provide their superiors with an answer to the decision. These decisions are either yes/no or yes/maybe/no. ORGAHEAD falls in the class of intellective models; it is not designed to simulate exact behavior, but capture dynamics, important from a theoretical standpoint.

Structure

ORGAHEAD tests a single quasi-hierarchical organization containing up to three levels which run from top to bottom" CEO, Manager, and Analyst. The organization does not have to take a pure hierarchical form as the information or reporting has to travel upward from the task to CEO. For instance, an Analyst can report directly to the CEO, but can never report to another analyst. Similarly, a CEO can have a direct link to a task bypassing any managers or analysts.
OrgAhead Initial Format

NOTE: This function only available in a full version of ORA.

Input Format for Initial Org Arguments

Each of these arguments takes a quote-enclosed string. The string given should consist of words separated by spaces, each word indicates the resources to give to a person. For example a 0b cd means create 3 people, the 3rd gets two resources, and the others each get one.

Each word should consist of characters indicating the resources given to this new person. For example, the string abc means the new person gets the first 3 resources of the immediate lower level (i.e. CEO gets managers who get analysts who get tasks). Each character may have a modifying digit preceding it. The modifying digit can be '0' for task, '1' for analyst, or '2' for manager. Case is not important. This indicates that the level of the resource the person sees is not necessarily the default level for the person. For example 0b indicates the person gets task B, even if the person is a manager or CEO. a1bc means the person gets resources A and C of the default level, and analyst B. (Of course, if the person is a manager, saying abc would have been the same as a1bc.) A - indicates a person with no resources (who has to randomly guess at the answer), and a . indicates no person (a silly thing to input, but nonetheless, it can be done). Passing an empty string indicates that there shall be no members on the level associated with the argument; however, if all three arguments get empty strings (-analysts, -managers, -ceos), then a random org is created for each simulation.

In addition, the -president switch indicates if the org should have a President, who oversees all CEOs and any unsupervised managers or analysts.

Output format for Organizations (seen if -print_organization is specified)

This format specifies the org's structural hierarchy, who supervises whom. If -print_organization is specified, it is printed once before simulation starts, once at the end, and every time a change to the org is made. Here is what a sample org might look like:

Organizational structure is: President: abc

a1a0a b1b0b 1c0c
abcfgi dfeh
a b c d e f g h i
The bottom line indicates that the first analyst sees task A, the second analyst sees task B, and so on. The next line up shows 2 managers; the first one supervises the first, second, third, seventh, and ninth analysts, and the second manager oversees the other ones. The top line depicts three CEOs. The first one oversees the first manager (A), as well as the first analyst (1A) and ask (0A). The second one sees the second manager, analyst and task. The third one oversees the third analyst and task. Finally, the first line indicates that this org has a President, who supervises the three CEOs.

Orgstat reads orgs from a file or stdin in this same format. It only reads orgs whose preceding line reads Final Organizational structure is. This way you could pipe output of orgsim to orgstat, and orgstat will ignore initial and intermediate orgs, using only final orgs, one for each simulation performed.

Output format for People (seen if -print_person is specified)

This format specifies the experience of every person in the org. If-print_person is specified, this data is printed for every person after each efficiency check. Here is what a single person’s experience might look like:

--------------
Manager #1 has resources: A1 T2 Eff: 43.00% (Recent: 43%) from 400 tasks. For pattern: 1 1

42 = 41 1 0 | 31 0 0 8 0 0 1 0 0 0 = 49
13 = 12 1 0 | 12 1 0 1 0 0 6 0 0 = 20
3 = 3 0 0 | 3 0 0 1 0 0 0 0 0 = 4

For pattern: 1 2

From the top line, we see that the first manager oversees the first analyst and the second task. He has an overall efficiency of 43.00, and a 43% relative efficiency from the last efficiency check. And he’s seen 400 tasks. Then we will see a listing of each pattern he may see; only his output for pattern (1 1) is shown above. The data is collected into 4 3x3 matrices, and they indicate his absolute, initial, relative, and old relative experience, from right to left. The rows indicate what the correct answer was (top=1, middle=2, bottom=3), and the columns indicate what he guessed (left=1, middle=2, right=3). So, in the full 400 tasks, where the pattern (1 1) emerged, the answer was 1 42 times, and 41 of those times he guessed 1. However, when he started off (initial experience) there were 31 1’s and he guessed correctly every time. Since the last efficiency check, there were 8 1’s, and he guessed them all, and in the previous efficiency check, there were 10 1’s and he guessed them all correctly again. The numbers on the left and right sides are sums, the right ones are useful in judging how he will react the next time he sees (1 1) Since the answer was 1 42 times (from
the left side), we figure he'd be best to guess 1. That's what he'll do, because the right number (49) is greatest on the right side.
OrgAhead Output

NOTE: This function only available in a full version of ORA.

Output format for Organizations (seen if -print_organization is specified)

This format specifies the org's structural hierarchy, who supervises whom. If -print_organization is specified, it is printed once before simulation starts, once at the end, and every time a change to the org is made. Here is what a sample org might look like:

Organizational structure is: President: abc

a1a0a b1b0b 1c0c
abcgi defh
a b c d e f g h i

The bottom line indicates that the first analyst sees task A, the second analyst sees task B, and so on. The next line up shows 2 managers; the first one supervises the first, second, third, seventh, and ninth analysts, and the second manager oversees the other ones. The top line depicts three CEOs. The first one oversees the first manager (A), as well as the first analyst (1A) and ask (0A). The second one sees the second manager, analyst and task. The third one oversees the third analyst and task. Finally, the first line indicates that this org has a President, who supervises the three CEOs.

Orgstat reads orgs from a file or stdin in this same format. It only reads orgs whose preceding line reads Final Organizational structure is. This way you could pipe output of orgsim to orgstat, and orgstat will ignore initial and intermediate orgs, using only final orgs, one for each simulation performed.

Output format for People (seen if -print_person is specified)

This format specifies the experience of every person in the org. If-print_person is specified, this data is printed for every person after each efficiency check. Here is what a single person's experience might look like:

--------------
Manager #1 has resources: A1 T2 Eff: 43.00% (Recent: 43%) from 400 tasks. For pattern: 1 1

673
42 = 41 1 0 | 31 0 8 0 0 1 0 0 0 = 49
13 = 12 1 0 | 12 1 0 1 0 0 6 0 0 = 20
3 = 3 0 0 | 3 0 0 1 0 0 0 0 0 = 4

For pattern: 1 2

From the top line, we see that the first manager oversees the first analyst and the second task. He has an overall efficiency of 43.00, and a 43% relative efficiency from the last efficiency check. And he's seen 400 tasks. Then we will see a listing of each pattern he may see; only his output for pattern (1 1) is shown above. The data is collected into 4 3x3 matrices, and they indicate his absolute, initial, relative, and old relative experience, from right to left. The rows indicate what the correct answer was (top=1, middle=2, bottom=3), and the columns indicate what he guessed (left=1, middle=2, right=3). So, in the full 400 tasks, where the pattern (1 1) emerged, the answer was 1 42 times, and 41 of those times he guessed 1. However, when he started off (initial experience) there were 31 1's and he guessed correctly every time. Since the last efficiency check, there were 8 1's, and he guessed them all, and in the previous efficiency check, there were 10 1's and he guessed them all correctly again. The numbers on the left and right sides are sums, the right ones are useful in judging how he will react the next time he sees (1 1). Since the answer was 1 42 times (from the left side), we figure he'd be best to guess 1. That's what he'll do, because the right number (49) is greatest on the right side.

**Output format for Tasks (seen if -print_task is specified)**

This format specifies what happens for each task, what everyone decides, what the org decides, and what the correct answer was. If -print_task is specified, this is printed for each task. Here is what a single task might look like:

```plaintext
3
2 2 1
1 2 2 2 2 1 2 2
2 2 2 2 2 2 2 A: 3 D: 3
```

The bottom line shows that all the task bits were 2. The next line up indicates that the first (leftmost) and 6th analysts guessed 1; the others guessed 2. The next line shows that the first two managers guessed 2 while the third guessed 1. The top line shows that the CEO guessed 3. At the end of the bottom line, one can see that the answer was 3, and so was the decision.
**Output format for Efficiency (seen if -print_efficiency is specified)**

This format specifies what happens for each efficiency check, how everyone is doing, and how well the org is doing. If -print_efficiency is specified, this data is printed out during each efficiency check, before any orgal changes take place. A sample efficiency check might look like:

Organizational Efficiency: 53.00% Overall: 54.03%
54.00 54.00 37.00 54.00 54.00 54.00 54.00 45.00
54.00 45.00 54.00 50.00
37.00 53.00 48.00 45.00 47.00 51.00 56.00 47.00

The org's overall efficiency is 54.03%, while its relative efficiency (since the last efficiency check) is actually 53%. From the bottom line, we see the analysts all had efficiencies ranging from 37-56%. The managers, one line above, ranged from 45-54%, and the CEOs ranged from 37-54%.

**Output Format for Orgstat**

This section describes the output orgstat generates. A sample output might look like this:

Data Organizational structure is:

ab c - - - - - - -
abc def ghi - - - - -
a b c d e f g h i
Connectivity = 0.5257 Hierarchy = 1.0000 ...

Data Organizational structure is:

AVG: 1.0000 SD: 0.0000 MIN: 1.0000 MAX: 1.0000 Connectivity
AVG: 1.0000 SD: 0.0000 MIN: 1.0000 MAX: 1.0000 Hierarchy

Central Graph Organizational structure is:

ab - - - - - - -
abc def ghi - - - - -
a b c d e f g h i
Connectivity = 0.1648 Hierarchy = 1.0000 ...

Hamming distribution (for nonparametric confidences):
1th: 1
2th: 1
...
10th: 7
Confidence at 90% = 4
Confidence at 95% = 7
Confidence at 98% = 7

First, orgstat prints out each org it just read in (after the org has been 'reduced' by orgstat's congruence algorithm.) After each org, it prints out some statistics about the directed-graph represented by the org's hierarchical structure. It prints out the means and standard deviations of the statistics. It then prints out the central graph of the 'data' orgs, along with statistics about the central graph. Then it optionally does the bootstrap analysis; in this case we used nonparametric random graphs. It creates a list of Hamming metrics, sorts the list, and prints it out. There were 10 samples used here, and the largest one was 7. Then it prints the 90% confidence metric, as well as the 95% and 98%.

Orgstat can also take as input a set of adjacency matrices, in which case the output will also be represented as adjacency matrices. There is also a -matrix switch to orgstat which forces it to output matrices even if orgs were read in.
Experience: How each Member Learns

Each person has a set of resources, which may be tasks, or the decisions of his inferiors (or both). From these resources, he sees a 'pattern', a single vector of numbers ranging from 1-3, and he must guess if the true answer is 1, 2, or 3 based on this pattern. He does this by storing experience matrices for every possible pattern. So when he next sees that pattern, he knows what the answer has been recently, and therefore can make a good educated guess on what the answer will be this time.

For each pattern, he stores 4 matrices. The first one, known as the initial matrix, records all of his experience while he is being trained. (He is in training as long as he has less than 500 tasks, this number is passed to the program under the parameter Training_Period). When he is no longer in training this matrix ceases to be incremented.

He also stores relative experience and old relative experience. Assuming an efficiency check occurs every 100 tasks (the default), his relative experience will encompass all tasks he has seen since the last efficiency check (which will be less than 100 tasks). After the next efficiency check, his relative experience matrix gets copied to his old relative experience matrix, and then gets zeroed. So his old relative experience matrix records his guesses for the last 100 tasks before the last efficiency check.

The fourth matrix records his absolute experience, it gets updated for every task he views, but he does not use it in making decisions; it mainly exists to examine his efficiency.

Each matrix is a 3x3 matrix indicating how many times the member guessed 1,2, or 3 and how many times the answer was 1, 2, or 3. Whenever a person receives feedback, he increments a single index in his relative and absolute matrices, as well as his initial experience if he is still in training. As long as a person's resources don't change, his matrices give an accurate history of what tasks have transgressed.

When his resources change, then the numbers of his matrices will be altered to reflect the change. If he loses a resource, then the matrices that represent patterns only differing by that resource are summed together. When he adds a new resource, all his matrices are triplicated and divided by 3. Thus, adding and then deleting a resource should leave experience matrices close to their initial values (there will be precision errors from discarded remainders when dividing numbers by 3).
OrgAhead Change

NOTE: This function only available in a full version of ORA.

Making a Change in the Org

Org change is handled very formally, and has different meanings in orgsim and orgahead. However, both treat change very similarly, so we will look at their similarities first, and then the difference in org change that distinguishes orgsim from orgahead.

Orgsim and orgahead conduct org change differently, but they may only change the org at specific points in the simulation. Periodically they stop simulation and attempt a change...if a change succeeds, the simulation continues with the changed org, otherwise, the original org continues until the next time for changing comes up.

There are five ways to change an org: hire someone new, fire someone, add a connection between two members, or a member and a task, change a connection, and delete a connection. Each of these may be done several times at once, but all the times must apply to the same level (or levels). For example the org can hire 3 new analysts, or change 2 connections between managers and tasks, but it may not hire an analyst and a manager at the same time.

Once a specific type of change is requested, orgsim and orgahead both proceed with the type of change in the same way. First they decide how many such changes can occur. This can be specified as either a constant (hire 2 people), or the program can be instructed to randomly decide how many changes to do based on a Poisson distribution.

Next, the programs pick a level of the org (for hiring and firing), or they pick a superior and inferior level (for add/change/delete connections).

Then they must decide which people on the levels picked are influenced. Usually there are parameters to decide this, and the options will be adjectives like best, worst, busiest, laziest, and random. Specifying best means use the person on that level with the highest relative efficiency, and worst means the person on that level with the lowest relative efficiency. Similarly busiest means the person on that level with the most tasks and laziest means the person with the least tasks. Finally, random means pick anyone on that level without regard to their efficiency or resources.

At this point the idiosyncrasies of each change come into play. The behavior of each change is described below:
For hiring, the level chosen indicates at what level the new member will exist in the org. If that level is full of members (the number of members meets a limit variable set by the program), no one may be hired on that level. The new person can receive no resource, or a random task or inferior person to supervise. Or he can receive resources from a 'mentor', a colleague on that same level. Like all members chosen, you can elect to use the busiest, laziest, best, worst, or random person to be a mentor. The mentor gives half his tasks to the new person. You may elect to have the mentor continue to supervise the resources he gave away, or to drop them. Finally a superior on the next level is assigned to supervise the new person (unless the new person is a CEO).

The above scenario is typical for when a person is hired on a level that already has people on it (who could serve as mentors). When a person is hired on a level with no current people on it, the program behaves slightly differently, depending on the level. When a CEO is added to an org with no CEOs, he supervises all the managers, or all the analysts if there are no managers. When a manager is added to an org with no managers, he supervises all the analysts, and the CEOs that were (presumably) supervising the analysts drop them. Or the manager supervises all the tasks if there are no analysts. When an analyst is added to an org with no analysts, he gets all the tasks his supervisor is currently overseeing. One final note: instead of a person supervising all the resources on a level, the program can be directed to give him one resource at random on that level instead.

For firing, the level chosen indicates what level the 'victims' occupy. A victim must be chosen from the level, and all his resources are given to one of his colleagues. It is possible to fire the last member on a level, but only if other members exist on other levels... you cannot fire the last person in an org. As with hiring, the programs behave slightly differently when the last person on a level gets fired. When the last CEO gets fired, his resources go to anyone that can supervise them (keeping mind that a supervisor must be on a higher level than a resource he must supervise). When the last manager gets fired, his task resources go to the analysts, and his analyst resources go to the CEOs if the CEOs were supervising the manger. When the last analyst gets fired, his tasks get distributed amongst his supervisors, or the existing managers, if no one is supervising the analyst.

When adding a connection, two levels must be chosen, the level of the superior and the level of the inferior, and someone on the superior level winds up supervising someone (or something) on the inferior level. The program first decides if the inferior resource must be an 'orphan' resource, that is, the resource is currently not supervised by anyone on the superior level. Then it picks an appropriate inferior resource, and superior person, and directs the superior to supervise the resource. (It ensures that the superior is not already supervising the resource.)
Changing connections also requires a superior and inferior level, and it is not possible to change a connection from level A to level B if there is no connection there in the first place. For example, you cannot change a manager-task connection if no managers are supervising tasks. First it picks a person on level A and resource on level B on which a connection exists. Then, it picks, either a second person on level A, or a second resource on level B, depending on whether it has been instructed to change the connection on the superior side or the inferior side, and makes the change.

Compared to the above, deleting connections is quite simple. A member on the superior level is found, who contains a resource on the inferior level chosen, and he loses that resource. Easy, isn't it?

Orgsim and orgahead differ in how they decide what kind of change to make. Orgsim assigns for each change, a threshold. As long as the relative efficiency does not change by more than that change's threshold, the org will not undergo that change. Also, if a change is successful, the org cannot be changed for a period of time depending on the type of change.

Orgahead ignores thresholds. It uses simulated annealing to determine what kind of change would be profitable...if a particular change improves the org, or at least, does not worsen the org significantly, that change is implemented, and the new org continues simulating, otherwise the old org continues until the next opportunity for change.
OrgAhead Murphies

NOTE: This function only available in a full version of ORA.

How To Handle Murphies

In organizational jargon, a 'murphy' is an event that embodies Murphy's Law; i.e. it is some catastrophe that afflicts orgs. A murphy can be represented as a person being lost, due to the person leaving the org, or disappearing. Or it can be represented as a line of communication that breaks, where one person cannot contact another, although both people are functioning perfectly fine in all other aspects.

Orgsim and the other programs provide flexible enough parameters to handle murphies, although they aren't implicitly aware of what a 'murphy' is. Here is how you would specify murphies to orgsim:

A murphy that destroys a person can be simulated in orgsim by firing a random number of people at a random level at a random time. Unlike normal firing, the org doesn't plan the action, so it does nothing (immediately) to reallocate resources. So the victim's resources are not immediately allocated to other colleagues. Of course, orgsim cannot destroy the last person in an org. Murphies should be used with hiring enabled, which simulates an org losing people at random intervals and having to patch itself up by hiring new people.

There is another type of murphy; it destroys a communication line between two people, leaving them otherwise intact. This is identical to deleting a random connection between two random people at two levels. This can be done with adding and changing connections enabled, which simulates an org trying to compensate for losing communication lines at random intervals.
OrgAhead Task Problems

NOTE: This function only available in a full version of ORA.

Task Problem Specification

The task problem determines how to determine the actual solution from the task bits. Generally, you can use a decomposable problem (where each task bit has the same weight as any other), or a nondecomposable one. You can also determine that the task should be biased (lean heavily towards an answer of 3) or unbiased (equal probability on all answers). These can be specified by the nondecomposable and -biased switches.

First a total is determined from the task bits, and then it is compared against two cutoffs. If the total is less than the first cutoff, the answer is 1, if it is less than the second cutoff the answer is 2, otherwise the answer is 3. The -nondecomposable flag affects the cutoff points, and so does the -biased flag. Additionally, you can tweak the -cutoff_friendly and -cutoff_hostile flags to introduce whatever level of bias you please.

If a decomposable problem is used, the total is the product of the task bits. Otherwise, the following formula is used:

Total = 2*t1*t2*t3 + 2*t4*t5 + t6 + t7 + 2*t7*t8*t9

If the cutoffs are not specified, the following cutoff values will be used:

Friendly Biased Unbiased Hostile Biased Unbiased
Decomposable 71 109 Decomposable 287 432
Nondecomposable 28 34 Nondecomposable 42 49
**Visualization**

- **Measure Charts**: When run this function will plot the three graphs, Bar Chart, Scatter Plot, and Histogram on the chosen network.
- **View Measures Over Time**: Requires multiple networks. First plots points for measure selected on each of the networks active with the option to see a direct line from the earliest to the latest point.
- **View Network Over Time**: Requires multiple networks. Displays nodes and links for each of the active networks.
- **Network Drill-Down**: Allows for quick, plotting of nodes connected to a chosen node.
- **Node Cloud**: Create an image with higher used concepts showing up in larger font sizes.
- **Color Grid**: Creates a colored grid representing the networks. White cells represent no connections.
- **Network Block**:
- **GeoSpatial Networks**: Analyze, forecast, and visualize a wide variety of spatial interactions and networks within a global-scale. [See GeoSpatial/Loom > GeoSpatial for more information](#)
- **View Trails**: Works with nodes moving between places over time. Requires the use of a trailset. [See Loom for more information](#)
- **View Trails in GIS**:

**View Networks**

- **3D Visualization**: Visualizes the selected network in the 3D Visualizer
- **2D Visualization**: Visualizes the selected network in the 2D Visualizer
- **Path Finder**: is used to find, not only, the shortest path between two nodes but also paths to other nodes when particular situations occur.
- **Sphere of Influence**: Each node within a network has a unique sphere of influence or ego network. Essentially it's a direct relationship with it's neighbors as a function of specified path length. The ORA Visualizer allows you to focus on this relationship by creating an Ego Map centered on any particular node you choose.
- **Key Set Selector**: uses information input by the user to create a simplified visualization.
- **Blank Visualization**: Opens the Visualizer with no active meta-network. Allows you to create nodesets and networks from scratch.
Measure Charts

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, Histogram, and Regression.

NOTE: The measures run can be changed by select from the main menu Analysis > Measures Manager.

Save Measures

Use this button to save results measures to a text file. This file can be opened in either Excel or a text editor. ORA will not attach an extension to this file and it is suggested to give it either a .txt or .csv extension.

Opening the File

Opening this file in Excel, making sure to import it as a delimited file, will give you the measures it can use and the values associated with each node in the nodeset chosen. You will notice that the names of the characters are characters_1, characters_2, and so forth. In this particular nodeset the Node ID contained the text characters_ plus a number and the Node Title contained the actual name of the character. This function used the Node ID when it exports this information.
<table>
<thead>
<tr>
<th></th>
<th>Measure</th>
<th>Input networks</th>
<th>Input node classes</th>
<th>Input parameters</th>
<th>characters_1</th>
<th>characters_2</th>
<th>characters_3</th>
<th>characters_4</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>capability</td>
<td>characters</td>
<td></td>
<td></td>
<td>0.9933072</td>
<td>0.9338295</td>
<td>0.2926904</td>
<td>0.0378589</td>
</tr>
<tr>
<td>3</td>
<td>cognitiveDistinctiveness</td>
<td>characters</td>
<td></td>
<td></td>
<td>0.42</td>
<td>0.33</td>
<td>0.29</td>
<td>0.37</td>
</tr>
<tr>
<td>4</td>
<td>cognitiveExpertise</td>
<td>characters</td>
<td></td>
<td></td>
<td>0.015625</td>
<td>0.1041667</td>
<td>0.2291667</td>
<td>0.3352273</td>
</tr>
<tr>
<td>5</td>
<td>cognitiveResemblance</td>
<td>characters</td>
<td></td>
<td></td>
<td>0.58</td>
<td>0.67</td>
<td>0.71</td>
<td>0.63</td>
</tr>
<tr>
<td>6</td>
<td>cognitiveSimilarity</td>
<td>characters</td>
<td></td>
<td></td>
<td>0.3860295</td>
<td>0.4101945</td>
<td>0.3309044</td>
<td>0.0890994</td>
</tr>
</tbody>
</table>
**Bar Charts**

**Bar Chart**

A bar chart contains horizontal bars representing the individual nodes in the set. These rectangular bars are usually proportional to the magnitudes or frequencies of what they represent.

Bar charts are used for comparing two or more values. The bars can be horizontally or vertically oriented. Sometimes a stretched graphic is used instead of a solid bar.
Use with Two-Mode Data

When you have two-mode data you can get the nodes of one nodesets that are connected to the most nodes of the second nodeset using measures charts. When using measure charts, first choose which nodeset you want to get values for then choose the measure.
Scatter Plot Charts

**Scatter Plot**

A scatter plot uses Cartesian coordinates to display values for two variables. The data is displayed as a collection of points, each having one coordinate on the horizontal axis and one on the vertical axis.

A scatter plot does not specify dependent or independent variables. Either type of variable can be plotted on either axis. Scatter plots represent the association (not causation) between two variables.

A scatter plot can show various kinds of relationships, including positive (rising), negative (falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it suggests a positive correlation between the variables being studied. If the pattern of dots slopes from upper left to lower right, it suggests a negative correlation. A line of best fit can be drawn in order to study the correlation between the variables. An equation for the line of best fit can be computed using the method of linear regression.
Scatter Plot

X-Axis measure: Capability
Y-Axis measure: Capability

N = 9, r = 1.0, r^2 = 1.0, M = 1.0, b = 0.0
Histogram Charts

**Histogram**

In statistics, a histogram is a graphical display of tabulated frequencies. A histogram is the graphical version of a table which shows what proportion of cases fall into each of several or many specified categories. The histogram differs from a bar chart in that it is the area of the bar that denotes the value, not the height, a crucial distinction when the categories are not of uniform width (Lancaster, 1974). The categories are usually specified as non-overlapping intervals of some variable. The categories (bars) must be adjacent.

The word histogram is derived from histos and gramma in Greek, the first meaning web or mast and the second meaning drawing, record or writing. A histogram of something is thus, etymologically speaking, a drawing of the web of this something.
Regression Charts

Regression

Regression analysis is also used to understand which among the independent variables are related to the dependent variable, and to explore the forms of these relationships. In restricted circumstances, regression analysis can be used to infer causal relationships between the independent and dependent variables.

The dependent and independent variables can be either a network measure or numerical attributes of nodes.

Calculating Linear Regression

The equation $y = mx + b$ algebraically describes a straight line for a set of data with one independent variable where $x$ is the independent variable, $y$ is the dependent variable, $m$ represents the slope of the line, and $b$ represents the $y$-intercept. If a line represents a number of independent variables in a multiple regression analysis to an expected result, the equation of the regression line takes the form $y = m_1 x_1 + m_2 x_2 + ... + m_n x_n + b$ in which $y$ is the dependent variable, $x_1$ through $x_n$ are $n$ independent variables, $m_1$ through $m_n$ are the coefficients of each independent variable, and $b$ is a constant.

Calculating Exponential Regression

Unlike linear regression, which plots values along a straight line, exponential regression describes a curve by calculating the array of values needed to plot it. The equation that describes an exponential regression curve is

$$y = b \times m_1^{x_1} \times m_2^{x_2} \times \ldots \times m_n^{x_n}$$

If you have only one independent variable, the equation is

$$y = b \times m^x$$
Output - Regression Statistics

R-Squared: The coefficient of determination, $R^2$, is the proportion of variability in a data set that is accounted for by a statistical model. There is no consensus about the exact definition of $R^2$. Only in the case of linear regression are all definitions equivalent. In this case, $R^2$ is simply the square of a correlation coefficient.

Adjusted R-Squared: Unlike $R^2$, the adjusted $R^2$ increases only if the new term improves the model more than would be expected by chance. The adjusted $R^2$ can be negative, and will always be less than or equal to $R^2$.

Standard Error: The Standard Error is an estimate of the standard deviation of the coefficient, the amount it varies across cases. It can be a measure of the precision with which the regression coefficient is measured. If a coefficient is large compared to its standard error, then it is probably different from 0.

Num Observations: Number of nodes in the nodeset.
Predicted Y Value: In the scatterplot, a point is plotted as (X, Y). The regression line will give the predicted Y value.

Residuals: The difference between the Predicted-Y value and the actual value.
Output - ANOVA

ANOVA: Information about levels of variability within a regression model and form a basis for tests of significance.
View Measures Over Time

Using the View Measures Over Time on a network allows an analyst to see how a network measures change over multiple time periods. If you use non-dated data, ORA will alert you if your meta-networks are not dated.

Highlight all the meta-networks and select from the main menu Visualizations > View Measures Over Time...

NOTE : Measures Over Time will only be run on the selected meta-networks.

Computation Parameters

First, the Computation Parameters dialog window appears. Here you can select the measures to use and whether to combine or transform the datasets. When done, click the [Compute] button to continue to the analysis.

Measures tab : gives you control over the measures used in the computation. With the Custom option you can select as many or few measures to use.

- All measures :
- Fast measures :
- Centrality measures : Uses only the network centralization measures.
• Custom: Calls up a dialog box which allows you to selectively pick which measures to use. Place a check mark next to any measure you want to use. You can also use the [Search] textbox to find a measure(s).

Aggregate tab: Combines multiple dates into one entry. If you have one meta-network for each day of the year, aggregating by month would reduce the 365 meta-networks into 12 meta-networks (the 12 would contain the 30 meta-networks for each day of the month unioned together).

Transform tab: The Conform using method makes the Node Classes identical across meta-networks. Union adds isolate nodes, and Intersect removes isolate nodes.

NOTE: Measure values computed on conformed meta-networks may differ from those computed on non-comformed data.
Measures Over Time window

This window is divided into three panes.

The Measure Selector Pane contains tabs for all Node Classes in addition to a network Level tab. If the Network Level tab is selected you can choose which measure(s) to apply to the entire meta-network. If a Node Class tab is chosen you can choose which Node(s) to view and in the Select a measure: text box select the measure to apply to them. All actions are instantly updated in the Charts Pane.

The Restrictor Pane allows you to set the beginning and ending time periods and additionally you can skip any number of intermediary steps.
The Charts Pane contains three tabs and a legend at the bottom showing the colors associated to which nodes. Each pane is further described on their own pages.
Over Time-Measure Selector Pane

The Network Level tab is a list of all the measures used in the current operation. Place a check mark next to any measure you want to use.

The [AND/OR] drop down allows for boolean operations on the measures.

The [Select All / Unselect All] buttons can be used as a starting point to select most measures or only a few measures.

All the individual Node Class tabs work identically. Like the Network Level you place a check mark next to the nodes you want to use and it also contains the [AND/OR] drop down.

The Measure: and Networks: drop downs allow you to hone your selections.

The [Select All / Unselect All] buttons can be used as a starting point to select most measures or only a few measures.
The Restrictor Pane allows you to set the starting and ending meta-network to use and also to skip a number of meta-networks in the middle.
Over Time-Measures Tab

Displays the charting of plotted measures over time denoting each by an individual color.
Frequencies

Fast Fourier Transform: Transform measures values to identify cycles in a temporal situation. Doesn't plot measure values. It plots strength of cycles. (i.e. traffic patterns could have a heavy/light traffic pattern or a weekly pattern, heavy on weekdays and light on weekends). Defines cycles of different lengths.

Dominant Frequencies: Selecting dominant frequencies on the radio button to the lower right, displays only the statistically significant frequencies.

Plots

- Original Plot:
- Period Plot:
- Filtered Plot:
- Original and Filtered:
CUSUM

Keeps track of cumulative total of deviation across time. No matter how small the change.

Networks in Control: Number of Networks to use as a control group

NOTE: If your change time is in the "Networks in control" bunch then you'll never see the change.

Standardized Change:

Set sensitivity to false alarm

Decision interval:

Risk: Higher risk numbers will possibly give more false alarms.

Observations:
**EWMA**

Exponentially Weighted Moving Average. Check Wikipedia. Incorporates historical data but places more emphasis on recent data.

Networks in Control: Number of Networks to use as a control group

Risk: Higher risk numbers will possibly give more false alarms.

Weight: Shows the weight of the newer observations over the older observations. Start and Finish is for which network to use.

**Shewhart X-Bar**

Show how different the current observation is from the baseline. This only takes into account the current observation.

Networks in Control: Number of Networks to use as a control group

Risk: Higher risk numbers will possibly give more false alarms.
Networks Over Time

Networks are ways of connecting the who, what, where, why, how and when. Each type of who, what, where, why, how and when is called an entity class. The items within them are called nodes or entities. The set of networks for three or more of these entity classes is called the meta-network. The entire field of Dynamic Network Analysis is based on the concept of the meta-network.

Terminology

Identity Crisis: Different entities with the same name could get confused. Bob #1 gets connected to Alice. Bob #2 gets connected to Carol. Alice and Carol get angry at their respective Bobs.

Meta-Network: A meta-network incorporates different nodeset classes and allow you to perform an analysis on the model that way. Such a model is called a meta-network.

A meta-network is network composed of multiple networks. A meta-network is the sum of all networks we are considering. The meta-network is the foundation for Dynamic Network Analysis;

Network: A network shows how the nodes connect to each other.

Node: A node can literally be anything you can think of; on an abstract level, an entity may be merely a dot in a visual network model. It is what we are networking and connecting our ties to and thus looking at in detail visually.

Nodeset Class: A nodeset class is a group of similar nodes (i.e. people, places, knowledge).

Node Occurrence Transparency: Easily see which nodes appear in the most timeslices.

Timeslice: A view of the data at a particular point in time. Often, one timeslice = one meta-network, but maybe a day/week/month-long snapshot.

Typos/Multiple IDs (think email addresses): Bob is assigned task Driver. bob is given resource Truck. ORA can't find a way for that task to be completed.

Vector Mapping: Views how measures and/or attributes affect each other as the time moves on.
Dynamic Networks

- S1: 2 agents share 1 location
- S2: They move apart to separate locations
- S3: A 3rd connected agent is detected at its own location
- S4: 2 of the agents meet
- S5: The 3rd joins at same locale
- S6: One agent disappears

Dynamic Meta-Networks in ORA

The clock icon indicates a dynamic meta-network.

The deltas contain changes to a network at a point in time.
The Operational Statistics indicate the number of additions, modifications, and removals to the network.

**Manipulating Keyframes/Deltas**

You can convert keyframes to deltas, deltas to keyframes, or aggregate by day/week/month/year.

**Over-Time Visualizations**

Visual comparisons, animating over time, and plotting changing centrality.
View Network Over Time

View Network Over Time: Uses all selected meta-networks for analysis in various time frames. Select all the meta-networks to use in the analysis.

NOTE: It is of the utmost importance that the networks in all meta-networks are named the same. If not, the Over Time function will not work correctly.

NOTE: meta-networks for use in the Over-Time tool are required to have date information. If they do not a warning box will appear telling you of the missing information.

NOTE: Menu options and right click context menus apply to what is currently selected. If an entire dynamic meta network is selected (the parent item) it applies to each snapshot/delta, otherwise it only applies to the currently selected snapshot/delta.

Now select from the menu Visualizations > View Network Over Time This will bring up the visualizer along with the Networks Over Time window.
The Animation Tab controls the workings of the animation. It also contains the Play/Stop buttons.

The Timeslices Tab contains check boxes for all active meta-networks. Placing a check mark in the boxes will use that particular meta-network.

The Clustering Tab allows you to set the time frame for clustering by day, week, month, or year.

**Animating the Display**

Pressing the [Play] button will start the animation. Below are the five Agent x Agent networks. In different time slices new nodes appear and the connections between the agents changes.
Immediate Impact on Raiders

**Impact on Raiders**

The following procedure uses the Raiders of the Lost Ark dynamic meta-network to show working with the Immediate Impact Report.
**Import Data**

**Intro**

The data for Raiders of the Lost Ark was garnered from the movie script which contained additional scenes not shown in the movie itself. Information concerning scenes, locations, characters appearing in a location during a scene and other attributes were complied in an Excel file. This file was imported into ORA.

**The Excel File**

The Scene x Character Query contains both the interactions between characters and the node attributes of the characters and locations involved. The story begins in Eyebrow of the Jungle with all actions from each scene, one per line.

**Importing a Dataset**

From the main menu select File > Data Import Wizard. Expand the menu What would you like to do? > Import Excel of text delimited files > Table of network links. Highlight Networks, nodes, and node attributes. Click [ Next > ]. Select Create a new meta-network with ID: and name it Raiders Scenes. Click [ Next > ].

Click [ Browse ] and select the Raiders Scenes Excel file and use the Scene x Character Query sheet. Place a check mark in the dynamic meta-network date: to create keyframes during import. Use the combo box to select Time. Near the bottom place a check mark in Create new nodes for unrecognized node IDs.

Step 2 is giving nodesets ID names. Scene has Type > Event and ID > Scene. Place has Type > Location and ID > Location. Character has Type > Agent and ID > Agent. ResourceForce has Type > Resource and ID > Resource. ResourceAffected has Type > Resource and ID > Resource. KnowledgeElicited has Type > Knowledge and ID > Knowledge. RelatedKnowledge has Type > Knowledge and ID > Knowledge. AgentAffected has Type > Agent and ID > Agent.

NOTE : Latitude, Longitude, and Role are attributes and should not be defined as entities.

**Network Tab**

Step 3 click the Network tag then click the [ New ] button. Networks will be designed to show now various nodesets interact with other nodesets.
<table>
<thead>
<tr>
<th>Source ID</th>
<th>Target ID</th>
<th>Link Weights</th>
<th>Network ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scene</td>
<td>Place</td>
<td>&lt;Select...&gt;</td>
<td>Scene x Location</td>
</tr>
<tr>
<td>Character</td>
<td>Place</td>
<td>&lt;Select...&gt;</td>
<td>Agent x Location</td>
</tr>
<tr>
<td>Character</td>
<td>ResourceForce</td>
<td>&lt;Select...&gt;</td>
<td>Agent x Resource</td>
</tr>
<tr>
<td>Character</td>
<td>KnowledgeElicited</td>
<td>&lt;Select...&gt;</td>
<td>Agent x Knowledge</td>
</tr>
<tr>
<td>Character</td>
<td>RelatedKnowledge</td>
<td>&lt;Select...&gt;</td>
<td>Agent x Knowledge</td>
</tr>
<tr>
<td>Character</td>
<td>AgentAffected</td>
<td>&lt;Select...&gt;</td>
<td>Agent x Agent</td>
</tr>
<tr>
<td>ResourceForce</td>
<td>ResourceAffected</td>
<td>&lt;Select...&gt;</td>
<td>Resource x Resource</td>
</tr>
<tr>
<td>ResourceForce</td>
<td>KnowledgeElicited</td>
<td>&lt;Select...&gt;</td>
<td>Resource x Knowledge</td>
</tr>
<tr>
<td>ResourceForce</td>
<td>RelatedKnowledge</td>
<td>&lt;Select...&gt;</td>
<td>Resource x Knowledge</td>
</tr>
<tr>
<td>KnowledgeElicited</td>
<td>RelatedKnowledge</td>
<td>&lt;Select...&gt;</td>
<td>Knowledge x Knowledge</td>
</tr>
</tbody>
</table>

NOTE: The Network ID can be changed to whatever makes sense to your dataset, i.e., Agent x Location could be called Character x Location.

**Attribute Tab**

Click the Attribute Tab to import attributes into nodesets. Click the [ New ] button and fill in the information from the table just as you did with the networks.

<table>
<thead>
<tr>
<th>Node IDs</th>
<th>Attribute Values</th>
<th>Value Type</th>
<th>Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place</td>
<td>Latitude</td>
<td>Text Category</td>
<td>Latitude</td>
</tr>
<tr>
<td>Place</td>
<td>Longitude</td>
<td>Text Category</td>
<td>Longitude</td>
</tr>
<tr>
<td>Character</td>
<td>Role</td>
<td>Text Category</td>
<td>Role</td>
</tr>
</tbody>
</table>

NOTE: Latitude and Longitude are special attribute names used in the GeoSpatial Visualizer. Be sure their Value Type is Text Category.

You can save your import settings for importing the same data structure again by clicking the [ Save configuration ] button. When you are done, click [ Finish ].

714
Examine Data

Examine Your Data

With the Raiders meta-network loaded (with the big clock on top), click the [ + ] to expand it. Contained within are the individual keyframes that occurred, each representing a scene. There are 83 scenes with dates ranging from 5/1/1936 to 6/11/1936.

It is always good to check your data after importing. Scan through some keyframes, check the nodesets, and see if the networks look correct.

Editor Tab

Select a network and click the Editor Tab. Click Display Options and select Numeric link weights. When first imported, you might ask, "Why do some characters have link weights greater than one?". When the dataset was imported it combined many relations of a character in one univariate file created weighted links.

<table>
<thead>
<tr>
<th></th>
<th>Eyebrow of th...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barranca</td>
<td>4.0</td>
</tr>
<tr>
<td>Yagua Indians</td>
<td>2.0</td>
</tr>
<tr>
<td>Indiana Jones</td>
<td>2.0</td>
</tr>
<tr>
<td>Sato</td>
<td>1.0</td>
</tr>
</tbody>
</table>

You can review which measures this would affect using the Analysis > Measure Manager. Under the column Uses Link Weights shows True/False for each measure.

Revising Your Data

You can binarize the link weights to correct this. Highlight the Raiders Scenes meta-network, click-and-hold, and drag to a blank area of the pane to create a copy. From the menu select Data Management > Meta-Network Transform. Select Raiders Scenes and click [ Next > ]. Select General in the left pane. Place a check mark in the Binarize (set link values to one) then click [ Run ]. As a copy was created click [ No ] to binarize this network. Then click [ Close ].

Rename this new meta-network and save it.

This network is identical to the first one only with single weight links.
Familiarization With Data

Data Familiarization

Highlight your newly binarized dynamic meta-network. From the menu select Visualization > View Networks Over Time. When the Visualizer appears, make sure the Show Arows is active to see the directionality of the interactions.

In the Networks Over Time dialog, click [ Play ] to watch the change in the networks.
Find Key Entities

We'll use the Visualizer to aggregate across all scenes then save that aggregated meta-network with the Key Entities Report.

Highlight the meta-network and click [ - ] to collapse it. In the Timeline section, click Select All which will place a dot beneath every date. Then click [ Aggregate ].

In the Aggregate dialog box, select By period and set to 1 year. Make sure there is no check mark in the Include empty aggregated meta-networks box. Click [ OK ].

By using the [ Aggregate ] button, we made a copy of the aggregated meta-network for the Visualizer. But the aggregated meta-network is not yet added to the Meta-Network Manager pane. To add this, we will first visualize it then save it. Click [ Select All ] then click [ Visualize ]. The aggregated meta-network is now displayed.

Before saving, uncheck the Scenes nodeset in the Legend as this nodeset is now irrelevant. From the menu select File > Add Meta-Network to Ora.
Highlight the new meta-network and expand it to see the nodesets and networks. The Scenes nodeset is size 0. Right-click the nodeset and select Remove Selected Node Class. Save this as a new meta-network to use in the future.

Highlight the new meta-network and click the [Generate Reports]. In the Generate Reports dialog, select Key Entities Ranking from the combo-box. Check that the correct meta-network is selected for analysis. Click [Next >].

The Key Entities Ranking dialog shows the nodesets and networks it can use. Click [Next >].

In the next dialog, select the ID: Role in the combo-box and the Value: Good Guy. Click [Next >].

Finally select the outputs for the results. Click [Browse] to select a directory for the reports. Next, give the report files a prefix name. Click [Next >].

The HTML files can now be viewed in your browser.
What Have We Learned

Indy is an important character, given a variety of relevant measures.

He ranked in the top 3 in 90% of measures calculated.

Marion Ravenwood, Sallah, & Rene Belloq are also important (i.e., top-ranked in a high percentage of measures).

German Agents, while identified as important, is an entity that represents various extras who wore Nazi uniforms in bit parts.

Knowing of the Well of Souls & the Ark of the Covenant is important.

The Ark of the Covenant is the most important resource in the movie.

The Raven Saloon & Tanis Ruins are important locations.

Questions

Does Indy go to Raven Saloon & Tanis Ruins?

If so, how is Indy’s visits to these important locations situated in the time course of the movie?

Are these locations near one another?

Is the Ark at one or both of these locations?

Should we restrict Immediate Impact analysis to a subset of locations/scenes?
Examine the GeoSpatial

Examine Data in GeoSpatial

So, Where does Indy go? Next we'll plot Indy's trail through the story. We'll compute Trails for Agent x Location network, using "Raiders Scenes" dynamic meta-network, export a Visitation Frequency Matrix from Loom to ORA, and Visualize Transitions network.

Afterwards, we'll plot Indy's Trail on the Map, import Lat/Long for Locations, and show it in the 3-D Geospatial Visualizer.

Highlight the meta-network and click [ View Trails… ]. In the combo-box, select Agent x Location. Click [ OK ].

In Loom display, select Indiana Jones. From the menu select File > Visible Visitation Frequency Matrix... which will export the trail to ORA. Close Loom display.
Expand the Trails Visitation Frequency Matrix meta-network and select Transition. Click [ Visualize this Network ].

The sequence of locations visited by Indy will be displayed. The opening sequence runs up to the Eyebrow of the Jungle.
What Do We Know

Indy visited the Raven Saloon and the Well of Souls sometime around the middle of the movie. So the locations are temporally near one another.

Question: Are the Raven Saloon and the Well of Souls geographically close?

Question: Is the Ark at these locations?

Question: Should we restrict Immediate Impact analysis to part of the movie?

What Next?

The next step is to find geographic proximity of Raven Saloon & Well of Souls.

Examine the Location nodes in the Editor. Notice there are no latitude or Longitude attributes. These need to be added in order to plot them on the map.
Select the Trails Visitation Frequency Matrix and click the Data Import Wizard icon. Expand the Import existing data? > Simple Table > Node Attribute. Click [ Next > ].

Verify the correct meta-network is selected. Click [ Next > ].
Click [Browse] and navigate to the Raiders Places dataset.

In step 2, select the column Place.

In step 3 make sure Latitude and Longitude are both set as Text Category. Also make sure Create new nodes for unrecognized node IDs is NOT checked. Click [Finish].
Reviewing the meta-network once more each place now has its Latitude and Longitude set. This can now be visualized on the map. From the menu select Visualization > GeoSpatial Networks....

After the trail is on the 2D map, select from the menu Options > Use 3D Visualization and explore Indy trail on the globe.

Checking Your Data

What we know

Raven Saloon & Well of Souls are reasonably close geographically.

It looks like Indy went directly from Raven Saloon to area near Well of Souls.

Questions
Where does the Ark appear?

Where is the Ark discussed?

Next steps

Find trail of Ark.

Find trail of Ark knowledge.

Compare trails to decide whether to restrict Immediate Impact analyses to part of movie.
Tracking the Ark

Problem: How can we find the Ark and Ark Knowledge if we have no Resource x Location and Knowledge x Location networks?

Solution: Agents have Resources and Knowledge. Agents are also associated with Location. We can build a Resource x Location and Knowledge x Location networks by finding which Resource/Knowledge and Location nodes share Agents. A little matrix multiplication is all we need.

Procedure

Make a copy of the Raiders Scenes meta-network Click and hold the Raiders Scenes dynamic meta-network and drag it to an empty area. When you let go, a duplicate will be created. Click in the ID textbox and rename it. Right-click the new meta-network and select Meta-Network Transform.

Make sure the correct meta-network is selected, then click [Next >].

In the left pane, select Networks. Click Clear All and select only Agent x Knowledge and Agent x Resource. At the bottom, place a check mark in the Transpose the Network. Click [Run].

From the menu select Data Management > Matrix Algebra. In the combo-box select Multiply Networks. For network 1 select Agent x Resource transpose and for network 2 Agent x Location Click [Compute]. Repeat this process using Agent x Knowledge transpose for network 1. When finished, click [Close].

Highlight the new Raiders Scenes (copy) and select Data Management > Matrix Algebra. Click [Next >].

Select operation Multiply Networks

Select network 1: Agent x Resource transpose

Select network 2: Agent x Location

Enter ID of new network: Resource x Location (shared agent)

Click [Run]

Repeat this procedure with the Agent x Knowledge transpose
Next Steps

Using the temporary copy of the Raiders Scenes dynamic meta-network, click the [View Trails… ] button to create Trails for the Ark of the Covenant and Knowledge of the Ark of the Covenant. You will do this twice. Once for the Ark itself (Resource x Location) and Knowledge of the Ark (Knowledge x Location).

Select Ark of the Covenant. Select File > Export to Ora-NetScenes > Visible Visitation Frequency Matrix. This will create a new meta-network in the Meta-Network Manager pane with the locations where the Ark was in the story. Repeat this with the Knowledge x Location Network. You can visualize locations for both knowledge of the Ark and the Ark itself.

Now you can compare the trails for Indiana Jones, the Arks, and knowledge of the Ark.
Infomation Check

Knowledge of the Ark first appears at Marshall College and last appears at Pentagon

The Ark chase begins in Marshall College scene
Ark first appears at Well of Souls
Ark is in Well of Souls
Ark is found in Well Souls
Ark last appears at Pentagon

Conclusion

Restrict Immediate Impact analysis to scenes beginning at Marshall College and ending at Pentagon
Aggregate

Use original Raiders Scenes dynamic meta-network. Delete and/or save temp copy of Raiders Scenes and Visitation Matrices. Keyframes in original Raiders Scenes are coded to exploit ORA's date-oriented aggregation capabilities. Scenes occurring in May, 1936 concern Chachapoyan Fertility Idol chase. Scenes occurring in June, 1936 concern the Ark chase. Aggregate original Raiders Scenes by Month. Make copy of June keyframe

Aggregating Your Data

Select Raiders Scenes. Right-click and select Aggregate. Aggregate by a one month period. Make sure NOT to include empty meta-networks. Be sure the Include empty aggregated meta-networks is not selected. Then click [ OK ].

Augmenting Your Data

Import task representation to "Ark Chase" meta-network, Coding of script does not include Tasks and associated networks. Task networks are needed to compute two of measures in Immediate Impact Report. Minimal Task networks are in "Raiders Tasks" data file

ORA Reports are designed to gracefully degrade; measures associated with missing input networks are not displayed. A Resource x Task network is no the same as a Task x Resource network.
From the menu select File > Data Import Wizard. Expand this to Import existing data? > Simple Table > Networks, nodes and node attributes. Click [ NEXT ].
Select the Add to the existing meta-network and from the combo-box, select Raiders ark Chase.

Click the [ Browse ] button and find Raiders Tasks. Click all the tabs and make sure they are all empty then return to the Networks tab. Click [ New ]. Click [ Load configuration ] to load Raiders Tasks Import config file. This will reload the networks to import. Click [ Finish ].
Random Node Removal

Random Node Removal For Baseline

Select Raiders Ark Chase then click [ Generate Reports… ]. Select Immediate Impact dialog box from the combo-box. Make sure the Raiders Ark Chase dataset is selected and click [ Next > ] here and the next dialog selecting all Networks.

Select Replication analysis and click [ Next > ]

100 replications will be OK. Change the number of agents to 1 and click [ Next > ]

Select your output formats. Click [ Browse ] and select a directory to save your reports. Type in a prefix for your report in the textbox and click [ Finish ].

The report will display that a random agent node was removed in 100 replications. The Network-level metrics are averaged over all replications. Near the bottom will be the metric values before removal, the Mean after removal, and the Mean % change.
The Meta-network does not change much by randomly removing an agent. This indicates there are few important agents and many unimportant agents.

IMMEDIATE IMPACT REPORT

Input data: Raiders Ark Chase
Start time: Thu Mar 07 11:13:45 2013

Data Description

Replication Analysis

The original input meta-network has the specified number of nodes from each class removed and the measures recomputed. This is repeated, and the average measure values across iterations computed.

<table>
<thead>
<tr>
<th>Number of replications:</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodeset</td>
<td>Nodes removed</td>
</tr>
<tr>
<td>Agent</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Original Value</th>
<th>Avg Replicated Value</th>
<th>Percent Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic Path Length</td>
<td>2.90</td>
<td>2.93</td>
<td>+1.26%</td>
</tr>
<tr>
<td>Input network(s): Agent x Agent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Communication Speed</td>
<td>0.35</td>
<td>0.34</td>
<td>-1.11%</td>
</tr>
<tr>
<td>Input network(s): Agent x Agent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Potentially Influential (betweenness centrality)</td>
<td>0.03</td>
<td>0.03</td>
<td>+0.52%</td>
</tr>
<tr>
<td>Input network(s): Agent x Agent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Potentially Influential (betweenness centrality)</td>
<td>0.01</td>
<td>0.01</td>
<td>+0%</td>
</tr>
<tr>
<td>Input network(s): Knowledge x Task, Agent x Resource, Agent x Task, Knowledge x Task, Resource x Resource, Task x Task</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrality (total degree centrality)</td>
<td>0.01</td>
<td>0.01</td>
<td>+0.93%</td>
</tr>
<tr>
<td>Input network(s): Agent x Agent</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrality (total degree centrality)</td>
<td>0.02</td>
<td>0.02</td>
<td>+0.00%</td>
</tr>
<tr>
<td>Input network(s): Knowledge x Knowledge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrality (total degree centrality)</td>
<td>0.01</td>
<td>0.01</td>
<td>+0.00%</td>
</tr>
<tr>
<td>Input network(s): Resource x Resource</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrality (total degree centrality)</td>
<td>0.50</td>
<td>0.50</td>
<td>+0%</td>
</tr>
<tr>
<td>Input network(s): Task x Task</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Specific Node Removal-Marion Ravenwood

We know that Marion Ravenwood is an important agent. She was ranked 2nd in total degree centrality and 2nd in betweenness centrality. So what if Marion was not in movie?

Select the Raiders Ark Chase then click [ Generate Reports... ]. Select Immediate Impact dialog box from the combo-box. Select Impact analysis and click [ Next > ].

In the General Filter tab type Marion Ravenwood in the textbox. Place a check mark next to her name in the table. Then click [ Next > ].

Next we'll tailor the report. From the ID: combo-box, select Role. Then from the Value combo-box select Good Guy. If you intend to do further analysis, place a check mark for Add the impacted network to the interface to perform further analysis without all the beginning steps. Click [ Next > ].
You will get two visualizations of the network: Before Isolation and After Isolation. The Network Level Measures chart will display the values before, after and the percent change. The rest of the report deals with the individual measures displaying Rank (before & after), Value (before & after) and Value Change (%).

Other popular Reports for finding nodes whose removal will degrade organizational performance are: Key Entities, Management, and Critical Sets.
Change Detection

Description

The View Measures Over-Time is used to find out how quickly you can identify changes in a network to exploit subtle organization change, and also to facilitate improved command and control subject to a specified risk of false alarm. Various measures of a network are taken at different points in time. You need to identify a) that a change did occur and b) when did that change occur.

NOTE: It is important to note that this is not predicting change. But rather it is detecting that a change has occurred quickly and be able to make some inference about the actual time of change.

Example of Change Detection

Change Detection may offer you a tool to operate inside the normal decision cycle. The following figure represents some measure of interest over time. It could be the revenue of a company, the combat power of an enemy, or a measure of interest from a social network. When do you conclude from this measure that a change may have occurred? Let's assume that by conventional methods you can detect a change in organizational behavior as of today, the vertical line. This time point might be too late to take preventative or mitigating action. In other words, this could be the point of inevitable bankruptcy for the company, or the successful culmination of a terrorist attack. Identifying that a change occurred by time period E might allow the analyst to respond to the change before it is too late; get inside the decision cycle.
Change detection is more challenging than it may seem at first. The sudden change in the measure between time D and time E, however, may look very similar to the peak at time A. Furthermore, if you assert that a change in fact occurs at time A, there may exist a large amount of time periods to investigate for the cause of any change. If you can identify more likely points in time where change may have occurred, you can reduce the costs in terms of time and resources to search for the potential causes of change. Identifying the likely time that a change may have occurred is called Change Point Identification.

Another problem you face is detecting the change as quickly as possible after the change occurred. Can you improve the ability to get inside the decision cycle by detecting the change at time D, or even better at time B? This is called Change Detection.

NOTE : It is important that you use at least 10 time periods for an accurate simulation.
The Three Procedures

The Shewhart X-bar Control Chart

This is simple and easy to implement and provides a proof of concept. It calculates a sample average of observations and measures of a process. The decision interval indicates whether the observation is in the tail of the distribution.

Cumulative Sum (CUSUM)

Other statistical schemes increase power (faster detection, given the same probability for false alarm). The CUSUM considers previous values of the observed process. It can take a long time to detect small changes. Intuitively, we can see change earlier. How to detect it?

Cumulative Sum is good at detecting small changes in mean over time and has good built-in change point detection.

The Load data and use CUSUM option. CUSUM has an additional parameter. This is equivalent to \( \gamma \) in the equation presented earlier. It is an optimality parameter for the
CUSUM approach that will make this approach the uniformly most powerful for a change in the social network measure of \( ? \). As a rule of thumb this is usually set to 1.

There are three ways to set the risk of a False Alarm.

1. The user can specify the decision interval.
2. The user can specify a probability as in the Shewhart approach.
3. The user can specify the average number of in-control networks expected before a false alarm.

This is due to the nested conditional probability inherent in the CUSUM.

The CUSUM signals a change, when the statistic exceeds the decision interval. The most likely point in time that the change actually occurred is interpreted as the point that the CUSUM was last equal to 0. In this case, the time period is 19, which is one time point before the actual change. This is where an analyst would begin to look for explanations of change in the group. There are two separate charts plotted. One is for increases (red) in the social network measure, and the other is for decreases (blue) in the measure.

**Exponentially Weighted Moving Average**

This chart requires two items.

- A definition of what normal behavior is.
- What is the risk of false alarm. (This is a trade-off between speed and mistakes).
Change Detection User Interface

User Interface

1) Recompute measures button: Runs the calculations. Allows you to change the measures used and obtain other results.

2) Measure Selector pane: In the left pane you can choose the particular measures that you want to analyze in either Network or agent level.
3) Restrictor pane: Allows you to set the dates which the Over-Time Viewer will work and also if you want to set a skip interval.

4) Chart pane: Area for displaying the final results. This area contains four tabs:

Measures Values:
Fast Fourier: Charts the results of the selected measures after applying the Fast Fourier Transform (FFT).

Change Detection: Used to quickly determine that a change has occurred. Find the change point to determine the exact date.
Distribution: Display this information in a color grid. The darker boxes signal higher values.

5) Function Buttons:

- Display Options: Allows you to Rename the X-Axis, Y-Axis, or both, recolor the measures lines, change the width of the lines on the graph for better visibility.
- Save Chart As...: Navigate to a directory, give the chart a name and click [ Save ].
- Date markers...: A one or more dates to the graph which will place a vertical line on the chart.
- Close: Close the dialog box.
Over Time Dependence

One major obstacle to the study of network dynamics is periodicity or over-time dependence in longitudinal network data. For example, if we define a social network link as an agent sending an email to another, we have continuous time stamped data. Intuitively, we can imagine that individuals are more likely to email each other at certain times of the day, days of the week, etc. If the individuals in the network are students, then their email traffic might follow the school's academic calendar. Seasonal trends in data are common in a variety of other applications as well. When these periodic changes occur in the relationships that define social network links, social network change detection methods are more likely to signal a false positive.

A False Positive: This occurs when the social network change detection method indicates that a change in the network may have occurred, when in fact there has been no change.

To illustrate, assume that you are monitoring the density of the network for change in hourly intervals. The density of the network measured for the interval between 3 A.M. and 4 A.M. might be significantly less than the network measured from 3 P.M. to 4 P.M. because most of the people in the network are asleep and not communicating between 3 A.M. and 4 A.M. This behavior is to be expected, however, and it is not desirable for the change detection algorithm to signal a potential change at this point. Rather, it would be ideal to control for this phenomenon by accounting for the time periodicity in the density measure. Only then can real change be identified quickly in a background of noise.

Periodicity can occur in many kinds of longitudinal data. Organizations may experience periodicity as a result of scheduled events, such as a weekly meeting or monthly social event. Social networks collected on college students are likely to have periodicity driven by both the semester schedule and academic year. Even the weather may introduce periodicity in social network data, as people are more or less likely to email, or interact face-to-face.

Spectral Analysis provides a framework to understand periodicity. Spectral analysis is a mathematical tool used to analyze functions or signals in the frequency domain as opposed to the time domain. If we look at some measure of a social group over time, we are conducting analysis in the time domain. The frequency domain allows us to investigate how much of the given measure lies within each frequency band over a range of frequencies.
For example, the figure below shows a notional measure on some made-up group in the time domain. It can be seen that the measure is larger at points B and D corresponding to the middle of the week. The measure is smaller at points A, C, and E.

If that signal is converted to the frequency domain as shown in the figure below, you can see how much of the measure lies within certain frequency bands. The negative spike corresponds to 7 days, which is the weekly periodicity in the notional signal. The actual frequency signal only runs to a value of 8 on the x-axis. The frequency domain signal after a value of 8 is a mirror image, or harmonic of the actual frequency signal.
The frequency domain representation of a signal also includes the phase shift that must be applied to a summation of sine functions to reconstruct the original over-time signal. In other words, we can combine daily, weekly, monthly, semester, and annual periodicity to recover the expected signal over-time due to periodicity. For example, the next figures represent monthly, weekly, and sub-weekly periodicities. If these signals are added together, meaning that the observed social network exhibits all three of these periodic behaviors, the resulting signal is shown in Sum of the Signals.
If the periodicity in the signal is not accounted for, it appears that there may be a change in behavior around time period 20, where the signal is negatively spiked. In reality, this behavior is caused by periodicity. If you transform the signal to the frequency domain you can see the weekly periodicity at point B and the sub-weekly periodicity at point A.
Spectral Analysis applied to social network measures over time will identify periodicity in the network. The next procedure will transform an over time network measure from the time domain to the frequency domain using a Fourier transform. Then the significant periodicity will be identified in the over-time network and present two methods for handling the periodicity.

The over time dependence analysis is accessed by selecting the Fast Fourier Transform tab in the Over Time Viewer. This displays the frequency plot of the data.

You can use the Over Time Viewer to help determine which frequencies are significant.

The [Dominant Frequencies radio button], displays only the statistically significant frequencies.

The [Fourier Transform radio button] uses the normal distribution in order to transform data from the time domain to the frequency domain. Therefore, the normal distribution is an appropriate distribution to fit to the frequencies plotted in the frequency plot. All frequencies that are within two standard deviations of the mean are then set equal to zero for the dominant frequency plot, revealing only the dominant frequencies.
NOTE: A dominant frequency is a potential source of periodicity, as opposed to random noise in the over time signal.

The analyst will often want to transform the statistically significant frequencies from the frequency domain back into the time domain so that he/she can make better sense of them. To do this, the analyst must select the radio button on the lower left called Period Plot.

The [Period Plot radio button] shows the analyst the expected periodicity in the over-time data. In the example, you can see weekly periodicity. The peaks and valleys in the period plot occur approximately every 7 days. At this point, the analyst may wish to merge the daily data into weekly networks. This would average out the effects of weekends and evenings that are likely to affect the properties of daily networks. Another approach is to simply look at the networks departure from what is expected.

The [Filtered Plot radio button] will create an over-time plot of how the measure deviates from what is expected, based on the periodicity of the measure. You can also plot the filtered measure with the original measure to see the difference as shown below.
Procedure

Your Dataset

Load your dataset which you need to run the Change Detection on into ORA. This should be a dataset with multiple time periods. Measures will be run on all the time periods and this will determine if a change has happened.

Highlight the Meta-Network.

Start Measures Over Time Function

From the Editor's main menu select Visualizations > View Measures Over Time... to start the process. In the dialog box select Centrality measures radio button. The measures for Change Detection you are mostly concerned about are the Closeness and Betweenness measures. But this will not always be the case.

Finally click [Compute].

Set Parameters For Trigger

False Alarm vs. Fast Detection: You need to determine which type detection you are looking for. This will help you set the trigger point. Where you set the risk bar has an effect on triggering alarms. Set it too low and it will trigger an alarm quite frequently possibly giving too many false alarms. Set it too high and you might not see the trigger until it's too late.

Example

I select Network Centralization, Row Betweenness: A-03

Next I click the Change Detection tab and select CUSUM from the drop down menu.

I then set the Risk to 0.17 and click [Compute].
Setting the Risk to 0.17 sets the trigger line in the chart (1).

The datapoint at (2) is a major spike but has not set off the alarm yet.

After a slight decrease the next jump at datapoint (3) is still under the trigger point but very close. and the following datapoint sets off the alarm Sep-2009. Tracing backwards the point of change is Jul-2009 when the upward trend began.

NOTE: There are two separate charts plotted. One is for increases (red) in the social network measures, and the other is for decreases (blue) in the measure.

NOTE: When a change signals in both increasing and decreasing directions, it is likely a false alarm.

NOTE: Once a signal occurs the CUSUM is no longer plotted over time.
Setting parameters to different values can make changes in the alarm rate. Changes in
the parameters (1) are Networks in control increase to 4 and Risk increases to 0.193.
This lowers the alarm trigger point to 0.7 (2).

(3) shows that the alarm is triggered in Aug-2009, a month earlier than the previous
example although the upward trend is also Jul-2009.

Had the Risk been risen any more the alarm would have been triggered in Jun-2009
and the changed point would be taken as May-2009, a full two months earlier than
the previous example.

The question would be is May-2009 the true change point or is it merely a false
alarm given the parameters set to detect it.
Network Drill Down

Network Drill Down allows for any path to be followed.

From the drop down textbox select the node you wish to start with. Here we'll begin with daniel_jackson.

The dialog box below will appear confirming you want to discontinue your last drill-down session.

Reset

Reset drill-down window with root node narim?

[OK] [Cancel]
Click on the node and a context menu will appear with all the links it has to other nodes. I select <event> (5 nodes).

This shows the five events the daniel_jackson was at.

Next I select summit_meeting and from the context menu select <resource> (4 nodes).
It drills down showing the five links to resource nodes connected to the summit_meeting.

This can be continued for as long as you need.

The [+] and the [-] buttons increase and decrease the font size.
Node Cloud

In ORA you can opt to visualize your data as a word cloud. A word cloud can loosely be described as a visual representation of words that appear within your data by displaying words that appear with the most common frequency as the largest. Below is a screen image of the SG1 data set as visualized in ORA's word cloud feature.

Word Cloud Tools and Settings

File: By accessing the File Menu you can open a previously saved meta-network, Save an Image to the clip board, and close your meta-network word cloud.

Options: In options, you can choose the measure you wish to apply to your word cloud visualization.
Horizontal Words: You can use this slider to set the ratio of the horizontal words visualized to the vertical word display (e.g., changing this setting to 100% would result in all horizontal word visualizations and no vertical words. Conversely, changing this setting to zero has the opposite effect.

Select a layout: Choose either word cloud layout (default) or a square layout. The square layout will attempt to visual your word cloud in approximate equal ratio of width and height.

Min. Font Size: Sets the parameter for the smallest font size to display. Note: if you change this setting, click [Run] to have the new setting applied.

Max. Font Size: Sets the parameters for the largest font size to display. Note: if you change this setting, click [Run] to have the new setting applied.

Max Words: Sets a limit on the maximum amount of words to visualize (e.g., if you set this at 10, the word cloud will only visualize the words that appear in the top ten in terms of frequency.

Run: Click [Run] to apply any changes to the settings.
The Color Grid is designed to allow you to quickly see what connections are in a network. Whereas the Editor either uses numbers in its numeric view or check boxes in its binary view the colored blocks used in the COlor Grid make it easier to discern who has a connection to whom.

The color ranges from White: no connection; Yellow: few connections; Red: the most connections.

Menus

File > Save Image As... Creates a color image (JPG or PNG) of the currently display grid.

File > Save Image As... (Greyscale) Creates a greyscale image (JPG or PNG) of the currently display grid.
Options > Toggle Headers: Toggles on/off the display for the headers and reduces the size of the grid.
**Region Viewer**

*NOTE: Before you start make sure your dataset contains both latitude and longitude data in order for information to be plotted and that it is in a numeric format.*

From the main menu select Visualizations > Region Viewer. You will be presented with a dialog asking you to select a shapefile. Click the [Load] button and navigate to the shape file to use. These files use the file extension .shp After selecting a file click the [Run] button.

**File Type**

*NOTE: The Region Viewer only works with WGS84-projected maps*

**Region Viewer**

The Region Viewer and Legend will appear on the screen. The Region Viewer with the shapefile you loaded and the Legend with the nodeset class containing the Latitude and Longitude attributes. Currently there are no values. This needs to be assigned.

**Shape Legend**

Using the Shape Legend you can color individual shapes. Click on a color box and choose a color. After hitting [OK] the shape will take on that color.

**The Menu**

**File**

Save Screenshot: Options for saves a screenshot in either the .PNG or .JPG format.

Close: Closes the Region Viewer

**Action**

Color All Shapes...: Brings up the Select an entity color dialog. All shapes will be colored.

Color All Occupied Shapes...: Will put selected color in shape which contains a node within the shape's boundaries.

Color All Unoccupied Shapes...: Will put selected color in shape which does not contain a node within the shape's boundaries.
Color Shapes by Attribute... : Select an attribute from the drop down. All shapes will be colored based on the value of that attribute.

NOTE : The attribute chosen needs to be a numeric value. Text values will not be shown in the drop down.

Color Shapes by Measures : Runs the selected measure on the meta-network and colors shapes from the min and max values.

Color Shapes Using Existing Value : With the Position tool deselected click on the color square and select a new color. Each shape clicked will be given this new color.

The Toolbar

The first three tools are straight forward. The far-right tool needs a slightly longer explanation.

Zoom In : Clicking this button will zoom in the map based on the center of the map.

Zoom Out : Clicking on this button will zoom out based on the center of the map.

Position : Clicking this button will toggle the center function and the color function. When highlighted clicking anywhere on the map will make that the current center. The map will redraw based on the new center. When unhighlighted the Colorize tool is activated.

Colorize : When the Position button is not selected this function is available by virtue of the small circle to the left of the color patch.
View Trails

Tracks agents as they travel from location to location finding when various agents were co-located in the same area.

The Person Pane allows you to choose which Trail(s) you want to visualize, as well as what color to use.

The Location Pane acts as more of a legend, showing you the currently active targets, while providing a way to change colors.

The Trail Pane is where the trails are actually visualized. The Y-Axis corresponds to time.

**Trails Data**

The data to be used is known as TAVI. It tracks persons as they move around, with their position decided by which camera locates that person for any given time. As
such, at any given point in time, each person is only associated with one location. TAVI makes use of a relatively new data format known as the Dynamic Meta Network. The Dynamic Meta Network allows for creation and usage of multiple time slices, while keeping file size complexity to a minimum. In TAVI's case, it works with around 2700 different time slices, tracking about 20 agents over the course of two years.

After a Trails dataset is loaded you can view the individual time slices in the Meta-Network pane. To view this is Loom select Visualizations > View Trails.

The Focus of Activity are figuring out where people tend to go and guessing what they do there?

It always involves both subjects and locations.

Unlike a network, subject may revisit location.

The time stream is an integral part of the data.

Subjects exist at one location at a time (but longer relationships may be implicit in repeated visits).

Loom is primarily concerned with how specific entities move or evolve through other entities. In the most basic case, this involves Agents as they move through Locations, which is what we'll be looking at today. More abstract examples include Agents moving through Beliefs or Beliefs moving through Locations. When you first start Loom, you are prompted for a Network. The target nodes in the Network dictate what they're moving through. The source nodes are who/what is doing the moving. Once started, Loom goes through all time slices, and looks at the connections in that network only. It sets up a series of way points based on what connections are made at that time slice, upon which it constructs a trailset. Classically, we restrained Loom such that for any time slice, any source node could appear in at most one target, but now we allow for a source node to occupy multiple targets at a time (Agents having multiple beliefs, for example).

Notes on Trails : Everything is scaled according to time. This can lead to some interesting behavior. In this example, we see a horizontal line. This doesn't mean an entity occupied two targets at that time, but rather, is because of the scale. The change may have taken only minutes or hours when the entire thing looks at two years.

**Procedure**

The Trails Report : To access the Trails Report use the Report Manager. The trails report can be found either through the drop down menu or in the Geospatial category.
Input: The report requires an input of at least two meta-networks with similar network structure (for the network we're interested in). Since TAVI is dynamic, we can get all the meta-networks we need from it. However, 2700 meta-networks will take quite a bit of time to work on, so we can aggregate by month to reduce it to a much more manageable number.

Selecting a Trail(s): The next window is perhaps the most important. While it doesn't ask for a specific Network, it does ask for nodes to track and a node class to track through.

In other words, we're selecting the Subjects (trails) up top, and the targets on the bottom. Since we've been looking at Person X Location, that is what has been selected.

Finish: Select the format for output, the directory in which to save it, and an optional extension.
Create Trails

Two Ways To Plot Locations

There's an easy way and a hard way to handle this. The hard way being the proper way and the only way if you want to look at multiple trails at the same time.

The Easy Way

Import all the data into a single Locations nodeset. Sort by the Date column to ensure everything flows in the proper chronological order. Create a Location x Location network. Go through and add a link from Location Node N to Location Node N+1. You'll end up with (N-1) links, since the last location never points anywhere.

The Hard/Proper Way

Import each location into a single meta-network. Each meta-network will contain two nodes: The agent node and the location node (containing where the agent was at that time). Make sure the meta-network is timestamped with the proper time. This'll generate chronological order. Combine all meta-networks into a single dynamic meta-network. Then use the View Trails in GIS feature.
Export Matrices

Importing

You will need a meta-network with location data.

Benefits and Drawbacks

It's good to understand what different information visualizations of trail data give you. The Over-Time Visualizer displays data in individual time periods. The GIS visualizer displays all data simultaneously regardless of time. The Loom displays paths agents take to locations chronologically.

Cluster Similar Trails

Use Loom to cluster similar trails. It is a high level concept display for who was where when.

Procedure

Take your dynamic meta-network and view them in Loom. From Loom menu select File > Export to Ora NetScenes > Transition/Colocation/Visit Matrix.... ORA takes the entire trailset and outputs a single meta-network. It takes all the data from the multiple time periods and aggregates them into a single meta-network.

Colocation: An edge is created between nodes if they ever existed at the same place at the same time.

Visit Matrix: An edge is created between a location and node if the location was the site of an event.

Transition: An edge is created between locations if a agent traveled to that location.

Visitation Frequency Matrix Location

The export operates from what is visible. It counts the total number of visits to all locations. The Matrix is similar to the Transition matrix.

Example

Click the [+] to expand the dynamic meta-network then click the [+] to expand the first time period. There are two nodesets, Agent [with one node] and Location [with one node], and an Agent x Location network. This represents the winner of the
first World Series. As the time period progress, more trophies are added as various sports add trophies.

Load your dynamic meta-network and make sure it is highlighted. Either click the [ View Trails ] button or select from the menu Visualizations > View Trails.

This Loom image displays all the winning cities of the World Series. Each stopping point represents one year. The other three looms are for Football, Hockey and Basketball. As each sports developed their own final game, an additional agent and location are added to the time period.

The display in Loom for the Baseball trophy is readable.
But adding in the other three creates a hard to decipher display.

**Colocation Network**

An edge is created between nodes if they ever existed at the same place at the same time.
Transition Network

An edge is created between a location and node if the location was the site of an event.
Visit Network

An edge is created between locations if an agent traveled to that location.
System Menu

The System Menu holds commands that relate to the operation of ORA:

- **Batch Mode Console**: Open a dialog for non-interactive operation of ORA.
- **System Monitor**: Show ORA's use of system resources.
- **Event Log**: Display a list of user actions performed in ORA.
Batch Mode Console

NOTE: Batch mode operation is only available in a batch enabled version of ORA.

The batch mode console supports non-interactive operation of ORA (batch mode), guided by user-provided parameters, including an ordered list of operations (script). A batch mode script is a user supplied XML document telling ORA what network data to load and what reports to generate.

Batch mode is useful for processing large data sets and executing repetitive analyses.
The System Monitor provides information on ORA’s use of system resources, primarily memory utilization. The line graph shows memory usage dynamically.

Clicking the [Garbage Collect] button will cause ORA to scan for allocated but currently unused memory and release it for reuse.
Event Log

The Event Log maintains a list of actions performed in ORA, allowing you to review steps that were taken during an ORA session. Executing the System > Event Log command displays the log in an "Event Log" tab in the ORA main interface.

The event log can be saved as a text file clicking the [Save Log] button and entering a file name.
Help Menu

*The Help Menu contains information which is beneficial in running ORA.*

Help Contents: Calls up this Help File System

About Ora: Contains information regarding this software, the institute of origin, permissions and warranties, version and build dates, and Java usage.
The ORA Visualizer produces a graphical model of a meta-network comprised of links and nodes. Moreover, you can interact with your meta-network model by removing key actors, isolating certain links, focusing on any particular relationship between two nodes using tools such as the Path Finder.

You can apply a host of grouping algorithms, look at node's Sphere of Influence, Locate Nodes, which may be hidden in complex clusters of nodes and links.

The Visualizer Interface

Below is a visualized meta-network displayed with the current tools available in the Visualizer. In this view all nodes and links are visualized. Note the different palette areas and options available from the Visualizer.
NOTE: If a meta-network contains more than 400 nodes then all node labels will be hidden. If a meta-network contains more than 1000 links then all links will be hidden also. The labels and links still exist and still factor into the layout, but just aren't drawn. The user still has the option to toggle them back on using the corresponding buttons on the Visualizer.

**Closing the Visualizer**

When you close the Visualizer you will be asked [ Save Visualizer options? ]. Selecting [ Yes ] will maintain the current state this meta-network is in (i.e. if you have hidden any nodes they will not appear the next time this meta-network is opened).
Synchronization

Synchronization allows you to work in the Editor and instantly see those effects in the Visualizer (or visa versa). Adding or removing a link in the Editor will place that link on the screen in the Visualizer.

The ORA Layout Algorithm uses a standard spring embedder algorithm. For large data sets, this has been enhanced using the Barnes-Hut Simulation for calculating the force of repulsion between any two nodes.

Visualizer Basics

Contained in this section are some basics to the visualizer. Many are small, yet important aspects to the visualizer.
Add Deltas

**Importing Delta Keyframe Data**

The easiest way to create a dynamic meta-network is to first create a number of regular meta-networks. Then select all the meta-networks you want to merge into a dynamic meta-network. Right-click on one of the highlighted meta-networks in the editor tree. Select Create a dynamic meta-network from the context menu.

This brings up a dynamic meta-network importer dialog containing all meta-networks you had selected. Next you need to select which meta-networks you want to act as keyframes. This can be as little as just the first meta-network or as many as all the meta-networks. Click the [Import] button at the bottom of the screen. A dynamic meta-network will be created.

**Does Data Have to Be in Delta Keyframe to Run Loom?**

No. It can be run with multiple meta-networks as long as the Node IDs in the location nodesets match in all meta-networks. In the zip file I sent for Star Wars, I included the regular meta-networks. Select all of them, and go the "visualizers -> view trails" route. It'll prompt for the network, and open up Loom.

**Can You Show Only Some Time Periods or Some Locations?**

In Loom, only the Locations that have entities currently moving through them gets shown. If an entity is currently moving through a location, that location cannot be hidden.

Similarly, there's no way to currently turn off a time period. The work-around would be to just not include that time-periods meta-network whenever you load up loom. I'm anticipating this being something I'm going to get to implement.

**The Danger of Creating Many Meta-Networks**

In a meta-network that uses Deltas, each time period only contains the changes to be made (add, delete, move nodes and links). But if your meta-network is very large (i.e., the TAVI dataset has over 2,700 time period) exporting the information out would create over 2,700 separate meta-networks. This can overwhelm a computer system in very short order.
Dotted Line Links

You can set this parameter to change certain links from solid lines to dotted lines by setting the parameter on the toolbar.

Change the dropdown menu from Hide links with weight: to Change to dotted-line links:. Then set the trigger [Less Than, Equal To, Greater Than], and then set the value.

Any link which matches these parameters will be converted to a dotted line.

The nodeset contains multiple links between agents most of which are a weight of 1. But five of the links are greater than 1. These links exist in the middle as we shall see.

<table>
<thead>
<tr>
<th></th>
<th>Alpha</th>
<th>Bravo</th>
<th>Charlie</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>0.0</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>Bravo</td>
<td>2.0</td>
<td>0.0</td>
<td>4.0</td>
</tr>
<tr>
<td>Charlie</td>
<td>3.0</td>
<td>9.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Here is the entire network. For ease of viewing I used Display > Link Appearance > Show Multiple Links Between Nodes to show the bidirectional links.

I change the option to Change to dotted-link links: and set the parameters to Less than 1.1 and change the And to Or. All links with a weight less than 1.1 become dotted links.
The group of solid links in the middle are the links from matrix.
**Link Colors**

There could be a time you want links in a network to be different colors to represent different types of information. Currently, the best method is to simply have two networks. One for each type of information (i.e., one color for email links and a second color for postal links).

**Procedure**

<table>
<thead>
<tr>
<th>Agent</th>
<th>Agent 1</th>
<th>Agent 2</th>
<th>Agent 3</th>
<th>Agent 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent 1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Agent 2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent 3</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent 4</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent 1</td>
</tr>
<tr>
<td>Agent 1</td>
</tr>
<tr>
<td>Agent 2</td>
</tr>
<tr>
<td>Agent 3</td>
</tr>
<tr>
<td>Agent 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Post</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent 1</td>
</tr>
<tr>
<td>Agent 1</td>
</tr>
<tr>
<td>Agent 2</td>
</tr>
<tr>
<td>Agent 3</td>
</tr>
<tr>
<td>Agent 4</td>
</tr>
</tbody>
</table>

Switch to List mode in the network editor. Add a simple attribute to each Network called Link Type.

For our example, the postal communication network, this would be set to Post. For the email communication network, this is all set to Email.

Upon visualizing this network, there are a few functions of likely interest here.
Link Appearance -> Show Multiple Links Between Nodes -> Retain/Split Symmetric Links: Should two nodes use both methods of communication, you'll see it.

Visualizer Legend -> Left Clicking on a network: Would bring up a dialog to allow for the changing of a network's colors.

Link Appearance -> Link Labels -> Show Attribute...: This allows us to show the "Post" or "Email" things we specified earlier.
Link Threshold

ORA attempts to find the link underneath the cursor. But as the number of links increases it becomes more difficult for to acquire the correct link.

A threshold limit of 5,000 has been set. ORA will not attempt to locate the link under the cursor when viewing a meta-network with more than this number.
Selecting Nodes

There are times you need to have a set of nodes selected in order to work on them. Instead of clicking on each node individually you can use the Marquee Tool.

Selecting a Set of Nodes

With the Marquee Tool you can select a set of nodes to work with. To select your nodes, Click and Hold the mouse button, drag the pointer to select the nodes, and release the button.
**The Visualizer Toolbar**

*This section explains the function of each of the toolbar’s default buttons. The user can add or remove buttons from the toolbars. These are explained in other sections of this help.*

When you first load a meta-network you will see the pause button depressed in the Visualizer toolbar. You can layout the meta-network by clicking the play button. The visualization will space apart across the screen. This is called laying out a network. The Visualizer is separating nodes and links that, at first, appear on top of each other. You can pause this process again when you think the meta-network is satisfactorily spaced apart or you can let ORA lay out the entire meta-network. Your computer speed, as well as the complexity of meta-network, will determine how long this takes.

- **Copy / Paste**: This feature allows you quickly capture a visualization and save it to be pasted into another document later.

- **Play / Pause**: The Play / Pause function works very similar to the play pause feature on any device. The pause button (two vertical bars) is depressed, the Visualizer stops laying out a meta-network. When the play button is depressed (right pointed triangle) ORA Visualizer begins laying out the meta-network as described above. The red ellipse highlights on the tool bar where this feature is located and accessible.

- **Magnifying / Maximizing**: The Magnifying Glass icon with the plus sign inside it, allows you to instantly fill the Visualizer window pane with the currently rendered meta-network. The red circle in the screen shot above highlights where to access this feature on the Visualizer tool bar.

If there are any nodes off screen, clicking the button once will bring all the nodes into view on the screen.

**NOTE**: This function works well when selecting a small part of your overall meta-network and magnifying it to fill the visualizer screen.

- **Rotating The Visualization**: To rotate your visualization look for the word Rotate next to the noon-pointing sundial icon in the tool bar. This feature is another way to manipulate your visualization to fill the entire visualizer window pane.

  **NOTE**: Use this feature in conjunction with the magnifying glass function to work your visualization into largest size possible.
Show Labels: The Show Labels button allows you to toggle the labels on and off in the visualizer. Default is ON.

Show links: The Show Links button allows you to toggle the links on and off in the visualizer. Default is ON.

Show Arrows: The Show Arrows button allows you to toggle the arrows on and off in the visualizer and show directional data. Default is OFF.

Font Size: The Font Size allows for setting the size of the font in the visualizer. This allows you to change the size of the font to suit your needs for each individual visualizer set. It ranges from 4, which is almost unreadable, to extremely large numbers, which can also be unreadable by virtual of overcrowding. So pick the size of font that best suits your screen.

Node Size: The Node Size allows for changing the node size, larger or smaller by increments of one. Four is the smallest size possible and creates a very small, almost indistinguishable dot. As the number increases it becomes easier to see the individual nodes until the number gets to a point where it can simply overpower the screen. But this gives you the ability to customize the entity size to suit your needs.

NOTE: This also affects the size of the nodes in the Legend.

Link Width: Allows for changing the general width of the line, larger or smaller. And as the options before you can pick the exact size which best suits your needs for the display.
Combine into MetaNode: Use the Meta-Node Manager to handle creating and removing meta-nodes.

Toggle Node Sizes: The Toggle Node Sizes button rotates through three sizes for the nodes (as seen below).

Hide Links by Weight: Use the Hide Links with Weight to select which links to display. As long as there are links with different values you can hide links of smaller values leaving only the more important links visible. This can assist in seeing links that might normally be too cluttered to view. Below left is a meta-network with all links in view. Below right is the same meta-network with links less than 2.0 hidden.
Drag: Used to move the view around the meta-network to see different parts. Press and hold the left mouse button and move the pointer around to view various parts of the meta-network.

Marquee: Click and drag the marquee over nodes to select them. After releasing the mouse button the set of selected nodes will remain enlarged enclosed in a dashed line.

After selecting a group of nodes they can be moved all together. Press the [Pause] button on the toolbar, switch to the [Move] tool, then grab and move the group. This is useful in creating displays of small portions of the visualizer.
NOTE : Only one set of nodes can be selected at a time. Creating a second selection negates the first nodes selected.

The Paint Tool : The Visualizer Paint Tool allows you to draw on the visualization. You can select a brush size and a brush color via a small pop-up menu that appears whenever paint mode is selected. Nodes are also selected whenever you stop drawing, using the shape drawn (plus a line from the endpoints of the drawing) as a giant polygon, which selects nodes based on whether or not they’re inside the polygon. There’s also a “clear” button that removes all paint. Painting works similarly to drawing with a marker on your computer screen – no matter how much you zoom/pan/rotate the visualization,
the marks will remain in the same place.

- **Node Creator**: You can create new nodes within pre-existing nodesets or create them in a new nodeset.

- **Link Creator**: Click on one node then drag the pointer to a second node. A link between the two will be created.

- **Node / Link Eraser**: While the Eraser tool is active any node or link clicked will be removed from the meta-network.
To help facilitate your workflow ORA allows you to mount/unmount tool buttons in the Visualizer's toolbar. The Visualizer contains two toolbars for this function. One on the top and another along the left side. Either of these toolbars can be placed in the horizontal or vertical position. Click the down-triangle to open the dialog box.

The grey-out buttons are the default set. The buttons at 100% are the ones I added to my GUI.

NOTE: Buttons without graphic images are placed on the toolbar using words. When placing a toolbar vertically it will expand to the width of the largest button.
The Configure Toolbar dialog box will appear. You will notice that some items are already checked. These correspond to the buttons already present. Placing a check mark next to any tool instantly mounts it on the toolbar. Removing the check mark from a button instantly removes the button from the toolbar.

When you are finished click [Close].

If at any point you can select the [Restore Default] button which will remove all the changes you made and restore the toolbar to the buttons found in the image at the top.

NOTE : The buttons appear in the order you select them. You can not re-arrange buttons once they are placed on the toolbar.
ORA can visualize your network with only the more weighted links displayed. Below are procedures to accomplish this task.

You can select to hide links either Less Than or Greater Than a certain value. Below is an agent x location network. And there are three tooltips displayed for jacob_carter for the values of 1.0, 2.0, and 3.0. We'll keep the hiding style as Less Than.

First we'll increase the value to 1.1 hiding all lower values. The link to the hasaraSystem_spaceStation is removed from view. The others, however are still on the screen.
Now let's increase the value to 2.1. This removes the link from jacob_carter to revanna.

If we increases to value to 3.1 then all of the links would be removed.
In this way you can remove links which are of lesser important to concentrate on a smaller set of data.
**Hyperbolic View**

The Hyperbolic function creates a bulge within your visualization adding a sense of depth. By moving the slider from right to left, you can increase or decrease this bulge effect and create different depth-added views. By moving the network around the window you can create the view you need. The Hyperbolic radio button and slider can be found at the bottom of the window.

This tool is useful when nodes may be very tight on screen such as the ones in the following images. Using the Hyperbolic tool you can help space them out for easier viewing. Here is how to do so:

NOTE: The Hyperbolic function, when selected, converts the slider to this feature. This is also true of using the zoom and rotate functions. Use all three in conjunction to get your visualization just the way you want it. Scroll down below this screen shot for another when viewed with the Hyperbolic feature.

Select the Hyperbolic tool and move the slider to the right. Then click-and-hold on some part of the white background and move the entire network to the left. You will notice the space between the nodes begins to increase the closer them come to the center of the screen.
Now the nodes are able to be read much easier.

NOTE : It is useful to use this tool in conjunction with the Rotate and Magnify tools to obtain just the view you desire.
Visualizer Paint Tool

The Visualization Paint tool allows you to draw colored lines on a visualization. You can select a brush size and a brush color via a small pop-up menu that appears whenever paint mode is selected.

Nodes are also selected whenever you stop drawing, using the shape drawn (plus a line from the endpoints of the drawing) as a giant polygon, which selects nodes based on whether or not they're inside the polygon. There's also a clear button that removes all paint. Painting works similar to using a marker on your computer screen - no matter how much you zoom/pan/do whatever to the visualization, the marks will remain in the same place.

From the Paint Palette you can select a brush size by adjusting the slider. Then choose a color by clicking a pre-set colour or clicking the [Custom Color] button and select any color. Clicking the [Clear] button sets everything back to default. Once brush size and color are selected, you can draw on the Visualization.

To undo your drawing click the [Clear] button.

NOTE: If you pan the visualization, the paint drawing will remain stationery on the screen. It does not move with the visualization.
Rotating A Visualization

You can rotate a visualization with the slider bar at the bottom of the interface or from the tool bar at the top. To do this from the slide bar, click the rotate option toward the bottom of the interface. This activates the rotate feature.

As you move the slider from the left to right, your visualization will rotate correspondingly. From the tool bar, you can click inside the rotate icon, which will turn the visualization depending on exactly where you clicked.

In the screen shot below, the yellow ellipses highlight where to access ORA's rotate tool both at the bottom and top of the visualizer interface.

NOTE: Use the rotate feature in tandem with the magnifying glass to find a visualization's maximum screen size.
Node labels, which often prove helpful in describing networks, can sometimes clutter a visualization. Thus, it may be necessary to eliminate labels from your visualization. To remove labels go to Visualizer tool bar and find the Show Labels button.

This initial screen shot shows the visualizer with all the labels.

When you click the Label button on the Visualizer tool bar ORA toggles the labels on and off. Note that now a much more clearer conceptual picture of the network is produced. You can flip between the two views.

**Hide Single Nodeset Label**

In ORA you can hide the labels of one nodeset but show the labels of another. You might want to do this, for example, if you want to show the names of organizations but not those of people (the agents). In order to do this you can do either of the following:

1) Turn on all labels. In the Legend, right click on the nodeset whose labels you want to hide. The Node Formatter Dialog will appear. Under Label are options for Hide Nodeset Name(s) and Show Nodeset Name(s).

2) Turn on all labels. Under Tools select Node Selector. In the top part, select the tab of the nodeset whose labels you want to hide. Select the Select Visible option. This selects all nodes in that nodeset (and only that nodeset). Below that, Select the Node Appearance tab. Uncheck the Show Label(s) checkbox and click the Set Labels button to the right of it.
**Zooming**

At the bottom of the Visualizer interface is a sliding zoom bar (image below).

You can drag the scrollbar left (to zoom out) or right (to zoom in).

![Zoom bar](image)

In the screen shot below the zoom bar has been set to the far left, the absolute zoom out possible. At this point very little is distinguishable.

In the next shot the zoom bar has been placed almost to the far right, absolute zoom in. It allows for extreme closeups of various parts of the meta-network.
NOTE: Clicking on the magnifying glass in the Visualizer tool bar will set the view to include all visible nodes.
File Menu

Open Meta-Network: This opens an Open File dialog box so you can navigate to a directory and open a meta-network into the Visualizer.

Open Ora-Image:

Save Image to File: This opens a Save As... dialog box and allows you to save an image of the current Visualizer in one of the following formats: PNG, JPEG, SVG (scalable vector), or PDF.

Save Meta-Network to File: After you've made changes to the information you can save the current status of the meta-network into a new file in a DyNetML format.

Save Special:

Save Meta-Network (Only Selected Nodes): Saves a new meta-network file which will contain only nodes currently selected, i.e. a subset of the currently loaded meta-network.

Save Grouping to New Meta-Network:

Save Meta-Network (No Dotted Links):

Save Meta-Network (Only Dotted Links):

Copy Image to Clipboard: Similar to the Save Image to File... only saves it to the clipboard where you can paste it into an image-editing program.

Record Movie:

Add Meta-Network to ORA: Save the currently visible network into a new meta-network titled, New Meta-Network. This new meta-network can be renamed accordingly.

Add Grouping to Current Meta-Network:

Add Meta-Nodes to Current Meta-Network:

Visualize in 3-D:

GeoSpatial Networks:

Node Cloud:

Close: Close the Visualizer and returns to the Main Interface.
Save Image to File

An image can be captured from the Visualizer and saved in a variety of formats:

- **PNG** (Portable Network Graphics). PNG is a bitmapped image format that employs lossless data compression. PNG was created to improve upon and replace the GIF format.
- **JPEG**: A standard compressed format for image editing.
- **ORA-NetScenes-PNG**:
- **PDF**: This format is usable with Adobe's Acrobat and Reader programs.
- **SVG**: Scalable vector graphics.
- **TIFF**: Format for raster graphics images.

ORA Images are functional in regards to PNGs. Whenever you save a PNG, relevant information about the visualization gets stored inside the image. These images record Node Colors, Node Location, Screen Center, and Zoom Value.

Loading images into a visualizer will re-create the image inside the visualizer. Loading an image is as simple as dragging-dropping it onto the visualizer.

**SVG**: SVG is an XML specification and file format for describing two-dimensional vector graphics, both static and animated. SVG can be purely declarative or may include scripting.

**Selecting Image Resolution on Save**

After choosing a format form the drop-down menu and specifying a filename press [Save]. A dialog box will appear asking for the quality of the image. The 1.0 saves the image in the same resolution. A higher number will result in a higher resolution image.

Below are examples of an image saved with a scale of 1.0 (on the left) and then saved with a scale of 5.0 (on the right). Use a number higher than 1.0 if there is a need for a higher resolution image.
NOTE: Values less than 1.0 are ignored when scaling images.
Save Selected Nodes to New Meta-Network

Occasionally you need to select only a portion of the visible meta-network and save them to a new meta-network. Using the Marquee tool and Control-Clicking individual nodes you can select exactly which nodes you need to create a new meta-network.

From the main menu select File > Save Special > Save Meta-Network (only Selected Nodes). Navigate to the directory to save the new meta-network and click [ Save ]

This new meta-network can be loaded into ORA and viewed independent of the original meta-network.

Save Selected Sub-Network

Ability to save selected sub-meta-network/network comprised of dotted-links/network comprised of non-dotted links, ability to launch into GIS (if the network has locations with appropriate data)
View Menu

This section of the help contains a description of the functions of the View Menu:

Change Font: Allows you to change the GUI font to any font on your system. Be careful with the font chosen as some fonts are built more for custom design rather than readability.

Log Hidden Nodes to Event Log: Initiates recording of nodes in the ORA log as they are hidden from view (e.g. by operations under the Actions menu such as the Hide Pendant Nodes action). Logging will continue until this menu item is selected again. (Note that when nodes are revealed the nodes are not logged.)

Log Hidden Nodes to File: Initiates listing of nodes in the specified file as they are hidden from view (e.g. by operations under the Actions menu such as the Hide Pendant Nodes action). Recording will continue until this menu item is selected again. (Note that when nodes are revealed the nodes are not listed.)

Create New Visualizer Tile: Create an additional view of the network in a separate tile. The appearance and layout in this tile will stay synchronized with the main visualizer view but can be selectively set to show information such as the outcome of grouping algorithms. More…

View Measure Chart when Running Measures: When selected, changing node appearance by measures opens a chart window displaying the computed measure values (for example, when manipulating nodes with Node Appearance → Attribute/Measure related Options). Unselect to stop chart creation/update.

Save Visualizer Profile: Create a file containing the current visualizer rules. More…

Load Visualizer Profile: Load a file containing saved visualizer rules and apply these rules to the currently visualized meta-matrix. More…

Flip Nodes Horizontal: Flip the current view horizontally across a line drawn vertically down the center of the view area.

Flip Nodes Vertical: Flip the current view vertically across a line drawn horizontally across the center of the view area.

Rotate Nodes: Rotate the current view a specified number of degrees.
Visualizer Tiles

Visualizer tiles are separate panes containing additional views of the currently visualized meta-network. A tile can be created using the Create New Visualizer Tile command found under the View menu. More than one tile can be open at the same time.

Tiles allow the user to explore meta-networks using multiple views. Each tile maintains the same node positions and style shown in the main visualizer window while nodes in each view can be separately marked and then used to explore and focus on different aspects of the data. For instance attributes can be used to mark nodes with user supplied data values, nodes can be colored by measures computed by ORA, or the results of multiple grouping algorithms can be compared simultaneously (see below for an example of comparing grouping algorithms). These methods can be applied in combination, making tiles a useful experimental tool to explore data.

Tile Characteristics

Tiles will reflect most changes made in the visualizer. This includes:

- Layout
- Node and Link Appearance

Some temporary annotations in the main visualizer view will not be reflected in tiles:

- Comments
- Pen lines
- Manually set node colors

Tiles can hold separate presentations of the network when certain options are applied:

- Node color options (found in the Node Appearance > Node Color menu):
  - Color Nodes by Attribute or Measure
  - Color Nodes by Component
  - Color Nodes by Dense Subgraph
  - Color Nodes by By Concor Grouping
  - Color Nodes by Newmann Grouping
  - Color Nodes by Louvain Grouping
- Size Nodes by Attribute or Measure (found in the Node Appearance > Node Size menu).
NOTE: The Reset Node Color and Size command will return nodes to their default appearance. It only affects the most recently changed tile.

**Tile Controls and Options**

Tiles are created using the View > Create New Visualizer Tile command in the menu bar. A dialog will open to enter an optional name for the (a unique tile name is recommended for convenience when multiple tiles are used). Then click the [OK] to create the tile.

Tile Controls: 1. Name tab; 2. Frame action controls L-R: Dock/Undock (Dock shown), Maximize/Restore (Maximize Shown), Close; 3. Command popup menu (right-click to activate).

Visualizer tiles provide very few direct controls. Tile contents are altered through the visualizer main window. Direct manipulations options include:

- Adjust tile size by dragging the edges of the containing window.
- Dock/undock the tile in the main visualizer window using the **Dock/Undock** button in tile upper right corner (also present in the tile's name tab).
- Maximize/restore a docked tile's size within the visualizer main window using the **Maximize/Restore** button in tile upper right corner.
- Close the tile using the **Close** button in the upper right corner (also present in the tile's name tab).
- Right clicking in the tile brings up an additional command list:
  - Undock - Put tile into a separate pane
  - Dock - Incorporate tile as part of part of the main visualizer window
  - Restore - *Not used.*
  - Minimize - *Not used.*
  - Close - Close tile.
• Close Others - Not used.
• Tab Orientation - Change the position of the name tab (and controls) using the list of options:
  • Up - Place tab at top (default).
  • Right - Place tab on right side.
  • Down - Place tab on bottom.
  • Left - Place tab on left side.
• Tab Direction - Change the orientation of the name tab (allows tab name to "lie flat" against the view area):
  • Up - Tab reads from bottom to top (usual when tab is at left or right).
  • Right - Tab reads from left to right (usual when tab is at top or bottom).
  • Down - Tab reads from top to bottom (usual when tab is at left or right).

Multiple View Example: Color Nodes by Group

Tiles provide a useful method for comparing the outcome of grouping algorithms. In this example two grouping algorithms are applied to a meta-network and the constituent agents are colored according by group using the 2D visualizer.

Side by side comparison of two grouping algorithms applied to the same meta-network. On the left nodes are colored using the CONCOR algorithm (split value=4), on the right using the Newman algorithm.

The following process was used to create the example image shown above (some steps are purely for adjusting the presentation appearance):
1. Open the meta-network for visualization.
2. Open a visualizer tile using the View > Create New Visualizer Tile command. Give the tile a unique name.
3. Dock the tile in the main visualizer window using the dock control on the tile's upper right corner.
4. Reduce the number of displayed nodes to the Agent nodeset.
5. Adjust the view windows to approximately equal sizes by dragging the inner margins and center the view using the magnifying glass button. Minimize the legend as part of the process.
6. Show the Newman groups in the tile by selecting Node Appearance > Node Color > Color Nodes by Newman Grouping from the menu. A dialog will appear asking "Which window should rule apply to?" with a pulldown list including the Main Visualizer Window and all open tiles (all tiles, even those with duplicate names and unnamed tiles, will be included). Select the previously created visualizer tile (Tier 1 in this example).
7. Show the CONCOR groups in the main visualizer window by selecting Node Appearance > Node Color > Color Nodes by Concor Grouping from the menu. A dialog will appear requesting the number of CONCOR splits. Four was input for the example. Then click the [OK] button to bring up the window selection dialog. Select the main visualizer window from the following dialog.
8. Tweak the images by running the layout, zooming, and rotating the image as desired. Set the node appearance to the node style Small Shapes.
9. Set the background to black using Display > Background Color > Black.

NOTE: You must open a visualizer tile before executing the grouping algorithms. Otherwise the visualizer will not offer the option of applying the results to a tile.
Visualizer Profiles

A visualizer profile is an XML format file containing visualizer rules. A profile allows the user to apply a set of actions during a visualizer session and then save the resulting rules for the visualization as a file. The rules can subsequently be reapplied during a later visualization session by loading the profile into the visualizer. The visualized meta-matrix can be the same or different from session to session.

NOTE: Visualizer profiles are currently available only in the 2-D visualizer. At present, only selected visualizer parameters are recorded in profiles, including:

- Node colors
- Node size

Example

Given a visualized meta-matrix, "Ultimate Spider-Man":

The following actions are performed:
• Node Appearance → Node Color → Color Nodes by Attribute or Measure then select the attribute \textit{gender}.

• Node Appearance → Node Size → Size Nodes by Attribute or Measure then select the measure \textbf{Boundary Spanner}.

After these actions, "Ultimate Spider-Man" appears as follows:

Using the View → Save Visualizer Profile option save the visualizer profile as "profile_1.xml".
Visualizing a second meta-matrix, "Valkyria Chronicles", which also has a gender attribute, the initial appearance is:

Load the saved visual profile using View → Load Visualizer Profile and selecting "profile_1.xml". After the profile is loaded, "Valkyria Chronicles" appears as follows:
Representation and Customization

A visualizer profile is a standard XML document, which can be saved in any desirable location. The output is editable and advanced users may wish to alter the rule set to create new profiles.
<?xml version="1.0" encoding="UTF-8"?>

- <MetaNetwork id="ult_spider_man">
  - <NodeColor>
    - <ruleclass id="GenericRuleByProperty">
      <property id="propertyname" value="Gender"/>
      - <map id="objectmap">
        <entry value="null" object="java.awt.Color[r=1, g=0, b=1]"/>
        <entry value="other" object="java.awt.Color[r=1, g=0, b=1]"/>
        <entry value="female" object="java.awt.Color[r=0, g=0, b=1]"/>
        <entry value="male" object="java.awt.Color[r=0, g=0, b=1]"/>
      </map>
    </ruleclass>
  </NodeColor>
  - <NodeSize>
    - <ruleclass id="GenericRuleByNumbericalMeasure">
      <property id="measurename" value="totalDegreeCelsius"/>
      <property id="failstate" value="0.0"/>
      - <map id="objectmap">
        <entry value="0.0080650001176429749" object="java.awt.Color[r=1, g=0, b=1]"/>
        <entry value="0.01612900011241436" object="java.awt.Color[r=1, g=0, b=1]"/>
        <entry value="0.02419400028884411" object="java.awt.Color[r=0, g=0, b=1]"/>
        <entry value="0.03225800022482872" object="java.awt.Color[r=0, g=0, b=1]"/>
        <entry value="0.04032300040125847" object="java.awt.Color[r=0, g=0, b=1]"/>
        <entry value="0.04838699847459793" object="java.awt.Color[r=0, g=0, b=1]"/>
      </map>
    </ruleclass>
  </NodeSize>
</MetaNetwork>

819
**Actions**

This section of the help contains a description of the functions of the Action Menu:

- **Undo**: Undoes a variety of actions performed in the Visualizer.
- **Add Node(s)**: Function for adding Nodes directly into the Visualizer. These can be added to existing nodesets or within newly created nodesets. You also have the option of the number of nodes to create.
- **Add Node (with links or attributes)**: Allows you to add a node directly into the Visualizer. In addition you can create links and assign weights to these new links. You can also select attributes and assign values to these attributes.
- **Add Link**: Allows you to create new links in a meta-network in the Visualizer. Then select the source and target nodes and then select the network. You have the option of creating a new network for this link. Lastly you can select the weight of the new link.

**Notes on Display of Multiple Edges**: If your meta-network contains graphs with multiple edges between two nodes ORA will display the edges as curved lines so as to allow visualization of overlapping edges. This is to say that if there is represented two nodes with four edges coming from four different graphs.

Please note that Tool tips are currently handled by math looking at the edge as if it were a straight line. Since our line is not straight anymore, it will only be highlighted if the cursor's in the middle - nowhere near the edge. But otherwise, you should still see tool tips.

- **Delete Isolates...**: Allows you to remove isolate nodes in two ways.
- **Delete Pendants**: Allows you to remove pendant nodes in two ways.
- **Delete Currently Visible Isolates/Pendants**: Currently Visible is exactly as it sounds. If it has no visible link on the screen, it's an isolate. It does not matter if there's a link that is hidden, it's an isolate/pendant.
- **Delete Underlying Isolates/Pendants**: Underlying ignores was is currently set to visible and hidden. It looks at the data itself. If the Data says it's an isolate/pendant, then it's an isolate/pendant and is removed.

**WARNING**: These actions DELETE the nodes from the meta-network. Saving the meta-network will permanently remove the nodes.

- **Pin All Nodes**: Set all nodes as unmovable
- **Unpin All Nodes**: Release all nodes and allow them to be moved independently.
Show Motifs

Show Isolates: Nodes which have no connection to any other node.

Show Dyads: Nodes which have a connection to only one other node.

Show Triads: Nodes which have a connection to two other nodes.

Show All-In-All Cliques: A group in which every node is connected to every other node in the group.

Show Stars: A central node with connections to all other nodes in the group. The pendant nodes are not connected to each other.

Show Long Chains: Seeks out links which are nodes with only two neighbors.

Show Cycles: A cycle exists if for any node in the group, there is a path back to that same node.

NOTE: Cycles is the only motif that really looks at link direction.

Isolates

Hide Isolated Nodes: Remove any node which has zero links connecting it to other nodes.

Periphery: Moves Isolates back to their original position.

Combine into MetaNode: Collects all the isolate nodes into a meta-node.

Move into Column: Moves all isolates to the right side of the screen in a column. The isolated nodes can be moved back using the Periphery option.

Hide Pendant Nodes: Remove any node which has only one edge connecting it to another node.

Recursively Hide Pendants: This function will run the Hide Pendant routine until there are no more pendants.

Recursively Hide Pendants and Isolates: This function will run both the Hide Pendant and Hide Isolate routines until there are no more pendants or isolates.

Hide Nodes by Degree: You are asked for a degree (visible neighbors) a node has and will hide all of these.

Recursively Hide Nodes by Degree: Works similar to Hide Nodes by Degree but continues processing until no mode nodes can be hidden.
Show All Nodes: Any nodes that were previously hidden will be revealed.

Show All Nodes Except Isolates: Reveal any nodes that were previously hidden with the exception of nodes that have no links connecting them to another node.

Compute Standard Measures for Visible Network: Computes the following collection of measures on the visible network: Total Degree Centrality, Betweenness Centrality, Eigenvector Centrality, Cognitive Demand, Resource Exclusivity, Task Exclusivity, Knowledge Exclusivity. The measure values can then be viewed within the Entity Status Window.
Hide Pendant Nodes

Pendants share links with only one other node. Their linkage is tangential and therefore isolated from the core linkages you may be interested in examining. Pendant Nodes, like Isolated Nodes, can be hidden.

From the drop down menu in the Visualizer select Tools > Hide Pendant Nodes.

Below is a Before/After screen shot of the visualization before showing the removal of the pendant nodes.
# Add Node(s)

**IMPORTANT NOTE**: Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File > Save Meta-Network As... (to save the entire meta-network with additions) or File > Add Meta-Network to Ora (to create a new meta-network using only the currently visible nodes). Changes can not be saved back to the currently open meta-network.

The Add Node(s) function allows addition of nodes to the current Visualizer. These added Nodes are not added to the currently open meta-network. If there is a need to save the meta-network with the added nodes then use the menu item File > Save Meta-Network to File... and create a new meta-network.

Below is the nodeset for Stargate with the original 16 node nodeset.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam...</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
</tr>
<tr>
<td>A04</td>
<td>teal'g</td>
</tr>
<tr>
<td>A05</td>
<td>jacob_cart...</td>
</tr>
<tr>
<td>A06</td>
<td>lt_eliott</td>
</tr>
<tr>
<td>A07</td>
<td>ren'al</td>
</tr>
<tr>
<td>A08</td>
<td>aldwin</td>
</tr>
<tr>
<td>A09</td>
<td>janel_frazier</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
</tr>
<tr>
<td>A11</td>
<td>gen_ham...</td>
</tr>
<tr>
<td>A12</td>
<td>lantash</td>
</tr>
<tr>
<td>A13</td>
<td>narim</td>
</tr>
<tr>
<td>A14</td>
<td>travell</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
</tr>
<tr>
<td>A16</td>
<td>yu</td>
</tr>
</tbody>
</table>

From the main menu select, Actions > Add Node(s) which brings up the Add Node(s) dialog box.
1. Use an Existing Nodeset:

   allows for a nodeset selectable in option 2 or Use a new nodeset creates a new empty nodeset.

2. This dropdown gives the option for selecting a pre-existing nodeset to place the new node.

3. The Node ID: textbox is used for giving the new node an ID.

4. The Number to Create: specifies the number of new nodes.

NOTE: If the Number to Create is larger than 1 then the text placed in section 3 for Node ID will be used as a prefix for all new nodes created.

After inputting the information to add node A17, the Visualizer will now display the new node as A17 with no connections. In order to display this node with a title will require saving the meta-network and changing the information within the ORA Editor.
Adding Multiple Nodes

The procedure for adding multiple nodes is similar to adding a single node. The exception is the text in the Node ID: textbox. When adding multiple nodes only use a prefix. ORA will attach numbers, starting at 1, for each node.

Here's the addition of three new nodes and the prefix A will be used. Three nodes, A_1, A_2, and A_3 are created on screen.

NOTE: You can only use a prefix ONCE. ORA will not accept any previously used prefixes a second time.

To add additional nodes use a different prefix.
NOTE: Now either save the altered meta-network using the File > Save Meta-Network As... to a new filename or continue with Add Link(s).
**Add Link**

Allows you to create links between nodes in the Visualizer and place them in an existing nodeset or create a new nodeset. You can also set the weight for the new link.

![Add a Link Window](image)

NOTE: Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File > Save Meta-Network As... (to save the entire meta-network with additions) or File > Add Meta-Network to Ora (to create a new meta-network using only the currently visible nodes). Changes can not be saved back to the currently open meta-network.

1. **Start node**: The start of a directed link.
2. **End node**: The end of a directed link.
3. Insert Nodes as they're clicked: Fills in the text boxes for Node. The first click adds the node in the Start node section. The second click adds the node to the End node section. Any further clicks will make the previous End node the start node and the newly clicked node becomes the new end node.

4. Use an Existing network: will place the links within the chosen network form the dropdown menu and Use a new network creates a new network from the name in option 5.

5. New Network ID: is the name for the new network from option 4.

6. Network: allows you to choice the network to create the link in.

7. Link Weight: The weight to assign the link between the nodes.

**NOTE:** Since this function creates directed links a second link would need created for reciprocal action.

Example: If a connection was made starting with A to B, a second connection would need to be made starting with B to A.

### Adding a Missed Link

If after the meta-network was constructed and it's noticed an link is missing (e.g. janet_frazier should have been connected to gen_hammond), the missing link can be added immediately without returning to the editor.

From the Visualizer menu select Actions > Add Link(s).
Be sure that the Insert Nodes as they’re clicked has been check marked and that Use an existing network is selected with the correct network is visible in the dropdown. Then select the [Create Link] button.

The two nodes are now connected with a directed link.
NOTE: this created a directional link from janet_frazier to gen_hammond but not the other way. To make it go both ways, a second link from gen_hammond to janet_frazier would need to be created.
Color Nodes by Attribute

When the agent-by-agent network is opened all the nodes default to the color red. ORA has default colors for all the various Node Classes. But ORA can also color the nodes based on their individual attributes. Here’s the default agent-by-agent Node Class in red.

From the Visualizer main menu select Actions > Color Nodes by Attribute or Measure. This brings up the Node Color Selector dialog box.

Selecting the down arrow for Select an Attribute:. Highlight an attribute from the list. ORA gives default colors to the nodes.
In some instances the color distinction isn't highly visible. And for presentation purposes a good contrast is necessary.

To bring up the Color Selector click on the color you want to change.

Note: By hovering over the measure or attribute, you can bring up detailed tool tips.

Select a new color from the swatches. Then select [OK]
Your new color choice is now reflected in the dialog box.

And the nodes with the attribute you selected are now a new, and brighter, color.
**Compute Standard Measures**

*This function runs four standard measures:*

**Cognitive Demand:** Cognitive Demand measures the total amount of effort expended by each agent to do its tasks. Individuals who are high in cognitive demand value are emergent leaders. Removal of these individuals tends to be quite disruptive to networks.

**Centrality, Betweenness:** Betweenness tells us which node is the most connected to other parts of a network. For example, Betweenness can tell us which person in a network is the most central to the network as a whole. Betweenness measures the number of times that connections must pass through a single individual to be connected.

**Centrality, Eigenvector:** Eigenvector Centrality reflects one's connections to other well-connected people. A person connected to many isolated people in an organization will have a much lower score in this measure than those that are connected to people that have many connections themselves. This would be true even if such a WHO might have a high amount of actual connections (i.e. high degree centrality).

**Centrality, Total Degree:** Degree Centrality tells us the relative number of direct connections a WHO might have in a network; the higher the score the more likely a WHO might be likely to receive and potentially pass on critical information that flows through the organization.

These values can be viewed either by hovering over a node and revealing the tooltip or double clicking a node and bringing up the Node status dialog and selecting the Measures tab.
Isolates

**Periphery**
Places isolates that were moved into column back to their original positions.

**Hide Isolate Nodes**
To further simply a visualization, it may prove useful to remove isolated nodes from the visualization.

Isolated nodes are not directly linked or connected to other nodes, which share direct links with each other. In the screen shot below, the red ellipses highlights an isolated nodes which need removed.

Select from the Main Menu: Actions > Hide Isolated Nodes.

In the screen shot below, after removing isolated nodes, the visualization is further simplified.
**Combine into Meta-Node**

This option will combine all the Isolates into one meta-node. This can be expanded right-clicking to bring up the context menu.

**Move into Column**

This function is used to move isolate nodes from the main viewing area to move easily view the connected nodes. These will be lined up on the left side of the screen.

**NOTE:** The original dataset was changed in order to create the isolates.

**NOTE:** If the names are not viewable and off the screen, change the position of the labels.

The isolates can be returned to the original position using the periphery options.
Add Network from Scratch

This function also allows the creation of networks from scratch. First, remove the check marks from all the nodesets in the Legend to remove them from the screen.

The DataSet

Next prepare your data for inclusion. Here is a small, five node, nodeset.

A01 col_jack_o'neill
A02 maj-samantha_carter
A03 daniel_jackson
A04 teal’c
A05 gen_hammond

From the main menu select Actions > Add Node(s).

In the dialog box activate the Use a new nodeset radio button. Underneath, in the Type: dropdown menu, select the type of nodeset. Then in the New Nodeset ID: textbox give it a name. Then select the [ Create Node(s) ] button.
The five nodes will appear in the Visualizer with the prefix and attached numbers. Now it's time to connect the nodes.

From the Visualizer menu select Actions > Add Link(s).
After selecting [Create Link] a new link will be drawn in the Visualizer.
Now switch the nodeset to use to Use an existing network, select the newly created nodeset in the dropdown, and create the rest of the links.

All of the links are now complete.

Save the Meta-Network with either Save Meta-Network As or Add Meta-Network to Ora and use the ORA editor to add in titles and attributes.
Size Nodes by Attribute

Size by Attribute uses the numerical value of an attribute to size the nodes. Sizes will be scaled accordingly. Below is an attribute created for this example.

The numbers range from 0 to 10 and denote approximate rank. 10 denoting general/leader down through the ranks to 5 for civilians and finally 0 for persons not involved.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
<td>9</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam...</td>
<td>7</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
<td>5</td>
</tr>
<tr>
<td>A04</td>
<td>tea'l't</td>
<td>5</td>
</tr>
<tr>
<td>A05</td>
<td>jacob_cart...</td>
<td>5</td>
</tr>
<tr>
<td>A06</td>
<td>lt_elliot</td>
<td>6</td>
</tr>
<tr>
<td>A07</td>
<td>ren'na1</td>
<td>10</td>
</tr>
<tr>
<td>A08</td>
<td>aldwin</td>
<td>5</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
<td>5</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
<td>8</td>
</tr>
<tr>
<td>A11</td>
<td>gen_ham...</td>
<td>10</td>
</tr>
<tr>
<td>A12</td>
<td>lantash</td>
<td>7</td>
</tr>
<tr>
<td>A13</td>
<td>narim</td>
<td>2</td>
</tr>
<tr>
<td>A14</td>
<td>travell</td>
<td>10</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
<td>0</td>
</tr>
<tr>
<td>A16</td>
<td>yu</td>
<td>0</td>
</tr>
</tbody>
</table>

From the main menu select Actions > Size Nodes by Attribute or Measure. Then select the attribute to use for the sizing. When finished, select [ Close ].

NOTE: Sizing nodes by attributes only works with attributes of numerical content. Alpha content will have no affect on the size of the nodes.
Each node will now be displayed according to the value in the chosen attribute.

NOTE: The numerals are not displayed in ORA and are shown only for display purposes.
Size Nodes by Measure

ORA has the capability to visualize nodes by scaling them relative to each other in relation to common SNA measures or attributes as selected within the ORA Visualizer.

The key benefit to sizing nodes by measure or attribute is the ability to conceptually capture which nodes in your network figure more prominently in terms of measures by simply gaging their size visually and intuitively.

First, visualize one of your networks. Below is the Stargate agent x event network to find the agent with expertise regarding events in the scenario.

From the main menu select Actions > Size Nodes by Attribute or Measure.

From the bottom text box I selected Cognitive Expertise. Each of the nodes in turn grows to reflect it's value from that measure.
The display now changes to reflect each node's value by size.

We'll compare two nodes: daniel_jackson and teal'c.

daniel_jackson’s cognitive expertise value is 0.2400 and is displayed with a large red circle while teal’c’s value is 0.1556 is displayed by a much smaller red circle. The values can be read in the Node Status dialog box.
### Cognitive Measure for daniel_jackson

<table>
<thead>
<tr>
<th>General Info</th>
<th>Attributes</th>
<th>Measures</th>
<th>Neighbors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>.2400</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Cognitive Measure for teal'c

<table>
<thead>
<tr>
<th>General Info</th>
<th>Attributes</th>
<th>Measures</th>
<th>Neighbors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>.1556</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Visualizer Tools

The ORA Visualizer provides a suite of tools to visually analyze your meta-network. The Visualizer Tools can be located accessed from within Visualization mode on the main menu bar (image below):

Legend : Allows for toggling visibility of nodes and links on the fly.

Drill Down : With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall Node Class knowledge, tasks, resources, agents) or by choosing individual nodes from a checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer.

Node Status : The Node Status Window is selected by default. It first pops-up when you select any node in the Visualizer. This window provides you with a snapshot of the currently selected node by displaying that nodes unique attributes, measures, and neighbors.

Attribute/Measure Viewer : Selecting an attribute will group nodes by the selected attribute. Selecting a measure groups nodes by the selected measure value.

Node Selector : You can use the Node Selector to simply complex visualizations.

Link Selector : In a complex network it may be difficult to locate one particular link. The Link Selector allows you can chose to work with One Node or Two Nodes, pick which is the Source/Target node, and the appearance of the link in the Visualizer.

Path Finder : The Path Finder allows you to focus or drill down on a particular node, or multiple nodes, that you may be interested in analyzing in greater detail.

Sphere of Influence : Each node within a network has a unique sphere of influence or ego network, essentially it's direct relationship with it's neighbors as a function of specified path length.

Backward Influence : Used to view how a node influences other nodes.

Block Maps : Block Maps display varying intensities of data by displaying "blocks" correlating to the value of data. For instance, a block map displaying node centrality values would reserve the largest block for the node highest in that value. Color is used to as well to visualize different values with the darkest color reserved for the highest value. Block Maps can also be referred to as heat maps.

Node Locator : Brings up a window with the meta-network in a collapsible tree structure. Selecting any node within this tree will highlight the node, enlarge it, and bring it to the center of the display.
Micro Simulation: Micro Simulation allows you to run some basic simulations on the currently loaded visualization. Link weights are important as once they are normalized, they correspond to the probability of a transmission.

Pie Nodes: Use multiple colors for nodes taken from attributes or measures.

Meta-Network Designer: Allows you to create, or add icon nodes, to a meta-network display. Select a nodeset then drag and drop icons onto the display.

Networks Over Time: Allows you to view a version of your network across multiple time periods.

Vector Maps:
**Attribute Measure Viewer**

The Attribute/Measure Viewer allows you to view multiple variations instantly of grouping nodes by attribute or running various measures on nodes to create meta-nodes.

We start with a meta-network containing agents, knowledge, or whatever yours contains.
Under Select an attribute: I chose gender which is one of the agent attributes. This created four meta-nodes for Male, Female, Robot, and Lacks an Attribute value. Yes, this is a science fiction dataset.

Next under Select a measures: I chose Total-degree centrality. This gave each node it's centrality value in the display regardless of nodeset. At this point we're unable to distinguish which node is which. For this information double-click on a node to bring up the Node Status dialog box.
This will display the information about the selected node. Under components it will display the nodeset and the name of the node.
**Backward Influence**

**Interface**

Select a number of Levels:

- Allow Self Links: Shows any link links from a node back to itself.
- Allow Cycles: Shows cycles that appear in the influence flow
- Allow Readjustments for Direct Paths: Options that appear in consecutive levels will be streamlined by placing nodes that occur on two consecutive levels on the further back one and sliding nodes around based on that.

**Example**

The network we use is a simple four-node network with limited links. Note that node C has no out links though others nodes have links TO that node.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>B</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>C</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>D</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

For this example we select all four nodes as well as the Allow Self Links and Allow Cycles. If you have multiple nodesets in your meta-network you can choose nodes from all of them.
Visualization Example of a Network.

Here is the example network visualized.

Select (a), Cycles, No Direct Path Adjustment (NDPA)
Degrees

1

Select (a), No Cycles, No Direct Path Adjustment (NDPA)

2

Select (c), Cycles, No Direct Path Adjustment (NDPA)

3

Select (c), Cycles, No Direct Path Adjustment (NDPA)
Select (c), Cycles, 3 Degrees

Degrees

1

2

3

Select (c), Cycles, 3 Degrees

NDPA

With Direct

3 Degrees

With Direct Path Adjustment, (a) on Degree 1 and (a) on Degree 2 merge (c) on Degree 2 and (c) on Degree 3 merge
Drill Down Wizard

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall nodeset (knowledge, tasks, resources, agents) or by choosing individual nodes from a checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer:

From the ORA Visualizer Main Menu select Tools > Drill Down.

The following window box will appear.

The top sections allows you to chose the nodes for use. The bottom tabs allow for choosing specific nodes within a set.
Drill Down Wizard Example

Using the Embassy meta-network, we will render the various nodesets using the Drill-Down Wizard Tool. The screen shot below displays the Embassy meta-network as it should first appear in the Visualizer.

From the Main Menu select Tools > Drill Down.

This will bring up the Drill Down dialog box as shown below)
Here, select the nodeset Knowledge by selecting the Knowledge check mark box. The screen shot below, displays the end result that you should now see in the Visualizer.
Next, with the Knowledge box checked, add the nodeset Task. The screen shot below displays the end result.
Next use the search bar feature of the Drill-Down Wizard to narrow the search.

Enter the word Bombing in the Visualizer search field below. Then select the check box on the bombing row. The screen should now reflect your new search parameters. Everything not associated with bombing has been turned off.
Drill Down Wizard Explained

The ORA Drill Down Wizard can be broken down into three primary sections of input:

1. **Section 1**: enables you choose individual nodesets or combination of nodesets to display in the Visualizer.
2. **Section 2**: of the Drill Down Wizard enables you to search for a particular node within your meta-network. This can be handy when you dealing with large nodesets and the one you are interested in finding is not easily located.
3. **Section 3**: enables you check mark an individual node within your meta-network by nodeset if so desired.
Drill Down Wizard

Select one or more entity sets below:

- [agent] size: 16
- [knowledge] size: 4
- [event, manual_event] size: 3
- [location, manual_location] size: 54
- [resource] size: 4
- [task] size: 5

1.

Search:

0 entity(es) selected, 06 visible, 06 total.

All

manual_location  resource  task

Agent  Knowledge  Manual Event

Entity Title  Entity ID  Class

- mohamed
- khafan_m
- mohammed
- ahmed_th
- fazul_moh
- wadih_el

Close

862
The Legend dialog box allows you to quickly hide and reveal nodes and links in the visualizer.

Use the check boxes to change a nodesets visibility. When you first call up the Visualizer all the boxes will contain checkboxes...

...and in the Visualizer all nodes and links are revealed. A little hard to make heads or tails of something like that.
By using the Legend check boxes you can selectively show/hide nodes and links. Deselect the checkbox to the left of Agent. Instantly all of the Agent nodes are hidden along with any connections they had with the rest of the nodes. The node structure is a little easier to see now.
Next think about a particular set of connexions you'd like to see, say a Task x Task network and how the agents relate to the tasks.

From the Legend box menu select Control > Hide All nodes Then again from the menu Control > Refresh Legend. Now place check marks in the check boxes for agent, task, and task x task. All the tasks will be linked together as per your network and all the agents will have connexions to the tasks they are associated with.
Another example is how knowledge relates to specific tasks. From the Legend menu select Control > Hide All Nodes. Now place check marks next to knowledge, task, and the Knowledge x Task network.
Now the Visualizer reveals which knowledge is required for which specific tasks.

The legend also reflects the size, shape, and color of the nodes in the Visualizer.
Legend Edit Menu

Below is an image of the Legend Edit Menu and a description of this tool:

<table>
<thead>
<tr>
<th>Edit</th>
<th>Control</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Copy Legend Image to Clipboard</td>
</tr>
</tbody>
</table>

Copy Legend Image to Clipboard:Copies an image of the entire legend that can be pasted into an image-editing program.

Save Color Scheme

Here is a network of agents, knowledge, and tasks.

Open a visualization. Select Node Appearance > Attribute/Measure based Options. In this example I set it to Color node(s) and color those nodes using the Centrality, Total Degree. You'll notice at the bottom of the dialog box there is a panel with the range for the measure. This can be copied and pasted into a document you're working on.
The nodes have now been colored according to the measure.

From the dialog box menu, select File > Copy Legend to Clipboard. This places a copy of the legend onto the clipboard which you can paste into your paint program of choice.
Furthermore, you can adjust any of the colors by clicking on the color well. This brings up the color picker where you can change the color of the range.
Legend Control Menu

Below is an image of the Legend Control window:

<table>
<thead>
<tr>
<th>Control</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show All Entities</td>
<td></td>
</tr>
<tr>
<td>Hide All Entities</td>
<td></td>
</tr>
<tr>
<td>Refresh Legend</td>
<td></td>
</tr>
</tbody>
</table>

Show All Nodes: Will bring into view all entities in the meta-network. Good to use if you need to make a fresh start.

Hide All Nodes: Hides every node. Good starting point when you only wish to display a small subset of nodes.

Refresh Legend: After using the menu items above and/or using the check boxes this item will bring the visualizer up to date.
Legend Node Color

The color of a nodeset can be changed in the Visualizer. In the Legend window click on the colored node of a nodeset. This will bring up a color selector box. Select a new color and click [ OK ]. All the nodes of that nodeset will change colors.

NOTE : This color change is in effect for as long as the Visualizer is open. If you close and re-open the Visualizer the colors will revert to their default colors.

Here is a section with the default colors of red for agents and cyan for tasks.

Open the Legend window (if it's not open already) and click once on the nodeset you want to change. This will bring up the Color Change dialog window.
Select [OK] and the new color will be displayed for the chosen nodeset.

The newly selected color appears in both the Visualizer and Legend windows.
Legend Context Menu

With the Legend displayed clicking on either a nodeset or a network will bring up the color picker which allows you to change the color of the node or link. But right-clicking on either of these will bring up other options.

Node Formatter

There are two ways to select nodes. 1) You can Control-Click on each node separately in the Visualizer. 2) You can use the Selector tool and lasso a group of nodes. When you have the nodes selected right-click to bring up the Node Formatter dialog box.

Appearance Tab : Controls the color, transparency, and labels of the node(s) selected.

Node Color : Control the color of individual nodes.

Match Nodeset Color : Resets the color of the node(s) back to the default color of the nodeset.

Choose a Custom Color : Click the color box. From the color the selector palette select a new color and click [ OK ]. In the Node Formatter box click [ Apply ].

Node Transparency : Set the node transparency from 0 (transparent) to 1 (visible).

Node Size : Set the node size from 4 (small) to 25 (large)

Visibility Tab : Controls visibility of nodes.

Hide Node(s) button Removes nodes from the display.

Show Node(s) button Puts the nodes back into the display. To bring back nodes of a nodeset which have been hidden you can toggle the check box in the Legend off and on and all nodes of a nodeset will reappear.

Label Tab : Set the label size from 1 (small) to 25 (large). You can also show or hide the labels of the selected nodeset.

Label Size : Change the size of the label from 1 (small) to 25 (large).

Hide Node Label(s) button Removes label from the display.

Show Node Label(s) button Puts the label back into the display.
NOTE : The Node Formatter works only with the node(s) originally selected. To change the parameters for another node(s) you must close the Node Formatter dialog box, select another node(s), then perform your changes.

**Link Formatter**

Right-Clicking on a Link in the Visualizer brings up the Link Formatter.

**Appearance Tab** : You can color the selected links by source node, target node, or pick a custom color. You also have the option of using solid or dashed lines.

**Node Color** : Control the color of individual nodes.

- **Color by Source Node** : Sets the color of the link(s) to the color of the source node.

- **Color by Target Node** : Sets the color of the link(s) to the color of the target node.

- **Choose a Custom Color** : Click the color box. From the color the selector palette select a new color and click [OK]. In the Link Formatter box click [Apply].

**Visibility Tab** :

- **Hide Link(s) button** Removes link from the display.

- **Show Link(s) button** Puts the link back into the display.

**NOTE** : If after you hide a link and close the Link Formatter dialog box the only way to bring that link back a link you have hidden is to use the menu item Actions > Show All Nodes. But remember, this will also undo any other hidden nodes and links you have.
Link Selector

In a complex network you may find it difficult to locate one particular link. This is where the Link Selector will help. You can choose to work with One Node or Two Nodes, picking which is the Source/Target node, and the appearance of the link in the Visualizer.

1. One or Two Nodes: Chose to specify links using methods for One Node (shows all nodes linked to node picked) or Two Nodes (where you specify the exact two links to use) or
2. Node Area: In One Node you pick the node and ORA shows you all the links. In Two Nodes you pick two nodes the chose one of three direction options: From First to Second, From Second to First, Goes Either Direction. This last one is handy in order to change the appearance of bi-directional links.
3. Link Area: Displays all links that meet the parameters in the Node Area. Beneath this are the [Select All] and [De-Select All] buttons.
4. Appearance/Visibility: This allows you to control the look of the links. Appearance allows you to change link color and make them dotted or continuous lines. Visibility allows you to Hide or Show links.
5. Link Color: The drop down menu has three options: Color by Source node, Color by Target Node, or Choose a Custom Color.
6. Dotted/Continuous Lines: Allows you to choose the style of line.

The Original Network

NOTE: For these examples I changed the color of the location nodes to light blue for better visibility during changes. See Legend Node Color for the procedure.
**Link Selector-One Node**

In [Area 1] Select the [One Node] tab. In [Area 2] select a node from the drop down menu. To the right select from the other drop down menu whether you want this to be a source or a target node. All links associated with this node will be displayed in [Area 3]. Click on links you want highlighted. Click the [Appearance] tab in [Area 4]. Select [Choose a Custom Color] from the drop down menu in [Area 5]. In the Color Select dialog box select a complementary color and click [OK] then click [Apply].

Example : I select the node Greedo and place checkmark in both boxes. Under the tab Appearance I select [Choose a Custom Color] from the drop down menu. A distinctive dark blue color is selected then I click [Apply].
You can further enhance this information by use of the [Make Link(s) Dotted-Lines] button.

Notice that in this example the link Greebo to Mos Eisley is a clearly defined dotted-line. The link Greebo to Han Solo is a blue dotted line but the link Han Solo to Greebo is still the default red and could obscure it in a more densely packed network.

Caution should be observed when working with a large network.

When finished you can, from the main menu, select Display > Link Appearance > Link Color and chose either Match Source Node or Match Target Node to reset your colors. Another choice is to select the particular links and change the colors via the method described above. You can also change any dotted-lines back using the [Make Link(s) Continuous LInes] button.
In [Area 1] select the Two Nodes tab. In [Area 2] select a node from both of the drop down menus. Between these menus is another drop down menu about whether you want this to be a From First to Second, From Second to First, or a Goes Either Direction. Choosing either of the first two will result in a single link. Choosing Goes Either Direction will give you one link (if the link is uni-directional) or two links (if the link is bi-directional). The links will be displayed in [Area 3]. Click on links you want highlighted. Click the [Appearance] tab in [Area 4]. Select [Choose a Custom Color] from the drop down menu in [Area 5]. In the Color Select dialog box select a complementary color and click [OK] then click [Apply].

Two nodes have been selected, Darth Vader and Luke Skywalker, with the option [Goes Either Direction]. A check mark is placed next to both links. At present both links are their default color, red.
Under the appearance tab select from the drop down menu [Choose a Custom Color]. Click the color block to the right and select a complementary color. For example, Fuchsia. Click the [Apply] button and the links then take on that color.

You can see how well they stand out now.
Notice here that a check mark is placed only next to Luke Skywalker. When the [Make Link(s) Dotted Lines] is clicked the dotted line is obscured by the continuous line from Darth Vader to Luke Skywalker.
Making them both dotted lines helps clarify the connection.
NOTE: You can also revert these changes by using the drop down menu to select Color by Source Node or Color by Target Node which will remove any custom color. Clicking [Make Link(s) Continuous Lines] will revert any selected links back to one solid link.
Micro Simulation

Micro Simulation allows you to run some basic simulations on the currently loaded visualization. Link weights are important as once they are normalized, they correspond to the probability of a transmission.

ORA Micro Simulation Overview

<table>
<thead>
<tr>
<th></th>
<th>I can give it to others</th>
<th>I keep it after sharing</th>
<th>I lose it after some time</th>
<th>I can get it back</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ideas</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Disease</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Money</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Technology</td>
<td>Yes</td>
<td>Yes</td>
<td>Sometimes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

General Thoughts on Micro Simulations

The simulations themselves are not that complex. Typically Disease, Money, and Information can be described as types of flows. At any given time point, any entity that has one of those things are going to try to give it to another node, with each flow having their own rules.

Ideas: Once an entity gets information, they cannot lose it. They also never stop giving out the information.

Disease: An entity can not re-get the disease, and an entity can only give out the disease while it has the disease. The entity can also give out a disease to multiple other entities. After a user-specified number of time periods, the entity loses the disease.

Money: Once an entity gives away the money, he cannot give the money to anyone else. There is no limit on re-getting the money.

Technology Adoption: How quickly a new technology might spread through a network.

It's important to understand how these transmissions occur. During the transmission phase, it looks at every node that has a resource. Then it iterates through all outgoing links trying to give that resource through that link (in the case of money, since it can only go through one link, we randomize the order links are tested). When looking at a link, it first does a check to see if the transmission can occur based on the link
weight. Then it does another check to see if the transmission can beat the transmission resistance.

These transmissions continue based on the rules outlined above for the user specified number of time periods. Then it generate a dynamic meta-network that shows for any given time period what entity was associated with a resource.

**Diffusion of Ideas**

NOTE: Negative weight links are ignored.

In the drop down box you are prompted to selected a Square Network for the simulation. If the nodeset you select is in multiple square networks, then all will be displayed below. Place a check mark next to the network to use.

This will create a new meta-network consisting of a single nodeset with the same nodes as the input nodeset, and a single network with the same links present in the selected networks. In the event multiple networks are selected and multiple links from node A -> node B are present, the resulting link from A -> B has a weight equal to the sum of all A -> B links.

Click [ Next ]

NOTE: Once a new meta network is created, it takes all the links and normalizes them between zero and one. The link weight then corresponds to the probability that a transmission will occur down that link. This obviously means that both link direction and link weight play a pretty important role here.
In the Node Selector box you chose a node(s) where an idea begins. I typed romana into the search box which displayed two choices. I placed a check mark to chose the romana_I node. When you've made your select, click [Next]

**Two Main Controls**

Transmission Resistance: ranges from 0.0 to 1.0. The higher the resistance the less likely a node will accept what is offered. Setting this to [0] allows for perfect transmission and the target node will accept whatever is offered.

Increase nodes size as it is hit: helps in seeing which nodes have been activated. Nodes get progressively bigger with each hit.
We'll leave the Simulation to Diffusion of Ideas. Say we don't want ideas to spread automatically but want the nodes to have a little resistance. So the Transmission Resistance it increased to 0.3. I also placed a check mark in the Increase node size as it is hit box so it will show the amount of hits a node gets.

When you are finished, click [ Next ].

Below is an animated example
Micro Simulation-Ideas

Ideas

• An agent can give away information it has access to.
• An agent retains information even after giving it away.
• An agent never looses information it gains.
• An agent never stops giving away information.
Micro Simulation-Disease

_Diffusion of Disease_

This function has two additional parameters:

Number of periods nodes remain contagious: After a node gets infected it will stay infected for a set number of periods before it then becomes immune. After that it can no longer spread the disease.

Percent nodes immune at start: You can set a percentage of nodes to be immune from the start. These nodes will be colored yellow.

_Information for Disease Simulation._

- An agent can not re-get the disease.
- An agent can only give the disease while it is infectious.
- An agent can give the disease to multiple other entities
- An agent loses the disease after a user-specified number of time periods.
Micro Simulation-Money

Dispersion of Money

This mode asks for the amount of money units to start with then makes them travel around the network. The amount of money stays constant.

• An agent can give away money it posses (all or nothing).
• Once given, an agent cannot give away the same money.
• An agent can re-acquire money previously given away.
• There is no limit to the amount of money an agent can receive/hold.
• Agents pick randomly the order of neighbor(s) to give away money to in effort to reduce endless loops.
Micro Simulation-Technology

Adoption of Technology

The Transmission Resistance determines how easily technology is adopted by the network. This is a unique simulation. A node is more likely to adopt a piece of technology if it has many neighbors trying to convince it to adopt the technology. A node is more likely to un-adopt a piece of technology if the user has fewer neighbors also using the technology.

- An agent may adopt technology if enough of its neighbors use the technology.
- An isolated agent will flip a coin to adopt a technology.
- An agent can stop using a technology, especially if its neighbors are not using the technology.
- An agent can re-start using a technology.
- An agent has a user-adjustable level of resistance to using new technology.
View Networks Over Time

The Networks Over Time loads multiple meta-networks into the Visualizer and displays them as Time Slices.

NOTE: Data that is not dated will be loaded in the order it was selected, not the order it is in the tree and not the order it was loaded in. This only happens when the data has no dates associated with it.

Procedure

Highlight the meta-networks to load into the Visualizer. For this example I divided the whole Stargate Summit network into four distinct phases. 1) The meetings; 2) What was supposed to happen; 3) What did happen; 4) The attack on the Tok'ra homeworld. These are Summit 1-4.

Start the Visualizer. Then select Tools > Networks Over Time

The dialog box appears to verify you've chosen the correct meta-networks. Place a checkbox in the ones you want or Check All. Then select [View].
To control the Over Time function from the main menu, select Tools > Networks Over Time.

The Phase Duration has two controls. Transition Phase duration sets the amount of time in milliseconds for the fading out of the previous set and the fading in of the new set. The Display Phase duration sets the amount of time in milliseconds that a set will be displayed before moving to the next set.

Constant maintains a node's position throughout all timeslices. Determined by Timeslice allows you to move a node independently in each timeslice.

Record Node Locations upon Exiting a Meta-Network maintains a node's position when changing timeslices. **NOTE:** It does not maintain the node's positions after you exit the Visualizer. Upon returning to the Visualizer all nodes will be in default positions.

The Slider bar controls which timeslice is displayed. The buttons at the bottom, [Play] and [Stop] control the motion display.

**Summit-1**

The initial meetings between the SGC and the Tok'ra
Note: You can select multiple nodes by simply clicking on them. You do not need to depress any other keys (i.e., ctrl+shift, etc.).

Summit-2

The plan as it was supposed to go
Summit-3
What really happened when Osiris showed up unexpectedly. Instead of poisoning the Summit daniel_jackson decides to forgo that action after hearing the information from Osiris. He's almost found out but still escapes.

Summit-4
What was happening back on Revanna while daniel_jackson was at the Summit.
NOTE: Measures and reports run on these multi-meta-networks are for all connexions, not the individual meta-networks.

**Time Clustering**

Time clustering is available via the Over Time dialog in the visualizer. It's a fairly simple panel - there's a ComboBox to select which period you want to cluster by (by Day, by Week, by Month, by Year), and two radio buttons to select what a week begins with (only used when clustering by week). Finally, there's a simple button to cluster.
Clusters are fairly straightforward. It looks at the start date (earliest date available in a set of timeslices) and the end, and grabs snapshots at the given interval, looking at the beginning of that interval. So, if you cluster by month, it'll move through each month, grabbing a snapshot of the 1st day. If no timeslices exist for that day, it just uses the timeslice with a date closest to that day without going over.
The Node Locator is a tool palette that allows you quickly zero in and find a node that may be obscured in a complex visualization. Essentially, when you click on a node in the Node Locator tool, the Visualizer will then pan over to the node centering on it. Below are procedures for using the node locator.

From the ORA Visualizer: Tools > Node Locator. This brings up the Node Locator dialog box. It contains to folders in it's root, Alphabetical Order and Categorical Order.

Alphabetical Order: Contains one folder for each set of nodes divided into letter groups. All nodes beginning with the same letter will contained in one folder.

Categorical Order: Divides the nodes into Node Categories. There were four nodesets in this example and it created four folders under Categorical Order.

Notice how the nodes for accounts_payable and also for accounts_receivable appear in both areas.

Selecting a Node

Whenever you select a node in the Node Locator dialog box that node will be highlighted. Since it's hard to see with a white background this example uses the black background. Notice the white circle around the accounts_payable node.
denoting it has been selected. If you select a new node the previously selected node will return to normal and the new node will be highlighted.
**Node Selector Tool in Visualizer**

*Note: A slightly different version of this tool is available in the ORA Main Menu interface (i.e., non-Visualizer tool).*

You can use the Node Selector to simply complex visualizations. The Node Selector tool is accessible from the Visualizer menu: Tools > Node Selector.

![Node Selector Tool in Visualizer](image)

**Node Selector**

Search: Displays only nodes which have matching content. To the right is the AND/OR dropdown box where you can select whether to make ORA search for entries with all terms in the box or terms in the box.
Node Class tabs: Contains a tab for each nodeset class in a meta-network.

Node Display Area: Displays all the nodes for the currently active tab. The checkbox to the left allows you to select/deselect nodes to work with.

Select Visible/Un-Select Visible buttons: These affect all nodes currently displayed in the Node Display area. Placing a check mark checks (selects) all visible items and removing a check mark (deselects) all items visible.

**Visibility**

Show Only Checked Items: Shows only nodes which have a check mark next to their names.

Show All But Checked Items: Shows only nodes without a check mark next to their names.

Add Checked Items: Adds to the visualizer display (if they are not already visible) any nodes which have a check mark to the left of their names.

Remove Checked Items: Hides in the visualizer display (if they are not already hidden) any nodes which have a check mark next to their names.

**Node Location**

Move to the Left: All selected nodes will be moved to a column to the left side of the screen.

Move to the Right: All selected nodes will be moved to a column to the right side of the screen.

**Node Appearance**

Show Label(s): Works in co-ordination with the [Set Labels] button and all selected nodes. Will make the labels visible (check marked) or hidden (no check mark).

Set Labels button: Clicking this button activates your choices with the Show Label(s) option.

Node Color: Brings up a color palette to choose a color.

Change Color button: The color of any node(s) selected will be changed to the new Node Color.
Other

Create Meta-Node: Creates a meta-node from all selected nodes.

Highlight Checked Items: Draws an outline around all nodes selected. This functions with nodes of all sizes.

Node Selector Examples

Following is a short example of the KeySet Selector. It covers the main aspects of the tool only.

In the Filter Commands text box the word poison is typed which causes all nodes with poison in any attribute to be revealed. Pressing the [Select All] button places a check mark in all the nodes. Lastly in the Visualizer Commands pressing the [Show Only Checked Items] button hides all but the checked items.

The [Clear All] button is pressed to clear all the check marks. poison is replaced in the Filter Commands with the word sg-1. Be aware that even though only nodes with sg-1 are to be added the two nodes with sg-17 also appear as sg-1 is a sub-string of sg-17. So instead of using the [Select All] button check marks are manually placed in the check boxes desired.

The [Add Checked Items] button is pressed and the four new nodes are added to the visualizer.
With the four nodes of sg-1 still check marked press the [ Highlight Checked Items ]. The four nodes are now displayed in a larger format.

The last button, [ Create Meta-Node ] will cull nodes into a meta-node.

**Move Left/Right**

If a set of nodes needs "pulled out" of the display the Move Left/Move Right buttons can help. Below is a normal display. The nodes for SG-1 are quite difficult to see.
From the Node Selector dialog select the nodes to be highlighted and place a check mark in the box.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>Class ID</th>
<th>Class Type</th>
<th>pos</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
<td>Agent</td>
<td>Agent</td>
<td>Sg-</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam...</td>
<td>Agent</td>
<td>Agent</td>
<td></td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
<td>Agent</td>
<td>Agent</td>
<td></td>
</tr>
<tr>
<td>A04</td>
<td>teal'c</td>
<td>Agent</td>
<td>Agent</td>
<td></td>
</tr>
</tbody>
</table>

Press the [ Move to the Right ] button. This brings the selected items toward that side of the display.
Pressing the button again will move the selected nodes farther in that direction.
Node Status

The Node Status Window is used to reveal pertinent information about one selected node. The window can be brought up by either selecting it from the main menu, Tools > Node status or by double-clicking the node in the Visualizer. The dialog box below will appear.

![Node Status Window]

The top of the box will contain general information about the selected node. Underneath there are five tabs available which will display the node's information. You can switch nodes by selecting any other node in the Visualizer. ORA will automatically change the display.

The Node Title: box allows you to change the title of the selected node.
**Tabs**

Neighbors: Displays the nodes which are linked to the selected node. It also displays the weight of each link.

Sources:

URIs: If there are any URIs attached to the node they are displayed under this tab.

Attributes: Types and values of all attributes are displayed under this tab.

Measures: If measures were run on the meta-network their values are displayed under this tab.

**Attribute Button**

This dialog box allows you to add attributes to a node. Click the [Add Attribute] button.

![Add Attribute](image)

The dropdown menu on the left contains all the current attributes for the node. You can select a preexisting attribute, enter a value, and click the [Add Attribute] button.

This also allows you to create New Attributes. Scroll down to the bottom of the drop down menu and select <Enter New Attribute ID:>, enter a value, and click the Add Attribute button. Your new attribute will appear in the meta-network.

**Show This Window Check Box**

When a check mark is placed in this box it causes this dialog box to appear whenever you click a node in the Visualizer.
Path Finder

The Path Finder is used to find, not only, the shortest path between two nodes but also paths to other nodes when particular situations occur. Below is an image of the Path Finder tool and a description of its various elements.

Interface Structure
The interface contains four sections:

Start node: Select the nodeset/node to begin the path.

End node: Select the nodeset/node to end the path.

Options: Options regarding link parameters and which nodesets to use.
Advanced Options: Options regarding whether, and how, to use one particular node within the nodeset.

**Using Only Agent Nodes (Tolerance = 0)**

Using only the Agent nodeset the pathway requires three intervening nodes.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samant...</th>
<th>daniel_jackson</th>
<th>teal'c</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>5.0</td>
<td>0.0</td>
</tr>
<tr>
<td>maj_samant...</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>-1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>-1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>teal'c</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>-5.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

NOTE: For this example the values in the network have been altered from the regular values.

**Tolerance Of "1", Nothing Else Checked**

**Shortest path: 1**

There is the direct link from gen_hammond to col_jack_o'neill and the secondary pathway with teal'c in the middle.

**Use Link Direction**

**Shortest path: 2**

The path direction must lead from the source to the target.
The link from gen_hammond to col-jack-o'neill is removed as it's a directional link in the wrong direction. The shortest link is "2".

**Use Link Weight (Remove Links with Negative Values)**

**Shortest path:** 6

Use link weights finds the shortest path from A to B using minimal weights as opposed to minimal number of links. Also the shortest path is the total of the link weights — not the number of links total.

![Diagram](image)

The shortest path is from col_jack_o'neill to teal'c (5) then from teal'c to gen_hammond (1) for a total of "6".

**Use Link Weight (Convert Negative Links to Positive Values)**

**Shortest path:** 3

Uses the absolute values of numbers. A negative number becomes a positive number.

![Diagram](image)

**Use Link Direction and Link Weight with Absolute Values**

**Shortest path:** 3
**Pie Nodes**

You can color nodes with individual colors based on measures or attributes. From the Visualizer Main Menu select Tools > Pie Nodes. This brings up the Pie Nodes dialog. You can select up to four values to color your nodes each using either a measure or an attribute. The bottom section shows the values which correspond to the colors.

When you have your values selected and whether they will be attributes of measures, click the [Run] button.

The nodes will change colors depicting the amount of values you chose. Notice that Value A is represented in the top right and continue in a clockwise direction.
These values can be altered and redrawn by clicking the [ Run ] button.
**Sphere of Influence/Ego Network**

The Sphere of Influence tool shows how a selected node (ego) or nodes are interconnected connected to other nodes (alters) within a specified distance (along with the connections to/from the ego and alters) by displaying only the ego and the alters (the ego’s sphere of influence). The tool allows the user to specify ego node(s) and to control the size of the sphere of influence. The user may also specify the type of links used to define connections and the display appearance.

NOTE : By convention, when a one-mode data is used, a single ego is selected, and the distance is set to one, the resulting meta-network is referred to as an ego network rather than a sphere of influence.

It is important to understand that a Sphere of Influence is similar to Reverse Influence but not identical. Sphere of influence ignores directionality and looks at both in and out degrees for each node. Sphere of influence answers the question "What other nodes are connected to the ego network". By using both in and out degrees it finds the sphere surrounding a node. Cycles are an endemic part of a sphere of influence and are not highlighted.

Reverse Influence only looks at the in-degree and answers the question what nodes influence the ego node. As such, cycles can be critical, leading to never ending chains, as when A influence B, B influences C and C influences A. The cycle and self-loop options enable the user to stop backward chaining when a loop or cycle is encountered.
Sphere of Influence

Each node within a meta-network can be used to create a Sphere of Influence or Ego Network. Essentially this network shows the direct relationship of the ego with its neighbors (alters) where the neighbors are those nodes within of specified path length. The ORA Visualizer allows you to focus on this relationship by creating an Ego Map centered on any particular node you choose. This mapping ignores directionality and counts equally both in and out degrees it finds to the sphere surrounding the node. Cycles are an intrinsic part of a sphere of influence and are not highlighted.

Procedure

The Sphere of Influence (Ego Network) dialog can be opened in the main interface or the visualizer. In the ORA main interface, select a network then use the pulldown list on the [Visualize▼] button (click the down-pointing triangle) then select Network Visualizer > Sphere of Influence, or when a meta-network has been visualized, use the Visualizer's Main Menu to select Tools > Sphere of Influence.

The following dialog box will then appear. From here you can select the size of your sphere's influence, the nodesets, and key sets to use.
Use this window to view the sphere of influence (ego network) of nodes. Select one or more nodes from the list below.
Sphere of influence radius - Set the radius (path length, distance) for the sphere of influence using the numeric spinner. All nodes with a shortest path value less than or equal to the radius value will be included in the sphere of influence.

Example spheres of influence with a radius of 1, 2, and 3. The ego node is circled.

Tab Area

The tab area allow the user to adjust the inputs used in computing the sphere of influence and the appearance of the visualized network.

Options Tab
Zoom options The following two items are mutually exclusive:

Auto-Zoom - Check to cause the view to expand or contract to fit the visible nodes.

Auto-Center - Check to move the selected node to the center of the window.

Hide connections between levels - Check to display all of the links between the alters of the selected node. If not checked only links directly on the shortest path to the selected node will be displayed. Generally, sphere of influence/ego networks are presented with connections between levels hidden.
The top image has connections hidden. The bottom image has connections visible.

Hide nodes not connected to all selected notes - Check to only show the nodes that are in every sphere of influence. This is similar to the intersection.

Use out-links to determine adjacency - Check to use out-links from the ego node when finding adjacent nodes.
Use in-links to determine adjacency - Check to use in-links to the ego node when finding adjacent nodes.

Nodesets Tab

Use only these nodesets to compute the sphere of influence:

- Agent
- Task
- Organization
- Location
- Knowledge
- Role
- Resource
- Action
- Belief

Use only these nodesets to compute the sphere of influence - Select the nodesets that can be included in the sphere of influence network. Checked nodesets are available for inclusion in the computed sphere of influence. Unchecked nodesets are not used and corresponding networks shown under the Networks Tab will also be automatically deselected. (Selecting a nodeset will cause the corresponding networks to be selected under the Networks Tab.)

Networks Tab

Use only these links to compute the sphere of influence:

- Agent x Agent
- Task x Task
- Knowledge x Knowledge
- Location x Location
- Agent x Knowledge
- Role x Role
- Organization x Organization
- Action x Action
- Resource x Resource
- Agent x Location
- Belief x Belief
- Agent x Role

Use only these links to compute the sphere of influence - Select the networks whose links can be included in the sphere of influence network. Checked networks are
available for inclusion in the computed sphere of influence. Unchecked networks are not used. If all networks for a given nodeset are deselected then the corresponding nodeset shown under the Networks **Tab** will also be automatically deselected. (Selecting a network will cause the corresponding nodeset(s) to be selected under the Nodesets **Tab**.)

---

**Ego Selection Area**

NOTE : If the Sphere of Influence (Ego Network) dialog is opened though the ORA main interface (using the pulldown list on the [ Visualize ▼ ] button then clicking the down-pointing triangle then selecting Network Visualizer > Sphere of Influence), the [ Run > ] and [ Close ] buttons will be present as shown above and will function as described below. If the dialog is activated through the visualizer (using the Visualizer’s Main Menu to select Tools > Sphere of Influence) then the buttons will not be present and selecting a node will cause immediate updates to the visualization (no additional views will be created).
Select one or more nodes from the list below. - You must select at least one node as the ego node prior to creating a sphere of influence. Multiple nodes are allowed. The selected node(s) are used as ego nodes and their sphere of influence is calculated. All selected ego nodes are shown in a single visualization. Note that you may select a node even if the nodeset is deselected under the Nodesets Tab. In that case, selected ego node(s) will be displayed but unselected nodes in the nodeset will be ignored in determining the sphere of influence.

The All Nodes Tab lists all nodes on a combined list. The remaining tabs list nodes by their nodeset names. Select the desired tab, then select individual nodes.

The options below apply to nodes directly:

Select ego nodes by checking the box options at the left. At least one of the listed nodes must be selected.

Standard searching and filtering are available to assist in selecting nodes:

**Searching**

- **Text Entry Field** - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the list of nodes. Use quotation marks to search for a phrase (spaces are treated as part of the search). All fields are searched.

  [ Contains ▼ ] / [ Equals ▼ ] - This button controls the text match policy. Contains matches all lines which include the string in any position. Equals matches only complete words.

**Selecting**

- **Individual Selection** - To select individual nodes, place a check mark in the left-hand box.

- **Multiple Selection** - To select multiple nodes, use the controls at the bottom of the Editor pane:

  Select/Clear All : Checking this box selects all nodes (whether a node is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselected all nodes.

  Select/Clear Visible : Checking this box selects visible nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after
a search are \textit{not} selected). This permits selection of all nodes found by a search. Unchecking the box deselects just the displayed nodes.

\textbf{WARNING :} When the [ Run ] button is not available, avoid using the Select/Clear All option for large nodesets. The automatic computation of ego networks when all nodes are selected may take a considerable time to complete.

\textbf{Sorting} - The displayed list of nodes can be sorted by clicking on an attribute column header label, which sorts the list based on the column entries (the sorted column will show \textup{↑} or \textup{↓}, depending on the sort direction). The initial sort direction is alphabetical (i.e. A-Z). A second click sorts the list in reverse alphabetical order (i.e. Z-A). Clicking a different column header will re-sort the list based on that column's content.

\textbf{Filtering} - Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu. The filter menu supports two types of filtering:

\textbf{Standard} - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.

\textbf{Custom} - Checking the Define a custom filter: option allows a user specified search. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The type of search depends on the type of data contained in the column (text or numeric).

For a short tutorial on search features, including additional options, see \textbf{9.2 Searching, Sorting, Filtering and Selecting Nodes} on the QuickStart Main Interface page.

\textbf{NOTE :} The following step is only available when the dialog is invoked through the main ORA window (using the pulldown list on the [ Visualize ▼ ] button and clicking the down-pointing triangle then selecting Network Visualizer > Sphere of Influence).

After entering all input options, click the [ Run ] button to create the sphere of influence visualization. The dialog will remain open to permit computation of additional spheres of influence (in separate visualizer windows). When all desired spheres of influence have been visualized use the [ Close ] button to cancel report generation.)
Rings

What Are Node Rings in the Visualizer?

Rings help you keep track of which nodes have been selected in a sphere of influence. Right-clicking on a node allows you to toggle the ring on and off.

They're not much more than rings around a node but rather they are used to help accentuate node(s) amongst other nodes. Currently, the only use they have is for sphere of influence, where the node(s) whose sphere of influence we're looking at get a ring around them.
Visualizer Layout Menu

Run Active Layout: Turns on the motion and allows ORA to attempt to sort out the positioning of the nodes.

Stop Active Layout: Turns off the motion and stops all nodes from moving. This allows you to move individual nodes around without disturbing the rest of the meta-network.

Spring Embedded Layout: This layout operates fine in datasets of approximately under 500 nodes. Much higher than that and the layout gets sluggish. A single layout iteration could take two minutes or longer. Not really practical.

Spring Embedded (with enhancements for large data): The enhanced layout with large datasets. It uses the same basic algorithm but has some optimizations built in. With 10k nodes or so, a single layout iteration takes 10 seconds or so.

It treats large clusters of nodes as blocks to help in reducing computations. In decreases the time for the final computations but the display loses flexibility in the process.

NOTE: Now you’re probably asking “if this new algorithm is so good, why not keep it on all the time?” Reason: If you pick up and drag a node, and as such drag an entire meta-network, the display will look jittery and confusing. So, whenever you load in under 500-nodes, the normal version is enabled. More than that, it uses the enhanced version.

Run MDS Layout: The purpose of Multidimensional Scaling (MDS) is to provide a visual representation of the pattern of proximities (i.e., similarities or distances) among a set of objects. Given a matrix of perceived similarities between objects, MDS plots these on a map such that those nodes that are perceived to be very similar to each other are placed near each other on the map, and those nodes that are perceived to be very different from each other are placed far away from each other on the map.

Run Tree Layout: This is a hierarchical style which attempts to find the root node (a node with an in-degree of 0). It then builds the network down from there.

Run Circle Layout (Pendants to Outside): Takes all pendants and puts them in a circle. All Nodes connected to a pendant are on a circle inside the pendant circle. Repeat until all nodes are in some circle, with the inner most nodes being the farthest from any pendant.

Run Circle Layout (Center is High Betweenness): Calculate the Centrality-Betweenness for the graph. Take the node(s) with the highest value. Place them in the center. All nodes connected to those nodes get put on a circle surrounding
the center. Repeat as necessary.

**Run Circular Layout for Groups:** NOTE: You must set Meta-Nodes > Meta-Node Appearance > Show Component Node Membership for this to display properly.

**Run Hierarchical Layout:** Tries to layout the network in a pyramid formation so that all arrows either point up or point down.

**Run Box Layout:** More of a Polygon Layout, really. You select 1-4 groups of nodes (either by nodeset or by nodeset class). Each group is then laid out as one edge of a polygon. 1 Group = circle, 2 Groups = 2 parallel lines. 3 Groups = Triangle, 4 Groups = square

**Attribute/Measure Layout:** Uses the input attribute and/or measure as the x,y coordinates of the nodes.
Hierarchical Layout

The Hierarchical layout option allows for two different layout styles.

The Pyramid style looks at level 0 as being the peak of the pyramid. Level 1 being the one beneath that, and so on. A level's width is equal to the level number (with the distance between levels being a constant). This gives it the appearance of a pyramid. This is the one that's been implemented for ages now.

Variable style Variable Style is similar in that the distance between levels is still constant, but the width of a level is now variable. Instead of being based on the level number its based on the number of nodes in that level. If you look at top-heavy networks, you'll learn the appeal of this layout.

You will be prompted for a square network (including the Visible meta-network, since technically it's square), and then for a node to use as the peak node.

Finally, you must choose the desired build direction. This refers to Link direction, since a link could mean reports to just as easily as it could mean commands.

NOTE : This layout typically works well with non-circular networks. i.e. networks were links have links going only one direction. Using circular layouts can create problematic displays.

Regular Layout : showing links between resources and the office staff.
**Automatic**

The Automatic buttons will take the most direct path in creating a hierarchy. Whichever node has no links out will most likely become the top node. You can chose [ Auto Layout (Top to Bottom) ] or [ Auto Layout (Bottom to Top) ].

Arrows always try to maintain their direction meaning, in the event of cycles, for example, we try to minimize the number of arrows that go "against the current", so to speak. It will also warn you should you try to input a symmetrical network, as those don't really have bosses or subordinates.

Hierarchical Layout (Top to Bottom) : which places both staff and resources in a top to bottom pyramid. This view makes it much easier to detect which resources are used by which staff member.
Automatic - Ignore Link Direction

Automatic - Ignore Link Direction Layout: Allows you to chose the node you want at the top. Notice in the image the direction of the arrows are not in the same direction.
Automatic - By Attribute

This layout is based on the attributes of the nodes. It requires all relevant nodes to have some number-based attribute. The lower the value of the attribute, the higher in the hierarchy it will be. Think of 0 as being the top, level 1 is one below, and so on.
Box Layout

Run Box Layout: This layout allows you to choose from one to four node subsets and will arrange them depending on how many are chosen. The default is to use individual nodesets. This would allow you to choose different agent nodesets for different sides of the shape.

Use Node Types

Using this option allows you to choose all nodesets which are the same nodeset class, e.g., all nodesets of the nodeset class agent, at the same time. It selects all of them for a single side of the shape.

Regular Layout

Here's a meta-network as originally displayed in ORA.
Box Layout (Two Nodesets)

Running the Box Layout lines up the nodeset classes opposite each other with their links displayed between them.
Box Layout (Three Nodesets)

Adding a third nodeset class would form a triangle with each nodeset class on one of the three sides.
Circle Layout (Pendants to Outside)

Run Circle Layout (Pendants to Outside):

Regular Layout

Circle Layout (Pendants to the Outside)
Here we see the spreadsheet and the desktop computer are at the center of the circle as they have multiple connections. You can also see the pendants (executive washroom, laptop, catered lunch, corner office, leather chair, and blackberry) comprise the outer circle. Lesser connected nodes drift to the outer circle.
Circle Layout (Center is High Betweenness)

Run Circle Layout (Center is High Betweenness):

Regular Layout

Circle Layout (Center is High Betweenness)
This example shows how the Office Manager is the most connected node being responsible for two nodes under him and reporting to the CEO.
Circular Layouts for Groups

Used to display meta-network done in various grouping styles.

NOTE: You must have Meta-Nodes > Meta-Nodes Appearance > Show Component Nodes by Membership for this to display correctly.

Newman: Used to find clusters in a network.

Girvan-Newman: This is a hierarchical clustering method where all nodes start off in the same group and are split off into new groups based on maximum betweenness scores.

MST:

Cliques: The number of distinct cliques to which each node belongs. Individuals or organizations who are high in number of cliques are those that belong to a large number of distinct cliques. A clique is defined as a group of three or more actors that have many connections to each other and relatively fewer connections to those in other groups. The scientific name of this measure is clique count and it is calculated on the agent by agent matrices.

CONCOR: Concor recursively splits partitions and the user selects n splits. (n splits -> 2n groups). At each split it divides the nodes based on maximum correlation in outgoing connections. Helps find groups with similar roles in networks, even if dispersed.

Johnson: This is a hierarchical clustering technique based on a Similarity Standard hierarchical approach that builds groups based on similarity scores.

K-Means: This clustering aims to partition n observations into k sets (k ≤ n) S = {S1, S2, .., Sk} so as to minimize the within-cluster sum of squares.

K-Fog: Works with either one-mode or two-mode networks to form nodes into groups (clusters or communities) and show which nodes share the secondary functions.
Procedure

From the main menu select Meta-Nodes > Create Meta-Nodes by Node Class. All nodes of one nodeset class are now represented by one meta-node. But you have no information about the individual nodes within each meta-node.

From the main menu select Meta-Nodes > Meta-Node Appearance > Show Component Node Membership. This will display the individual nodes for each meta-node.
**Attribute/Measure Layout**

Once you create a specific visualization there are ways to save the information so that you can use it in the future. From the Visualizer menu select Layouts > Attribute/Measure Layout.

![Attribute/Measure Layout Dialog](image)

Use this dialog to layout nodes by two attributes: one for the x-coordinate, and one for the y-coordinate.

Click **Save layout** to save the current node positions back into the specified attributes.

**X-Attribute**
- Attribute
- Measure

Select x-coordinate attribute: correspondence Analysis Dim 1

**Y-Attribute**
- Attribute
- Measure

Select y-coordinate attribute: correspondence Analysis Dim 1

[Close] [Save Coordinates] [Run Layout]

---

**Placement of Nodes**

When you have the nodes of your network you can save your coordinates for a future session. The layout will mirror the positions you were using at the time of the saving.

Set the X-Attribute to X-Axis and the Y-Attribute to Y-Axis and click [ Save Coordinates ]. The next time you need to work with this layout set the X and Y Attributes back to the Axis attributes and click the [ Run Layout ] button.
Node Color

After coloring nodeset classes, and even individual nodes, you can save these colors as an attribute. From the Visualizer menu select Node Appearance > Node Color > Save/Load Node Color to/from Attributes, which allows for saving and loading node colors.

NOTE: In less new versions, the same functions are stored under Node Appearance > Node Color > Save Node Color to Attributes and Node Appearance > Node Color > Load Node Color from Attributes.

Full Image

NOTE: Early Prototype Version

There is an early prototype for visualization saving called the ORA-PNG. This encodes node visibility/color/layout inside the image that gets saved.

Save a visualization using File > Save Image to File... and select the ORA-NetScenes-PNG format. Close your visualization and meta-network. Reopen your meta-network then visualize it as normal. Drag/Drop the ORA-PNG into the visualizer, and it should load in.
**Meta-Nodes**

A meta-node contains multiple nodes collapsed into one. You can create meta-nodes based on the nodesets in your organization, or you can create meta-nodes based on the attributes of the nodes. From the main menu select meta-nodes. This brings up the meta-node dialog box.

**Menu**

**Meta-Node Appearance**

- **NOTE**: To view these options you must create meta-nodes first.
- **Hide Component Nodes**: Resets these to their defaults
- **Show Component Node Membership**: 
- **Show Component Node with Bounding Box**: 
- **Show Component Node with Bounding Polygon**: 
- **Compute Meta-Link Weight By......**: 
  - Proportion of the maximum possible links: Takes the total number of links in the meta-nodes and divides this by the total possible number of links.
  - Absolute count of links: Counts any link from any node in the meta-nodes to any other node as 1.0. Uses this as the total
  - Block model links and weights: Uses two terms. A) The Proportion of the maximum possible links (as calculated above); and B) The total number of links in a meta-network divided by the total number of possible links in a meta-network. If (A) is higher than (B) then the value used equals (A). If (A) is lower then the value is 0.
- **Pin All Meta-Nodes**: Immobilizes all nodes in place.
- **Expand All Meta-Nodes**: Restores all nodes to individual display.
- **Color Nodes by Meta-Node Membership**: Colors the meta-nodes to the nodeset color set by the meta-network.
- **Increase Link Rigidity Between a Meta-Node's Component Nodes**: In a meta-node, there are nodes. If a link exists between a pair of nodes in the same meta-node, that link has its rigidity increased so that when meta-nodes are expanded/destroyed, the nodes in the same meta-node will band together via the layout.
Create Meta-Nodes by NodeClass: Creates one meta-node per NodeClass.
Create Meta-Nodes by Node Association: After selecting a nodeset will create meta-nodes and their connections.
Create Meta-Node by Grouping...: Allows you to choose from any of the installed grouping schemes.
Create Meta-Node by Attribute/Measures: You can create meta-nodes using either any attribute or collected by measure value.

Meta-Nodes...: Calls up the meta-node dialog box.
Meta-Nodes Basics

**Display Meta-Node in Own Window**
Right-Click on a meta-node in the Visualizer and select Open Meta-Node Components in New Visualizer. This allows you to view the contents and connections of a meta-node on its own.

**View Meta-Node Information**
This item displays in a box all the information for the selected meta-node including:

- Meta-Node Details: The Id, Label and Type
- Meta-Node Density:
- Component Nodes: The Ids, and Titles of all contained nodes
- Component Edges: The Source and Target of every Link.
The dialog box consists of four sections:

Expand all meta-nodes: Returns to the default display

Select how to create links: see main page above for more details.

Meta-Node Creation: Choose from creating by Node Class, Most Recent Grouping, Attribute, or Multiple Attributes.

Select an attribute: Choose an attribute from any nodeset. Only those nodes connected to those attributes will be displayed.
Base Meta-Network Display

First call up the meta-node dialog box from the main menu Meta-Nodes > Meta-Nodes which will display the dialog box shown above.

Create by Attribute

Make sure the section, Select an attribute: is visible. If not then click the [ By Attribute ] button. In the drop down select an attribute. The display will create meta-nodes corresponding to your choice. Below I chose my attribute gender.

Show Nodes by Meta-Nodes

By itself this is of little use. To reveal the nodes which are contained in these meta-nodes use the function Meta-Nodes > Meta-Node Appearance > Show Component
Node Membership. Now there are two meta-nodes with the pendants being the nodes associated via that attributes.

**Reset**
I reset the display with Actions > Show All Nodes to display all nodes.

**Funnel Nodes Without Attribute**
Another important function in the Meta-Node Dialog is the check box, Funnel nodes without this attribute into a new meta-node. Instead of just hiding any node without information in the specified attribute these nodes will become part of meta-node labeled None. To funnel these nodes place a check mark in the box near the bottom of the dialog box.

Here I change the attribute to robot and any node with Yes in that attribute belongs to the Yes meta-node. All others without a value in that attribute are grouped within the None meta-node.
But in this instance it's rather unwieldy, and unnecessary, to show all the nodes as the only nodeset with this attribute is the Agent nodeset. Using the Legend you could deselect any nodeset. Here I deselect all except the Agent nodeset.
Multiple Attributes

Click the [ By Multiple Attributes... ] button to call up the dialog box. From the drop down menu choose an attribute (e.g. gender). This gives the two regular attribute choices, male or female, and a third choice - Lacks an Attribute Value. This will collect any node which does not contain a value for that attribute.
Place a check mark in all the boxes you want to use. For this I marked all three. Then click the [Create Branch] button.

The left hand box now display how the meta-nodes will be created. Click the [Create Meta-Nodes] button.

NOTE: For easier viewing I made only the three meta-node names visible. Then I double-clicked on them and used the Node Status box to rename them.
This collects all nodes, no matter what their nodeset class, into the None meta-node.

If you give each node one or more attributes then you can change the appearance of nodes based on the attributes. Illustrative attributes are gender (female, male) or the type of organization (hierarchy, matrix, team…).
Meta-Node-Create by

Using the By Node Class button separate all nodes into meta-nodes based on their node class.

Start by Visualizing a Meta-Network.
Create Meta-Nodes by Node Class

This creates one meta-node per node class in your meta-network.

Create Meta-Nodes by Node Association

Choose a nodeset for display. The meta-nodes consist of all nodes with a connection to any of the nodes in that nodeset. These components can be found by double-
clicking any meta-node to bring up the Node Status dialog. Click on the Component tab and the sub tabs will display which node classes contain any nodes within.

**Create Meta-Nodes by Grouping**

![Diagram](image)

Creates meta-nodes based on the grouping style chosen. The meta-nodes consist of all nodes with a connection to any of the nodes in that nodeset. These components can be found by double-clicking any meta-node to bring up the Node Status dialog. Click on the Component tab and the sub tabs will display which nodeset contain any nodes within.
Node Status Example

The Node Title will reflect the meta-node chosen with the information below it containing other relevant information. The tabs contain the rest of the information for the meta-node.
Meta-Node Appearance

Meta-Nodes by Component Nodes
This is similar to the Create Meta-Nodes by NodeClass. The center of the cluster is the meta-node and the pendants are the individual nodes.

Meta-Nodes by Bounding Box
This shows all nodes in a meta-network with the meta-node names displayed near the meta-node. All nodes in that meta-node are contained within their box.
Meta-Nodes by Bounding Polygon

Each meta-node is contained within their individual colored polygons.
Other View Styles
There are many ways to display your network in ORA. Below are a few examples showing the diverse styles available

By Organization
Organization with Components

Links To A Meta-Node
Links To Other Meta-Nodes
Group Viewer

The Group Viewer helps separate nodes into distinct groups.

We'll use one of the networks for each of the groups to further examine the breakdown.

There are six groupings which can be called up:

Clique :
CONCOR :
Johnson :
Newman : Used to find clusters in a network.
FOG :
Alpha-FOG :

ORA implements the Newman algorithm presented in the following paper:


The algorithm uses link weights. It is not the Newman-Girvan algorithm based on betweenness centrality.

Note : Newman developed this algorithm as it scales better than the Newman-Girvan for large networks.
The Newman grouping is used to find clusters in a network. I began increasing the number of groups to view until the larger cluster began to break up. Newman's Algorithm starts with each node as its own group, and then combines groups in a hierarchical manner until only one group remains (e.g. it is agglomerative hierarchical clustering). At each step, which two groups to merge is based on what will maximize the modularity value - or group community structure value.
Newman with 4 groups

In the Group Viewer window set the Number of groups to view: to 4.
The Newman grouping is used to find clusters in a network. I began increasing the number of groups to view until the larger cluster began to break up.
Newman with 10 groups

Newman with 4 groups - Colored

Ora can also color-code each group for easier viewing.
Group Viewer-Girvan-Newman

Description

Girvan-Newman is divisive hierarchical clustering (all nodes start off in the same group and groups are split until each node is its own group). Groups are split by choosing from the edges that remain the one with the maximum edge betweenness score.
Girvan-Newman with 4 groups

In the Group Viewer window set the Number of groups to view: to 4.
The defaults for Cliques for this network are set to Minimum clique size: 3 and Number of groups to view: 25. This produces an unreadable display. Increase the number of groups until the number of groups becomes viewable. In this case Minimum clique size: 6 and Number of groups to view: 5.
Examining a Meta-Node

To view a list of the components of a meta-node, double click the node. Select the Components tab for a list of the nodes.
Node Status: 1

Node Title: 1

Nodeset is "Meta Nodes"
Node Class is "Meta Nodes"
0 Inks
Contained nodes: 7

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Measures</th>
<th>Neighbors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sources</td>
<td>URI</td>
<td>Components</td>
</tr>
<tr>
<td>Characters</td>
<td>Locations</td>
<td></td>
</tr>
</tbody>
</table>

Component:
- Agent::Luke Skywalker (18)
- Agent::Obi-Wan Kenobi (12)
- Agent::R2-D2 (18)
- Agent::Han Solo (13)
- Agent::C-3PO (18)
- Agent::Chewbacca (14)

☐ Show this window when a node is selected
Group Viewer-CONCOR

Below is an image of the Group Viewer window and procedures for using this tool. This is a Structural Equivalence/Clique which can be used on one or two mode data, and one or a set of networks at once.

Parameters

Use out-links (matrix rows)? The links leading out of the chosen node into another node.

Use in-links (matrix columns)? The links leading into the chosen node from another node.

Number of groups to view:
The example uses the network Star Wars dataset. For each of the three possibilities in, out, both the display is shown with the number of groups set to 4. The resulting displays show how the in and out links affect the groupings.
Use Out-Links
Use In-Links

Use Both In-Links and Out-Links
Group Viewer-Johnson

Below is an image of the Group Viewer Johnson window and procedures for applying the Johnson algorithm. This is a Hierarchical Clustering based on Similarity Standard hierarchical approach that builds groups based on similarity scores.
Group Viewer-Alpha-Fog

Alpha-Fog is similar to K-Fog in it clusters nodes into groups. The difference between the two is Alpha-Fog is used when the analyst is not quite sure of the number of groups.

The trade-off between K-Fog and Alpha-Fog is accuracy vs. insight.

The Alpha-Fog dialog box

Parameters

The dropdown menu contains all the networks in the meta-network. After selecting a network ORA will display the two nodesets in the network below in a set of radio buttons. Select one to display. The other will be used as the tasks set.
**Alpha Value (0-1):**

The slider bar controls the alpha-value. It defaults to 0.5. You can manually move the slider right or left then press [Compute].

Below the slider are three buttons, [Left], [Zoom Out], and [Right].

- Pressing the Left button will reset the three values. The left value will remain the same, the right values will be reduced by half, and the middle value will be the value somewhere between the two. Each press of the Left button will repeat the sequence. Pressing the Right button will do the same, but in the opposite direction.
- The Zoom Out button reverses the above procedure in the exact order (i.e. if you pressed Left, Right, Right, Left, and Left the Zoom Out button would undo then as Left, Left, Right, Right, Left).

The buttons at the bottom control the display. The [Compute] button uses the current alpha value and re-display the network. The [Reset button removes all groups and resets all the nodes to default. The [Close] button closes the dialog box.

Below is the initial display using the default of 0.5. It doesn't really tell us much about the grouping of the network. There are some groupings but there are also four groups with one node only and many small "almost" groupings. Also all the links are the same weight which does not indicate the leader of any group.

![Network Diagram](image)

Setting the slider bar to 0.0 groups all the nodes into a single group. This contains the opposite problem as there is only one group.
Setting the slider bar to 1.0 divides the tasks into 18 groups, none of which are distinctive. There is definitely no groupings here.

It's necessary to find the optimum setting.

Starting from the default setting I clicked Left. The range was from 0.0 - 0.5. got three groups which looked fairly good. But I decided to check out the other options. I clicked Left again and the range changed to 0.0 - 0.25. But it combined all the nodes into one group. This definitely wasn't the correct grouping. I clicked Right and the range changed to 0.125 - 0.25. It split them into two groups.
Group Viewer-K-Fog

FOG (or Fuzzy Overlapping Groups) works in either one mode (Nodeset-1 x Nodeset-1) or two mode (Nodeset-1 x Nodeset-2) networks. The two mode analysis is the more natural procedure. It's prime function is to form nodes into groups (clusters or communities) and show which nodes share the secondary functions.

REMEMBER : Groups produce tasks - people participate in tasks.

Below are images of the Group Viewer K-Fog window for both one mode and two mode.

Parameters

One Mode and Two Mode

Select a Network: The same in both. The dropdown menu lists all the available networks in the selected meta-network.

Select a number of groups to see : Number of groups to divide the nodes into. Generally the analyst would have an idea of the number of groups that are necessary.
**One Mode**

Select the number of trees per node: The number of sample events to generate.

Select the tree size: The number of people involved in each group

**Two Mode**

Select Node Class to Cluster: Selects, via the radio buttons, the node class to display using the other node class as it's base.

**Links**

The thickest link is usually the leader of the group. The question to ask is WHY is that particular person the strongest link. It is important to look at the composition of the group(s) involved.

If the weights are Lopsided (many strong and/or weak links) the analyst needs to look at the association of the interstitial actors whose information will assist in analyzing the groups.

If a node is connected to only one group and that group has few actors then it is considered somewhat insular.

**One Mode Example**

Run on the agent x agent network with a number of threes per node set to "2", the tree size set to "2", and the number of groups to see set to "2". The header designation is "S=the set (1-5)" and "G=first or second group".

<table>
<thead>
<tr>
<th></th>
<th>S1-G1</th>
<th>S1-G2</th>
<th>S2-G1</th>
<th>S2-G2</th>
<th>S3-G1</th>
<th>S3-G2</th>
<th>S4-G1</th>
<th>S4-G2</th>
<th>S5-G1</th>
<th>S5-G2</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o 'neill</td>
<td>0.2</td>
<td>0.125</td>
<td></td>
<td></td>
<td>0.1667</td>
<td>0.1667</td>
<td>0.2381</td>
<td>0.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>gen_hamm ond</td>
<td>0.4375</td>
<td>0.5</td>
<td>0.375</td>
<td>0.5</td>
<td>0.1667</td>
<td>0.5</td>
<td>0.2857</td>
<td>0.6</td>
<td>0.5789</td>
<td>0.1176</td>
</tr>
<tr>
<td>osiris</td>
<td></td>
<td>0.125</td>
<td>0.1</td>
<td>0.25</td>
<td>0.0416</td>
<td>0.0952</td>
<td>0.1334</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>yu</td>
<td></td>
<td>0.3334</td>
<td>0.0416</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>lantash</td>
<td></td>
<td>0.25</td>
<td>0.0416</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.0588</td>
<td>0.1052</td>
</tr>
<tr>
<td>daniel_jack son</td>
<td></td>
<td>0.0833</td>
<td>0.0416</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>travel</td>
<td></td>
<td>0.0476</td>
<td>0.1334</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>anubis</td>
<td></td>
<td>0.0476</td>
<td>0.2667</td>
<td>0.1579</td>
<td>0.1176</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ren'al</td>
<td></td>
<td>0.0476</td>
<td>0.2667</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

989
Two Mode Example

The agent x task network is used and the Task Node Class is selected to cluster. The number of groups to see was set to "4". The results of hitting [Compute] five times are shown below. Each of the results is different but there is an overall pattern. In four of them there is a distinctive single large cluster of nodes.
Node Appearance

Node Appearance

Label Style > Default : Sets the label to appear to the right of the node. This is the default position for labels.
Label Style > On Right of Node : Sets the label to appear to the right of the node.
Label Style > On Left of Node : Sets the label to appear to the left of the node.
Label Style > On Top of Node : Sets the label to appear on top of the node.
Label Style > On Bottom of Node : Sets the label to appear beneath the node.
Label Style > Centered on Node : Sets the label to appear directly centered on the node.

Node Style > Toggle Node Size : Rotates between the three sizes and styles for the display of the nodes.
Node Style > Spot : Sets the size of all nodes to a small colored circle.
Node Style > Small Shapes : Sets all nodes to a colored shape (circle, square, triangle, pentagon, diamond, hexagon).
Node Style > Large Shapes : Sets shape of nodes to a colored shape only large enough to contain the label.

NOTE : Meta-network must be saved in the Editor in order for colors to be reloaded the next time the meta-network is loaded.

The nodesets retain their default color in the Legend dialog. i.e. all agent NodeClasses will default to red.

Node Color > Show Node Occurrence Transparencies :

Node Color > Color Nodes by Attribute or Measures : Allows you to chose an attribute or measure to run on a meta-network and will color the nodes in specific groups.
Node Color > Color Nodes by Component :
Node Color > Color Nodes by Concor Grouping : Divides and colors nodes

991
according to the Concur Grouping
Node Color > Color Nodes by Newman Grouping: Divides and colors nodes according to the Newman Grouping

Reset Node Color and Size: Sets the color and size of all node to the default values.
NOTE: Primarily used to resetting size after using Size Nodes by Attribute or Measure. The size set on the toolbar is the default size.

Size Nodes by Attribute or Measure: Allows you to chose an attribute or measure to run on a meta-network and will size all nodes accordingly.

Performing measure-based operations is not dependent on having previously run a report.

A meta-network asks if a measure can be run. If so, it is added to the list. That is why you may not see all measures appear in the dropdown menu.

Apply Log Scale to Current Sizing:

Show Labels: Toggles the names of the nodes on and off.

Load Node Images: If nodes have image files attached to an attribute this will display the picture instead of the node icon.

Remove Node Images: Removes all images from the visualizer and returns all nodes to their icon status.

Node Shaper: Allows you to chose the size and/or shape of any set of nodes.
The set is not just one particular noderset but can be created from individually chosen nodes from any noderset.

Attribute Measure related Options:
Link Color

In ORA you can color links according to several preferences. Below are the procedures for doing so.

<table>
<thead>
<tr>
<th></th>
<th>Alpha</th>
<th>Bravo</th>
<th>Charlie</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>0.0</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>Bravo</td>
<td>2.0</td>
<td>0.0</td>
<td>4.0</td>
</tr>
<tr>
<td>Charlie</td>
<td>3.0</td>
<td>9.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

NOTE: For this example all the nodes are colored black so as to decrease the color confusion.

NOTE: For this example the link weights have been drastically altered from the original values to assist in display purposes.

NOTE: Below is a warning for the placement of the Min and Max sliders. When the sliders are set to the absolute left and right positions this causes all the colors to be set to red. Move the sliders in to prevent this.

Default Colors

When ORA starts out all agent nodes are red with red links. There is nothing to distinguish the weights of the links.

For clarity I will split the links using Display > Link Appearance > Show Multiple Links Between Nodes > Split Bidirectional Links so we can see the change in colors of the bidirectional links.
Now to distinguish the links by their weights select Display > Link Appearance > Link Color > By Link Weight. There are two options for coloring link weights.

**Even Distribution**

The colors used are evenly distributed across the chosen spectrum. Using a nodeset with weights of 1, 2, 3, 4, & 9 would have five colors chosen at evenly spaced intervals across the spectrum.

Limiting the spectrum too small might cause some of the numbers to contain very similar colors. This might make it difficult to tell the various shades of blue apart. Use this only when there are a very limited number of values.
Scale to Weight

Notice that values for 1.0 and 9.0 remain the same as the outer limits but the distribution for 2.0, 3.0, and 4.0 vary slightly.

Link Values

Notice that most of the colors are now in the blue to blue-green range and then a large gap over to yellow for the link weight of 9. These are scaled by the weight.

NOTE: When a link is bi-directional and the weights of the links are not the same the Visualizer will color the link that was drawn last. Sometimes it makes it difficult to tell the actual link color.

Change link Color

After setting the type Even Distribution/Scale by Weight the color of the links can be set manually through the color changer. Click on the color box of any of the links to bring up the color change dialog box. Select a new color and click [OK].
Node Shaper

The Node Shaper allows you to change the size of individual node(s) or assigning pictures. Below is an image of the Node Shaper widow and a description of how to change the shape of the nodes in your model.
1. Select a Style: Select from three Node Style Sizes or use an image in its place.
2. Select a Shape: An optional shape can be used instead of the nodeset's default shape. The node will retain its default nodeset color.
3. Select Node to Re-Shape: The bottom section contains the controls for selecting which nodes to work with. Typing anything in the Find textbox will automatically filter out non-matching nodes.
4. Nodeset tabs: Select which nodesets to view. ALL shows every node or the tabs will show only their individual nodesets.
5. Check boxes: Place a checkmark in the box next to the nodes you want to change.
6. Filters: Use for filtering based on individual attributes. You can filter on more than one attribute at a time. An example can be found in Create a new Meta-Network.
7. Select/Clear All buttons: Will either Select or Clear all VISIBLE nodes. If a check marked node has been filtered out and is currently NOT visible when the Clear All button is pressed, then that node will retain its checkmark and be affected by future changes.
8. Apply/Load Changes: After any changes have been made to the top portions selecting the [ Apply Changes ] buttons will cause them to be displayed in the Visualizer.
9. Close:
How the Node Shaper Changes the Nodeset

What follows are examples of how the Shaper changes the nodeset.

Whenever the Node Shaper is called and a node is assigned something other than it's default shape new attributes will be added to every nodeset, not just the nodeset you're working with.

- **Drawing Type**: This will define what type of node is to be drawn, shape of image. There are three options for size (small, medium, and large) and one option for image.
- **Nodes Shape**: There are four large shapes (circle, rectangle, ellipse, and hexagon), eight medium shapes (circle, hexagon, down triangle, pentagon, diamond, square, up triangle, and octagon), and one small shape.
- **Image**: Contains the name of the file associated with that node.

Changing one node will create these three attributes and place the default value in every node in every nodeset. Any of these attributes can be manually changed from within the Main Interface Editor.

This is useful if you have changed many nodes and want to restore them all to their defaults quickly and easily. The quickest way is using the Copy and Paste method.
Column "1" contains the modified values. In column "2" three values of medium are highlighted and copied using Ctrl-C. In column "3" the cursor is moved to the top cell and Ctrl-V is used to paste those three values in. In column "4" this is repeated until all values are back to their defaults.

If the Image attribute contained a filename then changing Drawing Type to image will relink that file to the picture. Any of the four Drawing Type values can be placed in this column.

<table>
<thead>
<tr>
<th>Drawing Type</th>
<th>Drawing Type</th>
<th>Drawing Type</th>
<th>Drawing Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>image</td>
<td>image</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>image</td>
<td>image</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>image</td>
<td>image</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>image</td>
<td>image</td>
<td>image</td>
<td>medium</td>
</tr>
<tr>
<td>small</td>
<td>small</td>
<td>small</td>
<td>medium</td>
</tr>
<tr>
<td>small</td>
<td>small</td>
<td>small</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>large</td>
<td>large</td>
<td>large</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>small</td>
<td>small</td>
<td>small</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>large</td>
<td>large</td>
<td>large</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
<tr>
<td>medium</td>
<td>medium</td>
<td>medium</td>
<td>medium</td>
</tr>
</tbody>
</table>
Node Shaper Examples

Original Agent x Agent Network

Below is the agent x agent network in the normal medium sized nodes.

We start out with the Stargate agent x agent nodeset class set to medium size nodes.

Changing a Few Nodes

From the Visualizer menu select Display > Node Appearance > Node Shaper. Click the tab marked Agent. Place a check mark next to col_jack_o_neill, maj_samantha_carter, daniel_jackson, and teal_c. Select the Large Node Style.
When you are finished click the [Apply Changes] button.
Now the four members of SG-1 stand out represented by larger nodes.

**Select Nodes to Re-Shape**

You can also use the Search box, in conjunction with the tabs, to bring up specific nodes in the grid. It's predictive so as you begin typing the grid will change. Continue typing until you see the node(s) you need. I wanted the two characters with the rank of major and knew their rank was a prefix. I typed maj into the search box and the two nodes were singed out.
Attribute/Measure Based Options

ORA allows you to alter the appearance of the nodes in a multitude of ways as seen from the drop down menu below. We'll take a look at two of these items which will give you an understanding of how they work.

Let's take a look at a few of these.

Here is a Network with all nodes set to the spot style and are all the same size to begin with. It contains agent, knowledge, resource, location, event, and task nodeset classes.
Scaling Nodes

Setting the controls to Scale Nodes and selecting Centrality, Total Degree it now scales the nodes to reflect the number of in and out links each node has. The bigger the node, the more links it has.
I reset the nodes to their default settings with Display > Node Appearance > Reset Node Color and Size. Changing the top drop down to Color node(s) colors the nodes in a sliding color scale.

NOTE: If you do not reset the node color and size they will remain the same size as before but only change their color.

### Coloring Nodes

You can click the double downward facing angles to reveal further options. For coloring nodes click any color box which brings up the color picker. This allows you to pick your exact colors for each level.
Next you can select only particular values to be display. Here I selected to show only the top six values for the measure. The display is to the right.
Color By Attribute

The Agent x Agent network defaults to all agents being red.
The display can reflect agents by individual attributes. First select Color Nodes then select an attribute (i.e., gender). Click [Apply Changes].
The display now shows all males as green, one female as yellow, and the robot of the story as blue.
Link Appearance

Reduce Visualization Complexity: Turns off links and labels, resets nodes to spot style, and hides nodes with less than two neighbors.

Link Labels > Show Link Labels: Toggles on/off the display of the labels of the links.
Link Labels > Show Weight Value Labels: Toggles on/off the display of the weight of the links
Link Labels > Show Weight Sign Labels: Sets the label and shows whether their weight is positive or negative.

Link Color > Default: Removes all custom link coloring and resets all links to default.
Link Color > By Link Weight: You can set a range of colors to represent the weight of links. A dialog box allows you to chose the colors for the minimum and maximum weights.
Link Color > Match Source Node: Colors the link the same as the source.
Link Color > Match Target Node: Colors the link to match the target.

Retain Bidirectional Links: When two nodes have links to each other only one link will be displayed.
Split Bidirectional Links: When two nodes have links to each other only both links will be displayed. These links will be rendered as curved links between the nodes.

Show Links: Toggles on/off the display of links between nodes.
Scale Link Width to Weight: Toggles on/off the display of links between nodes.
Scale Link Width to Number of Links Between Nodes: Adjusts the width of the link to represent the weight of the link.
Show Arrows: Toggles on/off the display of the arrows of the links.
Show Self Links (Loops): Shows whether there is a connection between a node and itself. It is designated with a circle pointing back to itself.
Display

Reduce Visual Complexity: Hides links, hides isolate, and sets node shape to small circle.

Comments

Set Comments Font: Sets the font used in Visualizer comments.
Set Comments Color: Sets the color used in Visualizer comments.

Title

Title Location > Top: Sets the title to the top of the Visualizer window.
Title Location > Bottom: Sets the title to the bottom of the Visualizer window.
Title Location > Left: Sets the title to the left of the Visualizer window.
Title Location > Right: Sets the title to the right of the Visualizer window.
Title Location > Center: Sets the title to the center of the Visualizer window.
Set Title: Create a title for a screen shot. The title will remain a static size and retain its position regardless of the zoom of movement of the display.
Set Title Font: Set the font used in the title of the screen shot
Show Title: Toggle visibility of the title.
Allow Click to Edit Node Title:
Show Mouse Overs: Toggles the information boxes on and off whenever you hover the mouse over a node or link in the visualizer.
Autozoom: Zooms the display either in or out to bring all nodes into view.

BackgroundColor

BackgroundColor > Black: Sets the Visualizer background to black.
BackgroundColor > White: Sets the Visualizer background to white.
BackgroundColor > Custom: Brings up the color picker which allows you to chose any color for the background.
NOTE: Some of the possible background colors can make it difficult to view the visualizer. Your best choice is black (although white is used in the examples for easier printing).
**Background Image**

Background Image > Load: Allows you to choose a .jpg, .gif, or .png format image to use as the visualizer background.

Background Image > Clear Image: Removes the image and returns the background to the last background color used.

**NOTE:** Some pictures may make viewing the network somewhat difficult.

- Black and White Only: Removes all colors from the visualizer.
- Grayscale: Removes the hue from all nodes and links displaying them as shades of gray. If any of the nodes are difficult to read try changing the background color to a darker or lighter color. A black background works very well for grayscale images.
- Reset Node/Link Options: Resets all node and link colors back to default.
Comments

While in the Visualizer Comments can be added to the display. Right-click a node and from the context menu select Add Comment. The comment is placed in a colored box with a dashed arrow connecting them to the original node.

NOTE: These comments are not saved when exiting the Visualizer.

NOTE: The main use of these comments would be in creating screen shots for display in order to add commentary for a report.

Below is a section of the Stargate scenario with the unexpected appearance of Osiris.

Adding a Comment

A comment is added stating Osiris's arrival changes the plan.
From the main menu, under the Tools item, the font size and color, as well as the color of the box, can be changed.

**Adding Multiple Comments**

It is also possible to add multiple comments to the same node.
NOTE: These comments are not saved when exiting the Visualizer.

**Deleting a Comment**

A comment can be deleted by first selecting that comment. A right-click brings up the context menu. From this menu select Delete Selected Node(s).
**Mouseovers**

NOTE: To access the context menu the option must be checked.

Go to Display > Show Mouse Overs and make sure the option is check marked.

When the pointer is passed over any Node in the visualizer a yellow tooltip box will appear showing information on links to other nodes as well as values for measures than have been run. Below is a screen shot comparing two mouseovers.

If an attribute is empty ORA will leave a blank line for that attribute. Only if the attribute has a value will it be displayed. Neighbors are all the links to other nodes.

**Mouseover Display Limit**

With the mouseover display active ORA will attempt to display which node or link you have the pointer hovering over. But there is a limit of 5,000 links when ORA no longer attempts to display the link. It will, however, still attempt to display which node the pointer is hovering over.
Multi Color Links

There may be an instance when you would want to differentiate links between the same nodes. This is done by creating separate networks for each instances. In the following example there are two nodesets with three nodes each. We want to show different relationships between these two nodesets.

We do this by creating individual networks for each separate instance. Two for abc x def and two for def x abc.

When first visualized all nodes are red as are their links.
To show one set of links differently click on the arrow next to one of the networks and the color picker will appear. Pick a new color and click [ OK ]. Notice how only the links in that network turned blue in the Visualizer. You can then continue this for all networks you want to reveal.

The third network was turned green and the fourth network was turned ocher. It is now easy to find which links belong to which network in the Visualizer.
**Node Images**

Nodes can be replaced with various symbols or pictures to make it easy to identify individual nodes. There are a few items to note:

- All images should be reduced to approximately 50 x 50 pixels before using in ORA. Bigger images will be reduced in size on the display and the image quality may possibly be degraded.
- If a picture is placed on a background with the color R=255, B=0, G=192 the background will be changed to the color of the node.

**Setting an Image Folder**

The Set Picture option is designed with modularity in mind, with adding new images as easy as putting a folder with images in the include\OraFiles\images\visualizer\node folder. The dialog will automatically read that folder for subfolders, use the subfolder names as categories, and the images inside the subfolders as the images for each category.

**Set Picture**

Right-click any node and select from the context menu Appearance Submenu > Set Picture. The Node Selector dialog box will appear. The drop down menu contains various types of node images. With a node selected a custom image can be applied. Nodes with Images will scale.
**Custom**

The Custom option allows for the inclusion of a user's own icons.

The custom category is used for images that have been previously loaded in the current meta-network. Clicking OK applies the currently selected node's image to all nodes selected in the visualizer.

Additional information can be found in the [Node Shaper](#) section.

The [New Image] button brings up a navigation box from which to navigate any directory and select an image file. The picture types can be jpg/jpeg, gif, or png. These will all be collected into the Custom section.

**NOTE :** Remember to reduce the picture size BEFORE importing it into ORA.

To set a new image right-click the node and select Set Picture. This brings up the picture dialog box. Locate the appropriate picture and select it. A black border will appear around the image. Clicking [OK] will set the picture to the node.
Scale Link Width to Weight

There will betimes when you need to see the differences in link weights in the Visualizer. This is accomplished using Display > Link Appearance > Scale Link Width to Weight.

This network contains links of varying weights but at a link weight set to 1 that is not visible on the screen.

Using Display > Link Appearance > Scale Link Width to Weight will set the links to increasing widths depending on the link weight. But with the default link weight set to 1 the differences is negligible.

To be able to see these differences increase the default link weight up [here I set it to 20. and now you can plainly see the differences in the link weight. But you must be aware that in a bidirectional network the links may have different weights.
The center wide link has one link weight of 4 and the other link weight of 9. In this mode only the weight of 9 is visible. The same goes for the bottom links which contain a 2 and a 3 weight.

Using the Display > Link Appearance > Show Multiple Links Between Nodes > Split Bidirectional Nodes you can see that links between two nodes are different weights. Using this function displays all nodes with no overlapping.
Visualizer Context Menus

The Context Menu is displayed by right-clicking an a node or link. It contains many standard uses in manipulating nodes and links.

**Node Menu**

**Pin Submenu**

Pin All Nodes: Globally pins all nodes. Nodes are unaffected by the [Play] button or the movement of other nodes.

Unpin all Nodes: Frees all nodes from being pinned.

Pin Selected Node(s): All selected nodes will become pinned

Unpin Selected Node(s): All selected nodes will become unpinned.

**URL Submenu**

Attach URI: You can attach a URI to the selected node.

Go To URI: Activates your browser and goes to the URI associated with this node.

**Appearance Submenu**

Set Picture: You can replace the node shape with a picture.

Set Node Size: You can numerically set the node size of an individual node.

Set Node Color:

Set Font Size: You can numerically set the font size for an individual node.

Enlarge: Increases the size of the selected node in the visualizer

Shrink: Decreases the size of the selected node in the visualizer

Brighten: Lightens the shade of the color of the selected node

Darken: Darkens the shade of the color of the selected node.

Hide Labels: Hides the label of the selected node.
Show Labels: Reveals the label of the selected node.

Show Ring(s): Places a highly visible ring around the selected node(s).

Hide Rings(s): Removes ring from selected node(s)

Visibility Submenu

Hide Node(s): Removes the selected node (along with all links) from view in the Visualizer.

NOTE: This does not delete the node from the meta-network.

Hide Adjacent Node(s): Hides all nodes that are linked to the selected node. The selected node remains visible.

Other

Color Adjacent Edges: Allows you to chose the color for all links associated with the selected node. Only works on one node at a time.

Select Node: Registers the node as selected when Ora affects multiple nodes.

Center Node: Brings the selected node to the center of the visualizer.

Pin Node: Pins node to background so it is unaffected by the movement of other nodes.

Expand Node: Shows all nodes and links connected to the selected node.

Combine into Meta-Node: Multiple nodes can be selected and combined into a meta-node which will contain links to all the nodes that the individual nodes had. The four large circles of SG-1 are selected. The and green circles show which tasks are associated with these agents. Press, and hold, the Control key while selecting each node for the meta-node. Then without releasing the Control key, right-click one of the nodes to bring up the context menu. Select Combine into Meta-Node.
After combining the task nodes that were linked to the individual nodes are now linked to the sg-1 meta-node.

NOTE: If additions or deletions of nodesets need done expand the meta-node before proceeding.

Add Comment: Attaches a comment to the currently selected node. Good for making notes for display purposes. Comments can be toggled to be shown or hidden from the Display menu. The color and font of the comments are also controlled from the Display menu.

Spread Out: Finds the center for the currently selected nodes. Then calculates a ray from that center through the nodes current location, and pushes the node along that ray by (currently) 40 units.

Delete Selected Node(s): Allows for the deletion of nodes form a meta-network from within the Visualizer.
NOTE: This deletion is permanent once the meta-network is saved. If there is any question regarding the deletion then remove the meta-network from ORA before saving and reload the meta-network.

**Link Menu**

Link Status: Brings up the Link Status box with information on its weight, the network, source and target nodes, source and target nodeset.

Hide Link: Hides the link. This does not delete the link.

Set Value: Set a new value for a link.

Reverse Direction: Reverses the Source and Target aspects of the link.

Delete Link: Removed the link from the Network.

**Empty Space**

Pin All Nodes: Globally pins all nodes. Nodes are unaffected by the [ Play ] button or the movement of other nodes.

Unpin all Nodes: Frees all nodes from being pinned.

Pin Selected Node(s): All selected nodes will become pinned

Unpin Selected Node(s): All selected nodes will become unpinned.

Add Comment: Attaches a comment to the currently selected node. Good for making notes for display purposes. Comments can be toggled to be shown or hidden form the Display menu. The color and font of the comments are also controlled from the Display menu.

Spread Out: Finds the center for the currently selected nodes. Then calculates a ray from that center through the nodes current location, and pushes the node along that ray by (currently) 40 units.

Format Nodes: Brings up the Node Formatter dialog box.
Comments

Add Comment: Attaches a comment to the currently selected node. Good for making notes for display purposes.

Osiris Arrival changes everything  Assassination plot as planned
Node and Link Formatter

**Node Formatter**

There are two ways to select nodes. 1) You can Control-Click on each node separately in the Visualizer. 2) You can use the Selector tool and lasso a group of nodes. When you have the nodes selected right-click to bring up the Node Formatter dialog box.

Appearance Tab : Controls the color, transparency, and labels of the Node(s) selected.

Node Color : Control the color of individual nodes.

Match Node Set Color : Resets the color of the node(s) back to the default color of the nodeset.

Choose a Custom Color : Click the color box. From the color the selector palette select a new color and click [OK]. In the Node Formatter box click [Apply].

Node Transparency : Set the Node Transparency from 0 (transparent) to 1 (visible).

Node Size : Set the Node Size from 4 (small) to 25 (large)

Visibility Tab : Controls visibility of nodes.

Hide Node(s) button Removes nodes from the display.

Show Node(s) button puts the nodes back into the display. To bring back Nodes of a nodeset which have been hidden you can toggle the check box in the Legend off and on and all nodes of a nodeset will reappear.

Label Tab : Set the label size from 1 (small) to 25 (large). You can also show or hide the labels of the selected nodeset.

Label Size : Change the size of the label from 1 (small) to 25 (large).

Hide Node Label(s) button Removes label from the display.

Show Node Label(s) button Puts the label back into the display.
NOTE: The Node Formatter works only with the node(s) originally selected. To change the parameters for another node(s) you must close the Node Formatter dialog box, select another node(s), then perform your changes.

**Link Formatter**

Right-Clicking on a link in the Visualizer brings up the Link Formatter.

Appearance Tab: You can color the selected links by source node, target node, or pick a custom color. You also have the option of using solid or dashed lines.

Node Color: Control the color of individual nodes.

Color by Source Node: Sets the color of the link(s) to the color of the Source Node.

Color by Target Node: Sets the color of the link(s) to the color of the Target Node.

Choose a Custom Color: Click the color box. From the color the selector palette select a new color and click [OK]. In the Link Formatter box click [Apply].

Visibility Tab:

Hide Link(s) button Removes link from the display.

Show Link(s) button Puts the Link back into the display.

NOTE: If after you hide a link and close the Link Formatter dialog box the only way to bring that link back a link you have hidden is to use the menu item Actions > Show All Nodes. But remember, this will also undo any other hidden nodes and links you have.
Node Context Menu

Right clicking any node in the Visualizer brings up a menu of the most useful tasks concerning nodes.

The Pin Node Submenu: Allows you to access various functions involving pinning and unpinning nodes in the visualizer.

The URI Submenu: Allows you to attach a URI to a node or go to a URI already attached to a node.

The Appearance submenu: You can enlarge or shrink the size of a node, brighten or darken its color, set its color or size, attach a picture to a node, or give it a display ring for easier visibility.

Label submenu: Individual labels can be hidden or displayed and the font size can be altered.

Visibility submenu: You can either hide the selected node or hide the adjacent nodes.

Color Adjacent Edges: Sets the color of adjacent links of the selected node.

Select Node: Makes the node selected.

Center Node: Centers the selected node to the center of the window.

Combine into Meta-Nodes: After selecting two or more nodes you can combine them into a single meta-node and give that meta-node a name. If necessary you can also expand that meta-node into its individual nodes.

Add Comment: You can add or delete comments for any node in the meta-network.
Spread Out: Puts node space between node around the selected node.

Delete Selected Node(s): Removes selected node(s) from display

Format Nodes: Calls up the Node Formatter
Removing Nodes in Visualizer

You can remove nodes directly from the ORA Visualizer by right clicking on a node and selecting Hide Node. Below is an example of removing an node using the Hide Node tool.

Find the node you want to hide. Here we will hide ren'al.

Place the cursor over the node and right-click on the node to bring up the context menu. Highlight Hide node ren'al and the four task nodes are now separated from the rest of the network.
Set Node Picture

In addition to changing the size of nodes in the visualizer you can also assign nodes individual pictures. This example is the Raiders of the Lost Ark set from Peru.

NOTE: This example uses only standard icons found in ORA.

I right-clicked on the Bullwhip node and selected Appearance Menu > Set Picture. This brings up the Set Picture dialog. I clicked the downward triangle and selected the Resource - Generic folder. I then selected the colored cubes icon.
Clicking [ OK ] assigns that picture to the selected node.
You can replace any number of nodes with icons.
Your Own Icon Set

You can create your own set of icons. Place all your personal icons in a folder and place that folder in the following directory. The next time you use ORA you will be able to select icons from your own folder.

NOTE: Be aware that very large icons will make viewing the display difficult. Small distinct icons work better. If using pictures of individuals it's advised to resize them to 50 x 50 pixels.
Motifs

This is a list of common motifs that can make it easier to find various clusters as the underlying structure of your network.

<table>
<thead>
<tr>
<th>No Links</th>
<th>2-Group</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="No Links" /></td>
<td><img src="image" alt="2-Group" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bowtie</th>
<th>Chain</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bowtie" /></td>
<td><img src="image" alt="Chain" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Circle</th>
<th>Star</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Circle" /></td>
<td><img src="image" alt="Star" /></td>
</tr>
<tr>
<td>Cognitive Demand</td>
<td>Eigenvector Centrality</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td></td>
<td>Degree Centrality</td>
</tr>
<tr>
<td></td>
<td>High Betweenness and No Degree</td>
</tr>
</tbody>
</table>
3D Visualizer

The 3D Visualizer uses the same meta-networks as the standard 2D Visualizer, only it projects them into a three dimensional setting. It can be called up either by selecting from the main menu Visualizations > View Networks > 3D Visualizations or in the editor by clicking the downward triangle on the [Visualize] button. This will visualize the highlighted meta-network.

As with the 2D visualization the Legend controls which nodeset classes are visible in the display.

Controls

The display at the bottom of the visualizer denotes working with a three-button mouse. When working with trackpad the controls are similar, left button to rotate and right button to translate. The zoom is accessed by using your finger on the side of the trackpad to zoom in and out.

Three Button Mouse

Rotate : Using the Left Button you can spins the display in whatever direction you move the mouse. You can move the mouse left/right and forward/backward.

Translate : Using the Right Button you can move the display laterally left/right or up/down. You can move the mouse left/right and forward/backward.

Zoom : Using the Middle Button you can affect how close-in or far away the display is. The zoom works by moving the mouse in the forward/backward direction only.

Using a Trackpad or a Two-Button Mouse

The Rotate and Translate function exactly the same. To use the Zoom function press and hold the Alt key then click the Left Button. Then move the mouse or your finger on the trackpad.
3D Visualizer GUI

In the 3D Visualizer - you can size nodes by standard social network metrics. This is one of the options under visualize nodes. You can also color the nodes by attribute. Performing measure-based operations is not dependent on having previously run a report.

The standard flow for using measures goes something like this.

1) User calls size nodes by attribute/measure. Dialog loads in the current meta-network.

2) For each measure that's been defined, the meta-network asks if it can run it. If it can, it gets added to a list.

3) User selects the measure, runs, and the visualizer calls the ORA back end to compute the measure.

2D Display

Here is the normal view in the 2D Visualizer.
3D Display
Here is the same network viewed in the 3D Visualizer.

The menus for the 2D and 3D Visualizer are nearly identical. The Layout menu, as well as other selected controls, are disabled in the 3D version.

Pinning Nodes
Currently pinning nodes in the 3D view is not available.

Nodes Hidden from View
As you move around your network you may notice some nodes disappear. In this view you need to be aware of working in 3D Space. In this first view the camera is far from the network and all the nodes are visible.
But as the camera is moved in it passes some nodes and they end up behind the camera.
2D 3D Differences

There are a number of functions available in the 2D Visualizer which are not available in the 3D Visualizer mostly due to being designed for the 2D space. Below is a list of these functions.

**File**

Open ORA-Image, Save Special, Add Grouping to Current Meta-Network, Add Meta-Nodes to Current Meta-Network, Visualize in 3D, GeoSpatial Networks

**View**

Change Font…

**Actions**

Pin All Nodes, Unpin All Nodes

**Tools**

Node Status, Backward Influence, Pie Nodes, Meta-Network Designer, Networks Over Time, Vector Maps

**Layouts**

All menu items inactive.

**Meta-Nodes**

Create Meta-Nodes by Grouping…, Create Meta-Nodes by Attribute/Measure, Meta-Nodes

**Node Appearance**

Label Style, Node Style, Node Color > Show Node Occurrence Transparencies

**Link Appearance**

Link Labels, Show Multiple Links Between Nodes

**Display**

Allow Click to Edit Node Title
Color by Attribute or Measure

As in the 2D Visualizer nodes can accept coloring by various means.

I start out by hiding all nodesets except Agents. If the Legend dialog is not visible select from the main menu Tools > Legend then from the Legend menu Control > Hide All Nodes. Then select the Agents nodeset. This will display all Agent nodes in their default red color.

Using the Select an attribute will allow you to assign individual colors to each attribute. Click on color well and choose your colors. I assigned the three homeworlds red, green, and blue and the Lacks an Attribute value was set to yellow. Click the [ Apply Changes ] button.
From the Select a measure: drop down select a measure to run. This will assign values to each node some of which could be equal. As with the attributes you can assign individual colors to each value.

The two nodes in the red circles are the same color, 0.46153846.
3D Context Menu

While in the 3D Visualizer right-clicking brings up a different context menu. There are different menus for clicking a node or a link.

**Right-Click a Node**

Add Node : Clicking on a node will add a link to a new node.

Add Link : Right-click a node and select Add Link. Click a second node and a link is created between those two nodes.

Center Node : Brings the selected node to the center of the screen and zooms in.

Delete : Deletes selected node from nodeset.

Drag : Selected node turns yellow indicating it is selected. Right-click and hold and you can drag the node to a new position. When you are finished click the [ Done ] button at the bottom of the visualizer.

Fixed Position : Sets a node's position in space while other functions are performed. The node turns light blue and a check mark indicates this is active. When finished selecting this function unselected the node.

Set Label… : Allows the user to give a node a new label.

Set Color… : Calls up the color palette and allows the user to give the selected node a new color.

Set Radius : Allows the user to manually resize a node.

Hide : Hide the selected node form the display.

NOTE : Hidden nodes can only be recalled using the Action > Show All Nodes function.

Show Details… :

**Right-Click a Link**

Delete : Deletes selected link.

Hide : Hides selected link.
Radius… : Changes selected link to new radius.

Weight… : Changes weight of the selected link.

NOTE : Weight of link can be set between 0.0 and 1.0.

Set Color… : Calls up color selector and sets link to that color.

Reverse Direction : Reverses the direction of the link.

NOTE : To show the current direction of the links click the Show Links button on the toolbar.

NOTE : If after reversing the direction of a link the direction does not change, toggle the Show Links button off and on.

Show Details… :
Geospatial Network

ORA provides tools to visualize geospatial information systems: GIS Visualizer and GIS Visualizer 3D. When working with the GIS Visualizer your meta-network must include location information.

GeoSpatial is concerned with plotting who or what was where on a global basis. It plots nodes on a map and then connects those nodes.

Loom also deals with nodes in locations but is keyed on the timeframes in which nodes appear. There are locations in which two agents appear in but which were there at different times and never met.
The GeoSpatial Visualizer differs from the 2D Visualizer as it places nodes on a representative map whereas the regular visualizer allows the nodes to float freely in a non-space.

Many Geospatial information system (GIS) products apply the term geospatial analysis in a very narrow context. In the case of vector-based GIS this typically means operations such as map overlay (combining two or more maps or layers according to predefined rules), simple buffering (identifying regions of a map within a specified distance of one or more features, such as towns, roads or rivers) and similar basic operations. The Geospatial Network tool in ORA allows for the plotting of a meta-network on a map of the globe using longitude and latitude for placing the nodes.

This longitude and latitude is associated with a location Node Class. Then other Node Classes are associated with the location Node Class. This information is used to place people and items on the map.

Below is the default map included with ORA's GIS tool.
NOTE: Other maps, or layers, can be added and loaded into the GIS Visualizer. The GIS Visualizer generally can load geospatial maps based on the Shapefile format.

The ORA Geospatial Visualizer can be accessed from either the main menu bar: Main Menu Bar > Visualization > Geospatial Networks or by clicking the triangle on the Visualizer button in the Editor.

**Geospatial Networks Attributes**

The meta-network MUST contain a location Node Class and that nodeset MUST contain longitude and latitude data. Below is an example of a Location Node Class information that contains Longitude and Latitude as attributes.

<table>
<thead>
<tr>
<th>Location</th>
<th>COUNTRY</th>
<th>POP</th>
<th>CAP</th>
<th>LONGITUDE</th>
<th>LATITUDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Murmansk</td>
<td>Russia</td>
<td>468000</td>
<td>N</td>
<td>33.0860405</td>
<td>68.96355</td>
</tr>
<tr>
<td>Arkhangelsk</td>
<td>Russia</td>
<td>416000</td>
<td>N</td>
<td>40.6461601</td>
<td>64.52067</td>
</tr>
<tr>
<td>Saint Petersburg</td>
<td>Russia</td>
<td>582500</td>
<td>N</td>
<td>30.4533272</td>
<td>59.95189</td>
</tr>
<tr>
<td>Magadan</td>
<td>Russia</td>
<td>152000</td>
<td>N</td>
<td>150.780014</td>
<td>59.571</td>
</tr>
<tr>
<td>Perm’</td>
<td>Russia</td>
<td>116000</td>
<td>N</td>
<td>56.2324638</td>
<td>58.00024</td>
</tr>
<tr>
<td>Yekaterinburg</td>
<td>Russia</td>
<td>162000</td>
<td>N</td>
<td>60.6101303</td>
<td>56.84654</td>
</tr>
<tr>
<td>Nizhniy Novgorod</td>
<td>Russia</td>
<td>202500</td>
<td>N</td>
<td>43.94067</td>
<td>56.28968</td>
</tr>
<tr>
<td>Glasgow</td>
<td>UK</td>
<td>180000</td>
<td>N</td>
<td>-4.26994753</td>
<td>55.86281</td>
</tr>
<tr>
<td>Kazan'</td>
<td>Russia</td>
<td>114000</td>
<td>N</td>
<td>49.1454659</td>
<td>55.73301</td>
</tr>
</tbody>
</table>

NOTE: The columns which are necessary to build a Location Node Class are highlighted in Blue. In this example below, COUNTRY, POP, and CAP are not necessary, though they can be added, as additional attributes. Further below this chart, we will display how a location nodeset will appear in ORA’s editor.

Longitude and Latitude Format: The longitude and latitude use the degree.minute format. Longitude begins at the prime meridian which runs through Greenwich Village and run eastward 360 degrees. You can also denote the longitude values with positive or negative (-) numbers between 0 and 180. Latitude uses a 0-point which begins at the equator and runs to 90 to the north and -90 to the south.
## Location Data Example

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>ethno-religion</th>
<th>friendship</th>
<th>latitude</th>
<th>longitude</th>
<th>political-affiliation</th>
</tr>
</thead>
<tbody>
<tr>
<td>afghanistan</td>
<td>afghanistan</td>
<td></td>
<td></td>
<td>34.28</td>
<td>69.11</td>
<td></td>
</tr>
<tr>
<td>africa</td>
<td>africa</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>airmport</td>
<td>airport</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>britain</td>
<td>britain</td>
<td>christian</td>
<td>friend</td>
<td>51.36</td>
<td>0.05</td>
<td>liberal</td>
</tr>
<tr>
<td>cape_town</td>
<td>cape_town</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dar_es_sal</td>
<td>dar_es_sal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>darfur</td>
<td>darfur</td>
<td></td>
<td>friend</td>
<td>12</td>
<td>24.45</td>
<td></td>
</tr>
<tr>
<td>egypt</td>
<td>egypt</td>
<td>sunni</td>
<td>friend</td>
<td>30.01</td>
<td>31.14</td>
<td></td>
</tr>
<tr>
<td>europe</td>
<td>europe</td>
<td></td>
<td>friend</td>
<td></td>
<td></td>
<td>liberal</td>
</tr>
<tr>
<td>farm</td>
<td>farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>indonesia</td>
<td>indonesia</td>
<td>sunni</td>
<td>friend</td>
<td>6.09</td>
<td>106.49</td>
<td>liberal</td>
</tr>
<tr>
<td>israel</td>
<td>israel</td>
<td>jewish</td>
<td>friend</td>
<td>31.71</td>
<td>35.1</td>
<td></td>
</tr>
<tr>
<td>karachi</td>
<td>karachi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>kenya</td>
<td>kenya</td>
<td></td>
<td>friend</td>
<td>1.17</td>
<td>36.48</td>
<td></td>
</tr>
<tr>
<td>lebanon</td>
<td>lebanon</td>
<td>sunni</td>
<td>friend</td>
<td>33.53</td>
<td>35.31</td>
<td></td>
</tr>
<tr>
<td>liberia</td>
<td>liberia</td>
<td></td>
<td></td>
<td>6.18</td>
<td>10.47</td>
<td></td>
</tr>
<tr>
<td>london</td>
<td>london</td>
<td>christian</td>
<td>friend</td>
<td>51.36</td>
<td>0.05</td>
<td></td>
</tr>
<tr>
<td>manhattan</td>
<td>manhattan</td>
<td>christian</td>
<td>friend</td>
<td>41.47</td>
<td>73.58</td>
<td>liberal</td>
</tr>
</tbody>
</table>
GeoSpatial Network Toolbar

The GUI contains tools to work with the GIS maps. You can also customize the toolbar with functions from the menu.

Standard Toolbar

 выполненная картинка с изображением карты, на которой показаны различные точки и связи.

COPY IMAGE TO CLIPBOARD: Places a copy of the current map in the clipboard which can be pasted into another program.

PAN MAP: Place the cursor on the map and click the button. The map will re-center on those co-ordinates.

NOTE: Right-Click on the map to center view on that area.

SELECT PLACE: Click and drag to capture nodes for information to display in an information window. This information will be displayed in an expanding tree format. Click and drag the cursor to include the nodes to display.

A pop-up window will display information for all the nodes captured by the cursor.
Zoom In: Zoom In works in two ways. 1) Click and drag to select the area you want to zoom in on. The selected area will fill the GIS window. 2) Click the map once and the view will zoom in centering on the clicked area. This can be repeated until you zoom in as close as needed.

Zoom Out: Place the cursor on the map and click the button. The map will zoom out and re-center on those co-ordinates.

Show Labels: Toggle the labels on & off.

Show Links: Toggle the links on & off.

Show Arrows: Toggle the arrows on & off.

Font Size: Increase or decrease font size using the up & down arrows.

Node Size: Increase or decrease node size using the up & down arrows. The size of the node is proportional to the number of entities in a location.

Link Width: Increase or decrease link width using the up & down arrows.
GeoSpatial File Menu

The GeoSpatial file menu allows you to open, add, and save map data.

Open Meta-Network : Opens a NEW meta-network file into the Geospatial map. REMEMBER: The new file needs to have both longitude and latitude data.

Open Trailset :

Save Screenshot : Saves the currently map to the .PNG format.

Add GIS Data :

Add CSV : You can load a .csv file and specify which columns contains the longitude/latitude data.

Add KML (Google Earth) : KML is a file format used to display geographic data in an earth browser (e.g. Google Earth). A KML file is processed in much the same way that HTML (and XML) files are processed by web browsers. Like HTML, KML has a tag-based structure with names and attributes used for specific display purposes.

Add e00 : Contains Geographic Information Systems (GIS) mapping data exported by ArcGIS software. ORA can import this style of vector data and convert it for use in the GeoSpatial tool.

Add ERSI Shapefile : An ERSI shapefile is a digital vector storage format for storing geometric location and associated attribute information. Shapefiles spatially describe geometries: points, polylines, and polygons.

NOTE : This format lacks the capacity to store topological information.

Add Shapefile (using Openmap) :
Add Shapefile (using Geotools):

**Save Map:**
- Save Map To PNG: Saves the currently map to the .PNG format.
- Save Map To SHP: Saves the currently map to the .SHP format.
- Save Map To KML: Saves the currently map to the .KML format.
- Save Map To DyNetML: Saves the current map to the DyNetML format with the added Node Class ClusterLocation--ClusterLocation. This records changes affected by the Network Aggregator in grouping locations into regions.

---

**No Aggregation**

[Diagram of a network with multiple ClusterLocation nodes and connections without aggregation]

---

**Network Aggregation to 4 regions**

[Diagram of a network with fewer ClusterLocation nodes and connections after aggregation]

- Save Map To Loom Trailset: Saves the currently map to the Loom format.
Current GIS Layers

- Open From Defaults: Opens what is currently saved as the default Dynamic Network and GIS layers.
- Open from a File: Uses the information saved in the choose file to set the Dynamic Network and GIS layers.
- Save As Default: Saves the currently selected Dynamic Network and GIS layers as the default.
- Save to a File: Saves the currently selected Dynamic Network and GIS layers to a file.

Current Meta-Network Locations Configurations

- Open From a File:
- Save to a File:
- Create Meta-Network From Visible Network…
- Copy Image To Clipboard: Saves a picture of the current map to the clipboard which can be pasted into another program for use in demonstration purposes.
- Close
GeoSpatial Modify Menu

GeoSpatial Actions Menu.

Replace Current Meta-Network: Allows you to open a new geospatial file without closing the GIS visualizer.

Create New Spatial Relation:

Create New Spatial Nodeset:

Generate Distance Network: Creates a new network of distances in the selected meta-network using the location nodeset.

<table>
<thead>
<tr>
<th></th>
<th>pit</th>
<th>natrona heights</th>
<th>DC</th>
<th>Chicago</th>
<th>LA</th>
</tr>
</thead>
<tbody>
<tr>
<td>pit</td>
<td>0.0</td>
<td>19.258506774908</td>
<td>190.20924377441406</td>
<td>410.607177734375</td>
<td>2120.249755859375</td>
</tr>
<tr>
<td>natrona heights</td>
<td>0.0</td>
<td>0.0</td>
<td>186.0699462890525</td>
<td>421.179656824219</td>
<td>2134.662353515625</td>
</tr>
<tr>
<td>DC</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>595.149571679688</td>
<td>2281.83447265525</td>
</tr>
<tr>
<td>Chicago</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1729.1634521484375</td>
</tr>
<tr>
<td>LA</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
GeoSpatial Analyze Menu

GeoSpatial Actions Menu controls color and size of location nodes.

Reset Map Zoom: Reset the display of the map to its default size.

Reset Nodes Colors and Size: Returns nodes to their default colors and sizes.
NOTE: If the colors do not reset, click on the map with the Pan tool to force the reset.

Size Nodes by Attribute or Measure: Sizes nodes using numerical data.
NOTE: You cannot size by an attribute using non-numerical data.

Size Links by Value: Adjusts the weights of links in proportion to all links.

Color Nodes by Attribute or Measure: Currently the colors are assigned automatically, with "Blue" corresponding to a high value and "Red" corresponding to a low value. The screen may not update automatically, so you may have to force a refresh by recentering/zooming/etc.
NOTE: If the display does not reflect your new colors you can force a re-evaluation by zooming in and out. Another method is using the Get/Set View which will not change your framing.

Color Nodes by Component:

Color Nodes by Concor Grouping: Colors nodes using Concor Grouping*.  

Color Nodes by Newman Grouping: Colors nodes using Newman Grouping*.

1063
GeoSpatial Tools Menu

Tools is a set of controls for adjusting how nodes and links are displayed.

Layer Manager: Controls the visibility of the nodeset(s), network(s), and shape layers on the map by checking or unchecking the boxes.

Network Aggregator: Controls the groupings of nodes which are displayed together as separate regions.

Get/Set View:

Configure Meta-Network Locations:
Layer Manager

The GIS Layer Manager controls what is displayed in the GeoSpatial Visualizer. This includes all nodeset classes and shape layers. It is similar to the Legend in the regular Visualizer.

Selecting or unselecting a nodeset class or GIS layer will remove it from the display. It does not remove it from the dataset.

The Move Up and Move Down buttons adjust the display position of the SHAPE files. These buttons have no affect on the network layers.

Layer Manager Menus

Layers

Add New Layer : You can add additional map files to the display.

Remove Selected Layer : You can remove any selected map layer that has a checkmark next to it from the display.

Show All Network Layers : Displays all node information on the map
Hide All Network Layers: Removes all network information from the map. The information is still available through the Layer Manager.

NOTE: If you have more than one map layer loaded you can arrange how they are stacked.

Change Layer Position > Move Layer Forward:
Change Layer Position > Move Layer Backward:
Change Layer Position > Move Layer To Front:
Change Layer Position > Move Layer To Back:
Add Layer As Nodeset:

Options

Set Current Map Data As Default:
Reset Map With Default Data:
Network Aggregator

The Network Aggregator looks at regions instead of individual locations. Using the slider you can control how dense each region will be. Increasing the density groups more locations into a region.

Using a sliding scale, which in turn represents network information retention (or loss) depending on the level of the adjusted slider. A value can also be entered manually in the numeric field box.

When the network bar is fully red it indicates full network resolution and therefore network information is preserved and displayed in the GIS Visualizer. Conversely, when lower network resolution figures are entered network detail can be sacrificed. This bar graph is intended to show the level of such loss.

Scrolling all the way to the left to a value of 0.0 will remove all but the most basic level of aggregation. Basic level being any time where two locations occupy the exact same point. By default, GIS loads up with a small level of aggregation in order to handle potential issues with rounding (in cases where data's generated by scripts). If the little bar doesn't do much, try typing the value (0.0) directly into the text field.
there and hitting enter. After a little wait as it recalculates things, absolutely all locations should be shown.

It is best to experiment with the slider at varying values and observing GIS visualization for optimum balance of data resolution and visual relevancy. This is a useful tool when you have many noisy or cluttered locations. The grouping assists you in seeing the connections easier.

**Keeping Separate Agents In The Same Location**

If you are having problems with aggregating your data you should check your data. Depending on the source, you could have incidents where all locations within a city are given the same latitude/longitude, or even all locations within a country. It all depends on what the data origin thought the data would be used for. Sometimes they skimp on the details/accuracy to save time which could cause problems in the final display.

NOTE : You need to remember that in aggregation, ORA is plotting locations, not agents. If two agents have the same latitude/longitude, then ORA will plot them as one point on the map.

NOTE : And there is also the ability to view this in the 2D or 3D Visualizer which will display all nodes regardless of the similar lat/long attributes.

**Example**

You have 15 agents in London and want to see the links between them. In order to see the individual agents they will all need different Latitude and Longitude values. The GIS is plots locations, and not Agents. Thus, if there is only a single location node for all 15 agents, they will be represented as a single node, with no links. The best way to do this would be to select these nodes out and visualize them in the regular network visualizer. Any perturbations to their Latitude and Longitude values would be random.

GeoSpatial with no aggregation
GeoSpatial using Network Aggregation
GeoSpatial Shapefiles Menu

Add Shapefile... :

Add ESRI Shapefile : Load a shapefile into the GIS Visualizer.

Add Shapefile (using Openmap) :

Add Shapefile (using Geotools) :

Add Preloaded Shapefile... :

Countries :

US States :

Timezones :

Color Shapes by Links... :

Color Shapes by Internal Links : Value determined by number of links within a single shape.

Color Shapes by External (Outgoing) Link Count : Color value determined by out-degree of node.

Color Shapes by External (Outgoing/Incoming) Link Count : Color value determined by total-degree of node.

Color Shapes by Internal/External Link Ratio : Color value determined by the ratio of internal to external links.

Color Shapes with No External Links : Colors shapes which contain no links.

Color Shapes by Node Count : Color Value determined by number of nodes contained in a shape.

Color Shapes by Attribute/Measure : Color Value determined by selected attribute or by results from measure.
General Content About Shapefiles

Shapefiles are used in the GeoSpatial Visualizer and allow you to color code map details from data in your meta-networks.

NOTE: Geospatial Distance does calculate distances by taking the curvature of the earth into consideration.

Finding Shapefiles

The GeoSpatial tool can use various shapefile formats. Shapefiles can be obtained from the following locations:

World Shape files: http://thematicmapping.org/downloads/world_borders.php
USA based shapefiles (various): http://www.census.gov/geo/www/tiger/shp.html
Other shapefiles: http://maplibrary.org/

Download, and if necessary, unzip these files. Place these files in a folder on your computer.

General Suggestions

Default Map Colors: Before using the coloring functions on shapefiles I have found it advantageous to set the default color of the shapes to a neutral grey. Go to the Layer Manager. If it is not visible call it up by selecting Tools > Layer Manager. Click on the colored box next to the checkbox. The dropdown allows you to change the fill color and the border color. When the color picker appears pick one of the middle grey tones (or any other color you prefer).
If you do not set a default color to your shapefile the color will be taken from the color spectrum range. This could possibly be different each time you run and select your colors. Also the grey, being neutral, helps define shapes which are not included in the data. Below is the same map which was not given a default grey color. Makes some of the colors harder to distinguish.
Shapefile Types

The default GIS renderer is known as OpenMap. Through OpenMap you can aggregate locations, add shapefiles, and perform basic visualization.

NASA WorldWind

Once the data has been loaded into GIS, under options you can select the 3D visualization, which uses Nasa Worldwind. Any feature available in the 2D version is available in the 3D version, albeit it may operate a tad differently. 3D Version operates primarily as a sphere, but a flat map version can be toggled on.

Google Earth
Google Earth is not integrated with ORA, but the GIS is capable of producing a .kml file for use with Google Earth. The command to do so is located under File -> Save Map. The output will have the same nodes and links.

Customizing

Shapefiles allow you to customize the map with custom political boundaries, highways, whatever you can find. Shapefiles are imported via the File -> Add GIS Data. menu. Both the fill color and border color can be changed via the GIS Legend. All shapefiles must be in WGS84 Projection. Screenshot shows a shapefile of the political boundaries of the states of Sudan, as downloaded from MapLibrary.org.
Load a Shapefile

Load Meta-Network Into GeoSpatial

You can load a meta-network into the GeoSpatial Visualizer in three ways.

In the main interface highlight the meta-network. Select from the main menu Visualizations > GeoSpatial Networks…

In the main interface highlight the meta-network. Click the downward triangle on the [ Visualize ] button and select GeoSpatial Networks…

From the GeoSpatial Visualizer select from the Main Menu File > Open Meta-Network…

Load Shapefile Into GeoSpatial

When started the GeoSpatial tool will display a world map with, if selected, your meta-network locations shown. From the GIS Menu select Shapefiles > Add… > Add ESRI Shapefile. Navigate to the location to which you saved this file. Highlight the file and click [ Open ].
You will notice the outlines appear to have gotten bolder. This is due to the second set of country outlines. In the Layers Manager deselect the default shapefile leaving only your newly loaded shapefile.
Color a Shapefile

A shapefile can be colored by various methods: By Node Count, Link Count, and Attribute/Measure.

Color Shapes by Links…

There are three options for links, Color Shapes by Internal Link Count, Color Shapes by External Link Count, and Color Shapes by Internal/External Link Ratio.

Color Shapes by Node Count

You can color the shapes accounting for the number of nodes in any location. The color bar allows you to set the color for the minimum and maximum. In this case I selected ultramarine for the minimum (which essentially means any country with zero nodes) up to the maximum which is colored orange.

Color by Attribute/Measure

For this example I took the population numbers of the U.S. States and territories. I set the high number to be yellow, going through the dark to light blues to green and ending up at white for the least populated.
Next I added an attribute to the U.S. population file and called it timezone which includes the lower 48 states plus the Atlantic territories. I assigned a number for each timezone and added entries when a state used multiple timezones.

NOTE: When adding attributes to use in this manner you need to make sure they are created as numeric. Text attributes will not work.
Add GIS Data to Meta-Network

Open file in GeoSpatial Visualizer by selecting Visualizations > GeoSpatial Networks.... If there is no Latitude/Longitude data in the meta-network ORA will inform you there is no location information. That's fine, just click [OK].

NOTE: How can ORA tell whether location data exists? It looks in the attributes for names which contain the substrings lat or lon. If so it will post those as possible geospatial attributes.

The Configure Locations dialog will appear asking you to select nodesets and attributes to use as locations. Ignore this and click [Next]. A second Configure dialog will appear but you need to ignore this box also so click [Finish]. An empty GIS map will appear.

From the menu select File > Add GIS Data... > Import locations from ERSI ShapeFile. Navigate to the shapefile which contains the latitude/longitude data for your network. Your locations will now appear on the map.

NOTE: For this example my meta-network contained information on the population of states. The ERSI file I used contained the latitude/longitude for the U.S. states. Make sure that the ERSI file you use contained the lat/lon data for your meta-network.

This procedure will add nodesets and networks as needed to your meta-network. The nodeset will contain the location data from the ERSI ShapeFile.
Things to Be Aware Of

To assure that the latitude and longitude data are properly imported into your meta-network the Node ID must match the information from the ERSI file. If not ORA will not match up the nodes and data will not be imported.

NOTE : For those so inclined this data is retrieved from the ShapeFile's DBF file which can be opened with Excel.
GeoSpatial Options Menu

These options control various display options of the Visualizer.

Show Links : Toggles the visibility of the Links.
Show Labels : Toggles the visibility of the Node Labels.
Show Arrows : Toggles the visibility of the link Arrows.

Toggle Map Grid : Show/Hide the grid on the map

Cluster by Attribute :
Cluster by Area of Influence :

Toggle Cluster Appearance :
Use 2D Visualization (OpenMap) :
Use 3D Visualization (NASA Worldwind): Switches to the 3D map view.

NASA World Wind is mapping software developed by NASA. The globe can be rotated, tilted, and zoomed in and out. Nodes and links are plotted on the globe with word balloons holding descriptions of the nodes.
MGRS Coordinates

MGRS coordinates consist of an even number of characters. It starts off identifying a Grid Zone, and then as more characters are added the location becomes more precise.

To implement, create an attribute called the Military Grid Reference System (MGRS) in your location nodeset. Unlike Lat/Lon, it only requires a single attribute. Populate each location with it's corresponding MGRS, and so on. Apart from it's separate conventions, it operates much the same as the Lat/Lon, in terms of adding it to your data.

NOTE: In terms of Priorities, GIS looks for Lat/Lon data first, then attempts to find MGRS.

Example

An example of an MGRS coordinate, or grid reference, would be 4QFJ12345678, which consists of three parts:

- 4Q (grid zone designator, GZD),
- FJ (the 100,000-meter square identifier), and
- 12345678 (numerical location; easting is 1234 and northing is 5678, in this case specifying a location with 10m resolution). These map coordinates are read from west to east first (easting), then from south to north (northing).

4QFJ15 is the square occupied by Honolulu. The 1 and 5 are the first digits of each of the four-digit combinations. The rest of the digits are used as refinement to the location.
NOTE: Common mnemonics include in the house, up the stairs, left-to-right, bottom-to-top and Read Right Up.

Image Licensing: Image map of Hawaii licensed under the Creative Commons Attribution-Share Alike 3.0 Unported license.
Create Lat/Long Data from Shapefile

Select either a network that does not contain location data or create a new meta-network. From the Editor main menu select Visualizations > GeoSpatial Networks... Using a network with no location data will bring up an alert telling you no location information was detected. Click [ OK ].

NOTE : Use the menu item not the dropdown in the button. This allows you to open up a meta-network that does not contain lat/long data.

From the GeoSpatial menu select File > Add GIS data... > Import Locations From ESRI Shapefile. This will prompt you to select a shapefile. This focuses on the DBF file and its attributes. It finds attributes with the substrings of lat and lon and makes them the location coordinate.

NOTE : The DBF file can be opened in Excel and examined if you are curious.

NOTE : If it finds no appropriate attribute ORA will prompt you to select one or you can skip and go to the next step.
Using the buttons you can either Remove GIS Attribute or Add GIS Attribute.

Add GIS Attribute: Click the [ Add ] button. From the dropdown menu select one of the four type of GIS data: Latitude_Longitude, MGRS, UTM, or Cartesian. Each of the types will ask you to select an attribute(s) to use as the GIS data.

NOTE: This only works if you have an attribute(s) in the correct numeric format. If you have no attributes that can be used keep the selection at <Select Coordinate type>

Remove GIS Attribute: This allows you to remove any GIS data which is currently in the meta-network.

Click [ Next ]

Next is Select Location Node Classes and Attributes.
Import Lat/Long Data from Table

To import an attribute to a Locations node and display the attribute on a map using ORA - GIS

1. Ensure the meta-network has a Location type nodeset.
2. In Excel or .csv file, make sure that latitude and longitude headers are specified (the names have to be specified in full).
3. Latitude and longitude should be in decimal form: 40.689060, -74.044636, not 40° 41' 20.6154? N, 74° 2' 40.689? W
4. In the Data Import Wizard, select Import Excel or text delimited files > Table of node attributes.
5. Select the meta-network with the location nodeset
6. Select the node names to match on (or select Create new nodes). Ensure that the latitude and longitude are imported as numerical values.

![Image of data import wizard]

7. Next, go to ORA-GIS visualizer, load shapefile, and select Shapefiles > Color Shapes by Attribute.

![Image of ORA-GIS visualizer]

Map displays of nodes and the grid can be toggled through the Options menu and layer manager.
**Region Viewer**

NOTE: Before you start make sure your dataset contains both latitude and longitude data in order for information to be plotted and that it is in a numeric format.

From the main menu select Visualizations > Region Viewer. You will be presented with a dialog asking you to select a shapefile. Click the [Load] button and navigate to the shapefile to use. These files use the file extension .shp. After selecting a file click the [Run] button.

**File Type**

NOTE: The Region Viewer only works with WGS84-projected maps.

**Region Viewer**

The Region Viewer and Legend will appear on the screen. The Region Viewer with the shapefile you loaded and the Legend with the nodeset class containing the Latitude and Longitude attributes. Currently there are no values. This needs to be assigned.

**Shape Legend**

Using the Shape Legend you can color individual shapes. Click on a color box and choose a color. After hitting [OK] the shape will take on that color.

**The Menu**

**File**

Save Screenshot: Options for saving a screenshot in either the .PNG or .JPG format.

Close: Closes the Region Viewer

**Action**

Color All Shapes...: Brings up the Select an entity color dialog. All shapes will be colored.

Color All Occupied Shapes...: Will put selected color in shape which contains a node within the shape's boundaries.

Color All Unoccupied Shapes...: Will put selected color in shape which does not contain a node within the shape's boundaries.
Color Shapes by Attribute... : Select an attribute from the drop down. All shapes will be colored based on the value of that attribute

NOTE : The attribute chosen needs to be a numeric value. Text values will not be shown in the drop down.

Color Shapes by Measures : Runs the selected measure on the meta-network and colors shapes from the min and max values.

Color Shapes Using Existing Value : With the Position tool deselected click on the color square and select a new color. Each shape clicked will be given this new color.

The Toolbar

The first three tools are straight forward. The far-right tool needs a slightly longer explanation.

Zoom In : Clicking this button will zoom in the map based on the center of the map

Zoom Out : Clicking on this button will zoom out based on the center of the map.

Position : Clicking this button will toggle the center function and the color function. When highlighted clicking anywhere on the map will make that the current center. The map will redraw based on the new center. When unhighlighted the Colorize tool is activated.

Colorize : When the Position button is not selected this function is available by virtue of the small circle to the left of the color patch.
GIS Links

How Links in GIS work

First, it assumes two node classes, Agent and Location and two networks Agent x Agent, and Agent x Location.

The location node class holds our geospatial information. It is the type Location and will have Latitude and Longitude coordinates. Even if all we had was this node class, we’d be able to see dots on the map. If there’s only one dot, then either there’s only one location with a coordinate, or the other coordinates aren’t formatted properly.

The format for Deg Minutes Second Degree Minute Second or Degree:Minute:Seconds. In the first example, the spaces are intentional.

As for links themselves, any network with target class Location and some non-location Source class infers a source is in that Location An Agent X Location network meaning those agents are in those locations, with a link from A -> Location B means A is in B.

To create links between locations we use other networks. A Location x Location network is fine for looking at inter-location connections. We can also use an Agent x Agent network, since we have Agents in Locations. For any link between Agent 1 and Agent 2, a link is created between any location Agent 1 is in and any location Agent 2 is in.
GeoSpatial Troubleshooting

ORA’s geospatial visualizer is a bit finicky. If you are having trouble displaying your location data in ORA, the likely issue is that your data doesn't have a nodeset of type Location and you aren't using the configuration manager properly.

Here are a few solutions.

1. Re-type the nodeset. If you switch from Agent to Location, and it has the attributes Latitude and Longitude, it'll do it's magic.
2. Create a location nodeset, and link all the nodes together.
3. Within the dialog Data Management->Meta-Network Transform, under the General header, there's an option **Create Implicit locations and networks**. Choosing this operation will automatically do #2 for you. It leaves your Agent and Agent x Agent network alone, creating new Location and Agent X Location networks from the existing data.
4. Use the Location Configuration Manager correctly. The short version: don't select the Agent X Agent network on the second screen.

The long version: By choosing the Agent X Agent network on the second screen, you're indicating that the Network represents an "Is located at" relationship. This is what's causing all the links to be hidden. The Geospatial Visualizer is first creating meta-nodes for each agent, and then adding to that meta-node any other agent that has a link to it. Gets messy quick.
Description

Loom is primarily concerned with how specific entities move or evolve through other entities. In the most basic case, this involves Agents as they move through Locations. More abstract examples include Agents moving through Beliefs or Beliefs moving through Locations.

When you first start Loom, you are prompted for a network. The target nodes in the network dictate what they're moving through. The source nodes are who/what is doing the moving.

Once started, Loom goes through all timeslices, and looks at the connections in that network only. It sets up a series of waypoints based on what connections are made at that timeslice, upon which it constructs a trailset.

Classically, we restrained Loom such that for any timeslice, any source node could appear in at most one target, but now we allow for a source node to occupy multiple targets at a time (Agents having multiple beliefs, for example).

NOTE: Loom can also display things like persons through beliefs showing how a person make change their mindset over time.

A Loom file in .csv is a bit of a misnomer. A loom dataset is a dynamic meta-network. A dynamic meta-network is just a bunch of single meta-networks. For a beginner, that's a good place to start. Take multiple csv's to bring in multiple meta-networks, combine them in ORA (select all meta-networks, right click, Convert to Dynamic Meta-Network), and load in Loom.

Caveat: Loom works best when Agents or whatever occupy a single location at a time. It can handle multiple locations, it just gets messy.

Before you Start

Before starting you need a dataset that can be used within the Loom. One such dataset is the TAVI dataset. Use File > Open Meta Network to open TAVI.xml

The clock icon in the Meta-Network Panel means that it is a dynamic meta network and that there are continuous-time updates (deltas, which are listed below the top-level network) indicating how the network changes over time.
To analyze the data you must have a relation that A) changes over time and B) stays many:one (e.g., a person must have only one location at any given time). Usually this is Agent x Location, but in theory you can select other relations.

In the main ORA screen, open the Visualizer > View Trails. Select the Person x Location input network.

At the top left is a list of Agents; the bottom left is a list of locations. Activating the check-box next to an agent will cause its trail to appear in the right hand panel. The large vertical strips correspond to locations, and the path moving between them is the trail indicating the agent’s location at each point in time.

Open Loom: Highlight the TA VI dataset in the Meta-Network pane. From the drop down menu select Visualizations > View Trailsets. In the dialog box select Persons x Locations. The Loom window will appear with the chosen Network.

1096
1. Person Pane: Lists all persons in the meta-networks. This pane contains a check box to the left of next to each person to control which persons are visible. To the right is a color designation.

2. Location Pane: Lists the locations in the meta-networks. To the right is a color designation.

3. Loom Pane: Displays the persons as they travel through the locations.

Selecting one person you can easily see where they've been (Left window). But when you select multiple people, it can quickly get impossible to view the trails right window.)
Making the Display more Readable: can be done in several ways. Clicking the color circle representing the individual node brings up the color changer. You can then select a color which stands out better for viewing.
Loom File Menu

Open: Opens up DyNetML file which contains location and time data.
Save as: Saves currently open DyNetML file under a new filename.
Export > DyNetML: Saves the Loom data as a DyNetML file.
Save Image as: Saves an image of the current Loom state. Can be saved as a png, jpeg, pdf, svg, or tiff file.
Loom Options Menu

Anti-Aliasing: Used to smooth out rough edged lines.
Grayscale: Removes all colors from image and is good when printing black and white images.
Show Timeline: Displays the timeline markers on the left of the Loom.
Stretch Vertical: You can select a percentage to enlarge the height of the Loom. Good when many nodes are situated in a small area.
Bar Width: Widens the individual locations. Good when many nodes are situated in a small area.

Allow Multiple Waypoints per Period: If unchecked, a node will appear only in the most weighted position. If checked, the node will be placed in all locations.

Example: A main location also contains three separate rooms. An agent can be listed to be in the main location but can also be listed as moving between the individual rooms. If this option is checked, the agent will be shown to be in all locations, which can lead to it appearing an agent is in two places at once.
NOTE: The dotted line denotes a node which disappeared from all locations then reappeared later on.
Trail Clustering

What Trail Clustering Can Do

Classification: Given a set of trails, the algorithm can classify trails based on the underlying patterns of observed location visits.

Level of Similarity: The degree of similarity in the classified trails can be increased or decreased according to user need by varying the specified depth of the PFSA.

Approximate similarity: Further, trails that have a subset of similar patterns of location visits, while also displaying differences by visiting other non-common locations can also be identified by specifying a threshold for the similarity.

Noise Insensitivity: Approximate clustering also provides an inbuilt imperviousness to measurement noise in the trails. Occasional incorrectly identified location in a trail will not prevent it from being classified correctly according to the other correctly identified locations.

Pre-specification of number of clusters: The use of agglomerative clustering eliminates the need of pre-specifying the required number of clusters. Thus, this removes the risk of assigning trails to clusters they do not necessarily belong to (such as in cases where the number of final clusters is less than that necessitated by the dataset).

The Clustering Tool

The clustering tool clusters trails based on similar patterns of visitation to (specific) locations.

One trail that visits location A and B in the pattern ABABAB and another trail that visits location C and D in the pattern CDCDCD would both be clustered because of their alternating natures. But with no overlap the two trails would not be clustered together. But two trails that have the following visit patterns ABCABCABC and BCABCABCA will definitely get clustered.

Trail Pattern Depth

Consider two trails that have the following visit patterns AABAABAAB and ABAABABAA. For a pattern length of 1, the above two trails will definitely get clustered because of they both visit locations A and B with the same frequencies (2:1). When you increase the pattern length, you can get more specific with
transitions. Now for a pattern length of two, the trails still have similar transitions AB, BA, AA but with slightly different frequencies of occurrence. (Ex: AA occurs thrice in trail 1 and twice in trail 2).

They may still get clustered together. But when you increase the pattern length to three that's when things get interesting. You have in trail 2 the pattern BAB that never occurs in trail 1. So they will not get clustered together. This also is the reason why in the Star Wars dataset Han Solo and Chewbacca get grouped together for a trail pattern of 5 because they are almost always co-located throughout the movie.

**Cluster Quality**

With a value of 1.0, it will only return clusters where every sequence of entries is exactly the same. Lower that, it gives some wiggle room. 0.7, you'll get entries that are mostly alike, 0.3, you'll get entries that have a number of similar event strings.

**Minimum Similarity**

For a little more flexibility in the clustering algorithm you can use the minimum similarity feature. If that value is less than 1, for example 0.75, then the clustering algorithm will consider trails which have 75% of the locations in common, i.e. a trails that visits locations A,B,C,D and a trail that visits location B,C,D,E will be compared for similar patterns of visitation to locations B, C and D. If they visit these common locations similarly then they will be clustered together.

**The Loom Dataset**

A Loom dataset is a dynamic meta-network. A dynamic meta-network is a group of single meta-networks. For a beginner, that's a good place to start. Take multiple csv's to bring in multiple meta-networks, combine them in ORA (select all meta-networks, right click, Convert to Dynamic Meta-Network), and load in Loom.

NOTE : Loom works best when agents, or nodes, occupy a single location at a time. It can handle multiple locations, but you may encounter problems reading the display.
**Trail Cluster Creation**

After loading a Loom ready DyNetML set (e.g. The Star Wars dataset) You can show how the characters are clustered. Below is the Loom with entire Star Wars characters set displayed. With this example we are interested in the Aunt Beru/Uncle Owen and Han Solo/Chewbacca pairings. Both pairs followed, for the most part, the similar path.

NOTE : The Loom lists characters in alphabetical order which may, or may not, correspond to the order of the characters in a dataset.

From the menu call up Trail Clustering by selecting Clustering > Show Similar Trails. Leaving most at their defaults I increase the Trail pattern length to four. Clicking [Compute] will display the four characters selecting in the Loom.
NOTE: In this example Uncle Owen = character_5, Aunt Beru = character_6, Han Solo = character_9, and Chewbacca = character_10.

Increasing the Trail pattern length to five removes Uncle Owen (character_5) and Aunt Beru (character_6). If you look at the Loom image below both these nodes appear in only four time slices. When the length is increased to five they are removed from the display.
Trail Cluster Analysis

Trail Clustering using Symbolic Time Series Analysis

The objective of the Trails Cluster Analysis is to find similar behaviors in large networks. This can be described as a network trail generated by an agent over a period of time. This tracking can be used to predict that agent's behavior.

This methodology is fast and flexible and can be applied to several different Node Classes. It views each trail as a sequence of discrete symbols where each symbol is a visited location. Clustering is performed using a model based approach where a representative Probabilistic Finite State Automata model (PFSA) is derived for each trail. Each trail is treated as temporal sequence generated by an underlying Markovian process. The process is assumed to be Markovian of length D; the current location of each agent is influenced only by the past D locations visited by the agent.

The trail clustering is a two-step approach. The first step is a coarse clustering stage where each trail's representative PFSA model is derived using the D-Markov algorithm (Ray, 2004). The value of D significantly affects the granularity of the analysis. A value of 1 for the depth D implies that agents visit the same locations with similar frequencies, though not necessarily in the same order. A higher value of depth implies that agents are clustered based on visiting locations in the same order with similar frequencies. After the models are derived, the trails are grouped into coarse clusters where the cluster membership is determined based only on the locations that the agents visit and not on the frequencies with which these locations are visited. The second step of the trail clustering algorithm is cluster refinement where hierarchical clustering is performed on each of the coarse clusters to form groups of trails where each of the trails visit locations with similar visit probabilities.

Figure 1: Trail Clustering Menu in LOOM
Sometimes it's necessary to look beyond trails which do not visit all the same locations but do visit many of them. For this a cluster quality index is used. It finds which percentage of locations are common amongst the coarse trails.

A cluster quality of [ 1 ] implies that trails which visit the exact same locations are only grouped together into coarse clusters. A cluster quality of [ 0.5 ] implies that all the trails in a coarse cluster have at least 50% of locations in common. The cluster refining step then groups the trails in the coarse cluster based on probability of visiting these common locations with similar frequencies.

The Clustering Tool is integrated into the LOOM Visualization tool. It requires two inputs:

1 : The trail pattern depth for the generation of PFSA.
2 : The cluster quality.

Trail clustering allows for the extraction of groups of trails that demonstrate similar behavior. (i.e. visiting the location in the same order though not necessarily at the same time). LOOM allows several different options for these visualizations.

![Cluster Visualization Options](image)

*Figure 2 : Cluster Visualization Options*

In addition to showing all the trails in each cluster and only the longest trail, LOOM also allows the visualization of the longest common subsequence amongst all the trails in a cluster. Trails belonging to the same cluster will have more sequences of locations visited in the same order (not necessarily consecutively) than trails belonging to different clusters. The longest common subsequence in a cluster depicts the most common behavior pattern amongst the agents that led to their being grouped together. The five different approaches to visualization of clusters provided by LOOM allows the end user different viewpoints of the clustered trails based on the analysis requirement.
Cluster Quality

First and foremost, it is only concerned with the sequence of transitions. It doesn't care when they occurred, only that they occurred. Trail depth indicates how many entries in a sequence it looks at.

Assuming trails a->b->a->c->d->a->b->c

Trails depth of two creates the following entries (ab)(ba)(ac)(ad)(da)(bc). Trails depth of three create (aba)(baa)(aac)(acd)(cda)(dab)(abc) And so on, and so on.

Cluster Quality is likely where your issue is with creating clusters. With a value of 1.0, it will only return clusters where every sequence of entries is exactly the same. Lower that, it gives some wiggle room. 0.7, you'll get entries that are mostly alike, 0.3, you'll get entries that have a number of similar event strings.

References


Loom Events Menu

Load Events from File: Load csv file containing two columns (date, events)

Group Events By:
- Don't Group: Makes each line correspond to one event.
- Day: Each line will correspond to a summation of all events for a day
- Month: Each line will correspond to a summation of all events for a month
- Year: Each line will correspond to a summation of all events for a year

Show Events: A toggle to show/hide event lines.
Make Loom Dataset

Multiple meta-networks can be combined into a single meta-network usable in Loom.

Prerequisites

To create a dataset usable in Loom it requires multiple meta-networks containing the exact same nodes/nodesets/networks. What changes between the multiple meta-networks is which Nodes and Links are present in each timeslice.

NOTE : Every nodeset needs to contain identical nodes in every nodeset. No exceptions.

What differs is the networks created from these agent and location nodesets. Below shows the difference between the first three time slices of the Star Wars set. Identical characters and locations but each network changes as to which characters are listed in individual locations.

Star Wars - Time Slice 1
<table>
<thead>
<tr>
<th></th>
<th>Tatooine</th>
<th>Mos Eisley</th>
<th>Sandcrawler</th>
<th>Moisture Farm</th>
<th>&quot;The Hills&quot;</th>
<th>Rebel Blockade</th>
<th>Death Star</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Princess Leia</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>R2-D2</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>C-3PO</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Luke Skywalker</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Uncle Owen</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Aunt Beru</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Obi-Wan Kenobi</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Greedo</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Han Solo</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Chewbacca</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Darth Vader</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

**Star Wars - Time Slice 2**

<table>
<thead>
<tr>
<th></th>
<th>Tatooine</th>
<th>Mos Eisley</th>
<th>Sandcrawler</th>
<th>Moisture Farm</th>
<th>&quot;The Hills&quot;</th>
<th>Rebel Blockade</th>
<th>Death Star</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Princess Leia</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>R2-D2</strong></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>C-3PO</strong></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Luke Skywalker</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Uncle Owen</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Aunt Beru</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Obi-Wan Kenobi</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Greedo</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Han Solo</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Chewbacca</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Darth Vader</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

**Star Wars - Time Slice 3**

1114
Creating a Data Set

Load all meta-networks into ORA. Highlight all these meta-networks. Right-Click to bring up the context menu.

<table>
<thead>
<tr>
<th>Character</th>
<th>Tatooine</th>
<th>Mos Eisley...</th>
<th>Sandcrawler</th>
<th>Moisture Farm...</th>
<th>&quot;The Hills&quot;</th>
<th>Rebel Blockade...</th>
<th>Death Star</th>
</tr>
</thead>
<tbody>
<tr>
<td>Princess Leia</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R2-D2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C-3PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Luke Skywalker</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uncle Owen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aunt Beru</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Obi-Wan Kenobi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Greedo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Han Solo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chewbacca</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Darth Vader</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Select Create Dynamic Meta-Network. This brings up the Create dialog box.
Clear check marks under Import as keyframe from all instance except the first. Then click the Create button.
Creates Meta-Network with Clock

- Star Wars Episode IV: A New Hope, part 1
- Star Wars Episode IV: A New Hope, part 2
- Star Wars Episode IV: A New Hope, part 3
- Star Wars Episode IV: A New Hope, part 4
- Star Wars Episode IV: A New Hope, part 5
- Star Wars Episode IV: A New Hope, part 6
- Star Wars Episode IV: A New Hope, part 7
- Star Wars Episode IV: A New Hope, part 8
- Star Wars Episode IV: A New Hope, part 9
- Star Wars Episode IV: A New Hope, part 10
- Star Wars Episode IV: A New Hope, part 11
- Star Wars Episode IV: A New Hope, part 12
- Star Wars Episode IV: A New Hope, part 13
- Star Wars Episode IV: A New Hope, part 14
- Star Wars Episode IV: A New Hope, part 15
- Star Wars Episode IV: A New Hope, part 16
- Star Wars Episode IV: A New Hope, part 17
- Star Wars Episode IV: A New Hope, part 18
- Star Wars Episode IV: A New Hope, part 19
- Star Wars Episode IV: A New Hope, part 20
- Star Wars Episode IV: A New Hope, part 21
- Star Wars Episode IV: A New Hope, part 22
- Star Wars Episode IV: A New Hope, part 23
- Star Wars Episode IV: A New Hope, part 24
- Dynamic Meta-Network

Now you have a dynamic meta-network that can be viewed in Loom.
ORA Measures

ORA contains over 100 measures.

**What is a Measure?**

A measure is a function that takes as input a meta-network and outputs a single value or a vector of values. The measure value tells something about the structure of the meta-network.

Consider the measure Density. This measure takes as input a single network and outputs a single value between zero and one which is the ratio of the number of links in the network to the number of total possible links.

Each measure available in ORA is described in the help system. The different parts of the help system are described below.
# Measures General Information

## Measure Input

A measure takes as input one or more networks. A network is unimodal (aka square) if the source nodeset (the row nodes) is the same as the target nodeset (the column nodes), and bimodal otherwise.

The following nodesets and networks (with their abbreviated symbol) are used throughout the document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following networks defined on these nodesets are used throughout the documentation:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Source Nodeset</th>
<th>Target Nodeset</th>
<th>General Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>Agent</td>
<td>Agent</td>
<td>Communication Network</td>
</tr>
<tr>
<td>AK</td>
<td>Agent</td>
<td>Knowledge</td>
<td>Knowledge Network</td>
</tr>
<tr>
<td>AR</td>
<td>Agent</td>
<td>Resource</td>
<td>Capabilities Network</td>
</tr>
<tr>
<td>AT</td>
<td>Agent</td>
<td>Task</td>
<td>Assignment Network</td>
</tr>
<tr>
<td>KK</td>
<td>Knowledge</td>
<td>Knowledge</td>
<td>Information Network</td>
</tr>
<tr>
<td>KR</td>
<td>Knowledge</td>
<td>Resource</td>
<td>Training Network</td>
</tr>
<tr>
<td>KT</td>
<td>Knowledge</td>
<td>Task</td>
<td>Knowledge Requirement Network</td>
</tr>
<tr>
<td>RR</td>
<td>Resource</td>
<td>Resource</td>
<td>Resource Substitute Network</td>
</tr>
<tr>
<td>RT</td>
<td>Resource</td>
<td>Task</td>
<td>Resource Requirement Network</td>
</tr>
<tr>
<td>TT</td>
<td>Task</td>
<td>Task</td>
<td>PrecePrecedence Network</td>
</tr>
</tbody>
</table>

The measure help description lists the type of network that it requires, and each network can have the following additional requirements:

- binary: link weights are ignored (all links are treated as if they had value one)
- symmetric: link direction is ignored (asymmetric links are made symmetric by adding the reciprocal link)
- interpretation: link value interpretation that describes what the measure expects the link values to mean.

**Measure Input Mode**

A measure can be characterized by its Input Mode which describes the number and type of inputs required:

- One Mode the measure takes as input a single unimodal network
- Two Mode the measure takes as input a single bimodal network
- Multi Mode the measure takes as input more than one network
- A measure that takes as input a single network (unimodal or bimodal) is called both One Mode and Two Mode

**Link Value Interpretation**

Measures generally interpret link values as the degree of similarity between two nodes. Thus, a larger value for link \((i,j)\) means that nodes \(i\) and \(j\) are more alike. An important exception is with the geodesic distance measures which interpret link value \((i,j)\) as the distance from node \(i\) to node \(j\), and this is a measure of dissimilarity.

Note that one can change the meaning of a link value from similarity to dissimilarity by inverting the link values (see the Meta-Network Transform or the Network Editor for how to do this).

**Measure Output**

A measure can output a single value or a vector of values, and a measure is classified by this output as:

- Node Level: which is true or false and indicates whether the measure outputs a single value that characterizes the input network(s) as a whole.
- Network Level: which is true or false and indicates whether the measure outputs a vector of values, one per input node.

**Formula Notation:**

Most measures cite a paper or book that describes in detail the measure. Most measures also have a formula that describes in detailed mathematical notation how it is computed. The notation for these formulas follows that of MATLAB, a common mathematics package for working with matrices. These are the common notations used in the measure formulas:

Let \(A\) be the matrix associated with a network.
• rows(A) is an integer value and is the number of rows in the matrix
• cols(A) is an integer value and is the number of columns in the matrix
• min(A) is a real value and is the minimum of all elements in the matrix
• max(A) is a real value and is the maximum of all elements in the matrix
• sum(A) is a real value and is the sum of all elements in the matrix
• rowsum(A) is a vector with size equal to the number of rows of A and contains the sum of the rows of A
• colsum(A) is a vector with size equal to the number of columns of A and contains the sum of the columns of A
• A(i,:) is the i'th row vector of the matrix
• A(:,j) is the j'th column vector of the matrix
• A * B is the standard matrix multiplication of matrix A with B
• A .* B is the cell by cell product of A and B (i.e. if C = A .* B, then C(i,j) = A(i,j)*B(i,j))
• [A>0] is a boolean matrix of the same dimension of A that has value 1 exactly when A is positive value (i.e. let B = [A>0], then B(i,j) = 1 iff A(i,j) > 0)
• binary(A) is the binarized (dichotomized) version of A, and is an alternative notation for [A>0]
• [A == c] is a boolean matrix of the same dimension of A that has value 1 exactly when A is equal to c (i.e. let B = [A == c], then B(i,j) = 1 iff A(i,j) == c). A typical usage is for c equal to one.
• A - B is standard matrix subtraction
• A - t where t is a scalar subtracts t from each value of A (e.g. let B = A - t, then B(i,j) = A(i,j) - t
• t - A where t is a scalar, subtracts from t each value of A (e.g. let B = t - A, then B(i,j) = t - A(i,j))

Measures Manager

In addition to the help system, the Measures Manager lists all of the measures available in ORA and gives some input and output information about each one. The Measures Manager is accessed from the Analysis main menu. The Measures Manager categorizes measures in the following ways:

• Node Level: whether the measure has node level output
• Network Level whether the measure has network level output
• Computation Time which is either Fast, Normal, or Slow and indicates the computation time of the measure.
• Uses Link Values which is true or false and indicates whether the measure uses link values during the computation. If false, then link value are ignored by treating all non-zero values as one. That is, the network is implicitly made binary.

The Measures Manager is used to choose which measures to use in reports, charts, or the Visualizer. When accessed from the main menu Analysis, the selected measures
determine which are used in the Visualizer. Reports and charts have a local Measures Manager that overrides the settings of the main menu, global setting.

**Significant Digits**

ORA stores data in single-precision (float) format. Most measures perform their mathematical operations in single-precision computer arithmetic (Eigenvector Centrality is a notable exception; it uses double-precision arithmetic). By default ORA prints results in 3-digit, fixed decimal notation (e.g. 5.262 or 0.078)

With very large networks it is not uncommon for various measures, e.g. closeness to be quite small. As such, with only three significant digits after the decimal place they will appear as zero. In this case, a 6-digit scientific notation is preferable.

You can change the number of decimal places and format by using ORA preferences. From the main menu select Preferences > All preferences.... Then, in the Ora Preferences dialog box that opens: select Reports tree on the left, select the Formatting tab. Set Decimal precision dial widget to the precision you want.
Vector Statistics

A vector of values, such as those output from a node level measure, can be characterized using different statistics. ORA uses the following statistics.

Centralization

This is a measure of the vector's spread or variability. It is defined as the normalized sum of distances from the maximum value.

Specifically, let \( v \) be a vector of values, and let \( v_{\text{bar}} \) be the maximum value of \( v \).

Then the Centralization (unnormalized) of vector \( v = (v_{\text{bar}} - v) \)

Measures such as Betweenness Network Centralization and Closeness Network Centralization will normalize this value in different ways.

Herfindahl-Hirshman Index (Normalized)

This measures the degree of concentration in a vector of values, that is, the degree to which one or a small number of values dominate the total sum of the values. It was originally developed and still used in Economics to measure the degree that a market is a monopoly (the vector values are market shares for each firm).

The measure is computed as follows:

let \( v \) be a vector of \( N \) values whose total sum is \( T \)

let \( H = \sum_{i=1}^{N} \left( \frac{v_i}{T} \right)^2 \) : for all \( 1 \leq i \leq N \)

Thus \( H \) is the sum of the fractions (squared) that each value of the vector contributes to the total sum \( T \).

Note that \( H \) is between \( 1/N \) and 1.

ORA normalizes \( H \) to be between 0 and 1 by computing: \( H - 1/N \) / (1 - 1/N)
# Mode Table

## 2-Mode Measures

### Quantity

Quantity measures count or average the entries of a matrix.

<table>
<thead>
<tr>
<th><strong>Degree</strong> - Counting the row or column entries of a two mode network.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Node</td>
</tr>
<tr>
<td>Current ORA measures: columnDegreeCentrality, inDegreeCentrality, outDegreeCentrality, rowDegreeCentrality, columnCount, rowCount, edgeCount, capability</td>
</tr>
</tbody>
</table>

Load-On network level, a single value for the entire network is calculated through averaging link values.

| Level: Network |
| Reference: Carley (2002) |
| Current ORA measures: knowledgeLoad, resourceLoad, density, rowBreadth, columnBreadth. |

### Variance

Variance measures create network level indices that describe the distribution of connections in networks.

<table>
<thead>
<tr>
<th><strong>Centralization</strong> - On way to describe the variance in a network is through calculating network centralizations based on the results of centrality measures.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Freeman (1979)</td>
</tr>
<tr>
<td>Current ORA measures: columnDegreeCentralization, inDegreeCentralization, outDegreeCentralization, rowDegreeCentralization</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Diversity</strong> - Diversity is a group measure and results in a single value for the whole network.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Hirschman (1945)</td>
</tr>
<tr>
<td>Current ORA measures: knowledgeDiversity, resourceDiversity</td>
</tr>
</tbody>
</table>

### Correlation

Correlation measures create a matrix $A$ that describe similarities/dissimilarities between all pair of agents.

<table>
<thead>
<tr>
<th><strong>Similarity</strong> - The degree of similarity between two agents based on shared knowledge.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Node</td>
</tr>
<tr>
<td>Reference: Carley (2002)</td>
</tr>
<tr>
<td><strong>Distinctiveness</strong> - Measures the degree to which each pair of agents ((i; j)) has complementary knowledge, expressed as the percentage of total knowledge.</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td><strong>Level:</strong> Dyad</td>
</tr>
<tr>
<td><strong>Reference:</strong> Carley (2002)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> relativeCognitiveDistinctiveness, cognitiveDistinctiveness, correlationDistinctiveness</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Resemblance</strong> - Measures the degree to which each pair of agents has the exact same knowledge.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level:</strong> Dyad</td>
</tr>
<tr>
<td><strong>Reference:</strong> Carley (2002)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> relativeCognitiveResemblance, cognitiveResemblance, correlationResemblance</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Expertise</strong> - The degree of dissimilarity between agents based on shared knowledge. Each agent computes to what degree the other agents know what they do not know.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level:</strong> Node</td>
</tr>
<tr>
<td><strong>Reference:</strong> Carley (2002)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> relativeCognitiveExpertise, cognitiveExpertise, relativeExpertise, correlationExpertise</td>
</tr>
</tbody>
</table>

Specialization: These measures identify agents that have either exclusive or redundant connections to other node class entities.

<table>
<thead>
<tr>
<th><strong>Exclusivity</strong> - Detects agents who are exclusively connected to elements of other node classes.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level:</strong> Node</td>
</tr>
<tr>
<td><strong>Reference:</strong> Ashworth and Carley (2006)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> knowledgeExclusivity, resourceExclusivity, taskExclusivity, exclusivityComplete, exclusivity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Redundancy</strong> - Knowledge is redundant if there are different agents sharing the same knowledge.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level:</strong> Network</td>
</tr>
<tr>
<td><strong>Reference:</strong> Carley (2002)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> columnRedundancy, rowRedundancy, knowledgeRedundancy, accessRedundancy, resourceRedundancy, assignmentRedundancy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Access</strong> - An access index identifies connections to critical knowledge, resources, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level:</strong> Node</td>
</tr>
<tr>
<td><strong>Reference:</strong> Ashworth and Carley (2006)</td>
</tr>
<tr>
<td><strong>Current ORA measures:</strong> knowledgeAccessIndex, resourceAccessIndex</td>
</tr>
</tbody>
</table>
Multi-Mode Measures

Quantity:

<table>
<thead>
<tr>
<th>Degree - Total number of people reporting to an agent, plus its total knowledge, resources, and tasks can be considered as Personnel Costs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Wasserman and Faust (1994)</td>
</tr>
<tr>
<td>Current ORA measures: complexity</td>
</tr>
</tbody>
</table>

Coherence: Coherence measures analyze to what extent requirements are accomplished by the actual allocation of agents to tasks.

<table>
<thead>
<tr>
<th>Congruence - Measures the similarity between what Knowledge is assigned to tasks via agents, and what Knowledge is required to do Tasks. Perfect congruence occurs when Agents have Knowledge when and only when it is needful to complete their Tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Carley (2002)</td>
</tr>
<tr>
<td>Current ORA measures: communicationCongruence, knowledgeCongruence, resourceCongruence, socialTechnicalCongruence (2 mode)</td>
</tr>
</tbody>
</table>

Needs - Task Knowledge Needs compares the Knowledge requirements of each Task with the Knowledge available to the Task via Agents assigned to it.

<table>
<thead>
<tr>
<th>Needs - Task Knowledge Needs compares the Knowledge requirements of each Task with the Knowledge available to the Task via Agents assigned to it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Node, Network</td>
</tr>
</tbody>
</table>

Waste - Waste measures focus on the missing part of congruence.

<table>
<thead>
<tr>
<th>Waste - Waste measures focus on the missing part of congruence.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Node, Network</td>
</tr>
</tbody>
</table>

Performance - Knowledge Based Task Completion calculated the percentage of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite Knowledge to do the Tasks.

<table>
<thead>
<tr>
<th>Performance - Knowledge Based Task Completion calculated the percentage of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite Knowledge to do the Tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Workload - Workload measures look for the Knowledge or Resource an Agent uses to perform Tasks to which it is assigned.</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Level: Node</td>
</tr>
<tr>
<td>Reference: Carley (2002)</td>
</tr>
<tr>
<td>Current ORA measures: knowledgeActualWorkload, resourceActualWorkload, actualWorkload, knowledgePotentialWorkload, resourcePotentialWorkload, potentialWorkload</td>
</tr>
</tbody>
</table>

Substitution: This group is rather diverse and include concepts and measures describing to which extent Agents can be substituted based on identical Roles or Agents need to negotiate with each other as well as Knowledge and Resources that is used or reused to perform Tasks.

<table>
<thead>
<tr>
<th>Availability - Availability measures use the node class Roles. Role Based Knowledge Availability computes the number of roles that an agent is qualified to have based on knowledge requirements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Behrman</td>
</tr>
<tr>
<td>Current ORA measures: roleKnowledgeAvailability, roleResourceAvailability, knowledgeBasedRoleAvailability, organizationalAvailability, resourceBasedRoleAvailability, overallRoleAvailability</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reuse - Knowledge utilization can be calculated with Reuse measures of Knowledge or Resources.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Carley et al. (2000)</td>
</tr>
<tr>
<td>Current ORA measures: knowledgeOmega, resourceOmega</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Negotiation - The extent to which Agents need to negotiate with each other because they lack the Knowledge to complete their assigned Tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Network</td>
</tr>
<tr>
<td>Reference: Carley (2002)</td>
</tr>
<tr>
<td>Current ORA measures: knowledgeNegotiation, resourceNegotiation</td>
</tr>
</tbody>
</table>

Control: Control measures are the most complex measures as they combine a couple of calculations into a single measure. Control measures describe to which extent an Agent is either important (central) for an entire meta-network or Agents have similar perspectives of the network.

<table>
<thead>
<tr>
<th>Demand - Cognitive Demand measures total amount of cognitive effort expended by each agent to communicate, performs its tasks, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level: Node</td>
</tr>
<tr>
<td>Reference: Carley (2002)</td>
</tr>
<tr>
<td>Current ORA measures: cognitiveDemand</td>
</tr>
<tr>
<td>--------------------------------------</td>
</tr>
<tr>
<td><strong>Awareness</strong> - A dyadic cognitive concept is Awareness. Share Situation Awareness measures the degree to which an Agents as similar, based on social interaction, physical distance, and socio-demographic data.</td>
</tr>
<tr>
<td>Level: Node, Dyad</td>
</tr>
<tr>
<td>Reference: Graham et al. (2004)</td>
</tr>
<tr>
<td>Current ORA measures: sharedSituationAwareness</td>
</tr>
</tbody>
</table>
Fast Measures

These measures are fast to compute and generally count nodes and links.

Measure Name | Uses link weights | Input Mode | Output values | Agent Socio Economic
---|---|---|---|---
Power | No | Multi Mode | Node Level | Capability | Yes or Two Mode
Breadth | No | One or Two Mode | Network Level | Column Count | Yes | One or Two Mode
Exclusivity | No | One or Two Mode | Node Level | Column Exclusivity | Complete | No | One or Two Mode
Gini Means Difference | Yes | One or Two Mode | Node Level | Column Redundancy | No One or Two Mode
Level Complexity | No | Network Level | Density | No One or Two Mode
Level Diagonal | Yes | One Mode | Network Level | In-Degree Average Neighbor | Yes | One or Two Mode
Level In-Degree Centrality | Yes | One or Two Mode | Network Level | Centralization | Yes | One or Two Mode
Level Interdependence | No | One Mode | Network Level | Node Count | No | One Mode
Level Isolate Count | No | One Mode | Network Level | Knowledge Based Access | Index | No | Multi Mode
Level Link Count | No | One or Two Mode | Network Level | Assortativity | Yes | One Mode
Level Row Count | No | One or Two Mode | Network Level | Resource Based Access | Index | No | Multi Mode
Level Row Exclusivity | No | One or Two Mode | Node Level | Row Exclusivity | Complete | No | One or Two Mode
Level Row Gini Means Difference | Yes | One or Two Mode | Node Level | Row Redundancy | No | One or Two Mode
Sequential Link Count | No | One Mode | Network Level | Span of Control | Yes | One Mode
Span Of Control | No | One Mode | Network Level | Total Degree | Degree Centrality | Yes | One Mode
Twitter, Average Mentions Per Tweet | Yes | Multi Mode | Network Level | Twitter, Number of Followers | Yes | One Mode
Twitter, Total Mentions | Yes | Multi Mode | Network Level | Twitter, Reciprocal Mentions | Unweighted | Yes | Two Mode
Twitter, Trusted Source | Yes | Two Mode | Network Level | Twitter, Wants To Be Influencer | Yes | Two Mode
Uni-directional Link Count | No | One Mode | Network Level | Weighted Degree | Yes | One Mode
Weighted Link Sum | Yes | One or Two Mode | Network Level | 

1130
Normal Measures

These measures take an average or normal amount of time to compute and usually involve a single matrix multiplication or a single pass over all links.

Measure Name Uses link weights Input Mode Output values Actual Workload No Multi Mode Node Level Agent Knowledge Needs Congruence No Multi Mode Node Level Agent Knowledge Waste Congruence No Multi Mode Node Level Agent Resource Needs Congruence No Multi Mode Node Level Agent Resource Waste Congruence No Multi Mode Node Level Authority Centrality Yes One or Two Mode Node Level Average Speed Yes One Mode Network Level Bi-directional Link Count No One Mode Network Level Bonacich Power Centrality Yes One Mode Node Level Boundary Spanner No One Mode Node Level Brokerage No One Mode Node Level Characteristic Path Length Yes One Mode Network Level Clique Count No One Mode Network Level, Node Level Clustering Coefficient Density No One Mode Network Level, Node Level Cognitive Demand Yes Two Mode Node Level Communication No Multi Mode Node Level Communication Congruence No Multi Mode Network Level Connectedness No One Mode Network Level Constraint Structural Holes Yes One Mode Node Level Centrality Yes One Mode Node Level Cosine Similarity Correlation No One or Two Mode Node Level, Dyad Level Diameter Yes One Mode Network Level Distinctiveness Correlation No One or Two Mode Node Level, Dyad Level Eccentricity Centrality Yes One Mode Node Level Effective Network Size Structural Holes Yes One Mode Node Level Efficiency No One Mode Network Level Efficiency Structural Holes Yes One Mode Node Level Eigenvector Centrality Yes One Mode Node Level Expertise Correlation No One or Two Mode Node Level, Dyad Level Fragmentation No One Mode Network Level Geodesic Distance Yes One Mode Dyad Level Hub Centrality Yes One or Two Mode Node Level Individual Congruence No Multi Mode Node Level Jaccard Similarity Correlation No One or Two Mode Node Level, Dyad Level K-core No One Mode Node Level Katz Centrality Yes One Mode Node Level Knowledge Actual Workload No Multi Mode Node Level Knowledge Based Task Completion No Multi Mode Network Level Knowledge Negotiation No Multi Mode Network Level Knowledge Potential Workload No Multi Mode Node Level Knowledge Under Supply No Multi Mode Network Level Minimum Speed Yes One Mode Network Level Organization Agent Knowledge Needs Congruence No Multi Mode Network Level Organization Agent Knowledge Waste Congruence No Multi Mode Network Level Organization Agent Resource Needs Congruence No Multi Mode Network Level Organization Agent Resource Waste Congruence No Multi Mode Network Level Organization Task Knowledge Needs Congruence No Multi Mode Network Level Organization Task Knowledge Waste Congruence No Multi Mode Network Level Organization Task Resource Needs Congruence No Multi Mode Network Level Organization Task Resource Waste
CongruenceNoMulti ModeNetwork Level Overall Task Completion NoMulti ModeNetwork Level PageRank Centrality Yes One ModeNode Level Performance As Accuracy NoMulti ModeNetwork Level Potential Workload NoMulti ModeNode Level Radiality Centrality Yes One ModeNode Level Reachable Diameter Yes One ModeNetwork Level Reciprocity No One ModeNetwork Level Resemblance Correlation No One or Two ModeNode Level, Dyad Level Resource Actual Workload No Multi ModeNode Level Resource Based Task Completion No Multi ModeNetwork Level Resource Negotiation No Multi ModeNetwork Level Resource Potential Workload No Multi ModeNode Level Resource Under Supply No Multi ModeNetwork Level Shared Situation Awareness No Two ModeNode Level, Network Level, Dyad Level Simmelian Ties No One ModeNode Level Skip Link Count No One ModeNetwork Level Social Technical Congruence No Multi ModeNetwork Level, Dyad Level Strict Knowledge Congruence No Multi ModeNetwork Level Strict Resource Congruence No Multi ModeNetwork Level Strong Component Count No One ModeNetwork Level, Node Level Task Knowledge Needs Congruence No Multi ModeNode Level Task Knowledge Waste Congruence No Multi ModeNode Level Task Resource Needs Congruence No Multi ModeNode Level Task Resource Waste Congruence No Multi ModeNode Level Transitivity No One ModeNetwork Level Triad Count No One ModeNode Level Twitter, Actual Influencer Yes Multi ModeNode Level Twitter, Most Mentioned Yes Two ModeNode Level Twitter, Potential Connectors Yes Multi ModeNode Level Twitter, Potential Consensus Leaders Yes Two ModeNode Level Twitter, Reciprocal Mentions Clique Count Yes Two ModeNode Level Twitter, Topic Local Connectors Yes Two ModeNode Level Twitter, Total Mentions K-Core Yes Multi ModeNode Level Twitter, Total Mentions Page Rank Yes Multi ModeNode Level Weak Component Count No One ModeNetwork Level Weak Component Members No One ModeNode Level Weak Component Size No One ModeNode Level Weighted Individual Congruence No Multi ModeNode Level
Slow Measures

These measures are slow to compute and often involve shortest path computations and/or matrix multiplications.

<table>
<thead>
<tr>
<th>Measure Name</th>
<th>Uses link weights</th>
<th>Input Mode</th>
<th>Output values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Betweenness Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Spatial</td>
<td>Yes</td>
<td>Multi Mode</td>
<td>Betweenness Centrality</td>
</tr>
<tr>
<td>Network Centralization</td>
<td>Yes</td>
<td>One Mode</td>
<td>Network Level</td>
</tr>
<tr>
<td>Closeness Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Spatial</td>
<td>Yes</td>
<td>Multi Mode</td>
<td>Closeness Network Centralization</td>
</tr>
<tr>
<td>Degree Centrality</td>
<td>Spatial Yes</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Diffusion</td>
<td>No</td>
<td>One Mode</td>
<td>Network Level</td>
</tr>
<tr>
<td>Eigenvector Centrality</td>
<td>Spatial Yes</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Network Centralization</td>
<td>Yes</td>
<td>One Mode</td>
<td>Network Level</td>
</tr>
<tr>
<td>Exponential Rank Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Global Efficiency</td>
<td>Yes</td>
<td>One Mode</td>
<td>Network Level</td>
</tr>
<tr>
<td>In-Closeness Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>In-Inverse Closeness Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Information Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Knowledge Omega</td>
<td>No</td>
<td>Multi Mode</td>
<td>Network Level</td>
</tr>
<tr>
<td>Link Betweenness Centrality</td>
<td>Yes</td>
<td>One Mode</td>
<td>ModeDyad Level</td>
</tr>
<tr>
<td>Local Efficiency</td>
<td>Yes</td>
<td>One Mode</td>
<td>ModeNetwork Level</td>
</tr>
<tr>
<td>Location Relevance</td>
<td>Yes</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Overall Role Based Availability</td>
<td>No</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Correlation</td>
<td>No</td>
<td>One or Two Mode</td>
<td></td>
</tr>
<tr>
<td>Potential Boundary Spanner</td>
<td>Yes</td>
<td>One Mode</td>
<td>ModeNetwork Level</td>
</tr>
<tr>
<td>Resource Omega</td>
<td>Multi</td>
<td>ModeNetwork Level</td>
<td></td>
</tr>
<tr>
<td>Role Based Knowledge Availability</td>
<td>No</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Role Based Resource Availability</td>
<td>No</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Twitter, Potential Reach</td>
<td>No</td>
<td>Multi Mode</td>
<td>Node Level</td>
</tr>
<tr>
<td>Upper Boundedness</td>
<td>No</td>
<td>One Mode</td>
<td>Network Level</td>
</tr>
</tbody>
</table>
Actual Workload

Description
The knowledge and resources an agent uses to perform the tasks to which it is assigned. Individuals or organizations that are high in workload are those that are doing more complex tasks and have the resources and knowledge or expertise to do those tasks. Tasks are more complex if they require more expertise and/or more resources.

Example
In a given organization, employees have access to certain knowledge (e.g., fix computers) and resources (e.g., computer parts). This measure would compute a value to reflect the overall level of organizational access within the network.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
Actual Workload is computed using Knowledge Actual Workload with the network AK replaced by the concatenated [AK AR] and KT replaced by the concatenated [KT;RT].

Reports Using Measure
- All Measures
- Change in Key Entities
- Key Entity
- Management

View report to measure table | View measure to report table
Agent Knowledge Needs Congruence

Description
The number of knowledge that an agent lacks to complete its assigned tasks expressed as a fraction of the total knowledge required for the assigned tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
Agent Knowledge Needs compares the knowledge needs of the agent to do its assigned tasks with the actual knowledge of the agent. The measure value for an agent increases when it has need of knowledge to which it is not assigned.
Let \( NK = AT^*KT' = \) knowledge needed by agents to do their assigned tasks

Then the output value for agent \( i = \frac{\text{sum}(NK(i,:) \cdot \sim AK(i,:))}{\text{sum}(NK(i,:))} \)

**Reports Using Measure**

- All Measures

*View report to measure table* | *View measure to report table*
Agent Knowledge Waste Congruence

Description
The number of knowledge that an agent has that are not needed by any of its tasks expressed as a fraction of the total knowledge of the agent.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Agent Knowledge Waste compares the knowledge of the agent with the knowledge it actually needs to do its tasks. Any unused knowledge is considered wasted.

Let \( NK = AT^*KT' \) = knowledge needed by agents to do their assigned tasks
Then the output value for agent $i = \frac{\text{sum}((\sim NK(i,:) .* AK(i,:)))}{\text{sum}(NK(i,:))}$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Agent Resource Needs Congruence

Description

The number of resources that an agent lacks to complete its assigned tasks expressed as a fraction of the total resources required for the assigned tasks.

Input Networks

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source node set</th>
<th>Target node set</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity

Normal computation time

Output

Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation


Formula

Agent Resource Needs compares the resource needs of the agent to do its assigned tasks with the actual resources of the agent. The measure value for an agent increases when it has need of resources to which it is not assigned.
Let NR = AT*RT' = resource needed by agents to do their assigned tasks

Then the output value for agent i = sum(NR(i,:)) * ~AR(i,:)) / sum(NR(i,:))

**Reports Using Measure**

- All Measures

[View report to measure table] | [View measure to report table]
Agent Resource Waste Congruence

Description
The number of resource that an agent has that are not needed by any of its tasks expressed as a fraction of the total resources of the agent.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Agent Resource Waste compares the resources of the agent with the resources it actually needs to do its tasks. Any unused resources is considered wasted.

Let $NR = AT^*RT^*$ = resources needed by agents to do their assigned tasks
Then the output value for agent $i = \frac{\text{sum}(\sim NR(i,:) \cdot AR(i,:))}{\text{sum}(NR(i,:))}$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Agent Socio Economic Power

Description
A measure of actor power based on access to knowledge, resources, and tasks in the organization.

Input Networks
These networks are used to compute the measure:

Source nodeset Target nodeset Link values
agent knowledge binary
agent resource binary
agent task binary

Complexity
Fast computation time

Output
Node level (one value per node)
Value type: Real
Minimum value: 0
Maximum value: 1

Citation
Carley, 2004

Formula
This is the Out-Degree Centrality of the binarized concatenated network:

[AK AR AT]

At least one of the input networks must exist, there can be multiple networks of each type, and not all types must exist. For example, the measure can be computed on [AK], or on [AK AR], or [AK1 AK2].

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Authority Centrality

Description
A node is authority-central to the extent that its in-links are from nodes that have many out-links. Individuals or organizations that act as authorities are receiving information from a wide range of others each of whom sends information to a large number of others.

Technically, an agent is authority-central if its in-links are from agents that have are sending links to many others. The scientific name of this measure is authority centrality and it is calculated on agent by agent matrices.

Hubs and authorities are a natural generalization of eigenvector centrality. There are two scores for each actor, a hub and an authority score. A high hub actor points to many good authorities and a high authority actor receives from many good hubs. The authority score of a vertex is therefore proportional to the sum of the hub scores of the vertices on the in-coming ties and the hub score is proportional to the authority scores of the vertices on the out-going ties.

These values are the same as the singular vectors derived from a single valued decomposition. There are scores associated with all the singular values but the one associated with the largest singular value is usually used as a centrality score.

Input Networks
Any network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
Authority Centrality is the Eigenvector Centrality of the network $A'\ast A$, where $A$ is the input network.

Reports Using Measure
- All Measures
- Key Entity
- Management
- Standard Network Analysis

[View report to measure table] | [View measure to report table]
Average Speed

Description
The average speed with which any two (reachable) nodes can interact. This is the inverse of the average shortest path length between node pairs. If no node is reachable from another node, then Minimum Speed is zero.

Example
In an organization that any two individuals have an average of 3.4 connections between them would approximate the average speed at which an a communication might spread throughout the organization. Naturally, the lower the average links, the higher the organizational speed.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Normal computation time

Output
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation

Formula
Average Speed is the average of the Inverse Closeness Centrality scores for the network entities.
Reports Using Measure

- All Measures
- Immediate Impact
- Key Entity
- Missing Links

View report to measure table | View measure to report table
Betweenness Centrality

Description
The Betweenness Centrality of node v in a network is defined as: across all node pairs that have a shortest path containing v, the fraction that pass through v.

Example
This measure indicates the extent that an individual is a broker of indirect connections among all others in a network. Someone with high Betweenness could be thought of as a gatekeeper of information flow. People that occur on many shortest paths among other People have highest Betweenness value. Betweenness is one of the key measures used by those interested in networks.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let D be the distance network for the input network; D(i,j) = shortest path distance from i to j, and zero if no path exists
let C be the network of the number of shortest paths for the input network (so that \( C(i,j) = \) number of shortest paths from i to j, and zero if no path exists)

The following computes the total fraction of shortest paths that node i lies on:

\[
\sum (C_{u,i} \cdot C_{i,v}) / C_{u,v} : \text{for (u,v) where } D_{u,v} = D_{u,i} + D_{i,v}
\]

This value is then normalized by the maximum number of shortest paths possible to get the betweenness centrality.

**Reports Using Measure**

- All Measures
- Change in Key Entities
- Communications Network Assessment
- Communicative Power
- Communicators
- Core Network
- Immediate Impact
- Influence Net
- K-Centrality
- Key Entity
- Management
- Missing Links
- Part Of Speech
- Semantic Network
- Simmelian Ties Analysis
- Standard Network Analysis
- Statistical Change Detection
- Tactical Insight
- Trails Analysis
- View Role and Sphere of Influence

[View report to measure table] | [View measure to report table]
Betweenness Centrality Spatial

Description
The extent to which a node lies between other nodes that are far from each other.
The spatial network metrics assume that for each node in the network you have
specified a latitude and longitude as two attributes of the node. Based on these values
a distance is calculated (as the crow flies).
Then the metrics are calculated taking this spatial proximity into account.
Specifically, Spatial Betweenness emphasizes the nodes that lie on shortest paths
between distant others (e.g. an expert who collaborates with people in different
cities) over paths paths that connect nearby others(e.g. a manager who connects the
workers in a single office).

Input Networks
These networks are used to compute the measure:
Source nodeset  Target nodeset  Link values
agent         agent           weighted
agent         location        weighted

Complexity
Slow computation time

Output
Node level (one value per node)
Value type: Real
Minimum value: 0
Maximum value: 1

Citation
Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network
Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth
International Sunbelt Social Network Conference, San Diego, CA.

Reports Using Measure
- All Measures
View report to measure table | View measure to report table
Betweenness Network Centralization

Description
Network centralization based on the betweenness score for each node in a square network.

Input Networks
Unimodal network with link values.
Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Network level (one value overall)
Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let v be the vector of Betweenness Centrality values for the input network of length N.
let c be the Centralization value for vector v
Betweenness Network Centralization = c / (N - 1)

Reports Using Measure
- All Measures
- K-Centrality
- Standard Network Analysis

View report to measure table | View measure to report table
Bi-directional Link Count

Description
The number of links in a unimodal network that go in both directions (i.e. reciprocated links).

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Network level (one value overall)

  Value type: Real
  Minimum value:
  Maximum value:

Citation

Reports Using Measure
- All Measures
- Standard Network Analysis

View report to measure table | View measure to report table
Bonacich Power Centrality

Description
This computes the centrality of each entity based on the centrality of its neighbors. Beta should be chosen such that its absolute value is less than the reciprocal of the largest eigenvalue of N.

Example
In a given organization, this measure can tell us who is connected to the most powerful (e.g., other highly connected agents) people.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A = adjacency representation of the network N. Then Bonacich Power Centrality for the network is the solution c to the following system of linear equations:

\[ \text{inverse}(I - \beta A)c = A\cdot e \]

Where I is an identity matrix, and e is a vector of ones.

inverse(I - beta*A)*c = A*e : I is an identity matrix, and e is a vector of ones
The solution vector \( c \) is then normalized by dividing by the absolute value of the largest element.

The magnitude of beta affects the degree to which distant ties are taken into account. By default, beta is chosen to be as large as possible (it must be \(< 1/\lambda\), where \( \lambda \) is the magnitude of the largest eigenvalue) so as to approximate eigenvector centrality.

Note: the meaning of the link \((i,j)\) should be that \( i \) is influenced by node \( j \)

Note: if \textbf{beta} is 0, then Bonacich Centrality equals the \textit{In-Degree Centrality} of each node.

**Reports Using Measure**

- All Measures

[View report to measure table] | [View measure to report table]
Boundary Spanner

Description
A node which if removed from a network creates a new component. Boundary spanners are also called Gate Keeper nodes, or articulation points of a network.

Example
An employee with few direct connections such that if removed from the network will result in an unconnected sub-group.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Binary
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Brokerage

Description
The Brokerage of a node measures the degree to which the alters in its ego network are not directly connected, and therefore the degree to which a node can act as a broker between its direct connections.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
None

Formula
Let $d =$ density of a node's ego network.

Then Brokerage is $(1 - d)$

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
**Capability**

**Description**
Detects entities with high or low degree relative to other entities. The formula discounts for the fact that most nodes have some connections and assumes that there is a general discount to having large numbers of connections.

For the most connected entity, this value tends to 1.0, for the least connected node it tends to 0, and for the average connected entity it tends to 0.5

**Input Networks**
Any network with link values.

**Complexity**
Fast computation time

**Output**
Node level (one value per node)
- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
Let A be the input network in matrix form

Let d = vector of row degrees of the nodes

Normalize d by the maximum degree score, that is, $d = d / \max(d)$
Then the Capability of node $i$ is computed as:

$$
\frac{1}{1 + \exp(10 \times (0.5 - d[i]))}
$$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Characteristic Path Length

Description

The average shortest path between two nodes when there exists a path between them. This is the sum of all shortest path lengths between reachable node pairs divided by the number of reachable pairs. Note that if the network is directed, then node B might be reachable from node A, but not vice-versa.

Example

In a given organization, this measure computes the average amount of connections between any two members in the organization.

Input Networks

Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity

Normal computation time

Output

Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: (Node Count) * (Maximum Link Value)

Citation

NetStat

Formula

let \( D(i,j) \) = shortest path length from node \( i \) to \( j \) (or 0 if no path exists)

Characteristic Path Length = \( \frac{\text{sum}(D)}{\text{sum}(D>0)} \)
Reports Using Measure

- All Measures
- Immediate Impact
- Missing Links
- Standard Network Analysis

View report to measure table  |  View measure to report table
Clique Count

Description
The number of distinct cliques to which each node belongs. A clique is defined as a group of three or more nodes that are all connected together and that cannot be made larger by adding another node.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Integer
Minimum value: 0
Maximum value:

Node level (one value per node)

Value type: Integer
Minimum value: 0
Maximum value:

Citation

Formula
A clique of an undirected, square network is defined in Wasserman and Faust as a maximal complete subgraph of three or more nodes. The clique detection algorithm employed is the Bron-Kerbosch maximal clique algorithm, which is Algorithm 457 of the Collected Algorithms from CACM.
Reports Using Measure

- All Measures
- Change in Key Entities
- Communicators
- Key Entity
- Standard Network Analysis
- Trails Analysis

View report to measure table | View measure to report table
Closeness Centrality

Description
The closeness of a node to the other nodes in a network (also called out-closeness). Loosely, Closeness is the inverse of the sum of distances in the network from a node to all other nodes.

Closeness reveals how long it takes information to spread from one node to others in the network. High scoring nodes in Closeness have the shortest paths to all others in the network. It would follow such nodes could monitor the information flow in an organization better than most others that have a lesser Closeness value. The ones with the highest value in this measure will often times have the best picture of what is happening in the network as a whole.

Example
Closeness reveals so-called people in the know. Closeness measures the path length from one person to another in a network. It tells us which person is central to an organization.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
let A be the unimodal input network with N nodes, minimum link value v, and maximum link value V

let D be the distance network defined as:

\[ D(i,j) = \begin{cases} 
\text{shortest path length from i to j, if a path exists from i to j} \\
N*V, \text{ if no path exists from i to j} \\
0 
\end{cases} \]

The following computes the sum of shortest path lengths from node i to all other nodes:

\[ d = \sum_{j} D_{i,j} \text{ : for all nodes j} \]

Closeness Centrality value for node i = \( V*(N-1) / d \)

Reports Using Measure
- All Measures
- K-Centrality
- Key Entity
- Management
- Standard Network Analysis
- Statistical Change Detection
- View Role and Sphere of Influence

View report to measure table | View measure to report table
Closeness Centrality Spatial

**Description**

The extent to which a node lies between other nodes that are far from each other.

The spatial network metrics assume that for each node in the network you have specified a latitude and longitude as two attributes of the node. Based on these values a distance is calculated (as the crow flies).

Spatial Closeness emphasizes nodes that are closest to the other nodes both in the network and in space by calculating standard closeness centrality on a distance-weighted copy of the network. Nodes connected mostly to spatially nearby neighbors would have higher spatial closeness than nodes connected to the same number of spatially distant neighbors.

**Input Networks**

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>location</td>
<td>weighted</td>
</tr>
</tbody>
</table>

**Complexity**

Slow computation time

**Output**

Node level (one value per node)

Value type: Real  
Minimum value: 0  
Maximum value: 1

**Citation**

Reports Using Measure

• All Measures

View report to measure table | View measure to report table
Closeness Network Centralization

Description
Network centralization based on the closeness centrality of each node in a square network. This is defined only for connected networks.

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Output
Network level (one value overall)
Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the unimodal input network with N nodes
let v be the vector of Closeness Centrality values for network A
let c be the Centralization value for vector v
Closeness Network Centralization = (2*N-3)*c / (N-1)*(N-2)

Reports Using Measure
- All Measures
- K-Centrality
- Standard Network Analysis

View report to measure table | View measure to report table
Clustering Coefficient Density

Description

Measures the degree of clustering in a network by averaging the clustering coefficient of each node, which is defined as the density of the node's ego network.

The clustering coefficient gives a sense of the local characteristics of the network - how information spreads by means of employee groups. A higher clustering coefficient supports local information diffusion as well as a decentralized infrastructure because employees are likely to share information and know what is happening in their work group.

Example

The average of the proportion of links between each employee and his or her direct neighbors divided by the number of links that could possibly exist between them.

Input Networks

Unimodal network with binary link values.

Complexity

Normal computation time

Output

Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1
Description: This is the average node level value.

Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
The Clustering Coefficient Density of a node is the density of its ego-network.

The ego network for node i consists of node i itself, all nodes directly to it, and the links between these nodes.

Reports Using Measure
- All Measures
- Communicators
- Immediate Impact
- Missing Links
- Semantic Network
- Standard Network Analysis

View report to measure table | View measure to report table
Cognitive Demand

Description
Measures the total amount of cognitive effort expended by each agent to do its tasks, need to move, connecting others, and so on. Such individuals may never become the formal leader of a group. Emergent leaders are identified in terms of the amount of cognitive effort that is inferred to be expended based on the individual's position in the meta-network.

Individuals who are strong emergent leaders are likely to be not just connected to many people, organizations, tasks, events, areas of expertise, and resources; but also, are engaged in complex tasks where they may not have all the needed resources or knowledge and so have to coordinate with others, or have other reasons why they need to coordinate or share data or resources.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>weighted</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>weighted</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>weighted</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
This measure requires as a minimum the Agent x Agent network. It will automatically use more input networks when they are available.

Reports Using Measure
- All Measures
- Change in Key Entities
- Immediate Impact
- Key Entity
- Management
- View Role and Sphere of Influence

[View report to measure table]  [View measure to report table]
Column Breadth

Description
The fraction of column nodes with degree greater than one.

Example
Consider an Agent x Knowledge network for an organization. The column breadth of this network would tell us the fraction of knowledge that are known by at least two agents.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A be the input network.

Column Breadth is the Row Breadth computed on the transpose of the input network A.
Reports Using Measure

- All Measures
- Management
- Standard Network Analysis

View report to measure table | View measure to report table
Column Count

Description
The number of column (target) nodes in a network.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Integer
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures
• Standard Network Analysis

View report to measure table | View measure to report table
Column Diversity

Description
This measures the degree to which column nodes are non-uniformly connected to row nodes.

Example
Computed on an Employee x Skills network, this characterizes the network in terms of how non-uniform is the distribution of employees to skills (e.g. the inverse of "the extent to which skills are had by an equal number of employees").

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
This is one minus the Herfindahl-Hirshman Index applied to the normalized column sums of the input network.

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Column Exclusivity

Description
Detects column nodes that have ties to row nodes comparatively few other column nodes have.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the binary input network

Column Exclusivity is the Row Exclusivity computed on the transpose of the input network A.

Reports Using Measure

• All Measures
• Standard Network Analysis

View report to measure table | View measure to report table
Column Exclusivity Complete

Description
Detects column nodes that have ties to row nodes that no other column node has.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the binary input network

Complete Column Exclusivity is the Complete Row Exclusivity computed on the transpose of the input network A.

Reports Using Measure
• All Measures
• Standard Network Analysis

View report to measure table | View measure to report table
Column Gini Means Difference

Description
Computes the Gini Means Difference for each column in the input network. This is a measure of variability well-suited for data from non-normal distributions. For a unimodal network, this measures the variability in the in-link values for each node. For a bimodal network, this measures the variability of link values for each column node.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation
Gini, C. (1912) Variabilita’ e mutabilita’: contributo allo studio delle distribuzioni e delle relazioni statistiche

Reports Using Measure
- All Measures
- Immediate Impact

View report to measure table | View measure to report table

1179
Column Redundancy

Description

The fraction of in-links in a network that are redundant. A column node has no redundancy (a value of zero) if it links to at most one row node; each additional link to a row node after the first link is redundant. The column node's redundancy is the fraction of its links that are redundant, and the network's column redundancy is the overall average of the column node redundancies.

When computed on an Agent x Knowledge network this is called Knowledge Redundancy and is the average normalized number of redundant agents per knowledge. An agent is redundant if there is already an agent who has the knowledge.

When computed on an Agent x Resource network this is called Resource Redundancy and is the average normalized number of redundant agents per resource. An agent is redundant if there is already an agent who has the resource.

When computed on an Agent x Task network this is called Assignment Redundancy and is the average normalized number of redundant agents assigned to tasks. An agent is redundant if there is already an agent assigned to the task.

Example

Column Redundancy computed on an Agent x Knowledge network would measure the extent to which each knowledge node is known multiple agents. If each knowledge is known by at most one agent, then column redundancy is zero. If each knowledge is known by everyone, then the column redundancy is one.

Input Networks

Any network with binary link values.

Complexity

Fast computation time

Output

Network level (one value overall)
Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**

**Formula**
Let A be the input network (whose link values will be treated as binary).

Column Redundancy is the Row Redundancy computed on the transpose of the input network A.

**Reports Using Measure**
- All Measures
- Standard Network Analysis

[View report to measure table](#) | [View measure to report table](#)
Communication

Description
Measures to what extent each agent communicates with other agents, either because an agent reports to another, or because of task based communication.

Example
In a given organization Bob is assigned a task which is dependant upon his social links to other individuals in the network. The measure would compute a value for how dependent Bob is on the links to the other individuals to complete the task. A higher value would indicate Bob must possess a greater number of connections to complete any given task he is assigned. Conversely, a low value would indicate relatively few linkages are necessary to complete certain tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1
Citation

Formula
uses the concepts from Communication Congruence: Handoff, Co-Assignment, and Negotiation.

let H, C, and N be defined as in Communication Congruence.

let M = [(AA + (H+H') + C + (N+N')) > 0], and M(i,i) = 0

Note: (H+H') and (N+N') is used to make the communication reciprocal

let vector d = rowsum(M)

Then Communication = d / (rows(A)-1), which normalizes the value into [0,1]

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table
Communication Congruence

Description
Measures to what extent the agents communicate when and only when it is needful to complete tasks. Perfect congruence requires a symmetric Agent x Agent network.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>binary</td>
<td></td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
<td></td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
<td></td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
<td></td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>binary</td>
<td></td>
</tr>
</tbody>
</table>

Task precedence network, link (i,j) means task i must be done before task j

Complexity
Normal computation time

Output
Network level (one value overall)
- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation
Formula

One of the following pairs of matrices must exist: \{Agent x Knowledge, Knowledge x Task\}, \{Agent x Resource, Resource x Task\}. If both exist, then the measure will use them both.

Communication Congruence = 1 if agents communicate when and only when it is needful to complete their tasks. There are three task related reasons when agents i and j need to communicate:

(a) Handoff: if i is assigned to a task t1 and j is assigned to a task t2 and t1 directly precedes task t2 (based on the precedence matrix TT).

(b) Co-Assignment: if i is assigned to a task s and j is also assigned to s.

(c) Negotiation: if i is assigned to a task s and j is not, and there is a resource r to which agents assigned to s have no access but j does.

The three cases are computed as follows:

(a) Handoff = AT * TT * AT'

(b) Co-Assignment = AT * AT'

(c) Negotiation = AT * Z * AR', where Z = [(AT' * AR - RT) < 0]

Note: C-Assignment matrix is always symmetric, but not necessarily Handoff and Negotiation.

let Q = [ ((H+H') + C + (N+N')) > 0]

Communication Congruence requires reciprocal communication, explaining the transposes of H and N to make them symmetric.

let d = hamming distance between Q and AA = (sum(Q .* ~AA) + sum(~Q .* AA)) / a*(a-1), where a = number of agents

Then Communication Congruence = 1 - d

Reports Using Measure

- All Measures
- Immediate Impact
- Key Entity
- Missing Links

View report to measure table | View measure to report table
Complexity

Description
This is a measure of the density of the meta-network as a whole.

Input Networks
The entire meta-network is used as a whole, or only one or more nodesets.

Complexity
Fast computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value:
  Maximum value:

Citation

Formula
Each network in the meta-network has a link count and maximum-possible link count. Complexity is the sum of the links divided by the sum of the possible links across all networks.

The Density of the meta-network as a whole.

Reports Using Measure
- All Measures
- Immediate Impact
- Key Entity
- Management

View report to measure table | View measure to report table
Connectedness

Description
Measures the degree to which a square network's underlying (symmetrized) network is connected.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 
Maximum value: 

Citation

Formula
Connectedness of a square, symmetric network is the Density of its Reachability Network.

The reachability network R for a square network A is defined as:

\[ R(i,j) = 1 \text{ if there is a path in network } A \text{ from } i \text{ to } j, \text{ and } 0 \text{ otherwise} \]

Reports Using Measure
- All Measures
- Simmelian Ties Analysis
- Standard Network Analysis

View report to measure table | View measure to report table

1187
**Constraint Structural Holes**

**Description**

The degree to which each node in a square network is constrained from acting because of its links to other nodes.

**Example**

Bob is given a certain task, but that task requires certain links, which Bob does not have. Bob is constrained in the sense he does not have the links to complete the task. This measure computes a value for such relationships as they distributed across the whole network.

**Input Networks**

Unimodal network with link values.

**Complexity**

Normal computation time

**Output**

Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

**Citation**


**Formula**

This is the Constraint measure described by Equation 2.4 (page 52 of reference book) computed on the unimodal input network.

**Reports Using Measure**

- All Measures
• Key Entity
• View Role and Sphere of Influence

[View report to measure table] | [View measure to report table]
Contribution Centrality

Description
This computes Eigenvector Centrality on a transformation of the input network. Link values are transformed to be proportional to the dissimilarity of the nodes they connect. The intuition is that a link between two nodes with the same neighbors is not an important link since neither node gains new neighbors by the connection. Specifically, each link is weighted by the inverse of the Jaccard similarity of its nodes.

Example
In a given organization, this measure can tell us who is connected to the most powerful (e.g., other highly connected agents) people.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A = adjacency representation of the network N.
Let \( D \) = distance between each pair of nodes in \( A \), where \( \text{distance}(i,j) = 1 - \text{JaccardSimilarity}(i,j) \)

where \( \text{JaccardSimilarity}(i,j) = \sum(\min(A(:,i),A(:,j))) / \sum(\max(A(:,i),A(:,j))) \)

Let \( W = A.*D \), that is, each link of the input network is scaled by the distance between (dissimilarity of) its nodes

Contribution Centrality is the \( \text{Eigenvector Centrality} \) computed on matrix \( W \).

**Reports Using Measure**

- All Measures
- Key Entity

[View report to measure table] [View measure to report table]
Cosine Similarity Correlation

Description
Measures the degree to which each pair of rows has overlapping data.

Input Networks
Any network with binary link values.

Complexity
Slow computation time

Output
Node level (one value per node)
- Value type: Real
- Minimum value: 0
- Maximum value: 1

Dyad level (one value per node pair)
- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation

Formula
Let A be the input network.

For each pair of rows (i,j) we compute the number of bits they have in common, and then normalize this by the sqrt of the product of their number of knowledge bits.

The Cosine Similarity of rows i and j of A is defined as:
let common = sum(A(i,:) .* A(j,:))

SC(i,j) = common / (sum(A(i,:)) + sum(A(j,:)) - common)

Note: by definition, SC(i,i) = 1, and SC is symmetric.

The node-level output value for node i = (∑SC_{ij})/(rows(A)-1) : for i ≠ j

This is the average Cosine Similarity row i has with the other rows.

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Degree Centrality Spatial

Description
This is the total geographical distance from a node to its neighbors.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>location</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Density

Description
The ratio of the number of links versus the maximum possible links for a network.

Example
Density computed on the Agent x Agent employee communication network would compare existing links to all possible links, and could be interpreted as the level of social cohesion in the organization.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the binary input network with m rows and n columns

The Density of network A = sum(A) / m*n

If A is unimodal and does not allow self-loops, then the Density = sum(A) / n*(n-1)

1195
Reports Using Measure

- All Measures
- Communicative Power
- Communicators
- Core Network
- Immediate Impact
- Key Entity
- Management
- Missing Links
- Semantic Network
- Simmelian Ties Analysis
- Standard Network Analysis
- Statistical Change Detection

View report to measure table | View measure to report table
Diagonal

Description
Returns the vector of diagonal (self-loop) values of the unimodal input network.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation
None

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
**Diameter**

**Description**

The maximum shortest path length between any two nodes in a unimodal network. If there exists a node that is not reachable from another node, then the diameter is technically infinite. In this case, the Diameter returned is $V \times N$ where $V$ is the maximum link value in the network.

This measures the worst-case distance when going from any one node to another node.

Note: directed networks will typically return value $N$ (for binary networks) or $V \times N$ (weighted networks) since there is usually a node not reachable from another.

**Input Networks**

Unimodal network with link values.

Note: link values are distances (dissimilarity)

**Complexity**

Normal computation time

**Output**

Network level (one value overall)

Value type: Real
Minimum value: minimum link value
Maximum value: (number of nodes) * (maximum link value)

**Citation**


**Formula**

let $A$ be the input network of size $N$ and maximum link value $V$
let D be the distance network for network A:

\[ D(i,j) = \text{shortest path distance from node } i \text{ to node } j, \text{ if a path exists} \]

\[ D(i,j) = 0, \text{ if no path exists} \]

If there is a path from every node i to every other node j, then network A is said to be connected, and every cell of D was computed.

If A is connected, then Diameter = max(D), otherwise Diameter = V*N

**Reports Using Measure**

- All Measures
- Key Entity
- Semantic Network

[View report to measure table] [View measure to report table]
**Diffusion**

**Description**
Computes the degree to which something could be easily diffused (spread) throughout the network. This is based on the shortest path length between nodes. A large diffusion value means that nodes are close to each other, and a smaller diffusion value means that nodes are farther apart.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Slow computation time

**Output**
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**

**Formula**
let A be the unimodal input network with N nodes

let D be the distance network for network:

D(i,j) = shortest path distance from node i to node j (and N if no path exists)

let TotalDistance= sum(D)
let AverageDistance = TotalDistance / (N*(N-1)), which is the average distance between nodes

Then Diffusion = N/(N-1) * [1 - AverageDistance/N], which is the average distance from 1 and normalized so that cliques get a score of 1

Reports Using Measure

• All Measures
• Immediate Impact
• Missing Links

View report to measure table | View measure to report table
Distinctiveness Correlation

Description
Measures the degree to which each pair of rows has complementary data, expressed as the percent of total data.

When computed on an Agent x Knowledge network this is called Cognitive Distinctiveness, and measures the degree to which each pair of agents has complementary knowledge, expressed as the percent of total knowledge.

Input Networks
Any network with binary link values.

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Dyad level (one value per node pair)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A be the input network.

1202
For each pair of rows \((i,j)\) we compute the number of knowledge bits they have 
exactly opposite. Then normalize this sum by the total number of knowledge bits. In 
effect, this is the exclusive-OR of their knowledge vectors.

The Distinctiveness Correlation between rows \(i\) and \(j\) of \(A\) is defined as:

\[
DC(i,j) = \text{sum}(A(i,:) .* \neg A(j,:)) + \text{sum}(\neg A(i,:) .* A(j,:))
\]

\[
DC = DC / \text{cols}(A)
\]

Note: by definition, \(DC(i,i) = 0\), and \(DC\) is symmetric.

The node-level output value for node \(i\) = \((\Sigma DC_{i,j})/(\text{rows}(A)-1)\) : for \(i \neq j\)

This is the average Distinctiveness Correlation row \(i\) has with the other rows.

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
**Eccentricity Centrality**

**Description**

The Eccentricity Centrality of a node is the normalized inverse of its maximum distance to any other node. It is highest when the distance to all other nodes is small.

The Eccentricity of a node is its maximum shortest path to another node, excluding the infinite distances from unreachable nodes. If a node cannot reach any other node, then its Eccentricity is zero.

**Example**

In a given organization, this measure bounds the distance from each node to another node.

**Input Networks**

Unimodal network with link values.

Note: link values are distances (dissimilarity)

**Complexity**

Normal computation time

**Output**

Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

NetStat

**Formula**

Consider a network with N nodes and minimum link value \( v \)

let \( D(i,j) = \) shortest path length from node \( i \) to \( j \) (or 0 if no path exists)
Reports Using Measure

• All Measures

View report to measure table | View measure to report table
Effective Network Size Structural Holes

Description
The effective size of a node's ego network based on redundancy of ties.

Example
In a given organization, let us say Bob has ties to many others in the organization, who in turn have redundant ties to other people. The point at which this no longer applies tends to define effective network size.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)
  Value type: Real
  Minimum value:
  Maximum value:

Citation

Formula
This is the Effective Size of Network measure described by Equation 2.2 (page 52 of reference book) computed on the unimodal input network.

Reports Using Measure
  • All Measures
  • Key Entity
  • View Role and Sphere of Influence

View report to measure table | View measure to report table
**Efficiency**

**Description**
The degree to which each component in a network contains the minimum links necessary to keep it connected.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
let A be the unimodal input network with m edges and n nodes

let K be the number of components in A

let $k_i$ be the size of component $i : 1 \leq i \leq K$

let penalty = $m - n + K$

let maxPenalty = $K - n + \sum k_i(k_i-1)/2 : for 1 \leq i \leq K$

Efficiency = 1 - (penalty / maxPenalty)
Reports Using Measure

- All Measures
- Simmelian Ties Analysis
- Standard Network Analysis

View report to measure table | View measure to report table
Efficiency Structural Holes

Description
The fraction of nodes in an ego network that are not redundant.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
This is Effective Network Size divided by the number of nodes in each ego network.

Reports Using Measure
• All Measures
• Key Entity
• View Role and Sphere of Influence

View report to measure table | View measure to report table
Ego Betweenness Centrality

Description
The Ego (Network) Betweenness Centrality of node in a network is its betweenness score within its own ego network. The ego network contains the following: the node itself, its immediate neighbor nodes, and all links between them.

Link values are ignored (all links are made binary), and the network is always symmetrized.

Input Networks
Unimodal network with binary link values.

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Binary
Minimum value:
Maximum value:

Citation

Reports Using Measure
- All Measures
- Key Entity

View report to measure table | View measure to report table
Eigenvector Centrality

Description
Calculates the principal eigenvector of the network. A node is central to the extent that its neighbors are central.

Example
A node's eigenvector centrality score is proportional to the scores of the nodes it is connected to. In a star, the highly central center node, will have a value proportional to the sum of the peripheral or pendant nodes, and so be high. In contrast, the pendant nodes will each be proportional to the center node, and will all be equal, but smaller than that of the center node.

Example
Individuals or organizations who are connected to many otherwise isolated individuals or organizations will have a much lower score in this measure than those that are connected to groups that have many connections themselves. This would be true even if such a node might have a high amount of actual connections (i.e. high degree centrality).

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Bonacich, Phillip. (1972). Factoring and weighting approaches to status scores and clique detection. Journal of Mathematical Sociology, 2, 113-120.


Formula

Eigenvector Centrality is not directly computed on networks with multiple components. Some tools only calculate it on one component with varying rules as to which component to use. ORA calculates the measure on all components separately (values are scaled according to the component size), and combines them into a single result vector.

Let $A$ be the unimodal input network (if not symmetric, links are added to make it symmetric) with $N$ nodes

Let $K$ be the number of components in the network $A$

Let $N_k$ be the nodes in the $k$th component.

Let $V_k$ be the dominant eigenvector computed on the sub-network induced by the nodes $N_k$

Scale the $V_k$ values by multiplying them by $N_k/N$

Eigenvector Centrality is the combined vector of all scaled component $V_k$ values.

Note: Hub Centrality and Authority Centrality measures are generalizations of the Eigenvector Centrality measure and take into account directed links.

Reports Using Measure

- All Measures
- Change in Key Entities
- Communications Network Assessment
- Key Entity
- Standard Network Analysis
- Trails Analysis

View report to measure table | View measure to report table

1212
Eigenvector Centrality Spatial

Description
The sum of the eigenvector centralities of all nodes located at a place. Intuitively, this computes the likelihood of arriving at a node at a particular location in a random walk.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>location</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Reports Using Measure
- All Measures
- Key Entity

View report to measure table | View measure to report table
Eigenvector Network Centralization

Description
Network centralization based on the eigenvector centrality of each node in a square network.

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation
None

Formula
This is the Centralization formula applied to the Eigenvector Centrality scores of the network.

let A be the input network of size N

let v = vector of Eigenvector Centrality values for network A

let c be the Centralization value for vector v

Eigenvector Centralization = c / (N - 1)
Reports Using Measure

- All Measures
- Standard Network Analysis

View report to measure table | View measure to report table
**Expertise Correlation**

**Description**
Measures the degree to which each pair of rows has complementary data, expressed as a fraction of the data of the first row.

When computed on an Agent x Knowledge network this is called Cognitive Expertise, and measures the degree to which each pair of agents has complementary knowledge, expressed as a fraction of the knowledge of the first agent.

**Example**
If one person in an organization knows how to perform X but can't do Y. Whereas another individual can do Y but not X, such individuals would rank highly in this measure.

**Input Networks**
Any network with binary link values.

**Complexity**
Slow computation time

**Output**
Node level (one value per node)
- Value type: Real
  - Minimum value: 0
  - Maximum value: 1

Dyad level (one value per node pair)
- Value type: Real
  - Minimum value: 0
  - Maximum value: 1
Citation

Formula
Let A be the input network.

For each pair of rows (i,j) we compute the number of bits that j has that i does not have. Then normalize this sum by the total number of bits that row i does not have.

The Expertise Correlation of rows i and j of A is defined as:

$$CE(i,j) = \frac{\text{sum}(\neg A(i,:) \cdot A(j,:))}{\text{cols}(A) - \text{sum}(A(i,:))}$$

Note: CE(i,i) = 0, and the output is not necessarily symmetric.

The node-level output value for node i = \( \frac{\sum CE_{i,j}}{\text{rows}(A)-1} \) : for i ≠ j

This is the average Expertise Correlation row i has with the other rows.

Reports Using Measure
- All Measures
- Potential Errors

View report to measure table | View measure to report table
**Exponential Rank Centrality**

*Description*
Computes the Exponential Ranking Centrality that defines the centrality of a node as its trustworthiness, which is based on the degree to which other nodes trust it. The link values define initial trust between nodes: positive values indicate trust and negative values distrust (negative link values can be used). This measure is similar to eigenvector centrality.

*Input Networks*
Unimodal network with link values.

*Complexity*
Slow computation time

*Output*
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

*Citation*

*Formula*
The algorithm is described in the reference, and is computed in like manner to Bonacich Centrality.

The algorithm requires a parameter $\mu$ which is taken to be $(\max(A) - \min(A))$, where $A$ is the input network.

If $\min(A) == \max(A)$, then $\mu$ is set to $1/10$
Reports Using Measure

- All Measures

View report to measure table | View measure to report table
Fragmentation

**Description**
The proportion of nodes in a network that are disconnected.

**Example**
In a given organization 25 out of 400 sales agents are disconnected from the resources and knowledge that exists at the company headquarters because they travel more frequently and are thus disconnected from the rest of the network. The attribute of this disconnection expressed as a property of the entire organization is its computed disconnected measure.

**Example**
Fragmentation will be zero when the input data is a single weak component. Note that Fragmentation ignores link direction, so it is more common to find a single component (say, versus Strong Component Count that does use link direction).

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**

Breiger, K. Carley, & P. Pattison (Eds.) Committee on Human Factors, National Research Council, 241-252.
**Formula**

Fragmentation is based on the number of weak components and the sizes of the components.

Let A be the unimodal input network with N nodes

Let $S_k$ be the number of nodes in the kth weak component of network A

Let $S = \frac{\sum S_k(S_k-1)}{N(N-1)}$

Fragmentation = 1 - S

**Reports Using Measure**

- All Measures
- Immediate Impact
- Key Entity
- Missing Links
- Standard Network Analysis

[View report to measure table] [View measure to report table]
Description
Computes the shortest path lengths between all node pairs. If no path exists between two nodes, then a distance of zero is given. The distance from a node to itself is also zero.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Normal computation time

Output
Dyad level (one value per node pair)

Value type: Real
Minimum value: 0
Maximum value: (Number of nodes - 1) * (Maximum link value)

Citation

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Global Efficiency

Description
The degree to which nodes are within a short distance of one another.

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
The average of the Inverse Closeness values for the input network.

Reports Using Measure

• All Measures
**Hierarchy**

**Description**

The degree to which a unimodal network exhibits a pure hierarchical structure, meaning, if there is a path from nodes A to C, there is not also a path from C to A.

**Example**

Let us say in an organization Sue is the president. Under Sue, we have 4 vice presidents, whom all in turn have 5 or 10 direct reports, who all have 2 or 3 managers working for them. To such a degree that this architecture is present in the organization is its computed Krackhardt Hierarchy value.

**Input Networks**

Unimodal network with binary link values.

**Complexity**

Slow computation time

**Output**

Network level (one value overall)

- Value type: Real
- Minimum value:
- Maximum value:

**Citation**


**Formula**

Hierarchy of a square, symmetric network is the inverse of the Reciprocity of its Reachability Network.

The reachability network R for a square network A is defined as:
$R(i,j) = 1$ if there is a path in network A from $i$ to $j$, and 0 otherwise

**Reports Using Measure**

- All Measures
- Simmelian Ties Analysis
- Standard Network Analysis

View report to measure table | View measure to report table
**Description**

A node is hub-central to the extent that its out-links are to nodes that have many in-links. Individuals or organizations that act as hubs are sending information to a wide range of others each of whom has many others reporting to them. Technically, an agent is hub-central if its out-links are to agents that have many other agents sending links to them. The scientific name of this measure is hub centrality and it is calculated on agent by agent matrices.

Technically, an agent is hub-central if its out-links are to agents that have many other agents sending links to them. The scientific name of this measure is hub centrality and it is calculated on agent by agent matrices.

Hubs and authorities are a natural generalization of eigenvector centrality. There are two scores for each actor, a hub and an authority score. A high hub actor points to many good authorities and a high authority actor receives from many good hubs. The authority score of a vertex is therefore proportional to the sum of the hub scores of the vertices on the in-coming ties and the hub score is proportional to the authority scores of the vertices on the out-going ties.

These values are the same as the singular vectors derived from a single valued decomposition. There are scores associated with all the singular values but the one associated with the largest singular value is usually used as a centrality score.

**Input Networks**

Any network with link values.

**Complexity**

Normal computation time

**Output**

Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:
**Citation**

**Formula**
Hub Centrality is the Eigenvector Centrality of the network A*A', where A is the input network.

**Reports Using Measure**
- All Measures
- Key Entity
- Management
- Standard Network Analysis

View report to measure table | View measure to report table
In-Closeness Centrality

Description
The closeness of all other nodes to a node in the network. Loosely, In-Closeness Centrality is the inverse of the sum of distances in the network to a node and from all other nodes.

Input Networks
Unimodal network with link values.
Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)
Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let A be the unimodal input network with N nodes, minimum link value v, and maximum link value V

let D be the distance network defined as:

\[ D(i,j) = \begin{cases} \text{shortest path length from } i \text{ to } j, \text{ if a path exists from } i \text{ to } j \\ N \times V, \text{ if no path exists from } i \text{ to } j \end{cases} \]
D(i,i) = 0

The following computes the sum of shortest path lengths from all other nodes to node i:

let \( d = \sum D_{u,i} \) : for all nodes u

Closeness Centrality value for node i = \( v^* (N-1) / d \)

**Reports Using Measure**

- All Measures
- K-Centrality
- Standard Network Analysis

[View report to measure table | View measure to report table](#)
In-Closeness Network Centralization

Description
Network centralization based on the in-closeness centrality of each node in a square network. This is defined only for connected networks.

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 
Maximum value: 

Citation

Formula
let A be the unimodal input network with N nodes
let v be the vector of In-Closeness Centrality values for network A.
let c be the Centralization value for vector v

In-Closeness Network Centralization = (2*N-3)*c / (N-1)*(N-2)

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
In-Degree Average Neighbor

Description
Computes for each node the average in-degree of its neighbors. Neighbors are nodes connected to the ego via an in-link. The degree of a neighbor is the number of in-links it has. Isolate nodes are given a score of zero. This measure uses the link values from the ego to its neighbors.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
Let A be the input network. The measure is computed in two main steps:

1. compute the set of neighbors: using in-links, out-links, or both
2. compute the degree of each neighbor: using in-links, out-links, or both

Average Neighbor In-Degree uses in-links for (1) and (2).

Average Neighbor Out-Degree uses out-links for (1) and (2).

Average Neighbor Total-Degree uses in-links and out-links for (1) and (2).
Note that mixed cases (e.g. In-Degree for (1) and Out-Degree for (2)) are not available.

For each case, link weights are used in step (1), but not in step (2).

Define the set of neighbor nodes \( N \) as those nodes connected to the node via an in-link.

If the set \( N \) is empty, then the node gets a score of zero.

Let \( s = \) sum of the links into the node (e.g. links from each neighbor to the node)

Let \( d = \) in-degree of each neighbor node (e.g. number of links into the neighbor)

Then the Average Neighbor In-Degree score is:

\[
(1/s) \cdot \sum \{ A(j,i) \cdot d[j] \mid \text{for each } j \text{ in } N \}
\]

**Reports Using Measure**

- All Measures
- View Role and Sphere of Influence

[View report to measure table](#) | [View measure to report table](#)
In-Degree Centrality

Description
The number of links directed into a node normalized by the maximum number of such links. This measure is also called Column Degree Centrality because it is computed by taking the sum of the column values in the input network.

The In-Degree Centrality of a node is its normalized in-degree. For any node, e.g. an individual or a resource, the in-links are the connections that the node of interest receives from other nodes.

Example
Imagine an agent by knowledge matrix then the number of in-links a piece of knowledge has is the number of agents that are connected to. The scientific name of this measure is in-degree and it is calculated on the agent by agent matrices.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let A be the input network with maximum link value V
In-Degree Centrality = colsum(A) / V*rows(A)

Note: if the network A is unimodal and not using the diagonal, then the measure is
normalized by V*(rows(A)-1).

**Reports Using Measure**

- All Measures
- Blog
- Communicators
- Influence Net
- Key Entity
- Management
- Standard Network Analysis
- Twitter
- View Role and Sphere of Influence

[View report to measure table](#) | [View measure to report table](#)
In-Degree Network Centralization

Description
Network centralization based on the in-degree centrality of each node in a network.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value:
  Maximum value:

Citation
NetStat

Formula
This is the Centralization formula applied to the In-Degree Centrality scores of the network.

let A be the input network with N rows
let v = vector of In-Degree Centrality values for network A
let c be the Centralization value for vector v

In-Degree Centralization = c / (N - 1)

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
In-Inverse Closeness Centrality

Description
The average closeness of a node to the other nodes in a network considering only paths emanating out from a node. Inverse Closeness is the sum of the inverse distances between a node and all other nodes.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Individual Congruence

Description
Individual Congruence represents the proportion of an individual’s tasks whose coordination requirements were satisfied through some type of actual coordination activity carried out through some means of communication by the agent.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>binary</td>
<td>actual coordination by communication</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
<td>task assignment</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>binary</td>
<td>task coordination requirement</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let the Coordination Requirements (CR) matrix and Actual Coordination Matrix (CA) be defined as in Social Technical Congruence.
We compute the proportion of an agents coordination requirements that are satisfied through its actual communication.

let \( S = [\text{CR} \cdot \text{CA} > 0] \) = binary matrix of task coordination satisfied by actual communication

let \( BCR = [\text{CR} > 0] \) = binarized coordination requirement matrix

Individual Congruence for node \( i \) = \( \frac{\text{sum}(S(:,i)) + \text{sum}(S(i,:))}{\text{sum}(BCR(i,:)) + \text{sum}(BCR(:,i))} \)

**Reports Using Measure**

- All Measures
- Management

[View report to measure table](#) | [View measure to report table](#)
Information Centrality

Description
Calculates the Stephenson and Zelen information centrality measure for each node.

Information centrality is a network metric that accounts for indirect as well as shortest paths among nodes. Information centrality is similar to betweenness, except that betweenness considers only shortest paths geodesics, whereas information centrality also considers more circuitous paths weighted by the inverse of the path length (the number of links along the path).

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Note: dense matrix storage is used, and required memory is proportional to network size squared.

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Calculates the measure described on pages 195-196 of Wasserman and Faust. Isolates (nodes without links) are first removed from the network, and the measure computed on the resulting sub-network. The isolate nodes are given value 0.
Reports Using Measure

- All Measures
- Standard Network Analysis

View report to measure table | View measure to report table
Interdependence

Description
The fraction of links in a unimodal network that are Pooled or Reciprocal.

Example
A reciprocal link is one that is bidirectional, for example, Bob has a link to Sue and Sue has a link back to Bob. If Bob, however, had links to Sue and to others, which were not reciprocated, then Bob would rank higher in radial links, which link in one direction. The extent that a network exhibits these relationships is computed as the Interdependence value for the network.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let A be the input unimodal network with m links

let r be the number of Bi-Directional Links and p the number of Pooled Links

Note that a link can be both a Pooled and a Bi-Directional link.
Then Interdependence for the network = \( \frac{p + r}{m} \)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Interlockers

Description
An Interlocker node is a member of relatively many triads.

Example
A typical corporate board of directors is a good example of an interlocking architecture. Whereas a predominant amount of board members - perhaps close to 70-percent - might serve on one board only, it is often common that the remaining 30-percent may serve on 3 or more other boards. These directors that serve on the other boards constitute the interlocking agents that connect all these typical boards together. The Interlockers and radial measures compute a value for such relationships as they exist in the network at the entity, that is agent (e.g., "board member"), level.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Binary
Minimum value:
Maximum value:

Citation

Formula
Interlocker nodes have a Triad Count greater than one standard deviation above the mean triad count across all nodes.
let triadCounts = vector of Triad Counts for the input network

let u = mean(triadCounts)

let d = standard_deviation(triadCounts)

Interlockers = binary vector [triadCounts >= u+d]

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Inverse Closeness Centrality

Description
The average closeness of a node to the other nodes in a network (also called out-inverse closeness centrality). Inverse Closeness is the average inverse distance from a node and to all other nodes.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the unimodal input network with N nodes, minimum link value v, and maximum link value V

let D be the distance network defined as:

D(i,j) = shortest path length from i to j, if a path exists

D(i,j) = 0, if no path exists
D(i,i) = 0

The following computes the sum of shortest path lengths from node i to all other nodes:

\[ \text{let } d = \sum \left( \frac{1}{D_{i,u}} \right) : \text{for all nodes } u \text{ where } D_{i,u} > 0 \]

Inverse Closeness Centrality value for node i = \( v^*(N-1) / d \)

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Isolate Count

Description
The number of isolate nodes in a unimodal network.

An isolate node is a node with no in-links and no out-links.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Integer
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures
• Immediate Impact
• Missing Links
• Standard Network Analysis

View report to measure table | View measure to report table
Jaccard Similarity Correlation

**Description**
Measures the degree to which each pair of rows has overlapping data.

When computed on an Agent x Knowledge network this is called Cognitive Similarity and measures the degree to which each pair of agents has overlapping knowledge.

**Example**
With an organization where Bob has the knowledge of X, Y and Z and Sally has the knowledge of Q, R and Z. The Cognitive Similarity measure would compute a value for Bob and Sally's overlapping knowledge of Z. The result will be a number between 0 and 1, inclusive.

**Input Networks**
Any network with binary link values.

**Complexity**
Slow computation time

**Output**
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Dyad level (one value per node pair)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**
P. Jaccard, Bulletin de la Société Vaudoise des Sciences Naturelles 37, 547 (1901).
**Formula**

Let A be the input network.

For each pair of rows \((i,j)\) we compute the number of bits they have in common, and then normalize this sum by the total bits between them.

The Jaccard Similarity of rows \(i\) and \(j\) of A is defined as:

\[
\text{common} = \text{sum}(A(i,:) .* A(j,:))
\]

\[
SC(i,j) = \frac{\text{common}}{\text{sum}(A(i,:)) + \text{sum}(A(j,:)) - \text{common}}
\]

Note: by definition, \(SC(i,i) = 1\), and SC is symmetric.

The node-level output value for node \(i\) = \(\frac{\sum SC_{i,j}}{\text{rows}(A)-1}\) : for \(i \neq j\)

This is the average Jaccard Similarity row \(i\) has with the other rows.

**Reports Using Measure**

- All Measures
- Potential Errors

[View report to measure table] | [View measure to report table]
Katz Centrality

Description
This computes the centrality of each entity based on the centrality of its neighbors. Alpha should be chosen such that its absolute value is less than the reciprocal of the largest eigenvalue of N.

Example
In a given organization, this measure can tell us who is connected to the most powerful (e.g., other highly connected agents) people.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A = adjacency representation of the network N. Then Katz Centrality for the network is the solution c to the following system of linear equations:

\[
\text{inverse}(I - \alpha A')c = \alpha A'e : I \text{ is an identity matrix, and } e \text{ is a vector of ones}
\]
The solution vector $c$ is then normalized by dividing by the absolute value of the largest element.

The magnitude of $\alpha$ affects the degree to which distant ties are taken into account. By default, $\alpha$ is chosen to be as large as possible (it must be $< 1/\lambda$, where $\lambda$ is the magnitude of the largest eigenvalue) so as to approximate eigenvector centrality.

Note: the input network is transposed, and the meaning of the link $(i,j)$ should be that $i$ chooses or 'gives influence to' node $j$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Knowledge Actual Workload

Description
The knowledge an agent uses to perform the tasks to which it is assigned.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent           knowledge      binary
knowledge       task           binary
agent           task           binary

Complexity
Normal computation time

Output
Node level (one value per node)
  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
Knowledge Actual Workload for node i is computed as follows:

\[ \frac{[AK \times KT \times AT'](i,i)}{\text{sum}(KT)} \]

Reports Using Measure

- All Measures

View report to measure table | View measure to report table
Knowledge Based Access Index

Description
Boolean value which is true if an agent is the only agent who knows a piece of knowledge and who is known by exactly one other agent. The one agent known also has its KAI set to one.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent          agent          binary
agent          knowledge    binary

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Binary
Minimum value:
Maximum value:

Citation

Formula
let AK and AA be the binary input networks, where AA has no self-loops

let UniqueAgent = [rowsum(AA) == 1]

let UniqueKnowledge = [colsum(AK) == 1]
let $K_i = \{k \mid AK1 == (i,k) \ast UniqueKnowledge(k) \ast UniqueAgent(i)\}$ which means:

Agent i is the only node with the knowledge k

Agent i has only one out-link

Knowledge Access Index for node i is true exactly when at least one of the following holds:

$K_i = 1$

there exists an agent j such that $K_j = 1$ and $A(j,i) = 1$

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Knowledge Based Task Completion

Description
The fraction of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite knowledge to do the tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 
Maximum value: 

Citation

Formula
We compute the fraction of tasks for which the agents assigned to the task do not provide the knowledge required to complete the task.

let suppliedKnowledge = AT'*AK, which is the knowledge supplied to each task via assigned agents
let requiredKnowledge = KT'

let I be the indices of tasks that need knowledge = \{t \mid \text{suppliedKnowledge}(t,k) < \text{requiredKnowledge}(t,k) \text{ for some knowledge } k\}

Knowledge Based Task Completion = fraction of tasks that could be completed = (|T|-|I|) / |T|

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Knowledge Negotiation

Description
The extent to which agents need to negotiate with each other because they lack the knowledge to complete their assigned tasks.

Example
In a given organization, Bob does not have knowledge needed to complete a certain task but Sue does have it. Bob must negotiate with Sue to gain that knowledge to complete the task. The extent to which others in the organization must negotiate for knowledge that others have is the organization's knowledge negotiation value.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
**Formula**

We compute the fraction of tasks for which the agents assigned to the task do not provide the knowledge required to complete the task.

let suppliedKnowledge = \( AT^*AK \), which is the knowledge supplied to each task via assigned agents

let requiredKnowledge = \( KT^* \)

let I be the indices of tasks that need knowledge = \( \{ t \mid suppliedKnowledge(t,k) < requiredKnowledge(t,k) \text{ for some knowledge } k \} \)

Knowledge Negotiation = \( \frac{|I|}{|T|} \) = fraction of tasks that need knowledge

**Reports Using Measure**

- All Measures

  View report to measure table | View measure to report table
Knowledge Omega

Description
The degree to which agents reuse knowledge while doing their tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Network level (one value overall)

- Value type: Real
- Minimum value:
- Maximum value:

Citation

Formula
let matrix TAT = AT'*AT

let matrix N = (T' .* TAT)*KT') .* KT'

Knowledge Omega = sum(N) / sum(KT)

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Knowledge Potential Workload

Description
Maximum knowledge an agent could use to do tasks if it were assigned to all tasks.

Example
In a given organization, let us say Bob is assigned to all tasks in the organization. This measure would compute a value expressing Bob's potential to carry out all the tasks based on his connections to the knowledge needed for the tasks.

Input Networks
These networks are used to compute the measure:

- Source nodeset: agent
- Target nodeset: knowledge
- Link values: binary

- Source nodeset: knowledge
- Target nodeset: task
- Link values: binary

Complexity
Normal computation time

Output
Node level (one value per node)
- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation

Formula
Then Potential Knowledge Workload = rowsum(AK*KT) / sum(KT)

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Knowledge Under Supply

Description
The extent to which the knowledge needed to do tasks are unavailable in the entire organization.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: number of knowledge

Citation

Formula
This is the number of required knowledge not available to tasks based on the current agent task assignments normalized by the number of tasks.

Knowledge Under Supply = \( \frac{\text{sum}((KT - AK^*KT) > 0)}{|T|} \), where \(|T|\) is the number of tasks

Reports Using Measure
- All Measures

View report to measure table | View measure to report table

1261
Lateral Link Count

Description
The fraction of lateral links in a unimodal network. A link \((i,j)\) is one in which the distance from a root node to \(i\) equals that distance from the same root to \(j\). The root node is always chosen to be the first node in the nodeset.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)
Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let \(A\) be the unimodal input network, and fix the first node in the nodeset to be the root
let \(D\) be the matrix of shortest path distances between nodes
let \(S\) = subset of lateral edges = \{(i,j) in A | D(root,i) == D(root,j), and the distance is not infinite\}
Lateral Link Count = \(|S| / (\text{number of links in A})\) = fraction of links in \(A\) that are lateral links

Reports Using Measure
- All Measures

[View report to measure table] [View measure to report table]
**Link Betweenness Centrality**

*Description*
The degree to which each link lies on the shortest paths from one node to another.

*Input Networks*
Unimodal network with link values.

Note: link values are distances (dissimilarity)

*Complexity*
Slow computation time

*Output*
Dyad level (one value per node pair)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

*Citation*

*Formula*
Link Betweenness Centrality for a link L is defined as: across all node pairs that have a shortest path containing L, the fraction that pass through L.

*Reports Using Measure*
- All Measures
- Key Entity

[View report to measure table] [View measure to report table]
**Link Count**

**Description**
The number of links in the network.

**Input Networks**
Any network with binary link values.

**Complexity**
Fast computation time

**Output**
Network level (one value overall)

- Value type: Integer
- Minimum value:
- Maximum value:

**Citation**

**Formula**
The maximum number of links in a network depends on whether the network is symmetric, and whether self-loops are allowed.

For a bimodal network (such as Agent x Knowledge) with m rows and n columns, the maximum number of links = m*n

For a unimodal network (such as Agent x Agent) with n nodes, the maximum number of links is:

- n*n, for a directed (not symmetric) network that allows self-loops
- n*(n-1), for a directed (not symmetric) network that does not allow self-loops

1264
\(\frac{n(n-1)}{2}\), for a symmetric network that does not allow self-loops

\(\frac{n(n+1)}{2}\), for a symmetric network that does allow self-loops

**Reports Using Measure**

- All Measures
- Communicative Power
- Semantic Network
- Simmelian Ties Analysis
- Standard Network Analysis

[View report to measure table] [View measure to report table]
Local Efficiency

Description
This is the degree to which the ego networks of all nodes are closely connected.

Input Networks
Unimodal network with link values.

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
The average Global Efficiency score of the ego networks. The ego network of a node does not include the ego node itself.

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Location Relevance

Description
The extent to which location influences a particular person's connections.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>location</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Reports Using Measure
- All Measures
- Key Entity

View report to measure table | View measure to report table
Minimum Speed

Description
The minimum speed with which two (reachable) nodes can interact. This is based on shortest path lengths.

Example
In an organization, we have Bob and Sue with numerous paths between them. The shortest path between this entity pair would be Bob and Sues (Bob/Sue) minimum speed. One might also say that if there were numerous links between Bob and Sue and that the average linkage was in the neighborhood of 5 paths (e.g., links) when every person in the organization is taken as a whole, the shortest linkage between them would be the minimum speed at which Bob and Sue might communicative. If Bob and Sue had direct links, minimum speed would be 0.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
Formula
The minimum speed with which two (reachable) nodes can interact. This is the inverse of the maximum shortest path in the network (the inverse of the maximum Eccentricity Centrality value of the nodes). If no node is reachable from another node, then Minimum Speed is zero.

Reports Using Measure
- All Measures

[View report to measure table] [View measure to report table]
Network Assortativity

Description
This measures the extent to which nodes of similar degree are inter-connected. High values (+1) mean that the nodes with high degree are clustered together and nodes of low degree are clustered together. Low values (-1) mean that high degree nodes connect to low degree nodes.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: -1
Maximum value: 1

Citation

Formula
let A be the unimodal input network with N nodes

let d be the out-degree of each node

let CoVariance = \[ \sum (A_{i,j} - d_i d_j/2m)(d_i d_j) \]

let Variance = \[ \sum (d_{i,j} * \text{kron}_{i,j} - d_i d_j/2m)(d_i d_j) \]

where \( \text{kron}_{i,j} = 1 \) if \( i = j \), else 0
Then Network Assortativity = CoVariance / Variance

**Reports Using Measure**

- All Measures

[View report to measure table]  |  [View measure to report table]
Node Count

Description
The number of nodes in a unimodal network.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Integer
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures
• Communicative Power
• Communicators
• Core Network
• Semantic Network

View report to measure table | View measure to report table
Nodeset Size

Description
The number of nodes in a nodeset.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: unbounded

Citation
None

Reports Using Measure
• All Measures

View report to measure table  |  View measure to report table
Organization Agent Knowledge Needs Congruence

**Description**
Across all agents, the knowledge that agents lack to do their assigned tasks expressed as a fraction of the total knowledge needed by all agents.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
Let $NK = AT \times KT' = \text{knowledge needed by agents to do their assigned tasks}$
Then the output value = sum(sum(NK .* ~AK)) / sum(N)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organization Agent Knowledge Waste

**Congruence**

**Description**
Across all agents, the knowledge that agents have that are not required to do their assigned tasks.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
Let NK = AT*KT' = knowledge needed by agents to do their assigned tasks
Then the output value = sum(sum(~NK .* AK)) / sum(AK)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organization Agent Resource Needs Congruence

Description
Across all agents, the resources that agents lack to do their assigned tasks expressed as a fraction of the total resources needed by all agents.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let NR = AT*RT* = resources needed by agents to do their assigned tasks
Then the output value = \text{sum(sum(NR .\sim AR))} / \text{sum(N)}

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organization Agent Resource Waste Congruence

Description
Across all agents, the resources that agents have that are not required to do their assigned tasks.

Input Networks
These networks are used to compute the measure:

Source nodeset   Target nodeset   Link values
agent            resource         binary
agent            task             binary
resource         task             binary

Complexity
Normal computation time

Output
Network level (one value overall)
Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let NR = AT*RT' = resources needed by agents to do their assigned tasks
Then the output value = sum(sum(~NR .* AR)) / sum(AR)
Reports Using Measure

- All Measures

[View report to measure table] | [View measure to report table]
Organization Task Knowledge Needs Congruence

Description
Across all tasks, the knowledge that tasks lack expressed as a fraction of the total knowledge needed by all tasks.

Input Networks
These networks are used to compute the measure:

Source nodeset Target nodeset Link values
agent knowledge binary
agent task binary
knowledge task binary

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let $S = AT^*AK = \text{knowledge supplied to tasks via assigned agents}$
We need to sum the knowledge required but not supplied.

The output value = \( \frac{\text{sum}(\text{sum}(KT \cdot \neg S))}{\text{sum}(KT)} \)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organization Task Knowledge Waste Congruence

Description
Across all agents, the knowledge that agents have that are not required to do their assigned tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
Let S = AT*AK = knowledge supplied to tasks via assigned agents

1284
We need to sum the knowledge supplied but not required.

The output value = \( \text{sum(sum}(-\text{KT'} .* S)) / \text{sum(S)} \)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organization Task Resource Needs Congruence

**Description**
Across all tasks, the resources that tasks lack expressed as a fraction of the total resources needed by all tasks.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
Let \( S = AT^*AR \) = resources supplied to tasks via assigned agents
We need to sum the resources required but not supplied.

The output value = sum(sum(RT' .* ~S)) / sum(RT)

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Organization Task Resource Waste Congruence

Description
Across all agents, the resources that agents have that are not required to do their assigned tasks.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent  resource  binary
agent  task  binary
resource  task  binary

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let \( S = AT^*AR \) = resources supplied to tasks via assigned agents
We need to sum the resources supplied but not required.

The output value = \( \text{sum}(\text{sum}(-\text{RT}' \cdot S)) / \text{sum}(S) \)

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Organizational Availability

**Description**
An organization is available to do a task if it has the required agents and the required resources. Computes the degree to which organizations are available to do tasks based on their access to resources and roles that are needed to do the tasks.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>organization</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>organization</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Slow computation time

**Output**
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

**Reports Using Measure**
- All Measures

View report to measure table | View measure to report table
Out-Degree Average Neighbor

Description
Computes for each node the average out-degree of its neighbors. Neighbors are nodes connected to the ego via an out-link. The degree of a neighbor is the number of out-links it has. Isolate nodes are given a score of zero. This measure uses the link values from the ego to its neighbors.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value:
- Maximum value:

Citation

Formula
This is the Average Neighbor In-Degree computed using Out-Links rather than In-Links for steps one and two.

Reports Using Measure
- All Measures
- View Role and Sphere of Influence

View report to measure table | View measure to report table
Out-Degree Centrality

Description
The number of links emanating from a node normalized by the maximum number of such links.

Example
For any node, e.g. an individual or a resource, the out-links are the connections that the node of interest has to other nodes. Imagine an agent by knowledge network where the number of out-links an agent would have is the number of pieces of knowledge it is connected to.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
let A be the input network with maximum link value V

Out-Degree Centrality = rowsum(A) / V*cols(A)
Note: if the network A is unimodal and not using the diagonal, then the measure is normalized by $V^*(\text{cols}(A)-1)$.

**Reports Using Measure**

- All Measures
- Blog
- Change in Key Entities
- Communicators
- Group Talk
- Key Entity
- Standard Network Analysis
- Trails Analysis
- View Role and Sphere of Influence

[View report to measure table] [View measure to report table]
Out-Degree Network Centralization

Description
Network centralization based on the out-degree centrality of each node in a network.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)
- Value type: Real
- Minimum value:
- Maximum value:

Citation
NetStat

Formula
This is the Centralization formula applied to the Out-Degree Centrality scores of the network.

let A be the input network with N columns

let v = vector of Out-Degree Centrality values for network A

let c be the Centralization value for vector v

Out-Degree Centralization = c / (N - 1)

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Overall Role Based Availability

Description
Computes the degree to which agents are available to do tasks based on their access to knowledge and resources and roles that are needed to do the tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>role</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>role</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>role</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>role</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

Reports Using Measure

- All Measures

View report to measure table | View measure to report table
Overall Task Completion

Description

The fraction of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite knowledge and resources to do the tasks.

Input Networks

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity

Normal computation time

Output

Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation


Formula

This is the average of Knowledge Based Task Completion and Resource Based Task Completion.
If either Knowledge or Resource Based Task Completion cannot be computed, then it is not included in the average.

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
PN Centrality

Description
Computes the PN Centrality on the input networks which takes into account both positive and negative links.

Input Networks
A unimodal network that can contain both positive and negative link values.

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation
Everett, M. and Borgatti, S. (2014) "Networks containing negative ties", Social Networks 38 p111-120

Reports Using Measure
- All Measures
- Key Entity
- Standard Network Analysis

View report to measure table | View measure to report table
PageRank Centrality

Description
Calculates the importance of a node based on the importance of its in-coming neighbors. The input network links are normalized and interpreted as the probability of a transition from node i to node j. The PageRank of a node can be interpreted as the fraction of times a node would be visited when traversing the network according to the network of probabilities.

Note that the input network is transformed so that a node with no out-links is given a link to every other node. The final transition probabilities are a combination of this modified input network and a network of small, equal values.

Input Networks
Unimodal network with link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
A node's score is based on the scores of its in-coming neighbor nodes, and in a way analogous to computing Eigenvector Centrality.

The algorithm models someone surfing the web, moving from one page node to another via hyperlinks. Starting from a page, he moves to a hyperlinked page with
probability proportional to the link value. If a page with no hyperlinks is encountered, then any one page is chosen uniformly at random.

In addition, the web surfer can jump to any page at random with a small probability, and if a page has no out-links, then a page is chosen uniformly at random.

let A = input network with N nodes where A >= 0

let rowsum = vector of row sums of A

let C = N x N network with links: (i,j) = (sum(A(i,:)) == 0), that is, transform each empty row of A into a row of ones

let A(i,j) = A(i,j) ./ sum(A(i,:)), that is, normalize each link by the sum of the values in its row to convert A into a stochastic matrix

let E = N x N network with each cell equal to 1/N, which is the random transition matrix

let the Google matrix G = alpha*A + (1 - alpha)*E

PageRank is the dominant eigenvector of the matrix G.

Note: by default alpha = .85 and therefore G > 0, and therefore an all positive dominant eigenvector exists; alpha = 0 would mean that all transitions are based on the probabilities of A, and alpha = 1 would mean that all transitions follow the uniform probabilities of E.

**Reports Using Measure**

- All Measures
- Key Entity

[View report to measure table] [View measure to report table]
Pearson Correlation

Description
Computes the Pearson correlation for each pair of rows.

Input Networks
Any network with binary link values.

Complexity
Slow computation time

Output
Dyad level (one value per node pair)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
None

Formula
Let A be the input network.

For each pair of rows (i,j) we compute the number of Pearson correlation of the row vectors.

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Performance As Accuracy

Description
Measures how accurately agents can perform their assigned tasks based on their access to knowledge and resources.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent          knowledge   binary
agent          task         binary
agent          resource    binary
knowledge      task         binary
resource       task         binary

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
One of the following pairs of matrices must exist: \{AK,KT\} or \{AR,RT\}
If both exist, then the measure first concatenates them into [AK AR], [KT RT] and uses them.

Accuracy is computed based on the binary classification problem, which is computed as follows:

Let $b$ be a binary string of length $|K|$, let $N = KT'$, and let $S = AK$.

Fix a task $t$.

The correct classification of $b$ with respect to task $t$ is defined as:

$$\text{true_answer} = \left( \frac{\sum_{N} t,k b_k}{\sum_{N} t,k} \right) > .5 : \forall k$$

Agent $i$'s classification of $b$ with respect to $t$ is defined as follows:

$$\text{answer}_i = \left( \frac{\sum_{N} t,k S_{i,k} b_k}{\sum_{N} t,k} \right) > .5 : \forall k, i \in I$$

The group of agents assigned to the task classify $b$ using majority voting as follows:

$$\text{group_answer} = \sum_{\text{answer}_i} > (|I|/2) : i \in I$$

The group correctly classified the binary task when $\text{group_answer} = \text{true_answer}$

This is repeated multiple times for each task and across all tasks.

Performance as Accuracy is the fraction of correct classifications by the group.

**Reports Using Measure**

- All Measures
- Immediate Impact
- Key Entity
- Missing Links

[View report to measure table] | [View measure to report table]
Personnel Cost

Description
Total number of people reporting to an agent, plus its total knowledge, resources, and tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Fast computation time

Output
Node level (one value per node)
   Value type: Real
   Minimum value:
   Maximum value:

Citation

Formula
The Personnel Cost of an agent is the sum of the number of in-links from other agents, and the number of out-links to knowledge, resource, and task nodes. This sum is then scaled by dividing by the total possible number of links the agent could have to/from the nodes.

Reports Using Measure
- All Measures
  View report to measure table | View measure to report table
**Political Independence Index**

*Description*
Computes the Political Independence Index on the input networks which takes into account both positive and negative links.

*Input Networks*
A unimodal network that can contain both positive and negative link values.

*Complexity*
Slow computation time

*Output*
Node level (one value per node)

Value type: Real
Minimum value: 
Maximum value: 

*Citation*
Smith, J. at al. (2014) "Power in politically charged networks", Social Networks 36 p162-176

*Reports Using Measure*
- All Measures
- Key Entity
- Standard Network Analysis

[View report to measure table] [View measure to report table]
Pooled Link Count

Description
The fraction of pooled links in a unimodal network. Pooled links point to nodes that other nodes point to.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
A link (i,j) is a pooled link if there is another node in addition to node i that links into node j.

let A be the unimodal input network with m links
let d be the vector of in-degrees for the nodes of A

let P be the subset of links \{(i,j) in A | d[j] > 1\}

Then Pooled Link Count = m / |P|

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table
Potential Boundary Spanner

Description
The degree to which a node spans disconnected groups in a network.

Example
Individuals or organizations that connect groups are those that are connecting disconnected groups. The individual or organization may be connected to only one or a few members of each group.

Input Networks
Unimodal network with link values.

Note: link values are distances (dissimilarity)

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
None

Formula
This is calculated as the ratio of Betweenness Centrality to Total Degree Centrality values on the input network.

let betweennessCentrality = Betweenness Centrality values for the input network
let totalDegreeCentrality = Total-Degree Centrality values for the input network
Potential Boundary Spanner = betweennessCentrality ./ totalDegreeCentrality

Reports Using Measure

• All Measures
• Change in Key Entities
• Communications Network Assessment
• Key Entity
• Simmelian Ties Analysis
• Trails Analysis

View report to measure table | View measure to report table
Potential Workload

Description
Maximum knowledge and resources an agent could use to do tasks if it were assigned to all tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)
  Value type: Real
  Minimum value:
  Maximum value:

Citation

Formula
Actual Workload is computed using Knowledge Potential Workload with the network AK replaced by the concatenated [AK AR] and KT replaced by the concatenated [KT;RT].

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table
Public Health Complexity

Description
Measures the total number of links in the public health system.

Input Networks
The entire meta-network is used as a whole, or only one or more nodesets.

Complexity
Fast computation time

Output
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation
None

Formula

Reports Using Measure
View report to measure table | View measure to report table
Radiality Centrality

Description
The Radiality Centrality of a node is the normalized sum of its closeness to all other nodes. The closeness of a node u to another node v is the network diameter minus the shortest path distance from u to v.

Input Networks
Unimodal network with link values.
Note: link values are distances (dissimilarity)

Complexity
Normal computation time

Output
Node level (one value per node)
Value type: Real
Minimum value: 0
Maximum value: 1

Citation
NetStat

Formula
Consider a network with N nodes, and a minimum link value of value v.
let \( D(i,j) \) = shortest path length from node i to j (or 0 if no path exists)
let diameter be the maximum \( D(i,j) \) over all (i,j) pairs
Radiality Centrality of node i = \( \frac{\text{sum}(\text{diameter} - D(i,:))}{(N-1) \times (\text{diameter} - v)} \)
Note: the maximum value of 1 is achieved for the center node of a star network.
Note: isolates have a score of 0

Reports Using Measure
• All Measures

View report to measure table | View measure to report table

1311
Radials

*Description*
A Radial node is a member of relatively few triads.

*Input Networks*
Unimodal network with binary link values.

*Complexity*
Fast computation time

*Output*
Node level (one value per node)
- Value type: Binary
- Minimum value:
- Maximum value:

*Citation*

*Formula*
Radial nodes have a Triad Count less than one standard deviation below the mean triad count across all nodes.

\[
\text{let triadCounts} = \text{vector of Triad Counts for the input network}
\]

\[
\text{let } u = \text{mean(triadCounts)}
\]

\[
\text{let } d = \text{standard_deviation(triadCounts)}
\]

\[
\text{Radials} = \text{binary vector } [\text{triadCounts} < u+d]
\]

*Reports Using Measure*
- All Measures

[View report to measure table] [View measure to report table]
Reachable Diameter

Description
The longest shortest path between reachable nodes.

Input Networks
Unimodal network with link values.
Note: link values are distances (dissimilarity)

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
The longest shortest path between reachable nodes. This is calculated in the same manner as Diameter, but uses only lengths of paths that exist in the network.

Reports Using Measure
- All Measures
- Standard Network Analysis

View report to measure table | View measure to report table
Reciprocity

**Description**
The fraction of links in the network that go in both directions.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**

**Formula**
The fraction of links in a unimodal network that are **Bi-Directional**.

**Reports Using Measure**
- All Measures
- Standard Network Analysis

[View report to measure table] [View measure to report table]
**Resemblance Correlation**

**Description**
Measures the degree to which each pair of rows has the exact same bits. Each value is normalized by the number of columns.

When computed on an Agent x Knowledge network this is called Cognitive Resemblance, and measures the degree to which each pair of agents has the exact same knowledge. Each value is normalized by the number of knowledge bits.

**Example**
In an given organizational network, let us say that Bob has the knowledge to perform X, Y, and Z. Whereas Sally also has the knowledge to perform X, Y and Z. This measure would rank this pair (i.e., dyad) high in Cognitive Resemblance.

**Input Networks**
Any network with binary link values.

**Complexity**
Slow computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Dyad level (one value per node pair)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

1315
**Citation**


**Formula**

Let A be the input network.

For each pair of rows (i,j) we compute the number of bits for which they have the same value - either zero or one. Each value is normalized by the number of columns of A.

The Resemblance Correlation of rows i and j of A is defined as:

\[
RC(i,j) = \text{sum}(A(i,:) \cdot A(j,:)) + \text{sum}(\neg A(i,:) \cdot \neg A(j,:))
\]

\[
RC = \frac{RC}{\text{cols}(A)}
\]

Note: by definition, \(RC(i,i) = 1\), and RC is symmetric.

The node-level output value for node i = \(\frac{\sum RC_{i,j}}{(\text{rows}(A)-1)}\) : for i ≠ j

This is the average Resemblance Correlation row i has with the other rows.

**Reports Using Measure**

- All Measures

[View report to measure table] | [View measure to report table]
Resource Actual Workload

Description
The resources an agent uses to perform the tasks to which it is assigned.

Input Networks
These networks are used to compute the measure:

Source nodeset Target nodeset Link values
agent resource binary
resource task binary
agent task binary

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
Resource Actual Workload is the same as Knowledge Actual Workload with the knowledge based networks replaced with the corresponding resource networks.

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Resource Based Access Index

Description
Boolean value which is true if an agent has exclusive access to a resource and who is known by exactly one other agent. The one agent known also has its KAI set to one.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent          resource           binary
agent          agent             binary

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Binary
Minimum value:
Maximum value:

Citation

Formula
Resource Access Index is the Knowledge Based Access Index with the knowledge based networks replaced with those for resources.

Reports Using Measure
- All Measures

View report to measure table  |  View measure to report table
Resource Based Task Completion

Description
The fraction of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite resources to do the tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)
Value type: Real
Minimum value:
Maximum value:

Citation

Formula
This is Knowledge Based Task Completion with the knowledge based networks replaced with the corresponding resource networks.

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Resource Negotiation

Description
The extent to which agents need to negotiate with each other because they lack the resources to complete their assigned tasks.

Input Networks
These networks are used to compute the measure:

Source nodeset   Target nodeset   Link values
agent            task             binary
agent            resource         binary
resource         task             binary

Complexity
Normal computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
This is Knowledge Negotiation with the knowledge based networks replaced with the corresponding resource based networks.

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table
Resource Omega

Description
The degree to which agents reuse resources while doing their tasks.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent          task            binary
resource       task            binary
task           task            binary

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 
Maximum value: 

Citation

Formula
This is Knowledge Omega with the knowledge based networks replaced with the corresponding resource based networks.

Reports Using Measure
• All Measures

View report to measure table | View measure to report table

1321
**Resource Potential Workload**

**Description**
Maximum resources an agent could use to do tasks if it were assigned to all tasks.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value: 
- Maximum value:

**Citation**

**Formula**
Potential Resource Workload = rowsum(AR*RT) / sum(RT)

**Reports Using Measure**
- All Measures

[View report to measure table] [View measure to report table]
Resource Under Supply

Description
The extent to which the resources needed to do tasks are unavailable in the entire organization.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: number of resource

Citation

Formula
This is Knowledge Under Supply with the knowledge based networks replaced with the corresponding resource based.

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Role Based Knowledge Availability

Description
Computes the degree to which agents are available to do tasks based on their access to knowledge and roles that are needed to do the tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>role</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>role</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 
Maximum value:

Citation
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Role Based Resource Availability

**Description**
Computes the degree to which agents are available to do tasks based on their access to resources and roles that are needed to do the tasks.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>role</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>role</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Slow computation time

**Output**
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

**Citation**
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

**Reports Using Measure**
- All Measures

[View report to measure table] | [View measure to report table]
Role Knowledge Availability

Description
Computes the number of roles that an agent is qualified to have based on knowledge requirements.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent          knowledge       binary
knowledge      role             binary

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table
Role Resource Availability

**Description**
Computes the number of roles that an agent is qualified to have based on resource requirements.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>role</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Slow computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value:
- Maximum value:

**Citation**
Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of Brigade Level Military Organizations"; PhD Thesis

**Reports Using Measure**
- All Measures

[View report to measure table] | [View measure to report table]
Row Breadth

Description
The fraction of row nodes with degree greater than one.

Example
Consider an Agent x Knowledge network for an organization. The row breadth of this network would tell us the fraction of agents that have at least two pieces of knowledge.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Let A be the input network.

We need to count the number of ones in each row of A.

Let vector d = rowsum(A), where the link values of A are treated as binary
Then Row Breadth = average([d > 1]), that is, the fraction of row nodes that link to at least two column nodes.

**Reports Using Measure**

- All Measures
- Standard Network Analysis

[View report to measure table] [View measure to report table]
Row Count

Description
The number of row (source) nodes in a network.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Integer
Minimum value:
Maximum value:

Citation

Reports Using Measure
- All Measures
- Standard Network Analysis

View report to measure table | View measure to report table
Row Diversity

Description
This measures the degree to which row nodes are non-uniformly connected to column nodes.

When computed on an Agent x Knowledge network, this is also called Knowledge Diversity and characterizes the network in terms of how knowledge is non-uniformly distributed across agents.

When computed on an Agent x Resource network, this is also called Resource Diversity and characterizes the network in terms of how resources are non-uniformly distributed across agents.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)
  Value type: Real
  Minimum value: 0
  Maximum value: 1

Citation

Formula
This is one minus the Herfindahl-Hirshman Index applied to the normalized row sums of the input network..

Reports Using Measure
  • All Measures

View report to measure table | View measure to report table

1331
Row Exclusivity

Description
Detects row nodes that have ties to column nodes that comparatively few other row nodes have.

When computed on an Agent x Knowledge network this is called Knowledge Exclusivity and detects agents who have knowledge that few other agents have.

When computed on an Agent x Resource network this is called Resource Exclusivity and detects agents who have resources that few other agents have.

When computed on an Agent x Task network this is called Task Exclusivity and detects agents assigned to tasks that few other agents are.

Example
Individuals or organizations that are high in exclusivity for location are those that have frequented locations that few others have.

Example
Individuals or organizations that are high in exclusivity for resources are those that have resources that few others have.

Input Networks
Any network with binary link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1
Citation

Formula
let A be the binary input network

We re-weight each out-link to make it inversely proportional to the total number of nodes that link to the target node. Thus, links to a popular target node are less valuable.

let row vector d = colsum(A) be the degree of each column (target) node

Exclusivity for node i = sum(A(i,:) .* exp(1 - d))

Note: exp(1 - d) decreases as the degree d increases, and equals 1 when the degree is 1

Reports Using Measure
- All Measures
- Change in Key Entities
- Communications Network Assessment
- Key Entity
- Management
- Standard Network Analysis
- Trails Analysis
- View Role and Sphere of Influence

View report to measure table | View measure to report table
**Row Exclusivity Complete**

**Description**
Detects row nodes that have ties to column nodes that no other row node has.

**Example**
Individuals or organizations that are high in complete exclusivity for location are those that have frequented locations that no others have.

**Example**
Individuals or organizations that are high in complete exclusivity for resources are those that have resources that no others have.

**Input Networks**
Any network with binary link values.

**Complexity**
Fast computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
let A be the binary input network
We re-weight an out-link to value zero if there are other nodes that link to the same target.

let row vector \( d = \text{colsum}(A) \) be the degree of each column (target) node

Exclusivity for node \( i \) = \( \sum(A(i, :) \cdot (d == 1)) \)

**Reports Using Measure**

- All Measures
- Change in Key Entities
- Key Entity
- Management
- Standard Network Analysis
- View Role and Sphere of Influence

*View report to measure table* | *View measure to report table*
Row Gini Means Difference

Description
Computes the Gini Means Difference for each row in the input network. This is a measure of variability well-suited for data from non-normal distributions. For a unimodal network, this measures the variability in the out-link values for each node. For a bimodal network, this measures the variability of link values for each row node.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 
Maximum value:

Citation
Gini, C. (1912) Variabilita' e mutabilita': contributo allo studio delle distribuzioni e delle relazioni statistiche

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
**Row Redundancy**

**Description**

The fraction of out-links in a network that are redundant. A row node has no redundancy (a value of zero) if it links to at most one column node; each additional link to a column node after the first link is redundant. The row node's redundancy is the fraction of its links that are redundant, and the network's row redundancy is the overall average of the row node redundancies.

**Example**

Row Redundancy computed on an Agent x Knowledge network would measure the extent to which each agent node knows multiple things. If each agent knows no more than one piece of knowledge, then row redundancy is zero. If each agent knows everything, then row redundancy is one.

**Input Networks**

Any network with binary link values.

**Complexity**

Fast computation time

**Output**

Network level (one value overall)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**


**Formula**

Let A be the input network (whose link values will be treated as binary).
We compute for each row node the fraction of its links to column nodes that are redundant. The average of the row node redundancy values is the network's row redundancy.

Let MaxNodeRedundancy = number of columns of A (for unimodal networks without a diagonal, subtract one)

Let vector d = (max(0,rowsum(A)-1) / MaxNodeRedundancy), that is, the fraction of redundant links to column nodes

Then Row Redundancy = average(d), that is, the average row node redundancy

**Reports Using Measure**

- All Measures
- Key Entity
- Standard Network Analysis
- View Role and Sphere of Influence

[View report to measure table] | [View measure to report table]
Sequential Link Count

Description
The fraction of links in a network that are neither bi-directional nor pooled. These links tend to be directed links in a chain.

Input Networks
Unimodal network with binary link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
The fraction of links in a network that are neither Bi-Directional nor Pooled. Note that a link can be both a Pooled and a Bi-Directional link.

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Shared Situation Awareness

Description
Individuals or organizations that are high in group awareness are those that by virtue of their connections to others, what resources they use, what knowledge there is, what tasks there are - have a better understanding of what others are doing. The scientific name of this measure is shared situation awareness.

Input Networks
These networks are used to compute the measure:

Source nodeset Target nodeset Link values
agent agent binary

Complexity
Normal computation time

Output
Node level (one value per node)
Value type: Real
Minimum value: 0
Maximum value: 1
Description: normalized row sum of the dyad output

Network level (one value overall)
Value type: Real
Minimum value: 0
Maximum value: 1
Description: average node level value

Dyad level (one value per node pair)
Value type: Real
Minimum value:
Maximum value:

Citation


**Formula**

let alpha, beta, delta, gamma, mu be decimal numbers.

let $A = \text{Agent x Agent interaction/communication network}$.

let $P = \text{Agent x Agent physical proximity network}$.

let $S = \text{Agent x Agent social demographic similarity network}$.

let $e = \text{eigenvector centrality measure computed on } A$.

let $G = \text{geodesics between agents computed on } A$.

Then the SSA between agents $i$ and $j$ is:

$SSA(i,j) = \alpha e[i]*e[j] + \beta P(i,j) + \delta S(i,j)/(\gamma G(i,j)) + \mu A(i,j)A(j,i)$

let $ssa = \text{rowsum}(ssa)$

The node level output is $ssa / \text{max}(ssa)$

The network level output is defined as the average of the node level output.

**Reports Using Measure**

- All Measures
- Key Entity
- Management

[View report to measure table](#) | [View measure to report table](#)
Simmelian Ties

Description
This measures for each node the fraction of nodes to which it has a Simmelian tie.

Example
Described informally as ties embedded in cliques and are often associated with brokers inside such cliques such that if Bob and Susan only know of each other because of Chan and now all of them, Bob, Susan and Chan, now know each other. Chan, Bob, Susan now have simmelian ties to each other.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation


Formula
let A be the unimodal, binary input network
Symmetrize network A by reducing or removing link values

All Cliques of size $\geq 3$

let $N_i$ be the number of distinct nodes that are in a clique with node $i$

Simmelian Ties for node $i = \frac{N_i}{(N-1)}$, where $N$ is the number of nodes in A

**Reports Using Measure**

- All Measures
- Management
- Standard Network Analysis

[View report to measure table] | [View measure to report table]
Skip Link Count

Description
The fraction of links in a unimodal network that skip levels. A link (i,j) is a skip link if there is a path from node i to node j even after the link (i,j) is removed.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
Social Technical Congruence

Description
Social technical congruence represents the proportion of overall coordination requirements that were satisfied through some type of actual coordination activity carried out through some means of communication.

Input Networks
These networks are used to compute the measure:

Source nodeset  Target nodeset  Link values
agent           agent           binary
agent           task            binary
task            task            binary

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Dyad level (one value per node pair)

Value type: Real
Minimum value:
Maximum value:
**Citation**


**Formula**

A representation of the coordination requirements among the different workers is obtained by multiplying AT, TT and transpose of AT matrices. This product results in a people by people matrix where a cell (i,j) indicates the extent to which person i works on tasks that share dependencies with the tasks worked on by person j. In other words, the resulting matrix represents the Coordination Requirements or the extent to which each pair of people needs to coordinate their work.

The Coordination Requirements (CR) matrix is determined by the following product:

\[
CR = AT \times TT \times AT' = \text{Agent x Agent network}
\]

Given a particular CR matrix constructed from relating product dependencies to work dependencies, we can compare it to an Actual Coordination (CA) matrix that represents the interactions workers engaged in through different means of coordination.

\[
\text{let CA = input network AA = the Actual Coordination matrix}
\]

Social Technical Congruence = \(\frac{\sum(\text{CR} \times \text{CA} > 0)}{\sum(\text{CR} > 0)}\)

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Span Of Control

**Description**
The average number of out-links per node using only nodes with at least one out-link.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Fast computation time

**Output**
Network level (one value overall)
- Value type: Real
- Minimum value: 0
- Maximum value: Nodes - 1

**Citation**

**Formula**
An out-link is counted in the [Out-Degree Centrality](#) and are links from a node to another node.

The out-degree for a node is simply the number of out-links that a node has.

let d = vector of out-degree counts for all nodes

Then Span of Control = sum(d) / sum(d > 0)

**Reports Using Measure**
- All Measures

[View report to measure table] [View measure to report table]

1347
Strict Knowledge Congruence

Description
Measures the similarity between what knowledge are assigned to tasks via agents, and what knowledge are required to do tasks. Perfect congruence occurs when agents have access to knowledge when and only when it is needful to complete tasks.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Knowledge Congruence achieves its maximum value of one if agents have knowledge when and only when it is needful to complete their tasks. Thus, we compute the knowledge assigned to tasks via agents, and compare it with the knowledge needed for tasks.
let $KAT = [AK' \ast AT > 0] = \text{binary matrix of what knowledge is supplied to tasks via agents assigned agents}$

Recall that $KT$ is a binary matrix of knowledge requirements for tasks

Strict Knowledge Congruence = $(\text{sum}(\sim KAT \ast KT) + \text{sum}(KAT \ast \sim KT))/ |K|*|T|$

**Reports Using Measure**

- All Measures
- Immediate Impact
- Key Entity
- Management

[View report to measure table] [View measure to report table]
Strict Resource Congruence

Description
Measures the similarity between resources assigned to tasks via agents, and what resources are required to do tasks. Perfect congruence occurs when agents have resources when and only when it is needful to complete tasks.

Input Networks
These networks are used to compute the measure:

- **Source nodeset**
- **Target nodeset**
- **Link values**
  - agent → resource: binary
  - agent → task: binary
  - resource → task: binary

Complexity
Normal computation time

Output
Network level (one value overall)

Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation

Formula
Strict Resource Congruence is the same as **Strict Knowledge Congruence** with the knowledge based networks replaced with the corresponding resource networks.
Reports Using Measure

- All Measures
- Management

View report to measure table | View measure to report table
**Strong Component Count**

**Description**
The number of strongly connected components in a network. Strong is used to indicate that the input network can be directed.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Normal computation time

**Output**
Network level (one value overall)
- Value type: Integer
- Minimum value:
- Maximum value:

Node level (one value per node)
- Value type: Integer
- Minimum value:
- Maximum value:

**Citation**

**Formula**
A component is a maximal subset of nodes that are mutually reachable (there is a directed path from each node in the component to every other node). If the network is undirected, then Strong Component Count is the same as Weak Component Count.

**Reports Using Measure**
- All Measures

[View report to measure table] [View measure to report table]
**Task Knowledge Needs Congruence**

**Description**
The number of knowledge not supplied to a task, but required to do the task, expressed as a fraction of the total knowledge required for the task.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**

**Formula**
Task Knowledge Needs compares the knowledge requirements of each task with the knowledge available to the task via agents assigned to it. It is similar to Knowledge Congruence, but quantifies only the under supply of knowledge to tasks.
Let $S = A^T A K = \text{knowledge supplied to tasks via assigned agents}$

We need to sum the knowledge required but not supplied.

The output value for task $i = \frac{\text{sum}(K^T(i,:). \sim S(i,:))}{\text{sum}(K^T(i,:))}$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Task Knowledge Waste Congruence

Description
The number of knowledge supplied to a task via agents that are not required by it expressed as a fraction of the total knowledge required for the task.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>knowledge</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Formula
Task Knowledge Waste compares the knowledge requirements of each task with the knowledge available to the task via agents assigned to it. It is similar to Knowledge Congruence, but quantifies only the over supply of knowledge to tasks.
Let $S = AT^*AK = \text{knowledge supplied to tasks via assigned agents}$

We need to sum the knowledge required but not supplied.

The output value for task $i = \text{sum}((\sim KT(i,:).S(i,:)) / \text{sum}(S(i,:)))$

**Reports Using Measure**

- All Measures

[View report to measure table] (View measure to report table)
Task Resource Needs Congruence

Description
The number of resources not supplied to a task, but required to do the task, expressed as a fraction of the total resources required for the task.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation

Formula
Task Resource Needs compares the resource requirements of each task with the resource available to the task via agents assigned to it. It is similar to Resource Congruence, but quantifies only the under supply of resource to tasks.
Let $S = AT^*AR$ = resources supplied to tasks via assigned agents

We need to sum the resources required but not supplied.

The output value for task $i = \frac{\text{sum}(RT'\text{(:,)} \cdot \sim S\text{(:,}))}{\text{sum}(RT'\text{(:,))}}$

**Reports Using Measure**

- All Measures

[View report to measure table](#) | [View measure to report table](#)
Task Resource Waste Congruence

Description
The number of resources supplied to a task via agents that are not required by it expressed as a fraction of the total resources required for the task.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>resource</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>resource</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 
Maximum value: 

Citation

Formula
Task Resource Waste compares the resource requirements of each task with the resources available to the task via agents assigned to it. It is similar to Resource Congruence, but quantifies only the over supply of resources to tasks.
Let $S = AT^*AR = resource\ supplied\ to\ tasks\ via\ assigned\ agents$

We need to sum the resources required but not supplied.

The output value for task $i = \frac{\text{sum}(\sim RT(i,:) \cdot S(i,:))}{\text{sum}(S(i,:))}$

**Reports Using Measure**

- All Measures

[View report to measure table] [View measure to report table]
Total Degree Network Centralization

Description
Network centralization based on the total-degree centrality of each node in a square network.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation
NetStat

Formula
This is the Centralization formula applied to the Total-Degree Centrality scores of the network.

let A be the input unimodal network with N nodes

let v = vector of Total-Degree Centrality values for network A

let c be the Centralization value for vector v

Total-Degree Centralization = c / scale, where scale is computed as follows:

If A has directed links (asymmetric):
(N - 1)*(2*N - 3) / (2*N - 1), when A allows self-loops

(N - 2), when A does not allow self-loops

If A has undirected links (symmetric):

(N - 1)*(N -1) / N, when A allows self-loops

(N - 2), when A does not allow self-loops

Reports Using Measure

• All Measures
• Standard Network Analysis

View report to measure table | View measure to report table
Total-Degree Average Neighbor

**Description**
Computes for each node the average total-degree of its neighbors. Neighbors are nodes connected to the ego via an in-link or out-link. The degree of a neighbor is the number of in-links plus out-links it has. Isolate nodes are given a score of zero. This measure uses the link values from the ego to its neighbors.

**Input Networks**
Unimodal network with link values.

**Complexity**
Fast computation time

**Output**
Node level (one value per node)
- Value type: Real
- Minimum value:
- Maximum value:

**Citation**

**Formula**
This is the Average Neighbor In-Degree computed using In-Links and Out-Links for steps one and two.

**Reports Using Measure**
- All Measures

[View report to measure table] | [View measure to report table]
Total-Degree Centrality

Description
The Total-Degree Centrality of a node is the normalized sum of its In-Degree and Out-Degree.

Input Networks
Unimodal network with link values.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

Citation

Formula
let A be the input network with N nodes and maximum link value V

Total-Degree Centrality for node i = ( sum(A(i,:)) + sum(A(:,i)) - A(i,i) ) / 2*V*(N-1)

Note: if the network A is symmetric, then the measure is normalized by V*(N-1).

Note: if the network A allows self-loops, then the normalize value is incremented.

Reports Using Measure
- All Measures
- Change in Key Entities
• Communications Network Assessment
• Communicative Power
• Core Network
• Immediate Impact
• Key Entity
• Missing Links
• Part Of Speech
• Simmelian Ties Analysis
• Standard Network Analysis
• Tactical Insight
• Trails Analysis
• Twitter

View report to measure table | View measure to report table
Transitivity

**Description**
The fraction of link pairs \{(i,j), (j,k)\} in the network such that (i,k) is also an link in the network.

**Input Networks**
Unimodal network with binary link values.

**Complexity**
Normal computation time

**Output**
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**
NetStat

**Formula**
let L be the set of links in the input network

let I = \{(i,j,k) | i,j,k are distinct node indices\}

let Potential = \{(i,j,k) ∈ I | (i,j) ∈ L and (j,k) ∈ L\}

let Complete = \{(i,j,k) ∈ Potential | (i,k) ∈ L\}

Transitivity = \(|Complete| / |Potential|

**Reports Using Measure**
- All Measures

[View report to measure table] [View measure to report table]
**Triad Count**

*Description*

The number of triads centered at each node in a square network.

*Input Networks*

Unimodal network with binary link values.

*Complexity*

Normal computation time

*Output*

Node level (one value per node)

Value type: Integer
Minimum value: 0
Maximum value: \((n-1)\times(n-2)\), where \(n\) is number of nodes

*Citation*

NetStat

*Formula*

Let \(A\) be the binary, unimodal input network

We create a new network called TriadCount such that:

\[
\text{TriadCount}(i,j) = \text{number of triads using link } (i,j) = \text{cardinality}\{ k \mid A(i,j) \times A(j,k) \times A(i,k) = 1 \forall i,j,k \text{ distinct}\}
\]

The Triad Count for node \(i\) = \(\text{sum(TriadCount}(i,:))\)

*Reports Using Measure*

- All Measures

[View report to measure table] [View measure to report table]
**Description**

These tweeters send messages which are reaching a large number of others either directly due to their followership or indirectly due to the followership of those that retweet or mention them.

**Input Networks**

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
</tbody>
</table>

**Complexity**

Normal computation time

**Output**

Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

**Citation**

None

**Formula**

The Actual Influence of a tweeter is a combination of **direct influence** from its Number Of Followers and **indirect influence** from how often it is mentioned or retweeted.

It is computed as follows:

let w = vector of Number Of Followers values
let \( d = w + [\text{AA-Retweeted-By}]w + [\text{AA-Mentioned-By}]w \)

Actual Influencer Twitter = \( \frac{d}{\max(d)} \)

**Reports Using Measure**

- Twitter

[View report to measure table] [View measure to report table]
**Twitter, Most Mentioned**

**Description**
These tweeters are mentioned the most. This may indicate a dialogue, strong agreement or strong disagreement.

**Input Networks**
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
</tbody>
</table>

**Complexity**
Normal computation time

**Output**
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

**Citation**
None

**Formula**
This is the Out-Degree Centrality of the binarized Agent x Agent Mentioned-By network.

**Reports Using Measure**
- Twitter

[View report to measure table] [View measure to report table]
Twitter, Number of Followers

Description
These tweeters have the most followers.

Input Networks
The entire meta-network is used as a whole, or only one or more nodesets.

Complexity
Fast computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
None

Formula
This value is taken from the NUMBER_FOLLOWERS attribute of the Agent nodeset. Values are scaled by dividing each value by the maximum value.

Reports Using Measure
  • Twitter

View report to measure table | View measure to report table
Twitter, Potential Connectors

Description
These tweeters are disproportionately active in disseminating information. On average they frequently retweet or mention messages and are also frequently retweeted or mentioned.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation
None

Formula
Using the X network described in Potential Reach Twitter, this is the In-Inverse Closeness Centrality using radius = 3, which means that only neighbors within 3 links are used when computing the distance network.

Reports Using Measure
- Twitter

View report to measure table | View measure to report table

1372
Twitter, Potential Consensus Leaders

Description
These are the tweeters that use the most topics also used by other tweeters.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>knowledge</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Normal computation time

Output
Node level (one value per node)

- Value type: Real
- Minimum value: 0
- Maximum value: 1

Citation
None

Formula
let AK (agent x hashtag) be the input network.

This measure gives a new weight to each link (i,j) proportional to the popularity of topic j.

The popularity of topic j is its fraction of the maximum degree of all topics.

Similarly, the weight is also normalized by the fraction of the maximum connection of any agent to that topic.
Therefore:

let d = column sum vector of AK = degree of topic j

let p(j) = d(j) / max(d) = popularity of topic j

let c(j) = max(AK(:,j)) = maximum link value to topic j

let X(i,j) = AK(i,j) * [p(j)/c(j)]

Potential Consensus Leaders = the Out-Degree Centrality of the network X.

Note: the maximum value of 1 achieved with one agent having a connection to all topics with value equal to one, and no other agent with any connections.

**Reports Using Measure**

- Twitter

[View report to measure table] | [View measure to report table]
Twitter, Potential Reach

Description
These tweeters have disproportionate influence as they are relatively close to a large audience and can reach them quickly. On average they frequently tweet, retweet or mention others in their tweets, and their tweets are frequently retweeted or mentioned and then those retweets are frequently retweeted and so on.

Input Networks
These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
</tbody>
</table>

Complexity
Slow computation time

Output
Node level (one value per node)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation
None

Formula
let $W =$ diagonal matrix of Number Of Followers values

let $X = [\text{AA-Retweeted-By}]^*W + [\text{AA-Mentioned-By}]^*W$

Note: $X(i,j) =$ number of times agent $i$ is retweeted or mentioned by agent $j$ scaled by the number of followers of $i$, and a higher value means that $i$ has more influence on $j$. 1375
Invert the values of X so that smaller values mean i has more influence on j.

Potential Reach Twitter = Inverse Closeness Centrality computed on the network X using radius = 3, which means that only neighbors within 3 links are used when computing the distance network.

Note: this measure will use one or both of the AA-Retweeted-By and AA-Mentioned-By networks

**Reports Using Measure**

- Twitter

[View report to measure table] | [View measure to report table]
**Description**
These are the topics that are most likely to be on idea paths.

**Input Networks**
These networks are used to compute the measure:

- **Source nodeset** knowledge
- **Target nodeset** knowledge
- **Link values** weighted

**Complexity**
Normal computation time

**Output**
Node level (one value per node)

- **Value type:** Real
- **Minimum value:** 0
- **Maximum value:** 1

**Citation**
None

**Formula**
This is the Betweenness Centrality scores computed on the input network using radius = 3, which means that only neighbors within 3 links are used when computing the distance network.

**Reports Using Measure**
- Twitter

[View report to measure table] [View measure to report table]
**Description**

These tweeters tend to be retweeted frequently. This suggests widespread trust or interest in what they say. Tweeters that are verified are likely to be very trusted; whereas, frequently retweeted and unverified tweeters may be emergent or locally trusted.

**Input Networks**

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
</tr>
</tbody>
</table>

**Complexity**

Fast computation time

**Output**

Node level (one value per node)

| Value type: Real | Minimum value: 0 | Maximum value: 1 |

**Citation**

None

**Formula**

This is the [Out-Degree Centrality](Out Degree Centrality) of the binarized Agent x Agent Retweeted-By network.

**Reports Using Measure**

- Twitter

[View report to measure table] View measure to report table
**Twitter, Wants To Be Influencer**

*Description*

These tweeters tend to retweet frequently. However, they may not actually influence others as their follower circles or likelihood of being retweeted may be small. Those tweeters that are verified are likely to be more influential.

*Input Networks*

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>weighted</td>
<td>retweeted-by</td>
</tr>
</tbody>
</table>

*Complexity*

Fast computation time

*Output*

Node level (one value per node)

Value type: Real  
Minimum value: 0  
Maximum value: 1

*Citation*

None

*Formula*

This is the In-Degree Centrality of the binarized Agent x Agent Retweeted-By network.

*Reports Using Measure*

- Twitter

[View report to measure table] [View measure to report table]
Uni-directional Link Count

**Description**

The number of links in a unimodal network that only go in one direction (and are therefore not bi-directional).

**Input Networks**

Unimodal network with binary link values.

**Complexity**

Fast computation time

**Output**

Network level (one value overall)

- Value type: Real
- Minimum value:
- Maximum value:

**Citation**


**Reports Using Measure**

- All Measures
- Standard Network Analysis

[View report to measure table](#) | [View measure to report table](#)
Upper Boundedness

Description
The degree to which pairs of agents have a common ancestor.

Example
In an organization, if Bob and Ahmed were both hired by Pedro this measure would compute a value correlating this shared ancestry or linkage that both have to Pedro (using a unimodal "was-hired-by" network).

Input Networks
Unimodal network with binary link values.

Complexity
Slow computation time

Output
Network level (one value overall)

Value type: Real
Minimum value: 0
Maximum value: 1

Citation

Reports Using Measure
- All Measures
- Simmelian Ties Analysis
- Standard Network Analysis

View report to measure table | View measure to report table
Weak Component Count

Description
The number of connected components in an undirected (symmetric) network.

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Network level (one value overall)

- Value type: Integer
- Minimum value: 0
- Maximum value: number of nodes

Citation

Reports Using Measure
- All Measures
- Communicators
- Standard Network Analysis
- Twitter

View report to measure table | View measure to report table
Weak Component Members

Description
Computes the component to which each node belongs in the underlying, undirected network. A component is a maximal subset of nodes that are mutually reachable (there is a path from each node in the component to every other node).

Input Networks
Unimodal network with binary link values.

Complexity
Normal computation time

Output
Node level (one value per node)

Value type: Integer
Minimum value: 0
Maximum value: number of nodes

Citation

Reports Using Measure
- All Measures

View report to measure table | View measure to report table
Weighted Density

Description
The ratio of the sum of the link values versus the maximum possible total sum for the network. The 'maximum possible total sum' is defined as the number of possible links * largest link value.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)

   Value type: Real
   Minimum value: 
   Maximum value: 

Citation

Formula
let A be the weighted input network with m rows and n columns and a maximum link of V

The Weighted Density of network A = sum(A) / V*m*n

If A is unimodal and does not allow self-loops, then Weighted Density = sum(A) / V*n*(n-1)

Note that if A is binary, then V = 1, and the formula is that of Density.
Reports Using Measure

- All Measures
- Key Entity
- Management
- Standard Network Analysis
- Twitter

View report to measure table | View measure to report table
Weighted Individual Congruence

**Description**

Weighted Individual Congruence represents the proportion of individual task coordination requirements that were satisfied through some type of actual coordination activity carried out through some means of communication by the agent.

**Input Networks**

These networks are used to compute the measure:

<table>
<thead>
<tr>
<th>Source nodeset</th>
<th>Target nodeset</th>
<th>Link values</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
<td>binary</td>
</tr>
<tr>
<td>agent</td>
<td>task</td>
<td>binary</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Complexity**

Normal computation time

**Output**

Node level (one value per node)

Value type: Real
Minimum value:
Maximum value:

**Citation**


**Formula**

let the Coordination Requirements (CR) matrix and Actual Coordination Matrix (CA) be defined as in Social Technical Congruence.
We compute the proportion of an agent's coordination requirements that are satisfied through its actual communication.

let $S = CR .* CA$ = matrix of task coordination satisfied by actual communication

let $BCR = [CR > 0]$ = binarized coordination requirement matrix

Individual Congruence for node $i = (\text{sum}(S(i,:)) + \text{sum}(S(:,i))) / (\text{sum}(BCR(i,:)) + \text{sum}(BCR(:,i)))$

**Reports Using Measure**

- All Measures
- Management

[View report to measure table] [View measure to report table]
Weighted Link Sum

Description
The sum of the link values in the network.

Input Networks
Any network with link values.

Complexity
Fast computation time

Output
Network level (one value overall)

Value type: Real
Minimum value:
Maximum value:

Citation

Reports Using Measure
• All Measures

View report to measure table | View measure to report table
**Reports**

**What is a Report?**

A report is a collection of analyses run to answer a particular research question. Most of the analyses are the measures available in ORA. Measure values are typically displayed as ranked tables of values to show which nodes score highest. A report typically also contains bar charts, spider charts, and network pictures that all serve to answer the research question.

A report typically outputs multiple files, and the following file formats are available:

- Text - human readable report in plain text (no images or charts). The "pages" of the report are separate files with appropriate names.
- HTML - which can be viewed in any browser.
- CSV - comma-separated-value files for importing into spreadsheets.
- JSON - data values in JavaScript Object Notation (JSON) format. This format supports access to the computed measures for further analysis.
- PowerPoint - a Microsoft PowerPoint slide deck. Two types of PowerPoint reports are available:
  - All slides - full human readable report, including text, tables, images and charts.
  - Only slides with charts and pictures - contains only slides containing tables, images and charts (with standard label text).
- PDF - human readable report which is saved in a single file.

**Common Reports**

The most common reports are listed below, and all reports are described in detail in separate help pages.

- All Measures by Category - computes all measures in a given category on a meta-network. [More…](#)
- Key Entities Ranking - finds the nodes that repeatedly score the highest on measures. [More…](#)
- Locate Groups - Identifies the groups present in the network using various grouping algorithms. [More…](#)
- Node of Interest Characterization - examines a node and the network immediately around it. [More…](#)
Report General Content

This section contains content common to all reports, and tables that relate reports to measures and usage.

Decimal Numbers

When reporting decimal numbers, the values can be in scientific (e.g. 1.234e01) or fixed notation (e.g. 12.34). Which format to use and how many decimal places to display is configured in the Save dialog of the reports. **Note:** that fixed format will automatically switch to scientific notation if the value is too small to show in the fixed format.

Select a link below:

- Report usage table
- Measure to report table
- Report to measure table
- Comparing measure values with statistics
- Measure values in context
Report Usage Table

This table lists each report and gives a description of what it does and how it might be used.

<table>
<thead>
<tr>
<th>Report</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Measures by Category</strong></td>
<td>Computes all measures in a given category for each input network and creates ranked tables and lists of values.</td>
</tr>
<tr>
<td><strong>Belief Propagation</strong></td>
<td>This report runs a simulation of belief (or attitude) propagation based on the Friedkin model from social influence theory.</td>
</tr>
<tr>
<td><strong>Bibliography and Citation</strong></td>
<td>Analyzes network data extracted from a list of citations in various formats including BibTex, RIS and Scopus.</td>
</tr>
<tr>
<td><strong>Blog</strong></td>
<td>Analyzes data extracted from blogs by the Blogtrackers tool.</td>
</tr>
<tr>
<td><strong>Capabilities</strong></td>
<td>Analyzes the knowledge, resource and task capabilities of agents and organizations in the network.</td>
</tr>
<tr>
<td><strong>Change in Key Entities</strong></td>
<td>Provides information on the overall structure of a complex network and identifies, for each type of node, which nodes stand out.</td>
</tr>
<tr>
<td><strong>Communications Network Assessment</strong></td>
<td>Evaluates the effectiveness of a computer network, with the computer nodes being represented as resources. The computer network represents the physical layer of connections between machines. Effectiveness takes into account the placement of nodes in the network</td>
</tr>
<tr>
<td><strong>Communicative Power</strong></td>
<td>Analyzes one or more semantic networks to classify concepts by measure values.</td>
</tr>
<tr>
<td><strong>Communicators</strong></td>
<td>Analyzes the communication network (agent by agent) and gives high level statistics on its structure.</td>
</tr>
<tr>
<td><strong>Context</strong></td>
<td>Compares measured values against various stylized forms of networks in an effort to characterize network topology.</td>
</tr>
<tr>
<td><strong>Core Network</strong></td>
<td>Computes the core network and reports general statistics. The <strong>core network</strong> is the largest component (sub-graph) in the graph.</td>
</tr>
<tr>
<td><strong>Critical Sets</strong></td>
<td>Finds critical sets of nodes in a network that best reach all other nodes or whose removal maximally disrupts a network. The custom report allows a user to be able to design a report to meet a specific need by identifying the metrics that should be calculated on an input network. The custom report can be used when a specific set of metrics or measures are needed routinely as opposed to simply producing the metrics directly each time.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>Examine whether nodes with the same attribute values are in the same locations.</td>
</tr>
<tr>
<td><strong>Detect Spatial Patterns</strong></td>
<td>Analyzes the ego networks for a collection of nodes. Ego networks</td>
</tr>
</tbody>
</table>
consist of a focal node ("ego") and the nodes to whom ego is connected by a path of a specified maximum length (the radius, most frequently set to 1). This report allows the user to specify ego nodes, radius, and the type of links used to define connections.

**Geospatial Assessment**
Finds nodes that are co-located based and counts the number of nodes that appear in location pairs.

**Group Talk**
Analyzes the relationship between agents and knowledge.

**Hot Topics (Content Analysis)**
This report will identify the most and least frequently mentioned concepts in a text set. The networks are typically formed from AutoMap with a frequency attribute on each concept node. It can operate on any network (meta-network, semantic network, or concept network) as it makes use of only the nodes of the network. This report allows you to perform one of two types of evaluation against the base network: Impact analysis and Replication analysis.

- **Isolation Analysis**: One or more of the nodes identified in the Key Entities Ranking report are deleted as part of an assessment of the degradation in the network if those nodes were no longer in the network. The report then shows the differences in values between the original and modified networks' at both the node and network measure levels.
- **Remove Nodes Replication Analysis**: Set a random number of nodes to delete, then the report will show the differences in values between the original and modified network's. Unlike Isolation Analysis, the nodes are selected at random. The user also selects the number of iterations to execute, allowing a researcher to assess the vulnerability of a network to random node deletions.

**Influence Net**
Displays the influence network and gives high level statistics on its structure.

**K-Centrality**
Calculates the geodesic centrality measures for various radius values k, which approximates the geodesic computation by only considering neighbors within the radius distance.

**Key Entities Ranking**
Identifies key entities and groups who by virtue of their position in the network are critical to its operation.

**Locate Groups**
Identifies groups present in a network by applying one or more grouping algorithms.

**Management**
Use this report to locate strongest and weakness parts of a meta-network and also the most well connected nodes.

**Missing Links**
Compute possible missing links in a network.
<table>
<thead>
<tr>
<th><strong>Network Comparison</strong></th>
<th>Compares the node and link distributions of a collection of meta-networks.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node of Interest Characterization</strong></td>
<td>For each individual, finds some important measures and facts about the actor in relation to their network.</td>
</tr>
<tr>
<td><strong>Optimizer</strong></td>
<td>Adapt the link structure of a meta-network to maximize or minimize selected measure values. This should only be used for small networks of several hundred nodes as it is computationally intensive.</td>
</tr>
<tr>
<td><strong>Part of Speech</strong></td>
<td>Identifies the part of speech from the concepts in a text set. The networks are typically formed from AutoMap with a part of speech (pos) attribute on each concept node. It can operate on any network (meta-network, semantic network, or concept network) as it makes use of only the nodes of the network.</td>
</tr>
<tr>
<td><strong>Potential Errors</strong></td>
<td>Detects potential errors in agent to agent interactions based on the expected interactions from cognitive similarity and expertise.</td>
</tr>
<tr>
<td><strong>QAP/MRQAP Analysis</strong></td>
<td>Compares multiple networks to understand how two different networks relate using one network as dependent and the other as an independent network. Also useful for predicting the future of a network if there are multiple snapshots of the same network.</td>
</tr>
<tr>
<td><strong>Semantic Network</strong></td>
<td>This report analyzes one or more semantic networks, computing central networks and key concepts and links. Performing map comparison can help to answer questions such as:</td>
</tr>
<tr>
<td>- Do different people use the same words and themes in the same way?</td>
<td></td>
</tr>
<tr>
<td>- Do different people link concepts and themes in the same way?</td>
<td></td>
</tr>
<tr>
<td>- Do different people share the same knowledge?</td>
<td></td>
</tr>
<tr>
<td>- How similar or different are the analyzed texts?</td>
<td></td>
</tr>
<tr>
<td><strong>Shortest Path</strong></td>
<td>Computes the shortest path between two entities and general statistics on the paths. The sphere of influence of each entity is also computed.</td>
</tr>
<tr>
<td><strong>Simmelian Ties Analysis</strong></td>
<td>Calculates the number of Asymmetric, Sole-Symmetric and Simmelian ties in unimodal networks computes standard measures on them.</td>
</tr>
<tr>
<td><strong>Socio-cultural Cognitive Mapping</strong></td>
<td>Analyzes social-cultural mappings. Socio-cultural Cognitive Mapping (SCM) is a best-fit network model to the set of underlying node to variable data. SCM permits objective visualization of the network, inference about the impact of changes in the underlying conditions influencing the nodes and comparison of disparate data.</td>
</tr>
<tr>
<td><strong>Statistical Change Detection</strong></td>
<td>Analyzes the changes in network-level measures over time using a Statistical Process Monitoring (SPM) control chart. Control limits are determined based on a user defined level of risk.</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Statistical Distribution</strong></td>
<td>Fits statistical distributions to a network based on measure values.</td>
</tr>
<tr>
<td><strong>Tactical Insight</strong></td>
<td>Analyzes the top agent nodes across time periods, tracking locations and measure values.</td>
</tr>
<tr>
<td><strong>Topic Analysis</strong></td>
<td>Finds topic clusters in a collection of text meta-networks using the latent Dirichlet allocation (LDA) and latent semantic analysis (LSA) algorithms.</td>
</tr>
<tr>
<td><strong>Trails</strong></td>
<td>Analyzes the trails that an entity class makes through another entity class, for example, how vessels pass through ports.</td>
</tr>
<tr>
<td><strong>Triad Census</strong></td>
<td>Computes and classifies the triads in a network.</td>
</tr>
<tr>
<td><strong>Twitter</strong></td>
<td>Identifies key tweeters and tweets and in a meta-network derived from twitter data. Characterizes tweets and tweeters.</td>
</tr>
<tr>
<td><strong>YouTube</strong></td>
<td>Analyzes data extracted from YouTube.</td>
</tr>
</tbody>
</table>
**Measure to Report Table**

To use this table look up the Measure in the left hand column and the Reports it is used in are listed in the right hand column. Measures which only list All Measures by Category are not standard in any report but can be be optionally computed using the All Measures by Category report.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Used by Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access Redundancy</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Actual Workload</strong></td>
<td>All Measures by Category, Changes in Key Entities, Key Entities Ranking, Management, Node of Interest Characterization</td>
</tr>
<tr>
<td><strong>Agent Knowledge Needs Congruence</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Agent Knowledge Waste Congruence</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Agent Resource Needs Congruence</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Agent Resource Waste Congruence</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Agent Socio Economic Power</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Assignment Redundancy</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Authority Centrality</strong></td>
<td>All Measures by Category, Key Entities Ranking, Management</td>
</tr>
<tr>
<td><strong>Average Speed</strong></td>
<td>All Measures by Category, Immediate Impact, Key Entities Ranking, Missing Links</td>
</tr>
<tr>
<td><strong>Betweenness Centrality</strong></td>
<td>All Measures by Category, Communications Network Assessment, Communicative Power, Communicators, Core Networks, Immediate Impact, Influence Net, K-Centrality, Key Entities Ranking, Missing Links, Node of Interest Characterization, Part of Speech, Semantic Network, Simmelian Ties Analysis, Statistical Change Detection, Tactical Insight</td>
</tr>
<tr>
<td><strong>Bonacich Power Centrality</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td><strong>Boundary Spanner</strong></td>
<td>All Measures by Category, Communications Network Assessment</td>
</tr>
<tr>
<td><strong>Burt Constraint</strong></td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Capability</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Characteristic Path Length</td>
<td>All Measures by Category, Immediate Impact, Missing Links</td>
</tr>
<tr>
<td>Classic SNA Density</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Clique Count</td>
<td>All Measures by Category, Changes in Key Entities, Communicators, Key Entities Ranking, Node of Interest Characterization</td>
</tr>
<tr>
<td>Closeness Centrality</td>
<td>All Measures by Category, K-Centrality, Statistical Change Detection</td>
</tr>
<tr>
<td>Closeness Network Centralization</td>
<td>All Measures by Category, K-Centrality</td>
</tr>
<tr>
<td>Clustering Coefficient</td>
<td>All Measures by Category, Communicators, Immediate Impact, Missing Links, Semantic Network</td>
</tr>
<tr>
<td>Cognitive Demand</td>
<td>All Measures by Category, Changes in Key Entities, Immediate Impact, Key Entities Ranking, Management, Node of Interest Characterization</td>
</tr>
<tr>
<td>Cognitive Distinctiveness</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>All Measures by Category, Potential Errors</td>
</tr>
<tr>
<td>Cognitive Resemblance</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Cognitive Similarity</td>
<td>All Measures by Category, Potential Errors</td>
</tr>
<tr>
<td>Column Breadth</td>
<td>All Measures by Category, Management</td>
</tr>
<tr>
<td>Columns Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Column Degree Centrality</td>
<td>All Measures by Category, Key Entities Ranking</td>
</tr>
<tr>
<td>Column Degree Network Centralization</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Column Redundancy</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Communication</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Communication Congruence</td>
<td>All Measures by Category, Immediate Impact, Key Entities Ranking, Missing Links</td>
</tr>
<tr>
<td>Communicative Need</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Complexity</td>
<td>All Measures by Category, Immediate Impact, Key Entities Ranking, Management</td>
</tr>
<tr>
<td>Connectedness</td>
<td>All Measures by Category, Simmelian Ties Analysis</td>
</tr>
<tr>
<td>Correlation Distinctiveness</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Measure</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Correlation Expertise</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Correlation Resemblance</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Correlation Similarity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Density</td>
<td>All Measures by Category, Communicative Power, Communicators, Core Networks, Immediate Impact, Key Entities Ranking, Missing Links, Semantic Network, Simmelian Ties Analysis, Statistical Change Detection</td>
</tr>
<tr>
<td>Diameter</td>
<td>All Measures by Category, Key Entities Ranking, Semantic Network</td>
</tr>
<tr>
<td>Diffusion</td>
<td>All Measures by Category, Immediate Impact, Missing Links</td>
</tr>
<tr>
<td>Edge Betweenness Centrality</td>
<td>All Measures by Category, Key Entities Ranking</td>
</tr>
<tr>
<td>Effective Network Size</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Efficiency</td>
<td>All Measures by Category, Simmelian Ties Analysis</td>
</tr>
<tr>
<td>Eigenvector Centrality</td>
<td>All Measures by Category, Changes in Key Entities, Communications Network Assessment, Key Entities Ranking, Node of Interest Characterization</td>
</tr>
<tr>
<td>Eigenvector Centrality Per Component</td>
<td>All Measures by Category, Changes in Key Entities, Key Entities Ranking</td>
</tr>
<tr>
<td>Exclusivity</td>
<td>All Measures by Category, Changes in Key Entities, Communications Network Assessment, Key Entities Ranking, Management, Node of Interest Characterization</td>
</tr>
<tr>
<td>Exclusivity Complete</td>
<td>All Measures by Category, Changes in Key Entities, Key Entities Ranking, Management, Node of Interest Characterization</td>
</tr>
<tr>
<td>Fragmentation</td>
<td>All Measures by Category, Immediate Impact, Key Entities Ranking, Missing Links</td>
</tr>
<tr>
<td>Geodesic Distance</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Global Efficiency</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>All Measures by Category, Simmelian Ties Analysis</td>
</tr>
<tr>
<td>Hub Centrality</td>
<td>All Measures by Category, Key Entities Ranking, Management</td>
</tr>
<tr>
<td>In Degree Centrality</td>
<td>All Measures by Category, Communicators, Influence Net, Key Entities Ranking, Management</td>
</tr>
<tr>
<td>In Degree Network Centralization</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Information Centrality</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Measure</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Interdependence</td>
<td></td>
</tr>
<tr>
<td>Interlockers</td>
<td></td>
</tr>
<tr>
<td>Inverse Closeness Centrality</td>
<td></td>
</tr>
<tr>
<td>Isolate Count</td>
<td></td>
</tr>
<tr>
<td>Knowledge Access Index</td>
<td></td>
</tr>
<tr>
<td>Knowledge Actual Workload</td>
<td></td>
</tr>
<tr>
<td>Knowledge Congruence</td>
<td></td>
</tr>
<tr>
<td>Knowledge Diversity</td>
<td></td>
</tr>
<tr>
<td>Knowledge Exclusivity</td>
<td></td>
</tr>
<tr>
<td>Knowledge Load</td>
<td></td>
</tr>
<tr>
<td>Knowledge Negotiation</td>
<td></td>
</tr>
<tr>
<td>Knowledge Omega</td>
<td></td>
</tr>
<tr>
<td>Knowledge Potential Workload</td>
<td></td>
</tr>
<tr>
<td>Knowledge Redundancy</td>
<td></td>
</tr>
<tr>
<td>Knowledge Task Completion</td>
<td></td>
</tr>
<tr>
<td>Knowledge Under Supply</td>
<td></td>
</tr>
<tr>
<td>Lateral Link Count</td>
<td></td>
</tr>
<tr>
<td>Link Count</td>
<td></td>
</tr>
<tr>
<td>Local Efficiency</td>
<td></td>
</tr>
<tr>
<td>Location Relevance</td>
<td>GeoSpatial Assessment, Key Entities Ranking</td>
</tr>
<tr>
<td>Minimum Speed</td>
<td></td>
</tr>
<tr>
<td>Network Levels</td>
<td></td>
</tr>
<tr>
<td>Node Count</td>
<td></td>
</tr>
<tr>
<td>Organization Agent</td>
<td></td>
</tr>
<tr>
<td>Knowledge Needs Congruence</td>
<td></td>
</tr>
<tr>
<td>Organization Agent</td>
<td></td>
</tr>
<tr>
<td>Measure</td>
<td>Categories</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Knowledge Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Agent Resource Needs Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Agent Resource Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Task Knowledge Needs Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Task Knowledge Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Task Resource Needs Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Organization Task Resource Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Out Degree Centrality</td>
<td>All Measures by Category, Communicators</td>
</tr>
<tr>
<td>Out Degree Network Centralization</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Overall Task Completion</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Performance as Accuracy</td>
<td>All Measures by Category, Immediate Impact, Key Entities Ranking, Missing Links</td>
</tr>
<tr>
<td>Personnel Cost</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Pooled Link Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Potential Boundary Spanner</td>
<td>All Measures by Category, Changes in Key Entities, Communications Network Assessment, Key Entities Ranking, Node of Interest Characterization, Simmelian Ties Analysis</td>
</tr>
<tr>
<td>Potential Workload</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Radials</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Reciprocity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Relative Cognitive Distinctiveness</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Relative Cognitive Expertise</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Relative Cognitive</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Parameter</td>
<td>Measure Details</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resemblance</td>
<td></td>
</tr>
<tr>
<td>Relative Cognitive Similarity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Relative Expertise</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Relative Similarity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Access Index</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Actual Workload</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Congruence</td>
<td>All Measures by Category, Management</td>
</tr>
<tr>
<td>Resource Diversity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Exclusivity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Load</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Negotiation</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Omega</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Potential Workload</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Redundancy</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Task Completion</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Resource Under Supply</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Row Breadth</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Row Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Row Degree Centrality</td>
<td>All Measures by Category, Changes in Key Entities, Group Talk, Key Entities Ranking</td>
</tr>
<tr>
<td>Row Degree Network Centralization</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Row Redundancy</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Sequential Link Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Shared Situation Awareness</td>
<td>All Measures by Category, Key Entities Ranking, Node of Interest Characterization, Management</td>
</tr>
<tr>
<td>Simmelian Ties</td>
<td>All Measures by Category, Management</td>
</tr>
<tr>
<td>Skip Link Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Social Technical Congruence</td>
<td>All Measures by Category, Capabilities</td>
</tr>
<tr>
<td>Span of Control</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Spatial Betweenness</td>
<td>All Measures by Category, GeoSpatial Assessment</td>
</tr>
<tr>
<td>Measure</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Centrality</td>
<td></td>
</tr>
<tr>
<td>Spatial Closeness Centrality</td>
<td>All Measures by Category, GeoSpatial Assessment</td>
</tr>
<tr>
<td>Spatial Degree Centrality</td>
<td>All Measures by Category, GeoSpatial Assessment</td>
</tr>
<tr>
<td>Spatial Eigenvector Centrality</td>
<td>All Measures by Category, Key Entities Ranking</td>
</tr>
<tr>
<td>Strict Knowledge Congruence</td>
<td>All Measures by Category, Capabilities, Immediate Impact, Key Entities Ranking</td>
</tr>
<tr>
<td>Strict Resource Congruence</td>
<td>All Measures by Category, Capabilities, Key Entities Ranking, Management</td>
</tr>
<tr>
<td>Strong Component Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Task Exclusivity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Task Knowledge Needs Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Task Knowledge Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Task Resource Needs Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Task Resource Waste Congruence</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Total Degree Centrality</td>
<td>All Measures by Category, Changes in Key Entities, Communications Network Assessment, Communicative Power, Core Networks, Immediate Impact, Key Entities Ranking, Missing Links, Node of Interest Characterization, Part of Speech, Simmelian Ties Analysis, Tactical Insight</td>
</tr>
<tr>
<td>Total Degree Network Centralization</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Transitivity</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Triad Count</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Upper Boundedness</td>
<td>All Measures by Category, Simmelian Ties Analysis</td>
</tr>
<tr>
<td>Weak Boundary Spanner</td>
<td>All Measures by Category</td>
</tr>
<tr>
<td>Weak Component Count</td>
<td>All Measures by Category, Communicators</td>
</tr>
<tr>
<td>Weak Component Members</td>
<td>All Measures by Category</td>
</tr>
</tbody>
</table>
# Report To Measure Table

This table shows for each Report (left-hand column) the Measures (right-hand column) that it uses.

<table>
<thead>
<tr>
<th>Report Measures All Measures by Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>All available measures are used.</td>
</tr>
</tbody>
</table>

**Belief Propagation Bibliography and Citation Blog Capabilities Change in Key Entities**

**Agent Level:** Measures computed on agent nodes.

- Actual Workload
- Betweenness Centrality
- Clique Count
- Cognitive Demand
- Eigenvector Centrality
- Out-Degree Centrality
- Potential Boundary Spanner
- Row Exclusivity
- Row Exclusivity Complete
- Total-Degree Centrality

**Communications Network Assessment**

**Potential for Catastrophic Failure**

- Boundary Spanner
- Potential Boundary Spanner
- Row Exclusivity

**Reliability of Injected Messages**

- Eigenvector Centrality
- Total-Degree Centrality

**Reliability of Relaying Messages**

- Betweenness Centrality
Communicative Power

- **Betweenness Centrality**
- **Density**
- **Link Count**
- **Node Count**
- **Total-Degree Centrality**

Communicators

**Node Level**: Node-level measures computed on meta-network.

- **Betweenness Centrality**
- **In-Degree Centrality**
- **Out-Degree Centrality**

**Network Level**: Network-level measures computed on meta-network.

- **Clique Count**
- **Clustering Coefficient Density**
- **Density**
- **Node Count**
- **Weak Component Count**

Context Core Network

**Node Level**: Node-level measures computed on meta-network.

- **Betweenness Centrality**
- **Total-Degree Centrality**

Critical Sets Custom Detect Spatial Patterns Ego Net Geospatial Assessment Group Talk

- **Out-Degree Centrality**

Hot Topics (Content Analysis)

Each node is ranked by its frequency attribute value.

Immediate Impact

**Node Level**: Node-level Measures computed on meta-network.
**Betweenness Centrality**
**Cognitive Demand**
**Column Gini Means Difference**
**Total-Degree Centrality**

**Impact Measures**: Measures used to assess the impact of removing one or more nodes from the meta-network.

- **Average Speed**
- **Characteristic Path Length**
- **Clustering Coefficient Density**
- **Communication Congruence**
- **Complexity**
- **Density**
- **Diffusion**
- **Fragmentation**
- **Isolate Count**
- **Performance As Accuracy**
- **Strict Knowledge Congruence**

**Influence Net**

- **Betweenness Centrality**
- **In-Degree Centrality**

**K-Centrality**

**Node Level**: Node-level measures computed on meta-network.

- **Betweenness Centrality**
- **Closeness Centrality**
- **In-Closeness Centrality**

**Network Level**: Network-level measures computed on the meta-network.

- **Betweenness Network Centralization**
- **Closeness Network Centralization**

**Key Entities Ranking**

**Unimodal Network Measures**: These measures are computed on all unimodal networks, such as Agent x Agent and Task x Task.

- **Authority Centrality**
- Betweenness Centrality
- Closeness Centrality
- Constraint Structural Holes
- Effective Network Size Structural Holes
- Efficiency Structural Holes
- Ego Betweenness Centrality
- Eigenvector Centrality
- Hub Centrality
- In-Degree Centrality
- Out-Degree Centrality
- PN Centrality
- PageRank Centrality
- Political Independence Index
- Total-Degree Centrality

**Bimodal Network Measures:** These measures are computed on all bi-modal networks, such as Agent x Knowledge or Event x Task.

- Out-Degree Centrality
- Row Exclusivity
- Row Exclusivity Complete
- Row Redundancy

**Agent Level:** Measures computed for agent nodes.

- Actual Workload
- Betweenness Centrality
- Clique Count
- Cognitive Demand
- Eigenvector Centrality
- Link Betweenness Centrality
- Potential Boundary Spanner
- Shared Situation Awareness
- Total-Degree Centrality

**Organization Measures:** Measures computed for organization nodes.

- Betweenness Centrality
- Eigenvector Centrality
- Out-Degree Centrality
- Potential Boundary Spanner
- Total-Degree Centrality

**Knowledge Level:** Measures computed for knowledge nodes.
• **Betweenness Centrality**
• **Out-Degree Centrality**
• **Total-Degree Centrality**

**Resource Level:** Measures computed for resource nodes.

• **Out-Degree Centrality**
• **Total-Degree Centrality**

**Location Level:** Measures computed on location nodes.

• **Eigenvector Centrality Spatial**
• **Location Relevance**
• **Total-Degree Centrality**

**Event Level:** Measures computed on event nodes.

• **Out-Degree Centrality**
• **Total-Degree Centrality**

**Task Level:** Measures computed on task nodes.

• **Out-Degree Centrality**
• **Total-Degree Centrality**

**Performance Measures:** These are the measures used to quantify the performance of the meta-network.

• **Average Speed**
• **Communication Congruence**
• **Complexity**
• **Density**
• **Diameter**
• **Fragmentation**
• **Performance As Accuracy**
• **Strict Knowledge Congruence**
• **Weighted Density**

Locate Groups Management

**Agent Level:** Measures computed on agent nodes.

• **Actual Workload**
• **Authority Centrality**
• Betweenness Centrality
• Closeness Centrality
• Cognitive Demand
• Hub Centrality
• Individual Congruence
• Row Exclusivity
• Row Exclusivity Complete
• Shared Situation Awareness
• Weighted Individual Congruence

**Knowledge Level**: Measures computed on knowledge nodes.

• In-Degree Centrality

**Resource Level**: Measures computed on resource nodes.

• In-Degree Centrality

**Task Level**: Measures computed on task nodes.

• In-Degree Centrality

**Performance Measures**: Measures used to assess the overall performance of the meta-network.

• Column Breadth
• Complexity
• Density
• Shared Situation Awareness
• Strict Knowledge Congruence
• Strict Resource Congruence
• Weighted Density

**Potential Problem Measures**: Measures used to compute potential problems in the meta-network.

• Actual Workload
• Cognitive Demand
• In-Degree Centrality
• Shared Situation Awareness
• Simmelian Ties

Missing Links
Node Level: Node-level measures computed on meta-network.

- Betweenness Centrality
- Total-Degree Centrality

Impact Measures: Measures to assess the impact in the meta-network.

- Average Speed
- Characteristic Path Length
- Clustering Coefficient Density
- Communication Congruence
- Density
- Diffusion
- Fragmentation
- Isolate Count
- Performance As Accuracy

Network Comparison Node of Interest Characterization

- Betweenness Centrality
- Closeness Centrality
- Cognitive Demand
- Constraint Structural Holes
- Effective Network Size Structural Holes
- Efficiency Structural Holes
- In-Degree Centrality
- Out-Degree Centrality
- Row Exclusivity
- Row Exclusivity Complete
- Row Redundancy

Optimizer Part Of Speech

- Betweenness Centrality
- Total-Degree Centrality

Potential Errors

- Expertise Correlation
- Jaccard Similarity Correlation

QAP/MRQAP Analysis Semantic Network

- Betweenness Centrality

1408
• **Clustering Coefficient Density**
• **Density**
• **Diameter**
• **Link Count**
• **Node Count**

Shortest Path Simmelian Ties Analysis

**Node Level**: Node-level measures computed on meta-network.

• **Betweenness Centrality**
• **Potential Boundary Spanner**
• **Total-Degree Centrality**

**Network Level**: Network-level measures computed on meta-network.

• **Connectedness**
• **Density**
• **Efficiency**
• **Hierarchy**
• **Link Count**
• **Upper Boundedness**

Socio-cultural Cognitive Maps Statistical Change Detection

• **Betweenness Centrality**
• **Closeness Centrality**
• **Density**

Statistical Distribution Tactical Insight

• **Betweenness Centrality**
• **Total-Degree Centrality**

Topic Analysis Trails

**Agent Level**

• **Betweenness Centrality**
• **Clique Count**
• **Eigenvector Centrality**
• **Out-Degree Centrality**
• **Potential Boundary Spanner**
• **Row Exclusivity**
• Total-Degree Centrality

Triad Census Twitter

Network Level

• Weak Component Count
• Weighted Density

Agent Level

• Twitter, Actual Influencer
• Twitter, Most Mentioned
• Twitter, Number of Followers
• Twitter, Potential Connectors
• Twitter, Potential Consensus Leaders
• Twitter, Potential Reach
• Twitter, Trusted Source
• Twitter, Wants To Be Influencer

Knowledge Level

• In-Degree Centrality
• Total-Degree Centrality
• Twitter, Topic Local Connectors

Location Level

• In-Degree Centrality

YouTube

Video Analysis

• In-Degree Centrality
• Out-Degree Centrality
• Column Breadth
• Column Exclusivity Complete

Commenter Analysis

• In-Degree Centrality
• Out-Degree Centrality
• Commenter, Length of Comments
Category Analysis

- In-Degree Centrality
- Column Exclusivity Complete

Channel Analysis

- In-Degree Centrality
- Column Exclusivity Complete

Social Media Analysis

- In-Degree Centrality
- Column Degree Exclusivity

Co-Commenter

- Total-Degree Centrality
- Betweenness Centrality
Statistical Comparison

Some reports support statistical comparison. For example, in the Key Entities Ranking report and the All Measures by Category reports bootstrapping techniques are used to assess statistical differences between statistics drawn from different networks. Two techniques are used:

1. Random Reassignment: "Shuffle" the links in a network around - and thereby keep same size and density.
2. Bootstrapping: Remove a small percentage of nodes and their attached links.

To compare the metrics a t-statistic[^1] is then calculated. Note that when the number of samples is large (> 100) the distribution for the t-statistic becomes the normal distribution.

[^1]: t-statistic is a ratio of the departure of an estimated parameter from its notional value and its standard error.
Context in Reports

Context attempts to address the question, "There's the measure values, but are they what I should expect? Are they low or high? I'm not sure what I should be seeing."

The Context the user needs from their measure values is comparing their measure values with the measure values that would result from a random network of the same size and density. This is somewhat helpful in addressing the questions, but by no means complete. It essentially answers how different the user's network is from a random network, and this may, or may not, be that useful to some users.

Most reports that use tables, which is nearly all of them, would show Context.

If you run a report on a single meta-network, then the some of the tables you see would show the Context. Not all measures have it, only some of them.

Example: In-the-Know (Total Degree Centrality)

The Total Degree Centrality of a node is the normalized sum of its row and column degrees. Individuals or organizations who are "in the know" are those who are linked to many others and so, by virtue of their position have access to the ideas, thoughts, beliefs of many others. Individuals who are "in the know" are identified by degree centrality in the relevant social network. Those who are ranked high on this metrics have more connections to others in the same network. The scientific name of this measure is total degree centrality and it is calculated on the agent by agent matrices.

Input network: characters x characters (size: 6, density: 0.466667)

<table>
<thead>
<tr>
<th>Rank</th>
<th>Characters</th>
<th>Value</th>
<th>Unscaled</th>
<th>Context *</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>indiana_jones</td>
<td>1.00</td>
<td>5.00</td>
<td>2.62</td>
</tr>
<tr>
<td>2</td>
<td>barranca</td>
<td>0.40</td>
<td>2.00</td>
<td>-0.33</td>
</tr>
<tr>
<td>3</td>
<td>belloq</td>
<td>0.40</td>
<td>2.00</td>
<td>-0.33</td>
</tr>
<tr>
<td>4</td>
<td>natives</td>
<td>0.40</td>
<td>2.00</td>
<td>-0.33</td>
</tr>
<tr>
<td>5</td>
<td>satipo</td>
<td>0.40</td>
<td>2.00</td>
<td>-0.33</td>
</tr>
<tr>
<td>6</td>
<td>jake</td>
<td>0.20</td>
<td>1.00</td>
<td>-1.31</td>
</tr>
</tbody>
</table>

* Number of standard deviations from the mean of a random network of the same size and density
Mean: 0.47  Mean in random network: 0.47
Std.dev: 0.25  Std.dev in random network: 0.20
**Common Procedures**

When creating reports, some procedural steps are used in multiple reports. Detailed descriptions for these common procedures are provided separately for each procedure.

**Filter Data** – Select the nodesets and networks to analyze in reports.

**Measures** – Select measures for reports to use in analysis.

**Measure Means Test** – Select options for measure means testing.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Preferences** – Choose options to customize report output.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Remove Nodes** – Select nodes to remove from each meta-network before generating reports.

**Save Options** – Select the report output format(s) and storage location.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Union by Thirds** – Select how to group the meta-networks into periods for analysis.
Select Report Common Procedure

Description

Select the report and the target meta-network or meta-networks.

Procedure

![Generate Reports - Locate Groups](image)

Reports: Select/change the report. The report type can be changed dynamically by the user:

Report combo box Lists all reports alphabetically. Click the down-arrow (▼) to view the report list or type into the text field to search the report list (for instance type "key" to list all reports with key in the name).

[ Categories ▼ ] Click the button to see a list of reports structured by category. See Groupings of Reports for a list of reports by category.

In this example the Locate Groups report was selected.

The selected report is briefly described in a set of tabs which are user selectable:
Description Provides a brief description of the report selected under Reports:. This value is automatically updated each time the report type is changed.

Input Requirements Provides a short list of the inputs required by the report selected under Reports:. This value is automatically updated each time the report type is changed.

Output Formats Provides a short list of the outputs generated by the report selected under Reports:. This value is automatically updated each time the report type is changed.

Meta-Networks: Choose the target meta-network or meta-networks for analysis. In this example a single meta-network was selected.

**Special Considerations**

*None.*

**References**

*None.*
Filter Data Common Procedure

Description
Select the nodesets and networks to analyze in reports. Processing time can be reduced by unselecting networks you do not wish to analyze.

Procedure

Select the parts of the meta-network to analyze.

Nodesets to analyze: Lists all nodesets contained in the input meta-networks. Nodesets checked will be included in the report and unchecked nodesets will be excluded. The networks list below is updated automatically to include only selected nodesets.

The [ Select All ] and [ Clear All ] buttons at the bottom of the list select or clear (check or uncheck) all the nodesets in the list.
Networks to analyze: The list only includes networks where both nodesets have been selected for analysis. Networks checked will be included in the report and unchecked networks will be excluded.

The [ Select All ] and [ Clear All ] buttons at the bottom of the list select or clear (check or uncheck) all the networks in the list.

As shown above, after unchecking the Knowledge nodeset, the Agent x Knowledge disappears from the Networks to analyze: list. The Agent x Agent network is unchecked, leaving the Agent x Task for analysis.

**Special Considerations**

None.

**References**

None.
Measures Common Procedure

Description

Allows customization of the report by changing the measures included. The three standard configurations are intended to allow the user to trade off processing time versus complexity for large meta-networks. The specific measures option allowing for report customization. A report does not necessarily use all measures.

Procedure

Measures: Select one of the following mutually exclusive options.

Run with all measures (Default value.) Select to run the full report, including all measures. This is the most computationally intensive of the standard configurations.

Run with fast and normal measures Exclude computationally intense measures to decrease processing time.

Run with only fast measures Run using only the least computationally complex measures.

Run with specific measures When selected, a tabbed panel opens to allow selection of measures and the data inputs for the selected measures.

**Hint:** Selecting specific measures is a useful when creating a customized report or focusing the All Measures report. Individual measure selection is not normally necessary when running a standard report.

**Tab List** Enables switching between the Select Measures and Set Measure Inputs panels.

Select Measures tab active.
Set Measure Inputs tab active.
Select Measures allows selection of measures for the report.
When the dialog for measure selection opens, measures are pre-selected based on the last standard option selected (i.e. one of "all", "fast and normal", "all measures"). The selected measures may or may not be used for the current report. See Report to Measure Table for a list of measures by report or check the Reports using the measure: entry in the Set Measure Inputs tab for information on individual measures.

In the sample shown above, Run with only fast measures was selected before Run with specific measures. Note that the selected measures are all marked as "fast" in the Computation Time column.

This example of the measures selection dialog shows the following (from top to bottom):

Search Bar Provides a simple pattern matching facility. Type one or more search words separated by a space. Use quotation marks to search for a phrase. For further information and additional selection options, see Searching and Filtering, below.

Selection panel This scrollable panel shows the list of node names for the selected tab after the search (or the entire list if no search is active). On the left of each line is a check box to select the measures individually. The following information fields are present and are sortable and searchable:

Measure Title Measure name.

Network Level Measure characterizes networks (true/false).

Node Level Measure characterizes nodes (true/false).

Computation Time Indicates the relative time requirement to compute measure, one of:

- fast
- normal
- slow

Uses Link Values Measure uses the link weight as an input (true/false).

Note: Pointing at a measure line in the panel will display the measure description:
Select/Clear All Checking this box selects all measures (whether the measure is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all measures.

Select/Clear Visible Checking this box selects visible measures under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all measures found by a search. Unchecking the box deselects just the measures.

Set Measure Inputs Provides information on individual measures selected under the Select Measures tab and allows selection of input where appropriate.
Select a measure: Allows measure selection using the pull down menu containing all selected measures (as previously selected under the Select Measures tab). Alternatively, typing into the measure name field will display a list of all selected measure titles containing matching text. The match list entries can be selected individually using a pointing device or keyboard up and down arrow keys (using the enter key to select). In the image below, after "cent" has been typed, a list of matches is open and the measure "Network Centralization, Out Degree" is highlighted for selection.
Description: Describes the purpose, formula, inputs and outputs for the selected measure.

Reports using the measure: Lists the standard reports which employ the selected measure.

**Input Selection** Displays the measure's input type and, if appropriate, an entry line which lists the available inputs for user selection (if no eligible candidates exist in the input meta-network, the pulldown menu is empty). (Note that not all measures have user selectable inputs.) Additional input lines can be added by clicking the [New] where multiple appropriate inputs exist in the input. The list of user selected inputs can be cleared by clicking the [Clear] and restarted if desired. Several examples are shown below.

The **Complexity** measure applies to the meta-network as a whole and has no user selectable inputs:
The **Redundancy, Access** measure uses an network of nodeset class **agent x resource**. The pulldown menu (**Select...**) below allows selection of one of the eligible networks:
The **Actual Workload** measure uses five networks of various nodeset classes. The pulldown menus below allows selection of one of the eligible networks:

### Searching and Filtering

The Select Measures panel supports several techniques for searching and filtering the measures list. More than one search/filter (collectively referred to as "filters") can be active at the same time. Searching and filtering reduces the list of measures displayed to simplify measure selection. The measures list is not otherwise altered.

**Search Bar** Allows string matching of entries in the measures list.

**Text Entry Field** Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the list of measures. Use quotation marks to search for a phrase (spaces are treated as part of the search). All fields are searched (for example entering "fast" will show measures with this value in the Computation Time column).

[ Contains ▼ ] / [ Equals ▼ ] This button controls the text match policy. Contains matches all measures lines which include the string in any position. Equals matches only complete words. For example:
Searching for "span", Contains selected. Three measures found.

See Options below.

**Column Filters** Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu.

The filter menu supports two types of filtering:

- The check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as the true/false entries in the Network Level column.
- Checking the Define a custom filter: option allows a text search. This filter technique provides a convenient way to filter columns with a large number of diverse entries such as the Measure Title column. The string match
  - Contains
  - Not contain
  - Equals
  - Not equal

For example:

After opening the filter menu for the Computation Time column, all entries except **fast** are unchecked:
After the filter is applied, the measure list display now contains only measures labeled fast:
A second filter menu is opened on the Measure Title column. In this instance the Define a custom filter: option was checked, the string "gini" entered and the match option Contains was selected. Clicking the [ Apply ] button will apply the filter:
After the filter has been applied, two entries are displayed:
Options Additional options for searching are revealed when the button is clicked (use to close).

[ Clear filters ] Clear all filters, including search strings. Displays the entire measures list.

Match all Show only measure lines that match all filters (equivalent to a logical and). (Match all is selected on start up.)

Match at least one Show measure lines that match any filter (equivalent to a logical or).

Sorting The displayed list of measures can be sorted by clicking on a column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is alphabetical (i.e. A-Z). A second click sorts the list in reverse alphabetical order (i.e. Z-A). Clicking a different column header will resort the list based on that column's content. In the image below, the list has been sorted to show the measure titles in reverse alphabetical order:
Selecting  After searching, selecting measures indicates that they are to be computed for the current report. Measures can be selected individually by checking and unchecking the selection box on the left of the individual measure lines. Mass selection is also supported:

Select/Clear All  Checking this box selects all measures (whether the measure is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all measures.

Select/Clear Visible Checking this box selects visible measures under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all measures found by a search. Unchecking the box deselects just the measures.

For example:

After application of filters, two measures are displayed. Note however that the selection count (lower right corner) shows that 176/176 measures are selected.
Unchecking the Select/Clear All followed by checking the Select/Clear Visible changes the selection count to 2/176. Only the visible measures are selected.
Switching to the Set Measure Inputs tabs and displaying the measures selection pulldown menu shows the two selected measures.

**Special Considerations**

*None.*

**References**

*None.*
Measure Means Test Common Procedure

Description

The measure means test compares the measures of the two input meta-networks and calculates whether they are statistically different. A series of random samples are taken from the network and then a T-test is calculated for each measure.

Procedure

Run measure means testing: Check to activate measure means testing.

Perturbation method: Select the sample selection method from the pulldown list.

Bootstrap – Use perturbation bootstrapping.

Random re-assignment – Use random re-assignment.

Perturbation iterations: Enter the number of iterations using the number spinner by typing into the number field or using the arrow buttons to increment/decrement the number by 100.

Special Considerations

The measure means test is only presented when exactly two meta-networks are input to the report. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

References

None.
Negative Links Common Procedure

Description
Select the input to use for measures where network links include positive and negative links. Such links may be contained in a combined network (with positive and negative values) or separately in two positive-valued networks, one of which will be processed as negative.

Procedure

Click [ New Input ] to add an entry to the list of cases. (Two entries have been created in the above image.)

NOTE: Networks are listed by name, using a merged list from all meta-networks. Take care to ensure that positive/negative matrix names do not overlap other networks.

When created, for each entry in the list, the following options are allowed:

Single network with +/- links: A single network holds both positive and negative link values.

Select… Choose the name of the matrix containing positive and negative links.
Combine network links: Positive and negative links are stored in two separate networks. Both contain positive numeric values.

Positive: Choose the name of the matrix containing the positive links.

Negative: Choose the name of the matrix whose positive link values are considered to be negative for analysis purposes. The actual link weights are positive values.

**Special Considerations**

*None.*

**References**

*None.*
Union by Thirds Common Procedure

Description
When three or more meta-networks are input to a report, comparisons between the meta-networks are structured into three groups (combining meta-networks where necessary). The Union by Thirds procedure allows the user control how the meta-networks are split into groups.

Procedure
When the Union by Thirds option is selected, the following dialog appears. The dialog will be inactive (as shown in the first image below) if the number of input meta-networks for the report is two or fewer (note that dynamic meta-networks may contain multiple meta-networks).

Increasing the number of selected meta-networks to four, activates the Union by Thirds dialog:
When the dialog is active, the **drop down** list provides two ways to specify the three groups:

Set the starting indices of the middle and end periods: Select this option to define the three groups by setting the index for the first meta-network in each group. Note however that the **order** of the meta-networks is set by the ordering of the meta-networks in the Meta-Network Manager panel and cannot be changed here. Further, ordinal numbers (indices) are used instead of meta-network names (e.g. in this example the first meta-network is identified by the index "1" not by the name "Randomized Network")

**Middle start:** Index of the first meta-matrix in the middle group.

**End start:** Index of the first meta-matrix in the final (third) group.
This method works with all types of meta-networks.

The first group always starts with index 1, the first meta-matrix, and is not set by the user.

Changing the meta-network selection to the single dynamic meta-network "Travel 2000" still activates the Union by Thirds dialog because the dynamic meta-network contains more than three meta-networks.

![Image of Generate Reports - Standard Network Analysis dialog]

The "Travel 2000" meta-matrix contains date information, making the second group option, group by dates appropriate.

![Image of Union by Thirds dialog]

Set the starting dates of the middle and end periods: Select this option to define the three groups by start dates. This option is useful when the meta-networks cover
separate time periods (for example, when analyzing dynamic meta-networks) but requires that the meta-networks have a time/date value set (dates can be added manually using the Meta-Network Time control in the Meta-Network panel).

The first group includes all meta-networks prior to the start time of the second group and is not set by the user.

Middle start: Use the controls to specify the starting date for the beginning of the middle group (year, month, day, time).

End start: Use the controls to specify the starting date for the beginning of the middle group (year, month, day, time).

**Note:** The union by date option is available for regular meta-networks, with or without date information. Also note that a dynamic meta-matrix may contain undated meta-matrices.

**Special Considerations**
This procedure is only enabled when three or more meta-networks are input to a report.

**References**

*None.*
**Transform Data Common Procedure**

**Description**
Add transformation steps which will be applied to each meta-network prior to running the report.

**Procedure**

This dialog appears when the Transform Data option is selected.

Check listed operations to transform meta-networks by combining or splitting networks or by altering or deleting links between nodes. These operations are performed on all meta-networks in the order listed in the dialog (from top to bottom).

- **Binarize (set link values to one)** Check to set all existing links to one, creating a binary network.

- **Remove links** Check to remove links based on whether the link weight is above or below a specified numeric value. Select one of the logical relationship listed below and enter a numeric value in the adjacent field.
  - Less than
  - Less than or equal to
  - Equal to
Conform meta-networks by method: Check to make the nodesets identical across meta-networks then select one of the following methods:

- **Union**: Add nodes appearing in some but not all meta-networks to all meta-networks.
- **Intersect**: Remove nodes appearing in some but not all meta-networks from all meta-networks.
- **Create union networks**: Check to create new networks that are the union of networks of the same type. For example, if there are two Agent x Agent networks `communication` and `kinship` then the network created is the union of these networks. (The original networks are not deleted.)

Symmetrize by method: Check to make all links bi-directional by adding or removing uni-directional links. Select one of the methods listed:

- **Maximum**
- **Minimum**
- **Sum**
- **Average**

Remove isolates based on Check to exclude isolated nodes (an isolated node has no connections to any other node). From the pull list menu choose either a single network or the entire meta-network to determine isolates.

Remove pendants based on Check to exclude pendant nodes (a pendant node is connected by a single link to one other node). From the pull down list choose either a single network or the entire meta-network to determine pendants.

Remove self loops Check to remove all connections from a node to itself (links on the matrix diagonal).

**Special Considerations**
Transformations are applied to all meta-networks selected for the report in the order listed (from top to bottom).

**References**

*None.*
Remove Nodes Common Procedure

**Description**

Select nodes to remove them from each meta-network before generating reports. The nodes are *not* permanently removed but are ignored when measures are computed.

**Procedure**

The dialog permits search and selection of node names; each node checked is ignored for analysis in the report. Note that the list of node names is merged across all meta-networks; if the same node name is used in different meta-matrices, all instances of the given node will be ignored.

This example shows the following (from top to bottom):
**Nodeset Tab List** Separate tabs for each nodeset class in addition to a combined list. In this example the All Nodes tab has been selected.

**Search Bar** Provides a simple pattern matching facility. In this instance a search for node names containing "_9" has been performed by typing the string into the text box and choosing Contains from the adjacent selection, yielding all node names with the string anywhere in the name (the alternative Equals will show only node names exactly matching the search string).

**Selection panel** This scrollable panel shows the list of node names for the selected tab after the search (or the entire list if no search is active). On the left of each line is a check box to select the node individually. In this example "Action_92" and two other nodes have been selected. Since the node list is larger than the screen area a vertical scroll bar is present on the right side of the panel.

Select/Clear All checking this box selects all nodes under this tab (whether the line is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all list entries.

Select/Clear Visible checking this box selects visible nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all nodes found by a search. Unchecking the box deselects just the visible list entries.

**Special Considerations**

None.

**References**

None.
Ranked Tables Common Procedure

Description
Specify the options for displaying tables of ranked nodes.

Procedure
Specify the options for displaying tables of ranked nodes.

Display nodes up to rank: When displaying lists of nodes in rank order, select the number of nodes for display. For example, using the default value of 10, the Recurring Top Ranked Agent chart will include the top 10 agents.

Nodes of equal value get: Select how ranks are assigned to nodes with identical values.

Consecutive rank Use distinct rank values (e.g. 1, 2, 3) and make an arbitrary assignment.

Equal rank Use the same rank for all nodes with the same value.

Standard deviation multiple: Defines how values will be marked as low and high in tables. The numeric value defines a band (in standard deviations) above and below
the mean where a value is considered "normal". A value below the band is marked "low" and a value above is marked "high".

Highlight critical nodes as those having the attribute: Select to emphasize certain nodes in the report based on an attribute value. Critical nodes are displayed in italic bold red text (e.g. 0.357) in the report. Selection activates the fields below to select the attribute value for highlighting:

ID: Select an attribute from the generated list.

Value: Select an attribute value to identify the critical nodes.

Print unscaled measure values Select this option to show unscaled measure values beside scaled measure values.

Create measure tables by component (component analysis) Select this option to perform component analysis for each component of a unimodal network (an Agent x Agent network is an example of a unimodal network). Measure tables are created for each component.

Special Considerations
None.

References
None.
Description
Set the report output format and storage location.

Procedure
Reports can present their results in different formats. Each format produces one or more files that are saved to a specified location. When multiple files are created, each file's name will start the filename given using additional text or file extension to distinguish different files where necessary.

Select the report formats to create: Choose the report output format. Multiple output types can selected simultaneously. Depending on the type, the output will be structured for human readability or further data processing.

Text Generate a human readable report in plain text (no images or charts). The "pages" of the report are separate files with appropriate names.
HTML Generate a human readable report in web format using Hyper Text Markup Language (HTML). The report consists of multiple files of several types. ORA attempts to automatically open the HTML report when report generation is complete.

CSV Generate data values in comma-separated value (CSV) format. This format supports access to the computed measures for further analysis. The data is output in a series of separate files with appropriate names.

JSON Generate data values in JavaScript Object Notation (JSON) format. This format supports access to the computed measures for further analysis.

PowerPoint Generate a report in Microsoft PowerPoint format. Output is contained in a single PowerPoint file. (NOTE: HTML output must be selected to enable this report format.) Two types of PowerPoint reports are available:

All slides Full human readable report, including text, tables, images and charts.

Only slides with charts and pictures Report contains only slides containing tables, images and charts (with standard label text). This format is intended as a source of images for preparing other reports and presentations.

PDF Generate a human readable report in Portable Document Format (PDF). Output is contained a single file. (NOTE: HTML output must be selected to enable this report format.)

Enter a directory in which to save the report: Use the [Browse] button to open a file browser. Navigate to the output directory, select the directory and click [Open]. Alternatively, enter the fully qualified directory name directly into the text field.

NOTE: When multiple output formats are specified, all output files are placed in the same folder; a report may consist of multiple files. All filenames will begin with the specified report name. The files making up given report are distinguishable by the file types (e.g. file extension or properties on a Windows system).

Enter a filename without extension: A default name is provided is generated by ORA. This can be altered by typing into the text field.

NOTE: All report files will begin with the specified report name. Reports which generate multiple output files will append additional text to distinguish constituent files. File extensions are appended automatically according to file type and should not be entered here.
Special Considerations

Enabling PowerPoint and PDF Output

HTML output must be selected to enable PowerPoint and PDF output.

In the image above HTML output is not selected; the PowerPoint and PDF output options are not available and are grayed out.

Identifying Constituent Report Files on Microsoft Windows

When multiple reports are saved to a folder under Windows, the constituent file or files for each report format can be identified by the file extension and type. With the exception of HTML format reports, a single file type is used per report. No file type is used in more than one report format.

<table>
<thead>
<tr>
<th>Microsoft Windows File Types by Report Output Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report Format</strong></td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>HTML</td>
</tr>
<tr>
<td>File Type</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>CSS</td>
</tr>
<tr>
<td>JS</td>
</tr>
<tr>
<td>PNG</td>
</tr>
<tr>
<td>CSV</td>
</tr>
<tr>
<td>JSON</td>
</tr>
<tr>
<td>PowerPoint</td>
</tr>
<tr>
<td>PDF</td>
</tr>
</tbody>
</table>

**References**

*None.*
Preferences Common Procedure

**Description**
Provides options for customizing report output.

**Procedure**

Choose how to display floating point numbers Options for displaying for floating point numbers. **Note:** ORA uses a decimal point (dot ".") for the decimal mark.

Format: Select the floating point format.

Fixed Use fixed-point notation (e.g. "0.021").

Scientific Use scientific notation (e.g. "2.083e-002").

Precision: Select the number of digits displayed after the decimal mark.
Floating point output using **Fixed** format and a **Precision** of 3.

Enable JavaScript (animated) charts Select to enable animated charts in the HTML report format by use of JavaScript components. (JavaScript is enabled on most web browsers.)

Enter any optional header text to appear at the top of each report: Enter text which will be displayed at the beginning of the report. Note that this text does not appear on each page as a page header but as a paragraph at the start of the report. **Hint:** This text can be usefully used to describe the report purpose or inputs.

Enter any optional footer text to appear at the bottom of each report: Enter text which will be displayed at the bottom of the initial page and in the Data Description section (if present). Note that this text does not appear on each page as a page footer but as a paragraph. **Hint:** This text can be usefully used to describe the data used, such as the constituent nodesets and networks.

**Note 1:** Header and footer text are included in report formats intended for human reading and presentation (Text, HTML, PowerPoint—All Slides, PDF). Text is not included in CSV and JSON format outputs which are intended to convey computed measures for further processing and normally will not appear in the PowerPoint—Only slides which is limited to charts and pictures.

**Note 2:** Basic HTML text formatting commands such as `<strong>` can be embedded in the header and footer text. More complex HTML elements are not recommended. Embedded HTML will be rendered in HTML format reports and ignored in PDF and PowerPoint formats. The embedded HTML commands will be displayed verbatim in Text format reports and hence are not advisable in cases where text format will be generated.

<table>
<thead>
<tr>
<th>Max</th>
<th>Std.Dev</th>
<th>Max</th>
<th>Std.Dev</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.188</td>
<td>0.049</td>
<td>1.87500e-001</td>
<td>4.85913e-002</td>
</tr>
<tr>
<td>9</td>
<td>2.332</td>
<td>9</td>
<td>2.33238e+000</td>
</tr>
<tr>
<td>0.333</td>
<td>0.097</td>
<td>3.33333e-001</td>
<td>9.71825e-002</td>
</tr>
</tbody>
</table>
Sample header and footer text with simple HTML commands to add emphasis.
ALL MEASURES BY CATEGORY REPORT

Class survey, taken at the end of third semester, 25 respondents. Online interactive survey, respondents anonymized.

Input data: Class Survey

Start time: Fri Apr 5 19:54:24 2019

Data Description

Calculates a collection of measures using the selected input networks.

Node-level centrality measures were computed.

Measures taking a single input network or multiple networks were computed.

Unimodal and bimodal networks were used.

Select a network analysis below:

Analysis of network Agent x Agent
Analysis of network Agent x Knowledge
Analysis of network Agent x Task

Multi-network Measures

The following relationships were noted:
Agent x Agent — Strong ties between students.
Agent x Knowledge — Students ranked as having superior information.
Agent x Task — Students who were key producers.

Produced by ORA, a joint product of the CASOS center at Carnegie Mellon University and Netanomics

All Measures by Category Report HTML output with header and footer text including HTML tags.

Special Considerations

Floating point numbers always use the decimal point (dot "." ) for the decimal mark.

References

None.
All Measures by Category

Description
Computes all measures in a given category for each input network and creates ranked tables and lists of values. Dynamic meta-networks are unioned by thirds prior to processing.

Why Use This Report
This report calculates all measures in a given category on networks contained in a single meta-network. The user can select networks individually or run measures on all networks. This report is often used as a convenient way to save measure values to files that can then be imported into a statistics package. Because this report does not give many interpretations of the measure values, it is most suitable for people who already understand what the measures mean.

Input Parameters
To generate an All Measures by Category Report, open the Generate Reports - All Measures by Category dialog box by selecting Analysis > Generate Reports > All Measures by Category… in the menu bar of the interface or by selecting a meta-network or meta-networks in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting All Measures by Category using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Union by Thirds** – Select how to group the meta-networks into periods for analysis.
**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next >] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

**Dialog 2 – Parameters**

![Image of Dialog 2 - Parameters dialog]

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the parameter values for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.
NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)

Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.
After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.

Side-by-side comparison.

Multiple meta-networks comparison.

**Measures and Algorithms Used**

**Measures**

All available measures in a given category are used.

[View report to measure table] | [View measure to report table]

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

Only one meta-network or dynamic meta-network can be processed at a time.

**References**

*None.*
Parameters

Select the measures type and networks for analysis along with certain report format options.

Select which measures using the options below: Use the menus on the line below to define which measures will be run on what type of network.

Measure category: Select the type of measure to be computed from the pulldown list below.

Centrality measures - Measures that compute the centrality of each node.

Node-level measures - Measures that output a scalar value for each node.

Network-level measures - Measures that output a single, scalar value for a network.

Input network type: Select the network type from the pulldown list below. This will change the networks listed in the Network Selection Area.

Any type - Use either unimodal or bimodal networks.

Unimodal networks - Use only unimodal networks, such Agent x Agent.
Bimodal networks - Use only bimodal networks, such as Agent x Knowledge.

Input network count: Select the type of measures based on the number of networks they process from the pulldown list below.

Any number - Measures that take as input a single or multiple networks.

Exactly one - Measures that take as input a single network.

More than one - Measures that take as input more than one network.

**Network Selection Area** - Lists all networks eligible for analysis based on the Input network type selected above (only unimodal networks, only bimodal networks, or all networks).

**Networks** - Click the box to the left of the network name to include/exclude a network (selected networks are checked, unselected networks present an empty box).

[ Select All ] - Click button to select all networks (check all listed).

[ Clear All ] - Click button to de-select all networks (remove check marks).

Create network pictures - Select to include images of networks in the output.

Create ranked node tables - Select to create tables of nodes ranked by value in the output.

Create top node summary table - Select to create a table that lists nodes that repeatedly rank highest on the measures.

[Return to the Parameters Dialog description]
Belief Propagation

Description

This report runs a simulation of the belief (or attitude) propagation based on the Friedkin model from the social influence theory.

Why Use This Report

Estimates belief propagation through social networks. This report contains the most common beliefs shared by most people, the beliefs with the highest GINI coefficient, the most strongly held beliefs, the most likely to change beliefs, the most neutral individuals, and the most opinionated individuals.

Input Parameters

To generate a Belief Propagation Report, open the Generate Reports - Belief Propagation dialog box by selecting Analysis > Generate Reports > Dynamics > Belief Propagation… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Belief Propagation using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

NOTE : Analyzed meta-networks must contain a Belief node class.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [Next>] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.
After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, multiple meta-network comparison.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

Analyzed meta-networks must contain a Belief node class.

References

None.

Parameters

Select one or both propagation algorithms to apply and the beliefs to propagate. Information on parameters are presented separately below.

Friedkin's Propagation Algorithm

![Friedkin's Propagation Algorithm](image)
Select one or both propagation algorithms:

Uniform value:

Network values:

Max iterations:

Select the beliefs to propagate:

Automatic

This computes how contentious each belief is and chooses the top ranked beliefs.

Number of nodes:

Manual

**Friedkin's Extended Propagation Algorithm**
Network values:

Max iterations:

Use Knowledge in the interaction network (W)

Use Beliefs in the interaction network (W)

Select the beliefs to propagate:

See entry under "Friedkin's Propagation Algorithm" above.

Return to the Parameters Dialog description
Bibliography and Citation

Description

Analyzes network data extracted from a list of citations in various formats including BibTex, RIS and Scopus.

Why Use This Report

This report generates a variety of summary measures tailored to networks derived from citation data. This includes centrality measures for authors, publication frequencies by date and co-authorship measures.

Input networks for the report can be constructed using the Bibliography & Citations data option in the Data Import Wizard to process bibliographic data stored in a variety of formats. The Recompute Derived Networks option of Data Import Wizard can be used to update derived networks, simplifying manual editing of existing citation meta-networks. For instance, a user could identify variant spellings of an author's name, merge such nodes appropriately and then regenerate derived networks such as the Co-Authorship network.

Input Parameters

To generate a Bibliography and Citation Report, open the Generate Reports - Bibliography and Citation dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Bibliography and Citation… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Bibliography and Citation using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE : There are no user selectable parameters for this report and hence no Parameters Dialog.

**Dialog 2 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report inputs or the [ Cancel ] button to cancel report generation.)
Output
Single meta-network.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
Blog

Description
Analyzes data extracted from blogs by the Blogtrackers tool.

Why Use This Report
The report analyzes blog data imported from Blogtrackers to determine:

- Nodeset Summary
- Network Summary
- Distribution of languages in Posts
- Blog Site Details (user selected sites)
- Bloggers who post the most
- Blog sites with the most activity
- Bloggers who post to the most blog sites

Blogtrackers data can be imported into an ORA meta-network using the Data Import Wizard's Blogtrackers data function.

Input Parameters
To generate a Blog Report, open the Generate Reports - Blog dialog box by selecting Analysis > Generate Reports > Social Media > Blog… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Blog using the Select Report option panel (see Dialog 1 below). select a meta-network in the Meta-Network Manager panel, click the [Generate Reports…] button in the Meta-Network panel and select Blog using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Warning: Select only a single meta-network derived from Blogtracker data for the blog report. Selecting multiple meta-networks will produce misleading outputs and may cause report generation to fail.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.
**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)
Output

Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

This report is optimized for processing meta-networks created from the Blogtrackers datasets. See also the entry for importing Blogtrackers data using the Data Import Wizard.

References


Parameters

Select any blog sites to analyze in detail:

Select blog sites for separate detailed analysis by checking the box at the left (the Node Name and Node Title contain the blog site names). Any number of the listed blog sites or none at all can be selected.

Standard searching and filtering options are available to assist in selecting blogs:

**Searching**

**Text Entry Field** - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the list of blog sites. Use quotation marks to search for a phrase (spaces are treated as part of the search). All fields are searched.

[ Contains ▼]/[ Equals ▼] - This button controls the text match policy. Contains matches all lines which include the string in any position. Equals matches only complete words.

**Selecting**
**Individual Selection** - To select individual blog sites, place a check mark in the left-hand box.

**Multiple Selection** - To select multiple blog sites, use the controls at the bottom of the Editor pane:

Select/Clear All: Checking this box selects *all* blog sites (whether the site is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all blog sites.

Select/Clear Visible: Checking this box selects *visible* blog sites under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are *not* selected). This permits selection of all blog sites found by a search. Unchecking the box deselects just the displayed blog sites.

**Sorting** - The displayed list of blog sites can be sorted by clicking on an attribute column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is alphabetical (i.e. A-Z). A second click sorts the list in reverse alphabetical order (i.e. Z-A). Clicking a different column header will re-sort the list based on that column's content.

**Filtering** - Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu. The filter menu supports two types of filtering:

- **Standard** - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.

- **Custom** - Checking the Define a custom filter: option allows a user specified search. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The type of search depends on the type of data contained in the column (text or numeric).

For a short tutorial on search features, including additional options, see 9.2 *Searching, Sorting, Filtering and Selecting Nodes* on the QuickStart Main Interface page.

[Return to the Parameters Dialog description](#)
Capabilities

NOTE: This report only available in a full version of ORA.

Description
This is used to assess an individuals' or organizations' capability to perform tasks.

Why Use This Report
Analyzes the knowledge, resource, and task capabilities of agents and organizations in the network.

Input Parameters
To generate a Capabilities Report, open the Generate Reports - Capabilities dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Capabilities… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Capabilities using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next >] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**
There are no user selectable parameters for this report except the optional measure means test which can be initiated by selecting the Measure Means Test option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)

**Dialog 3 – Output**

![Dialog 3 – Output](image)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the report parameters or the [Cancel] button to cancel report generation.)

**Output**

Single meta-network, side-by-side comparison, multiple meta-network comparison.

**Measures and Algorithms Used**

**Measures**

View report to measure table | View measure to report table

**Algorithms**

Information is not available at this time.

**Special Considerations**

None.

**References**

None.
Change In Key Entities

Description
This report provides information on the overall structure of a complex network and identifies, for each type of node, which nodes stand out.

Why Use This Report
Analyzes the changes over time of the agents that score highest in measure values.

A complex network typically is a meta-network with multiple types of entities such as people, expertise, resources and locations. Overall structure is defined using meta-network metrics such as Overall Complexity, Social Density, Social Fragmentation, Communication Congruence, Knowledge Congruence, Performance as Accuracy, and Average Communication Speed. Key entities within each of the component networks are identified in terms of metrics such as Degree Centrality, Cognitive Demand, Specialization, and Redundancy. Separate key-entity pages are produced for each type of entity. For example, if there are people and resources - then key people and key resources are both identified. If the user selects two or more networks, this report will compare the results.

Input Parameters
To generate a Change in Key Entities Report, open the Generate Reports - Change in Key Entities dialog box by selecting Analysis > Generate Reports > Dynamics > Change in Key Entities… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Change in Key Entities using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and two or more meta-networks (one or more one dynamic meta-networks) to analyze.

  NOTE : You must select at least **two** meta-networks or one **dynamic** meta-network to analyze in the Select Report panel before you can proceed to the next dialog.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

There are no user selectable parameters for this report except the optional measure means test which can be initiated by selecting the Measure Means Test option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

**NOTE:** The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

1488
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.
Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
This report requires at least one dynamic meta-network or 2 meta-networks as input

References
None.
Communications Network Assessment

Description
This report evaluates the effectiveness of a computer network, with the computer nodes being represented as resources. The computer network represents the physical layer of connections between machines. Effectiveness takes into account the placement of nodes in the network.

Why Use This Report
This report assesses a communications network. As information on speed of information transmittal becomes available it will be updated. This report takes a resource by resource network (preferably one where the nodes are communications devices and the links are the speed of reliability of the link).

NOTE : This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure values, but are they what I should expect? Are they low or high? I don't know what I should be seeing".

Input Parameters
To generate a Communications Network Assessment Report, open the Generate Reports - Communications Network Assessment dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Communications Network Assessment… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Communications Network Assessment using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.
Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

Dialog 2 – Parameters

There are no user selectable parameters for this report. You can adjust the appearance of ranked tables using the Ranked Tables option. For further information on individual options, click on the option name in the list below.

Ranked Tables – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output

Single meta-network
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References

None.
Communicative Power

Description
Analyzes one or more semantic networks to classify concepts by measure values.

Why Use This Report
NOTE: Also see Cube Analysis in the General Content section.

Input Parameters
To generate a Communicative Power Report, open the Generate Reports - Communicative Power dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Communicative Power... in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports...] button in the Meta-Network panel and selecting Communicative Power using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
Dialog 2 – Parameters

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the parameter values for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.
NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next>] button to proceed to the output dialog panel. (Alternatively use the [<Back ] button to revise the inputs or the [Cancel] button to cancel report generation.)

Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [<Back ] button to revise the report inputs or the [Cancel] button to cancel report generation.)
Output
Single meta-network, side-by-side comparison, multiple meta-network comparison.

Measures and Algorithms Used
Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
Parameters

The parameters should be entered from top to bottom in the dialog. After selections have been entered, values for the following parameters will automatically be inserted into the dialog where possible.

Select the nodesets to use in the analysis.

Concepts: Using the pulldown menu, select the nodeset that contains a list of words or phrases that represent concepts. Based on the user selection, ORA will attempt to nominate a value for the Semantic network - shared documents entry below.

Documents: Using the pulldown menu, select the nodeset that contains a list of documents that contain concepts. Based on the Concepts and Documents selection, ORA will attempt to nominate a value for the Usage network for documents entry below.
Authors: Using the pulldown menu, select the nodeset that contains a list of authors. Based on the Concepts and Authors selection, ORA will attempt to nominate a value for the Usage network for authors entry below.

Semantic network - shared documents: Using the pulldown list, specify a Concept x Concept - shared document network. Links indicate which concepts co-occurs in documents.

Usage network for documents: Using the pulldown list, specify a Concept x Document network. Links give the number of times a concept occurs in each document.

Usage network for authors: Using the pulldown list, specify a Concept x Author network. Links give the number of times an author uses a concept.

Determine the number of times each concept occurs in a document: Indicate the source for the concept count by selecting one of the mutually exclusive options below.

By attribute value: Select if the concept count is contained in an attribute then select the attribute from the pulldown list.

By node degree in the document usage network - Select if the links values of the networks contain the concept count.

Select how to define high and low measures values: Define what will be marked as high and low values in the report output. Options are mutually exclusive.

Top and bottom ##-th percentiles – Select to mark values falling into the specified percentile above and below the mean (minimum 5, maximum 50). Type the percentile number into the number spinner or use the up/down arrows to increase or decrease the value by 5.

By node degree in the document usage network ## standard deviations – Select to mark values which are the specified number of standard deviations above and below the mean. Type the number of standard deviations into the number spinner or use the up/down arrows to increase or decrease the value by 1.

Return to the Parameters Dialog description
Communicators

Description
Analyzes the communication network (agent by agent) and gives high level statistics on its structure.

Why Use This Report
When characterizing network topologies, it is important to consider the role of errors and incomplete data in the network. This report will provide additional analysis on network topologies and actors, respectively.

Input Parameters
To generate a Communicators Report, open the Generate Reports - Communicators dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Communicators… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Communicators using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

**NOTE** : There are no user selectable parameters for this report and hence no Parameters Dialog.
Dialog 2 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report inputs or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, side-by-side comparison.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

*Information is not available at this time.*

Special Considerations

*None.*

References


Context

Description
Compares measured values against various stylized forms of networks in an effort to characterize network topology.

Why Use This Report
This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure values, but are they what I should expect? Are they low or high? I don't know what I should be seeing".

Input Parameters
To generate a Context Report, open the Generate Reports - Context dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Context… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Context using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.

  NOTE: Works on square networks only.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.

**Dialog 2 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report inputs or the [ Cancel ] button to cancel report generation.)
Output
Single meta-network.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
Core Network

Description
Computes the core network and reports general statistics. The Core Network is the largest component (sub-graph) in the graph.

Why Use This Report
Good for extracting the big giant connected component in real life networks that have multiple disconnected small subcomponents and a big, giant connected component.

This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure values, but are they what I should expect? Are they low or high? I don't know what I should be seeing".

Input Parameters
To generate a Core Network Report, open the Generate Reports - Core Network dialog box by selecting Analysis > Generate Reports > Characterize Groups and Networks > Core Network… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Core Network using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.
- **Filter Data** – Select the nodesets and networks to analyze for the report.
- **Measures** – Select the measures for the report to use in analysis.
- **Negative Links** – Select the input to use for measures that take positive and negative links.
- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.

**Dialog 2 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the report inputs or the [Cancel] button to cancel report generation.)

**Output**

Single meta-network, side-by-side comparison.
Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
Critical Sets

NOTE: This report only available in a full version of ORA.

Description

Finds critical sets of nodes in a network that best reach all other nodes, or whose removal maximally disrupts a network.

Why Use This Report

This report has two functions. Find a set which 1) would fracture the meta-network the most or 2) which reaches the maximum number of nodes.

Only one mode (unimodal) networks an be analyzed. (A one mode network links nodes of the same class, such as an Agent x Agent network.)

Input Parameters

To generate a Critical Sets Report, open the Generate Reports - Critical Sets dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Critical Sets… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Critical Sets using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Select a network and then the type of critical set of nodes to find.

Select a network: Select the network to analyze from the pulldown list (only one-mode networks will be included on the list).

Select the type of critical set of nodes to find:

- A set whose removal would most fragment the network
- A set that most reaches other nodes in the network

Select the parameters:

- Size of the critical set to find:
- Number of algorithm iterations:

Add a meta-network where the critical set nodes have the attribute 'critical_set' set to value 'true'
Add a meta-network where the critical set notes have the attribute 'critical_set' set to value 'true'. Check this line if you want to create a separate copy of the meta-network with the computed critical nodes marked in the nodeset by an added attribute critical_set.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.
After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.

**Measures and Algorithms Used**

**Measures**

View report to measure table | View measure to report table

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

Only one mode (unimodal) networks can be analyzed. (A one mode network links nodes of the same class, such as an Agent x Agent network.)

**References**

*None.*
**Custom**

**Description**
Computes a custom report with user selected measures and output tables, pictures, and figures.

**Why Use This Report**
The custom report allows a user to be able to design a report to meet a specific need by identifying the metrics that should be calculated on an input network. The custom report would be used when a specific set of metrics or measures are needed routinely as opposed to simply producing the metrics directly each time.

**Input Parameters**
To use or modify an existing Custom Report, open the Generate Reports - Custom dialog box by selecting Analysis > Generate Reports > Custom Reports > **Custom Report Name**… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting the report by name (see Dialog 1 below).

To create a new or modify or delete an existing Custom Report select Preferences > All Preferences…. This will open the Preferences dialog. Select Design your own report (custom) using the Select Report in the left pane. [More to follow.]
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

NOTE : Creating a customized list of measures using the Run with specific measures option on the measures panel is a common step in creating a custom report.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.
Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the Next button to proceed to the output dialog panel. (Alternatively use the Cancel button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.

Dialog 2 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.
After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report inputs or the [ Cancel ] button to cancel report generation.)

**Output**
A single meta-network.

**Measures and Algorithms Used**

**Measures**
*View report to measure table* | *View measure to report table*

**Algorithms**
*Information is not available at this time.*

**Special Considerations**
None.

**References**
None.
Detect Spatial Patterns

Description

Why Use This Report

This report will find out whether a node attribute is clustered spatially, such that nodes are similar to nearby others.

Input Parameters

NOTE: Requires a Location node class with Latitude and Longitude attributes.

To generate a Detect Spatial Patterns Report, open the Generate Reports - Detect Spatial Patterns dialog box by selecting Analysis > Generate Reports > Geospatial > Detect Spatial Patterns… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Detect Spatial Patterns using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
Dialog 2 – Parameters

Select location networks to analyze:

Select the location nodeset:

Select the nodeset to analyze:

Select the agent x location network to analyze:

Choose any attributes whose spatial patterns you want analyzed: Place a check mark next to any of the attributes you want analyzed.

The [Select All] and [Clear All] buttons to the right of the list select or clear (check or uncheck) all the attributes in the list.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

Requires a Location node class with Latitude and Longitude attributes.

References

None.
Ego Network

Description

Analyzes the ego networks for a collection of nodes.

Ego networks consist of a focal node ("ego") and the nodes to whom ego is connected by a path of a specified maximum length (the radius, most frequently set to 1). This report allows the user to specify ego nodes, radius, and the type of links used to define connections.

In standard social network analysis, all nodes are of the same type, e.g. all nodes are people, and an ego network consists of nodes of one type. Further, standard ego networks are usually built using only ego and directly connected nodes (radius value of 1). In ORA it is possible to handle networks with nodes of multiple types at once. ORA also allows the user to use radius values other than one. In these cases, we refer to the network as a sphere of influence rather than an ego network.

Why Use This Report

Any node can be an ego node. An ego is the node about which you are asking questions, such as are the nodes it is connected to (the alters) highly similar. All nodes that are directly connected to the ego, either with an edge from the ego to them (outdegree of ego) or an edge from them to the ego (indegree of ego), are referred to as alters. A node's ego network is the set of adjacent nodes (the alters) and the links among the alters. Thus an ego network may be, but need not be, a star network with ego at the center.

This report will give you information on the structure of egos, ego networks, the similarity of the alters to each other, and the similarity of the alters to ego.

If you have a standard set of networks you can use this report to look at the ego networks of one or each of the nodes in that network. If you have a set of ego networks, one per meta-network, you can also use this report. Finally, if you have a set of ego network data, but you entered it such that your meta-network contains many ego-networks you can also use this report.

Input Parameters

To generate an Ego Network Report, open the Generate Reports - Ego Network dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Characterize Groups and Networks > Ego Net… in the menu bar of the interface or
by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Ego Net using the Select Report option panel (see Dialog 1 below).

**Dialog 1 – Inputs**

![Generate Reports - Ego Net dialog](image)

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next>] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

Dialog 2 – Parameters

Set the parameters specific to this report by selecting from the options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. For further information on individual options, click on the option name in the list below.

Select Egos – Select how to compute ego networks.

Select Attributes – Select the attributes to analyze within each ego network.
Select Link Types – Select the links to analyze within each ego network.

Other Options – Select to set ego and other options.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.
After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.

**Measures and Algorithms Used**

**Measures**

[View report to measure table] | [View measure to report table]

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

*None.*

**References**

*None.*
Select how to extract ego networks from each meta-network and which node attributes to analyze.

Select how to compute ego networks - The following options are mutually exclusive.

Select ego nodes directly - Check to select individual nodes for each ego network then select nodes from the list of nodes provided below.

Each meta-network is an ego network - Check to treat each input meta-network as an ego network.

Find ego nodes based on an attribute value - Check to select nodes for each ego network based on an attribute value then select the attribute value from the controls provided below.

The remaining inputs in the dialog depend on data selection made above. The following sections describe the inputs for each data type:
Select ego nodes directly

When this option is selected, all nodes are listed in the tab display below. The All Nodes tab lists all nodes on a combined list. The remaining tabs list nodes by their nodeset class. Select the desired tab, then select individual nodes.

The options below apply when the user selects ego nodes directly:

Select ego nodes by checking the box at the left. At least one of the listed nodes must be selected.

Standard searching and filtering options are available to assist in selecting nodes:

**Searching**
**Text Entry Field** - Type one or more search words separated by a space. Each word is searched for separately; the results of the search changes the list of nodes. Use quotation marks to search for a phrase (spaces are treated as part of the search). All fields are searched.

[ Contains ▼ ] / [ Equals ▼ ] - This button controls the text match policy. Contains matches all lines which include the string in any position. Equals matches only complete words.

**Selecting**

**Individual Selection** - To select individual nodes, place a check mark in the left-hand box.

**Multiple Selection** - To select multiple nodes, use the controls at the bottom of the Editor pane:

Select/Clear All : Checking this box selects all nodes (whether a node is currently displayed or not; items hidden after a search or outside the viewing window are still selected). Unchecking the box deselects all nodes.

Select/Clear Visible : Checking this box selects visible nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after a search are not selected). This permits selection of all nodes found by a search. Unchecking the box deselects just the displayed nodes.

**Sorting** - The displayed list of nodes can be sorted by clicking on an attribute column header label, which sorts the list based on the column entries (the sorted column will show ↑ or ↓, depending on the sort direction). The initial sort direction is alphabetical (i.e. A-Z). A second click sorts the list in reverse alphabetical order (i.e. Z-A). Clicking a different column header will re-sort the list based on that column's content.

**Filtering** - Individual columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu. The filter menu supports two types of filtering:

**Standard** - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries, such as attributes containing categories.

**Custom** - Checking the Define a custom filter: option allows a user specified search. This filter technique provides a convenient way to filter columns with a large number
of diverse entries. The type of search depends on the type of data contained in the column (text or numeric).

For a short tutorial on search features, including additional options, see 9.2 Searching, Sorting, Filtering and Selecting Nodes on the QuickStart Main Interface page.

Each meta-network is an ego network

There are no user-settable parameters for this method.

Find ego nodes based on an attribute value
Select nodes with a specified attribute value as ego nodes for the report. The inputs below are selected in order from top to bottom. Note that only a single attribute value may be selected.

Nodeset: From the pulldown menu, select the nodeset containing the target attribute.

Name: After selecting a nodeset, select an attribute contained in that nodeset (<No attributes> is displayed if the selected nodeset does not contain any attributes).

Value: After selecting an attribute, select a value from the pulldown list of values. Only a single attribute value may be selected.

Return to the Parameters Dialog description

---

Select Attributes

![Select Attributes](image)

When this option is selected, all attributes are listed by their parent nodeset in the tab display below. Each tab contains the attributes for the listed nodeset (even nodeset without defined attributes). All attributes are selected by default.

Select the attributes to analyze within each ego network.

Select a nodeset tab then unselect or reselect attributes by checking the box at the left.

Return to the Parameters Dialog description
Select Link Types

Set which links are included in the analysis. Links are selected at the network level (i.e. all links in a network are either included or excluded). By default, all networks and hence all links are included.

Select the links to analyze within each ego network - Links are selected on a network basis.

**Network Selection Area** - Lists all networks eligible for analysis. Networks from all selected meta-networks are combined into a single list (duplicate network names are listed only once).

**Networks** - Click the box to the left of the network name to include/exclude a network (selected networks are checked, unselected networks present an empty box).

Select All - Click button to select all meta-networks (check all listed).

Clear All - Click button to de-select all meta-networks (remove check marks).

[Return to the Parameters Dialog description]
Other Options

Set additional options, including the size and character of the ego network and whether the computed ego networks should be saved as meta-networks.

Ego options:

Select a radius: - Set the radius (number of links) value for neighbors. Neighbor nodes are defined as nodes within this many links of an ego node. A value of 1 indicates that only directly connected nodes are included in the ego-network while a value of 3 would include nodes connected through up to two intermediate nodes (i.e. 3 links). The default value of one is the most frequently used radius value in social network analysis.

Use out-links to determine neighbors - Check to include links leading from ego to other nodes in the analysis.

Use in-links to determine neighbors - Check to include links leading to ego from other nodes in the analysis.

Other options:

Ego networks are based on the same nodesets - Check this to indicate that the ego networks are all based on the same nodesets and therefore the intersection and union of the ego networks is well-defined.

Return ego networks to the main interface - Check to add the mean ego network to the ORA Meta-Network Manager. The mean ego network contains the nodes and
links that occur in at least half of the ego networks. The link weights are the number of ego networks in which the link occurred.

Create a separate analysis for each selected ego - Check this to create a separate analysis for each selected ego. Un-check to create a combined analysis.

Return to the Parameters Dialog description
Geospatial Assessment

Description
This report finds nodes that are co-located based, and counts the number of nodes that appear at location points.

Why Use This Report

Input Parameters
To generate a Geospatial Assessment Report, open the Generate Reports - Geospatial Assessment dialog box by selecting Analysis > Generate Reports > Geospatial > Geospatial Assessment… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Geospatial Assessment using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.
- **Filter Data** – Select the nodesets and networks to analyze for the report.
- **Measures** – Select the measures for the report to use in analysis.
- **Negative Links** – Select the input to use for measures that take positive and negative links.
- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
Dialog 2 – Parameters

Select location networks to analyze:

Select the location nodeset: All networks containing the location nodeset are listed. Select the one(s) to analyze by placing a check mark next to their name.

Choose how to determine distances between locations:

Compute distance from Latitude/Longitude node attributes

Get distances from network:

Select the location networks to analyze:

Number of links to list:

Select how to group location nodes:

Do not group locations

Group locations within this many miles:
After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)

**Dialog 3 – Output**

![Generate Reports - Geospatial Assessment dialog box](image)

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the report parameters or the [Cancel] button to cancel report generation.)

**Output**

A single meta-network.
Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
*Information is not available at this time.*

Special Considerations
*None.*

References
*None.*
Group Talk

Description

Analyzes the relationship between agents and knowledge.

Specifically, this report identifies what various groups of people are talking about using the communications dimension of the meta matrix (agent x agent) and the knowledge mapping network (agent x knowledge). It uses the Newman clustering algorithm to identify cohesive subsets of agents and knowledge.

Why Use This Report

When you need to find either the most prevalent knowledge or the greatest amount of agents discussing one particular knowledge.

Input Parameters

To generate a Group Talk Report, open the Generate Reports - Group Talk dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Group Talk… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Group Talk using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.

**Dialog 2 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report inputs or the [ Cancel ] button to cancel report generation.)
Output
A single meta-network.
X[i] = X[i] / sum(X)
Then the entropy is computed as:
Entropy is (-1 * (sum of (X[i] * log(X[i]))/ log (2.0)))

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms

Entropy
Entropy is measured using Shannon's Entropy measure (Shannon, 1948; Shannon, 1951). It is a measure of uncertainty. ORA takes the data vector, converts in to a probability distribution and then applies Shannon's formula.

Given a vector X (e.g. the vector of out-degrees for the AK graph)

NOTE : It only applies to measures with non-negative values.

The overall approach used is to:
1. compute a measure with non-negative values: x1, x2, ..., xN
2. divide each xi by the sum(x1, x2, ..., xN) - to create a probability distribution - and so create: p1, p2, ..., pN
3. Shannon Entropy is then calculated as the -sum_over_i(pi * log_base_2(pi)).

The density of a network is defined as: The number of edges divided by the number of possible edges.

Special Considerations
Entropy only applies to measures with non-negative values.

References

Hot Topics (Content Analysis)

Description
Identifies the most and least frequently used terms in a set of text documents. Frequency is measured per nodeset and across all nodes overall.

Why Use This Report
Use this to report node content analysis information from a collection of text analysis meta-networks.

The input meta-networks are typically output from a text extraction toolkit, such as AutoMap or NetMapper, where there is one meta-network per text and each node has a frequency attribute that is the number of times it occurs in the text. No networks are analyzed, only nodes and the frequency attribute values.

Input Parameters
To generate a Hot Topics (Content Analysis) Report, open the Generate Reports - Hot Topics (Content Analysis) dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Hot Topics (Content Analysis)... in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports... ] button in the Meta-Network panel and selecting Hot Topics (Content Analysis) using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.
After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

There is a specialized output format when three or more meta-networks are input.

**Measures and Algorithms Used**

**Measures**

- Each node is ranked by its frequency attribute value.

[View report to measure table] | [View measure to report table]

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

*None.*

**References**

Parameters

The parameters should be entered from top to bottom in the dialog. After selections have been entered, values for the following parameters will automatically be inserted into the dialog where possible.

A meta-network created by importing Twitter data (Twitter JSON pdftribute) is used as an example:
Sample input and output.

Select the nodesets to use in the analysis.

Concepts: Using the pulldown menu, select the nodeset that contains a list of words or phrases that represent concepts. Based on the user selection, ORA will attempt to nominate a value for the Semantic network - shared documents entry below. (The Topic nodeset is selected. ORA nominates the Topic x Topic - Co-Occurrence for the semantic network.)

Documents: Using the pulldown menu, select the nodeset that contains a list of documents that contain concepts. Based on the Concepts and Documents selection, ORA will attempt to nominate a value for the Usage network for documents entry below. (The Tweet nodeset is selected. ORA nominates the Tweet x Topic for the usage network.)

Authors: Using the pulldown menu, select the nodeset that contains a list of authors. Based on the Concepts and Authors selection, ORA will attempt to nominate a value for the Usage network for authors entry below. (The Agent nodeset is selected. ORA nominates the Agent x Topic for the usage network.)
Semantic network - shared documents: Using the pulldown list, specify a Concept x Concept - shared document network. Links indicate which concepts co-occurs in documents. (In the example, ORA’s generated suggestion is accepted.)

Usage network for documents: Using the pulldown list, specify a Concept x Document network. Links give the number of times a concept occurs in each document. (In the example, ORA’s generated suggestion is accepted.)

Usage network for authors: Using the pulldown list, specify a Concept x Author network. Links give the number of times an author uses a concept. (In the example, ORA’s generated suggestion is accepted.)

Determine the number of times each concept occurs in a document: Indicate the source for the concept count by selecting one of the mutually exclusive options below. (In the example, node degree is

By attribute value: Select if the concept count is contained in an attribute then select the attribute from the pulldown list.

By node degree in the document usage network - Select if the links values of the networks contain the concept count.

The report constructs a consolidated network that contains the union of each semantic network, and also a Concept x Text network that indicates which concepts were in which texts.

Add the output network to the interface – Check to add the union/consolidated meta-network to the Meta-Network Manager in a separate meta-network named "Union Semantic Network". The meta-network will contain copies of the input nodesets and networks, renamed to standardized name. (Selected for the example with the output shown in the image above.)

Return to the Parameters Dialog description
Immediate Impact

Description
Computes the key actors of the network and then isolates them individually to determine the effect on measure values.

Why Use This Report
This report allows you to perform one of two types of evaluation against the base network. The two types of analysis are: Change Analysis and Remove Nodes Replication Analysis.

Change Analysis: Allows the user to choose specific nodes to add or remove and choose individual links to add, remove or modify in value. The report then shows the differences in values between the original and modified networks at both the node and network measure levels. For example, Change Analysis can be used to allow one or more of the nodes identified in the Key Entities report to be deleted as part of an assessment of the degradation in the network if those nodes were no longer in the network. This is a more precise version of impact analysis with a broader range of options than the random node removal used by Remove Nodes Replication Analysis.

Remove Nodes Replication Analysis: Sets a random number of nodes to delete, then after analysis the report will show the differences in values between the original and modified networks. Unlike Change Analysis, the deleted nodes are selected at random. The user also selects the number of iterations to execute, allowing a researcher to assess the vulnerability of a network to random node deletions. This is the more general impact analysis than the Change Analysis discussed above.

This report allows the user to engage in what if analysis about the immediate impact of removing one or more nodes. Comparative statistic techniques are used to assess the network with and without the nodes in question.

The user identifies a network, identifies which node or nodes to remove, and then ORA computes the consequent changes in the network by removing those nodes in terms of overall network structure and key entities. A feature of this report is that the user can save the meta-network with the removed nodes and then assess the modified network with any of the other reports.

The Immediate Impact report is designed to help users understand how the removal of certain nodes, or a certain number of nodes, can affect a network. Change Analysis allows users to select specific nodes in the network to remove, and then compare
various metrics between the original network and the network where these specific nodes are removed. In a Remove Nodes Replication Analysis, users specify a specific number of random nodes to remove from a network. Users can then compare metrics of the original network with the average of a series of networks from which the set number of random nodes has been removed.

**Input Parameters**

To generate a Immediate Impact Report, open the Generate Reports - Immediate Impact dialog box by selecting Analysis > Generate Reports > Dynamics > Immediate Impact… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Immediate Impact using the Select Report option panel (see Dialog 1 below).

**Dialog 1 – Inputs**

![Generate Reports - Immediate Impact dialog box](image)

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.
Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next >] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel ] button to cancel report generation.)

Dialog 2 – Parameters

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. Use Visualization to select what to include in the before and after visualizations in the report. (Additionally, you can adjust the appearance of ranked tables using the Ranked Tables option.) You must specify at least one change through the parameters pane before advancing to the next dialog. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the analysis parameter values for this report.

**Visualization** – Select what to include in the before and after visualizations.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)

**Dialog 3 – Output**

![Dialog 3 – Output](image)

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the report parameters or the [ Cancel] button to cancel report generation.)

**Output**

Single meta-network.

**Measures and Algorithms Used**

**Measures**

[View report to measure table] | [View measure to report table]

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

None.

**References**

None.
Select an impact analysis method to apply. Information on analysis method parameters are presented separately below.

Choose a type of impact analysis:

Change Analysis - Choose nodes to add or remove and links to add, remove or modify in value.

Remove Nodes Replication Analysis - Randomly select a specified number of nodes from each nodeset.

The remaining inputs in the dialog depend on the analysis selection made above. The following sections describe the inputs for each analysis type:

**Change Analysis**
Change Analysis allows the user to choose specific nodes to add or remove and choose individual links to add, remove or modify in value. The report then shows the differences in values between the original and modified networks at both the node and network measure levels. This is a more precise version of impact analysis with a broader range of options than the random node removal used by Remove Nodes Replication Analysis.

For example, Change Analysis can used to allow one or more of the nodes identified in the Key Entities report to be deleted as part of an assessment of the degradation in the network if those nodes were no longer in the network.

The following sections describe the tab options:

Remove Nodes Tab

Select one or more nodes to remove along with links based on those notes. At least one node must be selected.

Remove Nodes Pane
All nodes are listed in this pane in a combined list (All Nodes tab) and in separate tabs by nodeset. Select node(s) for “removal” (nodes are simply excluded from analysis, no nodes are permanently deleted), using the process described for Remove Nodes.

Add Nodes Tab

Add one or more nodes to a single nodeset with optional links between the added and existing nodes.

Select a nodeset to add nodes to: From the pulldown, select a nodeset from the list to augment.

List the names of the nodes to create, and the number of nodes to create for each name: Use the

Node List - Enter node names in the text field; use delimiters between multiple node names (see list of delimiters below).
**Node Count** - Enter the number of each nodes to create for each node name. Names will be made unique by appending numbers to the node name as a suffix.

**Node List Delimiter** - If the Node List contains multiple node names, select the delimiter type(s) below. If no delimiter is specified then node list will be processed as a single name.

- space delimited - Use spaces to separate node names.
- comma delimited - Use commas to separate node names.
- semi-colon delimited - Use semi-colons to separate node names.

Choose how to create links for the new nodes: For each node created specify how to create links in each matrix listed below (list contains only matrices containing the selected nodeset).

**Link creation type**

- Manual alters - Manually select which nodes to link to in networks using the Change Links tab.
- Random alters - Randomly link to other nodes in networks.
- Low degree alters - Link to other nodes with the lowest degree.
- High degree alters - Link to other nodes with the highest degree.

**Link number** - Set number of links to be created, which can be either a set number or percentage.

**Method** - Using the pulldown, define how the link number will be applied.

- Percent - Connect to this percent of nodes.
- Count - Connect to a constant number of nodes.

**Change Links Tab**
The change links tab allows the user to alter existing links or add new links between nodes in each of the networks in the meta-network.

Network Tab - Select a network tab to change links within the network.

For each link alteration, a link change entry must be created. The following buttons are initially available in for this purpose:

[ New ] - Click to add a link change entry to the list

[ Clear ] - Click to remove all change entries from the list. (Individual change entries can be removed using the "X" button in each entry.)

Link change entry: Each link change entry permits the user to alter a specific existing link or create a new link.

NOTE : The source node must be selected first, followed by the target node, then the link value.
Source node: Select the source node from the pulldown list. After source node selection the target node list will be adjusted to show only links that already exist in the network if that option is selected.

Target node: Select the target node from the pulldown list. The existing link value will be shown in the new link value field.

New link value: Set a new link value by adjusting the value shown. (Note that a value of 0 indicates no link between the nodes and any other value indicates a link.)

- Click to remove this link change entry.

Show only existing links - Check to only show links that already exist in the network in the target node list. Uncheck if you want to add links to the network, which will include all nodes on the target node list.

---

**Remove Nodes Replication Analysis**

![Generate Reports - Immediate Impact](image)

**Parameters**
- Choose a type of impact analysis: Remove Nodes Replication Analysis

**Visualization**
- Select the number of nodes to remove from each nodeset. Each replication consists of removing randomly selected nodes and computing measures. The impact is measured by the change in the measure values.

**Ranked Tables**
- Number of replications: 100
- Nodeset agent: 0
- Nodeset knowledge: 0
- Nodeset resource: 0
- Nodeset task: 0

[< Back][Next][Cancel]
Set a random number of nodes to delete, then after analysis the report will show the differences in values between the original and modified networks. Unlike Change Analysis, the deleted nodes are selected at random. The user also selects the number of iterations to execute, allowing a researcher to assess the vulnerability of a network to random node deletions.

Select the number of nodes to remove from each nodeset. Each replication consists of removing randomly selected nodes and computing measures. The impact is measured by the change in the measure values.

Number of replications - Set the number of times nodes are randomly selected and removed.

**Nodeset List**

Select the number of nodes in each nodeset to remove at random from the list of nodesets presented below. In the image above the meta-network contains four nodesets (agent, knowledge, resource and task). The user must set at least one counter to a positive value before running the report.

[Return to the Parameters Dialog description]
Visualization

Customize the report outputs.

Select what to include in the before and after visualizations:

Entire network - Select to visualize the entire network.

Union of sphere influence networks of radius - Select to produce a union network, then enter the number of nodes used to determine what is included in the union network.

Select which nodesets to include in the visualizations: Using the list of nodesets presented in the pane below check nodesets to include them in the network visualizations and uncheck nodesets to exclude them. In the sample meta-network shown above, four nodesets were present (agent, knowledge, resource and task) and all will be included in the visualization.

Add the impacted network to the interface - Check to create a new meta-network containing the impacted network in the Meta-Network Manager.

Return to the Parameters Dialog description
Influence Net

Description
Displays the influence network and gives high level statistics on its structure.

Why Use This Report
This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure values, but are they what I should expect? Are they low or high? I don't know what I should be seeing".

Input Parameters
To generate a Influence Net Report, open the Generate Reports - Influence Net dialog box by selecting Analysis > Generate Reports > Dynamics > Influence Net… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Influence Net using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the parameter values for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References

None.

Parameters

The created Influence Net will use the above number of top ranked nodes for the Key Entity report measures.
IMPORTANT: If your network consists of more than one nodeset and one network you must place a check mark in the Transform the input network into an inference network before proceeding.

An Influence Network consists of a single entity class and a single directed, acyclic network. If the selected meta-network is not in this format, then you should select to transform the meta-network into an Influence Net.

Transform the input network into an inference network. Check if the input meta-network does not consist of a single entity class and a single directed, acyclic network.

Add inference network to the meta-network panel Check to create a new meta-network containing the inference network in the Meta-Network Manger.

Return to the Parameters Dialog description
K-Centrality

Description
Calculates the geodesic centrality measures for various radius values k, which approximates the geodesic computation by only considering neighbors within the radius distance. Only one mode networks are analyzed. (A one mode network links nodes of the same class, such as an Agent x Agent network, while a two mode network links two different node classes, for example Agent x Knowledge.)

Why Use This Report
When working with large one-mode networks this measure limits the surrounding neighborhood.

Input Parameters
To generate a K-Centrality Report, open the Generate Reports - K-Centrality dialog box by selecting Analysis > Generate Reports > Locate Key Entities > K-Centrality… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting K-Centrality using the Select Report option panel (see Dialog 1 below).

1578
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.
- **Filter Data** – Select the nodesets and networks to analyze for the report.
- **Measures** – Select the measures for the report to use in analysis.
- **Negative Links** – Select the input to use for measures that take positive and negative links.
- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

![Image of dialog panel](image)

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

**NOTE:** The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report.
(Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

This report only analyzes one mode networks.

References

None.

Parameters

Enter the k-centrality values to compute (separate values by a space): Enter one or more integer radius values (k), separated by spaces. K is the number of links from the target node considered to compute centrality.

Create network pictures – Check to include network visualizations. These will only be generated for small networks. (Charts and graphs are always included in the report.)

Return to the Parameters Dialog description
**Key Entities Ranking**

**Description**
Identifies key entities and groups who by virtue of their position in the network are critical to its operation.

**Why Use This Report**
This is a go-to report to identify the important (or "key") who, what, where, when, and why nodes in the meta-network. The input meta-networks can contain a single social network or networks spanning all of the ORA ontological categories (agents, organizations, etc.). The report will automatically run the subset of measures that are available for the given networks.

In addition, network-level measures are used to measure the overall performance of the meta-network.

Multiple meta-networks can be analyzed simultaneously; this is particularly useful for data over time.

**Input Parameters**
In the following example, the Key Entities Ranking report is run on a single meta-matrix using the default parameters. The target meta-matrix contains nodesets of each nodeset class, with a small number of networks (3).

To generate a Key Entities Ranking Report, open the Generate Reports - Key Entities Ranking dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Key Entities Ranking… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Key Entities Ranking using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Union by Thirds – Select how to group the meta-networks into periods for analysis.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

![Generate Reports - Key Entities Ranking](image)

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.

- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.

- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

**NOTE**: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.
After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [Cancel] button to cancel report generation.)

**Dialog 3 – Output**

![Screenshot of the output dialog panel](image)

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [Cancel] button to cancel report generation.)

**Output**

Report output is dependent on the input data and options selected by the user.
Certain charts and images are interactive. The image below shows the result of selecting a data point (by cursor roll-over) in an interactive HTML chart (data values are displayed).

When three or more meta-networks are input, the report output includes group comparisons. This sample shows the three groups and the overall value (overall value is shown in yellow and the three partitions in red, green, and blue).
Measures and Algorithms Used

Measures

Agent Level:

• Actual Workload
• Authority Centrality
• Betweenness Centrality
• Clique Count
• Cognitive Demand
• Edge Betweenness Centrality
• Eigenvector Centrality
• Eigenvector Centrality Per Component
• Row Exclusivity
• Row Exclusivity Complete
• Hub Centrality
• Potential Boundary Spanner
• Out-Degree Centrality
• Shared Situation Awareness
• Total-Degree Centrality

Organizational Level:

• Authority Centrality
• Betweenness Centrality
• In-Degree Centrality
• Eigenvector Centrality
• Row Exclusivity Complete
• Hub Centrality
• Potential Boundary Spanner
• Out-Degree Centrality
• Total-Degree Centrality

Knowledge Level:

• Betweenness Centrality
• In-Degree Centrality
• Out-Degree Centrality
• Total-Degree Centrality

Resource Level:

• Out-Degree Centrality
• Total-Degree Centrality

1588
Location Level:

- Authority Centrality
- In-Degree Centrality
- Row Exclusivity Complete
- Hub Centrality
- Location Relevance
- Out-Degree Centrality
- Spatial Eigenvector Centrality
- Total-Degree Centrality

Event Level:

- Authority Centrality
- In-Degree Centrality
- Row Exclusivity Complete
- Hub Centrality
- Out-Degree Centrality
- Total-Degree Centrality

Task Level:

- Authority Centrality
- In-Degree Centrality
- Row Exclusivity Complete
- Hub Centrality
- Out-Degree Centrality
- Total-Degree Centrality

Performance Level:

- Average Speed
- Communication Congruence
- Complexity
- Density
- Fragmentation
- Knowledge Congruence
- Performance as Accuracy

View report to measure table | View measure to report table

Algorithms

*Information is not available at this time.*
Special Considerations

None.

References

None.

Parameters

In this example, the default options are applied.

Select which node classes to analyze: Choose which category of analyses to perform. Only the analysis categories that are possible based on the input data are shown.

Who – Identifies key nodes of the agent and organization nodeset classes.

How – Identifies key nodes of the knowledge and resource nodeset classes.

What – Identifies key nodes of the task nodeset class.

Where – Identifies key nodes of the location nodeset class.

Why – Identifies key nodes of the belief nodeset class.
Select how to compute betweenness centrality: Define how betweenness is computed.

Regular betweenness centrality – Use the standard Betweenness Centrality measure.

K-Betweenness centrality with radius: Select to set the maximum radius (number of neighboring nodes) used to compute betweenness. When selected, the radius can be set in the adjacent numeric field.

Create network pictures – Check to include network visualizations. These will only be generated for small networks. (Charts and graphs are always included in the report.)

Return to the Parameters Dialog description
Locate Groups

Description
Identifies groups present in a network by applying one or more grouping algorithms.

Why Use This Report
This report can identify groups present in a meta-network using various grouping algorithms. The grouping algorithms applied are selected by the user. Most of the algorithms only work on a single network at a time but multiple input networks will be merged automatically to create a single network (if possible). The grouping algorithms may support analysis of only one mode networks or both one and two mode networks. (A one mode network links nodes of the same class, such as an Agent x Agent network, while a two mode network links two different node classes, for example Agent x Knowledge.)

Input Parameters
To generate a Locate Groups Report, open the Generate Reports - Locate Groups dialog box by selecting Analysis > Generate Reports > Characterize Groups and Networks > Locate Groups… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Locate Groups using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the grouping dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

Dialog Box 2 – Grouping

Refine input data and apply specialized transformations. For further information on individual options, click on the option name in the list below.

Groups to locate – Select which network elements to combine for group detection (using the nodesets and networks selected through the input Transform Data step).

Transform – Select meta-network transformations to apply (in addition to transformations selected in the input Transform Data step).
After entering grouping and transformation options, click the [Next >] button to proceed to the grouping algorithms dialog panel. (Alternatively use the [< Back] button to revise the grouping options or the [Cancel] button to cancel report generation.)

**Dialog Box 3 – Grouping Algorithms**

Select grouping algorithms used to determine group memberships (each functions independently) and ancillary measure and output options. At least one grouping algorithm must be selected; all other options have default values set initially. For further information, click on the option name in the list below.

**Algorithms** – Select one or more grouping algorithms for the report. At least one algorithm must be selected. Parameters for algorithms can be set in the panel below (algorithms are selected by the left-hand checkbox, clicking the algorithm name brings up the parameters).

**Attributes/Measures** – Select measures and attributes to compute on the group networks.

**General Options** – Select group related output options.
After entering all output options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back ] button to revise the grouping and transformation options or the [ Cancel ] button to cancel report generation.)

Dialog Box 4 : – Output

![Generate Reports - Locate Groups dialog box]

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network
Measures and Algorithms Used

Measures

- Betweenness Centrality
- Clique Count
- Clustering Coefficient
- Density
- Total Degree Centrality

View report to measure table | View measure to report table

Algorithms

See Select one or more grouping algorithms: in the Input Parameters section above.

Special Considerations

None.

References

http://www.analytictech.com/networks/hiclus.htm


http://dx.doi.org/10.1016/j.socnet.2008.03.001


Groups to locate
Select the parts of the meta-network to analyze.

Group these nodes together: Nodesets checked will be grouped together and analyzed for the report and unchecked nodesets will be excluded. Since the report analyzes networks, a nodeset must appear as part of a selected network to be included in the report. The networks list below is updated automatically to include matrices containing the selected nodesets.

Networks to define the groups: Networks checked will be used to determine groups for the report and unchecked networks will be excluded. The list only includes networks where at least one of the included nodesets have been selected for analysis.

**NOTE:** The networks selected will determine the available grouping algorithms:
If networks are selected that contain only nodes from the selected nodesets, then uni-modal algorithms are available for use. For example: if Agent and Knowledge nodesets are selected to join together, then selecting networks Agent x Agent and Agent x Knowledge would enable the uni-modal clustering algorithms.

If a network is a selected with nodes not from the selected nodesets, then only bi-modal clustering algorithms are shown. For example: if only Agent nodes are selected to join together, then selecting an Agent x Knowledge network would enable the bi-modal clustering algorithms.

The [ Select All ] and [ Clear All ] buttons at the bottom of each list select or clear (check or uncheck) all the items in the list.

Return to Grouping dialog.

Transform

Select the network transformations to apply: This deals with, among other parameters, isolates and pendants. Place a check mark next to all the transformations you want to apply.
Remove isolates before clustering: Check to drop all isolated nodes (nodes with no links) before processing.

Remove pendants before clustering: Check to drop all pendant nodes (nodes with only one link) before processing.

Symmetrize by method: Check to make all links bi-directional by adding or removing uni-directional links. Select one of the methods listed:

- Maximum
- Minimum
- Sum
- Average

Use only the largest component: Check to identify components in the network using weak components, then apply the selected grouping algorithm(s) to that component only (a component is a group in which all nodes are connected to each other and no links leave the group; weak components ignore link direction).

Return to Grouping dialog.

Algorithms

![Algorithms dialog box](image)

Select the grouping algorithms and specify the parameters.

- **Newman**: Automatically determine number of groups

...continued

1600
Choose any or all grouping algorithms to run (at least one algorithm must be selected). Most algorithms have their own parameters such as the number of groups in Newman, the minimum number of cliques in Cliques, or the relationship types and link method in Johnson. A few algorithms, such as the Louvain Method, have no user settable parameters.

**NOTE:** The list of grouping algorithms displayed in this panel is determined by the types of networks selected in the Groups to locate step. All available algorithms are listed below. Each of the algorithms in the list indicates the input type(s) it can process in the Input Matrix Mode entry.

To select an algorithm, check the box to the left of the algorithm name. The parameters will for the algorithm appear in the panel below. To see the parameters for an algorithm without selecting it for execution, click the algorithm name. The algorithm name will be highlighted and the parameters displayed below.

Note that parameters cannot be changed until an algorithm is selected but once set parameters are preserved for the rest of the ORA session, even if the algorithm is unselected or the report dialog is closed.

Select the grouping algorithms and specify the parameters.

Newman – Performs agglomerative hierarchical clustering, maximizing the modularity value.

**Node Assignment:** Nodes are assigned to a single group at most.
**Input Matrix Mode:** One mode.
**Number of Groups:** Automatically determined or user specified.
**Applicability:** Finds unusually dense clusters, even in large networks. Second fastest method for large networks.
**Parameters:** [Click for information.](#)

Girvan-Newman – A hierarchical clustering method where all nodes start in the same group and are split off into new groups by removing links with high betweenness scores.

**Node Assignment:** Nodes are assigned to a single group at most.
**Input Matrix Mode:** One mode.
**Number of Groups:** Automatically determined or user specified.
**Applicability:**
**Parameters:** [Click for information.](#)

Louvain Method – Detects groups by greedy optimization based on modularity scores.
Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One mode.
Number of Groups: Automatically determined.
Parameters: No user-supplied parameters.

Components – Identify groups using components analysis. A component is a group in which all nodes are connected to each other. Individual components are completely disconnected from each other. In this analysis, link direction is not considered in component determination (weak components as opposed to strong components where link direction is considered).

Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One mode.
Number of Groups:
Applicability:
Parameters: Click for information.

CONCOR – Starting with all nodes in a single group, CONCOR recursively splits (or partitions) each existing group into two groups based on the maximum correlation of outgoing connections (however groups with fewer than two nodes are not further partitioned).

Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One and two mode.
Number of Groups: The user selects the number of splits performed (n splits yields a maximum of 2^n groups).
Applicability: CONCOR helps find groups with similar roles in networks, even if dispersed. Suitable for smaller networks with a few thousand nodes.
Parameters: Click for information.

Johnson – Performs hierarchical clustering to create groups based on similarity scores.

Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One mode.
Number of Groups: User specified.
Applicability:
Parameters: Click for information.

K-Means – Partitions nodes into groups so as to minimize the within-cluster sum of squares.
**Node Assignment:** Nodes are assigned to a single group at most.

**Input Matrix Mode:** One and two mode.

**Number of Groups:** User specified.

**Applicability:**

**Parameters:** [Click for information.]

Spectral Analysis – Creates groups using eigenvectors derived from the input network(s).

**Node Assignment:** Nodes are assigned to a single group at most.

**Input Matrix Mode:** One and two mode.

**Number of Groups:** User specified.

**Applicability:**

**Parameters:** [Click for information.]

Attribute – Defines groups based on a user-specified categorical attribute.

**Node Assignment:** Nodes are assigned to a single group.

**Input Matrix Mode:** One mode.

**Number of Groups:** The number of groups equals the number of attribute categories present in the input network(s) (plus a "No Value" group if not all nodes have the attribute value assigned).

**Applicability:** Allows user specified groups.

**Parameters:** [Click for information.]

K-Fog – Identifies fuzzy overlapping group membership using expectation maximization (EM) clustering rather than hierarchical.

**Node Assignment:** Nodes can be assigned to multiple groups.

**Input Matrix Mode:** One and two mode.

**Number of Groups:** User specified.

**Applicability:** Suitable for smaller networks, typically under a thousand nodes.

**Parameters:** [Click for information.]

Alpha-Fog – Identifies fuzzy overlapping group membership using an alpha (α) parameter to encode the desired level of group cohesion (as opposed to specifying a number of groups).

**Node Assignment:** Nodes can be assigned to multiple groups.

**Input Matrix Mode:** One and two mode.

**Number of Groups:** Automatically determined.

**Applicability:** Suitable for smaller networks, typically under a thousand nodes.

**Parameters:** [Click for information.]
LSA (Latent Semantic Analysis) – Derives topics (groups) for the row nodes by performing Singular Value Decomposition on the matrix to determine the correlations between nodes.

**Node Assignment:** Nodes can be assigned to multiple groups.
**Input Matrix Mode:** One and two mode.
**Number of Groups:** User specified.
**Applicability:**
**Parameters:** [Click for information](#).

LDA (Latent Dirichlet Allocation) – Groups row nodes into topic groups.

**Node Assignment:** Nodes can be assigned to multiple groups.
**Input Matrix Mode:** One and two mode.
**Number of Groups:** User specified.
**Applicability:**
**Parameters:** [Click for information](#).

Local Patterns – Detects a variety specific patterns in the network (cliques, stars, chains, etc.). In addition to the user-selected report output, a results meta-matrix named "Groups" will be created in the ORA meta-network manager.

**Node Assignment:** Nodes can be assigned to multiple groups.
**Input Matrix Mode:** One mode.
**Number of Groups:** Automatically determined.
**Applicability:**
**Parameters:** [Click for information](#).

K-Cores – Defines groups by recursively removing all nodes with fewer than \( k \) links (thus 0-core includes all nodes in a network while 2-core includes only nodes with two or more links).

**Node Assignment:** Nodes are assigned to a single group at most.
**Input Matrix Mode:** One mode.
**Number of Groups:** Automatically determined.
**Applicability:** Handles large networks efficiently.
**Parameters:** No user-supplied parameters.

Dense Subgraphs – Finds dense subgraphs within the network.

**Node Assignment:**
**Input Matrix Mode:** One and two mode.
**Number of Groups:** Automatically determined.
Network Co-Clustering – Computes community structure on each unimodal network separately using Louvain's method. Nodes are put in the same output cluster only if they were clustered together across all Louvain clusterings.

NOTE: At least two unimodal networks must be selected as input.

Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One mode.
Number of Groups: Automatically determined.

Nearest Neighbor –

NOTE: Only a single nodeset is accepted for input; the nodeset is selected using the Groups to locate step.

Node Assignment: Nodes are assigned to a single group at most.
Input Matrix Mode: One mode.
Number of Groups: Automatically determined.

Return to Grouping Algorithms dialog.
Attributes and Measures

For detected groups, choose measures computed for the sub-network formed by each group.

Compute measures on each group network: Check to compute common measures for each sub-network formed by the group members.

Analyze the values that group members have for attributes: Perform analysis of selected attributes by group sub-networks. Select attributes from the list of eligible (analyzable) attributes from the list below (if any such attributes are available in the input meta-network(s)).

Attributes included in the list as analyzable are of types: Number, Number Category, and Text Category, while excluded attributes are of types: Date, Text, and URI. Note that the attribute types included are categorical while excluded types are not categorical in nature.

Click the [Select All] or [Clear All] buttons at the right of the attribute list select or clear (check or uncheck) all the attributes in the list. (These buttons will be hidden if there are no attributes available.)

Return to Grouping Algorithms dialog.
General Options

Group membership: Select group membership tables and measures for report output.

Membership table: Check to show which nodes are in which groups.

Group quality metrics: Check to show different metrics of how well the algorithm created clusters.

Co-Membership network: Check to analyze how often nodes appear together in the same group. This is a network where link (i,j) is the number of times that nodes i and j are grouped together.

Group x Group network with link values: Check to create a block model network which shows the distribution of links within and across groups. Then select the measure from the pulldown used to define the blocks:

- Density
- Binarized density
- Link count

Grouping algorithm process: Select outputs showing group formation.
Hierarchical clustering diagram: Check to include a pyramid view of how the algorithm created the groups which illustrates how objects are added to groups based on the clustering measure.

Dendogram: Check to include a tree diagram of how the algorithm created the groups. This is frequently used to illustrate the arrangement of the clusters produced by hierarchical clustering.

Note: The dendrogram and hierarchical clustering diagrams are available only for certain algorithms, those which use agglomerative or divisive grouping, such as Newman's Algorithm or CONCOR. The Clique algorithm is not this type of algorithm.

Return group nodesets and networks: Select to add networks containing group information to the Meta-Network Manager.

Add a new meta-network with the located groups: Check to create a new (separate) meta-network containing the identified groups and statistics and add to the Meta-Network Manager.

Add located groups to the input meta-network: Check to add group information to the input meta-network.

Return to Grouping Algorithms dialog.
Newman Parameters

Automatically determine number of groups: Check to allow the algorithm to determine the number of groups.

Find this many groups: Check to set a fixed number of groups, then set the numeric value.

Return to the algorithms description.
Girvan-Newman Parameters

Automatically determine number of groups: Check to allow the algorithm to determine the number of groups.

Find this many groups: Check to set a fixed number of groups, then set the numeric value.

Return to the algorithms description.
Louvain Method Parameters

There are no user-supplied parameters for this grouping algorithm.

Return to the algorithms description.

Components Parameters
Combine isolates into one component: Check to place all nodes without links into a single component rather than treating them as separate components.

Return to the algorithms description.

CONCOR Parameters

Use out-links (matrix rows)?: Check to compute groups based on out-link correlations.

Use in-links (matrix columns)?: Check to compute groups based on in-link correlations.

NOTE: At least one of the link categories must be selected. Selecting both is the default value.

Number of levels: Set the maximum possible number of groups. Each level doubles the maximum number of groups (level=n sets a maximum of $2^n$ groups). For example, a level of 3 finds up to 8 groups. (The number of groups found can be less than the maximum since a group must contain at least one member and groups are only split if this leads to good groups.)

Return to the algorithms description.
**Johnson Parameters**

Relationship type: Select the relationship type from the pulldown menu.

- Similarity
- Dissimilarity

Link method: Select the link method from the pulldown menu.

- CompleteLink
- SingleLink
- AverageLink

Find this many groups:

[Return to the algorithms description.]

---

**K-Means Parameters**

The K-Means parameters panel includes multiple tabs for various parameter types. Information is presented separately for each tab:

- General Parameters – Set K-Means parameters for group determination.
- Network Data – Define how networks are included in group determination.
- Attribute Data – Select numerical attributes for inclusion in group determination.
- Measure Data – Choose additional network measures to compute.

General Parameters

Groups to find: Enter the number of groups to be found.

Initialize type: Select the initialization type from the pulldown list.

KMeans++
Random data
Random cluster

Cluster method: Select cluster method from the pulldown list.

Euclidean distance
KL-Divergence
Angle norm
Network Data

Select the network data usage: Click one of the three mutually exclusive options.

None
Directly use the network links
Pearson correlation of the network rows

Network data weight: Enter a weight value (1 is default).
Attribute Data

Check one or more numeric attributes for use in group location. Only numeric attributes are displayed since only numeric attributes can be employed. If a node has multiple assigned values for a selected attribute, the first value (leftmost) is used. If a node has no attribute value, zero is used.
Measure Data

Check individual measures to have them computed and included in the report. Measures can only be computed on the single network constructed from combining all nodesets and networks.

The [Select All] and [Clear All] buttons at the bottom of the list select or clear (check or uncheck) all the measures in the list.

Return to the algorithms description.
Spectral Analysis Parameters

Groups to find: Enter the number of groups to be found.

Eigenvectors to compute:

Create an affinity matrix from the network, attribute, and measure data:

Sparse affinity network using k-nearest neighbors:

Dense affinity network

K-means parameters:

Initialize type: Select the initialization type from the pulldown list.
KMeans++
Random data
Random cluster

Cluster method: Select cluster method from the pulldown list.

Euclidean distance
KL-Divergence
Angle norm

Return to the algorithms description.

Attribute Parameters

Group by: Select a categorical attribute to define the groups.

Return to the algorithms description.
K-Fog Parameters

Trees per node:

Tree size:

Find this many groups:

Return to the algorithms description.
Alpha-Fog Parameters

Trees per node:

Tree size:

Iterations per link:

Alpha Value (0-1)

Return to the algorithms description.
LSA Parameters

Number of topics:

Return to the algorithms description.
LDA Parameters

Number of topics:

Number of iterations:

Alpha:

Beta:

Return to the algorithms description.
Local Patterns Parameters

Minimum spanning tree – Check to compute minimum spanning trees. A minimum spanning tree for a connected, undirected network of size N is a set of N-1 links from the network that connect all the nodes and that do so with minimum cost. The cost is the total sum of the link values of the tree. There can be multiple minimum spanning trees.
If the network is not connected, then a minimum spanning tree is found for each component. For each component, its size and the cost of its minimum spanning tree is reported. Isolates and dyadic-isolates are not reported.

Cliques of minimum size: Check to detect cliques then enter the minimum number of nodes required in a clique (lowest allowable value is 3). A clique is a pattern in which all nodes are linked together.

Hidden links with: Check to detect hidden cliques. A hidden clique pattern consists of two cliques that nearly completely overlap but lack a single link between them to form a combined, larger clique. This missing link is called a hidden link, and the two nodes of the link are both said to have a hidden link.

Minimum clique size: Enter the minimum number of nodes required in the overlapped clique (this count does not include the incompletely linked nodes). Lowest allowable value is 3.

Stars of minimum size: Check to detect star patterns then enter the minimum number of links in the star (lowest allowable value is 2). For example a value of 3 means at least 4 nodes make up the star. A star pattern consists of a central node, the ego node, with its direct neighbors who in turn are not connected among themselves.

Checkerboards with: Check to identify checkerboard (or butterfly) patterns. A checkerboard or butterfly pattern consists of a central node with two or more tightly connected sets of neighbors call tiles or wings. There are no direct connections between nodes in different tiles/wings. The central node is the only shared node between tiles (or butterfly body).

Minimum tile size: Enter the number of nodes allowed to constitute a tile/wing. Lowest allowable value is 2.

Minimum tile density: Enter the minimum density value (ratio of actual to possible links) within a tile/wing. Lowest allowable value is 0.1.

Minimum tiles: Enter the minimum number of tile/wings required in a pattern. Lowest allowable value is 2.

Ball and chains with: Check to detect ball and chains. A ball is densely connected group of nodes (but unlike a clique, all nodes do not have to be connected to each other). A chain is a sequence of 2 or more nodes such that the interior nodes have exactly two links that tie them into the chain. The following patterns are distinguished separately (a group of nodes is assigned to the most complex possible pattern):
• **Chain** - A group of connected nodes with interior nodes having exactly two links.
• **Club** - A single ball with connected chain.
• **Barbell** - A pair of balls connected by a chain.

(Patterns with more than two balls connected by chains will be reported as multiple barbells.)

Minimum ball size: Enter the minimum number nodes to required to constitute a ball. Lowest allowable value is 1.

Minimum ball density: Enter the minimum density value (ratio of actual to possible links) within a ball. Lowest allowable value is 0.1.

Minimum chain length: Enter the minimum number of links required to constitute a chain (e.g. a value of 3 means 4 nodes are connected in the chain). Lowest allowable value is 1.

Cycles with: Check to detect cycles. A cycle is a sequence of at least four nodes that start and end with the same node, such that a node is not repeated and the nodes in the cycle are only connected through the cycle.

Minimum cycle length: Enter the minimum number of nodes required to constitute a cycle. Lowest allowable value is 4.

Maximum cycle length: Enter the maximum number of nodes allowed to constitute a cycle. Lowest allowable value is 4.

[Return to the algorithms description.](#)
K-Cores Parameters

There are no user-supplied parameters for this grouping algorithm.

Return to the algorithms description.
Dense Subgraphs Parameters

Minimum number of nodes in the subgroup:

Minimum density of the subgraph:

Report subgraph size and density distribution

Report joins used to create subgraphs (row cosine values)

Return to the algorithms description.
Network Co-Clustering Parameters

Examine nodes in random order - Check to examine nodes in random order during optimization. This can produces a better solution. Un-check to remove randomization and reproduce results.

Return to the algorithms description.
Nearest Neighbor Parameters

Select the input data, either an existing similarity network or node attributes to construct a similarity network: (The input data is limited to the nodeset selected in the Groups to locate step and the networks using that nodeset.)

Similarity network: Check to use an existing similarity network to locate groups. Select the network from the pulldown menu to the right.

Nodeset attributes: Check to use node attributes to compute to locate groups then select attributes from the list below. Only attributes from selected nodeset are listed. The following columns are included in the attribute list:

- Include? - Check to include the attribute in the group computation. Uncheck to exclude.
- Attribute - Lists the attribute name.
Data Type - Lists the attribute data type.

Include Missing - Check to include entries with missing data in the analysis.

Weight - Shows the attribute weighting value (may not be modified by the user).

The [ Select All ] and [ Clear All ] buttons at the bottom of the list select or clear (check or uncheck) all the items in the Include? column.

Return to the algorithms description.
Management

Description
Identifies over- and under-performing individuals and assesses the state of the network as a functioning organization.

Why Use This Report
Use this report to locate strongest and weakness parts of a meta-network and also the most well connected nodes.

Like some of the other key-entity reports, the Management Report uses a multi-modal network to consider various aspects of an organization and report both organizational-level metrics as well as node-measures. This report includes identification of both top-ranked actors and knowledge, but also least-ranked actors. Thus, this report provides answers to questions such as:

Which actors are most central to the organization?

What knowledge comprise the organization's core competencies?

Which actors have access to the least knowledge?

Which actors are not well-integrated socially?

How much of the knowledge is unique to only one actor (across all actors)?

Input Parameters
To generate a Management Report, open the Generate Reports - Management dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Management… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Management using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Union by Thirds** – Select how to group the meta-networks into periods for analysis.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [Next>] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next>] button to proceed to the output dialog panel. (Alternatively use the [<Back] button to revise the inputs or the [Cancel] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, multiple meta-network comparison.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References

None.

Parameters

Return Role availability networks

Return to the Parameters Dialog description
Missing Links

NOTE: This report only available in a full version of ORA.

Description

Compute possible missing links in a network

Why Use This Report

Input Parameters

Any one chosen square network in the meta-network. If multiple meta-networks are chosen then your choice is only from the networks they have in common.

Input Parameters

To generate a Missing Links Report, open the Generate Reports - Missing Links dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Missing Links… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Missing Links using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Detects missing links in a unimodal network by running a collection of algorithms. The accuracy of each algorithm is computed.

Select the network to analyze: Select one network from the pulldown list. Only one mode (unimodal) networks are included in the list.

Select the missing link detection algorithms:

- Uniform random links
- Popularity
- Holdaran balance
- Shared values for attribute

Correlation Measures:

- Correlation, Distinctiveness
- Correlation, Expertise
- Correlation, Resemblance
- Similarity, Jaccard

Select the missing link detection algorithms:

- Kinship
- Knowledge
- Capabilities
- Task

Click to do replication analysis:

- Number of replications: 100
- Percent of links to remove: 10

Detects missing links in a unimodal network by running a collection of algorithms. The accuracy of each algorithm is computed.

Select the network to analyze: Select one network from the pulldown list. Only one mode (unimodal) networks are included in the list.

Select the missing link detection algorithms

Uniform random links : This with some probability just adds links at random where there were none.
Popularity: This just adds links where there were none with some probability such that the nodes that already get the highest number of links are more likely to get connections from the nodes not currently connected to them. The rich get richer.

Heiderian balance: Based on Heider’s balance theory. For triads, fills in missing links.

to quiescence: Repeats this until no more links can be added.

Shared values for attribute: Select an attribute from the pulldown list. If two nodes share a value on an attribute they are tied.

Correlation Measures

NOTE: The correlation measures require you to have two networks e.g., agent-x-agent and agent-x-location

Correlation, Distinctiveness: A link is placed in the unimodal network based on the probability of if greater than average correlation in what the two nodes in the two-mode network do not share.

Correlation, Expertise: A link is placed in the unimodal network based on the probability of if node 1 does not have the links in the two-mode network and node 2 does have those links.

Correlation, Resemblance: A link is placed in the unimodal network based on the probability of if node 1 and 2 have a higher than average resemblance in both what they are linked to and what they are not linked to in the 2-mode network.

Similarity, Jaccard: A link is place in the unimodal network based on the probability of if node has many of the same links in the two-mode network that node 2 does.

Input networks: Select or unselect networks for inclusion in the correlation analysis.

The [Select All] and [Clear All] buttons at the bottom of the list select or clear (check or uncheck) all the networks in the list.

Click to do replication analysis: If you desire to run multiple replication analyses place a check mark in the bottom box.

Number of replications:

Percent of links to remove:
After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

See Input Parameters, above.

Special Considerations

None.

References

None.
Network Comparison

Description
Comparedes the node and link distributions of a collection of meta-networks

Why Use This Report
Use this report to compare two or more meta-networks.

Input Parameters
To generate a Network Comparison Report, open the Generate Reports - Network Comparison dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Network Comparison… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Network Comparison using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and two or more meta-networks (one or more dynamic meta-networks) to analyze.

NOTE: You must select at least two meta-networks to analyze in the Select Report panel before you can proceed to the next dialog. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel ] button to cancel report generation.)
Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.

- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.

- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, side-by-side comparison or multiple meta-network comparison.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

This report requires at least one dynamic meta-network or 2 meta-networks as input.

References

None.

Parameters

The parameters presented depend on the number of meta-networks selected as input: three or more versus two. These are described separately below.

Parameters for Three or More Meta-Networks
Select an anchor meta-network:

The anchor network will be compared with all other input networks.

Include anchor network in the union

Specify the lossy count (\num\% of the meta-networks) (Percentage value updates depending on selected value.)

Compute distances between all pairs of networks Click to compute the distances between all pairs of meta-networks. This can be time-consuming.

Add computed distance networks to main interface

Add computed specialty networks to main interface

**Parameters for Two Meta-Networks**

Compute symmetric differences

Add symmetric difference meta-networks to main interface

Save symmetric difference meta-networks to a file

[Return to the Parameters Dialog description](#)
Node of Interest Characterization

Description
For each node specified, finds some important measures and facts about the node in relation to their network.

Why Use This Report
This report is used to examine the impact of an node (person, organization, location, etc.) and what the node is directly connected to.

For each node, identifies the set of actors, groups, knowledge, resources, etc. that influence, and are influenced, by that node.

Any network can be analyzed. But it's most interpretable if you have an agent by agent and also have another network such as agent by knowledge or agent by resources or agent by location.

Input Parameters
To generate a Node of Interest Characterization Report, open the Generate Reports - Node of Interest Characterization dialog box by selecting Analysis > Generate Reports > Locate Key Entities > Node of Interest Characterization… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Node of Interest Characterization using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Union by Thirds** – Select how to group the meta-networks into periods for analysis.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [Next >] button to proceed to the parameters dialog panel. (Alternatively use the [Cancel] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. Use Visualization to select what to include in visualizations in the report. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Visualization** – Specify the options relating to results presentation for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.
After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [<Back] button to revise the report parameters or the [Cancel] button to cancel report generation.)

**Output**

**Measures and Algorithms Used**

**Measures**

[View report to measure table] | [View measure to report table]

**Algorithms**

*Information is not available at this time.*

**Special Considerations**

*None.*

**References**

*None.*

1653
Parameters

Select the target nodes for analysis.

Select the ego nodes to analyze.

**Ego Node Selection Panel**

Select ego(s) for analysis, using the process described for Remove Nodes. At least one node must be selected.

[Return to the Parameters Dialog description](#)
Visualization

Selection options relating to results presentation.

Select an attribute for node images: Select an attribute containing image pointers for inclusion in the report (e.g. an image of an agent). Leave unselected if no image is present or no image output is desired.

Select the nodesets for which you want a network visualization: Select the nodesets for visualization (list is automatically restricted to the nodesets containing the selected image attribute if selected).

Return the sphere of influence network to the main interface Check to add the sphere of influence meta-network to the Meta-Network Manager.

Return to the Parameters Dialog description
Optimizer

Description
Adapt the link structure of a meta-network to maximize or minimize selected measure values.

Why Use This Report

Input Parameters
Input is any network in the selected meta-networks, with or without isolates.

To generate an Optimizer Report, open the Generate Reports - Optimizer dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Optimizer… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Optimizer using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.
- **Filter Data** – Select the nodesets and networks to analyze for the report.
- **Measures** – Select the measures for the report to use in analysis.
- **Negative Links** – Select the input to use for measures that take positive and negative links.
- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the optimization method selection dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
The Network Optimizer transforms an existing meta-network by adding and removing links in order to maximize or minimize a set of measures.

Choose the optimization method and parameters:

Monte Carlo

Number of experiments:

Simulated Annealing

Initial temperature:

Temperature coefficient:

After selecting the optimization method and options, click the [Next >] button to proceed to the network selection dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)
Dialog 3 – Network Selection

Select one or more networks to be variables. Only selected networks will have links added and removed during the optimization process.

Selection Panel

Network Select networks to be optimized.

Network Generation Options

Density

No isolates

After selecting networks and options, click the [Next] button to proceed to the measure selection dialog panel. (Alternatively use the [<Back] button to change the optimization method or the [Cancel] button to cancel report generation.)

Dialog 4 – Measure Selection

This dialog allows selection of both network and node measures.

Network Measures
This image illustrates selection of network-level measures for optimization.

Select the measures you would like to optimize. The objective function is the sum or product of the measure values chosen. Only measures that take as input at least one variable network are shown.

Network measures Tab selection for selecting network-level measures for optimization. For each variable in the list:

**Measure Selector** Use the pulldown list to the left of the variable name to select or unselect the variable. The following values are allowed:

------ Deselect the variable.
minimize Select the variable, optimize for the minimum possible value.
maximize Select the variable, optimize for the maximum possible value.

**Network Selector** Select one of the eligible networks from the pulldown list.

Select how to combine measures in the objective function:

Summation
Product
Node Measures

This image illustrates selection of node-level measures for optimization.

Select the measures you would like to optimize. The objective function is the sum or product of the measure values chosen. Only measures that take as input at least one variable network are shown.

Node measures Tab selection for selecting node-level measures for optimization. For each variable in the list:

mean: Use the pulldown list to optimize the variable's mean:

------ Do not optimize the mean, deselect the variable (if std dev is also deselected).
minimize Select the variable, optimize the mean for the minimum possible value.
maximize Select the variable, optimize the mean for the maximum possible value.

std dev: Use the pulldown list to optimize the variable's standard deviation:

------ Do not optimize the standard deviation, deselect the variable (if mean is also deselected).
minimize Select the variable, optimize the standard deviation for the minimum possible value.
maximize Select the variable, optimize the standard deviation for the maximum possible value.

**Network Selector** Select one of the eligible networks from the pulldown list.

Select how to combine measures in the objective function:

- Summation
- Product

After selecting measures and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to reenter the network selection or the [ Cancel ] button to cancel report generation.)

**Dialog 5 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.
Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the measures selection or the [Cancel] button to cancel report generation.)

Output
Single meta-network.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
This report should only be used for small networks of several hundred nodes as it is computationally intensive.

References
None.
Part of Speech

Description
Describe the distribution of concepts by part of speech in one or more networks.

Why Use This Report
This report will identify the part of speech from the concepts in a text set. The networks are typically formed from AutoMap with a part of speech (pos) attribute on each concept node. It can operate on any network (meta-network, semantic network, or concept network) as it makes use of only the nodes of the network.

Input Parameters
Input is any network in the selected meta-networks which contains an attribute named Frequency where that attribute contains numeric values.

NOTE: The nodeset to analyze needs an attribute which contains the parts of speech. This is usually titled pos.

To generate a Part of Speech Report, open the Generate Reports - Part of Speech dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Part Of Speech… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Part Of Speech using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters Page** – Specify the parameter values for this report.
- **Ranked Tables** – Specify the options for displaying tables of ranked nodes.
- **Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, multiple meta-network comparison.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References

None.

Parameters Page

Select the attribute that specifies the number of times the concept occurred in the text.

Frequency attribute:

Select the attribute that specifies the part of speech for the concept.

Part of speech attribute:
Create part of speech networks for each nodeset – Placing a check mark in the box will create a new meta-network in the Meta-Network Manager containing the generated part of speech networks.

Return to the Parameters Dialog description
Potential Errors

NOTE: This report only available in a full version of ORA.

Description

Detects potential errors in agent to agent interactions based on the expected interactions from cognitive similarity and expertise.

Why Use This Report

Input Parameters

To generate a Potential Errors Report, open the Generate Reports - Potential Errors dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Potential Errors… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Potential Errors using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.
Dialog 2 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the input parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References

None.
QAP/MRQAP Analysis

Description
Computes QAP and MRQAP Correlation and Regression (Dekker and Y-Permutation methods) on input networks.

Why Use This Report
Compares multiple networks to understand how two different networks relate using one network as dependent and the other as an independent network. Also useful for predicting the future of a network if there are multiple snapshots of the same network.

In network regression the unit of analysis is the dyad (a pair of nodes), and ORA lets you input three types of data:

- A network directly, such as an Agent x Agent network.
- A vector of node-level numeric attributes (such the Age of each node) repeated by row or column to form a network.
- A vector of node-level measure values (such as Betweenness Centrality) repeated by row or column to form a network.

Two analytical techniques are available:

QAP: QAP is designed as a bivariate test (only two variables). Computes QAP Correlation and Regression (Dekker and Y-Permutation methods) on input matrices. Generally, QAP is perfectly fine for almost any bivariate network problem.

MRQAP: Used for multivariate cases. If your dependent variable is continuous or count data (like in a negative binomial case), you should use MRQAP. If your dependent variable is binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent to using a linear probability model). You do need to interpret your results accordingly.

The MRQAP report is set up to compare the networks within a single meta-network: e.g. communication vs department membership. However, you can also select multiple meta-network for MRQAP, but you can not do regression of a network in one meta-network vs a network in a different meta-network.
You can do a regression using networks in the same and or different meta-networks. Moreover, you can take a vector and create a repeated column or repeated row network and use that network in the regression as well.

**Input Parameters**

NOTE: QAP can use either directed or undirected data.

NOTE: When comparing networks the networks need to be the same size.

Dialog Box 1: Select the meta-networks to use in the analysis. The first panel also gives you Transformation options for the final results.

To generate a QAP/MRQAP Analysis Report, open the Generate Reports - QAP/MRQAP Analysis dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > QAP/MRQAP Analysis… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting QAP/MRQAP Analysis using the Select Report option panel (see Dialog 1 below).

**Dialog 1 – Inputs**

![Generate Reports - QAP/MRQAP Analysis dialog box](image)

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the network selection dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)
Dialog 2 – Network Selection

Dependent Network Data

Select the meta-network with dependent data: From the pulldown below, select the meta-network containing the dependent data.

Select the type of data to extract: From the pulldown below, select one of the data types.

Network data - A network directly, such as an Agent x Agent network.
Measure value – Row repeated - A vector of node-level measure values (such as Betweenness Centrality) repeated by row to form a network.
Measure value – Column repeated - A vector of node-level measure values repeated by column to form a network.
Attribute value – Row repeated - A vector of node-level numeric attributes (such Age for each node) repeated by row to form a network.
Attribute value – Column repeated - A vector of node-level numeric attributes repeated by column to form a network.
The following parameter will vary depending on the data type picked above. The possible parameter choices are listed below with their options:

**Network Data Parameters** – The following options are presented when the dependent data type is set to **Network data**.

Network name: Select the dependent network from the pulldown list.

Transform: Select a network transformation to apply to the dependent network.

No transform
Squared
Natural log
Log base 10
Sqrt - Take square root of values.
Inverse - Select to invert values before analysis. Useful when values are dissimilarities (e.g. distance).

**Measure Value Parameters** – The following options are presented when the dependent data type is set to **Measure value**.

Measure name: Select a measure from the pulldown list.

Input network name: Select the input network from the pulldown list.

**Attribute Value Parameters** – The following options are presented when the dependent data type is set to **Attribute value**.

Nodeset name: Select the nodeset containing the target attribute from the pulldown list.

Attribute name: Select the attribute from the pulldown list.

Independent Network Data – Define one or more independent variables.

Variable-**&num;**; – Independent variable definition.

Extract the data from which meta-networks?
All meta-networks: Check to extract data from all included meta-networks.

One meta-network: Check to extract data from one meta-network, then select the desired meta-network from the pulldown menu.

Select the type of data to extract: From the pulldown below, select one of the data types.

Network data - A network directly, such as an Agent x Agent network.
Measure value – Row repeated - A vector of node-level measure values (such as Betweenness Centrality) repeated by row to form a network.
Measure value – Column repeated - A vector of node-level measure values repeated by column to form a network.
Attribute value – Row repeated - A vector of node-level numeric attributes (such as Age for each node) repeated by row to form a network.
Attribute value – Column repeated - A vector of node-level numeric attributes repeated by column to form a network.

The following parameter will vary depending on the data type picked above. The possible parameter choices are listed below with their options:

---

**Network Data Parameters** – The following options are presented when the independent data type is set to Network data.

Network name: Select the independent network from the pulldown list.

Transform: Select a network transformation to apply to the independent network.

- No transform
- Squared
- Natural log
- Log base 10
- Sqrt - Take square root of values.
- Inverse - Select to invert values before analysis. Useful when values are dissimilarities (e.g. distance).

---

**Measure Value Parameters** – The following options are presented when the independent data type is set to Measure value.

Measure name: Select a measure from the pulldown list.
Input network name: Select the input network from the pulldown list.

**Attribute Value Parameters** – The following options are presented when the independent data type is set to *Attribute value*.

Nodeset name: Select the nodeset containing the target attribute from the pulldown list.

Attribute name: Select the attribute from the pulldown list.

[ Add Independent ] Click to add an additional independent variable.

[ Remove Independent ] Click to remove the highest numbered (rightmost) independent variable. *(Variable-1 cannot be removed.)*

After entering all parameters and options, click the [ Next > ] button to proceed to the algorithm selection dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Algorithm Selection**

![Generate Reports - QAP/MRQAP Analysis](image)

Select the algorithms to run:

Correlation : Check to compute the correlation between the dependent and independent variable.
Y-Permutation Regression: Check to compute regression using a QAP technique involving permuting the independent network.

Double-Dekker Semi-Partialling Regression: Check to compute the regression using a technique to deal with the inherent dependence of link data. (Available only when multiple meta-networks (or a dynamic meta-network) are selected for analysis.)

Set the algorithm parameters: Correlation and regression use a bootstrapping technique that inputs a random seed and number of iterations.

Seed the random number generation with Zero: Check to initialize the random number generator with the seed value zero.

Seed the random number generator with: Check to initialize the random number generator with a user-provided seed value. Enter the seed value in the numeric field.

Number of permutations: Set the number of iterations by changing the numeric value.

Return regression network data to the main interface? Check to add the computed regression meta-network to the Meta-Network Manager.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [ < Back] button to revise the network selection or the [Cancel] button to cancel report generation.)
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the algorithm selection or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

See the Why Use This Report section above. See also Regression.

Special Considerations

When comparing networks the networks need to be the same size.

References

None.
Semantic Network

Description
This report analyzes one or more semantic networks, computing central networks and key concepts and links.

Why Use This Report
The report outputs the nodes and edges in the intersection, offset, and union.

It assesses the connection among concepts. Will derive networks from email content, texts, or documents of any sort.

The semantics networks report analyzes one or more semantic networks, computes the central graphs, and key concepts and links. This is a comparison of two or more semantic networks. Each node in the network is considered a concept, and each link connects two concepts. Link weights are interpreted as the number of times it occurred in the underlying input text.

The report includes tests whether the two semantic networks are statistically different using four different T-tests, based on the number of nodes, the number of links, betweenness centrality, and degree centrality.

The symmetric distance of network A to network B is the number of concepts and links in A that are not in B. In set theoretic terms, this is the set difference (A - B).

This report also provides communicative power analysis. Concepts are classified according to whether they have high and low values for the measures.

The semantic network report will perform analysis on a semantic network of concept colocations in a sentence generated by AutoMap. It will characterize the usage of words, such as a buzzword which is used but not described such as is often found in law documents. There are other word types based on how they exist within the semantic network.

Ordinary (low degree, low betweenness, low consensus)

Factoids (low degree, low betweenness, high consensus)

Buzzwords (low degree, high betweenness, low consensus)
Emblems (low degree, high betweenness, high consensus)

Allusions (high degree, low betweenness, low consensus)

Stereotypes (high degree, low betweenness, high consensus)

Placeholders (high degree, high betweenness, low consensus)

Symbols (high degree, high betweenness, high consensus)

The report also creates new networks that represent different levels of agreement between the loaded networks. The set-theoretic intersection on the 25, 50, 75% percent level is considered for this comparison. More precisely, the following outputs are computed:

The union of compared links.

The consensus between networks as it is represented by the intersection of links.

The dissension between networks as it is represented as the difference.

Do different people use the same words and themes in the same way?

Do different people link concepts and themes in the same way?

Do different people share the same knowledge?

How similar or different are the analyzed texts?

**Input Parameters**

To generate a Semantic Network Report, open the Generate Reports - Semantic Network dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text > Semantic Network… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Semantic Network using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Union by Thirds** – Select how to group the meta-networks into periods for analysis.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) Parameter values must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Parameters** – Specify the parameter values for this report.
- **Output networks** – Enter parameters for the creation of central networks.
NOTE: The Output networks item only appears when three or more meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [Finish] button to generate the report. (Alternatively use the [< Back] button to revise the report parameters or the [Cancel] button to cancel report generation.)

### Output
Single meta-network, side-by-side comparison.

### Measures and Algorithms Used

**Measures**

View report to measure table | View measure to report table

**Algorithms**

*Information is not available at this time.*

### Special Considerations
None.

### References
Parameters

The parameters should be entered from top to bottom in the dialog. After selections have been entered, values for the following parameters will automatically be inserted into the dialog where possible.

Select the nodesets to use in the analysis.

Concepts: Using the pulldown menu, select the nodeset that contains a list of words or phrases that represent concepts. Based on the user selection, ORA will attempt to nominate a value for the Semantic network - shared documents entry below.

Documents: Using the pulldown menu, select the nodeset that contains a list of documents that contain concepts. Based on the Concepts and Documents selection, ORA will attempt to nominate a value for the Usage network for documents entry below.
Authors: Using the pulldown menu, select the nodeset that contains a list of authors. Based on the Concepts and Authors selection, ORA will attempt to nominate a value for the Usage network for authors entry below.

Semantic network - shared documents: Using the pulldown list, specify a Concept x Concept - shared document network. Links indicate which concepts co-occurs in documents.

Usage network for documents: Using the pulldown list, specify a Concept x Document network. Links give the number of times a concept occurs in each document.

Usage network for authors: Using the pulldown list, specify a Concept x Author network. Links give the number of times an author uses a concept.

Determine the number of times each concept occurs in a document: Indicate the source for the concept count by selecting one of the mutually exclusive options below.

By attribute value: Select if the concept count is contained in an attribute then select the attribute from the pulldown list.

By node degree in the document usage network - Select if the links values of the networks contain the concept count.

Select how to define high and low measures values: Define what will be marked as high and low values in the report output. Options are mutually exclusive.

Top and bottom #%-th percentiles – Select to mark values falling into the specified percentile above and below the mean (minimum 5, maximum 50). Type the percentile number into the number spinner or use the up/down arrows to increase or decrease the value by 5.

By node degree in the document usage network # standard deviations – Select to mark values which are the specified number of standard deviations above and below the mean. Type the number of standard deviations into the number spinner or use the up/down arrows to increase or decrease the value by 1.

Return to the Parameters Dialog description

1691
Enter parameters for the creation of central networks.

Select the central networks to compute. A central network of level X only contains links common to X% of the networks. The percentages must be integral.

In the text area, enter a common or space separated list of integer percentage values.

Return Central Networks to main interface – Check to create a meta-network containing the computed central networks in the ORA Meta-Network Manager.

Compute hamming distances between networks – Check to compute the Hamming distance between networks.

Return to the Parameters Dialog description
Shortest Path

Description
Computes the shortest path between two entities and general statistics on the paths. The sphere of influence of each entity is also computed.

Why Use This Report

Input Parameters
To generate a Shortest Path Report, open the Generate Reports - Shortest Path dialog box by selecting Analysis > Generate Reports > Locate Key Relations > Shortest Path… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Shortest Path using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of
the panel. All options have default values set initially. For further information on
individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to
analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive
and negative links.

**Transform Data** – Select one or more of the provided transformations to
apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before
generating the report.

After entering all input options, click the [Next >] button to proceed to the
parameters dialog panel. (Alternatively use the [Cancel] button to cancel report
generation.)

**Dialog 2 – Parameters**
Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the parameter values for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.
Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output
Single meta-network.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
Select the two nodes (start and end) that you want to find the shortest path between.

Start node Select the starting point for the path.
Nodeset: Using the pulldown list, select the nodeset containing the start node.
Node: Using the pulldown list, select the start node.

End node Select the target end point for the path.
Nodeset: Using the pulldown list, select the nodeset containing the end node.
Node: Using the pulldown list, select the end node.

Select the nodesets to use when computing the shortest path. Not using a nodeset can potentially increase the shortest path length.

**Nodeset Selection Panel** From the list of available nodesets, select (or unselect) nodesets for use while computing the shortest path.

The [Select All] and [Clear All] buttons at the right of the list select or clear (check or uncheck) all the nodesets in the list.

*Return to the Parameters Dialog description*
Simmelian Ties Analysis

Description
Calculates the number of Asymmetric, Sole-Symmetric, and Simmelian Ties in unimodal networks computes standard measures on them.

Why Use This Report

Input Parameters
To generate a Simmelian Ties Analysis Report, open the Generate Reports - Simmelian Ties Analysis dialog box by selecting Analysis > Generate Reports > Locate Key Relations > Simmelian Ties Analysis… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Simmelian Ties Analysis using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of

1698
the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**
Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Parameters** – Specify the parameter values for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.
Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output
Meta-network with Simmelian ties.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
NOTE: Only square networks can be analyzed.

Select one or more networks to analyze:

**Network Selection Panel** From the list of available networks, select (or unselect) networks for analysis.

The [Select All] and [Clear All] buttons at the right of the list select or clear (check or uncheck) all the networks in the list.

Select the link partition networks to create:

- Asymmetric
- Simmelian
- Sole Symmetric

Click to add a new meta-network with the partitions

*Return to the Parameters Dialog description*
Socio-cultural Cognitive Mapping

Description
Analyzes social-cultural mappings.

Why Use This Report
Socio-cultural Cognitive Mapping (SCM) is a best-fit network model to the set of underlying node to variable data. SCM permits objective visualization of the network, inference about the impact of changes in the underlying conditions influencing the nodes and comparison of disparate data.

SCM is a method designed to help analysts make sense of communities and to understand and predict changes in these communities. From a socio-cultural perspective addressing these questions means attaining a structural understanding of actors, issues, and the relations connecting them. Or in other words, it means answering these questions: 1) Who are the critical actors, particularly the political, tribal, religious, economic, educational and religious elite and associated groups. 2) On what specific micro-issues are the interest of these elites and their groups aligned, and on what issues do they complete? 3) What is the basis for those relations, alliances and conflicts e.g., are they based in economics, status, education, religion, or location. Further it is important to not only understand the lay of the land, but to use that information to assess the community of actors of interest vis-à-vis some issue, e.g. resilience, cyber-attacks, or deterrence given those relations and the basis for them. And 4) How will the community change its position on a broad area of concern, an issue, given changes in the alliances and competitions on the more micro issues, perhaps due to the underlying basis for a relation being altered, or an actor being removed? That is, how stable it the community, how resilient is the community, given change at the actor level or basis for alliance/competition level?

For more information see the Socio-cultural Cognitive Mapping (SCM) Analysis - Description entry.

Input Parameters
To generate a Socio-cultural Cognitive Mapping Report select a meta-network in the Meta-Network Manager panel, click the [ Generate Reports… ] button in the Meta-Network panel and select Socio-cultural Cognitive Mapping using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Report – Select a report to run and one or more meta-networks to analyze.

Filter Data – Select the nodesets and networks to analyze for the report.

Measures – Select the measures for the report to use in analysis.

Negative Links – Select the input to use for measures that take positive and negative links.

Transform Data – Select one or more of the provided transformations to apply to each meta-network before analysis.

Remove Nodes – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**
Set the parameters specific to this report. All options have default values set initially. For further information on individual options, see the Socio-cultural Cognitive Mapping (SCM) Analysis - Procedure entry.

Select a frequency network:

From the pulldown list of the networks contained in the selected meta-networks, select a frequency network for analysis.

A network whose links are frequency values. Link (i,j) is the frequency of nodes i and j. The network can be unimodal or bimodal, and binary or weighted.

Model Parameters:

Type: Select the model type. Morgan Visual Segregation tends to be more robust to data, but creates much less tightly defined grouping than the Levine Statistical Segregation method. The models are further characterized in the Socio-cultural Cognitive Mapping (SCM) Analysis - Description entry.

Levine Statistical Segregation
Morgan Visual Segregation

NOTE: The model type selected will affect the availability of some of the model parameters below.

Dimensions: Specify the number of dimensions (Ndim) of the desired solution from the pulldown menu (from 1-3, 2 is the usual value).

1-Dimensional
2-Dimensional
3-Dimensional

Minkowski power values: Shows the current power settings. Change settings by entering any number of values ranging from 0.0 to positive infinity separated by semicolons (;). (Default is 0.7; 1.0; 2.0; 3.0)

Attenuation values: Shows the current attenuation settings. Change settings by entering any number of values ranging from 0.0 to positive infinity separated by semicolons (;). (Default is 0.7; 1.0; 2.0; 3.0)

Frequency data options:
Ignore zero frequencies - Click this to ignore frequency cells of value zero. The model will not attempt to match zero values. This will likely lead to a lower chi-square error.

Invert frequency values - Click to invert frequency values before optimizing. Zero frequency values when inverted are set to the maximum frequency value.

Optimization parameters:

Number of repetitions: Set the number of optimization passes for fitting the SCM (default is 5).

Allow negative multipliers

NOTE: The following two parameters are mutually exclusive. Using the same seed value, input data and parameters generates repeatable results.

Seed the random number generator with Zero Select to use an initial (seed) value of zero (0) for the random number generator. (This is the default seed value.)

Seed the random number generator with: Select to provide an initial (seed) value then enter a number in the entry area to the right.

Output options: Permits saving selected results as meta-networks in the ORA Meta-Network Manager.

NOTE: Entries in the Output Options section will add data to the Meta-Network Manager. This is in addition to the normal report output. (Options for normal report outputs are presented in the output dialog panel, which follows this dialog.)

Return a meta-network summarizing the model optimization Check to create a meta-network (SCM-Output Summary) summarizing the entire SCM run in the Meta-Network Manager.

Return a meta-network with results from the best model Check to create a meta-network (SCM-Output...) in the Meta-Network Manager containing the model with the minimum Chi-Square statistic between the estimated and actual frequency values.

After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back] button to revise the inputs or the [Cancel] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output

The standard report displays the 1, 2 and 3 dimensional SCM models.
Additional results can be saved in the input meta-matrix depending on the Output Options selected in the parameters dialog.

**Measures and Algorithms Used**

**Measures**

[View report to measure table] | [View measure to report table]

**Algorithms**

See Levine and Carley (2016) in References, below.

**Special Considerations**

The input meta-matrix may be modified with appended data, depending on the Output Options selected in the parameters dialog.

**References**

Statistical Change Detection

Description
Analyzes the changes in network-level measures over time using a Statistical Process Monitoring (SPM) control chart. Control limits are determined based on a user defined level of risk.

Why Use This Report

Input Parameters
At least three networks are required as input.

To generate a Statistical Change Detection Report, open the Generate Reports - Statistical Change Detection dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Statistical Change Detection… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Statistical Change Detection using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and three or more meta-networks (one or more one dynamic meta-networks) to analyze.

**NOTE**: You must select at least **three** meta-networks or one **dynamic** meta-network to analyze in the Select Report panel before you can proceed to the next dialog.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the algorithm selection dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Algorithm Selection**

![Algorithm Selection Dialog](image.png)

What algorithm do you want to use?

- Shewhart X-Bar Chart
- Cumulative Sum (CUSUM) Chart

After entering all parameters and options, click the [ Next > ] button to proceed to the algorithm parameters dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Algorithm Parameters**

Set parameter values for the selected algorithm (note that the parameter values are similar but not identical for the algorithms).

**Shewhart X-Bar Chart Parameters**
Select the number of networks used to establish in-control behavior, and then the risk – which is the probability of a false alarm.

Number of networks to establish in-control behavior: 2

Risk (probability of a false alarm): 0.0

Select the input for the measures. Selecting the entire meta-network will combine all networks into a single network.

Use entire meta-network

Use network: Agent x Agent

Select the network measures to monitor:
(values must be normally distributed for meaningful analysis):

- Centrality, Betweenness
- Centrality, Closeness
- Density

Cumulative Sum (CUSUM) Chart Parameters
Select the number of networks used to establish in-control behavior, and then the optimization and decision interval.

Number of networks to establish in-control behavior:

Enter a standardized change to optimize for:

Set sensitivity to false alarm:

- Decision interval:
- Risk (probability of a false alarm):
- Average number of observations before false alarm:

Select the input for the measures. Selecting the entire meta-network will combine all networks into a single network.

- Use entire meta-network
- Use network: Agent x Agent

Select the network measures to monitor:
(values must be normally distributed for meaningful analysis):
- Centrality, Betweenness
- Centrality, Closeness
- Density

Select the input for the measures. Selecting the entire meta-network will combine all networks into a single network.

Use entire meta-network

Use network:

1714
Select the network measures to monitor:
(values must be normally distributed for meaningful analysis):

Centrality, Betweenness

Centrality, Closeness

Density

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the algorithm selection or the [ Cancel ] button to cancel report generation.)

**Dialog 4 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.
Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the algorithm parameters or the [ Cancel ] button to cancel report generation.)

Output
Single meta-network, multiple meta-networks.

Measures and Algorithms Used
Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
This report requires at least one dynamic meta-network or 3 meta-networks as input.

References
None.
Statistical Distribution

Description
Fits statistical distributions to a network based on measure values.

Why Use This Report
When characterizing network topologies, it is important to consider the role of errors and incomplete data in the network. The Statistical Context and Communicators reports will provide additional analysis on network topologies and actors, respectively.

See also:

- Authority Centrality
- Least Squares
- Maximum Likelihood Estimation [MLE]
- Method of Moments [MOM]

Input Parameters
To generate a Statistical Distribution Report, open the Generate Reports - Statistical Distribution dialog box by selecting Analysis > Generate Reports > Statistical Procedures and Diagnostics > Statistical Distribution… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Statistical Distribution using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

Select an input network: Choose a network from the pulldown list for analysis.

Select an input measure: Choose a measure from the pulldown list for fitting.

Select the distributions to fit:

- Normal (Gaussian)
- Uniform
- Exponential
- Gamma
- Beta
- ChiSquare

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output

Single meta-network.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

None.

References


Tactical Insight

Description
Analyzes the top agent nodes across time periods, tracking locations and measure values.

Why Use This Report

Input Parameters
This report requires a dynamic meta-network or least 3 meta-networks as input. For most purposes, a chronological sequencing and some common agents across individual meta-networks are expected.

To generate a Tactical Insight Report, open the Generate Reports - Tactical Insight dialog box by selecting Analysis > Generate Reports > Dynamics > Tactical Insight… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Tactical Insight using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs

[Image of the Generate Reports - Tactical Insight dialog box]

1722
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and three or more meta-networks (one or more one dynamic meta-networks) to analyze.

NOTE: You must select at least **three** meta-networks or one **dynamic** meta-network to analyze in the Select Report panel before you can proceed to the next dialog.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.
Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the input parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network and multiple meta-network comparison.
Measures and Algorithms Used

Measures

- Betweenness Centrality
- Total-Degree Centrality

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

This report requires at least one dynamic meta-network or 3 meta-networks as input.

References

None.
Topic Analysis

Description
Finds topic clusters in a collection of text meta-networks using the latent Dirichlet allocation (LDA) and latent semantic analysis (LSA) algorithms.

Why Use This Report

Input Parameters

Every node is included and considered as a concept. The frequency of each concept is determined by the value of its frequency attribute.

NOTE: Requires an attribute Frequency to exist in the meta-network.

To generate a Topic Analysis Report, open the Generate Reports - Topic Analysis dialog box by selecting Analysis > Generate Reports > Knowledge Networks & Network Text Analysis > Topic Analysis… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [Generate Reports…] button in the Meta-Network panel and selecting Topic Analysis using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

The parameters dialog varies depending on the algorithm selected. Both versions are shown below

**Parameters Dialog with Latent Semantic Analysis Selected**

Select the documents and concept frequency network:

**Type:**

Choose an algorithm and set its parameters: Selecting a tab selects the algorithm for execution.

**Latent Semantic Analysis**
Number of topics:

The algorithms compute the membership value of each document and concept to each topic. Reporting all values can be memory intensive.

Select what to report for each topic:

Show the top ranked members:

Show all members

Select what network to return to the main interface:

Do not return a meta-network with membership values

Return a meta-network with top membership values

Return a meta-network with all membership values

Parameters Dialog with Latent Dirichlet Allocation Selected
Select the documents and concept frequency network:

Type:

Choose an algorithm and set its parameters: Selecting a tab selects the algorithm for execution.

Latent Dirichlet Allocation

Number of topics:

Number of iterations:

Alpha:

Beta:

The algorithms compute the membership value of each document and concept to each topic. Reporting all values can be memory intensive.

Select what to report for each topic:

Show the top ranked members:

Show all members

Select what network to return to the main interface:

Do not return a meta-network with membership values

Return a meta-network with top membership values

Return a meta-network with all membership values

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Save Options** – Select the report output format(s) and storage location.

**Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

Single meta-network, side-by-side comparison, multiple meta-network comparison.
Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
Requires an attribute Frequency to exist for each node analyzed.

References
None.
Trails

Description

Analyzes the trails that an entity class makes through another entity class, for example, how vessels pass through ports.

Why Use This Report

The trails report can show **who or what** was **where or when**. The report also can indicate **who or what** interacted with **who or what** when.

This report provides measures characterizing the trails in terms of frequency, transitions, time, and state. The user can specify certain trails for additional analysis as well as adjusting the inputs and format of the report. Results from the trail and ego pair analyses can also be saved in meta-network format.

Input Parameters

At least two meta-networks or one dynamic meta-network are required as input. Each meta-network contains the location of entities ("ego") at a given instant, represented as network (ego x location). The data must be in trails format: the input meta-matrices must use the same name and nodeset type for the ego and location nodesets and the same name for the ego x location network. In addition, the meta-matrices should be ordered, with the meta-network time set to a date or period. The duration between meta-matrices can be uniform or variable and meta-matrices can optionally be aggregated into larger time intervals before analysis. Dynamic meta-networks are a convenient way to store and organize trail data, but their use is not required.

To generate a Trails Report, open the Generate Reports - Trails dialog box by selecting Analysis > Generate Reports > Locate Key Relations > Trails… in the menu bar of the interface or by selecting one or more meta-networks in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Trails using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and two or more meta-networks to analyze.
- **Filter Data** – Select the nodesets and networks to analyze for the report.
- **Measures** – Select the measures for the report to use in analysis.
- **Negative Links** – Select the input to use for measures that take positive and negative links.
- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
- **Remove Nodes** – Select nodes to remove from each meta-network before generating the report. (Ego and state nodes can also removed in the following parameters dialog.)
After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

Dialog 2 – Parameters

Set the parameters specific to this report by selecting the Select Nodes, Trail Analysis, and Ego Pair Analysis options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) The Select Nodes values Ego Nodeset and State Network must be set, other options have default values set initially. For further information on individual options, click on the option name in the list below.

Select Nodes – Specify Ego and State nodes for this report.

NOTE : An Ego Nodeset and State Network must selected before running the report.

Trail Analysis – Specify how to create trails for this report.
**Ego Pair Analysis** – Specify how to find similar ego nodes for this report.

**Ranked Tables** – Specify the options for displaying tables of ranked nodes.

**Measure Means Test** – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE : The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.

After entering all parameters and options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.
Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output
Multiple Meta-Networks.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
Requires at least two meta-networks or one dynamic meta-network as input.

References
None.
Select Nodes

Indicate the ego nodeset and state network. Optionally, individually select nodes for inclusion in the report. Entries should be made from the top to the bottom of the dialog.

NOTE: An Ego Nodeset and State Network must be selected before running the report.

Select an Ego Nodeset: Use the pulldown menu to select the nodeset containing nodes to track. After selection, possible state networks will be identified and ego nodes will be listed under the Ego Nodes Tab.

Select a State Network: Use the pulldown menu to select the nodeset containing nodes to track. After selection, the state nodes will be listed under the State Nodes Tab.

Node Selection Area

The Node Selection Area allows individual selection of nodes for inclusion in the report for both the ego and state nodesets. Each nodeset is listed in a separate tab. All nodes are initially selected.
Ego Nodes Tab – Click to see the nodes contained in the ego nodeset.

Select the Ego nodes to analyze. Import attributes for the nodeset using the button to the right.

[ Import Attributes ] – Click the button to append attributes from a file. A dialog will open to specify a file containing attribute data.

Node Selection Panel – Use the panel to (optionally) select individual ego nodes to track. Nodes not checked will not be included in the analysis and report. By default all nodes are selected.

NOTE: For a brief introduction to selecting and filtering see 9. EDITING NODES AND ATTRIBUTES.

Selecting

Individual Selection - To select individual nodes, place a check mark next to the node.

Multiple Selection - To select multiple nodes, use the controls at the bottom of the Editor pane:

Select/Clear All: Checking this box selects all nodes (whether a node is currently displayed or not; items hidden after filtering or outside the viewing window are still selected). Unchecking the box deselects all nodes.
Select/Clear Visible: Checking this box selects *visible* nodes under this tab (all currently displayed lines even those outside the viewing window; items hidden after filtering are *not* selected). This permits selection of all nodes found by a filtering. Unchecking the box deselects just the displayed nodes.

**Filtering** - Individual attribute columns can be filtered based on contents (analogous to the filter feature in Microsoft Excel). Click on the downward triangle (▼) in the column heading to open the filter menu.

The filter menu supports two types of filtering:

**Standard** - The standard check list displays all distinct entries in the column. Unchecking items on the list hides the corresponding measure lines when the filter is applied. This is a simple way to filter columns with a small number of entries.

**Custom** - Checking the Define a custom filter: option allows a user specified search. This filter technique provides a convenient way to filter columns with a large number of diverse entries. The type of search depends on the type of data contained in the column (text or numeric). Only text filtering is described here.

**Text Filtering** - To create a text filter, enter match string in the text field. Then select the string match type is selected from the pulldown list:
- Contains
- Not contain
- Equals
- Not equal

[Apply] Click to apply the current filter.

[Cancel] To close the filter menu. (NOTE: To remove the filter, click the [Clear Filter] button.)
State Nodes Tab – Click to see the nodes contained in the state nodeset.

Select the State nodes to analyze. Import attributes for the nodeset using the button to the right.

[ Import Attributes ] – Click the button to append attributes from a file. A dialog will open to specify a file containing attribute data.

Node Selection Panel – Use the panel to (optionally) select individual state nodes use in trails. Nodes not checked will not be included in the analysis and report. By default all nodes are selected.

Selecting

For the selection procedure, see the Ego Nodes Tab section above.

Return to the Parameters Dialog description
Trail Analysis

Select how to create trails for the analysis:

Trail dimension – Set the number of state nodes to use as steps in the trail. Type the number of dimensions into the number spinner or use the up/down arrows to increase or decrease the value by 1.

A dimension value of 1 means use the locations as entered (for example Agent_1's trail might read "Location_1 to Location_2 to Location_4 to Location 5"). A value of 2 would use location pairs so Agent_1's trail might become "Location_1*Location_2 then Location_2*Location_4 then Location_4*Location_4 then Location_4*Location_5", where "Location_1*Location_2" means Agent_1 moves from Location_1 to Location_2. Using dimensions higher than one can be useful in distinguishing events such as trails which reverse directions, spend more than one period in a location (note "Location_4*Location_4" in the example), or distinguishing egos which use similar but not identical paths.

Trail duration unit: Use the pulldown list to choose the time unit when measuring durations. Observations within the same time unit will be merged. Sequential means to ignore dates and list states sequentially. Durations are:
Sequential
Years
Months
Days
Hours
Minutes
Seconds
Milliseconds

Restart trail interval: Select to restart the trail for an Ego each time the interval between two consecutive states exceeds the restart interval set in the numeric spinner. For trails using the Sequential time duration unit, this value is the number of states. For other time units (sequential trails), this value is the number of transition duration units (e.g. days, months, weeks).

Translate trails to the same start time – Select to translate each trail to a common start time. Trails will all begin at the time of the earliest trail.

Compress trails – Select to compress trails by ignoring gaps in time periods.

Most Likely Trails Tab – Add a section to the Most Likely Trails analysis showing the trails most likely to occur from a given starting node and moving forwards or backwards a certain number of step transitions.

NOTE: The Add Most Likely Trails button will not activate until an Ego Nodeset and State Network have been selected in the Select Nodes pane.

[ Add Most Likely Trails ] Button – Click to add a most likely trail entry (image shows one entry added; any number can be created). For each entry, use the following controls to define how the trail will be constructed:

Start node: From the pulldown, select the initial node for the analysis (the start node can be any node in a trail, it does not have to be at the beginning).

Movement: From the pulldown, indicate which direction to proceed from the start by selecting one of the options from the list below.

Forward from start node
Backward from start node

Steps – Set the (maximum) number of nodes to include in the trail. Type the number of steps into the number spinner or use the up/down arrows to increase or decrease the value by 1.
Return transition network to the interface – Select to add results from the trails analysis as a meta-network to the Meta-Network Manager.

Return to the Parameters Dialog description

Ego Pair Analysis

Analyze the data to identify various patterns.

Select the analyses to perform: Choose any or all of the ego analyses listed below.

Co-Entry: finds Ego node pairs that enter a state concurrently – Select to list Ego nodes entering a state together.

Co-Exit: finds Ego node pairs that exit a state concurrently – Select to list Ego nodes leaving a state together.

Co-Handoff: finds Ego node pairs in which one node enters a state when another exits it – Select to list Ego nodes where one node enters when another node exits.
Co-Occurrence: finds Ego node pairs at a state concurrently – Select to list Ego nodes at the same location at the same time.

Presence: finds Ego node pairs at the same state (not necessarily at the same time) – Select to list Ego nodes at the same location but not at the same time.

Transitions: finds Ego nodes with common transitions (not necessarily at the same time) – Select to list Ego nodes traveling along the same single link routes but not at the same time.

Return the Ego x Ego network to the interface – Select to add results from the ego analysis as a meta-network to the Meta-Network Manager.

Return to the Parameters Dialog description
Triad Census

Description
Computes and classifies the triads in a network.

Why Use This Report

Input Parameters
Only one mode (unimodal) networks can be analyzed. (A one mode network links nodes of the same class, such as an Agent x Agent network.)

To generate a Triad Census Report, open the Generate Reports - Triad Census dialog box by selecting Analysis > Generate Reports > Characterize Groups and Networks > Triad Census… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Triad Census using the Select Report option panel (see Dialog 1 below).

Dialog 1 – Inputs
Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

**Dialog 2 – Parameters**

![Dialog 2 - Parameters](image_url)

1747
Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

Parameters – Specify the parameter values for this report.

Ranked Tables – Specify the options for displaying tables of ranked nodes.

After entering all parameters and options, click the [ Next ] button to proceed to the output dialog panel. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

Dialog 3 – Output

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.
Save Options – Select the report output format(s) and storage location.

Preferences – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

Output
There is a specialized output format when three or more meta-networks are input.

Measures and Algorithms Used
Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
Only one mode (unimodal) networks can be analyzed. (A one mode network links nodes of the same class, such as an Agent x Agent network.)

References
None.
Parameters

Select a nodeset and the unimodal networks to analyze

Nodeset to analyze: Select a nodeset from the pulldown list.

Networks to analyze: Check one or more networks to select them for analysis.

The [ Select All ] and [ Clear All ] buttons below the list select or clear (check or uncheck) all the networks in the list.

Return to the Parameters Dialog description
**Twitter**

**Description**

Identifies key tweeters and tweets in a meta-network derived from twitter data. Characterizes tweets and tweeters.

**NOTE** : This report requires a meta-matrix containing Twitter data in a specific format. ORA's Data Import Wizard will read Twitter JSON files and create a meta-matrix in the correct format

**Why Use This Report**

Provides a simple way to analyze Twitter data rendered as a meta-matrix.

**Input Parameters**

The example Twitter input shown above was created by importing a Twitter JSON file using the Data Import Wizard. The nodesets and matrices are in the form required by the Twitter Report.

To generate a Twitter Report, open the Generate Reports - Twitter dialog box by selecting Analysis > Generate Reports > Social Media > Twitter… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting Twitter using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Select Report** – Select a report to run and one or more meta-networks to analyze.

- **Filter Data** – Select the nodesets and networks to analyze for the report.

- **Measures** – Select the measures for the report to use in analysis.

- **Negative Links** – Select the input to use for measures that take positive and negative links.

- **Union by Thirds** – Select how to group the meta-networks into periods for analysis.

- **Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.
Remove Nodes – Select nodes to remove from each meta-network before generating the report.

After entering all input options, click the [ Next > ] button to proceed to the parameters dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

Dialog 2 – Parameters

Set the parameters specific to this report by selecting the Parameters option in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. (Alternatively, you can adjust the appearance of ranked tables using the Ranked Tables option or initiate the Measure Means Test.) All options have default values set initially. For further information on individual options, click on the option name in the list below.

Parameters – Specify the parameter values for this report.

Ranked Tables – Specify the options for displaying tables of ranked nodes.

Measure Means Test – Initiate comparison of the measures of the input meta-networks and specify parameter values.

NOTE: The Measure Means Test only appears when exactly two meta-networks are selected as input. The meta-networks can be independent or part of dynamic meta-networks, in any combination.
After entering all parameters and options, click the [Next >] button to proceed to the output dialog panel. (Alternatively use the [< Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)

**Dialog 3 – Output**

![Generate Reports - Twitter Dialog](image)

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [< Back ] button to revise the report parameters or the [ Cancel ] button to cancel report generation.)

**Output**

The report includes analysis of: Tweeters, Topics, Locations, and Tweets.
Measures and Algorithms Used

Measures

View report to measure table | View measure to report table

Algorithms

Information is not available at this time.

Special Considerations

This report requires a meta-matrix containing Twitter data in a specific format. ORA’s Data Import Wizard will read Twitter JSON files and create a meta-matrix in the correct format and can serve as a guide to constructing a compatible meta-matrix by other means.

References

None.

Parameters

Geospatial Options - Allows use of a shapefile attribute to associate latitude/longitude coordinates with location names, such as cities or countries. This option might slow down report generation.

Create geospatial visualizations - Check to include a map of location data in the report.
Use a shapefile attribute to associate latitude/longitude coordinates with location names, such as cities or countries. This option might slow down report generation.

Use the shapefile: Check to use a shapefile to associate latitude/longitude coordinates with location names.

Use the [Browse] button to open a file browser. Navigate to the shapefile directory, select the shapefile and click [Open]. Alternatively, enter the fully qualified file name directly into the text field.

Attribute: After loading the shapefile, ORA will provide a list of attributes included in the file. Select the attribute for location matching.

Return to the Parameters Dialog description
Description
Analyzes data extracted from YouTube.

Why Use This Report
The YouTube report characterizes meta-network(s) generated from YouTube data. In addition to basic statistics, analysis categories include:

- Video Analysis
- Commenter Analysis
- Category Analysis
- Channel Analysis
- Co-Commenter Analysis

Input networks for the report can be constructed using the YouTube option in the Data Import Wizard to process YouTube data stored in a JSON format.

Input Parameters
To generate a YouTube Report, open the Generate Reports - YouTube dialog box by selecting Analysis > Generate Reports > Social Media > YouTube… in the menu bar of the interface or by selecting a meta-network in the Meta-Network Manager panel, clicking the [ Generate Reports… ] button in the Meta-Network panel and selecting YouTube using the Select Report option panel (see Dialog 1 below).
Dialog 1 – Inputs

Change the report or customize inputs for the report by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

**Select Report** – Select a report to run and one or more meta-networks to analyze.

**Filter Data** – Select the nodesets and networks to analyze for the report.

**Measures** – Select the measures for the report to use in analysis.

**Negative Links** – Select the input to use for measures that take positive and negative links.

**Transform Data** – Select one or more of the provided transformations to apply to each meta-network before analysis.

**Remove Nodes** – Select nodes to remove from each meta-network before generating the report.
After entering all input options, click the [ Next > ] button to proceed to the output dialog panel. (Alternatively use the [ Cancel ] button to cancel report generation.)

NOTE: There are no user selectable parameters for this report and hence no Parameters Dialog.

**Dialog 2 – Output**

![Generate Reports - YouTube dialog box](image)

Set the report output location, format and appearance by selecting options in the left column of the dialog, then reviewing and changing values in the right-hand side of the panel. All options have default values set initially. For further information on individual options, click on the option name in the list below.

- **Save Options** – Select the report output format(s) and storage location.
- **Preferences** – Choose options to customize report output.

After entering all output options, click the [ Finish ] button to generate the report. (Alternatively use the [ < Back ] button to revise the inputs or the [ Cancel ] button to cancel report generation.)
Output
Single Meta-Network.

Measures and Algorithms Used

Measures
View report to measure table | View measure to report table

Algorithms
Information is not available at this time.

Special Considerations
None.

References
None.
I. Command Line Arguments

The program ora.exe (henceforth called ORA) takes one or more of the following command line arguments as input: (1) Measures File to be used, (2) the Script File to use, and (3) the Log File to use.

If you installed the front-end of ORA, then the executable can be found as:
[ORA installation directory]\include\OraFiles\bin\ora.exe

Likewise, the Measures file can be found as:
[ORA installation directory]\include\OraFiles\xml\ora_xml_measures.xml

Measures File

The Measures File is distributed with ORA and contains an XML encoded description of all the measures available to ORA. This is distributed with ORA and is usually called ora_xml_measures.xml. The following command line parameter specifies the filename:

-measures <filename>

Script File

The Script File is an XML file created by the user and tells ORA where to load the input network data and which reports to generate. Section II - ORA Script XML Specification - describes in detail the format of this XML script. The following command line argument specifies the filename:

-script <filename>

Log File

The Log File is generated by ORA to record the progress and problems of ORA in processing the Script File. The log file is a text file, and the following command line argument specifies its filename:

-log <filename>
Help

A listing of the above parameters is available by using the following command line parameter:

-help

Version

The ORA version can be obtained by the following command line parameter:

-version

II. XML Script

The batch mode script is a user supplied XML document that is input to ORA (see the -script command line parameter above). It tells ORA what network data to load and what reports to generate.

Please note the following general guidelines for the script:

1. Camel case capitalization is used for element names: therefore element names begin lower case and the first letter of each word is capitalized. For example, meta-network is metaNetwork.

2. Default values are used: therefore a short, simple script can initially be used to run ORA. Advanced users can change the default values.

The root n is <ora>, which has two child elements <input> and <output>. The input element describes the network data to load, and the output section describes the reports to generate.

Example: an empty script
<ora>
<input/>
<output/>
</ora>

A. Input Section

The main unit of input to ORA is the meta-network, and therefore the input section of the XML script tells ORA how to load one or more meta-networks. A meta-network is simply an organization modeled as a collection of matrices. The entire meta-
network can be loaded from a single data file, or each matrix can be loaded from separate data files with possibly different data formats.

1. Meta-Network Specification

A meta-network is specified by the <Meta-Network> element. It accepts a single attribute called id which must be unique across all the meta-network elements.

The child elements describe the location and format of its matrix data. There are two cases: (1) all data for the meta-network is stored in a single file, (2) the data for matrices of the meta-network are located in separate files.

1.1 Meta-Network data in a single file

The first case is only possible for a data file in the DyNetML format. In this case, the <filename> and <format> children are required, and the <properties> child is optional. The child elements are described below:

filename : location of the data
format : must be dynetml
properties : [optional] Describes how ORA should interpret the data read from the file, but does not cause ORA to modify the input data in any way. Each graph in the meta-network is given the property.

Properties are specified with the attributes below, each of which takes values: yes or no

1. sparse: indicates whether the data is sparse
2. binary: indicates whether the data should be treated as binary (i.e. ignore edge weights)
3. symmetric: indicates whether the unimodal graphs should be considered symmetric
4. diagonal: indicates whether the diagonal values of unimodal graphs should be used

Example:
<Meta-Network id="Organization">
  <filename>data/organization.xml</filename>
  <format>dynetml</format>
  <properties binary="yes"/>
</Meta-Network>

1.2 Meta-Network data in multiple matrix files

The second case has the meta-network data located in multiple files. In this case, the script must describe how to assemble the meta-network from different data files.
Matrix data describes a relationship between two sets of nodes, called the source and target nodesets. Therefore, in specifying a matrix, these nodesets must be specified. A unique id for the matrix is also specified. This id must be unique across all matrices in the meta-network.

The `<matrix>` element defines a matrix and has the following case-insensitive attributes:

- `sourceType` : type of the source nodeset
- `source` : [optional] unique identifier of the source nodeset
- `targetType` : type of the target nodeset
- `target` : [optional] unique identifier of the target nodeset
- `id` : [optional] id of the matrix

The above attributes can be any string.

The `sourceType` and `targetType` attributes specify the class or general category of the nodesets. By convention, these are taken from Agent, Knowledge, Resource, Task, Location, or Organization, but any string can be used.

The `source` and `target` attributes uniquely identify the source and target nodesets, and if they are not specified the `sourceType` and `targetType` are used. To have more than one nodeset of a given type (e.g. "blue" agents and "red" agents), the `source` attribute must be used.

The `id` uniquely identifies the matrix within the collection of matrices that is the meta-network. By default, the `id` is constructed from the `source` and `target` types.

Examples:

```
<matrix sourceType="agent" targetType="agent" id="reports to"/>
```

```
<matrix sourceType="agent" source="employee" targetType="agent" target="employee" id="works with"/>
```

As in the first case, the `<matrix>` element must have the child elements `<filename>` and `<format>` that describe the location and format of the matrix data. The `<properties>` element is optional, and pertains only to the matrix.

The `<format>` element takes one of the following values:

- `dynetml` : DyNetML specified data
- `ucinet` : UCINET binary format (refer to UCINET documentation)
- `dl` : UCINET text format (refer to UCINET DL documentation)
- `csv` : CSV (Comma Separated Values) allows row and/or column labels
- `raw` : space, comma, or semi-colon separated data (no labels allowed)
Example:
<Meta-Network id="SampleOrganization">
<matrix sourceType="agent" targetType="agent" id="communication">
    <filename>data/organization_agent_agent.dl</filename>
    <format>dl</format>
</matrix>
</Meta-Network>

Multiple <matrix> elements are used to define the constituent matrices of the meta-network. Note that <Meta-Network> has no immediate <filename> and <format> children since the data is described under the <matrix> child elements.

Example:
<ora>
    <input>
        <Meta-Network id="SampleOrganization">
            <matrix sourceType="agent" targetType="agent" id="social">
                <filename>data/organization_agent_agent.dl</filename>
                <format>dl</format>
            </matrix>
            <matrix sourceType="agent" targetType="knowledge">
                <filename>data/organization_agent_knowledge.dl</filename>
                <format>dl</format>
            </matrix>
        </Meta-Network>
    </input>
</ora>

In the example, the meta-network contains two matrices: the first of type Agent x Agent and named social, and it is populated with data from the specified file of the specified format. The second has type Agent x Knowledge, and no name is specified.

1.3 Multiple Meta-Networks

Multiple meta-networks can be specified in the <input> section using unique id attributes.

Example: multiple meta-networks differentiated by id attribute
<ora>
    <input>
        <Meta-Network id="SampleOrganization1">
            <matrix sourceType="agent" targetType="agent" id="social">
                <filename>data/organization_agent_agent.dl</filename>
                <format>dl</format>
            </matrix>
        </Meta-Network>
    </input>
</ora>
1.4 Meta-Network Directories

If there are multiple DyNetML files in a single directory, then one can specify the directory and ORA will create a meta-network from each file. The `<Meta-NetworkDirectory>` element is used, whose only attribute is name that specifies the path of the directory. Each file must have .xml extension. A `<transform>` element can be used within the element to apply to each meta-network. The id for each meta-network is its filename.

Example: load all meta-networks from a directory

```xml
<ora>
<input>
<Meta-NetworkDirectory name="data/sample/>
<transform>
<conform method="union"/>
</transform>
</Meta-NetworkDirectory>
</input>
</ora>
```

B. Output Section

The second section of the script file is the `<output>` element, and it describes which reports to generate. The reports available in ORA and how to specify them in the ora-script is documented in the file ORA-batch-mode-parameters.xml, which is an XML specification in Relax-NG.

Ora-Script Report Generation
To tell ORA to create a report, the `<reports>` child element is used in the ora-script.
The `<reports>` child element contains a collection of `<report>` elements. Each report element specifies any input parameters, the output filename, and the output file type/format. Each `<report>` is uniquely identified by its id attribute.

The `<filename>` child specifies the name of the output file to create. The filename should NOT have an extension. The `<formats>` child contains one or more `<format>` children which specify the format of the report output.

For each report, the possible formats are: text, html, csv, dynetml

Example: generating a report in multiple output formats
```
<report id="intelligence">
  <filename>reports/intelligence</filename>
  <formats>
    <format>text</format>
    <format>csv</format>
  </formats>
</report>
```

Any report specific parameters are designated within the `<parameters>` child. The parameters for each report are documented in the file: `ora_xml_measures.xml`

Example: specifying report parameters
```
<report id="intelligence">
  <parameters>
    <numberOfKeyEntities>10</numberOfKeyEntities>
  </parameters>
  <filename>reports/intelligence</filename>
  <formats>
    <format>html</format>
    <format>csv</format>
  </formats>
</report>
```

Example: shorter script if only one output format is specified
```
<report id="intelligence" filename="reports/intelligence" format="text">
  <parameters>
    <numberOfKeyEntities>10</numberOfKeyEntities>
  </parameters>
</report>
```

3. Saving Meta-Networks

The input meta-networks can themselves be saved to files. This allows for converting between matrix formats and for saving transformed or conformed input data.
Example: saving a specific meta-network
<ora>
<output>
<Meta-Networks>
<Meta-Network id="sample">
<filename>data/output/sample.xml</filename>
<format>dynetml</format>
</Meta-Network>
</Meta-Networks>
</output>
</ora>

Only the specified meta-networks will be saved. Individual matrices can be saved using the syntax identical to that of the <matrix> element in the input section. The following, for example, saves the agent x agent matrix:

Example: saving a specific matrix from a meta-network
<ora>
<output>
<Meta-Networks>
<Meta-Network id="sample">
<matrix sourceType="agent" targetType="agent">
<filename>data/output/sample_agent_agent.dl</filename>
<format>dl</format>
</matrix>
</Meta-Network>
</Meta-Networks>
</output>
</ora>

In addition, network set operations (union, intersection, difference) can be performed on the input networks and then saved. The sample below assumes that there were two meta-networks specified in the <input> section, namely, A and B, and the set operations all pertain to them. Union and Intersect operate on one or more input meta-networks, and the parameter method indicates how to handle common edges. The method attribute takes on one of the following values: binary, sum, maximum, or minimum. The difference between two meta-networks is taken with respect to edges only, and thus no nodes are removed.

Example: saving union of multiple input meta-networks
<output>
<Meta-Networks>
<!--Union-->
<Meta-Network id="A Union B">
</Meta-Network>
</Meta-Networks>
</output>
</ora>
4. Transform Element

The transform element is used to pre-process a meta-network or an individual matrix of a meta-network before generating reports. It transforms its parent element. For example, if the <transform> element is a child of a <matrix> then it applies to that matrix. If it is a child of <Meta-Network>, then it transforms the entire meta-network: for nodeset modifications (removeNodes, subsetNodes, conform), these apply to the meta-network as a whole, but transformations of edges (symmetrizing, dichotomizing) are applied to each matrix independently.

The <transform> element has the following child elements that define the transformation:

<transpose> : transpose the graph
<removeIsolates> : remove isolate nodes

<removePendants> : remove pendant nodes

<symmetrize method=""/> : symmetrize using one of two methods
   “union” : symmetrize using the union/maximum method
   “intersect” : symmetrize using the intersect/minimum method
Default is “union”.

<subsetNodes> : defines a subset of nodes to create a subgraph
   contains one or more of the following child elements:
   <nodeSet type=""/> : adds all nodes in the specified nodeset to the subset.
   The type attribute can have values: agent, knowledge, resource, task, organization

   <node type="""" id="""" radius=""""/> : adds the specified node to the subset
   The type attribute is identical to that of the <nodeSet> element.
   The id attribute is the node’s unique id within the nodeset.
   The radius attribute is optional (by default it is zero), and includes all nodes within a
distance <= radius of the node. This is useful for defining ego nodesets.

<removeNodes> : defines a subset of nodes to remove
   contains the same <nodeSet> and <node> child elements as subsetNodes

<conform method=""""/> : creates an identical set of nodes across meta-networks. This
   is useful for time-series data to give each meta-network the same nodesets. The union
   method adds isolates to achieve identical sets, and the intersect method removes
   nodes.
   The method attribute can have one of two values:
   union: create union of nodesets
   intersect: create intersection of nodesets
   Default is "union".
   By default the agent, knowledge, resource, task, and organization nodesets are
   conformed. This can be customized by adding <nodeSet> child elements to specify
   specific nodesets, as in subsetNodes above.

<dichotomize criteria="""" cutoff=""""/> : creates a binary graph according to the criteria
   and cutoff. Any edges whose value does not satisfy the criteria and cutoff are given a
   value of 0, otherwise a value of 1.
The criteria attribute takes one of the following values: lessThan, lessThanEquals, equals, greaterThanEquals, greaterThan.

The cutoff attribute can be any numerical value.

Precedence
The order (i.e. precedence) in which the transformations occur is as follows: (1) individual matrices, (2) meta-networks, (3) across meta-networks. Each of these usages is in the examples below.

The precedence of operations within a transform (for example, is the graph symmetrized before dichotomizing, etc.) is defined to be the same as they are specified in the <transform> element. Thus, if the <symmetrize> child is before the <dichotomize> child, then the transformation first symmetrizes and then dichotomizes.

Example: remove all agent nodes and the specified knowledge nodes from the meta-network
<Meta-Network id="test">
<transform>
<removeNodes>
<nodeset id="agent"/>
<nodeset id="knowledge" id="physics"/>
<nodeset id="knowledge" id="mathematics "/>
</removeNodes>
</transform>
<filename>data/sample.xml</filename>
<format>dynetml</format>
</Meta-Network>

Example: symmetrize a single matrix of the meta-network
<Meta-Network id="test">
<matrix sourceType="agent" targetType="agent">
<filename>data/aa.csv</filename>
<format>csv</format>
<transform>
<symmetrize method="union"/>
</transform>
</matrix>
<matrix sourceType="agent" targetType="knowledge">
<filename>data/ak.csv</filename>
<format>csv</format>
</matrix>
</Meta-Network>
This example creates a sub-meta-network as follows: a set of nodes is defined, and then the meta-network induced by the nodes (that is, all the edges incident upon those nodes). The set of nodes consists of all nodes within distance 2 of agent Andy and within distance one of Sam. Because the transform is part of the meta-network, knowledge, task, or organization nodes can be connected to these agents, and would therefore be part of the set.

Example: define a subset of nodes

```xml
<Meta-Network id="test">
  <transform>
    <subsetNodes>
      <node nodesetId="agent" id="Andy" radius="2"/>
      <node nodesetId="agent" id="Sam" radius="1"/>
    </subsetNodes>
  </transform>
  <filename>/data/myorg.xml</filename>
  <format>dynetml</format>
</Meta-Network>
```

This example makes the agent nodes in the meta-networks conformable by creating the union of all the agent nodesets across the meta-networks. Currently, only agent nodes can be made conformable.

Example: conform nodesets across meta-networks

```xml
<input>
  <transform>
    <conform method="union"/>
  </transform>
  <Meta-Network id="org1">
    <filename>data/org1.xml</filename>
    <format>dynetml</format>
  </Meta-Network>
  <Meta-Network id="org2">
    <filename>data/org2.xml</filename>
    <format>dynetml</format>
  </Meta-Network>
  <Meta-Network id="org3">
    <filename>data/org3.xml</filename>
    <format>dynetml</format>
  </Meta-Network>
</input>
```
Bibliography


**Mixture of Topological Forms**


1775


**Circle / Wheel**


**Matrix**


**Hierarchy**


**Core-Periphery**


**Random**


**Small-World**


**Bow-Tie**

Cellular


Scale-Free


Complex Networks (Statistical Mechanics)


**Network Processes**


# Java Libraries

This table shows the Java libraries that are used within ORA.

<table>
<thead>
<tr>
<th>Library</th>
<th>Name / Website / License</th>
</tr>
</thead>
</table>
| activation      | JavaBeans Activation Framework  
Sun Microsystems, Inc. Binary Code License Agreement |
| ant-launcher    | Ant Laucher  
http://ant.apache.org  
The Apache Software License, Version 2.0 |
| ant-optional-1.5.1 | Ant Optional  
http://ant.apache.org  
The Apache Software License, Version 1.1 |
| batik-awt-util-1.6 | Batik AWT Utilities  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-bridge-1.6 | Batik Bridge  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-css-1.6    | Batik CSS  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-dom-1.6    | Batik DOM Implementation  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-ext-1.6    | Batik Extension  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-gvt-1.6    | Batik Graphics Vector Tree  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-parser-1.6 | Batik Parser  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
| batik-script-1.6 | Batik Script  
http://xmlgraphics.apache.org/batik/  
The Apache Software License, Version 2.0 |
<table>
<thead>
<tr>
<th>Package</th>
<th>Description</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>batik-svdom-1.6</td>
<td>Batik SVG DOM</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>batik-svgen-1.6</td>
<td>Batik SVG Generator</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>batik-transcoder-1.6</td>
<td>Batik Transcoder</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>batik-util-1.6</td>
<td>Batik Utilities</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>batik-xml-1.6</td>
<td>Batik XML</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>casosparser</td>
<td>CASOS Parser</td>
<td></td>
</tr>
<tr>
<td>colt</td>
<td>Colt</td>
<td></td>
</tr>
<tr>
<td>common-2.1.0</td>
<td>Commons</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-beanutils-1.4</td>
<td>Commons BeanUtils</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-cli-1.2</td>
<td>Commons CLI - Command Line Interface</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-cli-2.0-gt2-pre1</td>
<td>Commons CLI - Command Line Interface</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-codec-1.4</td>
<td>Commons Codec</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-collections-3.1</td>
<td>Commons Collections</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>commons-httpclient-3.1</td>
<td>Commons HttpClient</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>commons-io-1.2</td>
<td>Commons I/O Utilities</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-jxpath-1.2</td>
<td>Commons JXPath</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-lang-2.1</td>
<td>Commons Lang</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-logging-1.1.1</td>
<td>Commons Logging</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-logging-api-1.1.1</td>
<td>Commons Logging API</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-math-1.2</td>
<td>Commons Math</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>commons-pool-1.3</td>
<td>Commons Pool</td>
<td>The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>concurrent-1.3.4</td>
<td>Java Concurrency</td>
<td>Java 2 Platform SE 5.0</td>
</tr>
<tr>
<td>db2jcc_dummy-8.2.1</td>
<td>DB2 Spatial Data</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>dnsjava-2.0.8</td>
<td>DNS in Java</td>
<td>BSD license</td>
</tr>
<tr>
<td>dom4j-1.6.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ecore-2.1.0</td>
<td>Ecore</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>facebook-java-api-1.8-final</td>
<td>Facebook Java API</td>
<td>MIT License</td>
</tr>
<tr>
<td>facebook-util-1.8-final</td>
<td>Facebook Companion Utility</td>
<td></td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>freehep-graphics2d-2.0</td>
<td>FreeHEP 2D Graphics</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-graphicsio-2.0</td>
<td>FreeHEP GraphicsIO</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-graphicsio-pdf-2.0</td>
<td>FreeHEP GraphicsIO PDF</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-graphicsio-svg-2.0</td>
<td>FreeHEP GraphicsIO SVG</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-io-2.0.1</td>
<td>FreeHEP IO</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-util-2.0.1</td>
<td>FreeHEP Utilities</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>freehep-xml-2.0.1</td>
<td>FreeHEP XML</td>
<td>GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1</td>
</tr>
<tr>
<td>geoapi-nogenerics-2.1-M2</td>
<td>GeoAPI</td>
<td>GNU Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>geowidgets-1.0-M1</td>
<td>GeoWidgets</td>
<td>GNU Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>geronimo-stax-api_1.0_spec-1.0</td>
<td>GlueGen</td>
<td>BSD license</td>
</tr>
<tr>
<td>gluegen-rt</td>
<td>GlueGen</td>
<td>BSD license</td>
</tr>
<tr>
<td>gt2-api-2.3.3</td>
<td>GeoTools API</td>
<td></td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>gt2-arcgrid-2.3.3</td>
<td>GeoTools ArcGrid</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-arcsde-2.3.3</td>
<td>GeoTools ArcSDE</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-brewer-2.3.3</td>
<td>GeoTools Brewer</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-coverage-2.3.3</td>
<td>GeoTools Coverage</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-coveragetools-2.3.3</td>
<td>GeoTools Coverage Tools</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-cql-2.3.3</td>
<td>GeoTools CQL</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-db2-2.3.3</td>
<td>GeoTools DB2</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-demo-data-2.3.3</td>
<td>GeoTools Data Demo</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-demo-mappane-2.3.3</td>
<td>GeoTools MapPane</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-demo-property-2.3.3</td>
<td>GeoTools Property Demo</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-directory-2.3.3</td>
<td>GeoTools Directory</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-epsg-access-2.3.3</td>
<td>GeoTools EPSG Access</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-epsg-hsql-2.3.3</td>
<td>GeoTools EPSG-HSQL</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>Package</td>
<td>Description</td>
<td>URI</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>gt2-epsg-postgresql-2.3.3</td>
<td>GeoTools ESPG PostreSQL</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-epsg-wkt-2.3.3</td>
<td>GeoTools ESPF-WKT</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-geomedia-2.3.3</td>
<td>GeoTools Geomedia</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-geotiff-2.3.3</td>
<td>GeoTools GeoTIFF</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-gml-2.3.3</td>
<td>GeoTools GML</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-go-2.3.3</td>
<td>GeoTools Geospatial Object</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-graph-2.3.3</td>
<td>GeoTools Graph</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-gtopo30-2.3.3</td>
<td>GeoTools GTopo30</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-hsql-2.3.3</td>
<td>GeoTools HQSL</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-image-2.3.3</td>
<td>GeoTools Image</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-imagemosaic-2.3.3</td>
<td>GeoTools ImageMosaic</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-imagepyramid-2.3.3</td>
<td>GeoTools ImagePyramid</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-indexed-shapefile-2.3.3</td>
<td>GeoTools Indexed Shapefile</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-main-2.3.3</td>
<td>GeoTools Main</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>Processor</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>gt2-mappane-2.3.3</td>
<td>GeoTools MapPane</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-mif-2.3.3</td>
<td>GeoTools MIFFile</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-mysql-2.3.3</td>
<td>GeoTools MySQL</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-openoffice-2.3.3</td>
<td>GeoTools OpenOffice</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-oracle-spatial-2.3.3</td>
<td>GeoTools Oracle Spatial</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-postgis-2.3.3</td>
<td>GeoTools PostGIS</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-referencing-2.3.3</td>
<td>GeoTools Referencing</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-referencing3D-2.3.3</td>
<td>GeoTools Referencing 3D</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-render-2.3.3</td>
<td>GeoTools Render</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-sde-dummy-2.3.3</td>
<td>GeoTools SDE Dummy</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-shapefile-2.3.3</td>
<td>GeoTools Shapefile</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-shapefile-renderer-2.3.3</td>
<td>GeoTools Shapefile Renderer</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-svgsupport-2.3.3</td>
<td>GeoTools SVG Support</td>
<td><a href="http://geotools.org/">http://geotools.org/</a></td>
</tr>
<tr>
<td>gt2-tiger-2.3.3</td>
<td>GeoTools Tiger</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>gt2-validation-2.3.3</td>
<td>GeoTools Validation</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-vpf-2.3.3</td>
<td>GeoTools Vector Product Format</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-wfs-2.3.3</td>
<td>GeoTools Website Feature Server</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-widgets-swing-2.3.3</td>
<td>GeoTools Swing Widgets</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-wms-2.3.3</td>
<td>GeoTools Web Map Service</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-xml-2.3.3</td>
<td>GeoTools XML</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-xml-filter-2.3.3</td>
<td>GeoTools XML Filter</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-xml-gml2-2.3.3</td>
<td>GeoTools XML GML 2</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>gt2-xml-gml3-2.3.3</td>
<td>GeoTools XML GML 3</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>hsqldb-1.8.0.1</td>
<td>HyperSQL DataBase</td>
<td>BSD license</td>
</tr>
<tr>
<td>htmlparser</td>
<td>HTML Parser</td>
<td>Common Public License Version 1.0</td>
</tr>
<tr>
<td>httpclient-4.0-beta2</td>
<td>HttpClient</td>
<td>Apache License, Version 2.0</td>
</tr>
<tr>
<td>httpcore-4.0-beta3</td>
<td>HttpCore</td>
<td>index.html</td>
</tr>
<tr>
<td>Project Name</td>
<td>License Information</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>idw</strong></td>
<td>Adobe License. Links: <a href="http://hc.apache.org/httpcomponents-core-ga/httpcore-nio/index.html">idw</a></td>
<td></td>
</tr>
<tr>
<td><strong>imageioext-asciigrid-1.0-rc1</strong></td>
<td>Lesser General Public License (LGPL). Links: <a href="http://java.net/projects/imageio-ext/imageioext-asciigrid-1.0-rc1">imageioext-asciigrid-1.0-rc1</a></td>
<td></td>
</tr>
<tr>
<td><strong>imageioext-customstreams-1.0-rc1</strong></td>
<td>Lesser General Public License (LGPL). Links: <a href="http://java.net/projects/imageio-ext/imageioext-customstreams-1.0-rc1">imageioext-customstreams-1.0-rc1</a></td>
<td></td>
</tr>
<tr>
<td><strong>iText-2.1.0</strong></td>
<td>Affero General Public License. Links: <a href="http://itextpdf.com/">iText-2.1.0</a></td>
<td></td>
</tr>
<tr>
<td><strong>j3dcore</strong></td>
<td>Java Distribution License. Links: <a href="http://www.j3d.org/">j3dcore</a></td>
<td></td>
</tr>
<tr>
<td><strong>j3dutils</strong></td>
<td>Java Distribution License. Links: <a href="http://www.j3d.org/">j3dutils</a></td>
<td></td>
</tr>
<tr>
<td><strong>j3d-vrml97</strong></td>
<td>Java Distribution License. Links: <a href="http://www.j3d.org/">j3d-vrml97</a></td>
<td></td>
</tr>
<tr>
<td><strong>jai_codec</strong></td>
<td>Sun Microsystems, Inc. Binary Code License Agreement. Links: <a href="http://java.net/projects/jai/">jai_codec</a></td>
<td></td>
</tr>
<tr>
<td><strong>jai_core</strong></td>
<td>Sun Microsystems, Inc. Binary Code License Agreement. Links: <a href="http://java.net/projects/jai/">jai_core</a></td>
<td></td>
</tr>
<tr>
<td><strong>Jama-1.0.1</strong></td>
<td>GNU Lesser General Public License. Links: <a href="http://math.nist.gov/javanumerics/jama/">Jama-1.0.1</a></td>
<td></td>
</tr>
<tr>
<td>Package</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>java-getopt-1.0.13</td>
<td>Java GetOpt</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>javaml-0.0.12</td>
<td>Java Machine Learning Library</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jaxb-api-1.3</td>
<td>Java Architecture for XML Binding API</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jaxb-impl-1.3</td>
<td>Java Architecture for XML Binding Implementation</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jaxb-libs-1.3</td>
<td>Java Architecture for XML Binding Libraries</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>JAXWS2.1.3-20071218</td>
<td>Java API for XML Web Services</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jcommon-1.0.9</td>
<td>JCommon</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jdom-1.1</td>
<td>JDOM</td>
<td>JDOM License</td>
</tr>
<tr>
<td>jfreechart-1.0.13</td>
<td>JFreeChart</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jfreechart-1.0.13-swt</td>
<td>JFreeChart SWT</td>
<td>GNU Lesser General Public License</td>
</tr>
<tr>
<td>jgraphlayout</td>
<td>Java Graph Layout</td>
<td>BSD license</td>
</tr>
<tr>
<td>jhall</td>
<td>JavaHelp</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>License</td>
<td>URL</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td></td>
<td>GNU Lesser General Public License</td>
<td></td>
</tr>
<tr>
<td>jlfgr-1.0</td>
<td>Java Look and Feel Graphics Repository</td>
<td><a href="http://java.sun.com/developer/techDocs/hi/repository/">http://java.sun.com/developer/techDocs/hi/repository/</a></td>
</tr>
<tr>
<td></td>
<td>Java 2 Platform SE 5.0</td>
<td></td>
</tr>
<tr>
<td>jogl</td>
<td>Java OpenGL</td>
<td><a href="http://java.net/projects/jogl/">http://java.net/projects/jogl/</a></td>
</tr>
<tr>
<td></td>
<td>BSD license</td>
<td></td>
</tr>
<tr>
<td>jsi-generics</td>
<td>Java Spatial Index</td>
<td><a href="http://jsi.sourceforge.net/">http://jsi.sourceforge.net/</a></td>
</tr>
<tr>
<td></td>
<td>GNU Lesser General Public License</td>
<td></td>
</tr>
<tr>
<td>json-1.0</td>
<td>JSON in Java</td>
<td><a href="http://www.json.org/java/">http://www.json.org/java/</a></td>
</tr>
<tr>
<td></td>
<td>The JSON License</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Apache License, Version 2.0</td>
<td></td>
</tr>
<tr>
<td>jta-1.0.1B</td>
<td>Java Transaction API</td>
<td><a href="http://java.sun.com/products/jta/">http://java.sun.com/products/jta/</a></td>
</tr>
<tr>
<td></td>
<td>Java 2 Platform SE 5.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lesser General Public License (LGPL)</td>
<td></td>
</tr>
<tr>
<td>jung</td>
<td>Java Universal Network/Graph Framework</td>
<td><a href="http://jung.sourceforge.net">http://jung.sourceforge.net</a></td>
</tr>
<tr>
<td></td>
<td>The JUNG License</td>
<td></td>
</tr>
<tr>
<td>junit</td>
<td>JUnit Testing Framework</td>
<td><a href="http://junit.org">http://junit.org</a></td>
</tr>
<tr>
<td></td>
<td>JUnit Common Public License - v 1.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>JUnit Common Public License - v 1.0</td>
<td></td>
</tr>
<tr>
<td>kxml2-2.3.0</td>
<td>kXML 2</td>
<td><a href="http://kxml.sourceforge.net/kxml2/">http://kxml.sourceforge.net/kxml2/</a></td>
</tr>
<tr>
<td></td>
<td>BSD license</td>
<td></td>
</tr>
<tr>
<td>linkedin-j-android</td>
<td>LinkedIn for Android Java Wrapper</td>
<td><a href="http://m.linkedin.com/android">http://m.linkedin.com/android</a></td>
</tr>
<tr>
<td>Package</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>log4j-1.2.6</td>
<td>Log4j</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>mail</td>
<td>JavaMail</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>MDateSelector14-00347</td>
<td>MDate Selector</td>
<td>GNU Library or Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>omcorba</td>
<td>OpenMap CORBA Classes</td>
<td></td>
</tr>
<tr>
<td>omj3d</td>
<td>Java 3D Classes</td>
<td></td>
</tr>
<tr>
<td>omsvg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>opencsv-1.7</td>
<td>Open Source CSV Parser</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>openmap-4.6.5</td>
<td>OpenMap</td>
<td></td>
</tr>
<tr>
<td>picocontainer-1.2</td>
<td>PicoContainer</td>
<td>BSD License</td>
</tr>
<tr>
<td>poi-scratchpad-3.7.20101029</td>
<td>Apache POI Scratchpad</td>
<td></td>
</tr>
<tr>
<td>Package</td>
<td>Description</td>
<td>License</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>postgis-driver-1.0</td>
<td>PostGIS</td>
<td>GNU General Public License</td>
</tr>
<tr>
<td>postgresql-8.1-407.jdbc3</td>
<td>PostgreSQL JDBC Driver</td>
<td>BSD License</td>
</tr>
<tr>
<td>relaxngDatatype-X</td>
<td>Oracle Containers for Java</td>
<td>Java 2 Platform SE 5.0</td>
</tr>
<tr>
<td>rome-1.0</td>
<td>Rome</td>
<td>Apache Software License Version 1.1</td>
</tr>
<tr>
<td>rssutils</td>
<td>RSS Utilities</td>
<td>Java 2 Platform SE 5.0</td>
</tr>
<tr>
<td>signpost-core-1.2.1.1</td>
<td>Signpost</td>
<td>The Apache Software License, Version 2.0</td>
</tr>
<tr>
<td>spatialdb-0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>svgSalamander-tiny</td>
<td>SVG Salamander</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>swingx-1.0</td>
<td>SwingX 1.0</td>
<td>Lesser General Public License (LGPL)</td>
</tr>
<tr>
<td>TableLayout</td>
<td>TableLayout</td>
<td>Java 2 Platform SE 5.0</td>
</tr>
<tr>
<td>toolkits_1-2-0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>trove-2.0.4</td>
<td>Trove</td>
<td>Lesser GNU Public License (LGPL)</td>
</tr>
<tr>
<td>twitter4j-1.1.7</td>
<td>Twitter4J</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Description</td>
<td>License Link</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>vecmath-1.3.1</td>
<td>Java 3D Vecmath</td>
<td><a href="http://java.sun.com/products/java-media/3D/Java">http://java.sun.com/products/java-media/3D/Java</a> 2 Platform SE 5.0</td>
</tr>
<tr>
<td>velocity-1.4</td>
<td>Velocity</td>
<td><a href="http://velocity.apache.org/%22Th">http://velocity.apache.org/&quot;Th</a> Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>worldwind-0.6.430.13251</td>
<td>NASA World Wind</td>
<td><a href="http://worldwind.arc.nasa.gov/java/NASA">http://worldwind.arc.nasa.gov/java/NASA</a> OPEN SOURCE AGREEMENT VERSION 1.3</td>
</tr>
<tr>
<td>velocity-dep-1.4</td>
<td>Velocity</td>
<td><a href="http://velocity.apache.org/%22Th">http://velocity.apache.org/&quot;Th</a> Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>xercesImpl-2.7.1</td>
<td>Xerces Implementation</td>
<td><a href="http://xerces.apache.org/xerces2-j/">http://xerces.apache.org/xerces2-j/</a> The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>xml-apis-1.0.b2</td>
<td>XML APIs</td>
<td><a href="http://xml.apache.org/commons/">http://xml.apache.org/commons/</a> The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>xml-apis-xerces-2.7.1</td>
<td>Xerces XML APIs</td>
<td><a href="http://xerces.apache.org/xerces2-j/install.html">http://xerces.apache.org/xerces2-j/install.html</a> The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>xml-beans-2.3.0</td>
<td>XML APIs</td>
<td><a href="http://xml.apache.org/commons/">http://xml.apache.org/commons/</a> The Apache Software License, Version 2.0&quot;</td>
</tr>
<tr>
<td>xml-writer</td>
<td>XML Writer</td>
<td><a href="http://download.oracle.com/javase/1.5.0/docs/api/javax/sql/rowset/spi/XmlWriter.html">http://download.oracle.com/javase/1.5.0/docs/api/javax/sql/rowset/spi/XmlWriter.html</a> Java 2 Platform SE 5.0</td>
</tr>
</tbody>
</table>
Glossary

Adjacency Matrix: A matrix that is a square actor-by-actor (i=j) matrix where the presence of pair wise links are recorded as elements. The main diagonal, or self-tie of an adjacency matrix is often ignored in network analysis.

Aggregation: Combining statistics from different nodes to higher nodes.

Algorithm: A finite list of well-defined instructions for accomplishing some task that, given an initial state, will terminate in a defined end-state.

Agent: An agent, is an information processing entity. The most common agents are people. For some research questions, however, it may be useful to make these agents decision entities characterized by role, e.g., registered nurse and doctor. For other research questions, it make make sense to treat the agents as decision making units, like alpha=unit. For other research, the agents might be specific animals, or robots, or other types of actors. Researchers disagree as to whether all agents in the same entity class should be at the same level, e.g., all people, or whether different levels can be mixed such as people and decision units. The key is that an agent is an actor that can act in isolation and is not, for the purpose of the research, subdividable into parts nor has members.

Agent-Generic: Agent-generic are general classes of agents. These can represent the role or an attribute by which an agent is characterized. Examples include american, girl, child, nurse, president.

Agent-Specific: Agent-specific are specific agents. They are generally names entities representing a unique actor. Examples include George_Washington, Red_Deer_0001012.

Asymmetric Networks: Asymmetric are also called Directed Networks where there can be a link $e_{uv}$ is not necessarily equal to link $e_{vu}$ and infact this second link need not even exist.

Attribute: Indicates the presence, absence, or strength of a particular connection between nodes in a network. It can also be information about the specifics of the
agents. These are usually traits that agents have in common, each can be slightly different (e.g. visible traits like hair colour or intangible traits like religious beliefs).

Betweenness : Degree an individual lies between other individuals in the network; the extent to which a node is directly connected only to those other nodes that are not directly connected to each other; an intermediary; liaisons; bridges. Therefore, it's the number of nodes who a node is connected to indirectly through their direct links.

Betweenness Centrality : High in betweenness but not degree centrality. This node connects disconnected groups, like a Go-between.

Bimodal Network : A network most commonly arising as a mixture of two different unimodal networks*.

Binarize : Divides your data into two sets; zero or one.

Binary Network : A binary network is constructed by binary values (either 1 or 0) in its network matrix and contains only information whether a link between two entities in the network exists.

Bipartite Graph : Also called a bigraph. It's a set of nodes decomposed into two disjoint sets such that no two nodes within the same set are adjacent.

CAESAR III : An application for the design of information processing and decision making organizations. An application for the design of decision making organizations at the operational and tactical levels; it takes into consideration cultural differences in coalitions and of adversaries. This tool is under development by George Mason University.

Categorical : An Attribute Type used primarily used for grouping nodes.

Centrality : The nearness of a node to all other nodes in a network. It displays the ability to access information through links connecting other nodes. The closeness is the inverse of the sum of the shortest distances between each node and every other node in the network.

Centralization : Indicates the distribution of connections in the employee communication network as the degree to which communication and/or information flow is centralized around a single agent or small group.
Characteristic Path Length: The average length of the shortest distance connecting each employee to all other employees. If the links are binary, then the shortest distance is the number of links between them.

**Interpretation:** Characteristic path length gives an insight into how information spreads. It reflects the communication performance of the entire network and is important for diffusing information and routing information to the right people. A small average path length results in fewer "hops" where individuals or groups don't get information.

Classic SNA density: The number of links divided by the number of possible links not including self-reference. For a square matrix, this algorithm first converts the diagonal to 0, thereby ignoring self-reference (a node connecting to itself) and then calculates the density. When there are N nodes, the denominator is (N*(N-1)). To consider the self-referential information use general density.

Clique: A sub-structure within a network that is defined as a set of three or more nodes where every node is connected to every other node which cannot be made larger by adding another node.

Clique Count: The count of cliques for an entity. A network-level clique count is the total number of distinct cliques in the network. A node-level clique count is the number of distinct cliques the node is part of.

Closeness: node that is closest to all other nodes and has rapid access to all information.

Clustering coefficient: Used to determine whether or not a graph is a small-world network.

Cognitive Demand: Measures the total amount of effort expended by each agent to do its tasks.

Column Degree: see Out Degree.

Complexity: Complexity reflects cohesiveness in the organization by comparing existing links to all possible links in all four networks (employee, task, knowledge and resource).

Complementarity: The idea that people seek others with characteristics that are different from and complement their own, aka the idea that opposites attract.

Concor Grouping: Concor recursively splits partitions and the user selects n splits. (n splits -> 2^n groups). At each split it divides the nodes based on maximum correlation.
in outgoing connections. Helps find groups with similar roles in networks, even if
dispersed.

Congruence: The match between a particular organizational design and the
organization's ability to carry out a task.

Construct: A reduced form of Construct is found in ORA in the Near Term Impact
Report.

Continuous: A Attribute Type primarily used for values that are numerical so that
statistical analysis can be be performed (Average, Minimum, Maximum, and
Standard Deviation).

Count: The total of any part of a Meta-Network row, column, node, link, isolate, etc.

CSV: File structure meaning Comma Separated Value. Common output structure
used in database programs for formatting data.

Degree: The total number of links to other nodes in the network.

Degree Centrality: a node with the most connections. (i.e. In the know). Identifying
the sources for intel helps in reducing information flow.

Density:

- **Binary Network**: The proportion of all possible links actually present in the
  Matrix.
- **Value Network**: The sum of the links divided by the number of possible
  links. (i.e. the ratio of the total link strength that is actually present to the total
  number of possible links).

Disconnected Network: If subsets of nodes are arranged in a way that all nodes of
group A are unreachable from all nodes from group B and vice versa, the network is
disconnected. Therefore, there is no link connecting any pair of nodes between the
subsets of nodes.

Dyad: Two nodes and the connection between them.

Dyadic Analysis: Statistical analysis where the data is in the form of ordered pairs or
dyads. The dyads in such an analysis may or may not be for a network.
Dynamic Network Analysis : Dynamic Network Analysis (DNA) is an emergent scientific field that brings together traditional Social Network Analysis* (SNA), Link Analysis* (LA) and multi-agent systems (MAS).

DyNetML : DyNetML is an xml based interchange language for relational data including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal data interchange format to enable exchange of rich social network data and improve compatibility of analysis and visualization tools.

E | Top

Edge : See Link.

Ego Network : A one-mode network, containing a selected node of interest (ego) and the set of all nodes (alters) directly connected to the ego node along with the connections to/from the ego and alters. By convention, when multi-mode data is used or nodes not directly connected to the ego are included, the resulting meta-network is referred to as a sphere of influence* rather than an ego network.

Eigenvector Centrality : Node most connected to other highly connected nodes. Assists in identifying those who can mobilize others.

Entity Class (same as Ontology class) : The group of nodes that exist in the same domain and are connected to one another. It's a simplified way of viewing the information.

Event : Something that happens, especially something of importance. Events are usually thought of as a public occasions but they can also be clandestine meetings. The number of agents can range in the thousands or as few as two agents (e.g. Christmas in Times Square or dinner with friends).

Event-Generic : Something that occurs periodically (e.g. summer).

Event-Specific : One particular instance which may, or may not, be re-occurring. (e.g. Christmas 2011 or the 9/11 attacks).

F | Top

FOG : Fuzzy Overlapping Groups. Gives a better understanding of individuals spanning groups. Fuzzy groups are a more natural and compelling way of thinking of human social groups.

G | Top
General density: The number of links divided by the number of possible links including self-reference. For a square matrix, this algorithm* includes self-reference (a node connecting to itself) when it calculates the density. When there are N nodes, the denominator is (N*N). To ignore self-referential information use classic SNA* density.

Geodesic Distance: A generalization of the notion of a straight line to curved spaces. In presence of a metric, geodesics are defined to be (locally) the shortest path between points on the space.

Gini coefficient: The measure of inequality of a distribution of income. Uses a ratio with values between 0 and 1: the numerator is the area between the Lorenz curve of the distribution and the uniform (perfect) distribution line; the denominator is the area under the uniform distribution line.

Gower's Method: Gower's method is a frequently used measure of proximity for mixed data types. More…

Graph Level Metric: A metric defined for, and gives a value for, the network as a whole. The metric is calculated once for the network. Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness.

GraphML: GraphML is a comprehensive and easy-to-use file format for graphs. It consists of a language core to describe the structural properties of a graph and a flexible extension mechanism to add application-specific data.

Group: a collection of things (entities, nodes, ties, networks). A group might at times be represented as a meta-node*. Nodes may be classified in to groups on the basis of a shared attribute, type, id-range, label, user selection, etc. For example, if you have a set of people and know their gender, then their might be two groups - men and women. In addition the nodes representing those people could be displayed as a meta-node for men and a meta-node for women. Nodes may be classified in to groups on the basis of a grouping algorithm. For example, if you have a network showing connections among members of an organization and you run a grouping algorithm it will return clusters of nodes that fit together on some mathematical criteria. This cluster is a group and can be represented as a meta-node.

Hamming Distance: Number minimum number of substitutions required to change one string into another string of equal length. (e.g. "toned" and "roses" is 3.)
Heidarian Balance: A motivational theory of attitude change proposed by Fritz Heider, which conceptualizes the consistency motive as a drive toward psychological balance. (Also known as Balance Theory)

Heuristics: Problem-solving by trial and error: a method of solving a problem for which no formula exists, based on informal methods or experience, and employing a form of trial and error iteration.

Homophily: (love of the same) is the tendency of individuals to associate and bond with similar others.

- Status homophily means that individuals with similar social status characteristics are more likely to associate with each other than by chance.
- Value homophily refers to a tendency to associate with others who think in similar ways, regardless of differences in status.

HTML: HyperText Markup Language, a language used to specify information presentation structure (most frequently for web pages).

In-Degree: The sum of the connections leading to a node from other nodes. Sometimes referred to row degree.

Influence network: A network of hypotheses regarding task performance, event happening and related efforts.

Interstitial: An interstitial (something "in between") is a node situated within but not restricted to or characteristic of a particular group. It provides extra information to the analysis.

Isolate: any node which has no connections to any other node

Knowledge: Information learned such as a school lecture or knowledge learned from experience (e.g. Excellent knowledge of the periodic table or "I know what you did last summer").

Latent Semantic Analysis: Latent semantic analysis (LSA) is a technique in natural language processing, in particular in vectorial semantics, of analyzing relationships
between a set of documents and the terms they contain by producing a set of concepts related to the documents and terms.

Lattice Network: A graph in which the links are placed at the integer coordinate points of the n-dimensional Euclidean space and each node connects to nodes which are exactly one unit away from it.

Least Squares: The minimum of the sum of the squared deviations from the observed value, for a set of sums.

Link: These are the connections among nodes. An example is a connection between Deetee and United States indicating that she is a citizen of the country.

Link Analysis: A scientific area focused on the study of patterns emerging from dyadic observations. The relationships are typically a form of co-presence between two nodes. Also multiple dyads that may or may not form a network.

Link Class: A set of Links of one type. A set of links of one type can be represented as a meta-link.

Link Confidence: This is a second number associated with the link that specifies the degree of confidence in the presence of the link.

Link Direction: This defines whether the link implies a source-sink relation between the nodes, or is considered a simple link.

Link Type: This is the name given to this type of link. Link type is specified at the network level. An example of a type if friendship. A link type is defined by the two Node classes, the Name of the node classes, whether the links are directional or not.

Link Value: The strength of the link.

Location: An actual physical place. This could be a room in a building, a city, or a country (e.g. Pittsburgh, PA or my living room).

Location-Specific: A Named Entity which is a location (e.g. The Empire State Building).

Location-Generic: A location without a specific reference (e.g. a beach).

Lossy Intersection: Full intersection means that a node/link needs to be in 100% of the networks to be in the resulting network. Lossy intersection at X% percent means that a node/link needs to be in at least X% of the networks to be in the resulting network. Thus, Lossy intersection is a generalization of full intersection.
Main Diagonal: in a square matrix this is the conjunction of the rows and cells for the same node.

Math Terms: These mathematical terms and symbols are used:

Let S be any set:
- \( \text{card}(S) = |S| = \text{the cardinality of } S \)
  (the cardinality of the node-sets is represented as \(|A|, |K|, |R|, |T|\))
- ? denotes a real number
- \( Z \) denotes an integer

Matrix Algebra: The part of algebra that deals with the theory of matrices.

Maximum Likelihood Estimation (MLE): An analytic maximization procedure for selecting what probability distribution best fits the observed data by selecting the parameters for a model so as to maximize the model likelihood. NOTE: The larger the sample, the more powerful and precise the method.

Method of Moments (MOM): A computational method to obtain an approximation to the maximum likelihood estimation (MLE), by matching the mean and central moments of the fitted distribution to the mean and central moments of the observed distribution. Moments are used starting with the lowest order as lower moments are more stable. The order of moments is mean, variance, skewness, and finally kurtosis. (Pearson, 1985)

Measure: A measure is a function that maps one or more networks to \( \mathbb{R}^n \). Measures are often scalar (\( n=1 \)) or vector valued with \( n=|V| \) or \( n=|U| \).

Member Node: A node with a link to a meta-node.

Meta-Link: The representation of a group of links.

MetaMatrix: See Meta-Network


Meta-Node: this is a collection of nodes that can be treated as a node for purposes of visualization or analysis. For example, Deetee and Zebadiah could be combined into a single meta-node that we might label as friends. A meta-node can include all the nodes in a node class, in which case the meta-node and node-class will in a sense be indistinguishable.
Method of Least Squares (MLS): The method of least squares assumes that, given a set of observations, the best fitting curve is the curve that has the minimum sum of the deviations squared from the observations; i.e., the least squared errors. This method is typically used in regression analysis.

Monte Carlo: A random optimization of your organization

MRQAP - This describes a report in ORA. See Reports for more information. For multivariate cases, if your dependent variable is continuous or count data (like in a negative binomial case), you should use MRQAP. If your dependent variable is binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent to using a linear probability model). You do need to interpret your results accordingly.

Multi-Agent System: A loosely coupled network of problem-solver nodes that work together to find answers to problems that are beyond the individual capabilities or knowledge of each node.

Multi-node: More than one type of node (people, events, locations, etc.).

Multi-plex: Network where the links are from two or more relation classes.

Multimode Network: Where the nodes are in two or more node classes.

\( N \) | Top

Neighbors: nodes that share an immediate link to the node selected.

Network: The representation of a set of nodes (including meta-nodes) of one type and the links (including meta-links) of one type between them.

A network \( N \) is a triple consisting of two sets of nodes, called \( U \) and \( V \), and a set of links \( E \subseteq U \times V \). Thus, we write \( N=(U,V,E) \). An element \( e=(i,j) \) in \( E \) indicates a relationship or tie between nodes \( i \in U \) and \( j \in V \). A network where \( U=V \) and therefore \( E \subseteq V \times V \) is called \textit{unimodal*}; otherwise the network is \textit{bimodal*}. We write \( G=(V,E) \) for \textit{unimodal*} networks. For our purposes, unimodal networks will not contain self loops, which means that \( (i,i) \notin E \) for \( i \in V \).

Network Class: A set of Networks on one type. This can also be represented as a Meta-Network.
Network data format: usually comes in the form of NodeSet 1 listed vertically in column A starting in row 2 and NodeSet 2 listed horizontally in row 1 starting with column B. All the intersecting cells are the links between each of the nodes.

Newman Grouping: Finds unusually dense clusters, even in large networks.

Node: A representation of a single real-world or conceptual "thing" (a who, what, where, how, why item) representing people, organizations, beliefs, expertise, resource, tasks, events, locations, etc.

Node Attribute: Nodes can have a number of attributes. The possible attributes are specified at the Node Class level. For each attribute the user needs to specify a name, a mathematical type, and the possible values. As an example for the Node Class Agent the user specifies the attribute Gender, and the possible values of Male, Female, Mixed, Unknown. Then for the node Amy, the value for the attribute Gender is Female.

Node Class: This is the ontological category into which the associated node falls. ORA and AutoMap use these primary ontological categories - Agent, Organization, Knowledge, Resource, Belief, Event, Task, Location, Role, Action, Unknown.

Node-Generic: Generic entities are ones for which there are multiple instantiations; i.e., they represent a class.

Node ID: This is the unique to AutoMap/ORA ID of a node. This is usually not changed as it is used by ORA internally.

Node Level Metric: is one that is defined for, and gives a value for, each node in a network. If there are x nodes in a network, then the metric is calculated x times, once each for each node. Examples are Degree Centrality*, Betweenness*, and Cognitive Demand*.

Node Name: This is the label that the user assigns to a Node.

Nodeset: A set of nodes consisting of one Node Class.

Node Set Name: This is the label that the user assigns to a Node Set. The default is just to use the name of the node class. For example, the user could assign the name people to the node class agent.

Node-Specific: Specific entities are ones for which, within the bounds of the research project, there is exactly one entity that can be associated with that name.
Node Type (meta-type): This is the ontological level of the entity within its ontological category. There are ONLY two node types - specific and generic. This type applies only to the following categories - Agent, Organization, Location and Event. An entity is specific if there is one of those entities in the domain of study, otherwise it is generic. So Amy is a Node, of Node Class Agent, of Node Type Specific.

Normalized Sum: Otherwise known as the Average.

Notation: The following matrix notation is used throughout the document for an arbitrary matrix X:

- \( X(i,j) \) = the entry in the \( i^{\text{th}} \) row and \( j^{\text{th}} \) column of X
- \( X(i,:) \) = \( i^{\text{th}} \) row vector of X
- \( X(:,j) \) = \( j^{\text{th}} \) column vector of X
- \( \text{sum}(X) \) = sum of the elements in X (also, X can be a row or column vector of a matrix)
- \( \text{dich}(X) \) = dichotomize (make binary) X, so that \( \text{dich}(X)(i,j) = 1 \) iff \( X(i,j) > 0 \)
- \( X^\prime \) = the transpose of X
- \( \sim X \) = for binary X, \( \sim X(i,j) = 1 \) iff \( X(i,j) = 0 \)
- \( X@X \) = element-wise multiplication of two matrices (e.g. \( Z=X@Y \Rightarrow Z(i,j) = X(i,j)\times Y(i,j) \))

ODBC: Open Data Base Connectivity is an access method developed by the SQL Access group in 1992 whose goal was to make it possible to access any data from any application, regardless of which database management system (DBMS) is handling the data.

Ontology: "The Specifics of a Concept". The group of nodes, resources, knowledge, and tasks that exist in the same domain and are connected to one another. It's a simplified way of viewing the information.

Ontology Class (same as entity class): The group of nodes that exist in the same domain and are connected to one another. It's a simplified way of viewing the information.

Organization: A group of agents working together for a common cause (e.g. The Red Cross or the local chess club).

Organization-Specific: A Named Entity which is an organization (e.g. The Red Cross).
Organization-Generic: An organization without a specific reference (e.g. hospital).

Out-Degree: The sum of the connections leading out from a node to other nodes. This is a measure of how influential the node may be. Sometimes referred to as column degree.

Pajek: A visual tool for analyzing large networks (networks having thousands of vertices).

Path: A set of nodes and links that form a single unbroken chain, such that no node or link is repeated, e.g. A ? B ? C ? D ? E.

Pendant: Any node which is only connected by one link. They appear to dangle off the main group.

Percolation Theory: The behavior of connected clusters in a random network.

Pythia: Program used to create Influence Nets. Pythia is a timed influence net application. This tool can downloaded at the following URL: http://sysarch.gmu.edu/main/software/.

QAP Correlation: Calculates measures of nominal, ordinal, and interval association between the relations in two matrices, and uses quadratic assignment procedures to develop standard errors to test for the significance of association.

QAP is designed as a bivariate test (only two variables). Generally, QAP is perfectly fine for almost any bivariate network problem.

Random Graph: One tries to prove the existence of graphs with certain properties by assigning random links to various nodes. The existence of a property on a random graph can be translated to the existence of the property on almost all graphs using the famous Szemerédi regularity lemma*.

Reciprocity: The percentage of nodes in a graph that are bi-directional.

Redundancy: Number of nodes that access to the same resources, are assigned the same task, or know the same knowledge. Redundancy occurs only when more than one agent fits the condition.
Regression Analysis: This is used to understand which among the independent variables are related to the dependent variable, and to explore the forms of these relationships. In restricted circumstances, regression analysis can be used to infer causal relationships between the independent and dependent variables. The depend and the independent variables can be either network measure or numerical attributes of nodes. Used in Visualization/Measure Charts

Relation: The way in which nodes in one class relate to nodes in another class.

Resource: Can be either a physical or intangible object. Anything that can be used for the completion of a job. (e.g. Use a car to drive from point A to point B or use money from a bank account to fund something).

Robustness: Two different definitions:

- Networks: Concerned with the reliability (Kim & Médard, 2004) and continued functioning of a network following an intervention. The robustness of a network is particularly relevant in communication-type and flow-oriented networks. The purpose for understanding robustness of a network has more of a management of the network connotation.

- Measures: This meaning has more of a statistical connotation. Studying the robustness of a measure of a network can also be referred to as conducting a sensitivity analysis on the measure. In keeping with the terminology of the most-recently published research in this area, in lieu of using the term sensitivity, we too will use the robustness term, although the terms can be used interchangeably. A measure is robust if a slight perturbation in its input produces a slight change in its output.

Row Degree: see In Degree*.

S | Top

Scale-Free Network: Some nodes act as highly connected hubs (high degree), although most nodes are of low degree. Scale-free networks' structure and dynamics are independent of the system's size N, the number of nodes the system has. A network that is scale-free will have the same properties no matter what the number of its nodes is.

Self-Loop: A node with a connection to itself.

Self-Looped Network: Self-Loops are links from a node to itself. A self-looped network has therefore non-zero diagonal elements in the network matrix.
Shapefile: The GIS Visualizer can view overlay a Meta-Network over a map. The map is a shapefile: a digital vector storage format for storing geometric location and associated attribute information. A "shapefile" commonly refers to a collection of files with ".shp", ".shx", ".dbf", and other extensions on a common prefix name (e.g., "lakes.*"). For example, Shapefiles could represent water wells, rivers, and lakes, respectively. Each item may also have attributes that describe the items, such as the name or temperature.

Simmelian Ties: Two nodes are Simmelian Tied to one another if they are reciprocally and strongly tied to each other and strongly tied to at least one third party in common. It's a tie embedded in closed triples.

Simulated Annealing: A method of finding optimal values numerically. It's a search method as opposed to a gradient based algorithm. It chooses a new point, and (for optimization) all uphill points are accepted while some downhill points are accepted depending on a probabilistic criteria.

The term Simulated Annealing draws its inspiration from metallurgy, where atoms within a metal are heated thereby dislodging them from a metal's internal structure transforming the metal into another atomic state. In this way, your organization is heated changing its components in the attempt to arrive at an optimized state.

Slow Measures: As the name implies these measures generally take longer to run.

Small-World Network: Small-World Networks will have sub-networks that are characterized by the presence of connections between almost any two nodes within them.

Social Network Analysis: The term Social Network Analysis (or SNA) is used to refer to the analysis of any network such that all the nodes are of one type (e.g., all people, or all roles, or all organizations), or at most two types (e.g., people and the groups they belong to).

Sphere of Influence: A meta-network containing a selected node of interest (ego) and the set of all nodes (alters) within a specified path length (distance) from the ego node along with the connections to/from the ego and alters. Distance is the maximum number of allowed links from the ego to an alter; a distance of one means all alters are directly linked to ego. By convention, when one-mode data is used and the distance is set to one, the resulting meta-network is referred to as an ego network* rather than a sphere of influence.

Standard Deviation: The square root of the variance where variance is the average of the squared differences between data points.
.stl file format: This file format is native to the stereolithography CAD software created by 3D Systems. STL files describe only the surface geometry of a three-dimensional object without any representation of color, texture or other common CAD model attributes and can use both ASCII and binary representations.

Symmetric Networks: Any link in a network will have a reciprocal link. If there's a link from A to B then there will also be a link from B to A. Symmetric Networks have symmetric values about its diagonal.

Szemerédi’s Regularity Lemma: A fundamental structural result in extremal graph theory due to Szemerédi (1978). The regularity lemma essentially says that every graph can be well-approximated by the union of a constant number of random-like bipartite graphs, called regular pairs.

T | Top

Table data format: Table data usually contains a column with referencing IDs and headers denoting column names.

Task: A task is part of a set of actions which accomplish a job, problem or assignment. Task is a synonym for activity although the latter carries a connotation of being possibly longer duration (e.g.)

Tie: see Link

Time: Referring to time or circumstances. Can be as broad as a year or as pinpoint as the exact time of a particular day (e.g. Last year or 2:33 PM on March 1st, 2009).

Topology: The study of the arrangement or mapping of the elements (links, nodes, etc.) of a network, especially the physical (real) and logical (virtual) interconnections between nodes.

Total Degree Centrality: The normalized sum of a node's row and column degrees.

Trail: A set of nodes and links that form a single unbroken chain that can revisit nodes but not links, e.g. A ? B ? C ? A ? D.

Transpose: In linear algebra, the transpose of a matrix A is another matrix $A^T$ (also written $A^{tr}$, $A^t$, or $A'$) created by any one of the following equivalent actions:

- write the rows of A as the columns of $A^T$
- write the columns of A as the rows of $A^T$
- reflect A by its main diagonal (which starts from the top left) to obtain $A^T$
See The Transpose Wikipedia Entry for formulas, examples and more information.

Tuple : An ordered list of elements. Therefore $n$-tuple is an ordered list of $n$ elements. There is also a 0-tuple which is an empty sequence.

**U | Top**

Unimodal networks : These are also called square networks because their adjacency matrix is square; the diagonal is zero diagonal because there are no self-loops.

Unknown : This is a nodeset class that indicates that the entity has not been classified into one of the other classes, such as Agent, Knowledge, or Task.

**W | Top**

Walk : A set of nodes and links that form a single unbroken chain that can revisit both nodes and links, e.g. $A \Rightarrow B \Rightarrow C \Rightarrow B \Rightarrow D$.

Weighted Network : If the weights of the links are different we use the term weighted network. Every link will be represented by a real number running continuously from -? to +?. It contains not only whether a link exists but also the numerical information about that link. 0 indicates there is no link between two nodes.